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System Requirements
A typical installation installs Thermo-Calc and the latest version of the databases.

Additional add-on modules include:

l Diffusion Module (DICTRA)

l Precipitation Module (TC-PRISMA)

You can also install these Software Development Kits (SDKs):

l TQ-Interface (Windows and Linux)

l TC-API (Windows and Linux)

l TC-Toolbox for MATLAB® (Windows only)

System requirements and program availability are available on the web:
http://www.thermocalc.com/products-services/software/system-requirements/

Platforms Tested
Thermo-Calc and its components are tested on these platforms:

Windows Mac Linux1, 2

Windows 10 64-bit

Window 8 64-bit

Windows 7 SP1 32-bit

Windows 7 SP1 64-bit

Mac OS X Sierra
10.12.3

l Ubuntu 16.04 (Xenial)

l CentOS 7.0

l OpenSUSE 42.2

1 Thermo-Calc Software cannot guarantee full functionality if the software is installed on other Linux
distributions.
2 If you are installing on CentOS 7, it is recommended you install gtk2 before you run the installation script.

Key to Using this Guide
This installation guide is for all Thermo-Calc installations running on Windows, Mac OS or
Linux operating systems. It is also applicable to demo (trial) installations as well as
previously installed versions of Thermo-Calc (the new version is installed alongside the old
version).

This guide includes information about:

http://www.thermocalc.com/products-services/software/system-requirements/
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l The types of licenses and installations available.

l Installing the Thermo-Calc software and its components on stand-alone computers,
servers and client computers.

l Installing the license management software for network installations.

l Retrieving and installing license files.

l Troubleshooting to solve common installation problems.

Icons in this Guide

Name Description

Information Provides important information and indicates that
more detail is located in the linked or named topic.

Note
The information can be of use to you. It is
recommended that you read the text or follow the
link.

Operating system The operating system is indicated when the information is specific
to a Windows, Mac OS or Linux operating system.

License file
The license file, which contains the license keys and is installed on
either a standalone computer or a network server.

Thermo-Calc
The Thermo-Calc software and its components (including
databases) to be installed.

Typographical Conventions

Convention Definition

Forward
arrow →

The forward arrow symbol → instructs you to select a series of menu
items in a specific order. For example, Tools → Options is equivalent to:
From the Toolsmenu, select Options.
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Convention Definition

Boldface
font

A boldface font indicates that the given word(s) are shown that way in on
a toolbar button or as a menu selection. For example, if you are told to
select a menu item in a particular order, such as Tools → Options, or to
click Save.

Italic font An italic font indicates the introduction of important terminology. Expect
to find an explanation in the same paragraph or elsewhere in the guide.

code and
code bold

A code font indicates you are to make a keyboard entry. It also shows a
programming code or code examples. The code bold font highlights the
entry.

Installation Terminology

Term Definition

client
computer

A computer without a license file of its own but connected through the
network to a computer with the license information. The client computer
receives a license token from the computer where the license
management software is installed.

consolidated
network

A type of network installation where the Thermo-Calc software and a
Thermo-Calc licensing software are installed on a single server
computer. This allows all computers in the network to access both the
software and a license on the server via a client installation.

distributed
network

A type of network installation where the Thermo-Calc software is
installed on one server computer in a network and the Thermo-Calc
licensing software is installed on a different computer. After a thin client
installation, all computers in the network can access both the software
and the network license key via the server.

host ID The MAC/Ethernet Address on the computer that a license is locked to.

license file The file (called lservrc) that contains all the purchased license keys. It is
issued by Thermo-Calc Software, usually by email.
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Term Definition

license key The information contained in the license file that represents the
products purchased and which is then authorised for installation.

License
Manager
(Windows)

The Windows program used for license management: it distributes
license tokens as specified in the network license file issued by Thermo-
Calc Software.

License
Server
(Linux)

The Linux program used for license management: it distributes license
tokens as specified in the network license file issued by Thermo-Calc
Software.

license
server

The use of the term license server (lower case letters) is reserved for use
for scripts and option files (for example, in an "Unattended Network
Client Installations" on page 37). For the purposes of the step-by-step
instructions it is not used to refer to the type of network installation that
runs the license management program. Also see License Manager
(Windows) and License Server (Linux).

licensing
software

The Thermo-Calc license management software. When working in
Windows it is called License Manager (full name is Sentinel RMS License
Manager by SafeNet) and on Linux it is called License Server (full name
is Sentinel License Sever by Safenet).

Network
License
(NWL)

The license type used with the licensing software. The NWL can only be
used on one specific computer that hosts the licensing software. The
Network License uses information about IP addresses and IP ranges to
determine which client computers receive license tokens.

The software may be used on the number of sites you have paid for and
by the number of persons you have paid for on any number of network
connected computers

standalone
computer A computer which uses a SUNLL license type.
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Term Definition

Single-User-
Node
Locked-
License
(SUNLL)

A unique license file for one designated computer at one designated site.
It cannot be copied or moved outside the site. If the software is installed
on a portable computer, it can be temporarily used off-site. The license
can be used without network access (to the License Server).

thin client

An installation where the software is installed on a file server but is run
from a client computer. The licensing software may be installed on the
file server (consolidated network installation) or on a different computer
(distributed network installation).

XQuartz An open-source X Windows System, which is required to run Thermo-
Calc on a Mac.
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License and Installation Types
In this section:

License and Installation Types 9

About License Keys and Files 9

Standalone Installations (SUNLL) 10

Multi-User Network Installations (NWL) 10

Consolidated Network Installations 10

Distributed Network Installations 11

License Installations on a Server Network 12
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License and Installation Types
Installation procedures are based on the license type, the installation type and the operating
system.

Demo (trial) installations: Only a standalone installation is available and a
license file is automatically installed.

License
type Installation Type Windows Mac OS Linux

SUNLL Standalone Yes Yes Yes

NWL

Consolidated network Yes No Yes

Distributed network Yes No Yes

License installations on a
server network Yes Yes1 Yes

1 For Mac OS, the licensing software is installed on a Windows or Linux computer server.

www.thermocalc.com/purchase/licensing-options/

About License Keys and Files
Demo (trial) installations: A license file is automatically installed with the
software. You do not need to request it.

To run Thermo-Calc and its components you need a valid license key for each product. The
license keys are included in the license file emailed to you by Thermo-Calc Software.

You can copy the license file to the applicable computer(s) before or after installing the
software––the license file itself is not required during the installation process. However, it is
required to make calculations in Thermo-Calc.

"Request a License File from Thermo-Calc Software" on page 40

http://www.thermocalc.com/purchase/licensing-options/
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Standalone Installations (SUNLL)
The standalone installation is used with the Single-User Node-Locked License (SUNLL). The

Thermo-Calc software and a Thermo-Calc license file are installed on a standalone
computer. You can do a typical (all operating systems) or a custom installation (Windows
and Linux only).

To get started, go to "First Steps of Installation" on page 14 and then "Standalone
Installations" on page 21.

Multi-User Network Installations (NWL)
There are different types of multi-user network installations: consolidated, distributed and
where the licensing software is installed on a computer network. There is also a subtype of
installation called thin client, which is a step done with the consolidated and distributed
network installations.

Thin client installations: A thin client installation is where the Thermo-Calc
software is installed on a computer server but is run from a client computer.
The licensing software can be installed on the computer server (a consolidated
network) or on a different computer (a distributed network). This type of
installation is available for Windows and Linux operating systems. The client
computer must have the Thermo-Calc software installed. This type of
installation mainly sets environmental variables and paths on the client
computer.

Consolidated Network Installations
The consolidated network installation is used with a Network License (NWL) and it is
available for Windows and Linux operating systems.



Thermo-Calc Documentation Set

License and Installation Types ǀ 11 of 71

The Thermo-Calc software and the license management program are installed on the
same server where the license file is also copied. A thin client installation allows all
computers (the clients) in the server network to access both the software and the licensing
on the same computer server.

To get started, go to "First Steps of Installation" on page 14 and then "Network Client
Installations" on page 27.

Distributed Network Installations
The distributed network installation is used with a Network License (NWL) and is available
for Windows and Linux operating systems.

The Thermo-Calc software is installed on one computer server in a network and the
licensing software is installed on a different computer server where the license file is
also copied. A thin client installation allows all computers (the clients) in the server network
to access both the software and the licensing on the two computer servers.
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To get started, go to "First Steps of Installation" on page 14 and then "Network Client
Installations" on page 27.

License Installations on a Server Network
When a license file is installed on a server network, it is used with a Network License (NWL).
It is available for all platforms. However, for Mac OS the server containing the licensing
software must be set up on Windows or Linux.

The licensing software is installed on a computer server where the license file is also
copied. The Thermo-Calc software  is installed on every computer in the network that
needs it.

To get started, go to "First Steps of Installation" on page 14 and then "Network Client
Installations" on page 27.
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Preparing for Installation
In this section:
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Linux Installation Notes 19

Installing Libgfortran 19

openSUSE Administration (sudo) Users 20

Opening Thermo-Calc in Linux 20
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First Steps of Installation
This section reviews some of the things you need to do before installing the Thermo-Calc
software.

l Learn about the default directories where the software and license files are installed.

l For network installations, collect subnet information.

l For Mac, install XQuartz and make sure the security preferences are set correctly.

l For Linux, install libgfortran 4.4 (or higher).

l For a Linux Cent OS 7 installation, also install gtk2 before you run the installation
script.

yum install gtk2

Should I get my license file before or after software installation? The license
file itself is not required during the installation process (and not at all for demo
installations). However, it is required to make calculations in Thermo-Calc. The
license file has details about your computer(s) that in some cases cannot be
determined accurately until after installation (especially for a network
installation). For most users it is recommended you request the file before you
start installing.

Default Directory Locations
The default directories where the software and its components are installed, including
where the license file is stored, vary by platform and user type.

If you want to select specific components to install or if you want to install the software in a
non-default installation directory, then do a custom installation (Windows and Linux only). In
the table, <user> stands for the username and <version> for the version of Thermo-Calc, for
example 2017a.

Thermo-Calc Default Directories

OS User type Default directory

Windows Normal user

Users\<user>\Thermo-Calc\<version>

Users\<user>\Documents\Thermo- Calc\<version>

My documents
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OS User type Default directory

Administrator

Program Files\Thermo-Calc\<version>

Users\Public\Documents\Thermo- Calc\<version>

Public documents

Custom
installation
(for all users)

Users\Public\Documents\Thermo-Calc\<version>

License
software
installations
on a server
network (the
License
Manager
software)

C:\Program Files (x86)\Common Files\SafeNet
Sentinel\Sentinel RMS License Manager\WinNT\

Mac

Administrator
(user name
and password
required)

In the Applications folder: Thermo-Calc-<version>.app,
Thermo-Calc-<version>-Demo.app, and, uninstall-Thermo-
Calc-<version>.app

Examples and manuals in /Users/Shared/Thermo-
Calc/<version>

To go to this folder, in Finder, from the Go main menu
select Go to folder. Enter the above file path and click Go.

Linux

Non root user home/<user>/Thermo-Calc/<version>

Root user usr/local/Thermo-Calc/<version>

License
software
installations
on a server
network (the
License
Server
software)

If you are doing a network installation then these files are
available as a tar-file from the Thermo-Calc Software web
site.

In the downloaded tar-file, there is a restart_lserv script
file, which can be used as a template for creating a script
that starts up the License Server.
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Databases

Depending on the type of license and operating system, the encrypted Thermo-Calc
databases and the database initialization file are located in a subfolder to the Thermo-Calc
installation. For example, in a Windows standalone installation, you can find these in a folder
called data (file path is C:\Program Files\Thermo-Calc\<version>\data).
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TC-Toolbox for MATLAB

Examples for the TC-Toolbox are placed under MATLAB in the same documents folder as the
Thermo-Calc files (My Documents or Public Documents):

..\Documents\MATLAB\Thermo-Calc-Toolbox-X\Examples

Where X is the installed version number of the toolbox.

For most installations the examples are available in the MATLAB window when the software
is opened.

Database Checker Program

The Thermo-Calc software package includes a program to check that the syntax of
unencrypted database files is correct. The program applies the syntax rules set out in the
Database Manager User Guide and reports errors and issues warnings. This program is
intended for advanced users who develop and manage databases.

Thermo-Calc accepts deviations from these syntax rules. This means that a
database can work even if the Database Checker reports errors and warnings.
For example, an error is reported if an abbreviated phase name is found, but
phase name abbreviations are accepted by Thermo-Calc and its add-on
modules.

The executable DatabaseChecker file is found in the Thermo-Calc home directory. The
program can also be launched by selecting Tools→ Database Checker from the main menu.

Custom Property Models

All property models (whether these are predefined or custom models) must be
located in a subdirectory of the property model directory. You can go to Tools
→ Options and the Model directory field displays the default directory.

Predefined models included with the Property Model Calculator are installed in the locations
below based on your operating system. If you create your own models, this is the default
directory where these are saved. You can also use one of these as a template to create your
own property model.
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Operating
system Property Model installation directory

Windows C:\Users\Public\Public Documents\Thermo-Calc\ 2017a
\PropertyModels

Linux /home/user/Thermo-Calc/2017a/PropertyModels

Mac /Users/Shared/Thermo-Calc/2017a/PropertyModels

Subnet Information for Network Licenses
For network licenses, the subnet information is also required. Contact your company’s
network administrator for help as required. Additional requirements are included elsewhere
for network installations.

l Subnets should be in the format aaa.bbb.ccc*** (for example: 192.168.29.0/24 or
192.168.29.*

l A maximum of six subnets are permitted.

l An alternative way to get this information is to run the command:

l Windows: ipconfig /all

l Mac / Linux: ifconfig

Mac OS Installation Notes

Restarting after an installation

In some types of installations (e.g. a network installation), you may have to restart your Mac
to use Thermo-Calc for the first time.

Installing XQuartz

The XQuartz open-source X Windows system is required to run Thermo-Calc on Mac OS X
but it is not required to install Thermo-Calc. Before installing Thermo-Calc, you may also
need to ensure that the computer security permissions are set.

1. In a web browser go to https://www.macupdate.com or to download it directly from
XQuartz, http://xquartz.macosforge.org/landing/.

https://www.macupdate.com/
http://xquartz.macosforge.org/landing/
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2. In the Search Mac Apps field, enter XQuartz.

3. Click the XQuartz search result. For example, based on the recent version, the name is
XQuartz-2.7.7.dmg.

4. Click Download.

5. Double-click the XQuartz.pkg file. Follow the instructions.

6. Click OK when the message about logging out displays and click Close when the
installation is successful.

Enabling the security settings

1. From the Apple main menu, select System Preferences.

2. Click Security and Privacy.

3. Click General. At the bottom of the Security & Privacy window, click the lock icon to
make changes. Enter the administrator password as required.

4. If you have already tried to launch the Thermo-Calc installer, you can click Open
Anyway to proceed. Otherwise, under Allow apps downloaded from: click Anywhere
and then Allow from Anywhere.

5. Continue with the applicable installation type (standalone or network).

Remember to reset your security after installing Thermo-Calc.

Linux Installation Notes
The following are details you need to know regarding your Linux installation as well as how
to open Thermo-Calc.

Installing Libgfortran
To install and run Thermo-Calc and its components, a runtime library (libgfortran 4.4 or
higher) for GNU Fortran applications is required.
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How to install the runtime library

Linux
distribution Notes

openSUSE
42.2

On a standard installation, you do not need to install this
runtime library. You may need GCC if it is not already
installed on your computer.

Ubuntu
16.04
(Xenial)

Open a terminal and enter the following:
> sudo apt-get -y update

> sudo apt-get -y install gfortran

CentOS 7.0
Open a terminal and enter the following:

> sudo yum -y update

> sudo yum -y install libgfortran

openSUSE Administration (sudo) Users
Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:

sudo ./linux-installation-x64-6.0.0.17347.run

When this command is used, you will do a text-based installation instead of having a
graphical interface to guide you. The information is the same, just without the user
interface.

Opening Thermo-Calc in Linux
To open Thermo-Calc double-click the Thermo-Calc-2017a application or from the Thermo-
Calc installation directory enter $ ./Thermo-Calc-2017a.sh in the terminal.
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Standalone Installations
You can either do a typical or a custom standalone installation. The license type is called a
Single-User Node-Locked License (SUNLL).

In this section:

Typical Standalone Installations 22

Add New Components to an Existing Installation 24

Custom Standalone Installation 24
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Typical Standalone Installations
The following describes a typical standalone installation. These steps assume you have
completed the section "First Steps of Installation" on page 14.

Step 1: Request your license file from Thermo-Calc Software

Demo (trial) installations: Skip this step. A license file is automatically installed
with the software. You do not need to request it.

Updates to Thermo-Calc: Customers who subscribe to the annual maintenance
plan can skip this step if you have received your license file in an email from
Thermo-Calc Software AB. Save the license file to your computer to use during
software installation. The license file name must be the same as the existing file
name to ensure there are no errors during the update.

Follow the instructions for your operating system in the section "Request a License File from
Thermo-Calc Software" on page 40.

Step 2: Download your Thermo-Calc installation software

l Web downloads: For web links sent in an email from Thermo-Calc Software, go to the
URL and log in with the information provided to download the software.

l DVD installations: Insert the DVD and follow the instructions.

Step 3: Run the applicable installation file for your operating system

1. Open the folder for your operating system. Then for:

l Windows: Right-click the .exe file. Choose Save target as and save it to your
computer. Double-click the .exe file to launch the Setup program.

l Mac: Right-click the file Thermo-Calc-2016a-osx.app. Choose Download Linked File
and save the installation file to your Downloads directory. Unzip the file.

l Linux: Right-click the binary file (the BIN file) and save it to your computer. To start
the Setup Wizard in a Terminal window, enter these commands in the directory
where the binary installation file is saved:

> chmod +x linux-installation-x64-2017a.run

> ./linux-installation-x64-2017a.run

If you are an openSUSE root user, see "Linux Installation Notes" on page 19 for
some information about your installation.
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2. On the Setup-Thermo-Calc window click Next.

3. On the License Agreement window window click to accept the license agreement.

4. Click Next.

Demo (trial) installations: Your installation starts and is done when the
Completing the Thermo-Calc Demo Setup Wizard opens. Click Finish and
reboot your computer to start using Thermo-Calc.

Step 4: Select the installation type and upload the license file

1. In the Select installation mode window click Typical Standalone → Install Thermo-
Calc (incorporating Diffusion Module (DICTRA) and Precipitation Module (TC-
PRISMA).

2. In the Choose a license file field enter the path to your license file (called lservrc) or
click the file button to navigate to a location on the computer (for example, where
you saved it). Click Next.

To prevent errors, leave this field blank if you did not get a license file yet.

Step 5: Install the software and start using Thermo-Calc

1. In the Ready to Install window click Next.

2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to
finish the installation and start using Thermo-Calc.

If you did not get your license file see "Request a License File from Thermo-Calc
Software" on page 40.
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Add New Components to an Existing Installation
If you want to add new components to an existing Thermo-Calc installation (for example,
you purchased a license for TC-API), run the executable (Windows) or binary (Linux)
installation file again as in Step 3 of "Typical Standalone Installations" on page 22. This is not
available for Mac.

1. Double-click the executable Thermo-Calc installation file. Click Next.

2. Click to accept the license agreement. Click Next.

3. Select the additional component(s) to install. Click Next.

4. Click Next to start the installation, which adds the new component(s).

Use the Uninstall program to remove components. See "Uninstalling Thermo-
Calc" on page 60.

Custom Standalone Installation
This topic describes how to do a custom installation on a standalone computer for either a
Windows or Linux operating system. These steps assume you have completed the section
"First Steps of Installation" on page 14.

Step 1: Complete Steps 1 to 4 of a typical standalone installation

Follow the instructions for "Typical Standalone Installations" on page 22 to get your license
file and to download and run the software.

Step 2: Select the installation type and what components to install

1. On the Select installation mode window, click Custom. Click Next.

The option appears greyed out, but it is available to select.

2. In the Select Components window, click to select what you want to install. Click
Next.
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Additional licenses are required to run TC-API, TQ-Interface, TC-Toolbox for
MATLAB (Windows only) and some of the databases. Some elements are
included with Precipitation Module (TC-PRISMA) but a separate license is
required for full functionality.

Step 3: Set the installation directory path, license file location and shortcuts

1. In the Installation Directory window, either accept the default path or enter a path
to where you want to install the software (see "Default Directory Locations" on
page 14). Click the file button to navigate to another directory. Click Next.

For the Windows TC-Toolbox for MATLAB® component, and if you get a MATLAB not
found message, enter the MATLAB installation directory and click Next.

2. In the Choose Setup Type window, click Standalone.

3. In the Choose a license file field enter the path to your license file (called lservrc) or
click the file button to navigate to a location on the computer. Click Next.

To prevent errors, leave this field blank if you do not have a license file yet.



Thermo-Calc Documentation Set

Standalone Installations ǀ 26 of 71

4. Set up the Desktop shortcuts.

For Windows, in the Specify Configuration window, the default is Current user only,
meaning the installation is only available for the person logged in and installing the
software. Select All users to allow anyone using this computer to access Thermo-Calc.
By default, the Create Shortcuts on Desktop check box is selected. Click Next.

For Linux, and if you are installing as a non-root user, by default, the Create
Shortcuts on Desktop check box is selected. Click Forward.

Step 4: Install the software and start using Thermo-Calc

1. In the Ready to Install window click Next and then click Finish.

2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to
finish the installation and start using Thermo-Calc.

If you did not get your license file see "Request a License File from Thermo-Calc
Software" on page 40.
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Network Client Installations
This installation type is available for Windows and Linux. It is applicable to the consolidated
and distributed network types of installations as well as for the licensing installation on a
server network.

l Do a Typical Network Client installation if you only want to install the Thermo-Calc
program (including Diffusion Module (DICTRA)) and Precipitation Module (TC-
PRISMA)) and databases.

l Do a Custom installation if you want to select specific components to install or if you
want to install the software in a non-default installation directory.

In this section:

Typical Network Client Installations 28

Set Up the License Manager on Windows 29

Set Up the License Server on Linux 31

Thin Client Installations 34

Custom Network Client Installations 35

Unattended Network Client Installations 37
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Typical Network Client Installations
The following outlines how you do a typical network client installation.

Step 1: Install the licensing software

Follow the instructions for your operating system:

l "Set Up the License Manager on Windows" on the next page, or

l "Set Up the License Server on Linux" on page 31

Step 2: Complete Steps 1 to 3 of a typical standalone installation

Follow the instructions for "Typical Standalone Installations" on page 22 to download and run
the software. It is up to you whether you get the computer information for the license files
before or after installing the software.

Step 3: Choose the installation type and enter the computer server details

1. Click Typical Network Client installation to install Thermo-Calc incorporating
Diffusion Module (DICTRA) and Precipitation Module (TC-PRISMA).

The option appears greyed out, but it is available to select.

2. In the field, enter the name or IP number of the computer where the licensing
software is installed. Click Next.

Step 4: Install the software and components

1. In the Ready to Install window click Next.

2. When the Completing the Thermo-Calc Setup Wizard window opens, click Finish.

3. For Linux users, log out and log back in to start using Thermo-Calc.

If you did not get your license file see "Request a License File from Thermo-Calc
Software" on page 40.
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Set Up the License Manager on Windows
License Manager vs License Server: Both terms refer to the licensing software
program installed on a network computer. License Manger is for Windows and
License Server is for Linux. See "Installation Terminology" on page 5 for more
information.

Installation Requirements

This procedure explains how to install the License Manager on a computer that acts as a
license server in your network. It is a Sentinel RMS License Manager Windows service and it
supplies the client computers in your network with license tokens when it runs the Thermo-
Calc software. A network license can only be used on one specific computer that hosts the
License Manager. The network license determines which client computers receive license
tokens using their IP addresses and IP ranges.

l For Mac installations, the server containing the license file must be set up on a
Windows or Linux computer.

l For testing purposes, and in order to confirm the installation is working correctly,
install the Thermo-Calc software on the same computer as the Sentinel RMS License
Manager. Thermo-Calc can always be uninstalled after testing if required.

l Administrator rights are required.

Installing the License Manager

Step 1: Install the Sentinel RMS License Manager software

1. Follow the instructions to download your Thermo-Calc installation software.

2. Open the directory for Windows and right-click the file Sentinel RMS License
Manager 8.5.1.msi.

3. Select Save target as and choose a suitable directory so that you can easily find the
file later.

4. Right-click the downloaded file and choose Install. Click Next.

Step 2: Choose the installation directory

1. Click to accept the license agreement. Click Next.

2. Enter your User Name and Organization and select to install the License Manager
for All users. Click Next.
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3. In the Destination Folder window click Next to accept the suggested destination
directory or Change to select another directory. Click Next.

Step 3: Choose the setup type and install the software

1. In the Setup Type window, select Complete. Click Next.

2. Select the Unblock the system firewall for the Sentinel RMS License Manager
check box.

Selecting the check box is required to runThermo-Calc.

3. Click Next and then Install.

4. Click Finish to exit the InstallShield Wizard.

Step 4: Copy the license files to the destination directory

Copy the network license file to the destination directory. By default, it is installed in the
following directory with the name lservrc.

C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS
License Manager\WinNT\
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The name of the license file must be in lower case letters (lservrc). This is
especially important if both Windows and Linux operating systems are part of
your network; Linux commands and operations are case-sensitive.

If the default file path does not work, you can set the environmental variable LSERVOPTS to
select the license file:

a. In the Windows Control Panel, go to System → Advanced system settings.

b. In System Properties select Advanced → Environment Variables → New.

c. Enter the Variable name LSERVOPTS to specify the parameters with which the
License Manager is started.

d. To specify the path to the license file in the Variable value field enter the following
and include the complete license file path and name.

-s <license file path and name>

Step 5: Reboot or restart the license manager

Set Up the License Server on Linux
License Manager vs License Server: Both terms refer to the licensing software
program installed on a network computer. License Manger is for Windows and
License Server is for Linux. See "Installation Terminology" on page 5 for more
information.

Installation Requirements

There are a variety of things needed to prepare for a Linux License Server installation. The
following points are described in this section.

l You need to stop older versions of the License Server before running the new one. To
stop the license server you run lsrvdown .

l Root access to your computer is required or you need to be on the sudoers list.

l To run the License Server on a Linux 64-bit computer, you need to install 32-bit
library support. For example, on CentOS this can be done by running the command:

>yum install glib2.i686

l You need a valid lservrc network license file supplied by Thermo-Calc Software and
the actual License Server—a file(program) called lserv.
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l

The name of the license file must be in lower case letters (lservrc)
because Linux commands and operations are case-sensitive.

l The license file need to be read and writable by the license server(license manager)

l If you have a license server; Upgrade your license server if the new one is a higher
version than the present one. Clients work with newer license servers(managers) but
not necessarily with ones older than client.

openSUSE Administration (sudo) Users

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:

sudo ./linux-installation-x64-6.0.0.17347.run

When this command is used, you will do a text-based installation instead of having a
graphical interface to guide you. The information is the same, just without the user
interface.

Installing the License Server

Step 1: Stop any older versions of the License Server

Skip this step if this is a new installation.

1. To stop an old version of the License Server that is already running, go to the
directory where the old file is found, and enter the commands:

>chmod +x <lsrvdown>

>./lsrvdown <host_name>

2. Edit existing scripts that start the older version of the License Server so that they
start the newer version instead.

For more information about the lservdown utility, go to
http://sentinelrms.safenet-
inc.com/RMSDocumentation/SysAdmin/Content/lsrvdown.htm
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Step 2: Write a script to start the License Server

The following is an excerpt from the template script for starting the License Server found in
the restart_lserv file.

Replace the paths for LICENSE_SERVER_DIR, LICENSE_FILE_DIR and LOG_DIR to match your
system. Save it as a script:

# set the directory where the executables are located

LICENSE_SERVER_DIR=/usr/local/Thermo-Calc/2017a/Licensing-files

# set the directory of the license file lservrc

LICENSE_FILE_DIR=/usr/local/Thermo-Calc/2017a/Licensing-files

# set the directory where you wish to save the log-files

LOG_DIR=/tmp

# stop the running server

# (omit this line if calling this script at startup)

$LICENSE_SERVER_DIR/lsrvdown $HOSTNAME

# start the license server

$LICENSE_SERVER_DIR/lserv -s $LICENSE_FILE_DIR/lservrc -l $LOG_DIR/lserv_use.log -f
$LOG_DIR/lserv_err.log

Step 3: Confirm the HOSTNAME variable and open the UDP port

1. Before starting the License Server make sure that the value of the $HOSTNAME
variable is correct. This value can be shown by typing the > nslookup $HOSTNAME
command in the terminal window:

The value should be the same IP address that is shown when you use the ifconfig
command.

2. Open the UDP port 5093 in your firewall. In case you have installed SELinux you
might also need to disable it by setting SELINUX=permissive in the
/etc/selinux/config file.

Step 4: Start the License Server

1. To start the License Server, run the script created as root. Enter these commands in
the console:

> chmod +x <name_of_script_file>

> ./<name_of_script_file>

2. If you want the License Server to start when you boot the system, put a copy of the
start script under /etc/rc.d/init.d and start the script from the file
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/etc/rc.d/rc.local.

Thin Client Installations
This topic describes how you install a thin Thermo-Calc client to run Thermo-Calc from a file
server. It is applicable to consolidated and distributed network installations for either a
Windows or Linux operating system.

Installation Requirements

l You need access to the directory where Thermo-Calc is installed on the file server.

l You need the IP number or name of the computer where the license file is installed.

l For Linux you may have to disable your firewall. If SELinux is installed, try disabling it
by setting SELINUX=permissive in /etc/selinux/config.

Installing a Thin Client on Windows

1. Map the file server share as a network drive so that it gets an assigned drive letter
(e.g. E:).

2. Open the \Thermo-Calc\<version>\ directory on the file server, where version is the
current version of the software.

3. Open the directory Thin-client. Double-click the client-install-windows.exe file.

4. Click to accept the terms of the license agreement. Click Next.

5. Enter the name or IP number of where the license file and the License Manager
software is installed. Click Next.

6. In the Specify Configuration window, the default is Current user only, meaning the
installation is only available for the person logged in and installing the software.
Select All users to allow anyone using this computer to access Thermo-Calc. By
default the Create Shortcuts on Desktop check box is selected. Click Next.

7. In the Ready to Install window, click Next.

8. Click Finish. To start Thermo-Calc find the program on the server and start it from
there.

Installing a Thin Client on Linux

1. Add the following to the smb.conf file, where <user> is your user name:

[public]
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path=/home/<user>/Thermo_Calc/2017a

public=yes

writable=yes

comment=smb share

guest OK=yes

force user=<user>

2. From the client, mount the directory on the server computer that contains the
Thermo-Calc server installation (by default, this directory is called /Thermo-
Calc/2017a). How the directory is mounted depends on the Linux distribution being
used as well as how the Thermo-Calc directory on the server computer is shared. Use
the Linux command mount. For example:

> mkdir public

> sudo mount -t cifs //ip_number_server_computer/public ./public -o
user=<user>

3. Open the mounted directory on your computer, and run client-install-linux-
x64.run or client-install-linux-x86.run in the /Thin-client directory.

4. If you do this from the terminal window, use the following to start the installation
(assuming that the file server is a 64-bit computer):

> ./client-install-linux-x64.run

5. Click Forward and click to select the license agreement. Click Forward.

6. Enter the name or IP number of the License Server. Click Forward.

7. If you are installing as a non-root user, by default, the Create Shortcuts on Desktop
check box is selected. Click Forward.

8. In the Ready to Install window click Forward.

9. Click Finish. Log out and log back in to start using Thermo-Calc.

Custom Network Client Installations
This section describes how to do a custom network client installation for Windows and Linux
operating systems. The requirements are the same as for a typical client installation.

Step 1: Install the licensing software

Follow the instructions for your operating system:

l "Set Up the License Manager on Windows" on page 29, or

l "Set Up the License Server on Linux" on page 31
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Step 2: Complete Steps 1 to 4 of a typical standalone installation

Follow the instructions for "Typical Standalone Installations" on page 22 to download and run
the software. It is up to you whether you get the computer information for the license files
before or after installing the software.

Step 3: Choose the installation type and what to install

1. In the Select installation mode window click Custom. Click Next.

The option appears greyed out, but it is available to select.

2. In the Select Components window, choose what you want to install. Click Next.

Step 4: Set the installation directory path to the license file

1. In the Installation Directory window, enter the path to an installation directory (see
"Default Directory Locations" on page 14). Click Next.

For the Windows TC-Toolbox for MATLAB component and if you get a MATLAB not
found message, enter the MATLAB installation directory and click Next.

2. In the Choose Setup Type window, click Network Client and enter the name or IP
number of the computer where the licensing software is installed. Click Next.
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Step 5: Specify the configuration and create shortcuts

For Windows, in the Specify Configuration window, the default is Current user only,
meaning the installation is only available for the person logged in and installing the
software. Select All users to allow anyone using this computer to access Thermo-Calc.
By default, the Create Shortcuts on Desktop check box is selected. Click Next.

For Linux, and if you are installing as a non-root user, by default, the Create
Shortcuts on Desktop check box is selected. Click Forward.

Step 6: Install the software and start using Thermo-Calc

1. In the Ready to Install window click Next.

2. When the Completing the Thermo-Calc Setup Wizard window opens, click Finish.

3. Log out and log back in and start using Thermo-Calc. If you have not got the license
file, go to "Request a License File from Thermo-Calc Software" on page 40.

Unattended Network Client Installations
Terminology note: The use of the term license server (lower case letters) is
applicable to the option files as described in this section. For the purposes of the
step-by-step instructions it is not used to refer to the type of network installation
that runs the licensing software.

Sometimes it is convenient to install Thermo-Calc network clients without providing user
input after the installation is initiated (an unattended network client installation). This is
available for Windows and Linux operating systems.

Make sure you know the name or IP number of the computer where the
licensing software and the license file are to be installed.
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Step 1: Create an option file in a text editor to enter the options

The following is an example of an option file for a custom network client installation, where
<name/IP number> is the name or IP number of the computer where the license file is
installed and <MATLAB directory> is the path to the MATLAB directory (when applicable):

installation_mode=custom

setup_type=client

enable-components=thermo,databases,tq,tcapi,toolbox

config=all

icons=1

license_server=<name/IP number>

matlab_folder=<MATLAB directory>

Below is a shorter example, specifying that a typical Thermo-Calc network client should be
installed:

installation_mode=typical_client

license_server=<name/IP number>

Step 2: Go to the directory where the installation file is stored

Thermo-Calc can only be installed in unattended mode from the command line
prompt.

Start the installation in unattended mode using the option file created with this command:

l For Windows: <installationfile>.exe – mode unattended --optionfile
<path\optionfile>

l For Linux: <installationfile>.run --mode unattended --optionfile
<path/optionfile>

To see other options when you start the Thermo-Calc installation program from the
command line prompt, run this command:

l For Windows: <installationfile>.exe –help

l For Linux: <installationfile>.run –-help
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Request License Files
In this section:

Request a License File from Thermo-Calc Software 40

Getting License Information Using Thermo-Calc 40

Requesting the License File for Windows 41

Requesting the License File for Mac OS 43

Requesting the License File for Linux 44
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Request a License File from Thermo-Calc Software
The following explains how to retrieve the necessary diagnostic and network adaptor
information about your computer and then send an email to Thermo-Calc Software to get
your license file(s) containing the license key(s).

To set up the correct licensing (excluding demo installations where a license file is not
required):

1. Make a note of your company or organisation’s site number. You can find the site
number on an invoice or any correspondence from Thermo-Calc Software.

2. Retrieve your computer diagnostic and network adapter information.

3. Email Thermo-Calc Software with this information.

4. A Thermo-Calc Software representative emails you the license file. Save the license
file lservrc (there is no file suffix) to a location where you can easily access it later.

http://www.thermocalc.com/support/request-support/

Getting License Information Using Thermo-Calc
If you have already installed Thermo-Calc, you can view the license information in the GUI.
Select Help → Show License Info.

In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.

1. Open Thermo-Calc.

2. Click Switch to Console Mode.

3. At the SYS: prompt, enter DISPLAY_LICENSE_INFO (all caps).

http://www.thermocalc.com/support/request-support/
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4. You can output the information to a FILE or to the SCREEN.

5. For both options, the information is displayed on screen. Copy the section containing
the Ethernet and IP address. You can save it to a text file or paste it directly into an
email. If you choose FILE as the output, then you can attach the file to an email. For
Windows and Linux you can also run the diagnostic program located on the web.

Requesting the License File for Windows
Demo (trial) installations: Skip this section. A license file is automatically
installed with the software. You do not need to request it.

Upgrades to a new version of Thermo-Calc: Skip this section if you are
upgrading to a new version of Thermo-Calc and (and you have a maintenance
plan). Your license is sent to you in an email from Thermo-Calc Software AB.
Save it to your computer to use during software installation.

1. Go to Thermo-Calc's website (or click the link sent by email).

2. Under TCLOG (Thermo-Calc version S) →Windows computers click the link tclog
for Windows computers.

3. Click the Save file button and OK to download and save the tclog.zip file.

4. Unzip and extract the files.

5. Double-click to open the main folder of the downloaded file. Right-click the tclog.bat
file and select Run as administrator.

http://www.thermocalc.com/support/request-support/diagnostic-tools/
http://www.thermocalc.com/support/request-support/diagnostic-tools/
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6. Double-click the tclog.bat file. Click Run. This starts the diagnostic tool and creates a
tclog.log text file in the same directory.

7. Send an email to support@thermocalc.com and attach the tclog.log file. Make sure
to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.

8. A representative from Thermo-Calc Software replies to the email and attaches your
license file(s).

9. Save the license file(s) to your computer or network.

mailto:support@thermocalc.com
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Requesting the License File for Mac OS
Demo (trial) installations: Skip this section. A license file is automatically
installed with the software. You do not need to request it.

Upgrades to a new version of Thermo-Calc: Skip this section if you are
upgrading to a new version of Thermo-Calc and (and you have a maintenance
plan). Your license is sent to you in an email from Thermo-Calc Software AB.
Save it to your computer to use during software installation.

1. From the Apple main menu, select System Preferences.

2. Click Network.

3. In the left column select Ethernet or Built-in Ethernet (do not select a WiFi
connection as a local static MAC address is required).

4. Click Advanced → Hardware.
The Network window shows you the MAC Address. For example, the MAC address
(the host ID) might be 3c:07:54:28:5f:72.

5. Send an email to support@thermocalc.com and copy and paste the MAC address into
the body of the email. Make sure to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.

mailto:support@thermocalc.com
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6. A representative from Thermo-Calc Software replies to the email address provided
and attaches your license file or files.

7. Save your license file to your computer or network.

Requesting the License File for Linux
1. Go to Thermo-Calc's website.

2. From the Support menu select Diagnostic tools.

3. Under TCLOG→ Linux computers click the link tclog for Linux computers.

4. For the tclog.tar file, either Save File or Open with the default program.

5. Go to the Downloads directory. Extract the files using the mouse (for example, in
Ubuntu right-click to extract the files) or use this command in the Terminal window:

> tar –xf tclog.tar

6. This creates a subdirectory called tclog in the Downloads directory.

7. In a Terminal window run the following command replacing <tclog_path> with the
path to tclog:

> sh /<tclog_path>/script/getreg.sh

8. Double-click to open the tclog folder. Then either copy the output from the Terminal
window or right-click and save the tclog file. Name it tclog.log.

9. Send an email to support@thermocalc.com and attach the tclog.log file. Make sure
to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.

http://www.thermocalc.com/support/request-support/diagnostic-tools/
mailto:support@thermocalc.com
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10. A representative from Thermo-Calc Software replies to the email and attaches your
license file(s).

11. Save the license file(s) to your computer or network.
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Troubleshooting
In this section:

License Errors 47

Determining the Current License File Directory Path 49

Specifying a New Server Name or IP Number 52

Changing the server name or address (Windows) 53

Mac installations 53

Linux installations 53

MATLAB® Installation Directory 53

Firewalls 54

Client/Server Mismatch 54

Mac OS Installations: Running the License Initialization Script 56

Linux Installations: Running the License Initialization Script 57
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License Errors

Issue Platform Installation
type

Action or link to more
information

How do I add or
update a standalone
(SUNLL) license on a
Windows computer
where Thermo-Calc is
already installed?

Windows Standalone "Determining the Current License
File Directory Path" on page 49

How do I add or
update a standalone
(SUNLL) license on a
Linux computer where
Thermo-Calc is
already installed?

Linux Standalone "Determining the Current License
File Directory Path" on page 49

How do I add or
update a network
license on Windows?

Windows Network "Determining the Current License
File Directory Path" on page 49

How do I add or
update a network
license on Linux?

Linux Network "Determining the Current License
File Directory Path" on page 49

No license file found.
Copy a valid license
file to the installation
directory after
completing the
installation.

All All

You get this message if the wrong
path or no license file is found at a
path entered during the
installation process. See "Default
Directory Locations" on page 14
and "Determining the Current
License File Directory Path" on
page 49

MATLAB not found
(for the TC-Toolbox
for MATLAB
component)

Windows All "MATLAB® Installation Directory "
on page 53
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Issue Platform Installation
type

Action or link to more
information

Warning Environment
variable “LSHOST” is
not set. Software will
not function properly.

All Network "Specifying a New Server Name or
IP Number" on page 52

Problem running post-
install step.
Installation may not
complete correctly.

Unable to run post-
installation script, run
the license
initialization script as
root after the
installation.

Linux
and Mac Standalone

"Mac OS Installations: Running the
License Initialization Script " on
page 56 or "Linux Installations:
Running the License Initialization
Script" on page 57

Firewall warnings
related to license
management
software (License
Manager and License
Server)

Windows
and
Linux

Network "Firewalls" on page 54

Client / Server
naming mismatches

Windows
and
Linux

Network "Client/Server Mismatch" on
page 54

InstallScript engine
missing Windows Network

You are not notified if the
InstallScript scripting engine is not
installed. Install the ISScript.msi
file and then run the downloaded
file from Thermo-Calc again as
described in "Set Up the License
Manager on Windows" on page 29
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Determining the Current License File Directory Path
This topic explains how to find out where your license file is installed, either by default or if
a different directory was chosen for previously installed versions. For new installations,
where you may not have had a license file when you installed Thermo-Calc (for example,
you had a demo version), you can also use these instructions to determine the correct file
path.

From Thermo-Calc

If you have already installed Thermo-Calc, you can view the path to the license file in the
GUI. Select Help → Show License Info.

In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.
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Windows Standalone Installations

How do I add or update a standalone (SUNLL) license on a Windows computer where
Thermo-Calc is already installed?

1. Unpack the .zip file that contains your standalone license and save the LSERVRC file
on your computer. Find out where to place the new license file by opening a
Command Prompt Window (cmd.exe) and type in the command line:

>set LSERVRC

2. Press Enter. The output from the command is the path to the license file (including
the name of the license file). For example: if the output is

LSERVRC=C:\Program Files\Thermo-Calc\2017a\lservrc

then the new license file should be placed in C:\Program Files\Thermo-
Calc\2017a\

Linux Standalone Installations

How do I add or update a standalone (SUNLL) license on a Linux computer where Thermo-
Calc is already installed?

Find out where to place the new license file by opening a Terminal window and type in the
command line:

echo $LSERVRC

Windows Network Installations

How do I add or update a network license on Windows?

1. You need administrator rights to do the following.

l OnWindows 7, click the Start button and in the search field type Services.  Double-
click the Services result.
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l OnWindows 8, move the mouse over the right edge of the screen to access Search,
click Settings and then enter and select View Local Services.

2. In the list of installed services, right-click Sentinel RMS License Manager and select
Properties from the pop-up menu.

3. On the General tab under Path to executable, click the line containing the path to
see where the file lservnt.exe is located. The license file (lservrc) is in the same
directory.

The default path for the license file is

C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS
License Manager\WinNT\LSERVRC

4. Move your copy of the license file (lservrc) to this directory.

5. Restart the Sentinel RMS License Manager by:

l Restarting the computer, or

l Right-clicking Sentinel RMS License Manager and selecting Restart from the list of
installed services.
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Linux Network Installations

How do I add or update a network license on Linux?

Replace your current license file with the new license file. The license file is located in the
same directory as the license server.

Specifying a New Server Name or IP Number
The Thermo-Calc Setup wizard does not warn you if the name or IP number entered to the
server (with the license management software) is incorrect.

If the name or IP number is not set at all, or if it is set to an empty string, then when you
start Thermo-Calc the following message displays:Warning Environment variable “LSHOST”
is not set. Software will not function properly.
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Windows

Changing the server name or address (Windows)
This section explains how to specify or change the name or IP number of the server where
the License Manager is installed and for a consolidated network client installation.

To install a license for an existing Thermo-Calc program, follow these steps:

1. Close all running Thermo-Calc programs.

2. Open a command line window.

l InWindows 8, use Search (mouse-over the right edge of your screen) to find cmd and
then double-click the Command line icon.

l InWindows 7, from the Start menu click Run and type cmd in the field.

3. Specify the name or IP number of the licensing software server. Type:

set LSHOST=<name/IP number>

To display the current name or IP number, type:

set LSHOST

Mac

Mac installations
Permanently set the environmental variable LSHOST to specify a new licensing server name
or IP number. Refer to the file /Applications/Thermo-Calc-2017a.app/Contents/plist.info.

In this file, you can manually set the TC70_HOME variable, which specifies the home
directory of the Thermo-Calc program. See the plist.info file for an example.

Linux

Linux installations
You can set or change the name or IP number of the license server at a later time by setting
the environmental variable “LSHOST” to this name or number.

MATLAB® Installation Directory
For Windows installations of the TC-Toolbox for MATLAB component, you may get an error
message or window asking for the MATLAB installation directory path. If it is during the
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installation Setup process, enter the path in the field.

Determining the licensing software version

Sometimes you may need to know the version of License Manager (Windows) or License
Server (Linux) software being used. This can be useful while troubleshooting network
installations.

l OnWindows open a command prompt and go to the directory where lservnt.exe is
found. For example:

>C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS
License Manager\WinNT

Type the command >lservnt.exe –help and the version is displayed.

l On Linux open a Terminal window and go to the directory where the lserv script
is saved. For example:

>cd /usr/local/Thermo-Calc/<version>/Licensing-files

Type the command >./lserv –help and the version is displayed.

Firewalls

Windows

For a Windows License Manager installation you may have to change the system firewall
settings to allow the License Manager to communicate with the computers running the
client applications. Go to the Windows Firewall settings window to see if there are any
problems. If prompted, select Unblock the system firewall for the Sentinel RMS License
Manager and click Next.

Linux

For a Linux License Server installation you need to open the UDP port 5093 in your firewall.
In case you have installed SELinux you might also need to disable it by setting
SELINUX=permissive in the /etc/selinux/config file.

Client/Server Mismatch
For some network installations there can be a naming mismatch that causes errors. The
server (where the license management software is installed) gets information from its DNS
servers that an IP address (aaa.bbb.ccc) belongs to a computer (Computer A). But the client
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computer identifies itself as having a different IP address (aaa.bbb.ccc.eee) for the same
computer (Computer A).

Even if the IP address of the client computer belongs to a subnet range listed in the license
file, there is a problem with accessing the license file because the computer name does not
match the information.

You may need your organisation’s network administrator to assist with this issue.

How to Check

Step 1: Compare computer names on the client computer and server

1. On the client computer, start a command prompt cmd.exe and type ipconfig /all.
Press Enter. A variety of data is displayed on screen. Write down the following
information for later comparison:

l Host name

l Dns Suffix

l Current IPv4 Address

2. In the command window, type nslookup <client_computer_name>, where client_
computer_name is the actual name of the client. Press Enter.

This shows what information is saved on the DNS Servers used by the client computer.
This information should match what is shown in the output from the first step.

3. On the server that holds the license management software, open a command prompt
and run the command line: nslookup client_computer_name. The output lists the
information for this server.

Does it match the information given by the command ipconfig /all on the client
computer? If not try the following:

Step 2: Try these options to correct the issue

1. If the client computer has a dynamic (DHCP) IP address, either change it to a static
one or make a reservation on the DHCP Server so that the computer always get the
same IP address.

2. Update the records on the DNS Servers used by both the client computer and the
server computer.

You can also hard code computer names and IP addresses in the local "address book" of the
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client and server:

1. On the client computer, make a backup copy of the file
C:\Windows\System32\drivers\etc\hosts.

2. Open the original in a simple text editor.

3. Add a new line which contains the IP and name of the server, for example:
192.168.29.27 license_server.thermocalc.se.

4. Save the changes.

5. On the server, make a backup copy of the file /etc/hosts.

6. Open the original in a simple text editor.

7. Add a new line which contains the IP and name of the client, for example:
192.168.29.47 Computer_A.thermocalc.se.

8. Save the changes.

9. In the host file, there is an example of how the operating system (Windows or Linux)
wants the line in the hosts file to look like.

Mac OS  Installations: Running the License
Initialization Script
As part of the Standalone installation of Thermo-Calc, the Setup runs a license initialization
script. If this part of the installation process did not complete properly for a standalone
installation, you must manually run the license initialization script. You need the
administrator username and password for these steps.

How to Run the Script

For this script to successfully initialize the license, the license file must be called lservrc and
be located in the folder /Applications/Thermo-Calc-2017a.app/Contents/Resources or
/Applications/Thermo-Calc-2017a-Demo.app/Contents/Resources for demo installations.

Also see "Default Directory Locations" on page 14.

1. Open a terminal window. The Terminal application is in the /Applications/Utilities
folder.

2. At the prompt, enter this command:
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$ sudo /Applications/Thermo-Calc-
2017a.app/Contents/Resources/license-initialization-MacOS-x86_
64.sh

For demo installations, the path should be /Applications/Thermo-Calc-2017a-
Demo.app/Contents/Resources/ license-initialization-MacOS-x86_64.sh.

If you are not already logged in as an administrator, you probably cannot run the
sudo command. If this is the case, then you can use the su command in the terminal
window to login as an administrator. Contact your local system administrator for help.

3. Enter the administrator password and press Enter.

4. When you restart your computer and run the license initialization script, you are
ready to start using Thermo-Calc.

If you did not install a license file during this procedure, you can still start
Thermo-Calc although you will get the No license file found message.

Linux Installations: Running the License Initialization
Script
As part of a Standalone installation of Thermo-Calc, the Setup runs a license initialization
script. If you get a warning message during the standalone installation Unable to run post-
installation script, run the license initialization script as root after the installation, then you
need to manually run the script as root.

openSUSE Administration (sudo) Users

Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:

sudo ./linux-installation-x64-6.0.0.17347.run

When this command is used, you will do a text-based installation instead of having a
graphical interface to guide you. The information is the same, just without the user
interface.

How to Run the Script

For this script to successfully initialize the license, the license file must be called
lservrc and be located in the directory where you have installed Thermo-Calc.

Also see "Default Directory Locations" on page 14.
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1. In the console, go to the Thermo-Calc installation directory.

The default installation directory is /home/<user>/Thermo-Calc/2017a if you are
installing as a non-root user, where <user> is your user name. If you are installing as
root, then this directory is /usr/local/Thermo-Calc/2017a.

2. Enter this command:

$ sudo sh license-initialization-linux-x86_64.sh

If you are not able to execute the sudo command because you are not on the sudoers
list, you must log in as a root user with the command su, and then use sh to run the
license initialization script. For example, on a 64-bit computer, enter the following:

$ sh license-initialization-linux-x86_64.sh

3. Log out of Thermo-Calc and then log back in to save these changes.
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Uninstalling Thermo-Calc
In this section:

Uninstalling Thermo-Calc 60

Uninstalling Standalone Versions of TC-PRISMA 61
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Uninstalling Thermo-Calc

Windows 10

1. From the Control Panel Desktop app, go to Programs → Programs and Features →
Uninstall or change a program.

2. In the list of programs, locate the version of Thermo-Calc you want to uninstall. Click
to highlight that row.

3. Click Uninstall/Change.

4. In the Setup window, Uninstallation Mode dialog box, choose to uninstall the Entire
application or Individual components. Follow the instructions to finish.

Windows 7

1. From the Start menu, go to All Programs or All Apps → Thermo-Calc.

2. Click Uninstall-Thermo-Calc<version>.

3. In the Uninstallation Mode window, choose to uninstall the Entire application or
Individual components. Follow the instructions to finish.

Mac

Deleting the program from the Applications folder does not remove the program from your
operating system. Run the Uninstall-Thermo-Calc<version> program located in the
Applications folder. This is also applicable to the Demo version of the software.

1. Go to the Applications folder and double click the file that starts with Uninstall-
Thermo-Calc<version>. Enter the administrator’s user name and password.

2. Click Yes in answer to the question Do you want to uninstall Thermo-Calc and all of
its modules? Click No to quit.

3. The Uninstalling Thermo-Calc window shows the progress. Click OK when prompted.

Linux

1. To start the uninstallation procedure, in the Thermo-Calc installation directory use
the command
./uninstall-Thermo-Calc-2017a
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For Thin Client installations, use the command /uninstall-Thermo-Calc-Client-
2017a

2. To remove the whole application, including all its components, select Entire
application and click Forward, or to remove specific components, select Individual
components and click Forward.

If you intend to reinstall Thermo-Calc 2017a it is important to remove the
environmental variable TC70_HOME by logging out and back into the Linux user
account.

Uninstalling Standalone Versions of TC-PRISMA
As of Thermo-Calc version 2016a, TC-PRISMA is no longer a standalone
program. It is integrated into the Thermo-Calc Graphical Mode and considered
an add-on module called the Precipitation Module. It is also available for all
platforms (Windows, Mac and Linux). If you have older versions of the TC-
PRISMA software that you want to uninstall, follow these instructions.

1. Go to the Thermo-Calc uninstaller. For example, in Windows 7, go to Start → All
Programs → Thermo-Calc or in Windows 10 go to Start → All Apps → Thermo-Calc.

2. Click uninstall-Thermo-Calc-2015b (or the version of TC-PRISMA you have).

3. In the Setup window, click Individual components. Click Next.

4. Select the TC-PRISMA check box.
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5. Click Next and then OK when the software component is uninstalled.
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Quick Installation Guides
In this section:

Windows® Standalone Quick Install Guide 64

Request a License File 64

Install the Software 66

Mac OS® Standalone Quick Install Guide 68

Request a License File 68

Install the Software 69
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Windows® Standalone Quick Install Guide
This quick guide helps you do a typical, custom or demo standalone installation. A
standalone installation is used with the Single-User Node-Locked License (SUNLL), where the
software and the license file are together on one computer.

This guide is applicable to:

l Windows operating systems

l Standalone installation (SUNLL) –typical and custom types

l Demo installations – during the installation process you only need to do steps 2 and
3.

l Upgrading to a new standalone version of Thermo-Calc (maintenance plan only)

Also see the Thermo-Calc Installation Guide for detailed instructions for other
operating systems and network installations.

Request a License File

Demo (trial) installations: Skip this section. A license file is automatically
installed with the software. You do not need to request it.

Upgrades to a new version of Thermo-Calc: Skip this section if you are
upgrading to a new version of Thermo-Calc and (and you have a maintenance
plan). Your license is sent to you in an email from Thermo-Calc Software AB.
Save it to your computer to use during software installation.

1. Go to Thermo-Calc's website (or click the link sent by email).

2. Under TCLOG (Thermo-Calc version S) →Windows computers click the link tclog
for Windows computers.

3. Click the Save file button and OK to download and save the tclog.zip file.

4. Unzip and extract the files.

5. Double-click to open the main folder of the downloaded file. Right-click the tclog.bat
file and select Run as administrator.

http://www.thermocalc.com/support/request-support/diagnostic-tools/
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6. Double-click the tclog.bat file. Click Run. This starts the diagnostic tool and creates a
tclog.log text file in the same directory.

7. Send an email to support@thermocalc.com and attach the tclog.log file. Make sure
to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.

8. A representative from Thermo-Calc Software replies to the email and attaches your
license file(s).

9. Save the license file(s) to your computer or network.

mailto:support@thermocalc.com
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Install the Software

Step 1: Download and run your Thermo-Calc installation software

1. Open the Windows folder then right-click the .exe file. Choose Save target as and
save it to your computer. Double-click the .exe file to launch the Setup program.

2. On the Setup-Thermo-Calc window click Next.

3. On the License Agreement window click to accept the license agreement. Click
Next.

Demo (trial) installations: Your installation starts and is done when the
Completing the Thermo-Calc Demo Setup Wizard opens. Click Finish and start
using Thermo-Calc.

Step 2: Select the installation mode – typical or custom

1. In the Select installation mode window click Typical Standalone or Custom to
choose specific features to install.

The Custom option appears greyed out, but it is available to select.

2. For a Typical Standalone installation, in the Choose a license file field click the file

button to navigate to where you saved the license file emailed to you from
Thermo-Calc Software. The license file is called lservrc. Click Next.

DEMO Typical Standalone installations: Your installation starts and is done
when the Completing the Thermo-Calc Demo Setup Wizard opens. Click Finish
and reboot your computer to start using Thermo-Calc.
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Step 3: Customize your installation

1. In the Select Components window, click to select what you want to install. Click
Next.

2. In the Installation Directory window, either accept the default, enter a file path or
click the file button to navigate to another directory.

3. In the Choose Setup Type window it defaults to Standalone. In the Choose a license

file field you can accept the default file path or click the file button  to navigate
to, where you saved the license file emailed to you from Thermo-Calc Software
(called lservrc). Click Next.

4. In the Specify Configuration window, the default is Current user only, meaning the
installation is only available for the person logged in and installing the software.
Select All users to allow anyone using this computer to access Thermo-Calc. By
default, the Create Shortcuts on Desktop check box is selected. Click Next.
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5. In the Ready to Install window click Next. Click Finish and start using Thermo-Calc.

Mac OS® Standalone Quick Install Guide
This quick guide helps you do a typical or demo standalone installation. A standalone
installation is used with the Single-User Node-Locked License (SUNLL), where the software
and the license file are together on one computer.

This guide is applicable to:

l Mac operating systems

l A typical Standalone installation (SUNLL)

l Demo installations – during the installation process you only need to do steps 1 and
2.

l Upgrading to a new standalone version of Thermo-Calc (maintenance plan only)

Also see the Thermo-Calc Installation Guide for detailed instructions for other
operating systems and network installations.

Request a License File

Demo (trial) installations: Skip this section. A license file is automatically
installed with the software. You do not need to request it.

Upgrades to a new version of Thermo-Calc: Skip this section if you are
upgrading to a new version of Thermo-Calc and (and you have a maintenance
plan). Your license is sent to you in an email from Thermo-Calc Software AB.
Save it to your computer to use during software installation.

1. From the Apple main menu, select System Preferences.

2. Click Network.
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3. In the left column select Ethernet or Built-in Ethernet (do not select a WiFi
connection as a local static MAC address is required).

4. Click Advanced → Hardware.
The Network window shows you the MAC Address. For example, the MAC address
(the host ID) might be 3c:07:54:28:5f:72.

5. Send an email to support@thermocalc.com and copy and paste the MAC address into
the body of the email. Make sure to include the following in the subject line:

License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.

6. A representative from Thermo-Calc Software replies to the email address provided
and attaches your license file or files.

7. Save your license file to your computer or network.

Install the Software

Step 1: Download and install XQuartz

The XQuartz open-source X Windows system is required to run Thermo-Calc on Mac OS X.

mailto:support@thermocalc.com


Thermo-Calc Installation Documentation Set

Step 2: Download and run your Thermo-Calc installation software ǀ 70 of 71

1. In a web browser go to https://www.macupdate.com or to download it directly from
XQuartz, http://xquartz.macosforge.org/landing/.

2. In the Search Mac Apps field, enter XQuartz.

3. Click the XQuartz search result. For example, based on the recent version, the name is
XQuartz-2.7.7.dmg.

4. Click Download.

5. Double-click the XQuartz.pkg file. Follow the instructions.

6. Click OK when the message about logging out displays and click Close when the
installation is successful.

Step 2: Download and run your Thermo-Calc installation software

1. Open the Mac folder and right-click the file Thermo-Calc-2017a-osx.app. Choose
Download Linked File and save the installation file to your Downloads directory.

2. Unzip the file.

3. On the Setup-Thermo-Calc window click Next.

4. On the License Agreement window click to accept the license agreement. Click
Next.

Demo (trial) installations: Your installation starts and is done when the
Completing the Thermo-Calc Demo Setup Wizard opens. Click Finish and
reboot your computer to start using Thermo-Calc.

https://www.macupdate.com/
http://xquartz.macosforge.org/landing/
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Step 3: Select the installation mode

1. In the Select installation mode window click Typical Standalone.

2. In the Choose a license file field click the file button to navigate to where you
saved the license file emailed to you from Thermo-Calc Software. The license file is
called lservrc. Click Next.

To prevent errors, leave this field blank if you did not get a license file yet.

3. The installation starts and is done when the Completing the Thermo-Calc Setup
Wizard window opens.

4. Click Finish and start using Thermo-Calc.
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Introduction to Thermo-Calc
This guide is an introduction to working with both Graphical Mode and Console Mode in
Thermo-Calc.

In this section:

The Thermo-Calc Software 3
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About the File Types and Formats 7
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The Thermo-Calc Software
The Thermo-Calc software is a sophisticated database and programming interface package
used to perform thermodynamic calculations. It can calculate complex homogeneous and
heterogeneous phase equilibria, and then plot the results as property diagrams and phase
diagrams.

The Thermo-Calc software (also referred to as the Thermo-Calc program or the software to
distinguish it from the company name) fully supports stoichiometric and non-ideal solution
models and databases. These models and databases can be used to make calculations on a
large variety of materials such as steels, alloys, slags, salts, ceramics, solders, polymers,
subcritical aqueous solutions, supercritical electrolyte solutions, non-ideal gases and
hydrothermal fluids or organic substances. The calculations take into account a wide range
of temperature, pressure and compositions conditions.

Add-on modules

The Thermo-Calc program also includes add-on modules:

The Diffusion Module (DICTRA)and DIC_PARROT is used to simulate diffusion
controlled transformations in multicomponent systems.

The Precipitation Module (TC-PRISMA)is used to simulate diffusion controlled
multi-particle precipitation process in multicomponent and multi-phase alloy
systems.

Use online help for information about how to use Diffusion Module (DICTRA)
and Precipitation Module (TC-PRISMA).

Typographical Conventions
The following typographical conventions are used throughout the documentation.

Text

Convention Definition

Forward arrow
symbol →

The forward arrow symbol → instructs you to select a series of
menu items in a specific order. For example, Tools → Options is
equivalent to: From the Toolsmenu, select Options.



Thermo-Calc Documentation Set

Introduction to Thermo-Calc ǀ 4 of 238

Convention Definition

Boldface font

A boldface font indicates that the given word(s) are shown that
way on a toolbar button or as a menu selection. For example, if
you are told to select a menu item in a particular order, such as
Tools→Options, or to click Save.

Italic font
An italic font in the body of the text indicates the introduction of
important terminology. Expect to find an explanation in the same
paragraph or elsewhere in the guide.

COMMAND

For features in Thermo-Calc that use Console Mode (i.e. the
command line), this font and all capital letters indicates that this
is a Console Mode COMMAND. Examples of how you can use a
command are written with code font. For example:

Use DEFINE_ELEMENTS followed by a list of the elements that you
want in your system. (To list the elements that are available in
your current database, use LIST_DATABASE and choose Elements).

HELP

Text in blue and underline and a page number is a link to another
topic in the current or referenced guide. Command names are
often also topics. Clicking the link takes you to more detail about a
particular command or subject in the PDF or documentation set.

<Enter>
Text with <angle brackets> indicates a keyboard entry. Usually to
press <Enter> (or Return) or to use a series of keys such as <Ctrl +
S>.

code and code
bold

A code font shows a programming code or code example. The
code bold font highlights the entry.
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Icons

Convention Definition

Important Provides important information. It is recommended
that you read the text or follow the link.

Note
The information can be of use to you. It is
recommended that you read the text or follow the
link to more information.

Also see
Go to the link or guide to see more general
information about the topic being discussed.

Examples Go to the example collection to learn more.

Console Mode
This note relates specifically to something in Console
Mode.

Graphical Mode
This note relates specifically to something in
Graphical Mode.

Diffusion Module
This indicates that the information relates to the add-
on Diffusion (DICTRA) Module.

Precipitation
Module

This indicates that the information relates to the add-
on Precipitation Module.

Graphical Mode vs Console Mode
There are two interfaces available in Thermo-Calc: Graphical Mode with a graphical user
interface (GUI) and Console Mode, which uses a command line interface. Thermo-Calc and
the Diffusion Module (DICTRA) are available in both modes, and the Precipitation Module
(TC-PRISMA) is only available in Graphical Mode.
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In Graphical Mode calculations are set up, carried out, and visualized as part of
a project. The steps in the project are performed with activities. There are
templates and a Wizard available to guide you through the process of defining
the project.

In Console Mode you work withmodules, which are managed using commands
typed at a prompt. Some modules, called response-driven modules, ask you a
series of questions that typically take you through the process of defining your
system, setting calculation conditions, performing calculations and plotting the
results.

Switching between modes

The first time you open Thermo-Calc, it defaults to Graphical Mode. For any future instance
it defaults to the last mode used.

Along the top of the GUI is the GRAPHICAL MODE TOOLBAR where you switch between modes.

In Console Mode, except for the SWITCH TO GRAPHICAL MODE button, the toolbar is not used.

See "Main Menu and Toolbar" on page 37 in the Thermo-Calc User Guide for
information about the Tools, Window and Help menus, which are available in
both modes.

File extensions

The file extensions are different based on the mode you are in (Graphical vs. Console). In
Console Mode the extensions are also based on whether you are working with Thermo-Calc
or the Diffusion Module (DICTRA).

In Graphical Mode, the Thermo-Calc project files have the extension *.tcu. This
includes the examples for the add-on Diffusion Module (DICTRA) and
Precipitation Module (TC-PRISMA).
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In Console Mode, Thermo-Calc macro files have a *.TCM extension and the
Diffusion Module (DICTRA) file extension is *.DCM. In addition to macro files in
Console Mode the are also Log files andWorkspace files, which also differ.

Can I work with both modes at the same time?

The two modes can be run simultaneously, but there is no communication between them.
What you do in Graphical Mode does not affect the state of the Console Mode session and
vice versa. One exception is the plot settings. See "Global Settings: Graphical and Console
Mode-Plotting" on page 233 in the Thermo-Calc User Guide.

Data optimization and thermodynamic / kinetic assessments

Although many calculations can be done in either mode, data optimization and
thermodynamic or kinetic assessments are only available in Console Mode.

About the File Types and Formats
The file formats (and the file extensions / suffixes) are based on whether you are working in
Graphical or Console Mode, and in Console Mode, whether you are working with Thermo-
Calc and/or the Diffusion Module (DICTRA).

Graphical Mode
In Graphical Mode you work with one file type, a project file, which has a *.tcu file
extension. This is applicable to Thermo-Calc and the add-on modules.

Console Mode
In Console Mode there are file types (macro, log and workspace) and extensions (TCM, LOG,
POLY3, GES5, PAR and POP) to be aware of. For Thermo-Calc Console Mode the file types
are described in "Log, Macro and Workspace Files" on page 159 in this guide.

For DICTRA Console Mode see File Formats as described in the Diffusion Module
(DICTRA) User Guide.

Opening Graphical Mode Project Files

"Opening Console Mode Macro Files" on the next page

How to Open any Project File

There are different ways to open project files.
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In Thermo-Calc:

l From the main menu select File → Open Project.

l On the toolbar, click the Open button or press <Ctrl+O> on the keyboard. Then
navigate to the file on your computer and click Open.

On your computer:

l Navigate to the project file and double-click to open it.

How to Open an example project

To open an example project file for Thermo-Calc and the add-on Diffusion Module (DICTRA)
and/or Precipitation Module (TC-PRISMA):

1. Open Thermo-Calc.

2. Confirm you are in Graphical Mode. If not, click the Switch to Graphical Mode
button.

3. From the main menu, select File → Open Examples or Help → Open Examples.

4. Navigate to the project file you want and double-click to open.

5. The Graphical Mode examples are stored without calculated results so you will want
to run the example calculation and generate a plot or table. To do this, click the first
node in the tree at the top of the Project window. Then right-click and select
Perform now.

Opening Console Mode Macro Files

"Opening Graphical Mode Project Files" on the previous page

How to Open Macro Files

The macro files (with the extension *.TCM) include comments, which you can
either run in Thermo-Calc or open and read in a text editor.
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You can open the macro files (*.TCM or *.DCM files) in different ways.

l From the main menu,

l Using a command,

l By dragging and dropping the file into the Console window, or

l Navigate to the file location on your computer and double-click to open it. If you
already have Thermo-Calc open, this opens a new instance of the software.

l You can also read the commands listed in the macro file using a text editor.

If you only open and read the macro file in a text editor, you do not see the
output that Thermo-Calc gives in response to the commands stored in the
macro file.

How to Open a macro From the Main Menu

To open an example macro file for Thermo-Calc:

1. Open Thermo-Calc.

2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.

3. From the main menu, select File → Open Examples or Help → Open Examples. The
Console Mode folder opens with the Thermo-Calc examples in separate folders.

For the Diffusion Module (DICTRA) examples (*.DCM macro files), click the Up

One Level button and then double click the DICTRA folder.

4. In the folder, double-click the *.TCM file or click Open.

5. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the
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macro and produce a plot in the Console Results window.

How to open a macro Using a Command

At the SYS prompt, type MACRO_FILE_OPEN and press <Enter>. In the file dialogue window
that opens, navigate to and select the macro file to open.

how to Drag and Drop a Macro File into the Console Window

For example, on your computer, navigate to the examples folder. Drag the file from its
location into the Thermo-Calc Console window. When you release (drop) the file, the macro
starts running. Follow the prompts in the Console window i.e. keep pressing <Enter> to run
the macro and produce a plot in the Console Results window.

EXAMPLE
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Examples, Manuals and Materials Folders
There are several ways to access the examples, manuals (containing PDF documentation)
and materials data folders.

Main
Menu

System
Definer

From the
Windows Start
Menu

On your
computer Website

Manuals (PDF
documentation) x - x x x

Examples (project
and macro files) x - x x x

Materials - x x x x

From the Main Menu

Once your Thermo-Calc software is installed you can open the Examples and PDF
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documentation (Manuals) from the main menu:

l To open the PDF documentation select Help → Open Manuals Folder. See "About
the PDF Documentation" on page 15. Note for Linux openSUSE users:1

l To open the Examples based on whether you are in Console Mode or Graphical
Mode, select File → Open Examples or Help → Open Examples.

1This link is not functional. To access the folder, navigate to the default location based on your installation type.
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From the System Definer (Materials Only)

When you are working with the "System Definer" on page 61 you can open the default
Materials folder included with your installation.

At the bottom of the window under Material, click Load material to navigate to a material
file.

EXAMPLE
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Start Menu (Windows Only)

On Windows, once Thermo-Calc is installed, you can locate the Examples and Materials
folders, plus all the Manuals using the shortcuts located in the Start menu. Go to Start → All
Programs or All Apps → Thermo-Calc and click Examples, Manuals, or Materials as
required to open the applicable folder.

On Your Computer (All Operating Systems)

The PDFs, example files and materials xml files are included with your installation in a folder
location based on the operating system.

In the table, <user> stands for the username and <version> for the version of Thermo-Calc,
for example 2017a.

OS User type Default directory

Windows

Normal user

Users\<user>\Thermo-Calc\<version>

Users\<user>\Documents\Thermo- Calc\<version>

My documents

Administrator

Program Files\Thermo-Calc\<version>

Users\Public\Documents\Thermo- Calc\<version>

Public documents

Mac
Administrator (user
name and password
required)

Examples and manuals in /Users/Shared/Thermo-
Calc/<version>

To go to this folder, in Finder, from the Go main
menu select Go to folder. Enter the above file path
and click Go.

Linux
Non root user home/<user>/Thermo-Calc/<version>

Root user usr/local/Thermo-Calc/<version>

Website

You can download the PDF documentation and examples from the website.
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1. Go to http://www.thermocalc.com/.

2. From the menu, select Support → Documentation and navigate to the applicable
section.

About the PDF Documentation

There is PDF documentation available as part of your installation. This is the same
information as that contained in the online help, just in a different format.

"Examples, Manuals and Materials Folders" on page 11

Database Information Sheets

The database information sheets are included in the online help system and in a Manuals
sub-folder. You can also download these from the Thermo-Calc website.

PDF Documentation Sets and Guides

l Installation Guides: Includes the quick install guides for Standalone Windows and
Mac installations as well as the full installation guide for all platforms and
installation types.

l Thermo-Calc Documentation Set: Includes all the manuals needed to work with
Thermo-Calc including the installation guides, Thermo-Calc User Guide, Console
Mode Command Reference, Graphical Mode Examples Guide, Data Optimization
User Guide, Database Manager User Guide, and the DATAPLOT User Guide. It also
includes a copy of the Property Model Development Framework Guide.

l Property Model Development Framework: This PDF guide contains details about
setting up a development environment so you can build custom property models in
Thermo-Calc.

l Diffusion Module (DICTRA) Documentation Set: This add-on module is used for
accurate simulation of diffusion controlled reactions in multi-component alloy
systems, which is based on numerical solution of the multi-component diffusion
equations. The documentation set includes Diffusion Module (DICTRA)-specific
manuals plus the Thermo-Calc User Guide, Console Mode Command Reference, Data
Optimization User Guide, Database Manager User Guide, and the DATAPLOT User
Guide.

l Precipitation Module (TC-PRISMA) User Guide: This add-on module treats
concurrent nucleation, growth/dissolution and coarsening under arbitrary heat
treatment conditions in multi-component and multi-phase systems using Langer-
Schwartz theory and the Kampmann-Wagner numerical approach.

http://www.thermocalc.com/
http://www.thermocalc.com/products-services/databases/
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l TQ-Interface Programmer Guide: The TQ-Interface is available as a way to make
Thermo-Calc an integral part of application programs such as those for process
simulation, microstructure evolution modeling and materials property prediction.

l TC Toolbox for MATLAB® Programmer Guide: Use this to enable communication
between Thermo-Calc and MATLAB to be able to retrieve thermodynamic and kinetic
quantities.

l TC-API Programmer Guide: This is the Thermo-Calc API that can be used by
programmers to set up your own applications to work with Thermo-Calc.

About the Examples

To learn more about how to use the software you can open and run the example projects
(Graphical Mode) and macro files (Console Mode).

Graphical Mode Examples

Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module
(DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files
(*.tcu) and are included together in the same folder.

A brief description of all the examples, and how to access them, is in the Graphical Mode
Examples Guide, which you can find in this documentation set or by searching the online
help.

Console Mode Examples

Console Mode examples are available for Thermo-Calc and the Diffusion Module (DICTRA).
The macro files are in the format of *.TCM and .DCM, respectively.

There are other file types when you are working in Console Mode. See
"Thermo-Calc Console Mode File Types" on page 2 in the Console Mode
Command Reference, and About the File Formats in the Diffusion Module
Quick Start Guide.
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Thermo-Calc Examples

A brief description of the Thermo-Calc examples, and how to access them, is in "About the
Thermo-Calc Console Mode Examples " on page 2 in the Thermo-Calc Console Mode
Examples Guide.

Diffusion Module (DICTRA) Examples

A brief description of the Diffusion Module examples (both Graphical Mode and Console
Mode), and how to access them, is in the Diffusion Module (DICTRA) Examples Guide.

TQ-Interface and TC-Toolbox for MATLAB Examples

There are examples for the TQ-Interface and TC-Toolbox for MATLAB available as described
in "Examples, Manuals and Materials Folders" on page 11. You can also find information
about these in the respective user guides or by searching the online help.

About the Material Files

"Examples, Manuals and Materials Folders" on page 11

When you are working with the "System Definer" on page 61 you can open the default
Materials folder included with your installation. The files are in .xml format and the data
contained are from some common alloys. You can also save and create your own materials
files from the System Definer, or copy the xml files to the Materials folder.

Aluminum Alloys

Alloy

UNS_A95005

UNS_A96053

Cast Iron Alloys

Alloy

UNS_F10007
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Alloy

UNS_F33101
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Nickel Alloys

Alloy

UNS_N06600

UNS_N6600

UNS_N06625

UNS_N06690

UNS_N07001

UNS_N07718

UNS_N08800

UNS_N08825



Thermo-Calc Documentation Set

Introduction to Thermo-Calc ǀ 20 of 238

Solder Alloys

Alloy

ASTM_25A

ASTM_96TS

UNS_L50134

UNS_L54321

Steel Alloys

Alloy

Austenitic Stainless Steel

ASTM_304_(UNS_S30400)

ASTM_304L_(UNS_S30403)

ASTM_304LN_(UNS_S30453)

ASTM_316_(UNS_S31600)

ASTM_316L_(UNS_S31603)

ASTM_316LN_(UNS_S31653)

ASTM_317L_(UNS_S31703)

UNS_J92710

UNS_S30908

Duplex Stainless Steel
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Alloy

UNS_S31803_A

UNS_S32750_A

UNS_S32750_B

High Speed Steel

ASTM_M10_A5

High Temperature Steel

UNS_S31008

HSLA Steel

UNS_K12000

Low Carbon Steel

UNS_H61180

Maraging Steel

UNS_K92810

Martensitic Stainless Steel

ASTM_420

UNS_J82090

UNS_J91639

UNS_S44004
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Alloy

Tool Steel

UNS_T30106

UNS_T30109

UNS_T51620

Training Steel

Ferritic

M7_Steel
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Titanium Alloys

Alloy

UNS_R54520

UNS_R56260

My Materials

This is where you can add your own material files to be able to load it to the System Definer.
When you are in the System Definer Configuration window, you define your material then
click Save material as. You can save the profile to this folder or create a folder with a new
name.

Help Resources

'Online' Help: No Internet Required

To access online help in a browser, open Thermo-Calc and select Help → Online Help. The
content opens in a browser but uses local content so you don't need an Internet connection
except links to external websites.

Context Help (Graphical Mode Only)

When you are in Graphical Mode, you can access feature help (also called topic-
sensitive or context help) for the activity nodes in the tree.

1. In the Project window, click a node. For example, System Definer.

2. In the lower left corner of the Configuration window, click the help button .
3. The Help window opens to the relevant topic.
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The window that opens has the same content as the help you access in the browser. There
are these extra navigation buttons in this view.

l Use the buttons on the bottom of the window, ,
to navigate Back and Forward (these are only active once you have started using the
help to load pages and create a history), to Close the window, and Reload the
original content.

Console Mode Help

Console Mode is for Thermo-Calc and the Diffusion Module (DICTRA).

In Console Mode at the command line prompt, you can access help in these ways:

l For a list of all the available commands in the current module, at the prompt type a
question mark (?) and press <Enter>.

l For a description of a specific command, type Help followed by the name of the
command. You can only get online help about a command related to the current
module you are in.

l For general system information type Information. Specify the subject or type ? and
the available subjects are listed. This subject list is specific to the current module.

The Thermo-Calc Modules and Activities
Although many calculations can be done in either Graphical or Console Mode,
only data optimization and thermodynamic or kinetic assessments are available
in Console Mode. Conversely, only the Property Model Calculator is available in
Graphical Mode.
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For the Console Mode only commands see "The Console Mode Interface" on
page 145 and the Thermo-Calc Console Mode Command Reference included
with this documentation set.

Modules and Activities briefly describes the available modules. The specific modules, using
the names in the table, are accessed through Console Mode. For Graphical Mode, the
underlying principles, and the final calculations, are incorporated into the projects and
activities. Some modules require additional licenses.

Modules and Activities

The first and second columns are the Console Mode module names. The third column
indicates whether there is an equivalent activity available in Graphical mode.

Full Module
Name in
Console Mode

Short Name
Graphical
Mode
Activity

Primary Functions

BINARY_
DIAGRAM_
EASY

BIN
"Binary
Calculator"
on page 137

Calculate binary phase diagrams.
Access to specific databases
designed for BIN, such as TCBIN, is
required.

DATABASE_
RETRIEVAL DATA

"System
Definer" on
page 61

Select appropriate databases, define
chemical systems and retrieve the
data required for calculations.

DICTRA_
MONITOR DICTRA

"Diffusion
Calculator"
on page 91

Run simulations of diffusion
controlled transformations in
Thermo-Calc using the Diffusion
Module (DICTRA). An additional
license is required for this feature.

DIC_PARROT DIC_
PARROT

Console
Mode only

This is the data optimization module
for the Diffusion Module (DICTRA).
It allows you to assess experimental
data and use such data to optimize
calculations. An additional license is
required for this feature.
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Full Module
Name in
Console Mode

Short Name
Graphical
Mode
Activity

Primary Functions

EDIT_
EXPERIMENTS ED_EXP Console

Mode only

Part of the PARROT submodule, use
it to edit experimental data points
to make reliable optimizations.

GIBBS_
ENERGY_
SYSTEM

GIBBS Console
Mode only

Handles thermodynamic models and
quantities. Generally you do not
need to use this module, but you can
get information about models, and
list, add or amend the
thermodynamic parameters in use.

PARROT PARROT Console
Mode only

A data optimization module to
assess experimental data and use
the data to optimize calculations.

not available -
"Precipitation
Calculator"
on page 103

Set the conditions for, and perform,
a precipitation calculation.

not available -

"Property
Model
Calculator"
on page 68

You can evaluate models
simultaneously over a range of
compositions and cross plot the
results. You can then conduct an
uncertainty analysis and plot the
results as either a histogram or as a
probability plot.

POLY-3 POLY
"Equilibrium
Calculator"
on page 82

Equilibrium calculation module.
Specify conditions and make
calculations.

POST_
PROCESSOR POST

"Plot
Renderer" on
page 108

For post-processing and plotting of
calculation results. Modify property
and phase diagrams, add labels,
change the diagram colours, etc.
Submodules to POLY-3 and
DICTRA module for example.
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Full Module
Name in
Console Mode

Short Name
Graphical
Mode
Activity

Primary Functions

POTENTIAL_
DIAGRAM POTENTIAL

"Ternary
Calculator"
on page 139

Calculate and plot gas potential
diagrams in a ternary system. The
potential of two gas species are
used as the diagram axes.

POURBAIX_
DIAGRAM POURBAIX Console

Mode only

Calculate and plot pH-Eh diagrams
(Pourbaix diagrams) and property
diagrams for heterogeneous
interaction systems involving
aqueous solutions.

REACTOR_
SIMULATOR_3 REACTOR Console

Mode only

Simulate chemical reaction
processes in several feed-forward
steady-state stages or in several
dynamic stages.

SCHEIL_
SIMULATION SCHEIL

"Scheil
Calculator"
on page 141

Simulate and plot Scheil-Gulliver
solidification processes with no
diffusion in the solid phases and
with/without consideration of back
diffusion of interstitial components
(such as C, N, O, S).

SYSTEM_
UTILITIES SYS Console

Mode only

In Console Mode, interact with the
operating system and change
environmental settings. Create and
execute MACRO files.

TABULATE_
REACTION TAB Console

Mode only

Tabulate properties of chemical
reactions and substances
(stoichiometric or solution phases).

TERNARY_
DIAGRAM TERN

"Ternary
Calculator"
on page 139

Calculate ternary phase diagrams.
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Displaying Thermo-Calc License Information
You can start (and install) the software without a valid Thermo-Calc license but you cannot
do any calculations. To show information about the available and installed licenses, from the
main menu select Help → Show License Info.

Also see the Thermo-Calc Installation Guide.

This is an example of part of a License Information window for a local installation.

For a network license, under each license type with instances checked out, there is a list of
who checked out each license.

In Graphical Mode, an instance is checked out when an Equilibrium Calculator
activity is created, and checked back in when that Equilibrium Calculator is
removed.

In Console Mode, an instance is checked out when you enter the POLY module
and is checked back in when you exit the POLY module. In the example, two
users, amanda and nli, have licenses checked out.

l The Features column is a list of the specific software, databases and API licenses
purchases.

l The Version is an internal version number for the feature.

l The number of licenses column is how many instances of each license type available
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to be checked out simultaneously.

l The in use column shows how many license instances are checked out.

Console Mode License Restrictions

l If you start Thermo-Calc without a valid Thermo-Calc license you cannot leave the
SYS module.

l If all the licenses are checked out for a network client installation of Thermo-Calc,
you may not be able to enter the POLY or DICTRA modules until a license is available.

l To enter the DICTRA and the DIC_PARROT modules, you need a valid Diffusion
Module (DICTRA) license key.

l If you enter and use either the DIC_PARROT module or the PARROT module, then
you cannot enter the other module in the same session. You must close down
Thermo-Calc and launch the program again to enter the other data optimization
module.

Network Computer License Restriction

If you have a network computer installation of Thermo-Calc, then you may not be able to do
any calculations even if you have access to a valid network license file. This is because
others who are part of your network installation may have checked out all allowed instances
of the software.

If you are running a network installation of Thermo-Calc, you can see how many instances of
the client licenses are currently checked out and how many of them are left. You can also
see which client computers have checked out the licenses.

Using This Guide
If you are a new user, Graphical Mode is a good way to learn how to work with Thermo-
Calc. Depending on what you want to simulate, Console Mode can have more functionality
but until you are comfortable with the concepts, it is recommended you start in Graphical
Mode.

Additional documentation and training material is described in "Help Resources"
on page 23.

Graphical Mode

"The Graphical Mode Interface" on page 31 introduces you to the GUI layout and the
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workflow. In "Graphical Mode Projects" on page 50, it goes into more detail about how to
set up and run your projects (with the Quick Start Wizard), using templates, scheduling jobs
and creating activities. "Graphical Mode Activities" on page 60 specifically describes how to
set up each type of available activity in the tree structure.

For both Graphical and Console mode, "Changing Global Settings" on page 223 gives
information about adjusting global user settings.

Console Mode

In general, Console Mode has more functionality than Graphical Mode but the underlying
concepts are the same. There are, however, command lines and extensive details applicable
to this mode. This guide is only the beginning of the learning objectives. In particular, refer
to the Thermo-Calc Console Mode Command Reference for details about all the commands
available.

In this guide it is a basic introduction to the layout of the Command windows, as described in
"The Console Mode Interface" on page 145.

Several topics describe and give an example of the calculation types:

l "Equilibrium Calculations" on page 168

l "Property Diagrams" on page 173

l "Phase Diagrams" on page 177

l "Scheil Simulations" on page 181

l "T0 Temperature Simulations" on page 187

l "Paraequilibrium" on page 190

l "Potential Diagrams" on page 194

l "Aqueous Solutions" on page 198

l "Console Mode TAB Module" on page 208

Then in "Console Mode POST Module" on page 213 there is an overview of plotting.

For both Graphical and Console mode, "Changing Global Settings" on page 223 gives
information about adjusting global user settings.
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The Graphical Mode Interface
These topics introduce you to the concepts and terminology of Graphical Mode and describe
the basic workflow.

In this section:

The GUI Layout 32

Project Activities and the Tree Structure 33

Activity Successor and Predecessor Nodes 34

Creating Activities and Successors 35

Graphical Mode Workflow 37

Main Menu and Toolbar 37

Graphical Mode Menu and Toolbar Options 38

Saving and Opening Project Files 40

Project Activity Nodes 40

Project and Activity Menus 42

Organising the Windows on the Desktop 45

Moving Nodes in the Tree and Using the Grid 46

Zooming In and Out 47

Node Status Markers 48
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The GUI Layout
Open Thermo-Calc to view the default GUI layout for Graphical Mode. You can easily
reorganize the windows.

Also see "Organising the Windows on the Desktop" on page 45.

The windows are:

1. Project: Create, manipulate and navigate between the activities that make up a
project.

2. Configuration: Shows the settings that can be configured for the currently selected
activity.

3. Results: Shows the results of a calculation, either plotted as a diagram or displayed
in table format. In this example, there is a Plot Renderer tab in the Results window.

4. Scheduler: Displays information about jobs, such as calculations, that are being
performed or are scheduled to be performed. You can cancel scheduled jobs and if a
job has failed, then you can view information about the error.

5. Event Log: By default this window is closed but it displays during calculation
processes. You can always open it to view progress of calculations and to
troubleshoot.

Graphical Mode Windows

In this example, the Results window also has a Plot Renderer tab. You can also have a Table
Renderer tab.
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Project Activities and the Tree Structure
In a project, a set of linked activities is called a tree. A result calculated within a tree is fed
as input into the next activity in the tree. Consequently, if you have an Equilibrium Calculator
with another Equilibrium Calculator as its successor, the successor takes the calculation
results of the predecessor as the starting values for its calculation. When working with
activities in the Project window these are also referred to as nodes (or activity nodes) in the
tree structure.

Also see "Activity Successor and Predecessor Nodes" on the next page for
definitions.

The example below shows a My Project node with two trees. In each tree, settings and
calculation results are propagated downward until the calculation and the visualisation of
the results are completed in the Plot Renderer nodes.

The system definitions, settings and calculation results of the two trees are independent of
each other.

EXAMPLE
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Activity Successor and Predecessor Nodes
An activity node located below another activity node in a tree is referred to as that activity’s
successor. An activity located above another activity is called that activity’s predecessor. A
predecessor is performed before the predecessor’s successors and its result is fed forward to
any successor activities.

EXAMPLE

For example, to calculate and display a phase diagram, create a branch with three linked
activities: A System Definer activity linked to an Equilibrium Calculator activity, which in turn
is connected to a Plot Renderer activity.

See the example below that shows that Binary Calculator 1 is a predecessor to the
successors, Plot Renderer 2 and Table Render 1.

You can determine the available successors by right-clicking a node in the Project window
and choosing options from the menus.
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EXAMPLE

Also see "Creating Activities and Successors" below.

Creating Activities and Successors
You can create a new activity in these ways:

l In the Project window, right-click an activity and choose Create New Activity (My
Project node only) or Create New Successor (all other nodes).

l Select the activity you want to create from the submenu.

l At the bottom of the Configuration window, click Create New Activity or Create
New Successor and select the activity to create.

Predecessors and Successors by Activity

Activity Possible Predecessors Possible Successors

My Project None; this is the first node
of the tree structure

System Definer, Binary Calculator,
Ternary Calculator, Experimental
File Reader. Also choose
templates from this level.

"System Definer" on
page 61

My Project, System
Definer

Property Model Calculator,
Equilibrium Calculator,
Precipitation Calculator, Scheil
Calculator
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Activity Possible Predecessors Possible Successors

"Property Model
Calculator" on
page 68

System Definer Plot Renderer, Table Renderer

"Equilibrium
Calculator" on
page 82

System Definer,
Equilibrium Calculator

Equilibrium Calculator, Plot
Renderer, Table Renderer

"Precipitation
Calculator" on
page 103

System Definer Plot Renderer, Table Renderer

"Diffusion
Calculator" on
page 91

System Definer Plot Renderer

"Plot Renderer" on
page 108

Property Model
Calculator, Equilibrium
Calculator, Precipitation
Calculator, Diffusion
Calculator, Binary
Calculator, Ternary
Calculator, Scheil
Calculator, Experimental
File Reader

None

"Table Renderer" on
page 133

Equilibrium Calculator,
Property Model
Calculator, Precipitation
Calculator, Binary
Calculator, Scheil
Calculator

None

"Experimental File
Reader" on page 136 My Project Plot Renderer

"Binary Calculator"
on page 137 My Project Plot Renderer, Table Renderer
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Activity Possible Predecessors Possible Successors

"Ternary Calculator"
on page 139 My Project Plot Renderer

"Scheil Calculator"
on page 141 System Definer Plot Renderer, Table Renderer

Graphical Mode Workflow
You can set up a tree in the Project window (starting with the My Project node) and then
perform all the activities at once, or create and perform one activity at a time.

The typical workflow is to:

1. Define a System: Create a "System Definer" on page 61 activity (in the Project
window) where you select a database and the elements to have as system
components (in the Configuration window).

2. Set up and run a calculation: Create an "Equilibrium Calculator" on page 82 activity
(a successor to the System Definer), where calculation conditions are set
(temperature, pressure, etc.). This is where axis variables are set to create a
property or phase diagram. These settings are also made in the Configuration
window. You can also add a "Property Model Calculator" on page 68, "Precipitation
Calculator" on page 103, "Diffusion Calculator" on page 91 or "Scheil Calculator" on
page 141.

3. Visualize the results: Create either a "Plot Renderer" on page 108 or a "Table
Renderer" on page 133 activity in the Project window. When calculated, this creates
a plot or table in the Results window. The results are shown in a Plot Renderer or a
Table Renderer tab.

You need to Perform a Plot Renderer or a Table Renderer activity to visualize
the calculation results from an Equilibrium Calculator.

Main Menu and Toolbar

The File menu and toolbar are reserved for Graphical Mode but in Console Mode the Tools,
Window and Help menus have the same options.



Thermo-Calc Documentation Set

The Graphical Mode Interface ǀ 38 of 238

In Console Mode you use commands to access the other options. These are
discussed in "The Console Mode Interface" on page 145.

Graphical Mode Menu and Toolbar Options

Option Description Action (s)

New Create a new project.

Click New on the toolbar

Select File → New Project

Press <Ctrl+N>

Open
Open an existing project. See
"Saving and Opening Project
Files" on page 40.

Click Open on the toolbar

Select File → Open Project

Press <Ctrl+O>.

Open Examples

Open the examples folder
based on whether you are in
Console Mode or Graphical
Mode.

Select File → Open Examples or

Select Help → Open Examples

Save
Save a project. See "Saving and
Opening Project Files" on
page 40.

Click Save on the toolbar

Select File → Save Project

Press <Ctrl+S>.

Save Project
As…

Save an existing project with a
new name. Select File → Save Project As…

Switch to
Console Mode

Launch Console Mode and the
command prompt.

Click the button to exit Graphical
Mode and open Console Mode.

Switch to
Graphical Mode

Launch Graphical Mode to work
with the GUI version.

Click the button to exit Console
Mode and open Graphical Mode.

Append Project

Combine two projects into one
project file. See "Saving and
Opening Project Files" on
page 40.

Select File → Append Project
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Option Description Action (s)

Exit Exit the program.

In the upper right-corner of the
program, click the X.

Select File → Exit

Press <Ctrl+Q>.

Options

Change the global defaults for a
variety of settings. See
"Changing Global Settings" on
page 223.

Select Tools → Options

Database
Checker

Open the Database Checker, a
program to check that the
syntax of Thermo-Calc database
files is correct. This is for
advanced users who develop
and manage databases.

Select Tools → Database
Checker

Window menu Highlight a specific window on
the GUI

From the Window menu, select
an option to refocus on that
specific window.

Online Help

Open the online help system
where you can browse or
search all the Thermo-Calc
documentation.

Select Help → Online Help

Open Manuals
Folder

Open the folder on your
computer that has the PDF
documentation and guides.

Select Help → Open Manuals
Folder

Show License
Info

Open the License Information
window. Select Help → Show License Info
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Option Description Action (s)

Also see
"Displaying
Thermo-Calc
License
Information" on
page 28 and the
Thermo-Calc
Installation Guide

Check for
update

Check the Thermo-Calc
Software website for updates to
the software.

Select Help → Check for update

Saving and Opening Project Files
Thermo-Calc Graphical Mode uses project files with the file name suffix .tcu. The add-on
Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA) also use the same file
format in Graphical Mode.

For information about file formats in Console Mode, see "About the File Types
and Formats" on page 7.

To save your project and all its settings and results, on the toolbar click Save. Select to
Include calculated results in the project file (the default) as required.

To open a Thermo-Calc project file, on the toolbar click Open and select the project file in
the Open file window.

You can only have one project file open at a time. However, you can attach (append) the
trees from additional project files to the topmost My Project node. To append an additional
project file in this way, from the main menu select File → Append Project and open a
project file.

Also see "Saving Plots" on page 122 and Saving Tabulated Data for the "Table
Renderer" on page 133.

Project Activity Nodes
The section below is a brief description of the project activity types. When working with
activities in the Project window these are also referred to as nodes.
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These are the project activity nodes available in Graphical Mode.

Activity type Description

"System Definer"
on page 61

Define a certain thermodynamic system and read it from file into
memory.

"Property Model
Calculator" on
page 68

Choose one or more general models to predict and optimize
material properties. You can evaluate models simultaneously
over a range of compositions and cross plot the results. You can
then conduct an uncertainty analysis and plot the results as either
a histogram or as a probability plot.

"Equilibrium
Calculator" on
page 82

Set thermodynamic conditions and define axis variables when a
series of equilibrium calculations are to be performed in one or
more dimensions.

"Precipitation
Calculator" on
page 103

Set the conditions for, and perform, a precipitation calculation
using the Precipitation Module (TC-PRISMA).

"Diffusion
Calculator" on
page 91

Using the Diffusion Module (DICTRA), this activity is where you
set the geometry, add one or more regions, enter grids and
phases in the regions, and then enter compositions of phases.

"Plot Renderer" on
page 108 Determine the layout of non-text based output.

"Table Renderer"
on page 133 Use it for text-based output.

"Binary Calculator"
on page 137

Use it for some calculations involving two components only. It is
like a combination of System Definer and Equilibrium Calculator
activities with adaptations to simplify the configuration of
calculations on binary systems.

To perform this activity, you need a database
designed for the Binary Calculator, such as the TCBIN
database.
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Activity type Description

"Ternary
Calculator" on
page 139

Use it for some calculations involving three components. It is like
a combination of System Definer and Equilibrium Calculator
activities with adaptations to simplify the configuration of
calculations on ternary systems.

To get a reliable result you need a database that fully
assesses binary and ternary systems.

"Scheil Calculator"
on page 141

Perform Scheil-Gulliver calculations (also known as Scheil
calculations). A default Scheil calculation is used to estimate the
solidification range of an alloy assuming that i) the liquid phase is
homogeneous at all times and ii) the diffusivity is zero in the solid.
However, it is possible to disregard the second assumption for
selected components.

"Experimental File
Reader" on
page 136

Read experimental data files (*.EXP). This type of file contains
information specifying a plotted diagram, written in the
DATAPLOT graphical language.

Also see the DATPLOT User Guide.

Project and Activity Menus
When working in the Project window you can right-click nodes to open menus with the
available actions. For example, click the My Project node to open the menus. Most nodes in
the tree have a common menu with differences due to placement in the tree and the activity
type.

THE MENU FOR THE MY PROJECT NODE.
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THE MENU FOR AN ACTIVITY NODE.

Menu Options for Activities

Option Description Action (s)

Create New
Activity

Add System Definer,
Binary Calculator,
Ternary Calculator,
and Experimental File
Reader nodes.

Right-clickMy Project and from the Create
New Activity menu choose an option.
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Option Description Action (s)

See "Creating
Activities and
Successors" on
page 35.

Create New
Activity →
Use
Template

Choose from the
available templates
to use the Wizard or
add predefined
nodes.

See "Creating a
Project from a
Template" on
page 53.

Right-clickMy Project and from the Create
New Activity→ Use Templatesmenu choose
an option.

The templates are also available on the
Configuration window, which you can access
by clicking the My Project node, or from the
Window menu.

Create New
Successor

Add a successor to
the selected node.

See "Creating
Activities and
Successors" on
page 35.

Right-click one of these nodes System Definer,
Property Model Calculator, Equilibrium
Calculator, Precipitation Calculator, Diffusion
Calculator, Binary Calculator, Ternary
Calculator or Experimental File Reader, and
from the Create New Successor menu choose
an option.

Add a
Predecessor

Add a predecessor to
the selected node.

Right-click a node to add a predecessor to it
(when available).

Perform
Now or
Perform
Later

Perform a calculation
or create a plot or
table immediately, or
schedule it for a time
in the future. See
"Using the Scheduler"
on page 57.

Right-click any node.

Rename Change the name of
the node. Right-click any node.
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Option Description Action (s)

Remove Delete the selected
node from the tree. Right-click any node except My Project.

Clone

Duplicate the
selected node and
add it to the same
tree. See "Cloning
Activities and Trees"
on page 54.

Right-click any node except My Project.

Clone tree Duplicate a tree and
add it to My project. Right-click any node except My Project.

Apply Auto
Layout

Apply an automatic
layout to the nodes in
the tree.

Right-click any node.

Snap to
Grid

Snap a node to align
it with the grid. See
"Moving Nodes in the
Tree and Using the
Grid" on the next
page.

Right-click any node.

Show Grid
Turn the grid on or
off in the Project
window.

Right-click any node.

Zoom In,
Zoom Out,
Reset Zoom

Zoom in and out of
the Project window or
reset the zoom to the
default.

Right-click any node.

Organising the Windows on the Desktop
The windows on the Thermo-Calc desktop can be fixed or free-floating. By default, the
windows are fixed and open

One exception is the Event Log window, which is set to auto-hide by default.
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When a window is fixed it can also be set to auto-hide. Auto-hiding means that the window is
minimized when you select another window. The minimized window is then shown either
along the bottom or side of Thermo-Calc. A free-floating window is shown on top of the
other windows and can be moved outside the frame of Thermo-Calc.

Resetting the Desktop Layout

To return to the standard desktop layout, from the main menu, selectWindows → Reset
Windows.

Floating, Hiding and Minimizing Windows in the GUI

For each window you can rearrange, resize, minimize and close it. At the top right corner
are the buttons listed in the table.

Button(s) Description

Click to toggle on/off free-floating

Click to toggle on/off auto-hide.

Click to minimize an open window that has auto-hide
turned on.

The window automatically minimizes if another window is
selected.

Click to close the window. You can open the window again
from the Window main menu.

Moving Nodes in the Tree and Using the Grid
In the Project window, you can work with the activity nodes in these ways.
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Select and Move Individual Nodes

l Click an activity node to select it.

l To move activities, click and hold the activity node and move the cursor.

Select Several Nodes at a Time

l To select several activity nodes, hold down <Ctrl> while clicking on each node you
want to select.

l Click and hold the mouse button and draw a square around the activity nodes to
select. Both the name and the icon that represents an activity must be within the
square.

Show Grid and Snap to Grid

To show a grid of light-grey cross-hairs overlaid on a project, click Show Grid in the toolbar.
Click the button again to turn the grid off. Or right-click in the Project window and select
Show Grid.

Click Snap to Grid in the toolbar or right-click in the Project window and select Snap to
Grid to automatically position each activity in the Project window at a cross-hairs point in
the grid.

The Project window with the grid turned on and activity nodes moved from the default
location. These nodes are snapped to the grid.

Zooming In and Out
In the Results window (where the plots are):
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l Use the mouse scroll wheel to zoom in and out.

l Click and drag the mouse from left to right to highlight an area of the plot to zoom
into a specific point. Use the scroll wheel to continue zooming in or out.

l Click and drag the mouse from right to left reset the plot to its default view. You can
also click Perform Tree again.

In the Project window (where the activity nodes are):

l Right-click and select Zoom In or Zoom Out.

l To go back to the default zoom, select Reset Zoom.

Node Status Markers
Status markers indicate whether an activity is ready to be performed, is being performed, or
has been performed. The markers are overlaid on the activity nodes in the Project window.
The status markers are displayed on a System Definer node.

Also see "Results Window Status Markers" on page 128

Node Status Markers for the Project and Scheduler Windows

Window Status
marker Description

Project
window

No status marker means the activity is ready to be performed (it
has not been performed).

A yellow triangle means the activity cannot be run. The
necessary configurations for the activity may not be set or other
prerequisites are not met.

A green disc means the activity is performed.

A red circle with a dial (a clock face) means the activity is
currently being performed.
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Window Status
marker Description

Scheduler
window

No status marker means the activity (the job) is scheduled to be
performed (the job has not started).

A yellow triangle means there an error happened during the
activity job.

A green disc means the activity (the job) performed successfully.

A green right-facing arrow means the activity (the job) is being
performed.
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Graphical Mode Projects
These topics describes how you create, perform and link activities.

In this section:

The Quick Start Wizard 51

Creating a Project with the Quick Start Wizard 51

Creating a Project from a Template 53

Cloning Activities and Trees 54

Performing Projects, Trees and Activities 56

Using the Scheduler 57

The Event Log 58
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The Quick Start Wizard
Even before you understand how to work with Thermo-Calc projects, the Quick Start wizard
helps you set up a project and run calculations in Graphical Mode. You can set up, calculate
and visualize any of the following:

l Single point equilibrium

l Property diagram

l Phase diagram

l Scheil solidification simulation

See "Creating a Project with the Quick Start Wizard" below

Creating a Project with the Quick Start Wizard
To set up, perform and visualize a calculation using the Quick Start wizard:

1. In the Configuration window click Quick Start. If you cannot see the Quick Start
button, first clickMy Project in the Project window.

2. In the Select Project Type window click to select the type of calculation to perform.
Single point equilibrium, Property diagram, Phase diagram or Scheil solidification
simulation. Click Next.
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3. In the Define Systems window, choose an available Database.

4. Click to select Elements check boxes to include as system components. To add
elements from an existing material file, click the Material file button to enter the file
path to a material file or click the Select Material File button (to the right of the
field) to navigate to a file on the computer.

5. Click Next.

The Select Conditions window has different options depending on the Project type
and the elements selected.

In this example figure, using a Single Point Equilibrium, choose the Composition
unit and under Condition Definitions specify the values of the state variables in the
system.

For a Property diagram or Phase diagram, specify the Axis Definitions of the
stepping or mapping operation. Choose minimum and maximum values for the
variable(s) (select Linear – min no. of steps, Linear – max step size or Logarithmic –
scale factors) and whether it is Normal or Separate phases.

For a Scheil solidification simulation, and where applicable, select Fast diffuser to
account for back-diffusion of any fast-diffusing elements.

6. Click Finish.

7. Click to expand the Event Log window to see information about the progress of the
calculation.
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8. The diagram is plotted in a Plot Renderer tab in the Results window. If you have
calculated a single-point equilibrium, then a Table Renderer tab shows information
about the equilibrium.

9. To save the project, click Save on the main toolbar. To save a diagram or table, right-
click the diagram or table and select Save As.

Creating a Project from a Template
Use a Template to create all the activities for a certain type of calculation. In the Project
window click the My Project node to display the templates in the Configuration window.

CONFIGURATION WINDOW TEMPLATES

When you click a template, an activity tree is added to the Project window. You can then
configure and perform the activities or the project.
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For example, if you click Property Diagram, a tree is added to the My Project node with
System Definer, Equilibrium Calculator and Plot Renderer nodes.

PROPERTY DIAGRAM TEMPLATE

You can also select templates from the Project window. Right-click the My Project node and
choose templates from the Create New Activity → Use Template submenu.

USE TEMPLATE

Cloning Activities and Trees
As described in "Creating Activities and Successors" on page 35, you can clone a single
activity or the selected activity and all the activities that come after it (successors). The
predecessor of the selected activity also is the predecessor of the clone.

Cloned activities are configured exactly like the activities that they were cloned from, and
any results of calculations or plots are also cloned. To clone a selected activity, right-click
the activity and select Clone.

For example, if you clone the Equilibrium Calculator in this project the result is an
Equilibrium Calculator 2 created as a successor to System Definer 1.

The following applies to clones.

l The new Equilibrium Calculator has the same settings for conditions, functions and
options as its Equilibrium Calculator 1 clone.

l If the Equilibrium Calculator is already performed, then the calculation results are
cloned.
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l If the activity is a Plot Renderer or a Table Renderer, then the plot or table is cloned.

l If you want to clone all the successor activities that follow a selected activity, then
right-click and select Clone Tree instead.
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Cloning an Equilibrium Calculator Activity Node

Equilibrium Calculator Clones and Successors

If you create an Equilibrium Calculator as a successor to another Equilibrium Calculator,
then the successor inherits all the settings for conditions, functions and options from its
predecessor. In this respect, it is similar to a clone.

The Equilibrium Calculator successor is different from a clone in that it does not
inherit any calculated results and it is a successor to the Equilibrium Calculator
instead of a successor to its predecessor.

The calculated result from an Equilibrium Calculator that is the predecessor to another
Equilibrium Calculator is the starting value for the latter’s calculation. The clone of an
Equilibrium Calculator on the other hand, does not receive any data as input from the
Equilibrium Calculator that it is cloned from.

Performing Projects, Trees and Activities
You can trigger the performance of an activity (also called a job) and all the activities below
it in the same tree in either the Project or Configuration window. In the Project window you
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can also perform a single activity without performing its successors or perform the whole
project (all the activity trees).

In the Configuration window, click Perform Tree to perform the currently selected activity
and all the activities below it. If there are no activities below the selected activity, then the
button says Perform instead.

All activities that must be completed as prerequisites are automatically
performed first. For example, if you Perform Tree for a Plot Renderer, then the
predecessors, Equilibrium Calculator and System Definer, are automatically
performed before the Plot Renderer.

In the Project window, you can do any of the following:

l Perform an activity: Right-click the activity and select Perform Now, or Perform
Later and schedule a time to perform the activity.

l Perform an activity and all activities below it in the tree: Right-click any node in the
tree and select Perform Tree Now. Or select Perform Tree Later and schedule a
time for all activities in the tree to be performed.

l Perform a project: Right-clickMy Project and select Perform Now or Perform Later
and schedule a time to perform all project activities in the tree.

If there is an error during the performance of an activity, icons display status
markers, which are described in "Node Status Markers" on page 48.

Using the Scheduler
The Scheduler window has activity information about current or scheduled jobs. A job is any
activity you have selected to be performed. The Scheduler also indicates if there is an error
during a job and when a job has stopped. If you have set an activity, tree or project to be
performed at a later time then this is also listed.

About the Scheduler jobs

l Whenever you trigger the performance of a whole project, tree or individual activity,
all the activities to be performed are shown under a job heading.

l When all the activities belonging to a job are completed the job and its activities
disappear from the Scheduler window.

l If there is an error during the performance of an activity, icons for that job and
activity remain in the Scheduler window until removed.
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Also see "Node Status Markers" on page 48.

EXAMPLE

Managing the Schedule

In the Scheduler window, you can cancel scheduled jobs, remove errors and show
information about errors.

l To cancel all jobs, right-click the Scheduled Jobs label or the cogwheel icon, and
select Cancel All Jobs.

l To remove (clear) all failed activities and jobs, right-click the Scheduled Jobs label
or the cogwheel icon, and select Clear All Errors.

l To cancel a specific job, right-click the job label (for example, Job no 1) and select
Cancel Job.

l To remove (clear) a specific failed job, right-click the job label (for example, Job no
1) and select Cancel Job.

l To open a window with error details, right-click the label for the failed job (for
example, Job no 1), and select Show Error Log.

The Event Log
The Event Log window is closed by default. Click the Event Log window once to expand it or
select it from the Window→Event Log menu. Double-clicking the window maximizes it.

Information about what Thermo-Calc is processing or doing is in blue text and error or
warning messages are in red text.

To specify the level of detail in the Event Log, from the main menu select Tools →Options.
In the General tab set the Log level slide bar to anything between Debug (most detailed)
and Error (least detailed).
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Also see "Changing Global Settings" on page 223.

THIS EXAMPLE SHOWS INFORMATION,WARNINGS AND ERRORS.
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Graphical Mode Activities
These topics describe the activity types and has instructions for procedures tied to specific
activities.

In this section:

System Definer 61

The System Definer Settings 61

Property Model Calculator 68

Property Model Calculator Workflow 69

Equilibrium Calculator 82

Diffusion Calculator 91

Precipitation Calculator 103

Precipitation Calculator Settings 104

Plot Renderer 108

The Configuration Window 109

Table Renderer 133

Experimental File Reader 136

Binary Calculator 137

Ternary Calculator 139

Scheil Calculator 141

Scheil Calculator Advanced Settings 143
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System Definer
In a System Definer activity, you select the database to use to retrieve thermodynamic data
and define which elements the system has as components. You can also select the species to
include as well as change the reference temperature and pressure for your components.

Also see "Creating Activities and Successors" on page 35 for a list of possible
successors and predecessors for this activity.

The System Definer Settings

CONFIGURATION WINDOW

Choose Database(s) or a Database Package

At the top of the Configuration window you can choose to add one or more databases by
clicking the Add a database button. You can also choose a predefined or custom database
package from the Package list. Depending on your license, there are predefined database
packages available to select.

You can also click Remove this database button as required.



Thermo-Calc Documentation Set

Graphical Mode Activities ǀ 62 of 238

Also see "Global Settings: System Definition (System Definer)" on page 227 to
learn how to create a database package.

If you have chosen a database package and then remove or change a database,
a message displays Selected databases and selected package may differ. This
means that the original package you selected, which added preset databases,
does not match the databases you are using for the project. For information
about how to clear the message, see "Global Settings: System Definition (System
Definer)" on page 227.

There are several settings tabs available for the System Definer activity.

The following example uses the FEDEMO and MFEDEMO databases and Example 12
available with the Graphical Mode Examples.

Elements

On the Elements tab, and based on the databases or database package selected, you can
select and review elements using a Periodic Table or Alphabetic List format. Unavailable
elements are greyed out on the Periodic Table view.

Periodic Table

In this example, using the demonstration databases FEDEMO and MFEDEMO, there are only
a select number of elements to choose from.
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Alphabetic List

Material Composition

On the Periodic Table page, you can also define the material composition:

At the bottom of the window, click Load material to open a material file. The default folder
opens to the Materials folder included with your installation.
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"About the Material Files" on page 17 and "Examples, Manuals and Materials
Folders" on page 11

You can also click Save material as to save the material you defined, for example Ferritic.

Also see "Global Settings: System Definition (System Definer)" on page 227 to
learn how to create your own database packages.

If you Load a material file and then change the composition, a message displays
The composition has changed. This means that the original values/composition
does not match the values you are using for the project. The message is cleared
by either reloading the material file or editing the composition field to the
original value.

Species

On the Species tab for each database you can select and edit the Species.
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At the bottom of the window, click Add new species and enter the name of species in the
field.
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Phases and Phase Constitution

At the top of the Phases and Phase Constitution tab for each database, you can review and
edit the Status (Entered or Dormant) for the selectedPhases. Select the Check/uncheck all
check box to toggle between the options.

To review the Phase constitution for a specific phase, click it in the Phase list (for example
BCC_A2) and its details are displayed at the bottom of the window. Click Edit then click an
element to select or reject a constituent. The last remaining constituent on a sublattice
cannot be rejected.
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Components

The Components tab is where you can review and edit the Component, Reference phase,
Reference temperature, and Reference pressure. Click to toggle the SER (Stable Element
Reference) check box on and off. Then choose a Reference phase from the list and edit
accordingly.

Data Sources

Data sources are not available until the activity has been performed. Click Perform Tree to
display available data sources.

Description

The Description tab displays a description of the selected database(s). In this example,
MFEDEMO.

Creating a System Definer Activity

This topic describes how to define a system; specifically how to select one or more
databases and define the elements in the system.
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To change the default database or create a database package, see "Global
Settings: System Definition (System Definer)" on page 227.

Also see "About the Database Files" on page 219.

1. Right-clickMy Project and from the menu select Create New Activity→ System
Definer .

2. In the Project window, click the "System Definer" on page 61 activity node.

3. In the Configuration window, from the Databasesmenu choose Database(s) or a
Database Package.

OPTIONS:
l Select <User database>to define your own.

l You can choose to add one or more databases by clicking the Add a database
button.

l From the Package list, choose a predefined database package to add multiple
databases at a time. Depending on your license, there are predefined database
packages available to select.

4. Select the Elements tab to choose the elements in the Periodic Table or use the
Alphabetic List to choose elements for the system.

5. As required click the tabs to make edits: Species, Phases and Phase Constitution,
and Components. The Data Sources and Description tabs provide information based
on the database.

6. Click Perform to start the System Definer activity immediately and retrieve
thermodynamic data about the system. Click the Event Log window to watch the
progress of the job.

Property Model Calculator
A Property Model Calculator allows you to predict and optimize material properties. A set of
general models is available to use: a "Phase Transition Model" on page 77, "Driving Force
Model" on page 78, "Interfacial Energy Model" on page 78, "Coarsening Model" on page 79,
and an "Equilibrium Model" on page 81.

Experienced users can also create custom property models. See the
"Introduction to the Property Model Development Framework" on page 2 for
details.

You can evaluate models simultaneously over a range of compositions and cross plot the
results. You can then conduct an uncertainty analysis and plot the results as either a
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histogram or as a probability plot. The Configuration window for a Property Model
Calculator using the Phase transitionmodel is shown and described in "Defining the Property
Model Calculator" on page 72.

Property Model Calculator Workflow
When a project is first being designed, it is recommended you test it by first performing a
Single calculation type. This verifies that the configuration of the model is valid, otherwise
you will get a Not a Number result in "Event Log Window" on page 151 window  indicating
the calculation did not work correctly.

Once the Single calculation type performs successfully, you can experiment with other
calculation types such as Grid, Min/Max or Uncertainty. Best practice for both Grid and
Uncertainty is to start with a small number of steps (Grid) or samples (Uncertainty) to
confirm that it works before increasing the number of steps or samples.

In general, the workflow for the different models will differ. A recommended start point is to
do a Property Diagram calculation to determine what phases you get and where the
transitions are before setting up the Property Model Calculator. You can create a Property
Diagram using the Quick Start wizard or a template.

Also see "The Quick Start Wizard" on page 51 and "Creating a Project from a
Template" on page 53.

For examples using the Property Model Calculator, see examples 10, 11, and 12
in Graphical Mode Examples.



Thermo-Calc Documentation Set

Graphical Mode Activities ǀ 70 of 238

Configuration Window

Configuration Settings

Setting/Button Description

Composition
unit

Choose a unit:Mass percent, Mole percent, Mass fraction or Mole
fraction

Condition
Definitions

Choose a unit (Kelvin, Celsius or Fahrenheit) and then enter a value
for the Temperature and Composition.

The values entered in Condition Definitions are used as the start
values for the different calculation types.
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Setting/Button Description

Calculation
Type

Choose a calculation type: Single (no axes), One axis, Grid, Min/Max
or Uncertainty.

Select Single to calculate a single point.

Select One axis to vary a quantity on the X-axis.

Select a Grid to evaluate two axis variables of the selected quantities
in the specified range and number of steps.

The Min/Max calculation evaluates the property model(s) for all
variations of the selected quantities at the given limits. The Mean
field is as defined under Condition Definitions for the respective
quantity. The total minimum and maximum of the model(s) results
are shown in the Event log.

The Uncertainty calculation evaluates the property model(s) where
the values of the quantities are sampled from Gaussian distributions.
The Mean field is as defined under Condition Definitions for the
respective quantity. The result is visualized as a histogram or normal
probability plot by adding a Plot Render activity.

Single
calculation

For the Single calculation type no further settings are required. The
results from this calculation are displayed in the Event Log.

Axis Definition For One axis, select a Quantity to vary along the X-axis, for example,
Temperature then enter a Min, Max and Number of steps.

Grid Definitions

For the Grid calculation type, define the two axes variables using the
fields and menus: Quantity, Min, Max and Number of steps. The
number of steps along with the minimum and maximum values for
the axes define a grid. For each grid point the selected models are
evaluated.

Min/Max
Definitions

For the Min/Max calculation type, click to select the applicable check
boxes under Quantity to enable or disable an axis. The Mean field
is as defined under Condition Definitions for the respective quantity.

Enter numerical values in the ∆ Min/Max fields to evaluate the
change to the quantity. The highest and lowest value of each selected
model results are shown in the Event log.
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Setting/Button Description

Sampling of
Data from
Gaussian
Distributions

For the Uncertainty calculation type, click to select the applicable
check boxes under Quantity to vary this quantity. The Mean field is
for the distribution function as defined under Condition Definitions
for the respective quantity. ∆Min/Max is the 95% confidence
interval.

Sampling
Parameters

For the Uncertainty calculation type, choose a number of Standard
deviations where you want to Truncate the distribution. Choose the
Total number of samples.

Also see "About the Uncertainty Calculations" on the next page for more detail.

Defining the Property Model Calculator

1. From the left side of the Configuration window, click to select one or more of the
check boxes under the General Models folder.

A tab with the same name as the property model opens in the right side of the window
under Condition Definitions. When you select more than one model, a matching tab is
added in the same order that the check box is selected.

2. Enter the settings described in the following table for the Condition Definitions and
for each Calculation Type (Single, Grid, Min/Max, and Uncertainty). For each model
on the Configuration tab, select or enter settings as required. Click the Description
tab for more information about the model and refer to the individual sections for
details.
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l "Phase Transition Model" on page 77

l "Driving Force Model" on page 78

l "Interfacial Energy Model" on page 78

l "Coarsening Model" on page 79

l "Equilibrium Model" on page 81

About the Uncertainty Calculations

The following example uses the "Phase Transition Model" on page 77 and an Uncertainty
Calculation Type to describe how the sampling of data is performed. The example (which is
example 10 in Graphical Mode Examples) predicts the transition temperature to the
unwanted brittle Sigma phase and shows how the temperature is influenced by changes to a
steel alloy’s composition.

The Uncertainty calculation in Thermo-Calc uses the values (the mean) entered for
quantities in the Condition Definitions section as the starting point to estimate, within a
certain probability, the true variation of the quantity.

An example of a Gaussian distribution is shown The mean is at the peak of the curve
(labelled µ). The standard deviation (σ) is a plus and minus range, ±1σ, ±2σ or ±3σ, of the
variance from the mean.

Gaussian Distribution, the 3-Sigma Rule

Image by Dan Kernler, https://en.wikipedia.org/wiki/Normal_
distribution#/media/File:Empirical_Rule.PNG

https://en.wikipedia.org/wiki/Normal_distribution#/media/File:Empirical_Rule.PNG
https://en.wikipedia.org/wiki/Normal_distribution#/media/File:Empirical_Rule.PNG
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As long as the number of events (the sample size) is very large, then the Gaussian
distribution function can be used to describe physical events. A Gaussian distribution is
assumed to describe how each quantity varies in an uncertainty calculation.

In Thermo-Calc, the mean of the quantity’s distribution is defined in the Condition Definitions
section. The Mean is then used in the Sampling of Data from Gaussian Distributions section
as the starting point for how much you want to deviate from this value.

Condition Definitions and Sampling Settings

The mean defined in Condition Definitions is used during the sampling.
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The values entered in the ∆ Min/Max fields are the resulting width of the distribution
corresponding to the 95% confidence interval (approximately µ ± 2σ) shown in Gaussian
distribution, the 3-sigma rule.This confidence interval means that approximately 95% of the
sampled values will fall within these limits.

The default value for truncating the distribution is set at 3 standard deviations in the
Sampling Parameters section. This is also where you set the Total number of samples. The
default is 200. In order to maintain a Gaussian distribution for the varied quantities, this
number should not be too low.

Sampling Parameter Settings

You can experiment by varying the conditions and the number of samples to see the
distribution results smooth out as is to be expected based on the Central Limit Theorem. For
example, on the Plot Renderer the variable is set to measure the Composition of Ni. The
initial sample size uses the default, 200, and then, as in the example below where the
sample size is increased to 300, 400, 600, 800, and 1000 to show how the plot follows the
Gauss distribution.
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Histogram Plot

This is a series of histogram plots of the uncertainty calculations sampling data from
Gaussian distributions. It compares the Ni composition where the total sample size is
increased to show how the model follows the Gauss distribution.

Normal Probability Plot

You can also plot the results as a Normal probability. Continuing with this example, on the
Property Model Calculator Configuration window the X-Axis variable is plotted as
Composition and the Y-Axis variable is plotted as the Normal probability.
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This is a normal probability plot example of the uncertainty calculations sampling data from
Gaussian distributions. It compares the Ni composition where the total sample size is 200.
The sampled data (blue line) closely follows the ideal normal distribution (red line).
Deviations are naturally larger at the tails (≈1%Ni and ≈2%Ni) since the number of samples
are fewer there compared to the center of the distribution.

Phase Transition Model

By varying set conditions, the Phase Transition model calculates the point when a new
phase may form. The model is useful to determine melting temperature, boiling
temperature or solubility limits. It returns the phase transformation temperature, or
composition, depending on the varied condition.

For an example of a phase transition model, see example 10 in Graphical Mode
Examples.
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Define the:

l Matrix phase - The single phase region to start in. Select 'Any phase' to use the
phases that take part of the initial equilibrium or choose a specific phase.

l Phase to form - For the new phase to be formed, select 'Any phase' or choose a
specific phase.

l Condition to vary – Choose whether to vary a composition or temperature condition
when calculating the phase transition.

l Search direction - For the composition or temperature condition being varied,
choose the Search direction to be in a Positive, Negative, or Positive and Negative
direction.

l Upper search limit and Lower search limit - These values also relate to the search
direction, where an estimated change to the released condition implies where a new
phase is expected.

The start value (given in Condition Definitions) and phase transition point need to be
within these limits, otherwise the model returns Not a Number as result. For example,
a start temperature is 1100 K then the limits need to be outside these, e.g. 500-1500.

Driving Force Model

The Driving Force model calculates the thermodynamic driving force for a phase.

l Matrix phase: Choose a Matrix phase, the single phase region to start in. Select 'Any
phase' to use the phases that take part of the initial equilibrium or choose a specific
phase.

l Precipitate phase: Choose a Precipitate phase to calculate its driving force.

The calculation result is the driving force divided by RT.

For an example of a driving force model, see example 12 in Graphical Mode
Examples.

Interfacial Energy Model

Use the Interfacial Energy model to estimate the interfacial energy between a matrix phase
and a precipitate phase using thermodynamic data from a CALPHAD database. The
approximation model is based on Becker's bond energy approach and is also available in
Precipitation Module (TC-PRISMA). In the actual calculation, the coefficients taken
distinguish between only bcc and fcc structure for the (110) and (111) lattice plane,
respectively.
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For other planes and/or other phases, the estimate is approximate. In most situations, it is
recommended to perform calibrations against some experimental data because the
interfacial energy is dependent on so many factors that are ignored in the estimation, for
example entropy, incoherency, orientation, and curvature, etc. Uncertainty factors must also
be considered as thermodynamic data in CALPHAD databases are not always accurate.

Select the Matrix phase and Precipitate phase to return the interfacial energy [J/m2].

For an example of an interfacial energy model, see example 11 in Graphical
Mode Examples.

Estimation of coherent interfacial energy

Interfacial energy is an important parameter used in precipitation simulations to calculate
the rates of nucleation, growth/dissolution, and coarsening. The value of interfacial energy
can vary dramatically (usually between 0.01 to 2.0 J/m2).

The extended Becker’s model functions to estimate coherent interfacial energy by using
thermodynamic data from existing CALPHAD thermodynamic databases:

where σc is the coherent interfacial energy, ns is the number of atoms per unit area at the
interface, zs is the number of cross bonds per atom at the interface, zl is the coordination
number of an atom within the bulk crystal lattice, and ∆Εs is the energy of solution in a
multicomponent system involving the two phases being considered. (Reference1).

Coarsening Model

The Coarsening model calculates the coarsening rate coefficient K (m3/s) of a spherical
precipitate phase in a matrix phase.

l Matrix phase: Choose the Matrix phase.

l Precipitate phase: Choose a Precipitate phase to calculate its coarsening rate.

Returns the coarsening rate coefficient [m3/s] for the precipitate phase and the
interfacial energy [J/m2] between matrix and the precipitate phase.

This model requires that the thermodynamic and kinetic databases used include
descriptions of molar volume of the matrix and precipitates as well as mobilities
for the matrix phase.

1Becker, R., Die Keimbildung bei der Ausscheidung in metallischen Mischkristallen, Ann. Phys. 424, 128–140 (1938).
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For an example of a coarsening model, see example 11 in Graphical Mode
Examples.
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Particle Coarsening

In the coarsening regime where the driving force is capillarity, the change of mean particle
radius evolves according to the equation:

Following Morral and Purdy, the rate constant of precipitating β phase in a multicomponent
α phase is

The mobility matrix M is not the same as the mobilites that can be obtained directly from
the Diffusion Module (DICTRA). The M matrix instead corresponds to the L’’ matrix as
defined by Andersson and Ågren.

Using the u-fractions that is defined as

where the summation only is performed over the substitutional elements give the final
equation for the coarsening rate coefficient.

The interfacial energy σ is calculated using the extended Becker’s model (that also is
available as a separate Property Model Calculator model)

References

l Morral, J. E. & Purdy, G. R. “Particle coarsening in binary and multicomponent
alloys,” Scr. Metall. Mater. 30, 905–908 (1994).

l Andersson, J. & Ågren, J. Models for numerical treatment of multicomponent
diffusion in simple phases. J. Appl. Phys. 72, 1350–1355 (1992).

Equilibrium Model

The Equilibrium model calculates the equilibrium for the given conditions. Optionally define
additional Function Definitions. All quantities that normally can be obtained from an
equilibrium calculation can also be obtained when plotting the results, as well as the defined
functions.
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Equilibrium Calculator
An Equilibrium Calculator allows you to set the conditions for, and perform, a calculation.
The Configuration window for an Equilibrium Calculator has these tabs:

l Conditions: Set the conditions for your calculation that define the stepping or
mapping axis variables. This tab can be viewed in a simplified mode and in an
advanced mode. See "Equilibrium Calculator Conditions Settings" on the next page.

l Functions: Define your own quantities and functions, which you then can calculate
and plot. See "Calculating and Plotting Functions" on page 90.

l Options: Modify numerical settings that determine how equilibria are calculated, as
well as how stepping and mapping calculations are performed. See "Equilibrium
Calculator Options Settings" on page 87.

The Options tab is where you can locally define specific Equilibrium Calculator
settings. These settings can also be applied globally. From the main menu select
Tools → Options and click the Activities tab. Then click Calculation. See
"Global Settings: Calculation (Equilibrium Calculator)" on page 231 for some
more information.

See "Creating Activities and Successors" on page 35 for a list of possible successors and
predecessors for this activity. An Equilibrium Calculator that is the successor of another
Equilibrium Calculator inherits all the Configuration window settings of the predecessor.

For an example of how serially coupled Equilibrium Calculators can be used, see
example 6 in "Equilibrium Calculator Examples" on page 13.
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Configuration Window

Equilibrium Calculator Conditions Settings

Conditions and axis variables for the Equilibrium Calculator are set in the Conditions tab of
the Configuration window. The tab can be viewed in two modes: simplified (the default) or
advanced.

The conditions to set depend on the type of calculation.

See "Equilibrium Calculator Examples" on page 13: Example 1 is a single-point
equilibrium calculation; Example 2 is a stepping calculation; Example 5 is a
mapping calculation.

In advanced mode, you can add and remove conditions as well as set additional axis
definitions. However, the number and types of conditions set must still conform to the Gibbs’
phase rule. The Number of missing conditions is field, at the top of the tab shows how
many conditions that you have left to set. If the number is negative, then that number of
conditions need to be removed.

Setting Conditions for Simplified Mode

The following table briefly describes what you can set on the Conditions tab in simplified
mode. Click Switch to advanced mode for more options.
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The Conditions Tab

Conditions Tab, Simplified Mode Settings

These are the settings on the Equilibrium Calculator Conditions tab in Simplified Mode.

Setting or
Condition Options

Composition unit Choose from Mass percent, Mole percent, Mass fraction or
Mole fraction.

Condition
Definitions

Specify the values (and units) of the state variables: Temperature,
Pressure, and System size.

Calculation Type

Single equilibrium (no axes), Property diagram, Property grid
or Phase diagram.

For the Single calculation type no further settings are required.
The results from this calculation are displayed in the Event Log .

Axis Definitions

Property diagram: Define the axis variable using these fields and
menus: Quantity, Min, Max, Step division and Type.

Property grid: Define the two axis variables using these fields and
menus: Quantity, Min, Max and Number of steps.
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Setting or
Condition Options

Phase diagram: Define the two axis variables using these fields
and menus: Quantity, Min, Max, Step division and Type.

If the Equilibrium Calculator already has a Plot
Renderer as a successor and you change the
stepping/mapping quantities, then the quantities
represented on the X- and Y-axis are automatically
updated in the Plot Renderer.

Number of steps
(Property grid)

Set a fixed Number of steps. The number of steps along with the
minimum and maximum values for the axes define a grid. For
each grid point an equilibrium is calculated.

Type and Step
division (Property
diagram and Phase
diagram)

Type options: Linear - min no. of steps, Linear - max step size and
Logarithmic - scale factor.

For Linear - min no. of steps, the Step division value specifies a
minimum number of steps that is calculated between the
minimum and maximum value during the stepping/mapping
operation.

For Linear - max step size, the Step division sets the maximum
size of each step.For Logarithmic - scale factor, Step division
specifies the scale factor of a logarithmic function that distributes
the steps from the initial equilibrium to the minimum and
maximum values defined.

Calculating with a Fixed Phase (Advanced Mode)

This describes how to use the advanced mode to set a phase to be fixed at a certain amount.
This allows you to, for example, find out at what temperature a material starts to melt. If
you set the phase to be fixed to liquid phase at zero amount, and do not define the
temperature state variable, then you can calculate at what temperature the material enters
a state where the liquid phase is no longer zero (that is, when it starts to melt).
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How to Calculate with a Fixed Phase

For a fixed phase equilibrium calculation, it is recommended to serially couple
the Equilibrium Calculators. This is where one Equilibrium Calculator activity is
the successor to another Equilibrium Calculator activity that performs an
ordinary equilibrium calculation, and then, for the condition you are interested
in, you make a rough estimate of the value. This gives the fixed phase
calculation better starting values.

1. Right-click a node that can add an Equilibrium Calculator to your project. See
"Creating Activities and Successors" on page 35 for a list.

2. In the Project window, click the Equilibrium Calculator activity node.

3. In the Configuration window, click Switch to advanced mode.

If the Default calculation mode is globally set to Advanced then by default the
Configuration window is already in advanced mode. See "Changing Global
Settings" on page 223.

4. Under Condition Definitions, click the Add quantity button.

5. Select Fix phase from the first menu.

6. Select the phase that you want to fix in the second menu, and set the amount of that
phase you want to fix the phase to. For example, if you want to know when your
material starts to melt, set the phase to LIQUID and the value to 0.0:

Above the condition definitions, the Number of missing conditions is field is probably
-1. This means that you must remove one condition.

7. To remove a condition, either click the remove button, or click to clear the check-
box. For example, if you want to know at what temperature your material starts to
melt, then you cannot have a fixed temperature, in which case the temperature
condition is not selected:
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The Number of missing conditions is field displays 0. When you have set all your
conditions, you can perform the Equilibrium Calculator (now or later).

Equilibrium Calculator Options Settings

These settings are for the "Equilibrium Calculator" on page 82 and are located on the
Configuration window, Options tab.

These settings can be changed locally for a specific Equilibrium Calculator or
globally in the Options settings (from the main menu select Tools → Options.
Click the Activities tab then click Calculation).

Setting Options

Default
calculation
mode

Simplified (the default) or Advanced

Default
calculation
type

Single equilibrium (the default), Property diagram, Phase diagram or
Property grid

Single equilibrium and property grid
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Setting Options

Global
minimization

The check box is selected by default to ensure that the most stable
minimum under the specified conditions is computed.

Max no of
iterations

By default, the program tries 500 iterations before it gives up. As some
models give computation times of more than 1 CPU second/iteration,
this number is also used to check the CPU time and the calculation
stops if 500 CPU seconds/iterations are used.

Max grid
points

Coarse (2000 grid points, the default), Medium (20,000 grid points),
Fine (200,000 grid points), or Custom (set your own number of grid
points).

Required
accuracy

The default is 1.0E-6. This is a relative accuracy, and the program
requires that the relative difference in each variable must be lower
than this value before it has converged. A larger value normally means
fewer iterations but less accurate solutions. The value should be at least
one order of magnitude larger than the machine precision.

Smallest
fraction

The default is 1.0E-12. This is the value assigned to constituents that are
unstable. It is normally only in the gas phase you can find such low
fractions.

The default value for the smallest site-fractions is 1E-12 for all phases
except for IDEAL phase with one sublattice site (such as the GAS
mixture phase in many databases) for which the default value is always
as 1E-30.

In Console Mode, the default of 1E-30 is true unless you are
using the command SET_NUMERICAL_LIMITS to reset an
even-lower value (e.g. 1E-45, that is naturally enforced to
all the phases in the system.

Approximate
driving force
for
metastable
phases

The check box is selected by default, which means the metastable
phases are included in all iterations. However, these may not have
reached their most favourable composition and thus their driving forces
may be only approximate.

If it is important that these driving forces are correct, click to clear the
check box to force the calculation to converge for the metastable
phases.
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Setting Options

Force
positive
definite
phase
Hessian

The check box is selected by default.

Control
stepsize The check box is selected by default

Property diagram

Global
minimization

The check box is selected by default to ensure that the most stable
minimum under the specified conditions is computed.

Global test
interval

Every 10th eq (the default), Always or Custom

Phase diagram

Global
minimization

The check box is selected by default to ensure that the most stable
minimum under the specified conditions is computed.

Global test
interval

At node points (the default), Every 10th eq, Always or Custom

Generate
starting
points
automatically

The check box is selected by default

Use inside
meshing
points

Click to select the check box as required

No of meshes
along an axis The default is 3
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Calculating and Plotting Functions

The Functions tab allows you to define your own functions that can be plotted in a Plot
Renderer.

For an example of how you can use functions that you yourself define, see
example 7 in "Equilibrium Calculator Examples" on page 13.

How to Calculate and Plot Functions

1. Create an Equilibrium Calculator node and click it in the Project window.

2. In the Configuration window click the Functions tab.

3. Under Quantity Definitions, define Q1. Click the add button to Add a new
quantity. Then from the lists, choose the variable for each quantity to define. The
quantities are called Q1, Q2, Q3 and so on. In this example, the quantity Q1 is
defined as the Amount of phase, with No normalization, LIQUID inMole units.

4. Under Function Definitions, click the add button to add a new function. In the left
field edit the default name of each function and enter the function itself in the right
field after the equal sign. In this example, the quantity defined as Q1 is renamed to
fraction_solid, which gives as its output the fraction of solid phase (1-Q1).

You can also use Console Mode syntax when entering the function. For example,
the function above can be entered as 1-NP(LIQUID).

5. To plot the defined function, right-click Equilibrium Calculator and choose Create
new successor→Plot Renderer.

6. Click the Plot Renderer node. In the tab for the Equilibrium Calculator that contains
the function, set an Axis variable to Function, then from the menu select the defined
function. In this example the Y-axis is set to plot the value of the function fraction_
solid.

When run, the Plot Renderer plots the value of the function.
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Diffusion Calculator
The Diffusion Calculator is available with two elements if you do not have the
additional Diffusion Module (DICTRA) license. With the add-on module you can
use all available elements as per the licensed database selected.

A Diffusion Calculator allows you to set the conditions for, and perform, a diffusion
calculation. The Configuration window for a Diffusion Calculator has these tabs:

l Conditions: Set the conditions for your calculation that define the geometry, regions,
phases, grids, composition profiles and the thermal profile.

l Options: Modify the simulation conditions such as the choosing the default solver
(automatic or homogenization) and the time integration method. Also define the
time step controls and if you choose homogenization as the solver, define further
settings such as the interpolation scheme and whether to use global minimization or
not.

See "Diffusion Calculator Options Settings" on page 98.

The following Configuration window is from the Graphical Mode Quick Start Guide. It is using
project example file Ex_20 - Diffusion of a Moving Boundary.

EXAMPLE
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The following sections list the settings available from the Conditions tab. For the Options
tab, see "Diffusion Calculator Options Settings" on page 98.

You can edit the defaults for some of these settings by going to Tools →
Options → Graphical Mode → Diffusion. Also see "Global Settings: Diffusion
(Diffusion Calculator)" on page 231.
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The Diffusion Module (DICTRA) in Console Mode has commands to perform
some of the settings also available on the Diffusion Calculator. Where possible
the name of the command is indicated. All the commands are described in the
Diffusion Module (DICTRA) Command Reference.

General

See also these Console commands: ENTER_COMPOSITIONS and ENTER_
GEOMETRICAL_ EXPONENT

Setting Options

Composition
unit

Choose from Mass percent, Mole percent, Mass fraction or Mole
fraction.

Length unit Choose m, µm or nm.

Geometry

Choose Planar, Spherical or Cylindrical. For Cylindrical, also enter a
value for the First interface position .

With a cylindrical or spherical geometry, the system’s zero coordinate
(left boundary) is at the centre of the cylinder or sphere. The highest
coordinate (right boundary) is defined by the cylinder or sphere radius.

Region

See also these Console commands for some of the equivalent settings: ENTER_
COMPOSITIONS and ENTER_GRID_COORDINATES

Setting Options

Left and
Right
Interface
boundary

Toggle between hiding and showing the Left interface boundary or
Right interface boundary.

Click the Add quantity or Remove quantity buttons as required to
add a Phase and then enter a value for the Driving force as required.
The default driving force is 1.0E-5.

Name Enter a Name for the region in the field. For example, enter Austenite.
This name is automatically updated on the tab and above the grid points
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Setting Options

graphic. You can also double-click the tab to enter the name.

Width Enter a numerical value in the Width field. The unit is the one selected
for the Length unit.

Points Enter a numerical value in the points field. The default is 50.

Type (of
grid)

Select a type of grid, Linear, Geometric or Double geometric.

Choose Geometric for a grid that yields a varying density of grid points
in the region. Then enter a Ratio to determine the distribution. A
geometrical factor larger than one yields a higher density of grid points
at the lower end of the region and a factor smaller than one yields a
higher density of grid points at the upper end of the region.

Choose Double geometric to have a high number of grid points in the
middle or at both ends of a region. Then specify two geometrical factors,
the Upper ratio for the distribution in the lower (left) part of a region,
and Upper ratio for the distribution in the upper (right) part of a region.

Phase

Choose a Phase from the list. The available options are defined in the
System Definer. At least one phase that dissolves all system elements
must be selected.

Click the Add quantity or Remove quantity buttons as required.

Composition
profile

Click Edit to open the Initial Composition window.

Select a Dependent component for which the composition does not
need to be given. The available options depend on the phase description.

For each Component choose one of these options:

l Linear: enter a range in the from and to fields.
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Setting Options

l Step: enter a range in the from and to fields. Enter a numerical
value in the step at field. The unit is the one selected for the
Length unit.

l Function: Enter a composition function in the field using SI units.
Some useful functions are the error function denoted erf(X) and
the Heaviside step-function denoted hs(X). For example the
function 3+2hs(x-1e-4) provides a concentration of 3 at the left
side and 5 at the right side with a sharp step in the concentration
profile at 1e-4m=100mm.

Click Apply when you are done.

Thermal Profile

Setting Options

Isothermal

Use an Isothermal thermal profile to do a diffusion simulation at constant
temperature.

Enter a Temperature and select the unit as Kelvin, Celsius or Fahrenheit.
Enter a Simulation time and select the unit as Seconds, Minutes, Hours
or Days.

Non-
isothermal

For the Non-isothermal thermal profile, select a Temperature unit and
Time unit from the lists. Enter a value for the Simulation time.

Click Edit thermal Profile. Here the Temperature and Time coordinates
of thermal profile points are entered. You can also click Import to add
your own thermal profile.

EDIT THERMAL PROFILE WINDOW

This image is from example 22 - Diffusion Fe-C moving Boundary Austenite
to Ferrite.



Thermo-Calc Documentation Set

Graphical Mode Activities ǀ 96 of 238

Setting Options

Diffusion Module Options in Graphical Mode

The Diffusion Module is an add-on module to the core Thermo-Calc software.

A separate license is required to perform calculations for more than two
elements. Without it you are able to use the module in Demo Mode. This is not
available in Console Mode. See "Demonstration (Demo) Mode" on page 98 to
learn more.

Diffusion Simulation Template

A Diffusion Simulation template is available to all Thermo-Calc users when in Graphical
Mode.

If you are using the Diffusion Module in Demo Mode, see "Demonstration
(Demo) Mode" on page 98 for what is available to you. Even if you have a
license, you may find yourself in Demo Mode if you have a network license and
all the licenses are checked out. See Diffusion Module (DICTRA) Licenses for
more information.

Using the Template

When you first open Thermo-Calc in Graphical Mode, on the My Project window, click the
Diffusion Simulation button to add a System Definer, Diffusion Calculator and Plot Renderer
to the Project tree.
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Click the Diffusion Simulation icon in the Templates window to add THESE NODES to the
Project.

"Creating a "Project from a Template" in the Thermo-Calc User Guide or search
the Online Help.

Diffusion Calculator

A Diffusion Calculator allows you to set the conditions for your calculation that define the
geometry, regions, phases, grids, composition profiles and the thermal profile, plus
additional options. Many of the settings are automatically set as you define your system.
Details about this activity are described in "Diffusion Calculator" on page 91 in the Thermo-
Calc User Guide.

Demo Database Packages for the Examples Collection

Both a thermodynamic and mobility database are required to run the Diffusion Module
simulation. If you have a Diffusion Module (DICTRA) license you can run all the examples
because the demonstration database packages are included with your installation.

Select the database packages from the System Definer Configuration window to run a
simulation.

If you are in Demo Mode, see "Demonstration (Demo) Mode" on the next page
to learn more.

EXAMPLE
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Demonstration (Demo) Mode

The Diffusion Module and two examples are available to all Thermo-Calc users but only for
simulations with two elements. If you do not have a license for the then you are in Demo
Mode when using the Diffusion Calculator or Diffusion Simulation template.

Diffusion Simulation Template

When you are in DEMO mode, in the Templates area this is indicated by the text under the
logo.

Diffusion Calculator

If you are experimenting with the Diffusion Calculator in Demo Mode, you may have access
to a variety of databases based on your license. However, you can only define two elements
for a demo simulation.

If you define more than two elements on the System Definer, when you go to the Diffusion
Calculator, the Perform button is unavailable and the tooltip explains why.

EXAMPLE

Even if you have more than two elements, the Plot Renderer Perform button is
still available. However, if you click the button and try to run the simulation the
Event Log displays an error message.

Diffusion Calculator Options Settings

The following settings are available on the Options tab for aDiffusion Calculator.

You can edit the defaults for some of these settings by going to Tools →
Options → Graphical Mode → Diffusion. Also see "Global Settings: Diffusion
(Diffusion Calculator)" on page 231.
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The Diffusion Module (DICTRA) in Console Mode has commands to perform
some of the settings also available on the Diffusion Calculator. Where possible
the name of the command is indicated. All the commands are described in the
Diffusion Module (DICTRA) Command Reference.

Simulation Conditions

See also these Console commands for some of the equivalent settings:
HOMOGENIZATION_MODEL, SWITCH_MODEL, SET_SIMULATION_CONDITION,
and SET_NUMERICAL_LIMITS.

Setting Options

Default
solver

Automatic or Homogenization.

Select Homogenization to define additional sections.

ABOUT THE HOMOGENIZATION SOLVER

The homogenization solver (called the homogenization model in Console
Mode) is useful when you want to simulate long-range diffusion through
a multiphase mixture, under the assumption that local equilibrium holds
at each node point.

Time
integration
method

Trapezoidal or Euler backwards.

The default is Trapezoidal. However, if large fluctuations occur in the
profiles it may be necessary to use the more stable but less accurate
Euler backwards.

Save results
on file

Yes, No or Every nth. . Select Every nth to enter a value in the field.

This setting is determine if the results are to be saved on file during the
course of the simulation.

l Yes to always save on file

l No to never save on file

l Every nth. to save every nth time to file. Then enter an integer
value ranging from 0 to 99.

Use forced Select the check box to have these equilibrium calculations performed
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Setting Options

starting
values in
eq.
calculations

using forced starting values.

Default
driving
force for
inactive
phase

Enter a value in the field. The required driving force (evaluated as DGM
(ph)) to be used for determining whether an inactive phase is stable.
DGM is the variable for the driving force that is already divided by RT,
and it is dimensionless. The default is 0.01.

Also see "Suffixes" on page 341 in the Thermo-Calc Console
Mode Command Reference.

Timestep Control

See also these Console commands for some of the equivalent settings: SET_
ACCURACY, SET_SIMULATION_TIME, and SET_SIMULATION_CONDITION.

Setting Options

Max relative error Enter a value in the field. The default is 0.05.

Max absolute error Enter a value in the field. The default is 1.0E-5.

Time step

Enter values in the fields.

This value is always in seconds.

l Initial. What is used as the initial time step. The
default is 1.0E-7.

l Smallest allowed. The smallest time step
allowed during the simulation. This is required
when using the automatic procedure to
determine the time step. The default is 1.0E-7.
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Setting Options

l Max % of simulation time. The default is 10.

Factor specifying the
maximum increase in the
time step taken from one
time step to another

For example, if 2 is entered the maximum time step is
twice as long as the previous time step taken.

Enter a value in the field. The default is 2.

Classic Model Specific

See also these Console commands for the equivalent settings:SET_SIMULATION_
CONDITION and SET_NUMERICAL_LIMITS.

Setting

Use the [activity or potential] of a component in order to find the correct tieline at the
phase interface.

Determines whether the program should use the potential or the activity of a component
in order to find the correct tie line at the phase interface. The potential or the activity is
varied by the program and is set in order to reduce the degrees of freedom at the local
equilibrium.

Required accuracy during the solution of the flux balance equations. The default is 1.0E-
16.

Homogenization Model Specific

This section is available when Homogenization is selected (or automatically
selected) as the Default solver. These settings are available on the Options tab.

See also these Console commands for some of the equivalent settings: ENTER_
HOMOGENIZATION_FUN and HOMOGENIZATION_MODEL.

Setting Options

Homogenization
function

Several functions are available. The default is Rule of mixtures
(upper Wiener bound). See "About the Homogenization Functions"
on page 103.
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Setting Options

Use global
minimization

Select the check box for global minimization used in equilibrium
calculations. In general, using global minimization significantly
increases the simulation time, but there is also a significantly
reduced risk for non-converged equilibrium calculations.

Interpolation
scheme

When the homogenization model is used, simulations are run using
an implicit finite volume method to increase numerical stability.
Because of this, and other factors, homogenization model
simulations generally run slower than other comparable simulations.
You can reduce simulation time with the Use Interpolation scheme
check box. The check box is selected by default.

[Logarithmic or
Linear]
discretization
with [number
of] steps in each
dimension.

l For the linear discretization the scheme is not used at node
points where the content of one or more solutes fall below a
certain critical value. For such cases, where composition span
many orders of magnitude, the logarithmic discretization can
be tried.

l Enter the number of steps in composition space. In the limit
where an infinite number of steps are used, exactly the same
solution is obtained as without the interpolation scheme.
However, excellent results can be obtained with a reasonable
discretization. The default is 10000 steps.

Memory to use

This is the fraction of free physical memory to be used by the
interpolation scheme.

SelectMegabyte or Fraction of free and then enter a value in the
field.
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About the Homogenization Functions

The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical
shells of each phase. For the general lower Hashin-Shtrikman bound the outermost shell
consists of the phase with the most sluggish kinetics and vice versa for the general upper
bound. The geometrical interpretation of the Hashin-Shtrikman bounds suggest further
varieties of the bounds, viz. Hashin-Shtrikman bound with prescribed matrix phase and
Hashin-Shtrikman bound with majority phase as matrix phase, where the outermost shell
consist of a prescribed phase or the phase with highest local volume fraction, respectively.

The geometrical interpretation of the Wiener bounds are continuous layers of each phase
either parallel with (upper bound) or orthogonal to (lower bound) the direction of diffusion.

The labyrinth factor functions (described below) are only available in Console
Mode. 

The labyrinth factor functions implies that all diffusion takes place in a single continuous
matrix phase. The impeding effect on diffusion by phases dispersed in the matrix phase is
taken into account by multiplying the flux with either the volume fraction (Labyrinth factor f
with prescribed matrix phase), or the volume fraction squared (Labyrinth factor f**2 with
prescribed matrix phase), of the matrix phase.

The varieties with excluded phases (described below) are only available in
Console Mode. 

The varieties with excluded phases are useful in several respects. First, if a phase is
modelled as having zero solubility for a component, the mobility of that component in that
phase is undefined, which causes a (non-terminal) error. Setting a phase as excluded causes
the mobility of all components in that phase to be set to zero. Second, often there are some
major matrix solid solution phases and some minor precipitate phases. If the mobilities in
the minor precipitate phases are zero the lower Hashin-Shtrikman bound is useless as it
produces a kinetic coefficient of zero. However, using General lower Hashin-Shtrikman
bound with excluded phase(s) the excluded phases are not considered when evaluating what
phase has the most sluggish kinetics.

Precipitation Calculator

The Precipitation Calculator is available with two elements if you do not have
the additional Precipitation Module (TC-PRISMA) license. With the add-on
module you can use all available elements.
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A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation
calculation. The Configuration window for a Precipitation Calculator has these tabs where
you define the settings:

l Conditions: Set the conditions for your calculation that define the Matrix and
Precipitate phases. Choose the Calculation Type.

l Options: Modify Numerical Parameters that determine how the conditions are
calculated. The Growth rate model can be set to Simplified or Advanced mode.

Example

Precipitation Calculator Settings
The table lists all the settings available from the Conditions and Options tabs.

You can edit the defaults for some of these settings by going to Tools →
Options → Graphical Mode → Precipitation.
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Name Details

Composition unit Choose from Mass percent, Mole percent, Mass fraction
or Mole fraction.

 Matrix Phase

Phase: Choose a phase from the list. The list is based on the settings for the System
Definer. When setting up your system, choose a matrix phase with kinetic data available
in the database.

Only phases with kinetic data can be selected as the matrix phase. If the list
is empty, go to the System Definer to make sure that both thermodynamic
and kinetic databases are selected and defined. See "System Definer" in the
Thermo-Calc User Guide or search the Online Help.

Click Show details to view these additional settings for the Matrix Phase:

l Molar volume: Choose the default to take the value from the Database or User-
defined to enter another value. Database is available in the list when the molar
volume for the phase is defined in the thermodynamic database.

l Grain radius: Enter a numerical value and choose a unit from the list. The default
is 1.0E-4 m.

l Grain aspect ratio: Enter a numerical value. The default is 1.0.

l Dislocation density: Enter a numerical value. The default is 5.0E12 m-3.
l Mobility enhancement prefactor: Enter a numerical value.

l Mobility enhancement activation energy: Enter a numerical value.

Precipitate Phase

Phase: Choose a phase from the list. The list is based on the settings for the System
Definer.

The phases available to choose have both thermodynamic and kinetic data.
If the list is empty, go to the System Definer to make sure that both types of
databases are selected and defined. See "System Definer" in the Thermo-
Calc User Guide or search the Online Help.

Nucleation sites: Choose one of the following from the list.
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Name Details

l Bulk, Grain boundaries, Grain edges, Grain corners, or Dislocations. Click to
select the Calculate from matrix settings check box if you want to calculate the
number density of sites from the matrix grain size or dislocation density.

l For Grain boundaries, Grain edges and Grain corners, enter the Wetting angle in
addition to the matrix settings.

l To enter a specific value for the number of nucleation sites, deselect the check
box.

Interfacial energy: Choose Calculated to use the estimated value and then enter a
different prefactor value if you want to adjust the estimated value. You can also choose
User defined to enter a value in J/m2.

Click Show details to view these additional settings:

l Molar volume: Choose the default to take the value from the Database or User-
defined to enter another value. Database is available in the list when the molar
volume for the phase is defined in the thermodynamic database.

l Phase boundary mobility: Enter a numerical value.

l Phase energy addition: Enter a numerical value.

l Approximate driving force: Select the check box to include this if simulations
with several compositions sets of the same phase create problems.

Calculation Type

Isothermal
Use an Isothermal calculation type to do a precipitation
simulation at constant temperature. Enter a Temperature
and Simulation time.

Non-isothermal

For the Non-isothermal calculation type, select a
Temperature unit and Time unit from the lists. Enter a
value for the Simulation time.

Click Thermal Profile. Here the Temperature and Time
coordinates of thermal profile points are entered. A
minimum of two points is required. You can also click
Import to add your own thermal profile from an Excel
spreadsheet.
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Name Details

EDIT THERMAL PROFILE WINDOW

TTT diagram

Use a TTT-diagram calculation type to do a precipitation
simulation of the time-temperature-transformation (TTT).

Enter Min, Max, and Step values for the Temperature
and choose a Unit from the list.

Max simulation time: Enter a numerical value and
choose a Unit from the list.

Stop criterium: Choose Volume fraction of phase or %
of equilibrium fraction and then enter a numerical value
in the field. For each temperature, the simulation stops
when the stop criterium is fulfilled or if the maximum
simulation time is reached, whichever happens first.

Numerical Parameters

Max time step fraction The maximum time step allowed for time integration as
fraction of the simulation time. The default is 0.1.

No. of grid points over one
order of magnitude in
radius

Default number of grid points for every order of
magnitude in size space. The default is 150.0.

Max no. of grid points over
one order of magnitude in
radius

The maximum allowed number of grid points in size
space. The default is 200.0.
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Name Details

Min no. of grid points over
one order of magnitude in
radius

The minimum allowed number of grid points in size
space. The default is 100.0.

Max relative volume
fraction of subcritical
particles allowed to
dissolve in one time step

The portion of the volume fraction that can be ignored
when determining the time step. The default is 0.01.

Max relative radius change The maximum value allowed for relative radius change in
one time step. The default is 0.01.

Relative radius change for
avoiding class collision Set a limit on the time step. The default is 0.5.

Max overall volume
change

This defines the maximum absolute (not ratio) change of
the volume fraction allowed during one time step. The
default is 0.001.

Max relative change of
nucleation rate in
logarithmic scale

This parameter ensures accuracy for the evolution of
effective nucleation rate. The default is 0.5.

Max relative change of
critical radius

Used to place a constraint on how fast the critical radium
can vary, and thus put a limit on time step. The default is
0.1.

Min radius for a nucleus to
be considered as a particle

The cut-off lower limit of precipitate radius. The default is
5.0E-10 m.

Max time step during
heating stages

The upper limit of the time step that has been enforced in
the heating stages. The default is 1.0 s.

Plot Renderer
The Plot Renderer is where you define the settings and output results in a diagram that
displays in the Results window. The available Plot Renderer settings are based on the System
Definer and calculator activity node predecessors (e.g. Equilibrium, Scheil, and Property
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Model Calculators). Setting availability is also determined by the calculation type. There are
also other "Plotting Options" on page 114.

Plot Renderer for the Add-On Modules

If you have an add-on Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA),
there can be additional functionality available on the Plot Renderer. See "Diffusion
Calculator Plot Renderer " on page 128 and "Precipitation Calculator Plot Renderer " on
page 130.

The Configuration Window
The following is an example of the Configuration window for a Plot Renderer that is the
successor to an Equilibrium Calculator.

The options along the top are available for most of the calculation types (e.g. phase
diagrams, property diagrams, min/max, uncertainty and so forth). For an Equilibrium
Property Grid calculation type and a Property Model Calculator Grid calculation you can also
choose a Plot type.
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Examples of Calculation Type Differences

l If you choose a Property grid (Equilibrium Calculator) or Grid (Property Model
Calculator) type, select a Plot type and whether to Interpolate the data or not.

l For a Property Model Calculator Uncertainty calculation type, you choose an Axis
type: Frequency, Histogram or Normal probability.

l For other calculators (e.g. Equilibrium, Binary, and Scheil) there are different axis
types available such as Linear, Logarithmic, Logarithmic 10, and Inverse.

l If you are plotting a Property grid (Equilibrium Calculator) or Grid (Property Model
Calculator) then the X- and Y-axes always represent the quantities that define the
calculation axes, but you need to set a variable for the Z-axis (the axis perpendicular
to the plane defined by the X- and Y-axes).
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Plot Toolbar

Setting/Button Description

Save Diagram
Save the plot diagram.

Show Triangular Display the diagram in triangular form, with the X-axis along
the base and the Y-axis along the left side. Such a diagram is
often useful if you want to plot the fractions of two components
in a ternary diagram.

Show Grid
Overlay a grid on the diagram.

Switch Axes
Show the plotting X axis variable on the diagram’s Y-axis, and
the Y axis variable on the diagram’s X-axis.

Retain Labels
Toggle the default to keep labels displaying on the plot. By
default labels are retained.

Plot Settings

Setting/Button Description

Tie lines

Select how many tie lines to be plotted in the diagram. Every
nth number of tie line is plotted, where n is the number set
here. Consequently, the higher the number, the fewer the
number of plotted tie lines in the diagram.
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Setting/Button Description

This setting is not available if the Plot Renderer is a
successor to an Equilibrium Calculator where only
one axis is defined and varied (that is, an
Equilibrium Calculator that has performed a
stepping calculation).

Legend option Select whether the diagram’s legend displays the Stable
phases, the Axis quantity, or choose Off for no legend.

Legend style

You can select a Legend style for the Stable phases or Axis
quantity selected for Legend option. Choose None, All,
Constitution description, or Ordering description.

Also see "About Legend Styles" on page 117.

Plot type (property
grid or grid)

This menu is available if the Plot Renderer is a
successor to either an Equilibrium Calculator that
is set up to calculate a Property grid or a Property
Model Calculator that is calculating a Grid.

On a Heat map diagram, each equilibrium calculation in the
grid is represented by a colour-coded pixel, where dark red
represents the highest Z-axis variable value and dark blue
represents the lowest Z-axis variable value.

On a Contour diagram, Z-axis variable values are traced with
curves in the same way that height values are traced with
curves on a topographical map. The colors used originate from
the different data series.

From the Interpolate list, choose to interpolate data Never
(the default), Once, Twice or 3 times. This means points are
put in between calculated points in the grid and interpolated
instead of calculated in the calculation engine.

Interpolate (property
grid or grid)

Choose how many points of data to interpolate on a grid or
property grid to improve curve smoothness – Never, 20x20,
50x50, or 100x100. Try different settings for your own set of
data.
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Setting/Button Description

Axis variable

Set the state variable you want plotted along the X-axis and the
Y-axis.

If the stepping/mapping variables are changed in
the Equilibrium Calculator that precedes the Plot
Renderer, then the variables to be plotted along
the diagram’s X- and Y-axis are automatically
updated to the appropriate quantities.

Axis type Select the type of axis scale: Linear, Logarithmic, Logarithmic
10 or Inverse.

Limits

Specify the range along the axis to show in the plot. In the
fields, enter the minimum and maximum values of the axis
variable. You can also determine the step size between the tick
marks along each axis.

Select the Automatic scaling check box to allow the program
to set the limits.

Contour values and
Use custom contour
values (Z-axis,
contour plots).

The Use custom contour values check box is available when
Contour is selected as the Plot type. Select this check box to
enter one or a series of numbers in the Contour values field.
Numbers can be separated by a space, colon (:), semicolon (;)
or comma (,).

Add an axis and
Remove this axis
buttons.

Use these buttons to add additional X- and/or Y-axes to a plot
or to merge plots (to overlay one plot with another in the same
diagram). When merging plots, you define this variable as the
Z-axis. See "Plotting Options" below for details.

Plotting Options

The "Plot Renderer" on page 108 is a dynamic activity node with options such as being able
to:

l add more than one Plot Renderer to its predecessor node (i.e. one of the calculator
activities),

l add axes to the plots, and

l merge results in one plot.
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Plots can have more than one predecessor

A Plot Renderer can have several predecessors (if you want to plot several calculations in
the same diagram), in which case there are several tabs in the Configuration window, one
for each predecessor.

Several Plot Renderer activities (as well as Table Renderer activities) can be shown in the
Results window as different tabs. The figure is from Graphical Mode example 4 .

Also see "Plotting Several Calculations in One Diagram" on page 123 for details.

Add axes to plots

You can add additional X- and/or Y-axes to a plot to compare two or more variables at the
same time as in the figure.

Also see "Adding Axes to a Diagram" on page 124 for details.

Two variables plotted on the Y-axis.
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Merge results in one plot

You can merge (or overlay) calculated results for several variables into one plot. This is
similar to adding an axis, but instead of displaying different variables along the X- and/or Y-
axes, the same X and Y variables are used to compare the third variable (defined in the Plot
Renderer as the Z-axis).

As in the figure (from example 12 in Graphical Mode Examples), the driving force and
interfacial energy results are combined into one diagram. The X and Y axis is the same for
both (Mass percent Cr/Mass percent Mn).

Also see "Merging Plots into One Diagram" on page 126 for details of how to
combine diagrams.

A contour plot showing both the driving force and interfacial energy calculation results comparing
Mass percent Cr to Mass percent Mn.
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About Legend Styles

There are a variety of legend styles you can use to display detail about the phases.

The same legend styles are available for both Graphical Mode and Console Mode plots. For
Console Mode, use the command CHANGE_LEGEND.

In Graphical Mode the label styles are defined when using the "Plot Renderer" on page 108.
You can select a Legend style for the Stable phases or Axis quantity selected for Legend
option.

When there is a legend in the diagram you can append constitution and/or ordering
descriptions to the phase name.

If constituent description is included in the legend, then for each equilibria along a line in
the diagram, the largest constituent fractions are summed until they are equal or greater
than 0.6. This is done separately for each sublattice. If the equilibria along the line gets
different sets of constituents these are all appended to the list for that sublattice.

The ordering description is only printed for partitioned phases (phases that have a
disordered contribution) that begins with at least two identical sublattices (sublattices where
the set of constituents are identical). DISORD (disordered) is shown if site fractions are
identical between identical constituents on all identical sub lattices (with an error margin)
otherwise ORD (ordered) is shown in the legend.

If ordering between equilibria in a line are different, then ORD + DISORD is shown in the
legend.
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Legend Examples

To show the differences between labels, the following uses the same example file that
creates Figure 6 in TCNi8 database extended information document (found on the Thermo-
Calc website).

When All is selected for this specific example the label includes the following:

Specifically:

l There are two disordered FCC phases (matrix and carbide), one ordered FCC
(gamma prime), plus a phase NI3TA_D0A (called Delta in Ni-alloys).

l ORDERING shows the different FCC phases.

l CONSTITUTION shows that FCC_L12#1 is NbC, FCC_L12#2 is matrix with Ni and Cr as
major constituent, FCC_L12#3 is Ni3Al with Nb addition and NI3TA_D0A is Nb-rich
(eg. Ni3Nb).

Label Style Choice Examples

These examples are for each label style choice - None, All, Constitution or Ordering

The instructions are for when you are setting the options using the Plot Renderer. In Console
Mode, you choose the options (ALL, NONE, CONSTITUTION, or ORDERING) after the command
CHANGE_LEGEND.

When None is selected the legend includes the standard information about the phases.

When you select All the Constitution description and the Ordering description (when

http://www.thermocalc.com/media/23650/tcni8_extended_info_formatted_02.pdf
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there is ordering) are included.

When you select Constitution description, this is added to the standard description.

When you select Ordering description and when there is ordering, this is added to the
standard description.

Adding and Editing Plot Labels

To add a label text at a certain point in a plot, right click the point, and select Add Label. For
phase diagrams, the program suggests a label that you can keep or edit. The suggested label
specifies the names of the stable phases at the coordinate where you clicked. For all other
plot types, you enter your own text, which can either be Plain text or LaTeX formatted text.
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Add Label WIndow

Label Formatting

You can enter the label as Plain text or in LaTeX-formatted text. For LaTeX-formatted text
enter or edit the text as required. For example, underscores (_) are added before the
numbers to make subscripts in the label.

For a list of supported LaTeX commands, see:
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html.

By default when using LaTeX, you are in math mode and Thermo-Calc
automatically interprets the entered text as math. The above link uses the
dollar sign ($) in all the examples but this is NOT required. For example, if you
enter $E=mc^2$ this is displayed including the $ instead of the equation.

Entering a Mixture of Plain Text and Equations

When you enter text using LaTaX formatted text it displays by default on the plot in italics
and treats the text as an equation.

As in the following example, the top label does not display correctly because the label is a
mixture of text (Mole-Fraction) and an equation (Al2O3). In the bottom image, when the
same information is added as Plain text to the plot it now does not include the subscripts.

http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
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To add a mixture of plain text and equation text, you can exit math mode using the string
\textrm followed by the text to display enclosed in curly brackets. For example \textrm
{Mole-fraction }Al_2O_3 results in the label as shown:

In this example, you need to add a space at the end of fraction in order to
separate the text from the equation part of the label.

When working in Console Mode, you can also use the above windows on the
Console Results window to add and edit labels. In addition, you can use the ADD_
LABEL_TEXT command described in the Thermo-Calc Console Mode Command
Reference.

Rotation Angle and Show Anchor

By default the Show anchor check box is selected, which includes an arrow from the label
point to the coordinates.

If you do not want the label oriented horizontally in the Plot Renderer tab, then specify the
number of degrees of rotation in the Rotation angle field.

Click OK to add the label to the plot. You can also move a label by clicking and dragging it.
The default anchor arrow is added to indicate the point that belongs to the label.

Moving Labels in a Plot

Drag and drop labels anywhere on the plot. The anchor arrow points to the point of origin.
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Changing the Plot Properties

For global changes to the default settings plots see "Global Settings: Graphical and Console
Mode-Plotting" on page 233. The settings are the same but applied to all new plots.

To make local changes to the appearance of a specific plot, in the Results window right-click
a plot and select Properties. You can also edit some properties for individual plot lines (the
color, the line width and type, and whether data points are included).

In the Results window, hover the mouse over a plot line. When it is over a line that can
clicked the crosshair cursor turns into a pointing finger.

To prevent unintended edits, hold down <Ctrl> while moving the cursor around
the plot to only display it as a crosshair.

Saving Plots

1. To save a diagram, at the top of the Configuration window click Save Diagram.
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Or right-click the diagram in the Results window and select Save As.

2. In the Save window, navigate to where you want to save the plot, enter a File name,
and choose the File type to save it in. Click Save.

Plotting Several Calculations in One Diagram

You can plot several calculations in the same diagram by adding extra predecessors to the
Plot Renderer activity.

For examples where several calculations are plotted in one diagram, see
Graphical Mode example tcex5.

To plot several calculations in one diagram, you must have, in addition to the Plot
Renderer’s original predecessor, at least one available Plot Renderer predecessor in your
project, for example, the additional predecessor can be an Equilibrium Calculator, Binary
Calculator, Ternary Calculator, Scheil Calculator or Experimental File Reader.

How to Plot Several Calculations in One Diagram

1. In the Project window click the Plot Renderer node.

2. In the Configuration window click Add Predecessor. Or right-click the Plot
Renderer and choose Add Predecessor.
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3. Select a predecessor. When added, the extra predecessor is linked to the Plot
Renderer. On the Plot Renderer’s Configuration window, the predecessors are shown
as two tabs:

4. Configure how you want each calculation plotted on the tabs in the Configuration
window, then click to Perform the Plot Renderer activity.

The calculations are plotted in the same diagram in a tab in the Results window. If
any of the axis variables of the plots differ, then the label and scale of all calculations
are shown parallel to each other. The following screen shot shows a diagram in which
two calculations with different plotting axes variables have been plotted.

Adding Axes to a Diagram

You can add additional X- and/or Y-axes to a plot to compare two or more variables at the
same time.
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1. In the Project window right-click the calculator node (e.g. an Equilibrium Calculator)
and add a Plot Renderer node from the Create New Successor menu.

2. Click the Plot Renderer node.

3. In the Configuration window, define the plot. Available settings are based on the
calculation type.

4. Click the Add an axis button. A new settings section is added underneath.

5. From the X Axis and/or Y Axis sections define another Axis variable and choose an
Axis type.

6. Click Perform to plot both variables on the selected axis, in this example, the Y-axis.
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Axis Example

In this example Amount of phase and Volume are selected as the Y-axis variables and
Temperature as the X-axis variable.

Plot Example

Merging Plots into One Diagram

You can merge (or overlay) calculated results for several variables into one diagram. The
same X and Y variables are used to compare the third variable (defined in the Plot Renderer
as the Z-axis).
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You cannot overlay heat map or frequency plots.

The following uses example 12 in Graphical Mode Examples to describe the steps to overlay
two plots: the driving force and interfacial energy results are combined into one diagram.
The X and Y axis is the same for both (Mass percent Cr/Mass percent Mn).

1. In the Project window right-click the calculator node (e.g. Property Model
Calculator) and add a Plot Renderer node from the Create New Successor menu.

2. Click the Plot Renderer node.

3. In the Configuration window, define the plot. Available settings are based on the
calculation type.

Example

In this example the Property Model Calculator is set to a Grid calculation type.

Choose On for the Legend option and Contour as the Plot type.

4. Click the Add an axis button. A new axes settings section is added underneath.

5. From the Z Axis section choose the Axis variable. In this example, Interfacial energy.

6. Click Perform to plot both on the same diagram.

Plot Example

In this case, a contour plot showing both the driving force and interfacial energy calculation
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results comparing Mass percent Cr to Mass percent Mn.

Results Window Status Markers

If you have plotted a diagram and then modify something in the tree that the Plot Renderer
is associated with, then a notification —an exclamation mark enclosed in a yellow triangle—
is shown in the Plot tab.

Also see "Node Status Markers" on page 48.

Diffusion Calculator Plot Renderer

The following is information about the settings available for a Plot Renderer when it is a
successor to a "Diffusion Calculator" on page 91. Also see "Plot Renderer" on page 108.

x-axis Variable

Select the variable for the x-axis: Distance or Time.

l For Distance also choose a unit (m, μm, or nm) and what region to include. The list
contains the regions defined on the Diffusion Calculator or you can choose All
regions.

l For Time choose a unit (Seconds, Minutes, Hours, or Days).
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y-axis Variable

Select the variable to plot on the y-axis. The available options are based on choices such as
whether Distance or Time is chosen for the x-axis, whether isothermal or non-isothermal is
selected, whether there is a homogenization solver, or if there is one or more regions.

Distance along the x-axis

If Distance is plotted along the x-axis, then by default the Composition is plotted along the
y-axis.

l From the center list, choose the component to plot, or select All.

l From the next list, choose the unit to be Mass percent, Mole percent, Mass
fraction, Mole fraction, or u-fraction.

Time along the x-axis (one region)

If Time is plotted along the x-axis, then choose the y-axis variable to plot plus the additional
settings:

l Total phase fraction: By volume or By mass. Then select a phase from the list.

l Total fraction of element: By mole or By mass. Then select a component from the
list.

l Total fraction of element in phase: By mole or By mass. Then select a component
and a phase from the lists.

l For a non-isothermal thermal profile Temperature is available: Kelvin, Celsius, or
Farenheit.

Distance along the x-axis (Homogenization)

If Distance is plotted along the x-axis and a Homogenization solver is being used, then
choose Composition or Phase fraction to plot on the y-axis. Then select the applicable
settings.

l Choose the component to plot, or select All and the unitMass percent, Mole
percent, Mass fraction, Mole fraction, or u-fraction.

l Choose By mole or By mass then select a component from the list.

Time along the x-axis (two or more regions)

If Time is plotted along the x-axis, then choose the y-axis variable to plot plus the additional
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settings:

l Total phase fraction: By volume or By mass. Then select a phase from the list.

l Total fraction of element: By mole or By mass. Then select a component from the
list.

l Total fraction of element in phase: By mole or By mass. Then select a component
and a phase from the lists.

l Composition at interface:Mass percent, Mole percent, Mass fraction, Mole
fraction. Then choose a Region and whether it is Upper or Lower and a component.

l Position of interface: Choose a unit (m, μm, or nm) and the interface.

l Velocity of interface: Choose a unit (m, μm, or nm) and the interface.

l Width of region: Choose a unit (m, μm, or nm) and the interface.

l For a Non-isothermal profile, Temperature is available. Choose a unit Kelvin,
Celsius or Fahrenheit.

Axis Type

Select the type of axis scale: Linear, Logarithmic, Logarithmic 10 or Inverse.

Limits

Specify the range along the axis to show in the plot. In the fields, enter the minimum and
maximum values of the axis variable. You can also determine the step size between the tick
marks along each axis.

Select the Automatic scaling check box to allow the program to set the limits.

Time

When the x-axis variable is Distance, choose a Time unit (Seconds, Minutes, Hours, or
Days).

Add and Remove Axes

Use the Add an axis and Remove this axis buttons to add additional X- and/or Y-axes to
a plot or to merge plots (to overlay one plot with another in the same diagram).

Precipitation Calculator Plot Renderer

The following is information about the settings available for a Plot Renderer when it is a
successor to a "Precipitation Calculator" on page 103. Also see "Plot Renderer" in the
Thermo-Calc User Guide or search for it in the Online Help.

There are also specific settings related to non-isothermal simulations that are detailed in
this topic.
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Plot Settings

Setting/Button Description

Legend option Select whether the diagram’s legend displays On or Off.

Axis variable

Set the state variable you want plotted along the X-axis and the Y-
axis.

Select the Separate multimodal PSD check box to enter settings for
Points, Excess kurtosis, Valley depth ratio andMinimum peak.

Axis type Select the type of axis scale: Linear, Logarithmic, Logarithmic 10 or
Inverse.

Limits

Specify the range along the axis to show in the plot. In the fields,
enter the minimum and maximum values of the axis variable. You
can also determine the step size between the tick marks along each
axis.

Select the Automatic scaling check box to allow the program to set
the limits.

Unit (Time X
Axis) Choose a Unit : Seconds, Hours, or Days.

Add an axis
and Remove
this axis
buttons.

Use these buttons to add additional X- and/or Y-axes to a plot or to
merge plots (to overlay one plot with another in the same diagram).
When merging plots, you define this variable as the Z-axis.

Non-Isothermal Simulations

When doing non-isothermal simulations it is common that particles grow in different
generations. This results in multi-modal size distributions. To correctly estimate the
properties of these different generations of particles you need to separate the peaks of
multi-modal distributions.

When the Separate multimodal PSD check box is selected on a Plot Renderer activity for
the Precipitation Calculator, the size distribution is evaluated at the given time steps and
checked for multi-modal peaks. These are separated and used to calculate the specified
property.
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It can be applied on the following plot properties:

l Mean radius

l Size distribution

l Number density

l Volume fraction

Points

This field is available whenMean radius, Number density or Volume fraction is selected as
the Axis variable. Since the evaluation of multi-modality at each time step is costly, you can
specify how many evaluation Points to use. The points are geometrically distributed over
the time scale where nucleated particles are found. The default is 40 points.

Time

This field is available when Size distribution is selected as the Axis variable. Enter one or a
series of numbers in the field, separated by a space, colon (:), semicolon (;) or comma (,).

Example

For example, if you enter 100.0, 1000.0 and 1.0E7 in the field:

When you click Perform the three times are plotted:
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Excess Kurtosis

The Excess kurtosis number specifies the sensitivity when the program evaluates whether a
curve is bimodal or not. The evaluation process calculates the excess kurtosis of the given
size distribution and compares it with the input value. If the value is lower than the given
value, the distribution is split. The excess kurtosis is a statistical measure that measures how
peaked and how heavy tail a distribution has. For the definition used see
http://en.wikipedia.org/wiki/Kurtosis. The default is 25.0.

Minimum Separation Limit (Valley Depth Ratio)

The Minimum Separation Limit is a rough method to prevent that noise or wiggles are
interpreted as different distributions. If a local minima is encountered above this value the
following peak is not interpreted as a new distribution. The valley depth ratio is the ratio of
the minimum separation limit to the peak value. The default is 0.01.

Minimum Peak

Any separated peak below the enteredMinimum peak value is removed. The default is
100000.0.

Table Renderer
A Table Renderer visualizes calculation results in a table. Several Table Renderer activities
(as well as Plot Renderer activities) can be shown in the Results window as different tabs.

You can only successfully tabulate the results of a single-equilibrium calculation or a
stepping operation. The tabulated data from an equilibrium calculation is different from the
tabulated data from a stepping calculation.

http://en.wikipedia.org/wiki/Kurtosis
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Also see "Creating Activities and Successors" on page 35 for a list of possible
successors and predecessors for this activity.

Tabulated Results from an Equilibrium Calculation

The following tab shows the result of an equilibrium calculation (from example 1 in
Graphical Mode Examples).

For each stable phase listed, from the Composition and constitution menu you can select
the information to view. In this example, the maximum amount of information is shown and
includes details about both composition and constitution for BCC_A2#1.

The default for the Phase description detail can be changed globally. From the
main menu select Tools → Options and click the Activities tab. Then click
Tabulation.

Setting Background Colours

To change the background colours of the table, in the Results window right-click a Table
Renderer tab, and select Properties. Modify as required.
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The defaults for these settings can be changed globally. From the main menu
select Tools → Options and click the Activities tab. Then click Tabulation.

Tabulated Results from a Stepping Operation

The Table Render 1 tab in the example shows the results of a stepping calculation (from
example 2 in Graphical Mode Examples).

Configuration Window Settings

You can edit the defaults for some of these settings by going to Tools →
Options → Graphical Mode → Tabulation. Also see "Global Settings:
Tabulation (Table Renderer)" on page 232.

Defining the Table Columns

In the Configuration window for the Table Renderer 1 node, set the level of detail for the
Columns.



Thermo-Calc Documentation Set

Graphical Mode Activities ǀ 136 of 238

Setting Number Format and Number of Decimal Digits

The table results can be presented in ordinary decimal number format or with normalized
scientific notion. The Number format defaults to Auto to use the most appropriate format
based on the tabulated data. Or choose Scientific or Decimal to increase or decrease the
number of Decimal digits used in the table. The default is 5 digits.

The defaults for these settings can be changed globally. From the main menu
select Tools → Options and click the Activities tab. Then click Tabulation.

Saving Tabulated Data

To save all the data in a table as a plain text file, in the Configuration window click Save
table or in the Results window right-click in the table and select Save As.

To copy the data from a single cell of a table to the clipboard, right-click the cell and select
Copy. To copy the whole table to the clipboard, select Copy all.

The data saved is what is shown in the Table Renderer tab. If data is calculated
but not displayed it is not saved.

Experimental File Reader
The Experimental File Reader activity can only be created from the top My Project node.
This activity allows you to read an experimental data file (*.EXP). This type of file has
information specifying a plotted diagram, written in the DATAPLOT graphical language.

Also see "Creating Activities and Successors" on page 35 and the DATPLOT User
Guide included with this documentation set.
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How to Plot an Experimental Data File

1. Right-clickMy Project and from the Create New Activity submenu choose
Experimental File Reader.

2. In the Configuration window in the EXP file field, enter the name of the EXP-file to
plot.

3. Click Create New Successor and select Plot Renderer. Or right-click the
Experimental File Reader node and from the Create New Successor submenu
choose Plot Renderer.

4. In the Configuration window click Perform or right-click the Plot Renderer node
and select Perform.

Binary Calculator
A Binary Calculator can be used for some calculations involving two components. You can
think of this activity as a combination of a System Definer and an Equilibrium Calculator, but
designed to simplify setting up and performing calculations on binary systems.

The Binary Calculator relies on some specifications that are not supported by all databases.
You need a specially designed database for the Binary Calculator such as the TCBIN
database.

For an example of how a Binary Calculator can be used in a project, see
example 3 in Graphical Mode Examples.

Configuration Window

The following shows the Configuration window of a Binary Calculator activity.
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Configuration Settings

The table lists the available settings to configure before performing the calculation.

Also see "Creating Activities and Successors" on page 35 for a list of possible
successors and predecessors for this activity.

Setting Description

Select database Select a database that contains specifications dedicated to
the Binary Calculator.

Elements

(periodic table)
In the periodic table, select the two elements that make up
the components of the system.

Phases and Phase
Constitution

This tab is the same as for a "System Definer" on page 61.
See Phases and Phase Constitution for an example.

Data Sources This tab is the same as for a "System Definer" on page 61.
See Data Sources for an example.
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Setting Description

Description This tab is the same as for a "System Definer" on page 61.
See Description for an example.

Calculation Type

Phase diagram Select to perform a mapping calculation. Click Calculate
Phase Diagram to plot the results.

Gibbs energy curves
Select the Temperature and click Calculate Gibbs Energy
Curves to calculate at a constant temperature over the
whole composition range.

Activity curves
Select the Temperature and click Calculate Activity
Curves to calculate at a constant temperature over the
whole composition range.

Phase fractions
Select the Mole fraction and click Calculate Phase
Fractions to calculate as a function of temperature at a
constant composition.

Ternary Calculator
A Ternary Calculator is used for some calculations involving three components. You can
think of this activity as a combination of a System Definer and an Equilibrium Calculator, but
designed to simplify setting up and performing calculations on ternary systems.

For an example of how a Ternary Calculator is used in a project, see example 4
in Graphical Mode Examples.

Also see "Creating Activities and Successors" on page 35 for a list of possible
successors and predecessors for this activity.

Configuration Window

The following shows the Configuration window of a Ternary Calculator activity:
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Configuration Settings

The table lists the available settings that must be configured before performing the
calculation.

Setting Description

Select
database

Select a database that contains specifications dedicated to the Ternary
Calculator.

Elements
(periodic
table)

In the periodic table, select the three elements that make up the
components of the system.

Phases and
Phase
Constitution

This tab is the same as for a "System Definer" on page 61. See Phases
and Phase Constitution for an example.

Data
Sources

This tab is the same as for a "System Definer" on page 61. See Data
Sources for an example.
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Setting Description

Description This tab is the same as for a "System Definer" on page 61. See
Description for an example.

Calculation Types

Isothermal
section

Select the Temperature at which the ternary system is calculated for
the whole composition range.

Monovariant
lines The variation of the liquid compositions with temperature is calculated.

Liquidus
projection

Select the Temperature range (Min andMax) and an Interval. The
projection liquid surface and the monovariant lines are calculated over
the given temperature range.

Scheil Calculator
The Scheil Calculator activity is used to perform simulations of Scheil (Scheil-Gulliver)
solidification processes. By default, a Scheil calculation results in an estimation of the
solidification range of an alloy. The calculation is based on the assumption that the liquid
phase is homogeneous at all times and that the diffusivity is zero in the solid. However, it is
possible to disregard the latter assumption for selected components.

By default, a Plot Renderer successor has the default plot axesMole fraction of solid (X-
axis) and Temperature Celsius (Y-axis). When these default axes are used in the Plot
Renderer, the results of normal equilibria calculations are automatically plotted in the same
diagram as the Scheil calculations.

See example 8 in Graphical Mode Examples.

Configuration Window

The main Configuration window of a Scheil Calculator activity is shown below and listed in
the table. These settings must be configured before performing the calculation.
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Configuration Settings

You can edit the defaults for some of these settings by going to Tools →
Options → Graphical Mode → Scheil. Also see "Global Settings: Scheil (Scheil
Calculator)" on page 232.

Setting Description

Start
temperature

Enter a Start temperature that is higher than the liquidus temperature
of the alloy, in other words, the temperature at which the alloy is
completely melted.

Temperature
step

Enter a Temperature step. Decreasing the temperature step increases
the accuracy, but the default value is usually adequate.

Temperature
unit Select the Temperature unit: Kelvin, Celsius or Fahrenheit.

Composition
unit

Select the Composition unit:Mass percent, Mole percent, Mass
fraction or Mole fraction.

Composition This is based on what is entered in the "System Definer" on page 61.

Fast diffuser Click to select the Fast diffuser check box to allow redistribution of this
component in both the solid and liquid parts of the alloy.

Scheil Calculator Advanced Options and Settings

Additional advanced settings are available as shown below and in the table:
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Click Show advanced options to open this configuration window:

Scheil Calculator Advanced Settings

Setting Description

Global
minimization

By default the Global minimization check box is not selected. Click to
select it to perform a global minimization test when an equilibrium is
reached. This costs more computer time but the calculations are more
robust.

Allow
BCC→FCC

By default the Allow BCC → FCC check box is not selected. Select the
check box to allow transformations in the solidified part of the alloy
caused by each of the components specified to be a fast diffuser. It is
recommended that you only select this for steels.

Liquid phase The default in the list is the Liquid phase already defined in the
database.

Terminate
on

Enter a value to terminate the calculation on the Fraction of liquid
phase or at a specific Temperature.

Max no. of
iterations

By default, the program tries 500 iterations before it gives up. As some
models give computation times of more than 1 CPU second/iteration,
this number is also used to check the CPU time and the calculation stops
if 500 CPU seconds/iterations are used.
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Setting Description

Required
accuracy

The default is 1.0E-6. This is a relative accuracy, and the program
requires that the relative difference in each variable must be lower than
this value before it has converged. A larger value normally means fewer
iterations but less accurate solutions. The value should be at least one
order of magnitude larger than the machine precision.

Smallest
fraction

The default is 1.0E-12. This is the value assigned to constituents that are
unstable. It is normally only in the gas phase you can find such low
fractions.

The default value for the smallest site-fractions is 1E-12 for all phases
except for IDEAL phase with one sublattice site (such as the GAS mixture
phase in many databases) for which the default value is always as 1E-30.

In Console Mode, the default of 1E-30 is true unless you are
using the command SET_NUMERICAL_LIMITS to reset an
even-lower value (e.g. 1E-45, that is naturally enforced to
all the phases in the system.

Approximate
driving force
for
metastable
phases

The check box is selected by default, which means the metastable
phases are included in all iterations. However, these may not have
reached their most favourable composition and thus their driving forces
may be only approximate.

If it is important that these driving forces are correct, click to clear the
check box to force the calculation to converge for the metastable
phases.

Also see "Creating Activities and Successors" on page 35 for a list of possible
successors and predecessors for this activity and "Scheil Simulations" on
page 181 in the Console Mode section.
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The Console Mode Interface
The following is an introduction to the Console Mode’s user interface and the command line
prompt.

Also see "The Graphical Mode Interface" on page 31 for information about that
mode.

In this section:

The Console Mode Layout 147

Console Window 148

Editing the Default Console Directory 149

Console Mode Results Window 151

Event Log Window 151

Console Mode Workflow 152

Typical POLY Module Workflow 152

Performing Calculations in Console Mode 153

Using the Command Line Prompt 154

Moving Between Modules and Submodules 154

Entering Command Names or Abbreviations 155

Specifying Parameters 156

Wild Card Characters 157

Controlling Console Output 158

Command History 159

Log, Macro and Workspace Files 159
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The Console Mode Layout
By default the first time you launch Thermo-Calc it opens in Graphical Mode. After this, the
mode defaults to the most recent one. You can switch back and forth between modes. To
open the Console Mode interface, click Switch to Console Mode on the toolbar.

The Console Mode User Interface

The currently selected window is called the active window. This has a darker title bar than
the other windows. The windows are:

1. Console, with a Console 1 tab.

2. Console Results, with a Results Console 1 tab as well as a sub-tab (Plot 1), which is
what is displayed in the window in the figure.

3. Event Log, which is the active window in this example.

Console Tabs

By default, the tabs are side-by-side:
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You can toggle to view the tabs top-to-bottom/stacked (click the button) and back to side-
by-side (click the button) or the button.

Open Console Windows

Open a specific window from the Window main menu, or select Reset Windows to return
to the default window layout.

Console Window
By default the Console window is on the left-hand side of the console. This is where you
enter commands. The window can have several Console tabs.

To open and close Console tabs:

l To open (or add), click the button, press <Ctrl+T> when the Console window is
active, or right-click a tab header and select New Console.

l To close, click the button, press <Ctrl+W> or <Ctrl+F4>, or right-click the tab
header and select Close.

l To close all tabs except one, right-click the header of the tab you want to keep and
select Close Other.

l To close all tabs and open a new one, right-click the header of any tab and select
Close All.

You can change the tab name, font and colours for an individual Console tab by right-clicking
its header and selecting Properties.

EXAMPLE
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Editing the Default Console Directory
You can add a startup parameter to a shortcut when launching Thermo-Calc on any of the
platforms. When you launch the revised shortcut, the file path is set to a user-defined
default directory. An example of why you might want to have a custom directory path is if
you use batch projects or if you have macro files for batch jobs. The custom directory file
path can also be viewed from within Console Mode.

The shortcut is only valid throughout the existing session; it is not saved as a
default. Each time you want to use this file path you must launch Thermo-Calc
from the customized shortcut.

The following uses Windows for the example.

Setting up the Default Console Directory

1. Right-click a shortcut to Thermo-Calc and click Properties.
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2. In the Thermo-Calc 2017a Properties dialog, Target field, add the following to the
end of the string: –r plus the “path to the default directory”. Include a space between
the –r and path, and use quotation marks around the full file path. A simple example:

-r “C:\Thermo-Calc_Macro_Files”

3. Click Apply and OK.

4. Launch Thermo-Calc from the shortcut where you added the parameter. You can
confirm that it is set correctly from within Thermo-Calc.

Viewing the File Path in Thermo-Calc

1. Launch Thermo-Calc from the short cut where you added the parameter.

2. In Console Mode, right click the Console window and choose Properties.
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3. In the Console Properties window the Default directory section displays the custom
file path.

Console Mode Results Window
By default, the Console Results window is on the right-hand side of the screen. This is where
plotted diagrams display. Each Console has its own Results tab in the Results window. All the
plots and tables generated are presented in the Results tab.

l To open new Plot tabs press <Ctrl+Shift+T> or click the add button.

l To open a new Plot tab for the currently active Console tab, press <Ctrl+Shift+T>. To
close the Plot tab, press <Ctrl+Shift+W> or <Ctrl+Shift+F4>.

Event Log Window
By default the Event Log window is collapsed (closed). It includes important information
about the commands that run and are completed, including error messages. Click once to
toggle it open and closed.
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Console Mode Workflow
Working with Thermo-Calc involves moving between different modules. The workflow
differs depending on the type of calculation:

l If you want to perform a calculation using the POLY module, you typically first
retrieve thermodynamic data in the DATA module, perform the calculation in POLY,
and visualize the results in the POST module. It is possible to define a system directly
in POLY using "DEFINE_MATERIAL" on page 200 and "DEFINE_DIAGRAM" on
page 196.

l If you want to calculate and plot a diagram using a response-driven module, such as
POTENTIAL or SCHEIL, then you can go directly to that module. Response-driven
modules prompt you to go through the steps to do the calculation and the required
post-processing. These modules include BIN, TERN, POTENTIAL, POURBAIX, and
SCHEIL. You typically end up in the POST module after having used a response-driven
module. In the POST module you can modify the plots and save the diagram.

l If you want to tabulate a chemical substance, phase, or reaction, go directly to the
TAB module.

Typical POLY Module Workflow
The following represents the typical workflow when you perform calculations in the POLY
module. The solid arrows represent your typical movements between the modules. The
dashed arrows represent the movement of data within Thermo-Calc.

The basic workflow is:
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1. You are in the SYS module when you start Thermo-Calc in Console Mode.

2. In the DATA module define the system. Before performing a calculation, you must
define the system and retrieve thermodynamic data. The data is retrieved from a
database file (*.TDB or *.TDC).

3. The data needed to describe a system is then sent to the GIBBS module. This data is
accessed by the POLYmodule when you instruct it to perform calculations.

4. In the POLYmodule, perform the calculations.

l In POLY, the conditions are set for an equilibrium calculation (temperature, pressure,
system composition, etc.), then an equilibrium calculation is done.

l If you want to make a property or phase diagram, you set the conditions for a
stepping or mapping operation and perform that operation.

l This generates data that can be used to plot a property diagram (if a stepping
operation is performed) or a phase diagram (if a mapping operation is performed).

5. In the POST module plot and visualize your data.

l If a stepping or mapping operation is performed, then you can go to the POST
module and plot a property or phase diagram.

l The diagram can be plotted quickly using default settings, but you can also modify
which variables to plot of the diagram axes and change the appearance of the
diagram.

l You can save the diagram either as a plain text file with data about all the
coordinates or as an image file.

Performing Calculations in Console Mode
Calculations can be performed either in the POLY module, or using some of the response-
driven modules designed to perform specific types of calculations.

"About Equilibrium Calculations" on page 169 describes generally how to calculate and plot
Property Diagrams and Phase Diagrams. To calculate and plot a property diagram or a phase
diagram, you must first calculate an equilibrium.

Additional sections of use include "About Scheil Simulations" on page 182, "T0 Temperature
Simulations" on page 188, "About Paraequilibrium" on page 191, "About Potential Diagrams"
on page 195, and "About Aqueous Solutions" on page 199. Also search the online help or see
"TABULATION_REACTION Commands" on page 306 and "Equilibrium Calculations with the
POLY_3 Module" on page 163 in the Thermo-Calc Console Mode Command Reference.
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Using the Command Line Prompt
The command line prompt in the Console window tells you which module you are currently
in. When Thermo-Calc is first opened in Console Mode, you are in the SYS module, which is
indicated with the command line prompt SYS.

To use Console Mode, you type in commands at the command line prompt. The available
commands depend on which module you are in. You can list the commands by typing ? at
the prompt and then press <Enter>.

l "Moving Between Modules and Submodules" below

l "Entering Command Names or Abbreviations" on the next page

l "Specifying Parameters" on page 156

l "Wild Card Characters" on page 157

l "Controlling Console Output" on page 158

l "Command History" on page 159

Available SYS Module Commands

Moving Between Modules and Submodules
To go to a specific module, you typically use GOTO_MODULE (or just GOTO) followed by the
name of the module. For example, to go to the DATA module, type GOTO DATA.

The exceptions are the submodules POST and ED-EXP:

l To go to the POST module, you must enter the POST command from within the POLY
module or DICTRA module (if you have the add-on license).
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l To go to "Experimental Data Files" on page 72, you must enter the ED-EXP command
from within the PARROT module.

To go back to the previous module type Back. For example, if you are in the DATA module
and entered it from the SYS module, when you type Back, you return to the SYS prompt. This
command is also available to exit from the submodules POST and ED-EXP.

Without a valid Thermo-Calc license, you cannot leave the SYS module. To enter
the DICTRA and DIC_PARROT modules, you also need a valid Diffusion Module
(DICTRA) license key.

Entering Command Names or Abbreviations
The name of a command typically consists of terms linked with underscores, for example,
"LIST_EQUILIBRIUM" on page 209. Note the following:

l UPPER or lower case letters are OK.

l Hyphens (-) instead of underscores (_) are OK, e.g. LIST-EQUILIBRIUM.

l You can abbreviate commands as long as it is unambiguous, e.g. when more than
one command begins with LIST_, you need to type the next letter or word to
distinguish between the commands.

l Each word can be abbreviated e.g., L_E for LIST_EQUILIBRIUM.

Command Names and Abbreviations Examples

These are examples of how you can abbreviate commands at the command line prompt.

Command name Abbreviation

CALCULATE_EQUILIBRIUM C-E

CALCULATE_ALL_EQUILIBRIA C-A

LIST_EQUILIBRIUM L-E

LIST_INITIAL_EQUILBRIUM LI-I-E

LOAD_INITIAL_EQUILBRIUM LO-I-E

LIST_PHASE_DATA CBCC L-P-D CBC

LIST_PHASE_DATA CEMENTITE L-P-D CEM

SET_ALL_START_VALUES S-A-SS-AL



Thermo-Calc Documentation Set

The Console Mode Interface ǀ 156 of 238

Command name Abbreviation

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025 S-A-V 1 X(F,FE) 0 .89 .025

SET_START_CONSTITUENT S-S-C

SET_START_VALUE S-S-V

SET_AXIS_PLOT_STATUS S-A-P

SET_AXIS_TEXT_STATUS S-A-T-SS-A-TE

SET_AXIS_TYPE S-A-TY

SET_OPTIMIZING_CONDITION S-O-C

SET_OPTIMIZING_VARIABLE S-O-V

SET_OUTPUT_LEVEL S-O-LS-OU

Specifying Parameters
Running a command typically requires that several parameter values are specified, which
can be done directly in the command line after the command name. For example, to set an
axis variable for a stepping or mapping operation, enter:

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

You can also use SET_AXIS_VARIABLE and press <Enter>. At the command line prompt, you
then specify the parameters one at a time.

On all command lines, you can enter a question mark (?) for help. For some parameters,
enter two question marks (??) for more detailed information.

Default Parameters Values

When you are requested to specify a parameter, Thermo-Calc usually suggests an
appropriate default value, which is displayed at the prompt between two slash signs (//). For
example, this prompt means the default answer is TERMINAL:

OUTPUT FILE /TERMINAL/:

Press <Enter> to accept the default.

If you specify some parameters directly after the command name, then you can still choose
to accept default values for some parameters.

To accept the default value for a parameter, type a comma (,) instead of a value for that
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parameter. For the comma to be interpreted correctly, type a blank space on each side of
the comma. However, if you accept the default values for several parameters that follow
each other, then the commas can be typed in without blank spaces separating them: (,,,) is
interpreted in the same way as (, , ,).

For some commands and parameters, Thermo-Calc treats the values previously assigned as
default values if the command is used again. For example, if the first stepping or mapping
axis variable is specified as:

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

Then if you want to change a parameter value for this axis variable, type:

SET_AXIS_VARIABLE 1 , 0.1 ,,,

This changes the minimum value from 0 to 0.1 at which a stepping or mapping operation
halts. The other parameter values remain the same. Consequently, what is typed is
equivalent to:

SET_AXIS_VARIABLE 1 X(FCC,FE) 0.1 0.89 0.025

Wild Card Characters
You can sometimes use the asterisk (*) as a wild card character to, for example, refer to all
components, phases, or species, when showing calculated properties in the POLY module, or
when you set axis variables for plotting diagrams in the POST module.

When showing calculated properties in the POLY module, you can also use the dollar sign ($)
to refer to all stable phases.

For activity and/or chemical potential properties, the *and $ normally do not
work properly as wild card characters.

Wild Card Character Examples

These are examples of the wild card characters you can use to search commands at the
command line prompt.
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Command Action

SHOW_VALUE B(*) Lists mass (gram) of all components in the system.

SET_AXIS_VAR Y B(*) * Sets mass (gram) of all components in the system as Y-axis
variable.

SHOW_VALUE MUR(*) Lists chemical potentials of all components in the system.

SET_AXIS_VAR Y ACR(*)
* Sets activities of all components in the system as Y-axis variable.

SHOW_VALUE HM(*).T Lists heat capacities of all phases.

SET_AXIS_VAR Y GM(*)
* Sets molar Gibbs free energies of all phases as Y-axis variable.

SHOW_VALUE TC($) Lists curie temperature of all stable phases.

SHOW_VALUE W(*,*) Lists mass fractions of all components in all phases.

SHOW_VALUE W($,*) Lists mass fractions of all components in all stable phases.

SHOW_VALUE W(FCC,*) Lists mass fractions of all components in the FCC phase.

SHOW_VALUE W(*,FE) Lists mass fractions of the Fe component in all phases.

SHOW_VALUE W($,FE) Lists mass fractions of the Fe component in all stable phases.

SHOW_VALUE Y(*,*) Lists site fractions of all species in all sublattices of all phases.

SHOW_VALUE Y($,*) Lists site fractions of all species in all sublattices of all stable
phases.

SHOW_VALUE Y(*,*) Lists site fractions of all species in all sublattices of all phases.

Controlling Console Output
In response to a command Thermo-Calc may display a lot of text in the Console window.

l To pause the text on printing press <Ctrl+S>.

l To resume the printing on screen, press <Ctrl+Q>.

l When Thermo-Calc is performing a mapping operation, the results are continuously
printed in the Console window. To terminate the calculation of the current region of
the mapping and stop the output, press <Ctrl+C>.
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Command History
l To scroll through the last twenty commands used, type two exclamation marks (!!)
and press <Enter>.

l To repeat the last n commands, type ! followed by the number of previous
commands to be executed again.

l To scroll through previous performed commands, use the Up (↑) or Down arrow (↓)
keys.

l To read more information about the command history functionality in Thermo-Calc,
type ! ? at the command line prompt.

Log, Macro and Workspace Files
For DICTRA Console Mode see File Formats in the Diffusion Module
(DICTRA) User Guide

In Console Mode, Thermo-Calc uses different kinds of files, including:

l "Log Files" below (*.LOG)

l "Macro Files" on the next page (*.TCM or *.LOG)

l "Workspace Files" on page 163 in POLY (*.POLY3), GIBBS module (*.GES5), and the
PARROT module (*.PAR and *.POP).

l Experimental Data Files (*.EXP): See "Commands in the Experimental Data Files
(*.POP, *.DOP)" on page 73 in the Thermo-Calc Command Reference.

Log Files
Log files with the file extension *.LOG are plain text files used to save a sequence of
commands. Log files can be edited in a text editor.

l To start saving your input into such a file, use SET_LOG_FILE in the SYS module,
followed by the name of the file that you want to save your command sequence to.

l If you want to save the output in the log file as well, use SET_ECHO before the SET_
LOG_FILE command. Doing this is useful if you want use the log file later as a macro
file.

See "System Utilities Commands" on page 299 in the Thermo-Calc Console Mode
Command Reference.
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Macro Files
Macro files (with the file extension of either *.TCM or *.LOG) are plain text files used to save
a sequence of commands that can be loaded and executed. Macro files can be edited in a
text editor. When creating a command sequence, you add comments to the file by starting a
line with @@.

Macro files include comments, which you can either run in Thermo-Calc or open and read in
a text editor.

If you only open and read the macro file in a text editor, you do not see the
output that Thermo-Calc gives in response to the commands stored in the
macro file. It is recommended you run the macro to view all the details.
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Opening a Console Mode Example Macro File

To open an example macro file for Thermo-Calc:

1. Open Thermo-Calc.

2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.

3. From the main menu, select File → Open Examples or Help → Open Examples. The
Console Mode folder opens with the Thermo-Calc examples in separate folders.

For the Diffusion Module (DICTRA) examples (*.DCM macro files), click the Up

One Level button and then double click the DICTRA folder.

4. In the folder, double-click the *.TCM file or click Open.

5. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the
macro and produce a plot in the Console Results window.

Macro File Commands

Also see Example 12 in .

Action Command Description and Comments

To load a macro
file

In the SYS module,
"MACRO_FILE_OPEN"
on page 5 followed by
the name of the
macro file.

Thermo-Calc starts the command
sequence that the file contains.
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Action Command Description and Comments

Regain control
of the console

"SET_INTERACTIVE"
on page 295

End a macro file with this command to
have control of the Console returned to
you.

Add comments
to a macro file

Start a line with @@,
or enclose it between
an @ (-line and a @)-
line.

When lines are enclosed the software
ignores them when running the macro.

Open a macro
file MACRO_FILE_OPEN

When creating the log file, you can make
a macro file load up to five other macro
files.

Nest macro files
inside of each
other

MACRO_FILE_OPEN

SET_INTERACTIVE

If a nested macro file ends with SET_
INTERACTIVE, then Thermo-Calc resumes
with the higher-level macro file at the
command immediately following the
MACRO_FILE_OPEN command that loaded
and executed macro file that has just been
terminated. If a nested macro file doesn’t
end with SET_INTERACTIVE (but with an
end-of-file character), then the console
shuts down and the macro is stopped.

Macro File Control Characters

The @? character allows you to make a macro interactive by allowing input. At the @?
character, which is placed where a parameter value or argument is normally put, Thermo-
Calc prompts to input the value of a parameter or argument. You can enter a string
immediately following the @? character. This string is presented to the user when prompted
to enter the parameter value or argument. The entered value is used by Thermo-Calc as
input to the command in question. For example, you can request the user to specify the
temperature range of a stepping calculation by entering the following in a macro file:

SET_AXIS_VARIABLE 1 T @?Low-temperature-limit: @?High-temperature-
limit:

You can also use up to nine variables in your macro file and prompt the user to enter values
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that can be assigned to these variables. Use the @#n character when you want to prompt the
user to provide a value to the variable, where the n is a digit between 1 and 9. You can then
use this value by with the ##n character. For example, you can request the user to provide
the first element of a system by entering the following in the macro file:

@#3First-element?

You can then use this variable with the entering the character ##3 later in the macro file.
For example, you can write:

SET_AXIS_VARIABLE 1 x(##3) 0 1,,,

Finally, there is the @& pause character. Thermo-Calc pauses and waits for input from the
user when this pause character is read from a macro file. Inserting pause characters is
useful if you want to allow the user to monitor what is happening when Thermo-Calc is
running the macro.

Response-Driven Modules and Macros

Macro files that are created while you use a response-driven module begin with the module-
entering command (for example, Goto_Module Scheil) followed by a number of lines with
responses to the module’s questions and requests. The file terminates with the commands
"POST" on page 214 or "SET_INTERACTIVE" on page 295 (this command gives you back
control of the Console). An empty line cannot be edited with any input rather than the
default answer (to a specific question). Comment lines, commands to open other macro
files, pause characters or input-controlling characters cannot be inserted between these
empty lines (otherwise the response-driven module cannot be executed properly).

Workspace Files
Workspaces files allow you to save all the data in your current workspace. A workspace
contains all the data, specified settings and the result of any calculations performed. The
saved data includes original and modified thermodynamic data, the last set of conditions
and options, and the results of any simulations. You use the command SAVE_WORKSPACES to
create this file type, which is available in the POLY, GIBBS and PARROT modules.

When in Thermo-Calc Console Mode:

l POLY Module workspace files have the file extension *.POLY3

l GIBBS Module workspace files have the file extension *.GES5.

l PARROT workspace files have two file extensions *.PAR and *.POP.

For DICTRA in Console Mode, the PARROT .POP files have the file extension
*.DOP.
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The workspace has all the settings specified and the result of any stepping or mapping
operations performed after using SAVE_WORKSPACES. Consequently, the command opens a
workspace in which all data is saved which is generated after the SAVE_WORKSPACE
command is executed. The saved data includes original and modified thermodynamic data,
the last set of conditions and options, and calculation results.

To load the data and calculation results of a workspace file, use the READ_WORKSPACES
command available in the POLY module. The file can be used for calculation in POLY,
visualization in POST, or data manipulation in GIBBS. You are also given the option in the
POURBAIX and SCHEIL modules to open a previously saved workspace file. This allows you to
make new POURBAIX or SCHEIL calculations on the same chemical system as before but
with different temperature, pressure, and composition conditions, or to plot new property
diagrams based on the previous calculations.

For DICTRA Console Mode see File Formats in the Diffusion Module
(DICTRA) User Guide

Main Menu Commands
The File menu and toolbar are reserved for Graphical Mode.

In Console Mode you use commands to access these menu options. The Tools,
Window and Help menus are described in "Main Menu and Toolbar" on
page 37. If there is an equivalent command, it is listed in the table below.

Option Command

Open files

In Thermo-Calc, drag and drop the file into the Console window.

In the SYS module: "MACRO_FILE_OPEN" on page 5

In the SYS module: "OPEN_FILE" on page 301

Save (workspace)
This command depends on the module you are in. Type ? at the
prompt to look for a command such as "SAVE_GES_WORKSPACE"
on page 128 (GIBBS module)

Exit In any module: EXIT

Close In the SYS module: "CLOSE_FILE" on page 300

Display license info In the SYS module: "DISPLAY_LICENSE_INFO" on page 300
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Increasing the Buffer Size
Sometimes the output overflows the window text buffer (see "Controlling Console Output"
on page 158). To increase the buffer size in a specific Console tab:

1. Right-click the Console tab header in the Console window (if this is the first Console tab,
it is labeled Console 1).

2. Click Properties, and increase the Buffer size in the Console Properties window.

Defining a System in Console Mode
Defining a system means to select the chemical components and to retrieve thermodynamic
data about those components from an appropriate database in order to do the calculations.
You use database(s) with thermodynamic data and then define what system elements as
components. Once the system is defined, you retrieve the system’s thermodynamic data
from the database(s).

l If you use a response-driven module to perform your calculation, such as BIN or
POURBAIX, then the module prompts you to select database(s) and define the
system.

l When doing calculations in the POLY module, you typically have to manually select
databases and define the system in the DATA module. However, it is also possible to
define the system directly in POLY using "DEFINE_MATERIAL" on page 200 and
"DEFINE_DIAGRAM" on page 196.

Also see "Database Commands" on page 11 in the Thermo-Calc Console Mode
Command Reference.



Thermo-Calc Documentation Set

The Console Mode Interface ǀ 166 of 238

How to Define a System in Console Mode

1. Go to the DATA module. At the SYS prompt, use GOTO_MODULE and enter Data.

2. Change the default database unless you directly specify the name of the database as
a parameter to the command. Type SWITCH_DATABASE and follow the prompts.

The second part of the command prompt indicates the current default database. For
example, if the prompt is TDB_TCFE8, then the current database is TCFE8.

3. Use DEFINE_ELEMENTS followed by a list of the elements that you want in your system.
(To list the elements that are available in your current database, use LIST_DATABASE
and choose Elements). For example, if you want to have Fe and C in your system,
type:

DEFINE_ELEMENTS Fe C

4. Use REJECT and choose Phases if you want to avoid retrieving any phases from the
database. (To list the phases that are available in your current database, use LIST_
DATABASE and choose Phases. To list the phases that can form in the defined system,
use LIST_SYSTEM and choose Constituent.) For example, if you do not want the
graphite phase to be retrieved, you type:

REJECT PHASES GRAPHITE

If the number of phases to include is much lower than the total number of phases,
then it can be convenient to first Reject Phases * and then restore the phases to
include using Restore Phases.

5. Use GET_DATA to search the database and send the thermodynamic data about your
system to the GIBBS workspace.

At this point you can proceed to the POLY module (with GOTO_MODULE POLY).
However, you may want to add elements, phases and species to the GIBBS workspace
from other databases. If so, then proceed to the next step.

6. Use APPEND_DATABASE to select the (additional) database from which you want to
retrieve data. This command works exactly in the same way as the SWITCH_DATABASE
command, with the exception that it does not reinitialize the DATA module and the
GIBBS workspace, but instead appends or replaces the data that has already been
retrieved with new data from the additional database.

7. Define your elements and specify whether to reject and restore any phases. Do this
in exactly the same way when using the SWITCH_DATABASE command (see steps 2
and 3).
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8. Use GET_DATA to search the database and add the thermodynamic data to the data
that already exists in the GIBBS workspace.

9. Use APPEND_DATABASE again if you want to add data from yet another database.
When you have retrieved all the data you need, you can proceed to the POLY
module.
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Equilibrium Calculations
In this section:

About Equilibrium Calculations 169

Calculating an Equilibrium 171

Calculating an Equilibrium with a Fixed Phase 172

Calculating an Equilibrium with Suspended or Dormant Phases 172
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About Equilibrium Calculations
An equilibrium describes what the composition of the end state of a system is, given a full
specification of state variables such as temperature, pressure, initial composition, system
size, etc. An equilibrium calculation is normally done in POLY-3 according to the Global
Minimization Technique, which ensures that the most stable minimum under the specified
conditions is computed.

For an equilibrium calculation to be performed, the state variables must all be set as
conditions for the calculations. Such conditions include, for example, temperature, pressure,
and system composition. When you calculate an equilibrium in the POLY module, you have
to set these conditions manually.

Setting Conditions

Setting a condition normally involves giving a single state variable a specific value. For
example, you can set the temperature to 1273.5 Kelvin (T=1273.5). Alternatively, setting a
condition can involve giving a linear expression with more than one state variable a specific
value. For example, you can set the mole fraction of the S component to be the same in the
liquid and the pyrrohotite phases (X(LIQ,S)-X(PYRR,S)=0).

The number of state variables that need to set is determined by the Gibbs Phase Rule.
Typically, the state variables to give values to are:

l temperature (in K)

l pressure (in Pascal)

l system size in number of moles (in mole) or mass (in grams)

l the fraction of each component (in number of moles or mass)

If you fix the phase of the equilibrium and all but one of the state variables, you can discover
the value of the other state variable at equilibrium.

It is possible to specify a set of conditions that does not have any equilibrium and the
program detects this by failing to reach equilibrium during the calculation.

State Variables for Setting Conditions

The following table lists some of the available state variables you can use to set conditions:
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State Variable SET_CONDITION Parameter

temperature in the system (in K) T

pressure in the system (in Pascal) P

system size (mole number in moles) N

system size (mass in grams) B

number of moles of a component in the system N(<component>)

mole fraction of a component in the system X(<component>)

mass fraction of a component in the system W(<component>)

activity of a component in the system ACR(<component>)

chemical potential of a component in the system MUR(<component>)

mole fraction of a component in a phase X(<phase>,<component>)

mass fraction of a component in a phase W(<phase>,<component>)

activity of a species referred to a phase at ambient
temperature and pressure ACR(<species>,<phase>)

chemical potential of a species referred to a phase at
ambient temperature and pressure MUR(<species>,<phase>)

enthalpy in the system (in J) H

enthalpy of a phase (in J/mol) HM(<phase>)
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Equilibrium Information Example

Calculating an Equilibrium
This topic explains how to calculate an equilibrium in POLY. To calculate an equilibrium
means to calculate the equilibrium composition of your system, given a full specification of
conditions that reduce the degrees of freedom of the calculation to zero.

If you are running a network client installation of Thermo-Calc and cannot enter
the POLY module, this may be because all the license instances on that the
license server makes available have been checked out.

Also see "Equilibrium Calculations with the POLY_3 Module" on page 163 in the
Thermo-Calc Console Mode Command Reference.

1. Define your system (see "Defining a System in Console Mode" on page 165).

2. Go to the POLY module. At the SYS prompt, type GOTO_MODULE and enter POLY.

3. Use SET_CONDITION followed by conditions and value assignments to set the
conditions of your calculation. For example, to set temperature, pressure, initial
composition and system size for a Fe-Cr-C system, you might enter the following:

SET_CONDITION T=1200 P=1E5 W(CR)=0.18 W(C)=0.0013 N=1

This sets the temperature (T) to 1200 K, the pressure to 1 bar (100,000 Pascal), the
mass fraction of Cr to 18 mole percent, the mass fraction of C to 0.13 weight percent,
and the total amount of material to 1 mole. The fraction of Fe in the system is
calculated from the fractions of Cr and C. You have to set the fraction of all the
components in your system except one.
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4. Use COMPUTE_EQUILIBRIUM to run the calculation.

5. Use LIST_EQUILIBRIUM to see the results of the calculation.

Calculating an Equilibrium with a Fixed Phase
There are many ways to calculate equilibriums in Thermo-Calc. The following is one
example.

You can calculate an equilibrium that has a certain amount of a certain stable phase. Use
"CHANGE_STATUS" on page 100 and choose Phase to specify the phase and the amount of
that phase (in normalized mole number) that you want to set as fixed. For example, if you
want to find out at what temperature a system starts to melt, enter the following:

CHANGE_STATUS PHASE LIQUID=FIX 0

You must leave the state variable whose equilibrium value you are interested in unspecified.
However, if you have already specified that state variable, you can make it unspecified again
by using "SET_CONDITION" on page 220 and set that state variable to NONE. For example, if
you have given temperature a value, you can type:

SET_CONDITION T=NONE

The calculated equilibrium includes the value of the unspecified variable at which the
equilibrium enters the phase that is fixed.

For an example where an equilibrium is calculated with a fixed phase, see
Console Mode example tcex07. Go to "About the Thermo-Calc Console Mode
Examples " on page 2 in the Thermo-Calc Console Mode Examples Guide.

Calculating an Equilibrium with Suspended or
Dormant Phases
You can calculate an equilibrium under the assumption that one or several phases are
SUSPENDED or DORMANT using CHANGE_STATUS and choose Phase. For example, to specify
that all phases except one should be suspended, you can first suspend all phases and then
enter a single phase in the following way:

CHANGE_STATUS PHASE *=SUSPENDED
CHANGE_STATUS PHASE FE_LIQUID=ENTERED

For an example where this is done, as well as where the status of phases is set
to be dormant, see Console Mode example tcex10. Go to "About the Thermo-
Calc Console Mode Examples " on page 2in the Thermo-Calc Console Mode
Examples Guide.
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About Property Diagrams
When you calculate and plot a property diagram, there is only one independent state
variable. Many different properties can be plotted as a function of this independent variable.
For example, if the independent state variable is temperature, then the mole fractions of all
phases can be plotted as a function of temperature. Or the composition of a specific phase
may be plotted relative to temperature, or the activity of a component in the system as a
whole or in a specific phase may be plotted relative to it.

A property diagram is plotted based on a series of equilibria that is computed while the
value of one state variable is varied between a minimum and a maximum value. This
variable is referred to as the stepping axis variable. In Thermo-Calc, first calculate one
initial equilibrium, and then new equilibria are calculated at incremental steps in both
directions on the stepping axis from the initial equilibrium. This continues until the stepping
operation has covered the length of the axis between a minimum and a maximum value that
is specified.

For an example of the calculation of a property diagram, see Console Mode
example tcex08. Go to "About the Thermo-Calc Console Mode Examples " on
page 2in the Thermo-Calc Console Mode Examples Guide.

Calculating and Plotting a Property Diagram
This topic explains how to calculate a property diagram in POLY. To calculate a property
diagram means to calculate a series of equilibria while the value of the stepping axis
variable varies between a minimum and a maximum value. With the exception of the
stepping axis variable, all the state variables that you set when you calculate the initial
equilibrium retain the values when the new equilibria are calculated.

"Equilibrium Calculations with the POLY_3 Module" on page 163 in the Console
Mode Command Reference.

1. Calculate an initial equilibrium in the POLY module (see "Equilibrium Calculations"
on page 168).

2. Use SET_AXIS_VARIABLE to set the axis variable, the minimum and the maximum
stepping variable values and the step length. The first parameter of SET_AXIS_
VARIABLE is the axis number. Since a property diagram only has one axis variable, this
is set to 1. For example, if you want to set the axis variable to temperature, and
calculate an equilibrium at every 50 K between a minimum temperature of 100 K
and a maximum temperature of 2000 K, enter

SET_AXIS_VARIABLE 1 T 100 2000 50
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An axis variable must be a state variable that is set when you calculated the
initial equilibrium. For example, if you set the fraction of a component in
number of moles, then you cannot set the mass fraction of this component as an
axis variable. Also, the minimum stepping variable value must be smaller than,
and the maximum value larger than, the value that you set the state variable to
when calculating the initial equilibrium.

3. Use STEP_WITH_OPTIONS and choose Normal to perform the stepping operation.

Thermo-Calc lists the phase regions along the stepping axis, the phases contained in
each region, and the number of equilibria calculated in that region. Each region is
defined by the phases it contains.

The number of equilibria calculated is not just the number of steps that are
performed according to the step length and the minimum and maximum values
on the axis variable. This is because Thermo-Calc calculates extra equilibria
when a new phase is discovered in order to determine the phase region
boundary more precisely.

EXAMPLE OF STEP WITH OPTIONS
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4. To plot the diagram, use POST to open the POST module and then use PLOT_DIAGRAM.
By default, the X-axis represents the stepping axis variable and Y-axis represents the
sum of the mole fractions of all phases (NP(*)).

Calculating a Property Diagram One Phase at a Time
There are many ways to calculate property diagrams in Thermo-Calc. One example is where
you can calculate a property diagram with a separate stepping operation being performed
for each phase at a time in its default most stable composition (the major constitution). This
is useful if you want to create a property diagram for a heterogeneous system with both
ordered phases and their disordered pairs.

To calculate a property diagram one phase at a time, use "STEP_WITH_OPTIONS" on
page 227 and when prompted choose One_phase_at_time to perform the stepping
operation.

Calculating Several Properties in the Same Diagram
There are many ways to calculate property diagrams in Thermo-Calc. The following is
another example. If you perform several stepping calculations after each other, the results
of these calculations are all saved in your workspace file. This allows you to the following:

l Calculate (and then plot) missing parts of a specific property inside the first property
diagram. These parts are calculated inside the range of the stepping variable with a
different control condition.

l Calculate (and then plot) two or more sets of a specific property on the same
property diagram for the same system. These can be calculated under different
control conditions with stepping operations being performed across the same
stepping axis variable range.

l Calculate phase boundary lines and then plot them in a corresponding phase diagram
for the same system. This can be especially useful for some defined secondary phase-
transformations. For example, if you want to find the phase boundary between BCC_
A1 and BCC_B2, or the equal-Gm for two specific phases, or the equal-fraction or
equal-activity for two specific phases of a certain species, then this can be useful.

Unless you have opened a new workspace file previously using SAVE_WORKSPACES , the
results of the stepping calculations are saved in a RESULT.POLY3 file. To save the results of
several stepping calculations in a file different from the workspace file that your results are
currently saved to, then use SAVE_WORKSPACES before you perform the first stepping
calculation.

SAVE_WORKSPACES overwrites and deletes the results of all previous stepping
calculations.



Thermo-Calc Documentation Set

Phase Diagrams ǀ 177 of 238

Phase Diagrams
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About Phase Diagrams
Phase diagrams have two or more independent axis variables. Any state variable that has
already been set can be used as the mapping variable for a mapping calculation and then as
the axis variable for a phase diagram. From a mapping calculation, many types of phase
diagrams can be plotted, with one of the mapped variables as one axis variable, and with
other mapped variables or any varied property (state or derived variables) or entered
symbol (variables, functions or table values) as the other axis variables.

All phase diagrams consist of zero phase fraction lines. There are two distinct types of phase
diagrams: those with the tie-lines in the plane of the diagram and those where the tie-lines
are not in the plane. The former includes binary phase diagrams and ternary isotherms. The
latter includes more general isopleth diagrams with one or more fixed extensive variables
(normally, this is a composition). The BIN and TERN modules calculate binary and ternary
phase diagrams. The POTENTIAL and POURABIX modules calculate the more general
isopleth diagrams and other related diagrams.

The following topics describe how to calculate the types of phase diagrams in the
"Equilibrium Calculations with the POLY_3 Module" on page 163 module. In POLY, you can
calculate phase diagram for systems with up to 40 components and with thousands of
phases. You can combine activity conditions and fixed phase status and fraction conditions in
any way. Thermo-Calc can calculate any arbitrary 2D section through composition space.

There is no guarantee that the conditions set will result in a calculation that
reaches an equilibrium.

For an example of the calculation and plotting of a phase diagram, see Console
Mode example tcex04. Go to "About the Thermo-Calc Console Mode Examples "
on page 2in the Thermo-Calc Console Mode Examples Guide.

Calculating and Plotting a Phase Diagram
This topic describes how to calculate a phase diagram in the POLY module. The commands
are described in "Equilibrium Calculations with the POLY_3 Module" on page 163 and
"Plotting and Visualization with the POST Module " on page 240.

1. Calculate an initial equilibrium in the POLY module (see "Equilibrium Calculations"
on page 168).

2. Use SET_AXIS_VARIABLE to set the first axis variable, its minimum and maximum
mapping value and the length of each incremental step on this axis. The first
parameter of SET_AXIS_VARIABLE is the axis number and is set to 1. For example,
suppose you want the mass fraction of C as your first axis variable. You want it to
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vary between 0 and 0.1, with the length of each incremental step being no more than
0.002. You then enter:

SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002

An axis variable must be a state variable that is set when you calculated the
initial equilibrium. For example, if you set the fraction of a component in
number of moles, then you cannot set the mass fraction of this component as an
axis variable.

3. Use SET_AXIS_VARIABLE to set the second axis variable and specify its minimum,
maximum, and step length values. The axis number is set to 2. For example, suppose
you want temperature as your second axis variable and you want it to vary between
900 K and 1900 K, with an incremental step of 25 K. You then enter:

SET_AXIS_VARIABLE 2 T 900 1900 25

4. If you want more than two axis variables, then use SET_AXIS_VARIABLE until you have
set all the axis variables. You can set up to five axis variables. Axis variables 3, 4 and
5 must be set temperature, pressure or to the chemical potentials of components.

You may want to save your workspace with SAVE_WORKSPACES before you perform the
mapping calculation. This saves the axis variables you have set. However, it
overwrites the results of any previous stepping or mapping calculations done.

5. Use MAP to perform the mapping calculation. The console lists the phase region
boundaries and the phases contained on one side of each boundary.

6. To plot the diagram, use POST to open the POST module and then use PLOT_DIAGRAM.
By default, the X-axis represents mapping axis variable 1 and the Y-axis represents
mapping axis variable 2.
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Calculating a Quasi-Binary Phase Diagram
There are many ways to calculate phase diagrams in Thermo-Calc. The following is an
example where a quasi-binary phase diagram is used for calculations on a ternary system in
which one component has an activity or chemical potential that is fixed (although if you have
fixed a phase and the phase composition varies, then the activity or chemical potential may
also vary). The tie-lines in a quasi-binary diagram are in the diagram’s plane of the diagram.
This means that the calculation follows the lever rule as well as other rules.

For an example of a calculation of a quasi-binary phase diagram, see Console
Mode example tcex17. Go to "About the Thermo-Calc Console Mode Examples "
on page 2in the Thermo-Calc Console Mode Examples Guide.

How to Calculate a Quasi-Binary Phase Diagram
Use CHANGE_STATUS to set the component that has a fixed activity or chemical potential. For
example, suppose you want to compute a phase diagram for a Ca-Fe-O system in which the
liquid oxide (FE-LIQ) is in equilibrium with liquid Fe. You then enter:

CHANGE-STATUS FE-LIQ=FIX 0

Calculating a Quasi-Ternary Phase Diagram
There are many ways to calculate phase diagrams in Thermo-Calc. The following is an
example of a quasi-ternary phase diagram used for calculations on a quaternary system
where one component has a fixed activity or fixed chemical potential.

When calculating a quasi-ternary phase diagram it is necessary to set a condition on either
activity or chemical potential of the fourth component. To specify a meaningful value it is
recommended that you first change the component’s reference state using SET_REFERENCE_
STATE. For example, to calculate a phase diagram for a quasi-ternary Fe-Cr-Ni-C system with
fixed carbon activity, you can enter the following:

SET_REFERENCE_STATE C GRAPH ,,

You must also use SET_CONDITION to set the activity of the component whose activity or
chemical potential you have fixed. Do this by assigning a value to the ACR state variable. For
example, if the component is carbon, you might enter

SET_CONDITION ACR(C)=0.002
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About Scheil Simulations
Thermo-Calc is primarily a program for performing equilibrium calculations, but some non-
equilibrium transformations or partial-equilibrium transformations can be simulated. One
example of such a transformation is a Scheil-Gulliver solidification.

In a Scheil-Gulliver solidification, the diffusion in the solid phases is assumed to be so slow
that it can be ignored, while the diffusion in the liquid phase is assumed to be very fast. With
this approximation, the conditions at the liquid/solid interface can be described as a local
equilibrium.

By making a stepping operation on the temperature variable (or enthalpy or amount liquid
phase) with small decrementing steps, the new composition of the liquid can be determined.
After each step, the amount of formed solid phase is removed and the overall composition is
reset to the new liquid composition. In effect, the whole system is described as a non-
equilibrium state regarding various parts of solidified phases at various solidification stages.

The Scheil Module

You can simulate Scheil-Guilliver solidification processes with the SCHEIL module. When you
enter the module, you are prompted to answer a series of questions about which database
to use, what the major element is and in which amount. Thermo-Calc then displays a
property diagram showing how the fraction of solid phase varies with temperature (in
Celsius). You can then plot diagrams using other variables you are interested in. Do this by
starting a new simulation, by opening an old file with the results of a previous simulation
that you can plot differently. For example, you might be interested in plotting the fraction of
remaining liquid against temperature, the fraction of each solid phase or the total of solid
phases against temperature, the microsegregation in each solid phase, or the latent heat
evolution against temperature.

It is possible to use the SCHEIL module to run a modified Scheil-Gulliver simulation that also
takes back-diffusion of some fast-diffusing interstitial elements such as C or N into account,
as well as BCC to FCC phase transformation phenomena.

Scheil Module Examples

l See Thermo-Calc Console Mode examples tcex15 and tcex30 in the Thermo-Calc
Console Mode Examples Guide to simulate non-equilibrium transformations without
considering fast-diffusion elements.

l See Thermo-Calc Console Mode example tcex48 in the Thermo-Calc Console Mode
Examples Guide to simulate partial-equilibrium transformation with fast-diffusion
elements taken into consideration. This example also shows how you can perform
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lever-rule calculations (full-equilibrium transformations).

Scheil and the Diffusion Module (DICTRA)

If you also have a license for the Diffusion Module (DICTRA), you can import a
previously calculated Scheil segregation profile into the software using the
command INPUT_SCHEIL_PROFILE. Search the online help or see the Diffusion
Module (DICTRA) Command Reference.

Simulating a Scheil-Solidification
Simulating a Scheil-Gulliver solidification process involves calculating the liquid composition
of a higher-order multicomponent system at each step of a cooling process, and resetting
the liquid composition as the composition of the entire system (after having removed all
amount of solid phase).

"SCHEIL Module" on page 293 in the Console Mode Command Reference.

1. Use GOTO_MODULE SCHEIL to enter the SCHEIL module.

2. Type START-WIZARD.

3. Specify which Database to use.

4. Specify the Major element or alloy in your system.

For example, for a steel/Fe-alloy, enter Fe, for an Al-based alloy, enter Al, and for a
Ni-based super alloy, enter Ni.

5. Set whether to specify the Composition input in mass (weight) percent (the
default) or in Mole percent. Enter Y for mass percent and N for mole percent.

6. Specify the name of the 1st alloying element. You can directly specify mass or
mole percent after the name (for example, enter Cr 5). If this is not specified, then
you are prompted to enter it separately.

7. Specify the other alloying elements in the same way as you specify the first (for
example, c 1).

8. After you have specified your last alloying element, press <Enter> when requested to
specify the next element. This ends the process of defining the bulk composition of
the alloy system.

You can also specify all the alloying elements and their corresponding compositions
on the same line when you are prompted to specify your first alloying element in Step
6. For example, you can enter Cr 5 Ni 1 Mo 0.5 C 0.01 N 0.02.
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9. Specify the starting Temperature (C) in Celsius. The default is 2000.

This value should be sufficiently high so that the solidification simulation starts with
the alloy system in the liquid single-phase region.

10. Decide which phases (if any) to reject at the Reject phase(s) prompt. Enter the
name of the phases to reject or press <Enter> for NONE.

11. Decide whether to Restore phase(s). You may want to restore a phase that you
rejected when you ran the simulation earlier, or you may want to restore a phase
that is rejected by default in your database. Enter the name of the phases to restore
or press <Enter> for NONE.

12. When prompted OK? type N to go back to Step 9 to reconsider which phases to reject
or restore. Type Y to continue.

Thermodynamic data about the alloy system you defined is retrieved from the
database.

13. At the Should any phase have a miscibility gap check prompt, press <Enter>
for N or answer Y.

If you answer Y, you are prompted to specify the Phase with miscibility gap.
Answer with a solution phase name(s) (in this example FCC is entered) as well as the
Major constituents for sublattice (for each sublattice site) (for this example,
Cr is entered for sublattice 1 and C for sublattice 2). In this example the Phase with
miscibility gap is LIQUID PHASE NAME: LIQUID.

14. Press <Enter> to specify another phase.

15. Specify the names of any Fast-diffusing components. Press <Enter> for NONE or
type all the names on the same line then press <Enter>. If you do specify any fast-
diffusing components, then you are prompted to set whether BCC to FCC phase
transformations should be simulated.

The Scheil-Gulliver solidification simulation runs, and the default diagram
(Temperature versus Mole Fraction of Solid) is automatically plotted in the Console
RESULTS WINDOW.
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Scheil Module State Variables
Post processing is done the same way as POLY-3 (see "Equilibrium Calculations with the
POLY_3 Module" on page 163), specific variables for plotting in the Scheil Module are listed.

The variables can be plotted along the X- and Y-axes. In the table, ph is an abbreviation of
phase, and el is an abbreviation of element. Use the abbreviations of the variables when you
specify what the X- and Y-axes represent in a diagram.

Abbreviation State variable

T Temperature in Celsius

NL/BL Mole/mass fraction of liquid

NS/BS Mole/mass fraction of all solid phases

NS(ph)/BS(ph) Mole/mass fraction of a solid phase

W(ph,el) Weight fraction of an element in a phase

X(ph,el) Mole fraction of an element in a phase

Y(ph,el) Site fraction of an element in a phase

NN(ph,el) Distribution of an element in a phases
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Abbreviation State variable

NH/BH Heat release and Latent heat per mole/gram

CP/BCP Apparent heat capacity per mole/gram

NV/NV(ph) Molar volume of the system or a phase

DS/DS(ph) Average density of the system or a phase

BT Apparent volumetric TEC of the system
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T0 Temperature Simulations
The T0-temperature is the temperature at which two phases have the same Gibbs energy for
a certain composition in a multicomponent system. The T0-temperature is located within the
two-phase field between the phases and it is the theoretical limit for a transformation
without diffusion. T0-temperatures are often of interest if you want to understand how
diffusionless transformations work. The T0 temperature in a multicomponent system with a
fixed composition is temperature at which the tangent lines of the Gibbs energies of the two
target phases are the same.

If the composition of one or two components varies, the common Gibbs energy for the two
phases in partial equilibrium of a diffusionless transformation becomes a plane or surface,
and the T0 temperature becomes a line or plane.

See Console Mode examples tcex23 and tcex41. Go to "About the Thermo-Calc
Console Mode Examples " on page 2 in the Thermo-Calc Console Mode
Examples Guide.

Also see "Making a T0 Temperature Simulation" below for step-by-step
instructions. as well as "Console Mode POST Module" on page 213.

Making a T0 Temperature Simulation
This describes how to perform a T0 temperature simulation and apply a stepping calculation
to its initial result.

Before you perform a T0 temperature calculation, you must have defined your initial system
and be in POLY. The initial overall composition must have appropriate settings for the
desired T0 temperature calculation for the two target phases.

See "Equilibrium Calculations with the POLY_3 Module" on page 163 in the
Thermo-Calc Console Mode Command Reference.

1. Use SET_CONDITION to set the conditions of your calculation in the same way as when
you calculate an ordinary equilibrium.

2. Use COMPUTE_EQUILIBRIUM to run the calculation. The calculation does not need to
reach an equilibrium in which any of the target phases is stable.

3. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS and
choose T-zero.

4. When prompted, specify the names of the two target phases for which the T0
temperature (where the phases’ Gibbs energies are equal) is to be calculated.
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5. If the T0 temperature between the two target phases is calculated, this temperature
(in Kelvin) is shown in the Console window. 

6. If you want to do a stepping calculation based on this initial T0 temperature
calculation, then use SET_AXIS_VARIABLE to specify which state variable to use as the
stepping variable. This is done the same way as when you calculate a normal
property diagram.

When a T0 temperature simulation is run, you cannot set temperature as the
stepping variable.

7. Use STEP_WITH_OPTIONS and choose T-zero to initiate the stepping calculation. You
are prompted to specify the names of the target phases for which the T0
temperature is calculated.

During the STEP T-ZERO calculation procedure, the calculated T0 values are
presented next to the stepping variable.

For example, part of the output might look like this:

Phase Region from  1.000000E-01 for:

BCC_A2

FCC_A1

1.000000E-01        940.24

9.250000E-02        941.20

2.500000E-03        977.61

7.500000E-09        979.34

When the stepping calculation has finished, you can move to the POST module and
plot the T0 line against the stepping composition variable or another varying axis
value. Or you can impose the calculated T0 line onto a normal phase diagram.
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About Paraequilibrium
A paraequilibrium is a partial equilibrium where one interstitial component (such as carbon
C and nitrogen N) in a multicomponent alloy can diffuse much faster than the other
components (the substitutional elements, including the matrix element and alloying
elements). The chemical potential for the interstitial component in two partially equilibrated
phases is equal in such a case, but this is not true for the other components. In such a
paraequilibrium state, it is possible to have a transformation that is partly without partitions,
where a new phase of the mobile component can form with different content but where the
slowly diffusing components retain their compositions.

A paraequilibrium calculation is useful when, for example, you want to study phase
transformations in systems with large differences in the diffusivities of different elements.
Transformations occurring under paraequilibrium states can be much more rapid than if full
local equilibrium holds at the phase interface.

See Console Mode example tcex42. Go to "About the Thermo-Calc Console
Mode Examples " on page 2in the Thermo-Calc Console Mode Examples Guide.

Also see "Calculating a Paraequilibrium" below for step-by-step instructions.

Calculating a Paraequilibrium
This topic describes both how to calculate an initial paraequilibrium with two target phases,
and how to base a stepping calculation on this initial calculation.

Before you do any paraequilibrium calculations, you must have defined your initial alloy
system and be in POLY. The initial overall composition must have appropriate settings for
the desired paraequilibrium calculation for the two target phases.

These commands are described in the Thermo-Calc Console Mode Command
Reference included with this documentation set.

1. Use SET_CONDITION to set the conditions of your calculation just like when you
calculate an ordinary equilibrium.

2. Use CHANGE_STATUS to set the status of the chosen interstitial components to
SPECIAL. For example, if C is an interstitial component, enter:

CHANGE_STATUS COMPONENTS C=SPECIAL
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This gives you a clear picture on u-fractions of the substitutional and interstitial
components, which are different from the overall composition in the system. The
SPECIAL status means that the specified components are not included in summations
for mole or mass fractions. Therefore, all the composition variables plotted from
paraequilibrium calculations are u-fraction related quantities.

3. Use COMPUTE_EQUILIBRIUM to run the calculation.

4. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS
Paraequilibrium to perform the paraequilibrium calculation.

5. Specify the names of the target phases of the paraequilibrium state. For example,
FCC#1 BCC and FCC#2 M23C6.

Both phases must have similar interstitial/vacancy sublattices that the fast-
diffusion interstitial components occupy. Both target phases should have phase
constitution definitions that cover all the defined substitutional and interstitial
components of the current alloy system.

6. Specify the names of one or more fast-diffusing components. These components
must be located on the interstitial/vacancy sublattices in both of the chosen phases.

Interstitial components (for instance C and N combined) may have significantly
different behaviours depending on how they are partitioned in different
structured phases.

If the paraequilibrium between the two specified phases is successfully calculated,
then a message is displayed, for example:

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N = 4.1548129E-
03

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N = 2.3781027E-
04

All other compositions are the same in both phases

The first two lines show the phase amounts expressed in mole-percent [NP(phase)]
and the contents of the interstitial components C and N in each phase. These contents
are expressed in u-fractions. The third line states that the compositions of the matrix
component and all the remaining compositions (regarding substitutional components)
are equal in the two target phases at the paraequilibrium state.

7. If you want to do a stepping calculation based on this initial paraequilibrium, then
use SET_AXIS_VARIABLE to specify which state variable to use as the stepping variable.
This is done exactly in the same way as when you calculate a normal property
diagram.
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8. Use STEP_WITH_OPTIONS→ Paraequilibrium to initiate the stepping calculation.
You are prompted to specify the names of the target phases of the paraequilibrium
states as well as the fast-diffusing components.

The stepping calculation is performed, and the different phase regions are listed with
columns for the value of the stepping variable, the amounts of the two target phases,
the u-fractions of interstitial(s) in each of the two phases, and the LNACR value(s) of
the interstitial component(s).

EXAMPLE

It is possible to now move to the POST module and plot some of the results of
the calculation. For an example of a paraequilibrium calculation and how it can
be plotted, see Console Mode example tcex23. Go to "About the Thermo-Calc
Console Mode Examples " on page 2in the Thermo-Calc Console Mode Examples
Guide.
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Potential Diagrams
In this section:

About Potential Diagrams 195

Calculating a Potential Diagram 195

Calculating a Potential Diagram with Different Pressure 196
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About Potential Diagrams
If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a so-
called potential phase diagram given certain temperature and pressure. A potential diagram
uses the activities of two major species in the gaseous mixture phase as mapping variables.
The activities (that is, the fugacities at 1 bar) of these two species are typically set as the X-
and Y-axis when the diagram is plotted. The phase relations between the gaseous mixture
and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are
represented by different fields controlled by these two potential quantities.

This topic describes how to calculate such potential diagrams with the POTENTIAL module,
and how to later modify the pressure of such a calculation in POLY. The calculation done by
the POTENTIAL module always assumes a pressure of 1 bar.

"POTENTIAL_DIAGRAM Module" on page 272 in the Console Mode Command
Reference.

Calculating a Potential Diagram
You need access to a substance or solution database that contains a gaseous mixture phase,
metals (or alloys), and solids such as metal-oxides, sulphides, sulphates, carbonates,
silicates, nitrides or nitrates (stoichiometric or solution phases).

"POTENTIAL_DIAGRAM Module" on page 272 in the Console Mode Command
Reference.

1. Use GOTO_MODULE and enter POTENTIAL.

2. Specify which substance or solution database to use. Any substance or solution
database can be used that has a gaseous mixture phase, metals (or alloys), and solids
such as metalxides, sulphides, sulphates, carbonates, silicates, nitrides, and nitrates
(stoichiometric or solution phases).

3. Specify the matrix element (a metal) and the two gaseous species that define you
metal-gas interaction system. The names of these components must be available in
the database you are using.

4. Set the temperature (in Kelvin). (The pressure is always 1 bar.)

A potential diagram with the activities of the two gaseous species as mapping
variables is calculated. These mapping variables are also set as the axis variables in
the plotted diagram.

The following is an example diagram (from example 35 in the Console Mode
Examples).
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EXAMPLE

A POLY3-file is also automatically saved in the current working directory with the
default name POT.POLY3.

5. When the diagram is plotted, it opens the POST module where you can modify the
plotted diagram in any way you like.

Calculating a Potential Diagram with Different
Pressure
It is possible to modify both the calculation and the plotted diagram that the POTENTIAL
module generates in the POLY and POST modules. You can do this by opening a POLY3-file
with the results from a POTENTIAL module calculation in either POLY or POST. You can
modify the calculation in the same way that you can modify any ordinary mapping
calculation or phase diagram. For example, this is useful for calculating a potential diagram
at a pressure other than 1 bar.

"Equilibrium Calculations with the POLY_3 Module" on page 163 in the Console
Mode Command Reference.

You must have calculated a potential diagram already, and have the saved POLY3-file
available.
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1. Use GOTO_MODULE and enter POLY.

2. Use READ followed by the name of the POLY3-file that contains the results of the
potential diagram calculation that you want to modify.

3. This opens the workspace file and loads the previous settings and results. The
activities of the two gaseous species is now part of the conditions, and these
conditions are set as the mapping variables.

4. Use SET_CONDITION to specify the pressure under which you want the potential
diagram to be calculated. For example, to set the pressure to 1000 bar, enter:

SET_CONDITION P=1e8

5. Use COMPUTE_EQUILIBRIUM to compute the initial equilibrium.

You may also want to use ADD_INITIAL_EQUILIBRIUM to calculate some additional
equilibria that the mapping calculations are based on.

6. Use MAP to perform the mapping calculations.

7. Use GOTO_MODULE and enter POST to set conditions for visualization and to plot the
diagram.
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Aqueous Solutions
In this section:

About Aqueous Solutions 199

Calculating a Pourbaix Diagram 200

Plotting Additional Aqueous Solution Diagrams 203

Stepping Calculations in an Aqueous Solution 205
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About Aqueous Solutions
Heterogeneous equilibrium calculations involving aqueous solutions are not different from
other equilibrium calculations, but the setup of the equilibrium conditions and the reference
states of the system is more complex. For example, the pH and Eh values of the aqueous
solution phase are normally complex functions of bulk composition, temperature and
pressure conditions.

For some simple systems, thermodynamic approximations of pH-Eh calculations can be used.
But Thermo-Calc also has comprehensive thermodynamic models and databases for various
non-ideal solution phases. These let you accurately calculate pH and Eh property diagrams
(and many other types of property diagrams) in complex aqueous solutions in a variety of
conditions.

A Pourbaix diagram is a pH-Eh phase diagram where the tie-lines are not in the plane. The
chemical potentials or activities of two system components (H+ and EA) are used as mapping
variables and the pH and Eh quantities are normally plotted on the X- and Y-axes of the
diagram. You can use many other properties as axis variables in various property diagrams
for the interaction system at a specific temperature and pressure. The phase relations
between the aqueous solution and various metal forms, oxides, hydroxides, sulphides,
sulphates, nitrates, silicates, carbonates and other solids, or gaseous mixtures, are
represented as different fields defined by acidity and electric potential.

You can calculate Pourbaix diagrams with the Pourbaix module. The compositional definition
and variations and the basic solvent and electron components H2O, H+1 and ZE are
automatically determined by the aqueous solution phase in the Pourbaix module.

See Console Mode examples tcex40 and tcex53. Go to "About the Thermo-Calc
Console Mode Examples " on page 2in the Thermo-Calc Console Mode Examples
Guide.

Key Components

These key components are defined as follows:

Component Component status Reference state Ref-T(K) Ref-P(Pa)

H2O ENTERED AQUEOUS * 100000

H+1 ENTERED SER

ZE  ENTERED REFERENCE_ELECTRODE * 100000

Besides the aqueous solution phase, your system may also contain a gaseous mixture phase.
Other neutral and charged gaseous species may also be constituents. For multicomponent
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systems there are normally also some interacting solid phases (stoichiometric or solution) as
the so-called secondary phases. These are typically the matrix and/or precipitate phases in
the alloys of interest.

Some databases have been specially developed for the Pourbaix module’s diagram
calculations. Such a database contains all necessary phases, i.e., an aqueous solution phase,
a gaseous mixture phase, some alloy solid solution phases and some secondary solid phases.
Databases developed for the Pourbaix module include PAQ (TCS Public Aqueous Solution
Database) or PAQS (TGG Public Aqueous Solution Database).

If such a dedicated Pourbaix module is not used, then an aqueous solution
database such as TCAQ (TC Aqueous Solution Database), AQS (TGG Aqueous
Solution Database), or any user-specified aqueous databases can be used.

This database contains at least the AQUEOUS and REFERENCE_ELECTRODE phases. The
aqueous solution database needs to be appended with additional required data and phases,
such as interacting alloy (solid) solution phases and secondary (solid and liquid) phases.
Additional data is from one or more databases, such as SSUB/SSOL/TCFE or other
substances/solutions databases.

Calculating a Pourbaix Diagram
The POURBAIX module lets you construct Pourbaix diagrams and other types of property
diagrams for heterogeneous interaction systems with aqueous solution phases.

When calculating a Pourbaix diagram, you need to have a database with an aqueous solution
phase (that is, a phase with water as the dissolving solvent and with aqueous cation/anion
and complex species as the dissolved solutes). Due to restrictions of aqueous solution models
(SIT, HKF, Pitzer) used in the Thermo-Calc software, the aqueous solution database must be
designed in the same Thermo-Calc database format as that used in the PAQ, PAQS, TCAQ
and AQS databases for the aqueous solution phase.

Pourbaix diagram calculations are done in the advanced Pourbaix module.

"POURBAIX_DIAGRAM Commands" on page 274 in the Console Mode Command
Reference.

How to Calcuate a Pourbaix Diagram

1. At the SYS prompt, enter GOTO_MODULE POURBAIX.

2. At the Need any instruction on the POURBAIX module? prompt, press <Enter>
to skip or enter Y to learn more.
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3. Press <Enter> at the prompt Enforce a PAUSE after plotting when running a
MACRO?.

4. Press <Enter> to accept the default 1 to Start a completely new POURBAIX
diagram calculation or enter 3 to Open an old file and make another
POURBAIX calculation.

To choose 3, you must have already done a Pourbaix calculation and have it saved in a
POLY3-file. The new calculation uses the same system definition as the previous
calculation, but the other conditions, such as the bulk composition, temperature and
pressure, can be modified in the next step.

5. Type Y or N to set whether to Consider the GAS phase (gaseous mixture phase) in
the calculation.

The gaseous mixture phase should at least contain H2O, O2 and H2. If a GAS phase is
not considered, then only the interactions between the aqueous solution phase and
various solid phases (alloy phases and secondary phases) are calculated. Such a
calculation may not accurately present all the heterogeneous interactions. Some
secondary phases are therefore usually needed. Such phases exist in the PAQ or PAQS
Public Aqueous Solution Databases. They can also be appended from the
SSUB/SSOL/TCFE or other appropriate substances/solutions databases.

6. Type Y or N to set whether to Use single database (Y) or a multiple database (N).

If you choose to use a single database, at the Combined Database: /PAQ2/ prompt
specify a database that is specially developed for the Pourbaix module’s diagram
calculations.

If you choose to use a multiple database, then you are prompted to specify an
aqueous solution database and to append any additional required data and select
necessary phases, such as various interacting alloy (solid) solution phases, and
secondary (solid and liquid) phases, for example.

7. Specify all your solutes and the molality of each solute when prompted to do so. This
can be done in terms of elements (such as Fe, Ni, Na, Cl, C or S) or arbitrary complex
species (such as NaCl, CO2, CoCl3, Fe0.93S, NaSO4-1, or H2SO4). You can enter the
element/species and the molarity on one line (for an example, NaCl 2.5).
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The first letter of the element abbreviation must always be upper case. Any
second letters must be lower case. When you have finished your specification,
press <Enter> when asked to specify Next solute.

The definition of your system and its initial bulk composition is now presented.

8. Type Y to confirm the defined system and its bulk composition.

The thermodynamic data for your system is now retrieved from the database(s)
chosen.

9. Answer the questions that you are prompted regarding various parameters of your
calculation. You are asked to do any of the following:

l Rejectphase(s)or Restore phases(s)

l Check for miscibility gaps on any phase (Should any phase have a miscibility
gap check?)

l Enforce the Global Minimization Technique in calculations?

l Save all functions, variables and tables in POLY3 file?

l Set numerical limits on the calculation

l Confirm defined conditions?

l Accept the default settings for two mapping variables

8. The Pourbaix calculation starts. Answer the question Any missing phase boundary
you could possibly think of? Type Y or N to set whether you want to add
starting points to the calculation. If you suspect that the calculation has missed some
phase boundaries, this may help the program to detect them.

9. Answer questions about how the diagram is plotted and how to save the results of
your calculation. You are asked to do any of the following:

l Change the pH/Eh steps for smoother curves?

l Zoom in on a specific region of the diagram
l Change the curve-label option for the diagram

l Add label-texts onto the Pourbaix diagram

l Change the subtitle of the diagram

l Change the axis-texts
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l Further refine the diagram in the POST Module

l Print the diagram (save a Hard copy of the diagram)
l Save the X-Y coordinates of curve on a text file

l Modify the diagram

l Calculate and plot another Pourbaix diagram (Any more diagram?)

Plotting Additional Aqueous Solution Diagrams
When you have calculated a Pourbaix diagram, you can plot additional diagrams based on
the results of the same calculation, but with different axis variables than Ph and Eh.

The variables can be plotted along the X- and Y-axes. Use the abbreviations of the variables
when you specify what the X- and Y-axes represent in a diagram. In the table, AQsp refers to
the name of a specific aqueous species. The asterisk (*) can be used as a wild card character
for all such species. If neither AQsp nor * is entered in parenthesis, then all species are
searched.

You must have plotted a Pourbaix diagram to plot a diagram with other variables than Ph
and Eh on the Y-axis and the X-axis. You can either plot such additional diagrams directly
after having finished the plotting and saving/printing of a Poubaix Ph-Eh diagram or by
choosing option 2 (Open an old file and plot other property diagrams) when you enter the
POURBAIX module and opening a POLY3 workspace file.

Abbreviations for Aqueous Solution Variables

Abbreviation Variable

pH Acidity

Eh Electronic Potential (V)

Ah Electronic Affinity  (kJ)

Pe Electronic Activity (log10ACRe)

IS Ionic Strength

TM Total Concentration

Aw Activity of Water

Oc Osmotic Coefficient
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Abbreviation Variable

MF(AQsp) Mole Fractions of Aqueous Species

ML(AQsp) Molalities of Aqueous Species

AI(AQsp) Activities of Aqueous Species

RC(AQsp) Activity Coefficients of Aqueous Species
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How to Plot an Aqueous Solution Diagram

1. Type Y when prompted whether to plot any more diagrams, or select option 2 when
you enter the POURBAIX module.

2. Specify which variable you want the X-axis to represent. Use the abbreviation
specified in the preceding table. When you specify the name of an aqueous species,
you can use the asterisk (*) to select all species.

3. Specify which variable you want the Y-axis to represent. The diagram is then
automatically plotted.

4. Answer questions about how the diagram is plotted and how to save it. You are asked
to do any of the following:

l change the axis-type (linear, logarithmic or inverse) on the X-axis or Y-axis

l zoom in on a specific region of the diagram

l change the curve-label option for the diagram 

l add label-texts onto the Pourbaix diagram

l change the subtitle of the diagram

l change the axis-texts

l refine the diagram in the POST Module

l print the diagram (save a hard copy)

l save the X-Y coordinates of curve on a text file

l modify the plotted diagram

l calculate and plot another aqueous solution diagram

Stepping Calculations in an Aqueous Solution

Performing the stepping calculation overwrites all the previous settings and
stepping results on the POLY3-file. To avoid this, use "SAVE_WORKSPACE" on
page 289 to create a new workspace.

When you have calculated a Pourbaix diagram, you can use the saved results of the
calculation (the POLY3-file), and make a property diagram based on stepping calculation.

Since the program normally sets the calculated initial equilibrium point as the starting point,
the minimum value for the stepping variable must be specified as smaller or equal to the
specific initial condition, and the maximum value as larger or equal to that condition. If pH is
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set as the stepping variable, the program automatically calculates the equilibrium constant
in logarithmic (log10Ka) of the electrolysis reaction H2O (water) = H+ + OH- for the real
aqueous solution under the current temperature-pressure-composition conditions, and thus
this constant log10Ka value is considered as the highest pH in specifying the maximum value
along stepping. Subsequently, confirm or modify an increment factor with a default value;
for pressure and mole of a component, specify the step in logarithmic (log10P or log10N). 

State Variable Abbreviations

You can use any of these state variables as a stepping variable.

State variable Abbreviation

Temperature (K) T

Pressure (bar) P

Acidity pH

Electronic potential (V) Eh

Mole number of a dissolving component (such as Fe,
Na, Cl, or NaCl) in 1 kg of water.

N(Comp)

(for example, N
(Fe))

How to Do a Stepping Calculation

You must have plotted a Pourbaix diagram before making a stepping calculation on an
aqueous solution.

1. Use GOTO_MODULE POURBAIX to enter the POURBAIX module.

2. Type 4 to Open an old file and make another STEPPING calculation.

3. Choose which POLY3-file to load.

4. Specify the conditions of the calculation by answering the questions that follows.

The system definition is the same as in the previous Pourbaix calculation, but you can
modify conditions such as bulk composition, temperature and pressure, and change
some component definitions if necessary.

5. Specify which variable to use as the stepping variable (see the preceding table), its
minimum and maximum value, and the length of each incremental step.
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The settings and stepping results are written to the opened POLY3-file, and a first
default property diagram is plotted.
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Console Mode TAB Module
In this section:

Tabulation of Chemical Substances, Phases or Reactions 209

Tabulating a Reaction 210

Tabulating a Substance or Solution Phase at Fixed Composition 211
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Tabulation of Chemical Substances, Phases or
Reactions
The TABULATION_REACTION (TAB) module can be used to tabulate thermodynamic
functions of any type of substance, stoichiometric phase or solution phase, or reaction. The
module can tabulate thermodynamic functions of pure stoichiometric phases or solution
phases at fixed composition, as well as various kinds of partial derivatives for a pure
stoichiometric phase or solution phase at a given composition.

The TAB module begins by evaluating the most stable species of a substance in either a
homogeneous state or in a reaction. Results are presented in a table or plotted as a graph.

Also see "Tabulating a Reaction" on the next page.

A reaction tabulation presents you with the following properties, on rows representing
different temperature levels:

l Heat capacity change / Delta-Cp (Joule/K) in column 2.

l Enthalpy change / Delta-H (Joule) in column 3.

l Entropy change / Delta-S (Joule/K) in column 4.

l Gibbs energy change / Delta-G (Joule) in column 5.

In the case of a tabulation of a substance or solution phase at a fixed composition, the
properties presented are the heat capacity, enthalpy, entropy and Gibbs energy, rather than
the degree of change in those properties.

Also see "Tabulating a Substance or Solution Phase at Fixed Composition" on
page 211.

You can add a 6th column to the table that shows the values of a property or user-defined
function of your choice.

EXAMPLE
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Tabulating a Reaction
A tabulation of a given chemical reaction provides you with data about the rate of change of
the standard tabulation properties at various levels of temperature. You can also add a
column for a property of your choice to the table.

"TABULATION_REACTION Commands" on page 306 in the Console Mode
Command Reference.

1. Use GOTO_MODULE TAB to enter the TAB module.

2. If you want to add one thermodynamic functions to the tabulation calculation, which
is present in a sixth column in the table, use ENTER_FUNCTION.

You are prompted to enter the name of the column that is given at its head, and the
function itself. The following state variables can be used to define the function: G, H,
S, T, P, V and H298.

3. Use TABULATE_REACTION followed by a formula that specifies of the reacting species
and products to perform the tabulation calculation. The name of the elements must
be entered in upper case letters only. Terminate the chemical reaction with a semi-
colon. For example, you can enter:

TABULATE_REACTION 3H2+N2=2N1H3;
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Elements that are designated with a single letter must be followed by a stoichiometry
factor, even if this factor is 1. CO hence be interpreted as Cobalt rather than as carbon
monoxide. Carbon monoxide is entered as C1O1 or O1C1.

4. Set the pressure, the range of temperature that you want the tabulation to cover,
and change in temperature between each row in the table. You can also specify if
you want to output the calculation results to an EXP-file and whether you want any
graphical output, and if so, which column you want to be plotted against
temperature.

The tabulation calculation is performed and you are given a table that shows the
various properties at each temperature level within the range defined.

If you have chosen to receive graphical output, then the Console Results window
presents a graph that plots the column of you chose (on the Y-axis) against
temperature (on the X-axis). When this graph is plotted, you are now in the POST
module, where you can modify the graph in various ways.

Tabulating a Substance or Solution Phase at Fixed
Composition
A tabulation of a substance or solution phase at fixed composition provides you with data
about the standard tabulation properties at various levels of temperature for a given
chemical reaction. You can also add one extra property column of your choice to the table.

"TABULATION_REACTION Commands" on page 306 in the Console Mode
Command Reference.

1. Use GOTO_MODULE TAB to enter the TAB module.

2. Use SWITCH_DATABASE to switch to a database that contains solution-based data,
such as TCFE for example.

You cannot use the default SSUB database when tabulating substances or
solution phases at a fixed composition.

3. If you want to add one thermodynamic function to the tabulation calculation, which is
present in a sixth column in the table, use ENTER_FUNCTION.

You are prompted to specify the column header and the function itself. The following
state variables can be used to define the function: G, H, S, T, P, V and H298.

4. Use TABULATE_SUBSTANCE followed by the name of the substance or solution phase to
perform the tabulation calculation.
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5. Set the pressure, the range of temperature that you want the tabulation to cover,
and change in temperature between each row in the table. You can also specify if
you want to output the calculation results to an EXP-file and whether you want any
graphical output, and if so, which column you want to be plotted against
temperature.

The tabulation calculation is performed and a table shows the various properties at each
temperature level within the defined range.

If you have chosen to receive graphical output, then the Console Results window presents a
graph that plots the column you chose (on the Y-axis) against temperature (on the X-axis). ).
When this graph is plotted, you end up in the POST module, where you can modify the graph
in other ways.
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Console Mode POST Module
In this section:

Console Mode Visualization 214

Plotting Diagrams 214

Modifying Diagrams 215

Saving Diagrams 217

Loading Saved Diagrams 217
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Console Mode Visualization
The results of a calculation in Thermo-Calc can be plotted by the post-processor module,
also called the POST module. The diagram is presented in the Console Results window.

In the POST module, you can define and plot various kinds of diagrams based on a
calculation. You can modify diagram type, which variables to plot on each axis and between
which minimum and maximum values, append experimental data from an EXP-file, change
labels and symbols in the diagram, zoom in on (and out from) a certain region in a diagram,
etc.

If you calculate a property or phase diagram in POLY, then you have to open the POST
module yourself. If your calculation was performed by a response-driven module such as
SCHEIL or POURBAIX, then the plotting of a diagram based your calculation is part of the
dialogue of questions and answers you have in that module (but under the hood, the
response-driven module is actually utilizing the POST module to get the plotting done).

Plotting Diagrams
Plotting a diagram is to graphically represent how several variables (typically two variables)
co-vary. Each axis in a property diagram or a phase diagram represents the value of one
variable. The default variables represented by the X- and Y-axes are the following:

l If you plot a diagram based on the results of a mapping operation (a phase diagram),
then by default the X- and Y-axes represent the mapping axis variables 1 and 2 (set
using "SET_AXIS_VARIABLE" on page 218 in POLY).

l If you plot a diagram based on the results of a stepping operation (a property
diagram), then by default, the X-axis represents the stepping variable (set using SET_
AXIS_VARIABLE) and the Y-axis represents the sum of the mole fractions of all phases
(that is, NP(*)).

"Equilibrium Calculations with the POLY_3 Module" on page 163 in the Console
Mode Command Reference.

How to Plot a Diagram

To plot a diagram, you must have already made a stepping or mapping operation in POLY
(or in some cases, made a calculation as part of some opening a response-driven module),
and you must have entered the POST module.

The POST command is available inside POLY. Use POST to enter the POST module
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1. If you want to directly plot your diagram with the default variables represented by
the X- and Y-axes, type Plot and press <Enter>. This plots a property or phase
diagram with the default variables represented at each axis. If you do not want to
plot your diagram with these default variables, go to the next step. 

2. Use SET_DIAGRAM_AXIS to set which variables to plot on the X-axis and the Y-axis. For
example, if you want to plot a phase diagram with pressure on the Y-axis and
temperature on the X-axis, type:

SET_DIAGRAM_AXIS X T

SET_DIAGRAM_AXIS Y P

3. Use PLOT_DIAGRAM to plot your diagram.

Modifying Diagrams
Modifying a diagram amounts to changing the settings that determine how the POST
module presents the calculated results and plots a new diagram. Suppose that you have
already plotted a binary phase diagram with the mapping axis variables temperature and
mole fraction of one of your components (the Fe component, say) on the X- and Y-axes. If
you then want to modify your diagram so that the Y-axis instead represents, say, the mass
fraction of Fe rather than the mole fraction, then you use "SET_DIAGRAM_AXIS" on page 259
to set diagram axis Y to w(Fe), and then use "PLOT_DIAGRAM" on page 253.

There are many ways in which you can modify your diagram and how it is presented. Any
modification made in the plot settings is taken into account the next time you use PLOT.

Modification Examples

The following commands are described in the Thermo-Calc Console Mode
Command Reference.

The following are some of the modifications you can make.

l Use "SET_TITLE" on page 270 to set add a title or to change an already existing title.
The title is displayed above the plotted diagram in the Console Results window.

l Use "ADD_LABEL_TEXT" on page 243 to add a label text that starts at a certain X-
and Y-coordinate. If you have plotted a phase diagram, then you can let Thermo-Calc
set the label text that specifies the names of the stable phases at that coordinate.

l Use "SET_AXIS_TYPE" on page 257 to set whether the scale of an axis is linear,
logarithmic or inverse.
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l Use "SET_DIAGRAM_TYPE" on page 261 to plot a triangular diagram with the X-axis
on the triangle’s base and the Y-axis on the triangle’s left side. Such a diagram is
often useful if you want to plot the fractions of two components in a ternary diagram.

l Use "SET_SCALING_STATUS" on page 268 to modify the range of values that are
displayed on an axis. In effect, you can use it to zoom in or out of the diagram. For
example, to set the scale of the X-axis to range from 0 to 0 .3, type:

SET_SCALING_STATUS X N 0 0.3

The X specifies which axis to change the scaling on, the N turns off Thermo-Calc’s
automatic scaling, and 0 and 0.3 specifies the minimum and maximum values on the
scale. You can turn on automatic scaling again by setting the second parameter to Y.

SET_LABEL_CURVE_OPTION Example

Use "SET_LABEL_CURVE_OPTION" on page 263 to label each set of curves that have the
same stable phases with a certain digit. A legend is also added, where you specify which
phases each digit designates.

LTEXT vs LaTeX Commands for Labels

As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For
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existing users who may have plots and files that use the LTEXT format, and
especially when using Console Mode, the following examples show the
command changes from LTEXT and its LaTeX equivalent:

Symbol or text
format LTEXT LaTeX

Subscripts in an
axis text

S-A-TEXT Y N Mole-fraction
Al^DO2$O^DO3$

S-A-TEXT Y N \latex Mole-
fraction Al_2O_3

Label with
subscript add .13 .15 n c-ZrO^DO2$ add .13 .15 n \latex c-ZrO_2

Greek symbol ADD .05 .50 N ^GRd$ ADD .05 .50 N \latex \delta

Also see "Changing Global Settings" on page 223.

Saving Diagrams
When a diagram is plotted, there are several ways in which you can save it:

l Use "DUMP_DIAGRAM" on page 246 to save the diagram image to a PS, PDF, SVG,
EMF, GIF, or PNG file. You are asked what format to save it in.

l To save the diagram image in a variety of image file formats, right click the diagram
and select Save Plot.

l Use "PRINT_DIAGRAM" on page 254 to print a hard copy of the diagram.

Information about the underlying calculations that the diagram is based on is
not saved in an EXP-file.

Also see the DATAPLOT User Guide included with this documentation set.

Loading Saved Diagrams
If you have previously saved a diagram in an EXP-file, then you can load and superimpose
the diagram on another diagram. Both the following command requires you to specify which
prologue and dataset(s) that are loaded from an experimental data file.

Use "APPEND_EXPERIMENTAL_DATA" on page 245 to plot selected data from an
experimental data file (EXP-file). If you have set the axes of the diagram already, the labels
on the diagram are not changed when you plot the additional data from the EXP-file,
irrespectively of the data in that file.
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Use "QUICK_EXPERIMENTAL_PLOT" on page 254 to plot selected data from an experimental
data file (EXP-file). If you have set the axes of the diagram already, these settings are
overwritten with the axes settings from the EXP-file.
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About the Database Files

Encrypted vs Unencrypted Database Files

Any licensed databases purchased from Thermo-Calc Software are encrypted in files with
the extension .TDC; these files cannot be edited. These are referred to as encrypted
databases.

Unencrypted databases have the file extension .TDB and can be edited. For example, PURE5
or PG35 (the free databases) or a user-defined database file. If you plan to edit any of these
files, see "Editing the Database Initialization File or Unencrypted Database File" on page 221
for information.

Database Installation Folder

Depending on the type of license and operating system, the encrypted Thermo-Calc
databases and the database initialization file are located in a subfolder to the Thermo-Calc
installation. For example, in a Windows standalone installation, you can find these in a folder
called data (file path is C:\Program Files\Thermo-Calc\<version>\data).

Database Initialization File

In Windows, the database initialization file is called tc_initd.tdb. In Linux and Mac it is
called initd.tdb. The file contains a list of all the databases available from Thermo-Calc
Software. Individual licenses are still required to use each database.

The file is used differently by the program depending on whether you are working with
databases in Console Mode or Graphical Mode. For this reason, editing the file can be
problematic if you don’t understand the differences. See "About Cached Database Files
(Graphical Mode only)" on the next page and "Editing the Database Initialization File or
Unencrypted Database File" on page 221 for more information.

User Database Files

A user-defined database is considered to be an unencrypted database because you can make
changes to it.
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In Graphical Mode you can add user databases via the Options → Graphical Mode →
System definer window. Once you have added the user database it is available from the
database list in the System Definer Configuration window. See "Global Settings: System
Definition (System Definer)" on page 227 to add a user database.

In Console Mode, users may decide to add their own user-defined database to the database
initiation file, which then makes it available in the Console window. If you plan to edit this
file, see "Editing the Database Initialization File or Unencrypted Database File" on the next
page for important information.

About Cached Database Files (Graphical Mode only)
Also see Global Settings "General" on page 224 where you can set the default
database directory path.

The first time you open a database in Graphical Mode it can take a little while for it to load,
especially if it is one of the large databases such as TCFE or TCNI. However, the next time
the database opens quickly because now the databases are cached, or stored, in Graphical
Mode.

Think of a cache as an intermediate storage area. Once a database cache is established the
file made easily accessible, even if you close the software program. It is the same concept as
when you load a web page for the first time. The next time the page opens faster. This is
also how it works for the databases in Thermo-Calc Graphical Mode.

Thermo-Calc caches the database files, both encrypted and unencrypted types, at two points
–when you first open a database, sometimes called an in-memory cache, and then later as a
disk-based cache.. The disk-based cache is what speeds up database loading and it is at this
point that Thermo-Calc refers to the database initialization file for information. The disk-
based cache uses a lookup key to find the abbreviated database name (e.g. TCFE8 or TCNI8)
contained in this initialization file.

It is important to understand the way databases are cached in Graphical Mode
to ensure best practices for those who also use Console Mode, especially if the
database initialization file is edited. If you plan to edit this file, see Editing a
Database Initialization File or Unencrypted Database File for important
information.
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Editing the Database Initialization File or
Unencrypted Database File
Some advanced users may decide to edit the database initialization file, for example to
reorder the list of encrypted databases displaying in the Console window or to add their own
user-defined database for use in Console Mode. It is important to understand that changes
to this file impact the database caching process used in Graphical Mode (see "About Cached
Database Files (Graphical Mode only)" on the previous page).

The following recommendations are also applicable if you edit an unencrypted database file,
which includes user databases and free databases such as PURE5 or PG35.

Best Practice Recommendations
If you edit the database initialization file (tc.initd.tdb in Windows or initd.tdb in Mac and
Linux), then:

l If a user database is added to the file, it is subject to the same caching as the
encrypted databases. This means that further changes (to the user database) will not
be detected when you are working with databases in the System Definer in Graphical
Mode.

If you have a user database, which is subject to regular updates, then:

l If you make changes to a user database, you then need to clear the cache.

l It is recommended that you create a separate directory to store unencrypted
database files.

If you edit an unencrypted database file included with the installation (such as the PURE5
and PG35 files):

l Do not edit the file in the installation folder. Instead make a local copy and load it
into the application as a user database.

Database Checker
The Thermo-Calc software package includes a program to check that the syntax of
unencrypted database files is correct. The program applies the syntax rules set out in the
Database Manager User Guide and reports errors and issues warnings. This program is
intended for advanced users who develop and manage databases.
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Thermo-Calc accepts deviations from these syntax rules. This means that a
database can work even if the Database Checker reports errors and warnings.
For example, an error is reported if an abbreviated phase name is found, but
phase name abbreviations are accepted by Thermo-Calc and its add-on
modules.

The executable DatabaseChecker file is found in the Thermo-Calc home directory. The
program can also be launched by selecting Tools→ Database Checker from the main menu.

Also see the Database Manager User Guide.
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Changing Global Settings
In the Options window (select Tools → Options) you can globally set general settings for
Graphical Mode as well as default settings for any new activities for both Graphical Mode
and Console Mode.

In this section:

General 224

General Global Settings 224

Graphical Mode - Default Units 226

Graphical Mode: Activities 227

Global Settings: Graphical and Console Mode-Plotting 233

Global Settings: Console Mode Default Appearance 236
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General

These settings are for both Graphical and Console modes. To open this window, from the
main menu select Tools → Options.

General Global Settings

Setting Options

Tooltips enabled

Select whether to turn on tooltips information. By default the
Tooltips enabled check box is selected. This displays a small text
box when you hover the cursor above some buttons or other
items. 

Localization
To change the GUI language from the Localization list choose
English (the default), Swedish, Spanish, German, Russian,
Chinese, Japanese or French.

Look and feel To change the Look and feel of the GUI layout, choose Windows
(the default), Metal, Nimbus, CDE/Motif or WindowsClassic.

Database directory

In the Database directory field, specify the path to the directory
that contains the data directory. This is where the Thermo-Calc
database directory called data is located. Do not specify the path
to where the database files are found (that is, in the data
directory).

Modifying the Database Directory Path (Graphical Mode Only)

Important Note: Database Directory Path (Graphical
Mode only)

When you open a database for the first time, it is stored in a
cache (an intermediate storage area), that is maintained even if
you close the program. This improves the speed of loading the
next time you open that database. The cache is used for all
databases that are listed in the database initialization file,
typically all the standard databases that are included with
Thermo-Calc.
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Setting Options

If you modify your own user-defined database, or if you choose to
edit an unencrypted database, it is recommended that you create
a separate directory to store these database files. This way the
most recent version of the user-defined or edited databases are
loaded into the program when the System Definer is performed.

Also see "About the Database Files" on page 219.

Model directory

This is where the predefined and custom property models are
saved and stored by default. ClickModify to open the default
folder or to create a custom folder for your own models.

All property models (whether these are predefined or
custom models) must be located in a subdirectory of
the property model directory. For that reason it is
recommended that you do not change the directory
location.

See "Property Model Calculator" on page 68 for
information about using the predefined models. Also
see "Creating a New Property Model" in the Property
Model Development Framework Guide for details
about creating a custom model.

Log level
Select the level and type of information to display in the Event
Log window using the Log level slide bar. Choose from a Debug,
Info, Warning or Error level of detail.

Check update
interval

From the Check update interval list, choose not to check (Don’t
check, the default) or On startup. You can also manually check
for updates – choose Help→Check for update.

Experimental Select the Use GES6 in Graphical Mode check box to enable this
functionality.
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Setting Options

Reset to original
settings

In the lower corner of the window, click the Reset to original
settings button to restore the original settings. You may have to
expand the window to view the button.

Graphical Mode - Default Units

To open this window, from the main menu select Tools → Optionsand click the Default
Units tab.

Setting Options

Temperature Kelvin (the default), Celsius or Fahrenheit

Pressure Pascal (the default), Atmospheres or Bar

Amount Mole (the default), Gram, Kilogram or Pound

Composition Mass percent (the default), Mole percent, Mass fraction or Mole
fraction

Energy Joule (the default), Calorie or Electron volt

Volume Cubic meter (the default), Cubic decimeter or Cubic centimeter

Density Kilogram per cubic meter (the default) or Gram per cubic meter

Entropy Joules per Kelvin (the default), Calorie per Kelvin or Electron volt per
Kelvin

Length Meter (the default), Micrometer or Nanometer

Time Seconds (the default), Hours or Days
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Setting Options

Reset to
original
settings

In the lower corner of the window, click the Reset to original settings
button to restore the original settings. You may have to expand the
window to view the button.

Graphical Mode: Activities

To open this window, from the main menu select Tools → Options and click the Activities
tab.

There are System definition, Calculation, Precipitation, Diffusion, Scheil, Plotting and
Tabulation settings windows.

For Plotting, the default settings are shared with the Graphical and Console
Modes. Any changes you make also apply to the default settings on the Console
Mode → Plotting tab in the Options window (and vice versa). See "Global
Settings: Graphical and Console Mode-Plotting" on page 233 for details.

Global Settings: System Definition (System Definer)

When you create a new System Definer, the default databases are taken from these
defaults. The database selections for each System Definer can then be configured
individually. Once created, the specific (local) settings for a System Definer are not affected
if you later make changes to the global defaults.

To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click System definition.

EXAMPLE
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Also see "System Definer" on page 61, "Creating a Database Package" on the
next page and "Clearing a Database Package Message" on page 230.

Setting Options

Default database selection

Choose to define a Database or a Database package.

If you choose Database, then select the default installed
database to use globally for all System Definer nodes. For
example, choose TCFE8 or TCNI8.

If you choose Database Package, select an option from
the list. These Database Packages are defined in Database
Packages.

User Databases

Database name

Click the Add button to add a custom database. After you
have added the user database it is available from the list
to choose as the default.

Once a user database is added to the Database name list,
you can also click the Remove button to delete it from
your project.

Database Packages

Based on the installed
databases, there are also
default Database
Packages available.

Create and remove Database Packages by clicking the
Add a database package button or Remove this
database package button.
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Setting Options

The addition or removal of a database
package does not take effect until a new
System Definer node is defined.

Click Show details to display the list of databases included
with the package. Click Hide details to only display the
name of the package. See "Creating a Database Package"
below.

Reset to original settings
In the lower corner of the window, click the Reset to
original settings button to restore the original settings.
You may have to expand the window to view the button.

Creating a Database Package

1. From the main menu select Tools → Options .

2. Click the Activities tab and click System definition.

3. Under Database Packages, click the Add a database package button.

4. Replace the default text with a name for the package, for example My database
package.

5. Select a database from the Choose database list, for example, TCNI8.

6. Click the Add a database button and from the Choose database list, select
another database, for example, TCAL4

7. Click OK. The Database Package is now available to choose as the default for new
System Definer activities.
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The package is available for new System Definer nodes defined after adding the
package.

"Clearing a Database Package Message" below and "Global Settings: System
Definition (System Definer)" on page 227.

Clearing a Database Package Message

Sometimes when working on the System Definer Configuration window, you may add or
delete Databases. If you originally added a Database Package, the addition or removal of a
database means that the original package you selected does not now match the databases
you are using. To clear the message Selected databases and selected package may differ
and reset the databases you need to either:

l Change the newly added database back to the one that matches the database package,
or

l Choose another package from the Package list, then select the package you want.

For example, from the Package list you select Demo: Steels and Fe-alloys.

This adds the FEDEMO andMFEDEMO databases.

If you add or remove Databases, in this example MFEDEMO is removed, then this does not
match the Package and the message displays:
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To clear the message, click the Add a database button and from the Choose database
list, select the database that belongs with the package, in this example, MFEDEMO. The
message is cleared.

You can also choose another package from the list, which changes the databases, and then
re-select the original package to reset the message.

"Creating a Database Package" on page 229 and "Global Settings: System
Definition (System Definer)" on page 227.

Global Settings: Calculation (Equilibrium Calculator)

When you create a new Equilibrium Calculator, its initial settings are taken from these
defaults. The settings of each Equilibrium Calculator can then be configured individually.
Once created, the specific (local) settings for an Equilibrium Calculator are not affected if
you later make changes to the global defaults.

To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Calculation.

See the "Equilibrium Calculator Options Settings" on page 87 for information
about the settings.

You can reset the defaults. In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to expand
the window to view the button.

Global Settings: Diffusion (Diffusion Calculator)

When you create a new Diffusion Calculator, its initial settings are taken from these
defaults. The settings for each Diffusion Calculator can then be configured individually. Once
created, the specific (local) settings are not affected if you later make changes to the global
defaults.

To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Diffusion. 

See "Diffusion Calculator" on page 91 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to expand
the window to view the button.
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Global Settings: Precipitation (Precipitation Calculator)

When you create a new Precipitation Calculator, its initial settings are taken from these
defaults. The settings for each Precipitation Calculator can then be configured individually.
Once created, the specific (local) settings for a Precipitation Calculator are not affected if
you later make changes to the global defaults.

To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Precipitation. 

See "Precipitation Calculator" on page 103 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to expand
the window to view the button.

Global Settings: Scheil (Scheil Calculator)

When you create a new Scheil Calculator, its initial settings are taken from these defaults.
The settings of each Scheil Calculator can then be configured individually. Once created, the
specific (local) settings for a Scheil Calculator are not affected if you later make changes to
the global defaults.

To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Scheil. 

See "Scheil Calculator" on page 141 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to expand
the window to view the button.

Global Settings: Tabulation (Table Renderer)

When you create a new Table Renderer, its initial settings are taken from these default
settings. The settings of each Table Renderer can then be configured individually. Once
created, the settings of a Table Renderer are not affected by changes in the default settings.

To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Tabulation.

See "Table Renderer" on page 133 for information about each setting.

You can reset the defaults. In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to expand
the window to view the button.
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Global Settings: Graphical and Console Mode-Plotting
The default settings are shared with both modes. Any changes you make also
apply to the default settings on the Console Mode → Plotting tab in the
Options window (and vice versa).

To make local changes to the appearance of a specific plot, in the Results window right-click
a plot and select Properties. In the Plot Properties window a variety of settings can be
made.

You can also edit some properties for individual plot lines (the color, the line width and type,
and whether data points are included). In the Results window, hover the mouse over a plot
line. The crosshair cursor turns into a cursor resembling a pointing hand when it is over a
line that can clicked. Alternatively, hold down the <Ctrl> key while you move the cursor
around the plot to only display it as a crosshair and prevent unintended edits.

To globally configure the default settings for plotting, from the main menu select Tools →
Options. Click the Graphical Mode → Activities tabs and then click the Plotting node.

When you create a new Plot Renderer, its initial settings are taken from these default
settings. The settings can then be configured individually. Once created, the settings of a
Plot Renderer are not affected by changes to the default global settings.

To configure the settings of an individual Plot Renderer rather than the default settings,
right-click a plot in the Results window and select Properties from the menu.

Plot Renderer Settings for Console and Graphical Modes

These global settings are available for both Console and Graphical Modes.
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Setting Options

Title

Enter a title. Select Plain text (the default) or LaTeX formatted
text.

Click α button to add symbols. Click a symbol category (for
example, Latin characters or Greek and math symbols).  Then
click to choose the symbol located on the right-hand side.

When you select LaTeX formatted text you can use the LaTeX
math text to enter text. See "ADD_LABEL_TEXT" on page 243 and
"Adding and Editing Plot Labels " on page 119 for more details.

Title font, Legend
font, Label font,
Header font

ClickModify to edit the Font Name, Style, Size and Color.

Legend phase
caption style

Choose All, Constitution description or Ordering description.
See "About Legend Styles" on page 117 for details about these
options.

Legend
background color,
Background color,
Canvas color,
Border color,

ClickModify to choose a color or enter a specific color.

Label format Select Plain text (the default) or LaTeX formatted text.

Show anchor By default, an anchor between the label and the plot point is
displayed.

Retain labels
(Graphical Mode
only)

By default the check box is selected. Plot labels are kept
(retained) when plots are updated. It can be applied globally or
locally to individual plots.

Show header
(Console Mode
only)

Click to select the Show header check box to display the basic
details about the plot along the top. This includes the date and
time the plot is generated, the database used and the properties.

Border width Choose a plot border width between 1 (thin, the default) and 10
(thick).
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Setting Options

Color option

For the plot line colors, choose from the options in the list:
Legacy, Printer friendly, JFree chart, Pastel, Medium dark,
Bright dark, Vivid or Earth.

This option is also available for specific plot lines. To change the
color of an individual plot line double-click it in the Results
window and use the color palette to define it or enter a specific
color.

Line width
For the plot line width, choose from the options in the list. These
options are also available for specific plot lines. To change an
individual plot line width double-click it in the Results window.

Line type

This option is only available for individual plot lines. To change an
individual plot line type double-click it in the Results window and
choose an option from the list.

Show data points

Click to select the check box to display the data points on the plot
lines. This option is also available for specific plot lines. To show
data points on an individual plot line double-click it in the Results
window and select the check box.

Data point marker
size

Choose the data point marker size between 1 (small) and 10
(large). The default is 3.

Plot area size
The Fit the plot area size to the enclosing window option is
selected by default. Excluding triangular plots, click Define the
plot area size to enter a Plot area height and Plot area width.

Reset to original
settings

In the lower corner of the window, click the Reset to original
settings button to restore the original settings. You may have to
expand the window to view the button.
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Global Settings: Console Mode Default Appearance
To open this window, from the main menu select Tools → Options. To change the name,
buffer size, fonts and colours for a specific Console window, right-click the label for that
particular Console and select Properties.

EXAMPLE

Setting Options

Console name The default is Console or enter another name to display

Buffer size
The default buffer size is 40,000. Also see "Increasing the
Buffer Size" on page 165 to adjust locally when in Console
Mode.

System output font

ClickModify to open the Select Font window and makes
changes to the font type, style, size or color as required.Command prompt font

User input font

Background color
ClickModify to open the Select Color window to choose a
background color for the Console Mode window where you
enter commands.

Default directory Set the default directory where log files and workspace files
are saved.

Reset to original
settings

In the lower corner of the window, click the Reset to original
settings button to restore the original settings. You may have
to expand the window to view the button.
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Technical Notes
In this section:

Technical Note: Pipe or Redirect Output Data from Console.exe 238
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Technical Note: Pipe or Redirect Output Data from
Console.exe

Audience: Advanced Programmers and Users

OS: Windows, Linux, or Mac

Application: For users who want to pipe or redirect data from the Thermo-Calc
console.exe program.

Command
syntax:

$more my_commands.tcm | ./Console.sh -E > results.log

OR

$./Console.sh -E < my_commands.tcm > results.log

Command
examples:

$more my_commands.tcm | ./Console.sh -E > results.log

OR

$./Console.sh -E < my_commands.tcm > results.log

Command line definitions

E

For Linux and Mac users, the Emacs style editing feature must be
disabled (turned off) using the switch -E in order for redirection and
piping to work correctly with Thermo-Calc. For Windows this flag is not
necessary.

|

Pipe command that forwards output data as input to subsequently
defined programs. For example, more my_commands.tcm |
./Console.sh pipes the information from my_commands.tcm to the
Console.sh script file.

<>

Redirection commands. The direction of each arrow indicates the flow of
data. For example in ./Console.sh -E < my_commands.tcm >
results.log, the contents of my_commands.tcm is used as input to the
Console.sh script file and the resulting output is then written to
results.log.
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Introduction to the Property Model Development
Framework

The guide, including tutorials and the classes and methods of the API, is 
available as a PDF in the Manuals folder and accessible from the Help menu.

The "Property Model Calculator" on page 68 in Thermo-Calc Graphical Mode has predefined
models available for immediate use and new models are being added on a regular basis.
The Property Model Development Framework enables you to create custom property models
that are then able to be included with the Property Model Calculator and ultimately used for
your simulations.

When you use the Property Model Development Framework API, it extends the software to
enable you to create property models. The models are written in the easy-to-learn
programming language Python and the API provides seamless integration into Thermo-
Calc. This includes access to thermodynamic and kinetic calculation routines as well as to
the Thermo-Calc plotting system.

This API is like a plug in to Thermo-Calc. It is not an SDK. That is, you cannot use
this API to build other applications to work with Thermo-Calc like you would use
the TC-API or the TQ-Interface.

The API is based on Jython, which is a Python implementation running in the Java Virtual
Machine. All Python libraries that are compatible to the Jython distribution can be used
within the model (but not libraries based on native C-code).
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Model development is possible without any additional installation by using a
text editor (for example Notepad++). However, it is recommended you use a
Python Integrated Development Environment (IDE), which provides you with
advanced features such as debugging and auto-completion.

predefined property model Installation Location

All property models (whether these are predefined or custom models) must be
located in a subdirectory of the property model directory. You can go to Tools
→ Options and the Model directory field displays the default directory.

Predefined models included with the Property Model Calculator are installed in the locations
below based on your operating system. If you create your own models, this is the default
directory where these are saved. You can also use one of these as a template to create your
own property model.

Operating
system Property Model installation directory

Windows C:\Users\Public\Public Documents\Thermo-Calc\ 2017a
\PropertyModels

Linux /home/user/Thermo-Calc/2017a/PropertyModels

Mac /Users/Shared/Thermo-Calc/2017a/PropertyModels
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Introduction to the Command Reference
In this section:

About the Console Command Reference 2

Thermo-Calc Console Mode File Types 2
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About the Console Command Reference
This command reference is for Console Mode users of Thermo-Calc software.
This guide describes the function and syntax of the commands available in the
Thermo-Calc modules.

If you have the Diffusion Module (DICTRA) also see the Diffusion Module
(DICTRA) Command Reference found in the Diffusion Module
(DICTRA) Documentation Set PDF.

The commands available in all or most modules are described in "General Commands" on
page 3.

The next topics are listed in alphabetical order based on the module names, then in each
subtopic, the module commands.

Abbreviations Used in this Guide

l For the prompts, Y stands for Yes and N stands for No.

l TC is for Thermo-Calc. For example, default file names often start with tc.ini.

Thermo-Calc Console Mode File Types
In Console Mode, Thermo-Calc uses different kinds of files, including:

l Log Files (*.LOG)

l Macro Files (*.TCM or *.LOG)

l Workspace Files in POLY (*.POLY3), GIBBS module (*.GES5), and the PARROT module
(*.PAR and *.POP).

l Experimental Data Files (*.EXP). See "Commands in the Experimental Data Files
(*.POP, *.DOP)" on page 73.

For links to more information about this topic go to "Log, Macro and Workspace
Files" on page 159 in the Thermo-Calc User Guide.

If you are working in Console ModeFile Formats in the Diffusion Module
(DICTRA) User Guide.
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General Commands
In this section:

BACK 4

EXIT 4

GOTO_MODULE 4

HELP (? and ??) 4

HELP 5

INFORMATION 5

MACRO_FILE_OPEN 5

SET_INTERACTIVE 8
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BACK
Also see "GOTO_MODULE" below.

Syntax BACK

Switch control back to the most recent module. Going from the POST module
(post-processor), BACK goes only to the TAB or POLY module (from where the
POST module is entered).

EXIT

Syntax EXIT

Exit the program and return to the operating system. Use a save command
before exiting otherwise all data and results are lost (in either the GIBBS, POLY,
PARROT or REACTOR module).

GOTO_MODULE
Switch between modules. The name of the module must be typed. To get a list of available
modules, press the <Enter> key.

Syntax GOTO_MODULE

Prompt Module name: <Module name>

If the <Enter> key is pressed without typing a unique module name (or typing a
? mark) it prompts for the MODULE NAME and lists the available modules.

HELP (? and ??)
Gives text help about the current prompt (whether this is the prompt of a module, or a
prompt that requests you to specify the value of some parameter).

Syntax ? OR ??

For some commands and prompts, more detailed help is given when two ?? are
entered.
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HELP
Lists the available commands or explains a specified command. Specifying a unique
command displays an explanation on screen. Typing a command abbreviation that is not
unique lists all matching commands. Get the command information by typing a unique
abbreviation or the complete command name.

Syntax HELP

Prompt

Command: <Command name>

Command name is the name of the command (one of the-module commands)
to get help.

If the <Enter> key is pressed without typing a command name, then all the
available commands are listed.

INFORMATION
Get basic information about topics related to the module you are in.

Syntax INFORMATION

Prompt

Which subject /Purpose/: <Topic name>

Specify a Subject (or its abbreviation as long as it is unique). Enter a question
mark ? for a list of topics.

MACRO_FILE_OPEN
The macro file functionality is a way to predefine sequences of Thermo-Calc commands
stored in a macro file (a basic text file usually with the default extension TCM for the
Thermo-Calc Console Mode or DCM for DICTRA module) and then executing all of the
sequences using this command (preceded by the macro file name). This command can be
used within various modules (i.e. the SYS, POLY, PARROT and TAB modules in the Thermo-
Calc (Console Mode) software; SYS, POLY, PARROT and DICTRA_Monitor).
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Syntax MACRO_FILE_OPEN

<Name of a macro file *.tcm>

An Open window displays to specify the filename of the macro file (*.TCM) with
the macro command, so that the path (in the Look in field) and File name can
be specified.

The Files of type *.TCM for Thermo-Calc (Console Mode) calculations and
*.DCM for DICTRA simulations, cannot be changed. Click Open or Cancel to
continue.

If the macro file contains commands to set *.LOG files, to save or read GIBBS,
POLY or PARROT workspaces, switch user databases, compile experiments
(from existing *.POP files), create new *.PAR files, append *.EXP files, plot or
dump diagrams, etc., a window (e.g. Save, Open, Print, etc.) displays on screen.
If required, these windows can be avoided by issuing the file names (preferably
with file-type extensions; if the files are not in the current working area where
the macro is located, the appropriate and complete paths of the files should
also be specified) and sometimes with the required options after the
corresponding commands or parameters/options. For details, see the related
commands and modules.

When using a macro file that intended to plot graphs on screen, but the
command "SET_PLOT_FORMAT" on page 264 is used to alter the plotting
environment from the default value, it is important to first use the command
SET_PLOT_FORMAT again to change back to the default value.

See example tcex12 in the Thermo-Calc Console Mode Examples Guide.

This is useful when the same or similar calculations are made frequently with small changes
[in terms of system definitions, data manipulations, conditions (for single points, stepping or
mapping calculations), plotting settings, etc.). For example, use this feature when calculating
phase/property diagrams during an assessment of thermodynamic data.

A macro file can be automatically generated by the Thermo-Calc (Console Mode) software,
if in the SYS module the "SET_LOG_FILE" on page 303 command is used and a *.LOG file
name is given before any other SYS, DATA, TAB, GIBBS, POLY, POST, PARROT, or ED-EXP
command or any special-module command (e.g. BIN, TERN, POTENTIAL, SCHEIL, POURBAIX,
or REACTION). Such a *.LOG file generated from the Thermo-Calc (Console Mode) software
is a textual file, and using a textual editor (such as Notepad, WordPad, PFE, Emacs, vi, etc.) it
can be edited, for example, by taking away unnecessary command lines, modifying some
commands, settings and definitions, adding some pausing points, adding helpful commenting
lines beginning with @@ signs, and so forth. Then save it as a macro file with the standard
file extension TCM.
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Experienced users can also write/edit an appropriate macro file for calculations/simulations,
using any basic textual editor outside the Thermo-Calc program.

All commands can be used in a macro file. The file must be terminated with EXIT or be
interrupted with SET_INTERACTIVE.

Within a macro file you can use comment-lines (for describing the problems and for
explaining commands and inputs/outputs), which should always start with the @@ signs in
the beginning of each comment-line. Such comment-lines help to document the macro file,
while these are not considered as command lines and thus do not affect the proceeding of
all the normal commands in modules of the Console Mode when the file is called by the
Thermo-Calc Console Mode software.

You can put multiple-line comment-blocks in a macro file between the @ (” and “@)” signs.
The former sign indicates where the comment begins and the latter sign indicates where the
comment ends. A comment-block begins from a line started with the begin comment sign @
(and ends with the finish comment sign @); all the lines written in between are ignored, and
the line started with @) is also ignored.

Another use for a macro file is to allow you to interact at some specific points, using the
“@?” sign starting a text line (note that the text describing the expected user-
specification/input should be written as a continuous string without any empty space), for
user’s on-time specifications of arguments/parameters or inputs of parameter-values that
are requested by a certain command. The macro temporally stops at the “@?” sign, prompt
on screen the text given after “@?”, and waits for the specified argument/parameter/value.
The Thermo-Calc (Console Mode) software then uses specified argument/parameter/value
as the input(s) for the associated command. For example, you can input the values of lower
and higher temperature limits for the second axis-variable as follows:

GO POLY-3

SET-AXIS-VAR 2 T @?Low-temperature-limit:

@?High-temperature-limit:

You can have macro-variables denoted by the signs of @#n (for definition) and ##n (for
usage); and up to nine variables inside a single macro file. Such a macro-variable can be
assigned with its desired value, as for example:

@#3First-element?

This writes the text (note that the text describing the expected user specification/input is
written as a continuous string without any empty spaces) after the “@#3” sign as prompted
on screen and then wait for a specification. The input is assigned to the macro-variable ##3,
which is directly called in different parts within the current macro file.

For example, the content of the macro-variable ##3 is inserted in the command:

DEFINE-SYSTEM ##3
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It is also useful in more complicated commands, such as:

SET AXIS VAR 1 x(##3) 0 1,,,

This command sets the mole fraction of macro variable 3 as axis 1.

A macro file can have any number of pauses at the @& signs, for the purpose of checking the
details/results of executing certain commands when running the macro file. However, you
can also prevent the Thermo-Calc (Console Mode) software from temporarily stopping at
any pause by typing any character (except for the Y character for confirming a Yes answer
to a command prompt) after specifying the name of a macro file.

A macro file can have a maximum of five nested levels, i.e. a macro file can call another
macro file, and if one sub-level macro is terminated by the command it resumes at the next
command in the previous macro. If it is terminated by end-of-file, the Thermo-Calc
(Console Mode) software stops.

This feature is especially useful for alloy design that requires many (hundreds) of
calculations/simulations on similar material system/processes (specified in many different
but appropriately-documented macro files that are organized in up to five levels) during a
certain period of time (e.g. in an evening), you can run the main macro (on the top level) at
a certain time (e.g. before leaving  the office) and afterwards (e.g. next morning) you can
systematically and efficiently check/compare/analyse the results (saved as graphical files,
and/or EXP, TXT, XLS… files).

By adding the SYS command "SET_ECHO" on page 302 at the beginning of a macro file (or in
the primary macro file on the top level if any sub-level(s) of macro files are used), it is useful
to automatically display the complete/detailed meaning of various commands in all the
sequential operations in the software, all enforced according to the macro file(s).

SET_INTERACTIVE

Syntax SET_INTERACTIVE

Resets the input and output units to the initial values, i.e. keyboard and screen.
Add this as the last command to the macro files.
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BINARY_DIAGRAM Commands
In this section:

BINARY_DIAGRAM Module 10
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BINARY_DIAGRAM Module
The BINARY_DIAGRAM module (short name, the BIN module) enables you to quickly
calculate a simple binary phase diagram. Access to specific databases designed for BIN, such
as TCBIN, is required.

To enter the module, at the SYS prompt type GOTO_MODULE BINARY. There are no other
commands for this module. Follow the prompts to plot a diagram.

Also see the Graphical Mode equivalent to this command, "Binary Calculator"
on page 137 in the Thermo-Calc User Guide.

Syntax BINARY_DIAGRAM

Prompts Database: /TCBIN/

First element

Second element

Phase diagram, Phase fraction (FE), G- OR A-curves
(G/A): /Phase_Diagram/
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Database Commands
These commands are related to the DATABASE_RETRIEVAL module, which is
also known as the TDB module.

See example tcex50 in the Thermo-Calc Console Mode Examples Guide.

Search the online help or see in the Thermo-Calc User Guide for step-by-step instructions to
define a system.

In this section:

AMEND_SELECTION 12

APPEND_DATABASE 12

DATABASE_INFORMATION 14

DEFINE_ELEMENTS 14

DEFINE_SPECIES 14

DEFINE_SYSTEM 15

GET_DATA 16

LIST_DATABASE 16

LIST_SYSTEM 17

NEW_DIRECTORY_FILE 17

REJECT 18

RESTORE 20

SET_AUTO_APPEND_DATABASE 21

SWITCH_DATABASE 22
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AMEND_SELECTION
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Use this command after defining the elements, species or the system (with the commands
"DEFINE_ELEMENTS" on page 14, "DEFINE_SPECIES" on page 14, or "DEFINE_SYSTEM" on
page 15). The prompts allow changes to the predefined system. By answering Y or N, each of
the selected elements, species or phases can be accepted or rejected (although this is not
the case for the constituents or the entire system).

Syntax AMEND_SELECTION

Prompt
Keep <Name1> No/Quit /Yes/

Keep <Name2> No/Quit /Yes/

Options
Keyword-- Elements/Species/Phases name&

Names of the pre-defined or pre-selected elements/species/phases

APPEND_DATABASE
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Append data from a file or additional database to the current set of data already read from
another database. Data already read from another database and stored in the Gibbs energy
system is kept in the GES5 workspace.

This command also enters all additional parameters (phase constituents, G0 and interaction
parameters, etc.) to already existing phases, and all existing parameters (phase constituents,
excess model, G0 and interaction parameters, etc.) in the phase are replaced with the
values retrieved from the appending database.

The command is equivalent to the SWITCH_DATABASE USER command sequence. It is also
similar to "SWITCH_DATABASE" on page 22, but does not reinitialize the DATA module and
GIBBS workspace.

All the directly connected databases as predefined by the original database initiation file
(TC_INITD.TDB file in the /DATA/ area for Windows environments, or the initd.tdb file in
the \data\ area for Linux), or by a user-specified database initiation file after using "NEW_
DIRECTORY_FILE" on page 17, are listed after pressing <Enter> without giving any
argument. You can supply your own database by giving the argument USER, the database
name and the correct path if it is not located in the current working directory.
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After the command is executed for the first time, the TDB_XYZ: prompt (XYZ stands for the
name of the primary switched database) is changed to the APP: prompt to go to more
commands related to appending data.

Syntax APPEND_DATABASE

Prompt

Use one of these databases

PURE  = SGTE pure element database

SSUB  = SGTE substance database 1997

User   = User-defined database

Database name /XYZ/: <Additional database name>

Options

Additional database name

The name of an existing database or a USER database definition file
(***setup.TDB) that corresponds to the appending database.

Notes

If a USER database name or its path is not given on the same line of the
APPEND_DATABASE command, or if the name or path is incomplete or
incorrect, an Open window displays to open an appropriate database-setup.
You can then open the USER database, or can cancel the open session; in the
latter case, the program lists all predefined databases in the installation area,
and you can select one of these or proceed with the USER option again for
appending a desired database.

When this command is used in a macro (*.TCM) file, if the USER option is
selected, the database setup file name (*setup.TDB) containing the setup
definitions of the USER database, and its correct path, are required.

In Linux, the file name of a USER database, or one of the predefined names,
can be used under the prompt FILENAME: This is a valid file name for the USER
database definition file (***setup.tdb) or a predefined database name, with
the correct path. The default file name extension is .tdb.

This command can be called more than once if appending two or more
databases to the primary switched database.

After this command, the commands to define a system (in terms of either
elements or species), to reject/restore phases or species, and retrieve data
must be repeated; however, the second keywords and parameter values might
have to be different from the previous ones.
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DATABASE_INFORMATION
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Syntax DATABASE_INFORMATION

A short description of the current database is normally given by typing this
command.

This can include information on covered systems, used models, valid ranges for
parameters in temperature and composition, major applications, and so on.

DEFINE_ELEMENTS
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Define the system in terms of elements. All possible species that can be formed by the given
elements are retrieved from the database. The names of elements must be separated with a
space or comma. It is possible to use a wildcard * after a common part of element names so
that all the elements, which start with that common part and are available in the currently
switched or appending database, are defined in the system. Up to 40 elements can be
defined into a single system.

Also see "Defining a System in Console Mode" on page 165 in the Thermo-Calc
User Guide for step-by-step instructions to define a system with this command.

Syntax DEFINE_ELEMENTS

Prompt
Element& <Element1, Element2, …>

A list of elements to be defined into the system.

When appending database(s), this command, or "DEFINE_SPECIES"
below or "DEFINE_SYSTEM" on the next page must be repeated
with the same or similar elements as defined in the first switched
database.

DEFINE_SPECIES
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).
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Define the system in terms of species. Only those species given are retrieved. The different
names of species must be separated with a space or comma. It is possible to use a wildcard
* after a common part of species names so that all the species, which start with that
common part and are available in the currently switched or appending database, are
defined in the system. Up to 1000 species can be defined in a single system.

Also see "Defining a System in Console Mode" on page 165 in the Thermo-Calc
User Guide.

Syntax DEFINE_SPECIES

Prompt
Species& <Species1, Species2, …>

A list of species to be defined in the system.

When appending database(s), this command, "DEFINE_ELEMENTS"
on the previous page or "DEFINE_SYSTEM" below must be repeated
with the same or similar elements as defined in the first switched
database. 

DEFINE_SYSTEM
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Define the system in terms of either elements (equivalent to "DEFINE_ELEMENTS" on the
previous page) or species (equivalent to "DEFINE_SPECIES" on the previous page). Certain
databases have a default value of the keyword (as either ELEMENTS or SPECIES) reflecting
what is most appropriate when defining a system.

The different names of elements or species must be separated with a space or comma. It is
possible to use a wildcard * after a common part of elements or species names so that all
the elements or species, which start with that common part and are available in the
currently switched or appending database, are defined in the system.

When appending database(s), this command (or DEFINE_ELEMENTS or DEFINE_SPECIES)
must be repeated with the same or similar elements as defined in the first switched
database. Different databases might contain different elements and have different species
definitions: avoid defining elements/species that are missing in the appending database(s).
Otherwise, the program indicates these missing elements/species, and ignores them in
subsequent steps. But additional elements/species, and additional phases not available in the
first switched database can be defined and retrieved from the appending database(s). Up to
40 elements and 1000 species can be defined in a single system.
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Also see "Defining a System in Console Mode" on page 165 in the Thermo-Calc
User Guide for step-by-step instructions to define a system with this command.

Syntax DEFINE_SYSTEM

Prompt
Elements: <Element1, Element2, …>, or

Species: <Species1, Species2, …>

Options Description

Species or Elements Default keyword.

Element& Specify a list of elements for the defining system.

Species& Specify a list of species for the defining system.

GET_DATA
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Only after executing this command can you go to any of the application
programs such as GES, POLY or DICTRA and use the retrieved data. When
appending database(s), this command must be repeated in order to obtain the
additional system definitions, parameters and functions.

Syntax GET_DATA

Enter the defined system’s elements, species, phases, and the connected
parameters obtained from either the primary switched or additionally
appending database(s) to the GIBBS and/or DICTRA workspace. This command is
necessary for retrieval of all information concerning a defined system from the
databank.

LIST_DATABASE
This is a DATABASE_RETRIEVAL (TDB) command.

List all elements, species, phases or phase constituents in the database.



Thermo-Calc Documentation Set

Database Commands ǀ 17 of 370

Syntax LIST_DATABASE

Options Description

Keyword
One of the keywords Elements, Species, Phases or Constituent must be
used to indicate what to list

Elements
All available elements, the reference state, atomic mass, H298-H0 and
S298. Some elements have spaces in the column for the reference state.
This implies that there are no parameters stored for this element.

Species All available species together with the stoichiometric factors.

Phases
All available phases together with the number of sublattices and the
number of sites in each sublattice.

Constituent

All available phases, the number of sublattices, the number of sites in
each sublattice and the species dissolved in each phase. Species in
different sublattices are separated with a colon (:). It is important to
realize, for example, a phase can consist of Fe, Mo, V, and Cr, and its
thermodynamic parameters can come from the binary systems Fe-Mo,
Fe-V, Fe-Cr, and Mo-Cr. These data can give a relatively good description
of the corners of the Fe-Cr-Mo system, but would most certainly give a
bad one for the system Mo-Cr-V, due to the fact that the interaction
parameters are, by default, set to zero, which originates from binary
systems not included in the database.

LIST_SYSTEM
This is a DATABASE_RETRIEVAL (TDB) command.

List all elements, species, phases or phase constituents in the defined system. It works only
after a system is defined.

Syntax LIST_SYSTEM

Keyword
One of the keywords Elements, Species, Phases or Constituent (as
described in "LIST_DATABASE" on the previous page) must be used to indicate
what to list.

NEW_DIRECTORY_FILE
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).
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Open a new database initiation file (or called database directory file) generated by a local
database manager or user, for accessing additional databases not predefined in the original
database initiation file.

The original database initiation file is automatically copied by the installation script to the
main database area, on a local computer for an independent installation locates or a
connected server for a server installation.

l For Windows this is the TC_INITD (or TC_INITD.TDB) file in the \DATA\ area under
the directory defined by the TCPATH parameter.

l For Linux, it is the initd.tdb file in /data/ area that is under the directory defined by
the TC_DATA parameter. If the Thermo-Calc (Console Mode) is run on a Linux
platform, the new database initiation file must be located in the current working
directory.

If there are too many databases at one installation or if there are some user-specified
databases for a particular purpose, a local database manager can generate additional
database initiation files, or each user can have their own initiation file.

The command switches the working initialization of database groups in the DATA module
among the original and additional database initiation files. The Thermo-Calc (Console Mode)
can use additional database initiation files that define accessing paths to database groups
(databases located in different subdirectories under the directory defined by the TCPATH or
TC_DATA parameter). All directly accessible databases remain as in the same group, until
this command is called or recalled.

Syntax NEW_DIRECTORY_FILE

Prompt

File with database directory /tc_initd/: <Database-initiation-
file name>

Another database-initiation-file name

The name of the next database initiation file (either additional or original) that
is to be switched on as follows sessions.

If the file name or its path is not given on the same line of the
NEW_DIRECTORY_FILE command, or if it is incomplete or
incorrect, an Open window displays to specify the new database
initiation file.

REJECT
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).
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Reject elements, species, phases or phase constituents that can form from the defined
elements and species. Phases/species/constituents that are possible to form in the defined
system are removed from the list of system phases/species/constituents (shown by the
command "LIST_SYSTEM" on page 17). Phases/species/constituents that are not included in
the list cannot be entered without first being restored. The different names must be
separated with a space or comma. You can use a wildcard * after a common part of names
so that all the elements/species/phases/constituents that start with that common part and
are available in the currently switched or appending database, are rejected from the
defined system.

This command can also reject a defined system, and thus reinitiate the entire DATA module
memory and GES5 workspace.

Syntax REJECT

Prompt 1
(keyword = ELEMENTS or SPECIES or PHASES)

If keyword: <Name1, Name2, …>

Prompt 2

(if keyword = CONSTITUENT)

Phase: <Phase name>

Sublattice number: <Sublattice number in the phase>

Constituent: <Constituent(s) in the sublattice of the
phase>

Prompt 3 If keyword = SYSTEM the DATA module is reset to its initial state; GIBBS is
reinitiated and data already entered to GES5 is lost.

Options Description and additional information

Keyword
One of the keywords Elements, Species, Phases, Constituent or
System must be used to indicate what is rejected.

Name& Names of the pre-defined elements/species/phases/constituents/system

Elements The given elements are rejected.

Species
The given species are rejected, making it impossible to form them from
the defined elements.

Phases
The given phases are rejected, making it impossible to form them from
the defined elements or species.

Constituent

The given constituent in one phase are rejected. Add the following when
prompted:

Phase: The name of the phase containing the constituent to be rejected.
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Syntax REJECT

Sublattice number: The sublattice where the constituent enters (the
first sublattice is 1). The question is omitted if there exists only one
possible sublattice.

Constituent: The name(s) of the constituent(s) to be rejected.

RESTORE
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Restore already explicitly rejected elements, species, phases or constituents; it is the
opposite of the command "REJECT" on page 18 although it does not restore a completely
rejected system.

Phases/species/constituents that are possible to form from the defined elements or species
are entered to the list of system phases/species/constituents (shown by the command "LIST_
SYSTEM" on page 17). Phases/species/constituents that are not included on the list can now
be added to the list. The different names must be separated with a space or comma. It is
possible to use a wildcard * after a common part of names so that all the
elements/species/phases/constituents, which start with that common part and are available
in the currently switched or appending database, are restored in the defined system.

Syntax RESTORE

Prompt1
(if keyword = ELEMENTS or SPECIES or PHASES)

Keyword: <Name1, Name2, …>

Prompt2

(if keyword = CONSTITUENT)

Phase: <Phase name>

Sublattice number: <Sublattice number in the phase>

Constituent: <Constituent(s) in the sublattice of the
phase>

Options Description and Information

Keyword
One of the keywords Elements, Species, Phases or Constituent must
be used to indicate what is rejected.

Name& Names of the pre-defined elements, species, phases, and constituents
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Syntax RESTORE

Elements The given elements are restored.

Species
The given species are restored and thus possible to form from the
defined elements.

Phases
The given phases are restored and thus possible to form from the defined
elements or species.

Constituent

The given constituent in one phase are restored.

Add the following when prompted:

Phase: The name of the phase containing the constituent to be restored.

Sublattice number: The sublattice where the constituent enters (the
first sublattice is 1).

Constituent: The name(s) of the constituent(s) to be restored.

SET_AUTO_APPEND_DATABASE
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Enforce an automatic action that appends thermodynamic data from a chosen database
regarding the system to the data you already have about the system from the current
database (that is, the default database or the database last chosen with "SWITCH_
DATABASE" on the next page or "APPEND_DATABASE" on page 12).

This is useful to simultaneously retrieve both thermodynamic and mobility data
for a defined system when performing a DICTRA module simulation.

This command should be used before defining a system (with the commands "DEFINE_
ELEMENTS" on page 14, "DEFINE_SPECIES" on page 14, or "DEFINE_SYSTEM" on page 15)
and retrieving the data with the "GET_DATA" on page 16 command from the primary
switched database.

Syntax SET_AUTO_APPEND_DATABASE

Prompt Database name /XYZ/: <Additional database name>

Option
Additional database name

The name of an existing database or a USER database that
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Syntax SET_AUTO_APPEND_DATABASE

corresponds to the automatically-appending database.

It works in a way that is similar to the APPEND_DATABASE<DATABASE-NAME> command
sequence, but only the phases that are also available in the primary switched database are
appended. There is no possibility to manually list, reject and/or restore any phase that is
available in the appending database. When retrieving data with the GET_DATA command
afterwards, all the phases that exist in the appending database but not in the primary
switched database are automatically rejected. The prompt is kept as for the primary
switched database, TDB_XYZ: (where XYZ stands for the name of the primary switched
database) until the execution of the GET_DATA command.

Therefore, to selectively append more phases from a secondary database to a system that is
defined and retrieved from a primary switched database, then the APPEND_DATABASE
command and sequential commands (such as DATABASE_INFORMATION, DEFINE_SYSTEM,
DEFINE_ELEMENT, DEFINE_SPECIES, LIST_SYSTEM, REJECT, RESTORE and GET_DATA) should
be used instead, before this command.

Although it is impossible to manually list, reject and restore any phase from the appending
database, the DATA module automatically ignores all the phases that do not exist in both the
primary switched database and the appending database, and append the data for the phases
(that are also available in the primary switched database) from the appending database, as
informed on screen when executing "GET_DATA" on page 16 afterwards.

SWITCH_DATABASE
This command is for the DATABASE_RETRIEVAL module (also called TDB
module).

Switch (or change) from the current database to a new one, and reinitialize the entire DATA
module for defining a system and the GES5 workspace for storing retrieved data. All the
directly connected databases as predefined by the original database initiation file, or by a
user-specified database initiation file after using "NEW_DIRECTORY_FILE" on page 17, are
listed by pressing the <Enter> key without giving any argument. You can also supply your
own database by giving the argument USER and then the database name and its correct path
if it is not located in the current working directory. The second part of the prompt TDB_XYZ
indicates the present database XYZ.
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Syntax SWITCH_DATABASE

Prompt

Database name /xyz/: <new database name>

Use one of these databases:

l PURE (SGTE pure element database)

l SSUB (SGTE substance database 1997)

l USER (user-defined database)

Options Description and Information

New
database
name

The name of an existing database or a USER database definition file
(***setup.TDB).

Database
name

The new database is specified by typing the abbreviation given in the front of
one of the available predefined databases. When switching/appending
databases or additionally purchased databases you can add these to the
predefined database list in the database initiation file TC_INITD.TDB or
initd.tdb of your installed software.

When this command is used in a macro (*.TCM) file, if the USER option is
selected, the database setup file name (*setup.TDB) that contains the setup
definitions of the USER database, and its correct path, must be provided.

Filename

In Linux, the filename of a USER database, or one of the predefined names,
can be used under this prompt. A valid filename for the USER database
definition file (***setup.tdb) or a predefined database name, with the
correct path. The default filename extension is .tdb.

Notes

If a USER database name or its path is not given on the same line of the
SWITCH_DATABASE command, or if it is incomplete or incorrect, an Open
window is displayed for the to-be-switched database.

The USER database is used without reinitiating the Gibbs energy system, data
from different databases can thus be combined. Therefore, the SWITCH_
DATABASE USER command sequence is equivalent to the APPEND_DATABASE
USER command sequence. The result of a combination must be examined
carefully, because differences in standard states, phase models and names
can be disastrous. If the same parameters occur in several such switched or
appended databases, the last one retrieved is used in the calculations. It is
not advisable to use this method for large databases since these load slowly.

After this command, those commands for defining system (in terms of either
elements or species), rejecting/restoring phases or species, retrieving data,
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Syntax SWITCH_DATABASE

as well as for appending data from additional database(s), can be proceeded.
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EDIT_EXPERIMENTS Commands
These commands are accessed through the PARROT module.

Some special commands are designed only for the ED_EXP module and can also be used in
*.POP or *.DOP files.

In this section:

Running the EDIT_EXPERIMENTS Command 27

ADVANCED_OPTIONS 27

COMPUTE_ALL_EQUILIBRIA 36

COMMENT 37

COMPUTE_ALL_EQUILIBRIA 37

COMPUTE_EQUILIBRIUM 38

CREATE_NEW_EQUILIBRIUM 40

DEFINE_COMPONENTS 40

DELETE_SYMBOL 41

ENTER_SYMBOL 41

EVALUATE_FUNCTIONS 44

EXPERIMENT 44

EXPORT 46

FLUSH_BUFFER 47

GRAPHICS_PLOT 47

IMPORT 47

LABEL_DATA 48

LIST_ALL_EQUILIBRIA 48

LIST_CONDITIONS 49

LIST_EQUILIBRIUM 49

LIST_STATUS 50
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LIST_SYMBOL 51

MAKE_POP_FILE 52

READ 53

READ_WORKSPACES 53

REINITIATE_MODULE 54

RESTORE_ALL_WEIGHTS 54

SAVE_WORKSPACES 54

SELECT_EQUILIBRIUM 55

SET_ALL_START_VALUES 55

SET_ALTERNATE_CONDITION 57

SET_CONDITION 60

SET_NUMERICAL_LIMITS 62

SET_REFERENCE_STATE 63

SET_START_CONSTITUTION 65

SET_START_VALUE 66

SET_WEIGHT 66

SHOW_VALUE 68

STORE_ALL_WEIGHTS 68

TABLE_HEAD, TABLE_VALUES and TABLE_END 68

TRANSFER_START_VALUES 70
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Running the EDIT_EXPERIMENTS Command
To run the EDIT_EXPERIMENTS (ED_EXP) module:

l The first necessary command after entering the ED_EXP module for the first time
(with "EDIT_EXPERIMENTS" on page 139 in the PARROT module) should always be
READ_BLOCK in order to load the experimental data block from the current work
*PAR-file for editing. Also, the read command must also be used prior to any other
ED_EXP command if the module is reinitiated, or if no experimental data block has
not previously been read from a work file compiled with a proper experimental data
.POP/.DOP file, or if you want to change to another data block for editing.

l If any change is made in the ED_EXP module remember to use the command "SAVE_
WORKSPACE" on page 289 before going BACK to the PARROT module.

Although the TABLE_HEAD, COMMENT and FLUSH_BUFFER commands are
visible in the ED_EXP module, these cannot be used in the ED_EXP module;
these are only functional in an *.POP or *.DOP file.

ADVANCED_OPTIONS

Syntax ADVANCED_OPTIONS

Prompt Which option? /Step_and_Map/: <Option>

Also see "ADVANCED_OPTIONS Descriptions" on page 168.

LIST_PHASE_ADDITION has no additional prompt.

STEP_AND_MAP (the default)

Settings for MAP and STEP:

Global test interval /0/: <Integer number>

Settings for MAP:

Automatically add initial equilibria /Y/: <Y or n>

Number of mesh along an axis /3/: <Integer number>

Use inside meshing points /N/: <Y or N>

Global test interval /0/: <Integer number>

The integer number determines how often the Global Minimization should be used during
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STEP_WITH_OPTIONS and MAP calculations. If it is set to 0 (zero), the recommended global
test interval is used: i.e. every tenth step and at each phase change during STEP calculations,
and only at node points during MAP calculations. Any other positive integer number, n,
suggests it performs a Global Minimization test at every n-th step during STEP and MAP
calculations. Of course, the Global Minimization test is always carried out at a phase change
or a node point. The Thermo-Calc software is installed with 0 (zero) as the default value, but
such a configuration for the default value can be changed by using SET_TC_OPTIONS in the
SYS module.

Automatically add initial equilibria /Y/: <Y or N>

When "ADD_INITIAL_EQUILIBRIUM" on page 166 is not used before MAP, a mesh of initial
equilibrium points are added before the mapping itself takes place. This mesh is only
available when two (2) axes are already defined. The default on start-up may be changed by
SET_TC_OPTIONS in the SYS monitor.

Number of mesh along an axis /3/: <Integer number>

An integer for how many intervals of initial equilibrium points to be added along an edge in
the diagram. For example, if set to 2 (two), initial equilibrium points are added at the
beginning, center, and end of each axis-variable forming 2 intervals.

Use inside meshing points /N/: <Y or N>

If N the INITIAL_EQUILIBRIUM mesh consists of initial equilibrium points added only along
the edge/border of the diagram defined by the axis-variables. If Y, the initial equilibrium
points added are also added inside edge.
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NONE

Take away any set advanced option in all subsequent single-point equilibrium and MAP/STEP
calculations.

If there is any convergence problem in finding a stable solution, at any stage of an advanced
option calculation conducted by an ADVANCED_OPTIONS command-sequence, these
messages display:

Convergence problems, increasing smallest site-fraction from 1.00E-30  to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

The smallest site fraction in the current POLY3 workspace is automatically increased from
the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14).
For other subsequent POLY-module calculation in the current TC run, you can use the POLY
command "SET_NUMERICAL_LIMITS" on page 296 to restore or reset the smallest site
fraction to the previous or another preferred value, as well as to reset other numerical
limits.

EQUILIBRIUM_CALCULATION

The following prompts affect the ways how the POLY optimization does the Ordinary POLY
Minimization to reach the minimum of an equilibrium state.

Settings for the minimization of an equilibria:

Force positive definite phase Hessian /Y/: <Y or N>

Control stepsize during minimization /Y/: <Y or N>

Force positive definite phase Hessian /Y/: <Y or N>

Choose Y or N to determine how to reach the minimum of an equilibrium state in a normal
POLY optimization procedure. This is related to the special quantity, the phase stability
function QF (phase), for all kinds of phases in an equilibrium state [A phase stability function
for a phase is negative when the phase composition is inside a spinodal, and positive
everywhere else].

If the composition of a solution phase is inside its spinodal, the enforcement of positive
definite eigenvalues of a Hessian matrix (i.e. by answering Y) makes the step be taken
towards the minima rather than the local maxima. Furthermore, if an eigenvalue (for a
phase) of the Hessian matrix is near 0.0, the step-size is large and the answering Y sets a
lower limit to this eigenvalue, and reduces the step-size and improves the convergence. The
POLY command-sequence SHOW_VALUE QF(phase) shows the size of the lowest eigenvalue of
a phase in an equilibrium state.

By answering Y it might help the Ordinary POLY Minimization to converge, if there is such a
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problem, especially if QF(phase)=0 for phases.

By answering N the Ordinary POLY Minimization routine is applied.

For each phase in a defined system, the molar Gibbs energy of the phase is a function of the
temperature-pressure condition and its composition:

Compute a Hessian matrix as which describes the curvature of the Gibbs energy curve of this
phase at the defined composition X:

Diagonalize this matrix and call the Eigenvalues as e1,e2,...,en . The QF(phase) quantity for
this phase is the lowest of these eigenvalues divided by the same values for a corresponding
ideal (stoichiometric) phase:

Here, se1,se2,...,sen are the eigenvalues for the ideal phase. Therefore, for an ideal
(stoichiometric) phase, the QF(phase) should always be 1.0.

Control stepsize during minimization /Y/: <Y or N>

Choose Y or N to determine whether to introduce a control of step-size while reaching the
minimum of an equilibrium state in a normal POLY optimization procedure. By answering Y
it might help the POLY optimization to converge, especially if when some site fractions are
less than 1E-4.

GLOBAL_MINIMIZATION

The following prompts affect how the Global Minimization is done. Settings for global
minimization:

Use global minimization as much as possible /Y/: <Y or N>

Use global minimization for test only? /N/: <Y or N>

Maximum number of gridpoints per phase /2000/: <Integer number>

Use global minimization as much as possible /Y/: <Y or N>

Choose Y or N to decide if using the Global Minimization Technique from start of calculation



Thermo-Calc Documentation Set

EDIT_EXPERIMENTS Commands ǀ 31 of 370

or not. The default value on start-up may be changed by SET_TC_OPTIONS in the SYS module.

If Y the calculation is done when possible (depending on the condition settings), and a Global
Minimization test is always performed when an equilibrium is reached. This costs more
computer time but the calculations are more accurate.

If N the calculation is not used to reach the equilibrium state. Use global minimization
for test only? determines if the Global Minimization test is made against the calculated
equilibrium states obtained by the Ordinary POLY Minimization calculation.

Use global minimization for test only? /N/: <Y or N>

If Y a calculated equilibrium state obtained by the Ordinary POLY Minimization calculation is
tested against the Global Minimization Technique after it is reached; and if found it as
unstable, there is an error message.

If N the Global Minimization Technique is never tested for or done for all sequential
calculations throughout the current TCC run. This implies that Global Minimization
Technique is permanently turned off, and that consequently only the Ordinary POLY
Minimization routine is used.

Maximum number of gridpoints per phase /2000/: <Integer number>

Specify the maximum number of grid points that are computed for each of the phases in the
currently defined system, during the calculations enforced by the global minimization. More
grid points give a higher robustness and take more computation time. The total number of
computed grid points in all phases is limited to 2E6.

IGNORE_COMPOSI_SET_ORDER

Ignore composition set order /N/

NEW_COMPOSITION_SET

The following prompts are to specify the additional composition set(s) to handle possible
miscibility gap(s) of a certain solution phase:

Phase with miscibility gap: <Name of a phase>

Specify the name of the phase with miscibility gap.

New highest composition set number /2/: <#>

The default value is usually one higher than the current value. Each phase has initially one
composition set. If a lower value is given, composition sets are deleted. You cannot take
away the first composition set.
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A message displays to show that you need to specify the composition for the composition set
# (2,3,…).

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) in each sublattice can be given. This may simplify giving start
values when calculating the equilibrium as phases with miscibility gaps should have different
major constituents for each composition set.

This prompt is repeated for each sublattice in the phase, sometimes even for all sublattices
in the first composition set if such major constituents have not been specified.

MAJOR_CONSTITUENT

The following prompts are to specify the major constituent(s) on each of the sublattice sites
for a composition set of a certain solution phase:

Phase name: <name of a phase>

Specify the name of the solution phase with a new set of major constituents.

Composition set number /1/: <#>

The default value for the composition set number (#) is usually /1/ as the other composition
sets are given major constituents when creating them. Each phase has initially one
composition set.

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) on each sublattice of a solution phase can be given. This may
simplify giving start values when calculating the equilibrium as phases with miscibility gaps
should have different major constituents for each composition set.

This question is repeated for each sublattice in the phase.

PHASE_ADDITION

The following prompts are to specify the additional energy term (always being a constant) of
a given phase.

Phase name: <Name of a phase>

Specify the name of the (stoichiometric or solution) phase with the addition.

Addition to G per mole formula unit: <xxxxx>

The value (xxxxx) given is added to the Gibbs energy of the (stoichiometric or solution)
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phase. It can represent a nucleation barrier, surface tension, elastic energy or whatsoever.

It is not composition-, temperature- or pressure-dependent.

PRESENT_PHASE

Specify the name of the present phase a the name of the phase that should be present at all
calculated equilibria:

Present phase:

Phase name: <Name of a phase>

Console Mode examples tcex45, tcex46 and tcex47 use this advanced option.

T-ZERO_TEMPERATURE

Name of first phase: <Phase A>

Name of second phase: <Phase B>

The names of phases A and B must be given, for which the T0 temperature (where the Gibbs
energies are equal) is to be calculated.

If the T0 temperature between the two specified phases is successfully calculated, a
message displays, e.g.

The T0 temperature is 840.82 K. Note: LIST-EQUILIBRIUM is not relevant

The first message shows the calculated T0 temperature between the two specified phases.

The second message indicates that after this option calculation with LIST_EQUILIBRIUM is
irrelevant and does not list the equilibrium for the system at the T0-temperature.

PARAEQUILIBRIUM

Name of first phase: <Phase A>

Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium state is to
be calculated, must be entered subsequently or on the same (first) line at once then
separated by an empty space, e.g. FCC#1 BCC or FCC#2 M23C6.

You need to understand what you are dealing with in terms of calculating a
paraequilibrium state between the two specified phases.
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Specifically, there are four distinguished cases to understand: (1) both chosen phases must
have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component
(s) occupy; (2) the choice on the target phase pair must be reasonable for the defined
system and specified initial overall composition; (3) both target phases should have phase
constitution definitions that cover all the defined substitutional and interstitial components
of the current alloy system; or (4) it is impossible to calculate the paraequilibrium state
between the target phase pairs with given interstitial component(s) in the currently defined
system.

Fast diffusing component: /c/: <interstitial component(s)>

Fast diffusing component: /none/: <interstitial component(s)>

The name(s) of the fast-diffusing component(s) (C as the default single component) must be
given at the above prompts subsequently or at the same (first) prompt. It is possible to
specify more than one interstitial component as fast diffusion species.

Note the following:

Such specified interstitial component(s) must be appropriately defined according to the
phase constitution definitions of the two selected phases: these must be located on the
interstitial/vacancy sublattices in both chosen phases;

If there is only one fast-diffusing component which is carbon, press the <Enter> key to accept
the default input at the first prompt; if the single fast-diffusing component is another
element (e.g. N), type its name at the first prompt;

If there are two or more fast-diffusing components (e.g. C and N), type their names at the
above prompts subsequently or at the same (first) prompt (separated by an empty space,
such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt, i.e. by
pressing <Enter> key to start the paraequilibrium point calculation;

If NONE or a non-existing component name is typed at the first prompt, it means no back
diffusion is to be considered, and the para-equilibrium calculation is thus canceled entirely.

If the paraequilibrium state between the two specified phases is successfully calculated, the
messages displays e.g.

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N = 4.1548129E-03

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N = 2.3781027E-04

All other compositions the same in both phases

Note: LIST-EQUILIBRIUM is not relevant

The first and second lines list the phase amounts expressed in mole-percent [NP(phase)] and
the contents of the interstitial components C and N in a specific phase expressed in the so-
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called u-fractions [u-f(phase,C) and u-f(phase,N)], for the phase A (in this case as FCC) and
phase B (in this case as BCC), respectively. The third line states that the compositions of the
matrix component and all the remaining compositions (regarding substitutional
components) in both the target phase A and target phase B are the same at the current
paraequilibrium state, while these are not shown on screen. The last line indicates that after
this advanced-option calculation the LIST_EQUILIBRIUM command is irrelevant and does not
list the paraequilibrium state for the system at the current condition.

However, if the single-point calculation of the paraequilibrium state between the two
specified phases has failed, these messages display:

*** Error    4 in ns01ad

*** Numerical error

This implies that the chosen target phase pair may be unreasonable for the defined alloy
system or for the defined initial overall composition, or one or both phases may have
inappropriate phase constitution definitions regarding the specified interstitial component
(s). Then, you must either modify the settings of initial overall composition or specify the
reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in
the defined alloy system.

STABILITY_CHECK

Stability check on? /y/: <y or n>

The default is Y to switch on the automatic stability check during all subsequent single-point
equilibrium and MAP/STEP calculations. By answering N, there is no stability check in various
calculations.

Check also for unstable phases? /Y/: <Y or N>

If the automatic stability-check option is switched on choose to also check the stability for
unstable phases. The default is Y and if an unstable phase is found to be located in a
miscibility gas during a subsequent single-point equilibrium or MAP/STEP calculation, a
warning message informs you to selectively make adjustments in the calculation settings
[e.g. suspending the unstable phase, or using FORCED automatic start values for phase
constituents by the S_A_S_V F command-sequence, or creating other composition sets, etc.].
By answering N the stability check is enforced only to stable phases in the system.

TOGGLE_ALTERNATE_MODE

Set alternate toggle to DEFAULT, ALWAYS, or NEVER?

Set global toggle to DEFAULT, ALWAYS, or NEVER?

DEFAULT means that the experiment points are calculated according to the Alternate
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Technique depending on the SET_ALTERNATE command.

ALWAYS means the experiment points are always calculated according to the Alternate
Technique even if the Alternate Mode is switched off in the PARROT module.

NEVER means the experiment points are calculated as normal equilibria even if you SET_
ALTERNATE in the PARROT module.

SHOW_FOR_T=

Temperature (K) /298.15/: <temperature_in_K>

Specify the new temperature condition (in K) under which the values of some specific state
variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic
properties of the entire system, of components, or of phases) in the currently-defined system
(being in a frozen state) is shown on screen.

State Variable or symbol /VM/: <state variable or symbol name(s)>

Specify the name(s) of the desired state variable(s) or derived/partial variable(s) or defined
symbol(s) for various thermodynamic properties of the entire system, of components, or of
phases) in the currently-defined system. More than one state variable or symbol of interest
can be simultaneously specified on the same line. For example, you can choose to show the
values of VM or GM (i.e. molar volume or molar Gibbs energy of the entire system), or of
VM(*) or HM(*).T (i.e. molar volumes or isobaric heat capacity of all phases), or of ACR(*),
DGM(*) and LNACR(*,FCC) [i.e. activities of all system components, driving forces for all
phases, and activities (in logarithm) of all system components in the FCC solution phase],
under the new temperature condition (being in a frozen state).

OUTPUT_FILE_FOR_SHOW

A window opens with a default name for the file tc_show.dat. Choose a location to save the
file and click Open.

COMPUTE_ALL_EQUILIBRIA

Syntax COMPUTE_ALL_EQUILIBRIA

In ED_EXP and PARROT modules, each experiment is treated as an individual equilibrium
with some measured values. These are created with "CREATE_NEW_EQUILIBRIUM" on
page 195, and stored in an experimental data *.POP file and then compiled and saved in the
POLY3 workspace of a PARROT work *.PAR file.
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With COMPUTE-ALL-EQUILIBRIA, all equilibria from the current to the last experimental
points are calculated. If an equilibrium calculation fails, the calculation is stopped at that
equilibrium. Equilibria with weight zero is skipped.

A current or present experimental point means the latest selected or calculated
one. Once used the current point turns to the last point in the data block; in such
a case you first use "SELECT_EQUILIBRIUM" on page 216 so that the current
point is switched to a desired one.

For this command there is always a list output on screen, which consists of six columns for
all experimental points available in the current data block. The first column is the
equilibrium identifier (a number) assigned by this command, the second the data label
assigned with "LABEL_DATA" on page 48, the third the number of iterations, the fourth the
current weight, and the fifth the current temperature. In the sixth column the fixed stable
phases are listed together with any comment text given after a "COMMENT" on page 77 in
the *.POP or *.DOP file.

If the weight is zero for an equilibrium columns 3-5 are replaced by the text <unused>. If the
alternate mode is used for some experimental points, the listing is slightly different for such
points. The 3-4 columns are displayed with *alt*, instead. If an alternate calculation is failed
at one experimental point, the point is automatically assigned with a zero weight, and a
warning message is shown above the data line (with all six columns).

COMMENT
This command is only used in the *.POP/*.DOP files to write brief comments or descriptive
information on a newly created equilibrium (experimental) data point or a set of points
given in a table.

Syntax COMMENT

A comment can have a maximum of about 60 characters written on the same
line.

COMPUTE_ALL_EQUILIBRIA

Syntax COMPUTE_ALL_EQUILIBRIA

In ED_EXP and PARROT modules, each experiment is treated as an individual equilibrium
with some measured values. These are created with "CREATE_NEW_EQUILIBRIUM" on
page 195, and stored in an experimental data *.POP file and then compiled and saved in the
POLY3 workspace of a PARROT work *.PAR file.
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With COMPUTE-ALL-EQUILIBRIA, all equilibria from the current to the last experimental
points are calculated. If an equilibrium calculation fails, the calculation is stopped at that
equilibrium. Equilibria with weight zero is skipped.

A current or present experimental point means the latest selected or calculated
one. Once used the current point turns to the last point in the data block; in such
a case you first use "SELECT_EQUILIBRIUM" on page 216 so that the current
point is switched to a desired one.

For this command there is always a list output on screen, which consists of six columns for
all experimental points available in the current data block. The first column is the
equilibrium identifier (a number) assigned by this command, the second the data label
assigned with "LABEL_DATA" on page 48, the third the number of iterations, the fourth the
current weight, and the fifth the current temperature. In the sixth column the fixed stable
phases are listed together with any comment text given after a "COMMENT" on page 77 in
the *.POP or *.DOP file.

If the weight is zero for an equilibrium columns 3-5 are replaced by the text <unused>. If the
alternate mode is used for some experimental points, the listing is slightly different for such
points. The 3-4 columns are displayed with *alt*, instead. If an alternate calculation is failed
at one experimental point, the point is automatically assigned with a zero weight, and a
warning message is shown above the data line (with all six columns).

COMPUTE_EQUILIBRIUM
The full equilibrium state is calculated for the given set of conditions. The Global
Minimization Technique is by default enforced in this command (C_E), while it can be
disabled temporarily (for the current single-point equilibrium calculation) if using C_E – or
C_E * command-combination, or permanently (for all the sub sequential single-point
calculations or stepping/mapping calculations within the current TCC run) if having
decisively switched it off by a user (or possibly in some special modules) through changing
the minimization option using the "ADVANCED_OPTIONS" on page 174 → MINIMIZATION_
OPTION command-sequence.
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Syntax COMPUTE_EQUILIBRIUM

Prompt

The C_E command can be used, in order to enforce the ordinary POLY
minimization routines in an equilibrium calculation; this is because of that the
ordinary C_E command is now associated with the Global Minimization
Technique, and only after the Global Minimization

If technique is permanently switched off the C_E command makes no
difference from the C_E – command-combination.

Only certain types of equilibrium conditions [e.g. T, P, N, N(<component>), X
(<component>), B, B(<component>), and W(<component>)] are fully supported in
the Global Minimization mode (called Direct Global Minimization); and when
other types of equilibrium conditions are used, after the initial POLY, a Global
Minimization test and corrections are performed until the lowest minimum is
found (called Indirect Global Minimization).

If there is any problem with convergence, you may try the C_E * command-
combination. The character * enforces the command to use an advanced
technique to obtain a complex equilibrium. However, after a successful C_E
*calculation, you may repeat the C_E command and can check the status of
phases, species or components (with "LIST_STATUS" on page 210 → CPS
command-sequence) and equilibrium conditions (with "LIST_CONDITIONS" on
page 209) and list out the calculation results (with "LIST_EQUILIBRIUM" on
page 209), because such actions may tell you how to further modify various
settings for your current calculation. This command-combination is not that
useful anymore, because the Global Minimization Technique that is always
associated with the C_E command is even more powerful and more precise in
finding the most-stable equilibrium state in a complex heterogeneous
interaction system; therefore, the C_E * command-combination is functional
and can be used only after the Global Minimization mode has already been
disabled temporarily or permanently.

Some phases that are not stable in the current equilibrium state may not have
their most favorable composition after this command, and thus their driving
forces may not be correct. You can force the program to correctly calculate the
driving forces of metastable phases, by giving repeated C_E commands until
the number of iterations (that is shown on screen after this command) is
reduced to 2.

Also see the POLY command "SET_NUMERICAL_LIMITS" on
page 296 which can set the approximate driving force for
metastable phases option on or off in all the subsequent POLY
calculations within the current TCC run.
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Syntax COMPUTE_EQUILIBRIUM

If an equilibrium state for the defined system is not found, an error
message is given.

You can try repeating this command a few times, or change some of settings
for the numerical limits, for starting variables and starting values, for starting
constitutions of certain phases and for reference states of certain components,
or to verify some of the defined conditions.

CREATE_NEW_EQUILIBRIUM
During data-assessments using the PARROT/ED_EXP modules, you can, in the POLY module,
create several equilibria with different sets of conditions and phases (but normally with the
same set of components). By default, there is one equilibrium. To keep the set of conditions
and phase for this equilibrium, create another one using this command, and use another set
of conditions for that. Two equilibria may be useful to calculate easily the enthalpy
difference between two states. In the PARROT module, the experimental information is
stored as a sequence of equilibria.

Syntax CREATE_NEW_EQUILIBRIUM

Prompts

Equilibrium number /2/: <A new equilibrium number>

Each equilibrium in the POLY3 workspace is identified by a unique
integer number. Such an equilibrium number can be recalled with
"SELECT_EQUILIBRIUM" on page 216.

Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all
components and phases (initiation code 2), ENTER the components
only (initiation code 1) or SUSPEND everything (initiation code 0). No
other values are legal.

The entered components and phases can later be
changed with "CHANGE_STATUS" on page 100.

DEFINE_COMPONENTS
Change the set of components. By default, the elements are used as components. The set of
components can be important because some conditions are set using components, for
example, the amounts, activities or chemical potentials.
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For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components,
thus replacing the default FE, SI and O.

This implies a command "REINITIATE_MODULE" on page 215 and it should be
given as the first command in the POLY module.

Syntax DEFINE_COMPONENTS

Prompt

Give all new components / existing components/: <New components>

The new components must be specified all on one line. These replace the
existing component definitions.

The number of components cannot be changed with this command.
Use "CHANGE_STATUS" on page 100 instead.

To keep some existing components, it is recommended that you also enter
these on the line. Otherwise, the added new components may not be defined
correctly. This is especially important if some components are built out of
several elements.

The new components do not have to be present as species.

DELETE_SYMBOL
This is a POLY3 module command.

Delete symbols (i.e. constants, variables, functions or tables. These symbols are entered with
"ENTER_SYMBOL" on page 113.

Syntax DELETE_SYMBOL

Prompt

Name: <Name of a symbol>

Specify the name of the symbol to be deleted. Only one symbol can be deleted
each time.

ENTER_SYMBOL
This command is specific to the ED-EXP module.

Also see "ENTER_SYMBOL" on page 113 for the GIBBS Module and "ENTER_
SYMBOL" on page 247 for the POLY and POST Modules.
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Symbols are a useful feature modules to define quantities that are convenient. Symbols can
be constants, variables, functions or tables.

Syntax ENTER_SYMBOL

Prompt

Constant, Variable, Function or Table? /Function/: <keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.

l CONSTANTS can only be entered once and is a means of using a name
for a numeric value. For example, the value of 1 atmosphere in Pascal
can be denoted by P0 after the command ENTER CONSTANT
P0=101325. Defined constants can be used as values in condition
assignments, for example, SET-COND P=P0.

l FUNCTIONS are expressions of state variables or other functions. These
expressions are saved, and whenever a function value is requested all
functions are evaluated. The reason for this is that they may depend on
each other.

l VARIABLES are similar to functions because they can also be
expressions of state variables. However, contrary to functions, they are
only evaluated when they are entered or if they are explicitly named in
an "EVALUATE_FUNCTIONS" on page 208 command. It is possible to
enter a variable with a new expression any time. This expression is
evaluated directly and its value stored as the value of the variable.
Defined variables can be used as values in the SET-CONDITION
command.

l TABLES are used for listing results from the STEP or MAP commands. A
table consists of a list of any number of state variables, functions or
variables. Defined tables can also be used in the post-processor POST.

There is a special connection between tables and variables. If a
variable is used in a table, it is evaluated for each line of the table
in the TABULATE command or when the table is used in a plot.

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have
maximum 8 characters.

Legal characters include letters (either UPPER or lower case), digits and
underscore _. Any other special character, such as parentheses ( and ), plus +,
minus -, slash / or \, full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line,
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Syntax ENTER_SYMBOL

these must be separated with an equal sign =, for example, TC=T-273.15 or T_
C=T273.15 which stands for a definition of temperature in Celsius. Otherwise,
these questions are asked.

For different types of symbol (constant, function, variable or table),
the questions have different prompts.

Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or
other functions, constants or variables. The expression is a FORTRAN-like
expression and operators +,  -, *, = and ** can be used (** only with integer
powers).

Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An
expression can be continued on more than one line. An expression should be
terminated by a semicolon (;) or an empty line (by pressing <Enter> at the next
prompt).

Examples of function expressions:

l GM(LIQUID): The Gibbs energy of liquid per mole component

l H.T/4.184: The heat capacity of the system in calories

l ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

l T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the
new line if one line is not enough for the function. If you finish the function
press <Enter> again.

Value: <Value for a constant>

A constant can only be assigned a numeric value once.

Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is
evaluated immediately and discarded. Only the numeric value is kept. This
gives a possibility to save a value between calculations with different
conditions because all state variables and functions are evaluated for the new
conditions.
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Syntax ENTER_SYMBOL

Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain
results from a STEP command is through a table. 

Example:

ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the
temperature, the mole fractions of C and Cr in the LIQUID phase, and the
activity of C.

To show the temperature in Celsius in a table, give the command ENTER
FUNCTION TC=T-273; and then use the symbol TC in the table.

& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new
line if one line is not enough for the table. If you finish the table press <Enter>
again.

EVALUATE_FUNCTIONS
The value of one or more or all entered functions or variables are evaluated and listed.

Syntax EVALUATE_FUNCTIONS

Prompt

Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By
typing a wildcard *, all functions and variables are evaluated.

Variables are evaluated only if these are explicitly named.

EXPERIMENT
This command is used in original experimental data files (*.POP or *.DOP), but can also be
given interactively inside the ED-EXP module, to change the value or uncertainty of an
experiment or to add more experimental information.

An experiment usually consists of two parts with a colon (:) separating them:

l as a quantity relation, and

l as the uncertainty of the value for the quantity,
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The quantity relation can be a normal POLY-module condition or an inequality (which is
similar to condition but the relation between the quantity and given value is not in equality,
i.e. < or >). The uncertainty can be expressed as an absolute value or relative to the value
(x%).

An experiment that uses an inequality gives zero contribution to the sum of
errors in the optimization procedure of PARROT if the value is on the right side.
If the value is on the wrong side, the value after the colon determines how
steeply the error increases with the value.

Syntax EXPERIMENT

The experiment must be typed after the command. Several experiments can be
given on the same line.

The syntax of EXPERIMENT is similar to a CONDITION. Usually, a state variable
set equal to a value with a given uncertainty is specified after the colon (:). For
example, T=1273.15:5.

An inequality, < or >, can also be used. For example:
ACR(C)<-0.01:0.001, W(BCC,AG)>0.05:10%

Additional Information About the EXPERIMENT Command

A typical experiment added interactively specifies that a phase should not be stable in a
certain experiment, because a phase may appear in a range of composition or of
temperature where it has never been observed during the optimization. A phase is unstable
if its driving force is negative, and you can add experimental information to enforce that.
For example, you can suppress the HCP phase in an existing experimental point:

CHANGE-STATUS HCP=DORMANT

EXPERIMENT DGM(HCP)<-.001:.0001

DGM is the POLY variable for the driving force that is already divided by RT, and
it is dimensionless. Only dormant phases can have driving forces larger than
zero, as this indicates that these would be stable if allowed to form. The
experiment in the above case tries to modify the model parameters to make the
HCP phase unstable.

More general examples of experiment definitions:

EXPERIMENT X(LIQ,PB)=.10:.01 X(FCC,PB)=0.02:.01

EXPERIMENT ACR(PB)=0.8:5%

EXPERIMENT T=700:5
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The first experiment above describes a tie-line where the experimentally measured mole
fraction of Pb is 0.1 in the liquid phase and 0.02 in the FCC phase, and its uncertainty is 0.01
for both measurements. The second experiment is that the activity of Pb should be 0.8 with
an uncertainty of 5 percent.

The reference state of the component Pb must be set with the command "SET_
REFERENCE_STATE" on page 224. The final one is that the temperature should
be 700 K with an uncertainty of 5 degrees.

Experiments that are functions of states variable(s) must be described as the defined
functions. For example:

ENTER_FUNCTION HTR=HM(LIQUID)-HM(FCC);

EXPERIMENT HTR=7000:1000

EXPORT
This command is for the ED-EXP module.

Transfer/export a calculated value from an equilibrium to an optimizing variable in the
PARROT workspace. Thus the value can be used, for example, in the Gibbs energy
description of a phase. Of course, this variable should not be optimized (i.e. it should be set
as a fixed variable in PARROT).

Syntax EXPORT

Prompt

Function name: <Function name>#<n>

Specify the name of the function, the value of which should be transferred to a
V variable. The number (n) of the V variable must be given after the function
name, separated by hash character #.

The function name is UPPER/lowercase sensitive, and it should
normally be given in UPPER case.

Example

Enter_function strngy=gm(fcc).x(cu);

Export strngy#6

This transfers the value of the partial derivative of the Gibbs energy of the FCC
phase with respect to the mole fraction of Cu to the optimizing variable 6 (i.e.
V6).
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FLUSH_BUFFER
This command is only used in the *.POP/*.DOP files. It is needed if the number of
experiments require more space than can be fitted into one buffer. When the PARROT
program compiles experiments, it informs if any FLUSH commands are needed. The FLUSH_
BUFFER command terminates the current block, save it to the work file and starts a new
block. With the READ command in the EDIT-EXP module, you can select the block to edit.

Syntax FLUSH_BUFFER

After a FLUSH_BUFFER command, the workspace is reinitiated and all functions
or constants must be entered again in the *.POP file. You can take advantage of
this; for example, you can use the FLUSH command to have blocks with different
components in one *.POP file.

GRAPHICS_PLOT
This command can help create a experimental data file from the *.POP/*.DOP file. Several
data sets and different symbols are allowed.

Syntax GRAPHICS_PLOT

<Dataset#> <X value> <Y value> <Symbol index>

IMPORT
Transfer/import the value of one of the optimizing variables to a constant. Normally, it is
directly used inside an experimental data (*.POP or *.DOP) file. It is the inverse of "EXPORT"
on the previous page.

This is useful if several experiments are done at the same activity of a component, but this
activity is not known. The activity should then be optimized and all equilibria with the same
activity should use the same value. In this case the variable must be set as an optimizing
variable, and an initial guess of the activity should be given. During the optimization, the
PARROT program tries to find the activity that gives the best fit.

If an approximate value of the activity is known, it can be supplied as an
experiment.

See example tcex36 in the Thermo-Calc Console Mode Examples Guide.
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Syntax IMPORT

Prompt

Constant name: <Constant name>#<n>

The value of the V variable must be assigned a symbolic constant. The number
(n) of the V variable must be given after the constant name, separated by hash
character #.

The constant name is UPPER/lowercase sensitive, and it should
normally be given in UPPER case.

Example

Enter_constant acu=0.1

Import acu#2

This transfers the value of the optimizing variable 2 (i.e. V2) to the constant
ACU.

LABEL_DATA
Add a label to the experimental equilibrium point, either as a single point or several points
given individually or in a table. The label is maximum four characters and must start with
the letter A. Normally, it is directly used inside an experimental data (*.POP or *.DOP) file.

Several experimental equilibria can be given the same label, and the label can be used in
the command "SET_WEIGHT" on page 66 to assign the same weight to all equilibria with the
same label.

Syntax LABEL_DATA

Prompt

Label? /A1/: a<bcd>

Specify a textual label (as maximum characters and must start with the letter
A) for the current experimental equilibrium point(s).

LIST_ALL_EQUILIBRIA
This is an EDIT_EXPERIMENTS command.
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Syntax LIST_ALL_EQUILIBRIA

List all the details (including equilibrium indicators, labels, iteration numbers,
weight, and fixed phases or comments) of all equilibrium points from the
current one to the last one on screen. You can always use "SELECT_
EQUILIBRIUM" on page 216 to select a specific point as the current equilibrium
point for such a list.

LIST_CONDITIONS
This is a PARROT module command.

In the PARROT module, generate a list of the current values of optimization conditions, as
well the current status of listing, either on screen or in a basic text file which can be opened
and edited by a text editor.

Syntax LIST_CONDITIONS

Prompt
Output to screen or file /Screen/: <File name>

Press <Enter> to output to screen or on the list file under a specific file name.

LIST_EQUILIBRIUM
This is a POLY3 module command.

The result (always in SI units) from the last calculated equilibrium is listed on screen or in a
textual file.

You can also execute this command if no calculation is made or if the
calculation fails. It is your responsibility to interpret the results accordingly.

Syntax LIST_EQUILIBRIUM

Prompt

Output to screen or file /Screen/: <File name>

The name of the text file where the list of the calculation results shall be
written.

Options /VWCS/: <Option(s)>

Select the output units and formats by optionally specifying a combination of
these letters.
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Syntax LIST_EQUILIBRIUM

l Fraction order:V means VALUE ORDER; A means ALPHABETICAL ORDER.

l Fraction type: W means MASS FRACTION; X means MOLE FRACTION.

l Composition: C means only COMPOSITION; N means CONSTITUTION and
COMPOSITION.

l Phase: S means including only STABLE PHASES; P means including ALL
NON-SUSPENDED PHASES.

Default options are VWCS. If the output fraction type should be in mole fraction
(rather than mass fraction), then give VXCS or type X (implying that in this case
the options V, C and S are accepted as the listing manners for fraction order,
composition and phase).

If accepting all the default options, or if accepting all the altered options that
had already changed when using this command previously, you can type L_
E,,, or LIST_EQUILIBRIUM ,,,

LIST_EQUILIBRIUM displays ORD (ordered) or DISORD (disordered)
(when available). See "CHANGE_LEGEND" on page 246 for details.

LIST_STATUS
This command is for the POLY and ED-EXP modules.

List the status of components, species or phases.
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Syntax LIST_STATUS

Prompt

Specify what to list:

Option /CPS/: <keyword(s)>

keyword = C or P or S, or any combination

l C means list component status

l P means list phase status

l S means list species status

l CS for both components and species

Default is CPS.

The results depend on the key word specified in the options for "CHANGE_
STATUS" on page 100, a table with the current status of phases or species or
components, or the combinations, is shown:

l For components, the statuses and reference states are listed.

l For species, only the status is listed.

l For ENTERED and FIXED phases, the status, driving forces and
equilibrium amounts are listed.

The metastable phases are listed in descending order of stability.
To avoid long outputs only 10 metastable phases (in ENTERED
status) are listed by lines, while all other less stable phases are
merged onto one line. For DORMANT phases, their phase names
and driving forces are listed. For SUSPENDED phases, only the
phase names are listed.

LIST_SYMBOL
This is a GIBBS_ENERGY_SYSTEM (GES) command.

List the symbols available in the current GIBBS workspace, which are defined (retrieved
from database in the DATA module, or directly entered in the GIBBS module) and used in TP-
functions for the entered model parameters for various phases in the defined system.

For encrypted commercial databases you may not be able to use this command
to list any retrieved symbol.
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Syntax LIST_SYMBOL

Prompts

Name: <Symbol name>

Specify a symbol name (either as the full name of a defined symbol,
or as the first few common characters of several symbols which
have names starting with such common characters).

Only those symbols that match this name are listed.

Or press <Enter> for a list of all the symbols defined (retrieved from
database in the DATA module, or directly entered in the GIBBS
module) for the current system, which are available in the current
GIBBS workspace.

Output to screen or file /Screen/: <File name>

Specify the name of a simple-textual file in which the entered
symbols shall be written in a readable manner (such a basic textual
file can later on be opened and edited by any text editor). The
default value is the screen (by pressing <Enter>).

MAKE_POP_FILE
It is possible in the ED_EXP module to make interactive changes and additions to the original
experimental data file (the *.POP or *.DOP file).

To document or transfer the current or final experimental data to a *.POP/*.DOP file, you
can use this command to write it to a new *.POP/*.DOP file or overwrite it on an old one.

Check this output carefully for errors. Tables in original *.POP/*.DOP files are written as
individual experimental points. The output can be shown on screen or be saved as a new
*.POP file where to write or overwrite the edited experimental information in a simple text
format.

If an existing *.POP file name is specified, it is overwritten.

In the DICTRA module, a *.DOP file is written or overwritten.

Syntax MAKE_POP_FILE

Prompt

Output to screen or file /Screen/: <POP/DOP-file name>

Specify a name of the new *.POP/*.DOP file where to write or overwrite the
edited experimental information in a simple text format.
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READ

This command must be given each time the ED_EXP module is entered, unless it
is already given once in ED_EXP and does not use "LIST_RESULT" on page 149 or
"OPTIMIZE_VARIABLES" on page 154 in PARROT in between.

Syntax READ

Prompt

Block number /#/: <n>

The number of data block that should be edited must be given. If there is no
command "FLUSH_BUFFER" on page 77 in the original POP or DOP file, then
there is only one data block with the number 1.

READ_WORKSPACE = READ

This command (previously named READ_BLOCK) is equivalent to "READ_
WORKSPACE" on page 288 in the POLY module, but it only reads the POLY3
workspace from the work file set by "SET_STORE_FILE" on page 162 in the
PARROT module.

READ_WORKSPACES
This command is used in both the POLY and GES (GIBBS) modules.

The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP
commands can be READ from a file where they are saved with "SAVE_WORKSPACES " on the
next page. Such an *.POLY3 file is not printable.

Syntax READ_WORKSPACES

Options

File name is the name of a saved POLY3-file where the POLY3 and GIBBS
workspaces shall be read from must be specified. You do not need to type the
extension if it is the default *.POLY3 (Windows) or *.poly3 (Linux), otherwise
type the whole POLY-file name.

A window opens so that the path (in the Look in field) and File name can be
specified. The Files of type (i.e. POLY3) cannot be changed. Click Open to open
the POLY3 and GIBBS workspaces from the saved *.POLY3 file.

When reading back an original POLY3 workspace that has already been saved
as an *.POLY3 file in the current Thermo-Calc (Console Mode) run or had been
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Syntax READ_WORKSPACES

read from an existing POLY3 file under the current work area, while some
additional changes in the settings may be made but do not need to be kept in
further steps in the current Thermo-Calc (Console Mode) run or any diagram is
plotted in the POST module, you can type READ,, or READ_WORKSPACE ,,

REINITIATE_MODULE
Ensures that the whole POLY module (and thus the entire POLY workspace) is reinitiated to
the state as it was when first entered.

Syntax REINITIATE_MODULE

All the defined components, defined conditions, changed status, entered
symbols, defined independent axis-variables, calculated starting equilibrium-
points, added initial equilibrium points, stepped/mapped equilibrium data, and
so forth, are removed completely. The saved file name is restored to the
default.

RESTORE_ALL_WEIGHTS
Restore a specific weight-set (previously saved by "STORE_ALL_WEIGHTS" on page 68) and
assign all the different experimental points in the current data block with the previously-set
weights in the sequential assessments.

Syntax RESTORE_ALL_WEIGHTS

Prompt
Set number (0 for list) /0/: <weight-set number>

The default value 0 is for a list on screen.

SAVE_WORKSPACES
This command is for the ED-EXP module.

In the PARROT workspace this command saves the current status of the EDIT_EXPERIMENT
submodule before you switch back to the PARROT module. This is required when you want to
save equilibria changes, including changes to conditions, experimental data, and/or
computed equilibria results, as well as any newly added equilibria.



Thermo-Calc Documentation Set

EDIT_EXPERIMENTS Commands ǀ 55 of 370

With this command all the changes made in the EDIT_EXPERIMENT submodule are saved in
the PARROT workspace. This means you do not need to execute "SAVE_PARROT_
WORKSPACES" on page 156 in the PARROT module.

However, when in the PARROT module, additional changes can only be saved with the SAVE_
PARROT_WORKSPACES command even if they have been made prior to executing SAVE_
WORKSPACES in the EDIT_EXPERIMENT module.

When you exit the EDIT_EXPERIMENT module (or Thermo-Calc), the next time the file is
opened it is in the same state as when you executed the SAVE_WORKSPACES command.
However, if you use "OPTIMIZE_VARIABLES" on page 154 the computed results are
automatically updated.

Syntax SAVE_WORKSPACES

Prompt

<File name> <Y or N>

Sometimes good starting values ("SET_START_VALUE" on
page 226) are required to successfully get or compute an
equilibrium correctly. In this case, it is important to save the
computed equilibrium in the PARROT workspace. It is important to
remember that the computed results can be ruined by improper
optimizations. For this reason, it is suggested you save the PAR file
with a different name to back up the PARROT workspace.

SELECT_EQUILIBRIUM
If you create more than one initial equilibrium (during data-assessments using the
PARROT/ED_EXP modules), you can switch between them using this command.

Syntax SELECT_EQUILIBRIUM

Prompt

Number /Next/: <Choice on equilibrium>

Answer FIRST, LAST, NEXT, PREVIOUS or PRESENT.

Most commands affect only the PRESENT equilibrium. However, the commands
"REINITIATE_MODULE" on page 215 and "DEFINE_COMPONENTS" on page 196
remove all the stored equilibria.

SET_ALL_START_VALUES
Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If
temperature and pressure are not conditions, you are asked for values of them. Then for
each phase prompt on if it should be stable and on its constitution.
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Syntax SET_ALL_START_VALUES

T /XXXX/: <Temperature in K>

If the temperature is not a condition, supply a guess of its final value (in K).

P /100000/: <Pressure in Pa>

If the pressure is not a condition supply a guess of its final value (in pa).

Prompts

Automatic start values for phase constitutions? /N/: <Y, N or F>

Answer N (the default), Y or F (for force).

The reason for the F option is that in some cases the calculation has failed
because impossible conditions are set, e.g. W(C)=1.5 [W(C) is mass fraction
and must thus be less than unity]. The program tries to fulfil this condition by
putting maximum amount of carbon in all phases, but can fail anyway. When
you detect the error and set W(C) to 0.015, the calculation may still fail
because it could start from the previous values. To get back to ‘fresh’ start
values, give the answer F for FORCE.

If Y this command immediately terminates, and the program automatically
sets the start values for phase constitutions in all possible phases.

For N supply an initial amount of each entered phase and the major
constituents or site fraction of each constituent.

Should <phase> be stable /N/: <Y/1 or N/2>

A guess on if this phase should be stable or not is requested. All entered
phases are prompted for this question and next two.

You cannot have more phases stable than you have components,
but at least one (which dissolves all constituents) must be set as
stable. For backward compatibility, this question can be answered
by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2.
For phases with miscibility gaps, there should be two phases with the same
name but with different numbers after the hash sign.

Major constituent(s): <Name of major constituent(s) in the
phase>

The constituent with the largest fraction in the phase should be specified. If
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there are more than one constituent with a large fraction, give them all on the
same line. If the default major constituents should be used answer with an
asterisk (*). By giving $ the constitution is not changed. If there should be no
major constituent give NONE and or if the major constituent(s) are improperly
specified, you are asked for individual fractions in the phase.

Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by
pressing <Enter> or give a new value (.YYYYY).

The phase name or constituent name may have a hash sign # followed by a
digit, e.g. Y(BCC_A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility
gaps, there should be two phases with the same name but with different
numbers after the hash sign. For phases with sublattices, the constituents in
sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.

SET_ALTERNATE_CONDITION
A special command used in the experimental data *.POP/*.DOP file but also possible in the
ED_EXP module. It is used only when you have specified that the alternate mode is set in the
PARROT module.

The command syntax is almost the same as for the POLY command "SET_CONDITION" on
page 220 while the uncertainty should also be specified.

The alternate condition (including the normally POLY-module condition plus
uncertainly; see below) must be given explicitly, but can be given on the same
line or on separate lines with each one started with the command.

Syntax SET_ALTERNATE_CONDITION

Prompt
State variable expression: <State variable name or linear
expression>

Give either a state variable or a linear expression of state variables.

Options Description and Information

State
variables

Some of the state variables that can be used in conditions are:

l T (temperature in the system)

l P (pressure in the system)

l N (system size in moles)
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Syntax SET_ALTERNATE_CONDITION

l B (system site in grams)

l W(<component>) (mole fraction of a component in the system)

l X(<component>) (fraction of a component in the system)

l ACR(<component>) (activity of a component in the system)

l MUR(<component>) (chemical potential of a component in the system)

l W(<phase>,<component>) (mole fraction of a component in a phase)

l X(<phase>,<component>) (mass fraction of a component in a phase)

l ACR(<phase>,<component>) (activity of a component in a phase)

l MUR(<phase>,<component>) (chemical potential of a component in a
phase)

l H (enthalpy in the system)

l HM(<phase>) (enthalpy of a phase per mole)

Additional
prompts

Factor: <A factor for the state variable, or a continuation>

This question means that the previous question was not answered. The
program is then expecting a single state variable or a complete state
variable expression, or the numeric factor in an expression with only one
state variable. In a state variable expression a state variable may be
preceded by a constant factor. An example of this is:

2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical
potential of FE plus three times the chemical potential of O should be -35000
J/mol.

State variable: <A specified state variable, or a
continuation>

This question is prompted if a single state variable name has not given in
either the prompt State variable expression or Factor, or a state
variable expression is given but the expression is incomplete, for example,
T- or 2*MUR(FE)+, for which the program is then expecting a continuation of
the unfinished expression. You need to specify a state variable or a complete
state variable expression, or complete the unfinished state variable
expression. If a numeric factor is given before this prompt, only one state
variable can be specified; otherwise, the program only takes the first state
variable to complete the expression (i.e. the factor times the state variable).
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Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a
variable. A suggestion is given as the default value. The special value NONE
means that the condition is removed.

Uncertainty /None/: <Uncertainty of the condition>

The uncertainty of the condition. This can be a numeric value, a constant or
a variable. The default value NONE means that the uncertainty for the value
specified above is zero. The uncertainty can either be expressed as an
absolute value or relative to the value of the condition in percent (x%).

Notes

There are more state variables that can be used in conditions. For more
information, type an INFO STATE_VARIABLES command in the POLY module.
A condition is normally a value of a single state variable with its value.

For example:
T=1273.15 P=1E5

X(C)=.002

W(CR)=1.5

ACR(CR)=0.85

X(FCC,C)=.001

H=-250000

HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than
one state variable.

For example:
X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S should be the
same in the LIQUID and PYRRHOTITE phases. In practice that should be the
congruent melting point.

After the equal sign only a numeric value is allowed.
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SET_CONDITION
Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as
most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state
variables (with respect to chosen reference states), can be used as conditions. Beside
temperature and pressure conditions, a multicomponent system can have mixed types of
conditions; this brings the extreme flexibility and powerfulness to the complex calculations
with the Thermo-Calc software system. You should repeat this command for a
multicomponent system, till the degree of freedom in the defined system becomes zero.
When a FIXED phase status is used on a specific phase (use "CHANGE_STATUS" on page 186),
it is equivalent to one condition (implying that particular phase is stable in the defined
system).

Syntax SET_CONDITION

Each condition must be given explicitly, but can be given on the same line
(separated by a comma (,) or an empty space) or on separate lines with each
one started with the command.

Example
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2

or

SET_COND T=1273, P=1E5

SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5
Pascal), the mass (weight) fraction of C to 0.0015 and the mole fraction of Cr to
0.22 and the activity of N to 0.2.

Prompt

State variable expression: <State variable name or linear
expression> or a linear expression of state variables.

Some of the state variables that can be used in conditions are:

l T: temperature in the system (in K)

l P: pressure in the system (in Pascal)

l N: system size (mole number in moles)

l B: system size (mass in grams)

l N(<component>): mole number of a component in the system

l X(<component>): mole fraction of a component in the system

l W(<component>): mass fraction of a component in the system
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l ACR(<component>): activity of a component in the system

l MUR(<component>): chemical potential of a component in the system

l X(<phase>,<component>): mole fraction of a component in a phase

l W(<phase>,<component>): mass fraction of a component in a phase

l ACR(<species>,<phase>): activity of a species in a solution phase

l MUR(<species>,<phase>): chemical potential of a species in a solution
phase

l H: enthalpy in the system (in J)

l HM(<phase>): enthalpy of a phase (in J/mol)

There are many state variables that can be used in conditions. For more
information, enter an INFO STATE_VARIABLES command. A condition is
normally a value of a single state variable with its value.

Example
T=1273.15 P=1E5

X(C)=.002

W(CR)=0.5

ACR(CR)=0.85

X(FCC,C)=.001

H=-250000

HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one
state variable. For example,

X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S component should
be the same in the LIQUID and PYRRHOTITE phases. In practice, that should be
the congruent melting point.

After the equal sign only a numeric value is allowed in the
expression.

Factor: <A factor for the state variable, or a continuation>

This question means you did not answer the previous question. The program is
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then expecting a single state variable or a complete state variable expression,
or the numeric factor in an expression with only one state variable. In a state
variable expression a state variable may be preceded by a constant factor. An
example of this is:

2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential
of FE plus three times the chemical potential of O should be -35000 J/mol.

State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either
the prompt State variable expression or Factor, or a state variable
expression is given but the expression is incomplete, for example, T- or 2*MUR
(FE)+, for which the program is then expecting a continuation of the unfinished
expression. You need to specify a state variable or a complete state variable
expression, or complete the unfinished state variable expression. If a numeric
factor is given before this prompt, only one state variable can be specified;
otherwise, the program only takes the first state variable to complete the
expression (i.e. the factor times the state variable).

Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a
variable. A suggestion is given as the default value. The special value NONE
means that the condition is removed; for example T=NONE takes away the
temperature condition.

SET_NUMERICAL_LIMITS
Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by "COMPUTE_EQUILIBRIUM" on page 190, "STEP_WITH_
OPTIONS" on page 227, "MAP" on page 212 or "ADVANCED_OPTIONS" on page 174), this
message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current Thermo-
Calc (Console Mode) run, you can use this command to restore or reset the smallest site
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fraction to the previous or another preferred value, as well as to reset other numerical
limits.

Syntax SET_NUMERICAL_LIMITS

Prompt

Maximum number of iterations /200/: <xxx>

By default, the program tries 500 iterations before it gives up. As some models
give computation times of more than 1 CPU second/iteration, this number is
also used to check the CPU time and the calculation stops if 500 CPU
seconds/iterations are used.

Required accuracy /1E-6/: <yyy>

This is a relative accuracy, and the program requires that the relative
difference in each variable must be lower than this value before it has
converged. A larger value normally means fewer iterations but less accurate
solutions. The value should be at least one order of magnitude larger than the
machine precision.

Smallest fraction /1E-12/: <zzz>

This is the value assigned to constituents that are unstable. It is normally only in
the gas phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except
for IDEAL phase with one sublattice site (such as the GAS mixture phase in
many databases) for which the default value is always as 1E-30 (unless you
have used the SET_NUMERICAL_LIMITS command to reset an even-lower value
(e.g. 1E-45, that is naturally enforced to all the phases in the system).

Approximate driving force calculation for metastable phases /Y/:
<Y or N>

Normally the POLY module only requires that the set of stable phases is in
equilibrium in order to terminate the iterations. The metastable phases are
included in all iterations but these may not have reached their most favourable
composition and thus their driving forces may be only approximate
[corresponding to Y]. You can also force the calculation to converge for the
metastable phases by answering N if it is important that these driving forces
are correct, which may require more iterations, and the STEP and MAP
command may also terminate due to bad convergence in a metastable phase.

SET_REFERENCE_STATE
The reference state for a component is important when calculating activities, chemical
potentials and enthalpies. The reference state for a component is determined by the
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database. For each component the data must be referred to a selected phase, temperature
and pressure, i.e. the reference state. All data in all phases where this component dissolves
must use the same reference state. However, different databases may use different
reference states for the same element. Thus you must be careful when, for example, mixing
data from different databases.

By default, activities, chemical potentials, etc. are computed relative to the reference state
used by the database and this may thus differ depending on the database. With this
command select the reference state for a component if the reference state in the database
does not suit.

You can set the reference state for a component as SER, i.e. the Stable Element Reference
(which is usually set as default for a major component in alloys that is dominated by the
component). Under such a case, the temperature and pressure for the reference state is not
needed and thus is not prompted.

In order to specify conditions in the specified reference state, you can append an R to the
state variables. Thus, AC is the activity (of a system component or of a species in a phase)
with respect to the default reference state, and ACR is the activity with respect to the
selected reference state; MU is the chemical potential of a system component with respect
to the default reference state, and MUR stands for the chemical potential with respect to
the selected reference state. The AC and ACR variables, for both components in a system
and species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).

Syntax SET_REFERENCE_STATE

Prompts
Component: <Name of the component>

The name of the component must be given.

Reference phase: <Name of a phase used as the new reference
state>

The Name of a phase, that must be either ENTERED or DORMANT or
SUSPENDED, must be given here. The component must, of course, be a
constituent of this phase.

For a phase to be usable as reference for a component the component need to
have the same composition as an end member of the phase. The reference
state is an end member of a phase. For example, in the Fe-C system, BCC can
be a reference state for Fe but not for C since BCC cannot exist as pure C.

If a component has the same composition as several end members of the
chosen reference phase, then the end member is selected that at the specified
temperature and pressure has the lowest Gibbs energy. For example, setting
the reference state for component O as gas (one sublattice) with constituents
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O1, O2 and O3 results in O2 being the reference state if, at the present
temperature, pure O2 has the lowest energy of O1, O2 and O3. If the
reference state is set above a critical higher temperature, then O1 has the
lowest energy and consequently become the reference state.

The actual calculation of the reference state is only performed
when SET_REFERENCE_STATE is executed. For example, if GAS is
chosen as the reference phase of component O at such a high
temperature that O1 has the lowest energy, then O1 remains the
reference state even at calculations performed at lower
temperatures where O2 has a lower energy than O1.

Temperature /*/: <Temperature for the reference state>

Select the temperature (in K) for the reference state. The wildcard value *
means the current temperature is used for the calculation.

Pressure /1E5/: <Pressure for the reference state>

Select the pressure (in Pa) for the reference state. The wildcard value * means
the current pressure is used for the calculation.

Examples
S-R-S Fe SER

S-R-S Cr FCC * 100000

S-R-S H2O AQUEOUS * 100000

S-R-S ZE REF_ELECTRODE * 100000

SET_START_CONSTITUTION
This command is similar to "SET_ALL_START_VALUES" on page 217, but is used for an
individual phase that may have a wrong constitution.
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Prompts

Phase name: <Name of a phase, and possible major
constituent(s)>

Specify the name of a phase for which the constitution shall be set.

If there is a major constituent of the phase, you must specify this on
the same line as the phase name. By giving an*, select the default
major constituents. A $ means keeping the same constitution, and
NONE means to give individual site-fractions.

Y(<Phase>#<Composition_set>,<Constituent>#<Sublattice>)
/xxx/: <SF>

The site fraction (SF) of the constituent shall be given. The default
value xxx is the last calculated one.

SET_START_VALUE
Set a start value of an individual variable.

This command is not often required as the automatic start values can be
handled for most problems.

Syntax SET_START_VALUE

Prompts
State variable: <Name of a state variable>

The state variable must be given.

Value

Specify the value to be assigned the state variable as start value.

SET_WEIGHT
Each experimental value has an uncertainty associated with it, specified by the value after
the colon (:) with the command "EXPERIMENT" on page 44. During an optimization the
absolute difference between the experimental and calculated values gives a contribution to
the sum of error.

With the SET_WEIGHT command, you can change the scale of such a contribution (the
uncertainty) for a single experimental point, or the contributions (all uncertainties) for a set
of equilibria. The default weight is always unity. A value smaller than one means that the
experiments should have less weight. A value larger than one that these should have higher
weight. The special value zero means that the set of equilibria should be ignored in editing
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in ED_EXP (as "COMPUTE_ALL_EQUILIBRIA" on page 37 is given) and in "OPTIMIZE_
VARIABLES" on page 154 in PARROT.

The weight may be needed to obtain a balance between different kinds of
experiments. For example, if there are only five experimental values of the
composition of a phase diagram but 500 experimental values of activities or
enthalpies, then the five composition points may have to be given higher weight
than unity, otherwise these are not well described by the optimizing procedure.

Syntax SET_WEIGHT

Prompts

Value /1/: <Weight value>

Specify a weight of the experiments in the specified equilibria (asked in the
next prompt). The contribution to the sum of errors of these experiments are
multiplied by this weight.

The weight is squared, thus use 0.7 to make the error half (0.49)
as big, and 1.4 to make it twice (1.96) as large.

Equilibria (range) or label(s) /Present/:<Selection>

Define the equilibria. These are available in the read data block from the
current work file and are given the above-defined weight.

The selection may be given as a range but the equilibrium numbers must then
be separated only by a minus sign.

The start and end equilibrium numbers must be available in the
read data block read from the current work file.

For example, 5-101, means that all equilibria starting from the identifier 5
until the identifier 101. Some of numbers between these two identifiers may
not exist in the data block.

The selection may also be given as one or more labels (which should be
separated only by a space). All equilibria with the specified label(s) in the read
data block are given the above-defined weight.

By pressing <Enter> to accept the default value present, the above defined
weight is only assigned to the current or present experimental point (which is
selected by the POLY command "SELECT_EQUILIBRIUM" on page 216).

If "COMPUTE_ALL_EQUILIBRIA" on page 37 is used but no specific
equilibrium point is selected afterwards, the last point in the read
data block remains the present point.
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SHOW_VALUE
Show the current value of any state variable, function or variable.

Syntax SHOW_VALUE

Prompt

State variable or symbol: <Name(s) of state variable(s) or
symbol(s)>

A single or several state variables or symbols (entered functions or variables)
can be specified.

The wildcard * can be used to denote all phases or all components.

You can use the dollar-sign $ to denote all stable phases. Thus, the command
SHOWW(*,*)lists the mass fraction of all phases, whereas SHOW W($,*)lists the
mass fraction of all stable phases.

If you SHOW a function, all functions are evaluated using the
current values of the state variables. But if you SHOW a variable, it
retains its value from the time it was ENTERED or last EVALUATED.

Therefore to save a value from one calculation to another, ENTER it to a
variable. This is frequently done in the PARROT module to transfer values
between equilibria.

STORE_ALL_WEIGHTS
Store a new weight-set that is the current situation of specified weights for all the different
experimental points read from the currently-selected experimental data block in an
assessment. This is useful when you want to try various weight-settings for some
experimental points or for all the points, and then compare the assessment results from
different weight-sets. Such a saved weight-set can be recalled and restored for all
experimental data point with"RESTORE_ALL_WEIGHTS" on page 54 sequentially.

Syntax STORE_ALL_WEIGHTS

Prompt

Command line: <Weight-set name>

Give a weight-set name (comment line texts) for the current weight set for all
experimental points.

TABLE_HEAD, TABLE_VALUES and TABLE_END
These commands are used only in the *.POP/*.DOP files. It represents a convenient way to
enter many experimental measurements of the same type in a table format.
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These commands should always be used together and in a sequence, meaning
that a table should always start with the TABLE-HEAD command, then follows
the TABLE-VALUES command, and finish by the TABLE-END command. Between
the two TABLEHEAD and TABLE-VALUES commands, there should exist some
definition lines (e.g. on phase status, reference states, conditions, experiments,
labels, etc.) for the experimental measurements of the current information
type.

Syntax

TABLE_HEAD
TABLE_VALUES
TABLE_END

Prompt

After the TABLE-HEAD command, there must be an equilibrium description
similar to a single experimental equilibrium but with some special notation.
Then, there is always a TABLE-VALUES command, after which the actual data is
given in columns. At the end of each table, there must be a TABLE-END
command.

The TABLE-HEAD command must be followed by a numeric value. This is used to
generate unique numeric identifiers for all the equilibria in the table. The
numeric identifier is incremented by one for each experimental (equilibrium)
point in the table.

Example

An example of the use of a table for enthalpy measurements in the liquid is
given here. Much more elaborate tables can be used

$ Enthalpies of mixing, Topor and Kleppa, Met Trans 1984 TABLE-HEAD 1

CREATE—NEW @@ 1

CHANGE-STATUS PHASE LIQ=FIX 1

SET-REFERENCE-STATE AU LIQ * 1E5

SET-REFERENCE-STATE CU LIQ * 1E5

SET-CONDITION P=1E5 T=1379 X(LIQ,AU)=@1

LABEL ALH

EXPER HMR=@2:5%

TABLE—VALUES

0.0115 -322
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Syntax

TABLE_HEAD
TABLE_VALUES
TABLE_END

0.0563 -1520

0.8499 -2976

0.9002 -2114

TABLE—END

The equilibrium description between TABLE-HEAD and TABLE-VALUES is similar
as for a single experiment, except for these details:

l @@ Used to automatically generate a series of identifying numbers
instead of creating only one with the command "CREATE_NEW_
EQUILIBRIUM" on page 195. The program automatically generates the
identifying numbers starting after the number given after the TABLE-
HEAD command (in this case it is 1).

l @1 values in the table are specified by an @ sign followed by a column
number. In the above case, the mole fraction of Au in the liquid is in
column 1 (see the line for SET-CONDITION). The columns may have
other information than values, and you can use phase names or any
text. If the text contains spaces or special characters, it must be
surrounded by double quotes in the table, e.g. “ABC DEF&ghi”.

l For the syntax checker all commands describing the equilibrium must be
in UPPER case after the TABLE-HEAD command.

l After the TABLE-VALUES command, there should be one line for each
experimental measurement of the same type giving the values or texts
that should be copied into the places of the condition or experiment
defined by @1, t, etc. You can have columns that are not used but there
must be exactly the same number of columns of each line, otherwise
the syntax checker gives an error message in the PARROT module.

TRANSFER_START_VALUES
In the ED_EXP module it is time consuming to calculate all equilibria when the optimization
is sensitive to start values of the composition of the phases. Usually in one data block there
are several experimental points with the same kind of equilibrium and each must have its
start value set. When you manage to calculate equilibriums of such experimental points, this
command is useful to transfer the site fractions from a successfully-calculated equilibria to
the present experimental point.
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Syntax TRANSFER_START_VALUES

Prompt

From equilibrium /Previous/: <Equilibrium number>

The equilibrium number is the numeric identifier for the equilibrium from
which the start values should be copied to the present experimental point.
Previous is the default if you press <Enter>.
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Experimental Data Files
In this section:

Commands in the Experimental Data Files (*.POP, *.DOP) 73

TABLE_HEAD, TABLE_VALUES and TABLE_END 75

COMMENT 77

FLUSH_BUFFER 77
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Commands in the Experimental Data Files (*.POP,
*.DOP)
In order to conduct an assessment for a system, the experimental data is described with a
syntax, which is similar to the way that one calculates an equilibrium in the POLY module or
you edit an experimental point in the ED_EXP module. Similar to a Thermo-Calc (TCC)
macro file (*.TCM), an experimental data file (i.e. the *.POP or *.DOP file) is a basic text file
and can be opened and edited by any text editor. For this reason, an *.POP or *.DOP file is
not hardware dependent.

A POP or DOP file consists of various commands from the POLY and ED_EXP modules, as
well some special commands which can only be used in such experimental data files.
Various experimental information can be inputted in an *.POP or *.DOP file as different
tables; the same type of experimental data are usually documented in the same table (see
below).

An *.POP or *.DOP file is used in the PARROT module to provide experimental information
for the optimization process, and is checked by a syntax checker when the PARROT
command "COMPILE_EXPERIMENTS" on page 137 is proceeded.

Many POLY and ED_EXP commands can be directly used in a POP or DOP file. But there are
some differences with the set of POLY or ED_EXP commands, and some specially designed
commands as described in this topic can only be used in the *.POP or *.DOP files.
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Frequently Used Commands

Most of the commands in the experimental data file are the same as in the POLY module.
The most frequently used are listed below:

l "CREATE_NEW_EQUILIBRIUM" on page 195

l "CHANGE_STATUS" on page 186

l "SET_CONDITION" on page 220

l "SET_REFERENCE_STATE" on page 224

l "ENTER_SYMBOL" on page 247

l "SAVE_WORKSPACES " on page 54

As the last command in an *.POP or *.DOP file, you must always have the SAVE
command.

Other Commands

Other legal commands from the POLY module that are used less often are:

l "DEFINE_COMPONENTS" on page 196

l "EVALUATE_FUNCTIONS" on page 208

l "SET_ALL_START_VALUES" on page 217

l "SET_NUMERICAL_LIMITS" on page 296

l "SET_START_VALUE" on page 226

l "ADVANCED_OPTIONS" on page 174

The DEFINE-COMPONENTS command must be always used as the first
command in an *.POP or *.DOP file, as it automatically reinitiates the whole
workspace.

Most of the special commands for the ED_EXP module are also often used in an *.POP or
*.DOP file. For example:
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l "EXPERIMENT" on page 44

l "EXPORT" on page 46

l "IMPORT" on page 47

l "LABEL_DATA" on page 48

l "SET_ALTERNATE_CONDITION" on page 57

l "SET_WEIGHT" on page 66

The following special ED_EXP commands are illegal and should not be used in
any *.POP or *.DOP file:

l COMPUTE-ALL-EQUILIBRIA

l MAKE-POP-FILE

l READ (READ-BLOCK OR READ-WORKSPACE)

l TRANSFER-START-VALUES

The special commenting identifier, i.e. a single dollar sign $ which starts a line, is used to
document comment lines at any position in an *.POP or *.DOP file. You may remember that
this feature is universally the same as in almost all kinds of text files in Thermo-Calc
software, e.g. in *.TDB, *.DAT, *.TCM, *.POP/*.DOP and *.EXP files. Such a sign and all
information after wards in the same comment line is skipped and ignored by the syntax
checker. Therefore, you shall feel free to write such comment lines in any of these types of
text files.

TABLE_HEAD, TABLE_VALUES and TABLE_END
These commands are used only in the *.POP/*.DOP files. It represents a convenient way to
enter many experimental measurements of the same type in a table format.

These commands should always be used together and in a sequence, meaning
that a table should always start with the TABLE-HEAD command, then follows
the TABLE-VALUES command, and finish by the TABLE-END command. Between
the two TABLEHEAD and TABLE-VALUES commands, there should exist some
definition lines (e.g. on phase status, reference states, conditions, experiments,
labels, etc.) for the experimental measurements of the current information
type.
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Syntax

TABLE_HEAD
TABLE_VALUES
TABLE_END

Prompt

After the TABLE-HEAD command, there must be an equilibrium description
similar to a single experimental equilibrium but with some special notation.
Then, there is always a TABLE-VALUES command, after which the actual data is
given in columns. At the end of each table, there must be a TABLE-END
command.

The TABLE-HEAD command must be followed by a numeric value. This is used to
generate unique numeric identifiers for all the equilibria in the table. The
numeric identifier is incremented by one for each experimental (equilibrium)
point in the table.

Example

An example of the use of a table for enthalpy measurements in the liquid is
given here. Much more elaborate tables can be used

$ Enthalpies of mixing, Topor and Kleppa, Met Trans 1984 TABLE-HEAD 1

CREATE—NEW @@ 1

CHANGE-STATUS PHASE LIQ=FIX 1

SET-REFERENCE-STATE AU LIQ * 1E5

SET-REFERENCE-STATE CU LIQ * 1E5

SET-CONDITION P=1E5 T=1379 X(LIQ,AU)=@1

LABEL ALH

EXPER HMR=@2:5%

TABLE—VALUES

0.0115 -322

0.0563 -1520

0.8499 -2976

0.9002 -2114

TABLE—END

The equilibrium description between TABLE-HEAD and TABLE-VALUES is similar
as for a single experiment, except for these details:

l @@ Used to automatically generate a series of identifying numbers
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Syntax

TABLE_HEAD
TABLE_VALUES
TABLE_END

instead of creating only one with the command "CREATE_NEW_
EQUILIBRIUM" on page 195. The program automatically generates the
identifying numbers starting after the number given after the TABLE-
HEAD command (in this case it is 1).

l @1 values in the table are specified by an @ sign followed by a column
number. In the above case, the mole fraction of Au in the liquid is in
column 1 (see the line for SET-CONDITION). The columns may have
other information than values, and you can use phase names or any
text. If the text contains spaces or special characters, it must be
surrounded by double quotes in the table, e.g. “ABC DEF&ghi”.

l For the syntax checker all commands describing the equilibrium must be
in UPPER case after the TABLE-HEAD command.

l After the TABLE-VALUES command, there should be one line for each
experimental measurement of the same type giving the values or texts
that should be copied into the places of the condition or experiment
defined by @1, t, etc. You can have columns that are not used but there
must be exactly the same number of columns of each line, otherwise
the syntax checker gives an error message in the PARROT module.

COMMENT
This command is only used in the *.POP/*.DOP files to write brief comments or descriptive
information on a newly created equilibrium (experimental) data point or a set of points
given in a table.

Syntax COMMENT

A comment can have a maximum of about 60 characters written on the same
line.

FLUSH_BUFFER
This command is only used in the *.POP/*.DOP files. It is needed if the number of
experiments require more space than can be fitted into one buffer. When the PARROT
program compiles experiments, it informs if any FLUSH commands are needed. The FLUSH_
BUFFER command terminates the current block, save it to the work file and starts a new
block. With the READ command in the EDIT-EXP module, you can select the block to edit.
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Syntax FLUSH_BUFFER

After a FLUSH_BUFFER command, the workspace is reinitiated and all functions
or constants must be entered again in the *.POP file. You can take advantage of
this; for example, you can use the FLUSH command to have blocks with different
components in one *.POP file.
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Gibbs Energy System (GES) Commands
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ADD_COMMENT

Syntax ADD_COMMENT

Add a comment or make notes about parameters.

AMEND_ELEMENT_DATA
The data for an element (in the SER, the Stable Element Reference, state) can be changed by
this command. It should only be used for the elements that do not have any data in the
database because the element data available in the database is set by the database-
developer for the purpose of internal consistency. Except for the mass, the other values have
no influence on the calculations.

Syntax AMEND_ELEMENT_DATA

Prompts
Element name: <Element name>

Specify the name of the element for which you want to change the data.

New stable element reference /ABCD/: <Name of ser>

Press <Enter> to accept the default SER or specify a new SER for the element.
Important: The default name should not be changed if this data is retrieved
from a database. This name is used when parameters for a phase are listed
and the database assumes that the stable element reference is the same as in
the database. Only if the element's data have not been fetched from a
database, e.g. entered manually, can you enter a new SER.

New atomic mass /xx.xxxx/: <yyyyyy>

Press <Enter> to accept the default atomic mass or specify a new value for the
element. The atomic mass of the element is given in g/mol.

New h(298.15)-h(0) /xxx.xxx/: <yyyyy>

Press <Enter> to accept the default H(298.15)-H(0) or specify a new value for
the element. H(298.15)-H(0) is the enthalpy difference between 298.15 K and
0 K for the element in its SER state.

New s(298.15) /xx.xxxx/: <yyyyy>

Press <Enter> to accept the default S(298.15) or specify a new value for the
element. S(298.15) is the absolute value of the entropy at 298.15 K for the
element in its SER state.

Default element reference state symbol index /#/: <index>



Thermo-Calc Documentation Set

Gibbs Energy System (GES) Commands ǀ 82 of 370

Syntax AMEND_ELEMENT_DATA

The index only changes the symbol, not any value. Normally the
index is set correctly by the database. Only when manually
entering data, you must set the index to get the correct symbol.

Specify an index for the default listing parameters (symbol), or press <Enter>
to accept the pre-set index. 0 is for G, 1 is for H298 and 2 is for H0.

The index is to define the symbol printed in parameter listings. The symbol can
be:

l G the data are referred to Gibbs energy at a variable temperature (also
called lattice stability).

l H298 the data are referred to the enthalpy of the element at 298.15 K
and 1 bar.

l H0 is the same as H298 but at the temperature 0 K.

AMEND_PARAMETER
This AMEND_PARAMETER command is for the GES module. There is also a
PARROT module command with the same name ("AMEND_PARAMETER" on
page 132).

Use this command to interactively change/amend the temperature-pressure function of a
parameter. This is useful to correct typing errors because the old function is made available
on the terminal for interactive editing. For most of these prompts, refer to "ENTER_
PARAMETER" on page 143 for details.

Syntax AMEND_PARAMETER

Prompts

Parameter: <Parameter name>

Specify a correct parameter name. If a parameter name is not acceptable or
you only press <Enter>, the error message displays:

Error, please re-enter each part separately

The program prompts for separate input for each part for a parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or Va or Vb or Vc
or Vk>
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Syntax AMEND_PARAMETER

Specify one of these legal identifiers as described for ENTER_PARAMETER.

Phase name (/ABCD/): <Phase name>

Specify the phase name.

Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name.

Interacting constituent (in sublattice # /xyz/): <Species name>

Specify the interacting constituent name: If there is no interacting constituent,
press <Enter>.

Interacting constituent (in sublattice # /xyz/): <Species name>

If there are more than one interacting constituents, specify them; otherwise
press <Enter>.

Degree /#/: <Degree>

Specify a numerical number as the degree of the phase parameter.

After the parameter name is specified correctly, the program lists its current
definition (either present in the database or defined by the ENTER_
PARAMETER command), such as:

L(PHASE2,AL,MG;1)=

298.15<T<2000.00: +5000

2000.00<T<4500.00: +4500

4500.00<T<6000.00: +4000

Then you are prompted to change the parameter definition, as shown below:

Do you want to change the number of ranges /NO/: <Y or N>

If you want to change the number of ranges for the chosen function, or change
some of the temperature limits in the definition, for Y, retype both the
low/high temperature limits and functions.

If you do not want to change the number of ranges but want to change the
function(s) in one or more ranges, press <Enter> to accept the default N, then
the whole definition of the chosen parameter in all ranges (if any) is listed on
screen, such as:

DIFFERENT FUNCTIONS IN THESE RANGES
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Syntax AMEND_PARAMETER

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00

The prompt is given:

Do you want to change range limits /No/: <Y or N>

If there is more than one range, this question is prompted press <Enter>.

Range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges,
you must specify the range of the function of which you want to amend. Or
press <Enter> or type 0 to exit this command without making any changes.

Function:

The previous function is available for editing. The editing is performed within
the general subroutine FOOLED, as described in "AMEND_SYMBOL" on
page 134. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at
that position between colons, (::).

Commands

These commands can be given:

l Help: ?

l Move CP to last or first character: <+/-> A

l Delete characters from CP: <+-#characters> D

l Exit: E

l Find: <#occurrences> F<string>@

l Insert: I<string>@

l Move: <+-#positions> M

l Restore string: R

l Substitute: S<OLD>@<NEW>@

l Type string: T
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Syntax AMEND_PARAMETER

Where CP denotes the current position in string, # means number of, @ is a
terminator of an input or search string.

When the string is typed the character at the current position is
replaced by an underscore _.

To finish the editing of the current function, type E at the prompt.

Solution Models in the GIBBS Module
The command "AMEND_PHASE_DESCRIPTION" on page 93 is used to specify/amend phase
descriptions if a phase has a miscibility gap, uses a special excess energy model, or has a
specific additional contribution to its Gibbs energy, for example.

This topic outlines the application of each option and includes important information about
each command.

There are many solution models implemented in the GIBBS module (type INFO MODELS to
see details about various thermodynamic models). However, these are switched on and
handled differently via various GIBBS routines/commands:

l The first models the non-ideality as excess parts, i.e. by amending the phase’s
EXCESS_MODEL and/or TERNARY_EXTRAPOLAT models.

l The second models the non-ideality as ADDITIONAL parts, i.e. by amending the
phase’s other subjects in this command, e.g. MAGNETIC_ORDERING for the Magnetic
Ordering Model, DISORDERED_PART for the CVM Approach in modelling chemical
ordering/disordering phenomenon, QUASICHEM_IONIC for using a quasi-chemical
entropy term for an ionic two-sublattice liquid solution phase, QUASICHEM_FACT00
or QUASICHEM_IRSID for describing a substitutional liquid solution phase, DEBYE_
HUCKEL for the DHLL/SIT Model in describing a dilute aqueous solution phase, etc.

l The third implements the model entirely or partially into the GIBBS module and
related database(s), such as for the electrostatic contribution in an AQUEOUS
solution phase by the Complete Revised_HKF Model, the Murngham Model, Birch-
Murngham Model or Generalized PVT Model for high-pressure/temperature volume
contribution in a solid or liquid phase, the SUPERFLUID Model for the non-ideal EOS
and non-ideal mixing in a gaseous mixture.

NEW_CONSTITUENT

Use this if you want to add a new constituent to a phase. It is illegal to add new constituents
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to an ionic two-sublattice liquid phase.

RENAME_PHASE

Use this to change the names of some specific phases. For example, a phase called FE3O4_S
may be better namedMagnetite to help identify it during the calculations and
postprocessing. This is also a way to delete a phase by hiding it under a new name.

SITE_RATIOS

Use this to change the number of sites (i.e. the stoichiometric coefficients of various
sublattices) in a sublattice phase.

COMPOSITION_SETS

Use this for solution phases that may have miscibility gap(s). However, this is less important
today and often unnecessary to define additional composition set(s), since the implemented
Global Minimization Technique can usually detect and add such composition set(s) in an
automatic manner where it is really necessary during equilibrium calculations (of single-
points, stepping or mapping).

MAJOR_CONSTITUENT

Use this to set major constituent(s) on each sublattice in each composition set for a solution
phase. This is useful to make calculations converge faster because it may simplify giving
start values when calculating the equilibrium as those phases with miscibility gaps should
have different major constituents for each composition set. The databases often set major
constituents for several phases automatically when data are retrieved.

FRACTION_LIMITS

Use this to limit the application range (in terms of mole-fractions of all the involved
elements) of a particular solution phase. This is useful to avoid automatic creations
(enforced by the Global Minimization Technique) of additional composition sets for some
solution phases (such as AQUEOUS solutions or dilute Fe-based liquid mixtures) of which the
used models [e.g. the SIT Model or the Complete Revised_HKF Model for AQUEOUS
solution, or the modified dilute solution parameters (plus a quadratic term, according to
Hillert (1986) based on the SigworthElliot Model (Sigworth and Elliot, 1974) for Fe-rich liquid
mixture] cannot be appropriately applied on a full scale.

Globally set the composition limits (in terms of mole fractions of various elements) in a
specific solution phase, so that whenever the program finds a potential phase composition or
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a new composition set of possible miscibility gap(s) but that is out of this globally-set
composition range, the program automatically ignores such a phase composition in an
equilibrium calculation. This can be done either permanently inside a database (by enforcing
this option for amending the phase-description of the solution phase) or temporarily within
the GIBBS module (by using this phase-description amendment option).

This is important for solution phases for which the thermodynamic models and assessed data
for the phases are for specific composition ranges, for example, the FE_LIQUID phase in the
SLAG database is only applicable for Fe-rich liquid mixture, and the AQUEOUS phase in the
TCAQ/PAQ and AQS/PAQS databases is only applicable for H2O-dominant aqueous solution
phase.

Specify the low and high mole-fraction limits for each of the elements possibly available
within the considered phase (in the currently defined system, or in a certain database). Do
this for all the possible elements (defined in the phase) in a single AMEND_PHASE_
DESCRIPTION FRACTION_LIMITS command-sequence, for example:

TYPE_DEFINITION R GES AM_PH_DES FE_LIQUID FRACTION_LIMITS Fe 0 0.6

Ag 0 0.01 Al 0 0.05 Ca 0 0.05 Co 0 0.01 Cr 0 0.01

Cu 0 0.02 Mg 0 0.05 Mn 0 0.05 Mo 0 0.05 Nb 0 0.05

Ni 0 0.05 Pb 0 0.05 Si 0 0.10 Sn 0 0.02 Ti 0 0.05

U 0 0.01 V 0 0.02 W 0 0.02 Zr 0 0.03

B 0 0.01 C 0 0.01 H 0 0.01 N 0 0.01 O 0 0.01

P 0 0.01 S 0 0.01 !

DISORDERED_PART

This command is needed for the special treatment of chemically-ordered phases where the
contributions from the disordered state are described by a phase without ordering
sublattices (the disordered phase name must be specified).

Several checks are made that the ordered and disordered phases are compatible
(sublattices, sites and constituents). A link is then created between the phases, and the
disordered phase is hidden from application programs. The Gibbs energy for the ordered
phase also includes the Gibbs energy for the disordered phase.

Phases which can have an order/disorder transformation have parameters split on two
phases and are referred to as the two phase description in the GIBBS module. One of them
has sublattices for chemical ordering, the other one represents the disordered state.
Normally, the ordered BCC and FCC or HCP phases may have either 2 or 4 substitutional
sublattice (plus one additional interstitial site), that are handled by the Two Substitutional-
Sublattice Ordering Model or Four Substitutional-Sublattice Ordering Model, respectively.
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Two phase means that the ordered phase has parameters that describe the ordering. The
disordered phase has all parameters for the reference state and those for describing the
disordered phase. The ordered phase may occur only is some systems whereas the
disordered phase may occur frequently, typical examples are the disordered FCC and BCC
which may become ordered as L12 or B2 in certain systems. In order to treat
multicomponent systems where some subsystems have ordering it would be necessary to
transform all parameters of BCC into a B2 model.

The parameters describing the disordered phase are not changed but the Gibbs Energy
system is informed that the Gibbs Energy for the two phases should be added.

The method used calculates the Gibbs Energy of a two phase model with two or four
substitutional sublattices for ordering.

The mole fractions xi are calculated from the site fractions yi. The last term
means that the contribution from Gmord in a disordered state (same site
fraction, equal to the mole fraction, on both sublattices) is subtracted. The
effect of this is that the parameters in the ordered phase have no contribution
to the disordered state.

MAGNETIC_ORDERING

Change the magnetic ordering parameter for a certain phase with magnetic ordering
contribution, in terms of its anti-ferromagnetic factor. By default this is –1 for BCC phase
and –3 for all other phases (FCC, HCP, etc.). The fraction value of the total enthalpy (due to
short-range ordering above the magnetic transition temperature) is by default 0.40 for BCC
phase and 0.28 for all other phases (FCC, HCP, etc.).

EXCESS_MODEL

See example tcex52 in the Thermo-Calc Console Mode Examples Guide.

Use this to change the default Excess Model (for interaction energies) from the default
(REDLICH-KISTER_MUGGIANU). The model handles the excess interaction energies in a
solution phase is chosen from:

l REDLICH-KISTER_MUGGIANU: for binary (R-K) & ternary (R-K-M) interactions

l REDLICH-KISTER_KOHLER: for binary (R-K) & ternary (R-K-K) interactions

l FLORY-HUGGINS POLYMER MODEL: for interactions in a polymer mixture phase (F-
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H)

l MIXED-EXCESS-MODELS: (R-K default) for mixed binary excess model (R-K, Legendre
& Polynom) of a substitutional solution phase

l HKF: for interaction in an AQUEOUS solution phase (HKF)

l PITZER: for interaction in an AQUEOUS solution phase (PIT)

l CENTRAL_ATOM_MODEL: for interaction in a liquid slag solution phase (C-A-M)

For extrapolations of excess energies from related binary systems to ternary or higher-order
systems, the Redlich-Kister binary excess interaction parameters may be extrapolated with
either a Muggianu extension (i.e. the default REDLICH-KISTER_MUGGIANU model) and a
Kohler extension (i.e. the alternative REDLICH-KISTER_KOHLER model), where there is no
ternary, quaternary or higher-order interaction parameter.

The REDLICHKISTER_KOHLER model is implemented only for ternary systems.

The MIXED-EXCESS-MODELS option works only for a substitutional phase with no sublattice
(such as the metallic LIQUID phase) and it can be used to invoke asymmetrical simple or
Legendre polynomial as binary excess energy models in addition to the default symmetrical
Redlich-Kister model for the chosen pair of constituents in a substitutional phase with no
sublattice. Asymmetrical here means that the power series depend only on one of the
constituents, for example with expansions based on the [1-2*X(B)] term rather than [X(A)X
(B)].

Binary interaction parameters for such a pair of constituents must be entered
prior to turning on the non-default Legendre or Polynom models.

TERNARY_EXTRAPOLAT

See example tcex52 in the Thermo-Calc Console Mode Examples Guide.

Use this to change the extrapolation method from the default REDLICH-KISTER_MUGGIANU to
another extrapolation model. This method extrapolates from binary to ternary (and higher-
order) excess interaction parameters in a solution phase and is chosen from:

l MUGGIANU for Muggianu Extrapolation from R-K parameters

l TOOP-KOHLER for Toop-Kohler Extrapolation Model

l KOHLER-ALL for Kohler Extrapolation Model

l MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model
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Only when all the relevant binary excess energies in the current solution phase
are treated by the default Redlich-Kister Model (i.e. the Mixed-Excess-Model
should have not been used), the MUGGIANU_RESTOR method for ternary
extrapolations is equivalent to the Redlich-Kister_Muggianu Model, or the
KOHLER-ALL method to the RedlichKister_Kohler Model.

The default ternary extrapolation method MUGGIANU_RESTOR applies to a solution phase as a
whole, whatever the binary excess model(s) enforced to each of individual binary pairs in
the phase. In case that all the binary pairs in the phase use the default binary excess model
REDLICH-KISTER, then the ternary extrapolation method becomes the so-called Redlich-
Kister_Muggianu Model (in short as R-K-M), for extrapolations from binary parameters to
ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for
that, such a default R-K-M Model is always used.

The KOHLER-ALL ternary extrapolation method can be turned on also for a solution phase as
a whole, whatever the binary excess model(s) enforced to each of individual binary pairs in
the phase. In case that all the binary pairs in the phase use the default binary excess model.

REDLICH-KISTER, then the ternary extrapolation method becomes the so-called Redlich-
Kister_Kohler Model (in short as R-K-K), for extrapolations from binary parameters to
ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for
that, such an R-K-K Model is used.

The TOOP-KOHLER ternary extrapolation method is applied in a special way: for a specific
ternary system (e.g. A-B-C) in a solution phase, specify which two constituents as the so-
called Kohler constituents and the remaining constituent as the so-called Toop constituent on
a given sublattice. If for the A-B-C ternary system you have specified A and B, or B and A, as
the Kohler constituents (entered as the basis constituent and first interacting constituent)
and C as the Toop constituent, only the A-B binary interaction parameters are used in
accordance with the Kohler ternary extrapolation formula for A-B-C ternary interaction,
while any other binary interaction parameters involving the Toop species C (i.e. of A-C and
B-C binaries) are used in line with the Toop-Kohler ternary extrapolation formula (for the A-
C-B and B-C-A ternary interactions).

DEBYE_HUCKEL

To use the DHLL (Debye-Hückel Limiting Law) model and SIT (Specific Ionic Interaction
Theory) model for a dilute AQUEOUS solution phase, switch the DEBYE_HUCKEL part on, and
it removes previously set (if any) ADDITIONAL part on the non-ideality for the chosen
AQUEOUS phase.

HKF_ELECTROSTATIC

To use the hypothetical electrostatic contribution for the chosen phase (it must be an
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aqueous solution phase using the Complete Revised_HKF Model). It removes previously set
(if any) ADDITIONAL part on the non-ideality for the chosen AQUEOUS solution phase.
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QUASICHEM_IONIC

To use the Quasichemical-Ionic model for the chosen liquid phase, you must have already
entered/retrieved a liquid phase as an ionic two-sublattice liquid solution phase (normally,
that is the IONIC_LIQ phase), and then use this amending option to switch QUASICHEM_
IONIC on. It creates a completely new liquid solution phase [namely the QUAS_IONIC phase
which uses the Quasichemical Model for the entropy, according to Mats Hillert (2001: J of
Alloys and Compounds, 320, 161-176)], while the original IONIC_LIQ phase remains in the
system and is not changed by this option.

QUASICHEM_FACT00

To use the Quasichemical Model developed by Kongoli et al. in the F*A*C*T group in
Montreal, you must have entered/retrieved a liquid phase using a normal substitutional
liquid model with specified associates or species (on a single lattice site), and then turn on
the option QUASICHEM_FACT00. This removes the previously-set (if any) ADDITIONAL part
on the non-ideality for the chosen liquid phase.

See examples tcex49 and tcex50 in the Thermo-Calc Console Mode Examples
Guide.

QUASICHEM_IRSID

To use the Kapoor-Frohberg-Gaye Quasichemical Cell Model (i.e. the Quasichemical Model
developed by ISRID, France) for a liquid SLAG solution phase, you can use a normal liquid
model with specified associates or species.

GLASS_TRANSITION

To use the special model for glass transition of a liquid phase. It removes previously set (if
any) ADDITIONAL part on the non-ideality for the chosen liquid phase.

REMOVE_ADDITION

To remove all the selected ADDITIONAL part from the Gibbs energy description for the
chosen phase. If preferred, set a specific phase-status bit for a phase, use the PHASE_BITS
option as long you know the restrict meaning of each part of a phase- status bits.

DEFAULT_STABLE

Set phases as default-stable, which helps you to have a better guess of which phases that
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should be stable at the first calculation.

AMEND_PHASE_DESCRIPTION
Specify/amend phase descriptions if a phase has a miscibility gap, uses a special excess
energy model, or has a specific additional contribution to its Gibbs energy, for example.

Also see "Solution Models in the GIBBS Module" on page 85 for detailed
information about this command and its options.

Syntax AMEND_PHASE_DESCRIPTION

Prompts

Phase name: <Phase name>

Specify the name of the phase.

Amend what /Composition_Set/: <Subject>

Several subjects for the phase can be amended but most often this
command is used to enter two or more composition sets for a phase. If
a phase has a miscibility gap it is necessary to have two composition
sets, one for each possible composition that can be stable
simultaneously.

Enter a question mark at the prompt to get a list of all possibly
amended subjects for a phase.

There are no additional prompts for DEBYE_HUCKEL, HKF_ELECTROSTATIC,
GLASS_TRANSITION, QUASICHEM_FACT00, QUASICHEM_ISRID, REMOVE_
ADDITION, and DEFAULT_STABLE.

RENAME_PHASE

New phase name /ABCD/: <Phase name>

Give a new phase name for the chosen phase, or press <Enter> to keep
the default shown.

Site_ratios

Sites in first sublattice /XX/ : <YY> Sites in second
sublattice /XX/ : <YY>

Specify the site numbers for each of the prompted sublattices for the
current phase. Press <Enter> to accept the previous definitions.

New_
constituent

Sublattice /#/: <Sublattice number>

Specify the sublattice where the new constituents are located.

Species: <Species name>

Give a valid species name.
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Syntax AMEND_PHASE_DESCRIPTION

Composition_
sets

New highest set number /#/: <Set number n>

The default value (#) is usually one higher than the current value. All
phases have initially one composition set. If a lower value (i.e. lower
than the default one) is given, that specific composition sets are
deleted.

You cannot take away the first composition set.

Major constituent(s) for sublattice #: /AB/: <Major
constituent(s)>

Specify the new major constituent(s) for the sublattice #, or press
<Enter> to accept the default which was automatically set according to
the specified composition set of the phase.

This prompt is repeated for all available sublattices in the chosen phase.
The major constituents in each sublattice can be given. This may
simplify giving start values when calculating the equilibrium as phases
with miscibility gaps should have different major constituents for each
composition set.

Major_
constituent

Composition set /1/: <Composition set number>

Give the composition set (digit number) for the chosen phase, or press
<Enter> if you want to set major constituents for the specified
composition set.

Major constituent(s) for sublattice #: /AB/: <Major
constituent(s)>

Specify the new major constituent(s) for the sublattice #, or press
<Enter> to accept the default which is automatically set according to
the specified composition set of the phase.

This prompt is repeated for all available sublattices in the chosen phase
for the specified composition set.

The major constituents in each sublattice can be specified. This is useful
in order to make calculations converge faster and more easily (because
it may simplify giving start values when calculating the equilibrium as
those phases with miscibility gaps should have different major
constituents for each composition set). The databases often set major
constituents for several phases automatically when data are retrieved.
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Syntax AMEND_PHASE_DESCRIPTION

Fraction_
limits

Element : <el1>

Low fraction limit /0/ : <Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit >

Element : <el2>

Low fraction limit /0/ : <Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit>

Element : <eln>

Low fraction limit /0/ : <Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit >

Magnetic_
ordering

The antiferromagnetic factor /XX/: <YY>

Specify the anti-ferromagnetic factor for the chosen phase. This should
be –1 for BCC phase and –3 for all other phases (FCC, HCP, etc.).

Short range order fraction of the enthalpy /XX/: <YY>

The magnetic ordering is a second-order transformation and part of the
enthalpy due to this transformation is due to short-range order. This
value is the fraction of the total enthalpy that is due to short-range
ordering above the magnetic transition temperature.

The default value (xx) is 0.40 for BCC phase, and 0.28 for all other
phases (FCC, HCP, etc.).

Disordered_
part

Disordered phase name: <Phase name>

Give the disordered phase name for which there is no ordering
sublattice.

Excess_model

Model name /ABCDEFG/: <Model name>

The default model is the pre-set model for the solution phase, normally
the REDLICH-KISTER_MUGGIANU model, or choose another model for
the phase to be amended:

l REDLICH-KISTER_MUGGIANU

l REDLICH-KISTER_KOHLER

l FLORY-HUGGINS POLYMER MODEL

l MIXED-EXCESS-MODELS (R-K default)
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Syntax AMEND_PHASE_DESCRIPTION

l HKF

l PITZER

l CENTRAL_ATOM_MODEL

The MIXED-EXCESS-MODELS option has sub-options:

First (the independent) constituent: <Constituent name>

Second (the dependent) constituent: <Constituent name>

Specify the binary pair of constituents in the current substitutional
solution phase (the first one as the so-called independent constituent,
and the second one as the dependent constituent), for which you wish to
change the binary excess model from the default REDLICH-KISTER
model to another model (LEGENDRE or POLYNOM).

You are prompted with the first sub-option (i.e. First (the
independent) constituent after you have specified the desired
binary Excess model type. To make further changes of binary excess
model for other specific binary pairs in the current substitutional
solution phase, press <Enter> (implying that there are no more changes
of binary excess model for all other possibly-remaining binary pairs that
shall still use the default REDLICH-KISTER model).

Excess model type: /Legendre/: <Desired binary excess
model type>

For the currently-specified binary pair, choose one the legal binary
excess models: LEGENDRE, POLYNOM or REDLICH-KISTER. If the default
binary excess model REDLICH-KISTER is used for a certain binary pair,
you can either specify the model name (or in short as R-K) or press
<Enter>. After this sub-option, it returns to the first sub-option First (the
independent) constituent: either for further change(s) of binary excess
model of any other binary pair(s) or for termination (by pressing
<Enter>) in the MIXED-EXCESS-MODELS option.

Ternary_
extrapolat

Extrapolation method: /Toop-Kohler/: <Ternary model>

Choose a ternary extrapolation model for the current solution phase:

l TOOP-KOHLER for Toop-Kohler Extrapolation Model

l KOHLER-ALL for Kohler Extrapolation Model

l MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model
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Syntax AMEND_PHASE_DESCRIPTION

The TOOP-KOHLER option further prompts:

Constituent in sublattice #: <Basis constituent name>

First interaction constituent: <Interacting constituent
name>

Toop constituent: <Toop constituent name>

Specify the so-called Kohler constituents (entered as the basis
constituent and first interacting constituent) and Toop constituent on a
given sublattice in the current solution phase.

Quasichem_
ionic

To use the Quasichemical Model for the chosen liquid phase, you must
first enter it as an ionic liquid phase, and then use this amending option.
It creates a completely new phase, the original IONIC_LIQUID phase
remains in the system and is not changed.

Number of bonds/atom /2/: <Number of bonds per atom>

Specify the Z value (number of bonds per atom).

Status_bits

Correct the phase status bits. It is important to fully understand this
command before using it:

New status word (in hexadecimal) /04204000/: <New status
bits>

Also see "LIST_STATUS" on page 122 for information on the
status bits.

Normally, these should never be changed in this way, because such
phase status bits are automatically set on when all the phase
descriptions (predefined in databases and amended in the GIBBS
module) are defined properly. The only exceptions are for the Kapoor-
Frohberg-Gaye cell model for liquid SLAG solution phase, which can be
set only as 04208000; and for the complete Revised HKF AQUEOUS
solution model, which can be set as 02084000.

AMEND_SYMBOL
This command is for the GES (GIBBS) and PARROT modules.

Interactively calculate the current values of a function or table (predefined by the switched
database or previously entered with "ENTER_SYMBOL" on page 113) at the current
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temperature and pressure condition, and also possible to modify the definitions of variables
or functions.

The current values of the temperature and pressure used to calculate the
functions or tables are the ones listed with "LIST_STATUS" on page 122. There is
no way to change the current temperature and pressure values interactively.

To modify the definitions of entered symbols (variable, functions or parameters), the
performance of this command is slightly different one from another, as described below:

l For variables, the values can be changed.

l For functions the low and high temperature limits in various ranges (if any), as well
the expressions, can be changed.

l For parameters the low and high temperature limits in various ranges (if any), as
well the expressions, can be changed.

Syntax AMEND_SYMBOL

Prompts

Name: <Symbol name>

Specify the name of an entered symbol.

For tables and functions (or parameters which are treated as functions after
these are entered by the ENTER_SYMBOL command with the Parameter
keyword, but not by the ENTER_PARAMETER command), after the symbol
name is specified here, the program automatically calculates the values under
the current temperature and pressure conditions, and lists the current values,
such as:

FUNCTION VALUE 2.52500000E+01

TABLE VALUE 1.56000000E+02

For variables and functions (or parameters), there are additional prompts and
depend on the symbol type.

For a variable, its current value is displayed, and you can change it to a new
value:

Value /Current value/: <New value>

For a function (or a parameter entered as a symbol):

Do you want to change the number of ranges /No/: <Y or n>

To change the number of ranges for the function, or change some of the
temperature limits in the definition, For Y, you must retype both the low/high
temperature limits and functions (see all the remaining details in the ENTER_
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Syntax AMEND_SYMBOL

SYMBOL command.

If you do not want to change it, press <Enter> to accept the default. The
definition of the chosen function in all ranges (if any) is listed, for example:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00

and this message displays:

Do you want to change range limits /No/: <Y or N>

If a function is different in two or more temperature ranges, you must specify
the range of the function of which you want to amend. Or press <Enter> or
type 0 to exit this command without making any change.

Range number (0 to exit) /0/: <Range number>

Function:

The previous function is available for editing. The editing is performed within
the general subroutine FOOLED. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at
that position between colons (::).

Commands

These commands can be given:

l Help: ?

l Move CP to last or first character: <+/-> A

l Delete characters from CP: <+-#characters> D

l Exit: E

l Find: <#occurrences> F<string>@

l Insert: I<string>@

l Move: <+-#positions> M

l Restore string: R
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Syntax AMEND_SYMBOL

l Substitute: S<OLD>@<NEW>@

l Type string: T

where CP denotes the current position in the string, # means number of, @ is a
terminator of an input or search string.

When the string is typed the character at the current position is
replaced by an underscore _. To finish the editing of the current
function, type E at the prompt.

CHANGE_STATUS
For the GIBBS_ENERGY_SYSTEM module, the status of an element or species or phase can
be either ENTERED or SUSPENDED. The suspended status can be either implicit or explicit.
The implicitly suspended status can be set e.g. for a species if any of the elements in its
chemical formula is explicitly suspended. A species that is implicitly suspended becomes
entered automatically if all its elements are set entered. After this command, a message
shows which elements/species/phases are suspended or restored (entered). Consequently,
the status bits for the specified elements or species or phases are changed, as listed with
"LIST_STATUS" on page 122.

Syntax CHANGE_STATUS

Prompts
For Element, Species or Phase /Species/: <Keyword>

Specify the keyword (element, species or phase).

Suspend /Y/: <Y or N>

The status is changed from ENTERED to SUSPENDED (Y), or vice versa (N).

If an element is suspended all species with this element become implicitly
SUSPENDED too. A phase may become implicitly suspended if all its
constituents or all constituents in a sublattice are suspended.

List of elements/species/phases: <Name of elements or species
or phases>

Specify the names or indices of those elements or species or phases that shall
become suspended or active. For names, these should be separated by a space
and terminated with a semicolon (;) or an empty line. For indices it is possible
to give a range by separating two numbers by a hyphen (-). The list should be
terminated by a semicolon (;). Example: 5 1 7-12 FE;
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ENTER_ELEMENT
Specify a system interactively. The program searches the currently switched or preset
database for data for the given elements. The data for the elements in the database are the:

l mass in g/mol

l name of the Selected Element Reference State (SER) which normally is the stable
phase for the element at 298.15 K

l enthalpy difference for the element in the SER state at 298.15 K and zero K

l absolute entropy for the element in the SER state at 298.15 K.

The two predefined elements, i.e. electrons and vacancies, have the chemical symbols /-
and VA, respectively. Initially, these are suspended but can be entered either by this
command or "CHANGE_STATUS" on the previous page.

If an aqueous solution phase is involved, in the GIBBS module you enter a special aqueous
electron called, ZE. This is specially designed for appropriately calculating the standard
electric potential in the aqueous solution system.

Syntax ENTER_ELEMENT

Prompt

Element name: <Element name>

Specify several elements on one line. The name of an element is its chemical
symbol. The chemical symbols must be separated by spaces. Fictitious element
names are legal but naturally no data are found in the database for them.

An element name (maximum 2 characters) can either have its first
letter in upper and the second (if any) in lower case (i.e. Lower
Case Mode) or both letters can be in upper or lower case (i.e.
Upper Case Mode). The Upper or Lower Case Mode is selected by
the command "REINITIATE" on page 127, which removes all data,
and should be executed before any other command.

About the ENTER_PARAMETER Command
For the PARROT Module, this command is the same and is described here. See
"ENTER_PARAMETER" on page 143 for the command details.

In the descriptions of the standard thermochemical properties and special physical
properties for a phase, there are a number of parameters which may depend on the
temperature and pressure. The expressions for these parameters can be given in a free
form as a sum of terms with powers of T and P and may also include the natural logarithm
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TP-functions. Identical parameters (in terms of parameter-names) are stored only once in
the GIBBS workspaces.

The composition-dependence of the Gibbs energy is described in the GIBBS module by the
internal data structure, which is created when the phase is entered (see "Gibbs Energy
System (GES) Commands" on page 79). The Gibbs energy of a phase is always referred to
one formula unit of the phase, i.e. the amount derived from the number of sites (i.e. the
stoichiometric coefficient) for each sublattice. If vacancy is a constituent of a sublattice, the
amount of matter per formula unit of the phase may vary with composition.

Defining the Parameter
A valid parameter should have the general form of:

<identifier>(<phase>, <constituent array>; <digit>) <xxx> <expression> <yyy>
<keyword Y or N> <zzz> !

The identifier must be followed by an opening parenthesis, a phase name, a comma and a
constituent array. Optionally, the constituent array can be followed by a semicolon and a
digit. The parameter name is terminated by a closing parenthesis. The parameter form is
defined as:

l <identifier> is the parameter type;

l <phase> is the phase name (maximum 24 characters);

l <constituent array> is the specific constituent array in the phase;

l <digit> is the degree of composition-dependent interaction contribution (an integer
number from 0 through 9), that is only for excess energy (L), Curie temperature (TC)
and Bohr magneton number (BMAGN), as well as for volume-related parameters (V0
or VA or VB or VC or VK); if it is valued as zero, or if it is for the standard Gibbs
energy (G) for which the degree is always zero, it can be omitted;

l <expression> is the mathematical relation to describe the parameter;

l <xxx> and <yyy> are the low and high temperature limits respectively for the
applicable temperature range of the parameter expression;

l <keyword Y or N> is the indicator on if there is continuation for the parameter
expression or not;

l <zzz> is the reference index/number for the assessment of this parameter;

l The exclamation point ! is used to indicate that the current parameter definition is
ended.

PARAMETER NAME

The GES parameter name has a general form of:
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<identifier>(<phase>,<constituent array>;<digit>)

Examples of parameter names:

l G(GAS,C1O2): The Gibbs energy of formation of a CO2 molecule in gas.

l G(FCC,FE:VA): The Gibbs energy of formation of fcc Fe with interstitials.

l L(LIQ,Fe,Cr;0: The regular solution parameter for Fe and Cr in liquid.

l L(LIQ,Fe,Cr;1): The sub-regular solution parameter.

l TC(BCC,Fe:Va): The Curie temperature of bcc Fe.

l BMAGN(BCC,Fe:Va): The Bohr magneton number parameter of bcc Fe.

The parameter name consists of several parts. The first is a type-identifier and these can be
used:

l G: Standard energy parameter (Gibbs energy of formation) or for interaction
parameters;

l L: Excess energy parameter (Gibbs energy of interaction) always used for interaction
parameters;

l TC: Curie temperature for magnetic ordering;

l BMAGN or BM: Bohr magneton number for magnetic ordering (or Born function ωPr,Tr
for aqueous solute species).

l VO: Molar volume at 298.15 K and 1 bar (a numeric value only);

l VA: Integrated thermal expansivity;
l VB: Bulk modulus at 1 bar;

l VC: Isothermal compressibility;

l VK: High-pressure fitting parameter.

When necessary quantities as H (enthalpy), S (entropy), V (Volume), F
(Helmholtz energy), etc., can be calculated from the Gibbs energy.

PHASE NAME

Specifying the PHASE NAME in uppercase is recommended; however, if you prefer to write it
as a mixture of uppercase and lowercase, it automatically converts all lowercase to
uppercase, as the GIBBS module only recognises uppercase phase names. It is important that
if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition
(already by the PHASE keyword; such as GAS:G, LIQUID:L,SLAG:L, IONIC-LIQ:Y, SPINEL:I, FCC_
L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code should not be
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attached to the phase name when ENTER_PARAMETER is executed.

CONSTITUENT ARRAY

The constituent array consists of a list of constituent names. Interaction parameters have
two or more constituents from the same sublattice separated by a comma. If the phase has
sublattices, at least one constituent in each sublattice must be specified. The constituents in
different sublattices must be given in sublattice order and are separated by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess
energy model used for the phase. If no semicolon and digit are given, the sub-index value is
assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary
parameters, are multiplied with two or more fractions of the constituents from the same
sublattice of the solution phase. These additional constituents must be given as interacting
constituents (as the following prompt).

Solution phases with sublattices can have interacting constituents in each
sublattice.

INTERACTION PARAMETER

An interaction parameter, which is used to describe the excess term of a quantity, must have
two or more constituents that interact with each other on a specified sublattice site of the
given phase. It is arbitrary which of these constituents is given as the first constituent and
what is given as the interacting constituents. The software always sorts the constituents (in
each sublattice) in alphabetical order when the parameter name is written as a prompt (for
entering its parameter value) and when the parameter is listed (using the GIBBS commands
"LIST_PARAMETER" on page 147 or "LIST_PHASE_DATA (from GIBBS)" on page 148). This is
important for all asymmetric interaction parameters where the sign of the interaction
parameter must depend on the appearance order.

Use an asterisk* to denote that the excess interaction parameter is independent of the
constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that the
interaction parameter is for the binary interaction between constituents AL and NI on the
first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on
the second sublattice. An interaction parameter in the list of constituents is always added to
the Gibbs energy and the asterisk * is calculated with the term of [1∑y(specified
constituents)], which implies that in an A-B binary system these L parameters are identical
(but in higher-order systems, these are different):
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l L(phase,A,B) is multiplied with X(A)*X(B)

l L(phase,A,*) is multiplied with X(A)*(1-X(A))

l L(phase,B,*) is multiplied with X(B)*(1-X(B))

If you press <Enter> when you are asked for a parameter name or if you have improperly
input the entire parameter name, you are asked for each of these items in the name.

ENTER_PARAMETER
This command is for both the GES and PARROT modules.

Also see "About the ENTER_PARAMETER Command" on page 139 for details
about each of the options.

Use this command to enter TP-function(s) for a specific parameter for a phase interactively
with this command. If there is already a parameter expression defined (for this parameter),
that is deleted and replaced with newly entered one.

The entered TP-Function(s) for the parameter can be changed later with the command
"AMEND_PARAMETER" on page 82.

Syntax ENTER_PARAMETER

Prompts

Parameter: <Parameter name>

As explained in "About the ENTER_PARAMETER Command" on page 139,
specify a correct and complete Parameter Name, which should contain
all the necessary parts of the general form:

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter>, is pressed, a message
displays:

*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter
name.

Options Description or Information

Identifier

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB
or VC or VK>

If this command is used one or more times, the previous value on this
prompt is set as default. Press <Enter> for the same type identifier or
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specify a new type.

Phase name

Phase name (/ABCD/): <Phase name>

Each parameter is valid for a specific phase only. The name of that phase
must be supplied (maximum 24 characters). The name can be
abbreviated.

Constituent

Constituent (in sublattice # /ABC/): <Species name>

A parameter is identified by the constituents on a specified sublattice site
of the given phase, the stoichiometric coefficients of which are multiplied
with the parameter. The name of the constituent can be abbreviated.

It is the species name, not the stoichiometric formula
required here.

If this command is used one or more times, the previous value on this
prompt is set as default. Accept it by pressing <Enter> if the constituent is
the same, or specify a new species name.

Interacting
constituent

For phases with several sublattices, the program asks for one constituent
in each sublattice.

Interacting constituent (in sublattice # /XYZ/): <Species
name>

If this command is used one or more times, the previous value on this
prompt is set as default. Press <Enter> to accept it if the constituent is
the same, or specify a new species name.

To cancel the default value of the interacting constituent
type NONE or the name of another constituent.

This question is repeated until all the interested interacting constituent(s)
on a specific sublattice in the phase are specified, and finally an <Enter>
is enforced.

Degree

Degree /#/: <Degree>

Degree is model-dependent. Specify an integer number (a value from 0
through 9) as the degree of composition-dependent interaction
contribution for the phase parameter. This is valid for excess energy (L),
Curie temperature (TC) and Bohr magneton number (BMAGN), as well as
for volume-related parameters (V0, VA, VB, VC or VK).
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For binary interaction parameters, the degree is usually the power in the
Redlich-Kister expression. For ternary interaction parameters, it is usually
the Hillert ternary index.

For a standard G parameter for a pure component (end-member) its
degree should be always 0 and this prompt should not display.

Phase
parameter

After this prompt, the program echoes on the screen the full TP-Function
of the phase parameter.

Low temperature limit /298.15/: <Lowest temperature limit
in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure
limit (in Pascal but entered as a negative number), for the current TP-
Function.

Function: <Definition for a function>

A TP-Function consists of terms in T and P.

& <Continuation of the definition for the current function>

Continuation of a TP-Function definition.

High temperature limit /6000/: <High temperature limit in
K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit
(in Pascal; only if the lowest limit is entered as a negative number) for
the current TP-Function.

Any more ranges /N/: <Y or N>

Enter Y for more function(s) or N to end this command.

About the ENTER_PHASE Command
With the command "ENTER_PHASE" on page 110 , the phase name, phase-type, sublattice
number, and constituents or constituent array(s) for the phase are entered into the GIBBS
workspaces.

About Phase Names

A thermochemical system must have at least one phase (which is a homogeneous part of the
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system with a uniform composition and structure). In the GIBBS module, any number of
phases can be entered for a system and for each phase there must be a description of how
its Gibbs energy varies with temperature, pressure and composition. A phase has a large
amount of data connected to it, e.g. it starts with a phase name:

l It may be treated as a special phase-type;

l It may have structural information about sublattice(s), etc.,

l There must be a list of constituents (for a substitutional phase with no sublattice) or
of constituent arrays (for a sublattice phase);

l There may be basic information on what kind of EXCESS_MODEL (polynomial
expression) is used to describe the binary, ternary and/or higher-order interactions
between constituents;

l There may be so-called Additional contributions to the Gibbs energy of the phase
from special physical phenomena, e.g. magnetic ordering, hypothetical electrostatic
interaction, and so forth;

l There must exist all the parameters required for the descriptions of thermochemical
properties (i.e. G terms for standard Gibbs energies, and L terms for binary, ternary
or higher-order interaction excess energies) and of some special physical properties
(e.g. the Curie temperature TC and Bohr magneton number BMAGN (or BM) for
magnetic ordering, V0-VA-VB-VC-VK parameters for volume contributions, Born
functions for hypothetical electrostatic interaction in an aqueous solution phase)
stored in connection with the phase.

About Phase Type Code

A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a
substitutional phase without sublattice, and that an L phase (ordinary liquid solution) is
normally (but not always) modelled as a substitutional phase without sublattice, too.

The F and B phase-types are useful for ordered FCC (or HCP) and BCC solution phases
handled by the so-called Four Substitutional-Sublattice Ordering Model, which always
requires that the solution phase must have four sublattices for substitutional ordering and
can additionally have an interstitial sublattice.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners
of the regular tetrahedron on these lattices all of which are the nearest neighbours. A
Normal 4-Sublattice Model requires that all the G parameters for each of end-members with
the same elements but distributed on different sites be given separately. However, as these
corners are identical lattice points, the phase-type option F means that the G parameters
need be given only once. The possible permutations are handled automatically. To be more
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clarified: An A-B binary solution phase (with the element A locates on one sublattice site and
B on three sublattice sites) treated by the Normal 4-Sublattice Model has to have 4 G
parameters for 4 end-members, i.e. G(phase,A:B:B:B), G(phase,B:A:B:B), G(phase,B:B:A:B)
and G(phase,B:B:B:A), because of that in the general case these G parameters can be
different from each other. But for the FCC and HCP orderings, these are identical and thus
all G parameters of such end-members need be given only once, and the possible
permutations are then automatically handled by the GIBBS module. This significantly
simplifies the usage of this model (Four Substitutional-Sublattice Ordering Model) in
multicomponent alloys.

There are restrictions on the excess parameters allowed with the phase-type option F. You
can only have excess parameters of these types:

L(phase,A,B:*:*:*;0…9)

L(phase,A,B:C,D:*:*;0…9)

The asterisk * means that the interaction parameter is independent on the constituents on
its corresponding sublattice. No ternary interaction parameters (i.e. with three elements on
one sublattice site) are allowed. The reason for this restriction is that it would be too
complicated to handle all possible permutations. In the current Four Substitutional Sublattice
Ordering Model, the binary interaction between A and B atoms is thus independent of the
constituents on the other sublattices, where there are many other parameters to model the
composition-dependence of the Gibbs energy (both in the ordered and disordered parts of
the phase). The model for these ordered phases are always partitioned in a disordered part
(with a single substitutional sublattice) and an ordered part (with four substitutional
sublattices for ordering).

For ordered BCC phases, the phase-type option B means the same thing but the situation is
more complicated, as the 4-sublattice ordering phase represents an irregular tetrahedron
with two pairs of sites that are next nearest neighbours. Thus, for an A-B binary solution
phase (with the element A locates on two sublattice site and B on other two sublattice sites)
treated by the Normal 4-Sublattice Model, the end-member described by the G
(phase,A:A:B:B) term has four nearest neighbour bonds between A and B atoms, whereas the
end-member described by the G(phase,A:B:A:B) term has two nearest neighbour bonds
between A and B atoms and two next nearest neighbour bonds

For detailed reference visit the Crystal Lattice Structure web page
http://www.nrl.navy.mil/mstd/branches/6390.

The first end-member (described by the G(phase,A:A:B:B) term) represents B2- ordering and
the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There are two
permutations of the G(phase,A:A:B:B) term and four permutations of the G(phase,A:B:A:B)
term, automatically conducted in the Four Substitutional-Sublattice Ordering Model. And
there are also two kinds of reciprocal interaction parameters, i.e.

http://www.nrl.navy.mil/mstd/branches/6390
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L(phase,A,B:C,D:*:*;0…9) L(phase,A,B:*:C,D:*;0…9)

An advanced feature with the phase-type options F and B is that a composition set that
represents the solution phase has a suffix (indicating that it is really as an ordered or
disordered phase) that is automatically added to its phase name in some listings of
equilibrium calculations (when performing either single-point or stepping or mapping
calculations, and when plotting the calculated property diagrams or phase diagrams). Such
suffix indications can be:

l _L12 or _L10 for ordered FCC

l _A1 for disordered FCC

l _B2, _B32, _D03 or _L21 for ordered BCC

l _A2 for disordered BCC

l _D019 and _B19 for ordered HCP

l _A3 for disordered HCP

Solution Phase Suffix for Disordered Phase Suffix for Ordered Phase

FCC PHASE PHASE_A1
PHASE_L12

PHASE_L10

BCC PHASE PHASE_A2

PHASE_B2

PHASE_B32

PHASE_D03

PHASE_L21

HCP PHASE PHASE_A3
PHASE_D019

PHASE_B19

ENTER_PHASE
See "About the ENTER_PHASE Command" on page 107 for details about the
phase-type and other prompts.

With this command, the phase name, phase-type, sublattice number, and constituents or
constituent array(s) for the phase are entered into the GIBBS workspaces. However, for the
remaining parts of thermodynamic descriptions (i.e. thermochemical and physical
parameters, excess model, and possibly additional contribution term) for the phase, the
GIBBS commands "ENTER_PARAMETER" on page 143 and "AMEND_PHASE_DESCRIPTION"
on page 93, should be used sequentially.
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Normally, data for a system are retrieved from the preset database after the elements and
species are specified. This is automatically done through "GET_DATA" on page 16. In some
cases, specify a phase interactively.

Syntax ENTER_PHASE

Options Description and Information

Phase name

Name of phase: <Phase name>

The phase name is any string starting with a letter and containing only
letters, digits or the underscore character. The phase name must be
unique.

type code: <Phase-type code>

The Phase-type code must be specified for the phase if it is not an
ordinary solution phase. Press <Enter> if the phase is ordinary.

Phase-type

G
Gaseous mixture phase.

There may only exist one gas phase in a system.

A Aqueous solution phase.

L Liquid solution phase but not A (aqueous) or Y (ionic liquid)

Y
Ionic liquid solution phase (that is specially treated by the Ionic Two
Sublattice Liquid Model).

I
A phase with charged species but not G (gaseous), A (aqueous) or Y
(ionic liquid).

F
An ordered FCC or HCP solution phase with four substitutional
sublattices (additionally, such a phase can also have an interstitial
sublattice).

B
An ordered BCC solution phase with four substitutional sublattices
(additionally, such a phase can also have an interstitial sublattice).

Sublattice
number

Number of sublattices /1/: <Sublattice number>

Phases with stoichiometric constraints usually have two or more
sublattices. On each sublattice one or more species can be entered as
constituents. The number of sublattices must not exceed 10.
Substitutional phases with no sublattices are treated as phases with one
sublattice.
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Number of sites on sublattice # /1/: <Site number>

For phases with sublattices, the ratio of the sites on each sublattice
(donated with #) must be given. The program asks for values for all
sublattices (by repeating this question for each sublattice), but these
may have a common factor extracted. It is recommended to use integer
numbers as sites if possible. For substitutional phases with no
sublattices, this question does not show up.

Constituents

Name of constituent: <Constituent name(s)>

For each sublattice specify at least one species as constituent. Several
constituents can be given consequently (on the repeated prompt) or on
the same line separated by a space. This question is repeated till
pressing <Enter> or giving a semi-colon (;), meaning that the list of
constituents is terminated by (;) or an empty line.

Will you add constituents later /N/: <Y or >

For Y add other constituents to the phase by specifying new components
in e.g. an ENTER_PARAMETER command. The default is N or press
<Enter>.

If illegal constituents are used, you get a message e.g. when parameters
are entered.

Do you want a list of possible parameters /N/: <Y or Nn>

Enter Y for a list of all possible parameters up to the fifth interaction
order for the entered phase.

ENTER_SPECIES
Specify a species from the already entered elements. The stoichiometry of the species is the
chemical formula of the species. For each species, its name and chemical formula must be
given.

All elements are automatically entered simultaneously as species. The
constituents of a phase must be species, but there is no thermochemical data
associated with the species except as constituents of a phase.
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Prompt

Species name: <Species name>

Enter a unique species name. This is usually its chemical formula but it can be
any string which starts with a letter and contains only letters or digits.
Parenthesis () and an underscore _ are permitted. The combination /- or /+
used to denote charge.

Species Names Examples
NACL2, FE2O3, FEO3/2, FE1O1.5, CA.5MG.5SI1O3,

AL1H1O1_Al(OH) , AL1H1O1_HAlO, C2H4O3_124TRIOXOLANE, NA+, SIO4-4,
H1/+1, H1O1/-1, AGC2N2-1.

The species name can be used to separate isomers with the same
stoichiometry, e.g. C2H2Cl2, (CHCl)2_cis, (CHCl)2_trans, CH2_CCl2.

Stoichiometry /Species name/: <Chemical formula>

The elements in the chemical formula are normally separated by
stoichiometric numbers. Neither parenthesis () nor an underscore _ is allowed
in the chemical formula, while the special combination /- or /+ can be used.

In upper case mode (see "REINITIATE" on page 127), the stoichiometric number
unity can be excluded only if the element symbol consists of two letters. In
lower case mode, the element must be typed with the first letter in UPPER case
and the second in lower, and it is thus possible to distinguish CO (carbon
monoxide) from Co (cobalt) without any stoichiometry number.

All elements in a species must be entered prior to entering the
species.

ENTER_SYMBOL
This command is for the GES ( GIBBS) module.

In the GIBBS module, a symbol can be used to represent a numeric quantity (e.g. a variable),
a function, or a table. The entered symbol (with a symbol name of maximum eight
characters) can be used later when parameters are entered, and this is a flexible way to
manipulate thermodynamic functions. Symbols are especially useful if the same function or
table is used in several thermochemical parameters. A parameter symbol is used to assign
the values of phase parameters (which are defined with the command "ENTER_
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PARAMETER" on page 143) to specific characterized symbols. If you want to define a
constant quantity, enter it as a simple function with a constant value in all (temperature)
ranges.

The symbols entered in the GIBBS module can also be listed and used in the "Optimizing with
the PARROT Module" on page 130 (for data optimization) where you can use the GIBBS-
entered symbols (variables, functions or parameters) to define parameters that shall be
optimized.

Symbols entered in the GIBBS module are not the same symbols as defined in
the POLY and POST modules.

Also see "ENTER_SYMBOL" on page 247 for the POLY and POST modules.

See example 44 in the Thermo-Calc Console Mode Examples Guide for an
example of using variables and functions.
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Prompt

Variable, function, table or parameter? /Function/: <Keyword>

The keyword can be a variable, function, table or parameter.

l Variables are similar to functions because these can also be
expressions of state variables. It is possible to enter a variable with a
new expression anytime.

l Functions are expressions of state variables or other functions.

l Tables are used for listing results. A table consists of a list of any
number of state variables, functions or variables.

l Parameter symbols are used to assign the values of phase
parameters (which are defined by the command ENTER_
PARAMETER) to specific characterized symbols. If the phase
parameter is not defined yet, the parameter symbol is assigned zero
or a symbol which is valued as zero. In this way it is easy to refer to
entered phase parameters in further defining other phase
parameters.

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have
maximum 8 characters.

The following prompts are based on the type of symbol.

Variable
symbol

Value: <Numeric value of a variable>

Only a constant numeric value, not an expression, is accepted.

Function
symbol

Enter the lower-temperature limit, the expression, an upper-temperature
limit and if there is another expression above this upper limit:

Low temperature limit /298.15/: <Lowest temperature limit in
K>

Specify the lowest-temperature limit, below which its (first) expression is
not applicable. The default lowest limit of all kinds of data is 298.15 K.

If a negative number is given as the lowest-temperature limit, it is assumed
that there are breakpoints in pressure for this function; in such a case, it is
interpreted as the lowest-pressure limit (in Pascal), and the other limits in
the current function are also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the functions are checked during
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calculations. An indicator is set if the actual temperature/pressure
condition is below the lowest temperature/pressure limit or above the
highest temperature/pressure limit; and in such a case, an extrapolation is
conducted using the TP-FUNCTIONS valid in the nearest
temperature/pressure range.

Function: <Definition for a TP-function>

A TP-Function consists of terms in T and P. The expression is a FORTRAN-
like expression and operators +,  -, *, = and ** can be used (** only with
integer powers). Unary-functions LN or LOG (both for natural logarithm)
and EXP (for exponential) can also be used. An expression can be continued
on more than one line. A PT-function must be terminated by a semicolon (;)
or an empty line. No more than 78 characters can be written on a line. If
this is not sufficient space on one line, press <Enter> and continue on the
next line. The program prompts with an ampersand & when a continuation
is expected.

A function can have several temperature ranges, and a
different expression (i.e. a TP-Function) for each region; if
required, a single function can have up to ten different
temperature ranges (and thus have up to ten different TP-
Functions).

This question is repeated if the current function has more than one
expression (TPFunction) in various temperature ranges [or pressure ranges;
only if the lowest limit is entered as a negative number)].

& <Continuation of the definition for the current TP-
Function>

This is for a continuation of the definition for the current TP-Function. The
ampersand & means that you can continue to write the function on the new
line if one line is not enough for the current TP-Function. If you are finished
the current TP-Function, press <Enter> again.

High temperature limit /6000/: <High temperature limit in K>

For a TP-Function, specify the high-temperature limit, above which its
current expression is not applicable. The default high-temperature limit for
all kinds of data is always 6000 K.

This question is repeated if the function has more than one expression
(TPFunction) in various temperature ranges.
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All the temperature limits for the presently-be-entered TP-
Function MUST be in an increasing order; otherwise the whole
function is given a single value of zero.

If a negative number is given as the lowest-temperature limit, it is
interpreted as the low-pressure limit (in Pascal), and the high-temperature
limit is also taken as the high-pressure limit (in Pascal) for the current TP-
Function.

The high-temperature/pressure limit for the current applicable expression
(TPFunction) is the low temperature/pressure limit for the next range if
several ranges are needed to describe the temperature/pressure-
dependence of this function.

The temperature/pressure limits for the functions are checked during
calculations. An indicator is set if the actual temperature/pressure
condition is below the lowest temperature/pressure limit or above the
highest temperature/pressure limit; and in such a case, an extrapolation is
conducted using the TP-Function valid in the nearest temperature/pressure
range.

Any more ranges /N/: <Y or N>

Answer N to finish the definition of the current function. If Y the program
asks for a new function valid above the last high temperature limit and
below a new high temperature limit. The maximum number of
temperature ranges is 10.

Important note: Make sure that the function and its first derivatives are
continuous across break points.

Table
symbol

Specify the low and high temperature limits, temperature step and tabled
value at each specified temperature:

Low temperature limit /298.15/: <Low temperature limit in K>

The lowest temperature where the table has a value.

High temperature limit /6000/: <High temperature limit in K>

The highest temperature where the table has a value.

Step in temperature /100/: <Temperature step>

The step in temperature between each value in the table. This step must be
constant for the whole table. If a table cannot be described with a single
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step it must be divided into several tables for different temperature ranges.
The upper and lower limits are truncated to give reasonable values where
the table values must be specified.

Table value at XX /YY/: <Table value>

The value of the table at the specified temperature (xx) must be given. The
default value (yy) is the last value.

Parameter
symbol

Input the correct name of a phase parameter (including its identifier, phase
name, constituent and interacting constituent(s) in various sublattices (if
exist), and degree of the parameter. Most of the settings are the same as in
the "ENTER_PARAMETER" on page 143 command or the Function symbol
prompts above.

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all
the necessary parts of the general form:

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter> is pressed, this error
message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a
parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB or
VC or VK>

Specify one of these types of legal identifiers.

Phase name (/abcd/): <Phase name>

Specify the phase name.

Constituent (in sublattice # /abc/): <Species name>

Specify the constituent name on the specified sublattice site of the given
phase.

Interacting constituent (in sublattice # /XYZ/): <Species
name>

Specify the interacting constituent name on the specified sublattice site of
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the given phase; if there is no interacting constituent, press <Enter>.

Interacting constituent (in sublattice # /XYZ/): <Species
name>

If there is more than one interacting constituent on the specified sublattice
site of the given phase, specify them; otherwise press <Enter>.

Degree /#/: <Degree>

Specify an integer number (a value from 0 through 9) as the degree for the
phase parameter.

Low temperature limit /298.15/: <Lowest temperature limit in
K>

Specify the lowest-temperature limit (in Kelvin), or the lowest-pressure
limit (in Pascal but entered as a negative number), for the current TP-
Function.

Function: <Definition for a function>

Specify the desired TP-Function for the current temperature range (or
current pressure range; only if the lowest limit is entered as a negative
number).

& <Continuation of the definition for the current TP-
function>

Specify the desired TP-Function continuation for the current temperature
range (or current pressure range; only if the lowest limit is entered as a
negative number).

High temperature limit /6000/: <High temperature limit in K>

Specify the high-temperature limit (in Kelvin), or the high-pressure limit (in
Pascal; only if the lowest limit is entered as a negative number) for the
current TP Function.

Any more ranges /N/: <Y or N>

LIST_CONSTITUENT
This is a GIBBS_ENERGY_SYSTEM (GES) command.
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List all the constitutions (as site-fractions) for all the phases in the defined
system.

This is mainly for software managers. There are no commands in
the GIBBS monitor to set the constitution.

LIST_DATA
This is a GIBBS_ENERGY_SYSTEM (GES) command.

All data for the current system that is defined (retrieved from database in the DATA module,
or directly entered in the GIBBS module) within the current GIBBS workspace is written in a
readable manner on the output file. If no output file is specified, the data display on screen.

The output data consists of a list of all elements and their data followed by a list of all
phases and the data associated with each phase. The thermochemical parameters listed for
each phase are always in SI units.

For encrypted commercial databases you may not be able to use this command
to list any retrieved data. However, it can be used to list some basic definitions
(such as phase models and phase-constituents) retrieved from an encrypted
database, as well as all the references related to original assessments (but not
thermodynamic parameters) for the currently-defined system.

Syntax LIST_DATA

Prompts

Output to screen or file /Screen/: <File name>

Specify the name of a file in which the data shall be written in a readable
manner. The default value is the screen (by pressing <Enter>).

Options?: <Option(s)>

Choose one or several of these options for output:

l N the output is written as a user database format.

l P the output is written as a macro file for future input. This is useful for
creating *SETUP files for data assessments.

l S the symbols are suppressed.

l R the references for the parameters are listed (only for some
databases in which references are available)

l L the output is written suitable for a LaTeX preprocessor.
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LIST_PARAMETER
This command is for both the GIBBS and PARROT modules.

List the TP-function(s) of a specific parameter for a phase. You must supply the name of the
phase parameter:

The parameter name: <Identifier>(<Phase>,<Constituent array>;<Digit>)

For encrypted commercial databases, you may not be able to use this command
to list any retrieved parameter.

Syntax LIST_PARAMETER

Prompts

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the
necessary parts of the general form: <identifier>(<phase>,<constituent
array>;<digit>)

See "About the ENTER_PARAMETER Command" on page 139 to
learn how to define the Parameter Name.

If a parameter name is not acceptable or <Enter> is pressed, an error
message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a
parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB or VC
or VK>

Specify one of these types of legal identifiers.

Phase name (/ABCD/): <Phase name>

Specify the phase name.

Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name on the specified sublattice site of the given
phase.

Interacting constituent (in sublattice # /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the
given phase; if there is no interacting constituent, press <Enter>.
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Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice
site of the given phase, specify them; otherwise press <Enter>.

Degree /#/: <Degree>

Specify a numerical number as the degree for the phase parameter.

LIST_PHASE_DATA
This is a GIBBS_ENERGY_SYSTEM (GES) command.

All data for a specific phase are written in a readable manner on screen. The
thermochemical parameters listed for the phase are always in SI units.

For encrypted commercial databases you may not be able to use this command
to list any phase data. However, this command can be used for listing some
basic definitions (such as phase model and phase-constituents) for the specified
phase, as well as all the references related to original assessments (but not
thermodynamic parameters) for the currently-defined system.

Syntax LIST_PHASE_DATA

Prompt
Phase name: <Phase name>

Specify a phase name (if abbreviated, it should be unique).

LIST_STATUS
This is a GIBBS_ENERGY_SYSTEM (GES) command.
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Syntax LIST_STATUS

For the GIBBS module, list the entered elements, phases and species with the
status word. The command is included for system managers.

Each element, species, phase and symbol has a set of status bits.
The values of these bits are listed with this command.

The bits are listed as hexadecimal, i.e. four bits are written as a hexadecimal
number. Two hexadecimal numbers make a byte. In hexadecimal, 0 to 9 mean
normal digits. A to F means values 10 to 15. The number E4000000 has thus bit
1, 2, 3 and 6 equal to one. The bits are numbered starting with 1 for the most
significant (leftmost) bit.
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Element Status Word

Set the element status word (Bit. Meaning) if:

1. Element cannot be deleted (only vacancy and electron)

2. Suspended (inclusive OR of bit 3 and 4)

3. Explicitly suspended

4. Implicitly suspended (cannot occur for an element)

Species Status Word

Set species status word (Bit. Meaning) if:

1. Species record for an element (each element has a species record)

2. Suspended (inclusive OR of bit 3 and 4)

3. Explicitly suspended

4. Implicitly suspended (e.g. if a species element is suspended)

5. Charged (inclusive OR of bit 6 and 7)

6. Negative charge

7. Positive charge

8. Vacancy

9. Component (by default the elements are the components)

Phase Status Word

Set phase status word (Bit. Meaning) if:

1. Ideal (no sublattices and no excess parameters)

2. Suspended (inclusive OR of bit 3 and 4)

3. Explicitly suspended

4. Implicitly suspended (e.g. if all constituents suspended)

5. Gas phase

6. Liquid phase

7. Solution phase

8. Only one constituent (in each sublattice)
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9. Ions (inclusive OR of bit 10 and 12)

10. New ionic liquid model (charge balance handled internally)

11. Constituents cannot be added

12. External charge balance needed

13. Aqueous model

14. Charged species (ions)

15. Dilute entropy

16. Last calculation exceeded temperature range for any parameter

17. Kapoor-Frohberg-Gaye cell model

18. Turbo calculation used

19. Turbo calculation impossible

20. Turbo calculation illegal

21. Phase is not ideal

22. Current site fractions saved

23. This phase is the ordered part

24. This phase is the disordered part (bit 2 and 3 also set)

25. Shadow phase with diffusion data

26. Error in ionic model

27. Sometimes

28. CVM-SRO (short-range ordering) entropy expression

29. CVM initialization is made

30. Used to test quasi-chemical ordering model

31. Major constituents check even if no miscibility gap (ordering)

32. Hoch-Arpshofen model

Symbol Status Word

Set symbol status word (Bit meaning) if:

1. Constant

2. Variable

3. Function
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4. Table

5. Value must not be amended

6. Undefined

LIST_SYMBOL
This is a GIBBS_ENERGY_SYSTEM (GES) command.

List the symbols available in the current GIBBS workspace, which are defined (retrieved
from database in the DATA module, or directly entered in the GIBBS module) and used in TP-
functions for the entered model parameters for various phases in the defined system.

For encrypted commercial databases you may not be able to use this command
to list any retrieved symbol.

Syntax LIST_SYMBOL

Prompts

Name: <Symbol name>

Specify a symbol name (either as the full name of a defined symbol,
or as the first few common characters of several symbols which
have names starting with such common characters).

Only those symbols that match this name are listed.

Or press <Enter> for a list of all the symbols defined (retrieved from
database in the DATA module, or directly entered in the GIBBS
module) for the current system, which are available in the current
GIBBS workspace.

Output to screen or file /Screen/: <File name>

Specify the name of a simple-textual file in which the entered
symbols shall be written in a readable manner (such a basic textual
file can later on be opened and edited by any text editor). The
default value is the screen (by pressing <Enter>).

READ_GES_WORKSPACE
This command is specific to the GES (GIBBS) module.

The data area saved onto a *.GES5 file with "SAVE_GES_WORKSPACE" on page 128 is read
back into the GIBBS workspace.
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Syntax READ_GES_WORKSPACE

Enter a File name and specify the working directory where to save the file in the
Look in field. Normally the default file-type in the Files of type field is the
correct one for the GIBBS workspace format (i.e. *.GES5 file).

The saved *.GES5 files are unique for each CPU type, and therefore
a *.GES5 file saved on one CPU type cannot be read and used on
another CPU type.

REINITIATE
All data in the stored GIBBS workspace are erased, and all variables are initiated to their
default values.

Syntax REINITIATE

Prompts

Upper case only /Y/: <Y or N>

The name of elements and species can be either in only UPPER case (by typing
Y or pressing <Enter>), or the elements with two letter names have the first
letter in Upper and the second in lower case (by typing N).

In upper case mode all input in lower case is automatically
converted to upper case.

Lower temperature limit /298.15/: <Lowest t in K>

This value is used as the lower temperature limit when data are entered
interactively.

Upper temperature limit /6000/: <Highest t in K>

This value is used as the upper temperature limit when data are entered
interactively.

Default element reference state symbol index /1/: <1 or 2 or 3>

Specify a proper index for the default listing parameters (symbol), or press
<Enter> to accept the preset index 1.

The index is for defining the symbol printed in listings of parameters. The
symbol can be:

l G: the data are referred to Gibbs energy at a variable temperature
(also called Lattice Stability).
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Syntax REINITIATE

l H298: the data are referred to the enthalpy of the element at 298.15 K
and 1 bar.

l H0 is the same as H298 but at the temperature 0 K.

The index only changes the symbol, not any value. Normally the
index is set correctly by the database. Only when manually
entering data must you set the index to get the correct symbol.
Set the index value to 0 to get the symbol G, to 1 to get the symbol
H298 and to 2 to get H0.

SAVE_GES_WORKSPACE
This command is for the GES (GIBBS) module.

The data area used by the GIBBS workspace can be saved on a file (with a default extension
GES5 under MS-Windows, or ges5 under Linux). The default file name is RESULT.GES5 or
equal to the one used in a previous "READ_GES_WORKSPACE" on page 126 command.

Syntax SAVE_GES_WORKSPACE

Enter a File name and specify the working directory where to save the file in the
Save in field. Normally the default file-type in the Files of type field is the
correct one for the GIBBS workspace format (i.e. *.GES5 file).

The output is unformatted and cannot be printed.

SET_R_AND_P_NORM
The value of the gas constant (R) is used to define the energy units that are used for input of
data. On output, all data are in SI units. The value of the pressure 1 atm is used to interpret
values of the pressure given by application programs.
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Syntax SET_R_AND_P_NORM

Prompts

Value of gas constant in your energy units /8.31451/: <New
value>

The default value of the gas constant is in SI units (i.e. 8.31451). If you change
this value, it only affects the interpretation of energy data given interactively
from the terminal, e.g. if the value is set to 1.98717 you can give values in
Calories.

Value of one bar in your presure units /100000/: <New value>

The value of the pressure given in application programs is divided by this value
and then multiplied with the value of one bar expressed in Pascal before it is
used inside the GIBBS module.
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Optimizing with the PARROT Module
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AMEND_PARAMETER
This AMEND_PARAMETER command is for the PARROT module. There is also a
GES module command with the same name ("AMEND_PARAMETER" on
page 82).

Interactively modify the TP-function(s) for a specific parameter for a phase with this
command. This is useful in order to correct typing errors because the old function is made
available for interactive editing on the terminal.

Syntax AMEND_PARAMETER

Prompts

Parameter: <Parameter name>

Specify a correct parameter name. If a parameter name is not acceptable or
<Enter> is pressed, the error message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each part for a parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB or
VC or VK>

Specify one of these types of legal identifiers (see "ENTER_PARAMETER" on
page 143).

phase name (ABCD/): <Phase name>

Specify the phase name.

constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name.

interacting constituent (in sublattice # /XYZ/): <Species name>

Specify the interacting constituent name; if there is no interacting constituent,
press <Enter>.

interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent, specify these; otherwise
press <Enter>.

degree /#/: <Degree>

Specify a numerical number as the degree of the phase parameter.

After the parameter name is specified correctly, the program lists its current



Thermo-Calc Documentation Set

Optimizing with the PARROTModule ǀ 133 of 370

Syntax AMEND_PARAMETER

definition (either preset in database or defined by the ENTER_PARAMETER
command), such as:

L(PHASE2,AL,MG;1)=

298.15<T<2000.00: +5000

2000.00<T<4500.00: +4500

4500.00<T<6000.00: +4000

You are prompted to change the parameter definition:

do you want to change the number of ranges /No/: <Y or n>

To change the number of ranges for the chosen function, or change some of
the temperature limits in the definition, by typing Y you have to retype both
the low/high temperature limits and functions

If you do not want to change the number of ranges but want to change the
function(s) in one or more ranges, press <Enter> to accept the default N the
whole definition of the chosen parameter in all ranges (if any) is listed such
as:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00

This message prompts:

do you want to change range limits /No/: <Y or n>

If there is more than one range, this question is prompted. Press <Enter>.

range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges,
you must specify the range of the function of which you want to amend. Or
press <Enter> or type 0 to exit this command without making any change.

Function

The previous function is available for editing. The editing is performed within
the general subroutine FOOLED, as described in "AMEND_SYMBOL" on the
next page. This routine prompts as follows:

1:+:>
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The prompt consists of the current position in the string and the character at
that position between colons, (::).

Commands

These commands can be given:

l Help: ?

l Move CP to last or first character: <+/-> A

l Delete characters from CP: <+-#characters> D

l Exit: E

l Find: <#occurrences> F<string>@

l Insert: I<string>@

l Move: <+-#positions> M

l Restore string: R

l Substitute: S<OLD>@<NEW>@

l Type string: T

where CP denotes the current position in string, # means number of, @ is a
terminator of an input or search string.

When the string is typed the character at the current position is
replaced by an underscore _.

To finish the editing of the current function, type E.

range number (0 to exit) /0/: <Range number>

Give a range number to edit that function, or press <Enter> or type 0 to exit
this command.

AMEND_SYMBOL
This command is for the GES (GIBBS) and PARROT modules.

Interactively calculate the current values of a function or table (predefined by the switched
database or previously entered with "ENTER_SYMBOL" on page 113) at the current
temperature and pressure condition, and also possible to modify the definitions of variables
or functions.
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The current values of the temperature and pressure used to calculate the
functions or tables are the ones listed with "LIST_STATUS" on page 122. There is
no way to change the current temperature and pressure values interactively.

To modify the definitions of entered symbols (variable, functions or parameters), the
performance of this command is slightly different one from another, as described below:

l For variables, the values can be changed.

l For functions the low and high temperature limits in various ranges (if any), as well
the expressions, can be changed.

l For parameters the low and high temperature limits in various ranges (if any), as
well the expressions, can be changed.

Syntax AMEND_SYMBOL

Prompts

Name: <Symbol name>

Specify the name of an entered symbol.

For tables and functions (or parameters which are treated as functions after
these are entered by the ENTER_SYMBOL command with the Parameter
keyword, but not by the ENTER_PARAMETER command), after the symbol
name is specified here, the program automatically calculates the values under
the current temperature and pressure conditions, and lists the current values,
such as:

FUNCTION VALUE 2.52500000E+01

TABLE VALUE 1.56000000E+02

For variables and functions (or parameters), there are additional prompts and
depend on the symbol type.

For a variable, its current value is displayed, and you can change it to a new
value:

Value /Current value/: <New value>

For a function (or a parameter entered as a symbol):

Do you want to change the number of ranges /No/: <Y or n>

To change the number of ranges for the function, or change some of the
temperature limits in the definition, For Y, you must retype both the low/high
temperature limits and functions (see all the remaining details in the ENTER_
SYMBOL command.

If you do not want to change it, press <Enter> to accept the default. The
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definition of the chosen function in all ranges (if any) is listed, for example:

DIFFERENT FUNCTIONS IN THESE RANGES

298.15<T<2000.00

2000.00<T<4500.00

4500.00<T<6000.00

and this message displays:

Do you want to change range limits /No/: <Y or N>

If a function is different in two or more temperature ranges, you must specify
the range of the function of which you want to amend. Or press <Enter> or
type 0 to exit this command without making any change.

Range number (0 to exit) /0/: <Range number>

Function:

The previous function is available for editing. The editing is performed within
the general subroutine FOOLED. This routine prompts as follows:

1:+:>

The prompt consists of the current position in the string and the character at
that position between colons (::).

Commands

These commands can be given:

l Help: ?

l Move CP to last or first character: <+/-> A

l Delete characters from CP: <+-#characters> D

l Exit: E

l Find: <#occurrences> F<string>@

l Insert: I<string>@

l Move: <+-#positions> M

l Restore string: R

l Substitute: S<OLD>@<NEW>@

l Type string: T
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where CP denotes the current position in the string, # means number of, @ is a
terminator of an input or search string.

When the string is typed the character at the current position is
replaced by an underscore _. To finish the editing of the current
function, type E at the prompt.

COMPILE_EXPERIMENTS
The descriptions of the experimental equilibria saved on a textual *.POP file, given as
commands in the POLY and ED_EXP syntax, is compiled by this command into the PARROT
structured data, i.e. stored into the current work *.PAR file which is created with "CREATE_
NEW_STORE_FILE" on page 139, set by "SET_STORE_FILE" on page 162 , or opened with
"READ_PARROT_WORKSPACES" on page 154, all done before COMPILE_EXPERIMENTS.

This command also lists the compilation details on screen or onto a listing file (*.TXT).

If a syntax error in the commands is detected, the compilation is terminated.
You need to correct the error in the *.POP file (using a textual editor) and
recompile it with the *.PAR work (store) file.

After a successful compilation, the program translates all the experimental data points in
the *.POP file into a graphical experimental data file (*.EXP) in the DATAPLOT syntax, which
can be further edited and used as a graphical experimental data file (*.EXP) for the purposes
of imposing onto calculated/plotted phase diagrams and/or property diagrams for
comparisons during the assessment process.

Also see the DATAPLOT User Guide included with this documentation set.

Syntax COMPILE_EXPERIMENTS

A window displays to open the original experimental data file (*.POP). Enter a
*.POP File name box, and specify the working directory in the Look in box.
Normally the default file-type in the Files of type field is the correct one for
the experimental data format (i.e. *.POP file). Click Open or Cancel button as
applicable.

Prompts

Output to screen or file /Screen/: <*.pop file name>

A list of the source code in the *.POP file and error messages during
compilation is written on screen (by pressing <Enter>) or on a list *.TXT file
under a specific file name which can later on be opened and edited by any
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basic textual editor.

initiate store file /y/: <y or n>

After a successful compilation, the data in the POLY3 workspace is stored as a
new block of equilibria on the current work (store) file. If you specify that the
store file should be initiated before compilation (Y), only the compiled block is
stored on the current work file (consequently, the *.PAR file is updated). If a
negative answer (N) is chosen here, the current work file is not changed.

A window displays to generate/store the graphical experimental data file
(*.EXP) in the DATAPLOT syntax. Enter a *.EXP file name in the File name field
and specify the working directory when opening the *.EXP file in the Look in
field. Normally the default file type in the Files of type field is the correct one
for the graphical experimental data format (i.e. *.EXP file). Click Open or
Cancel as applicable.

CONTINUE_OPTIMIZATION
This command continues the optimization using the same Hessian matrix.

In some cases it is not possible to attempt continuation. For example, if the
optimization has already converged or if the optimizing parameters or the set of
experimental equilibria used in the current optimization runs are changed. The
program gives a warning message if you try to continue when you make these
changes.

Syntax CONTINUE_OPTIMIZATION

Prompts

Are you sure? /N/: <N or Y>

Prior to this question, a message displays to confirm if it is OK to continue:

It is safe to CONTINUE only after TOO MANY ITERATIONS and no change
in variables and experiments ...

You can accept the default (N) in order to cancel this special attempt.

Number of iterations /N/: <Integral number of iteration>

Specify an integral number for the optimization iteration. The specified
iteration number is shown as the default number. The PARROT program tries
this exact number of different sets of values of the optimizing variables
without stopping the optimization even it would have converged earlier or
should give up earlier.
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CREATE_NEW_STORE_FILE
This file is hardware dependent and cannot be read by any text editor.

Create a binary file to be used as a work file (also called store file) before any optimization
can be done. The workspace used by the GIBBS, POLY and PARROT modules is stored
automatically on the work file but not any experimental information. The binary work file
has a default extension of PAR under MS-Windows or par under Linux/UNIX.

A work file that is created at a previous run can be used in the PARROT module with the
other command SET-STORE-FILE.

Syntax CREATE_NEW_STORE_FILE

Prompt

<*.par file name>

A Save window displays. Enter a File name and specify the working directory in
the Save in field. Normally the default file-type in the Files of type field is the
correct one for the PARROT workspace format (i.e. PAR file). Click Save or
Cancel as applicable.

EDIT_EXPERIMENTS
Initialize and make available the sub-module for editing experimental equilibria, i.e. the ED_
EXP module. All experimental equilibria compiled from the *.POP file can be accessed in the
ED_EXP module.

The ED_EXP module is similar to the normal POLY module, but some commands are special
and some POLY commands are not available. In the ED_EXP module, you can calculate each
equilibrium separately or together, provide start values for equilibria which failed to
converge, set weights, and modify the values of experiments or conditions.

Also see "Running the EDIT_EXPERIMENTS Command" on page 27.

Syntax EDIT_EXPERIMENTS

You are now in this submodule and can start using
the commands.

About the ENTER_PARAMETER Command
For the PARROT Module, this command is the same and is described here. See
"ENTER_PARAMETER" on page 143 for the command details.
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In the descriptions of the standard thermochemical properties and special physical
properties for a phase, there are a number of parameters which may depend on the
temperature and pressure. The expressions for these parameters can be given in a free
form as a sum of terms with powers of T and P and may also include the natural logarithm
and exponential function. This type of expression is called TP-functions. Identical parameters
(in terms of parameter-names) are stored only once in the GIBBS workspaces.

The composition-dependence of the Gibbs energy is described in the GIBBS module by the
internal data structure, which is created when the phase is entered (see "Gibbs Energy
System (GES) Commands" on page 79). The Gibbs energy of a phase is always referred to
one formula unit of the phase, i.e. the amount derived from the number of sites (i.e. the
stoichiometric coefficient) for each sublattice. If vacancy is a constituent of a sublattice, the
amount of matter per formula unit of the phase may vary with composition.

Defining the Parameter
A valid parameter should have the general form of:

<identifier>(<phase>, <constituent array>; <digit>) <xxx> <expression> <yyy>
<keyword Y or N> <zzz> !

The identifier must be followed by an opening parenthesis, a phase name, a comma and a
constituent array. Optionally, the constituent array can be followed by a semicolon and a
digit. The parameter name is terminated by a closing parenthesis. The parameter form is
defined as:

l <identifier> is the parameter type;

l <phase> is the phase name (maximum 24 characters);

l <constituent array> is the specific constituent array in the phase;

l <digit> is the degree of composition-dependent interaction contribution (an integer
number from 0 through 9), that is only for excess energy (L), Curie temperature (TC)
and Bohr magneton number (BMAGN), as well as for volume-related parameters (V0
or VA or VB or VC or VK); if it is valued as zero, or if it is for the standard Gibbs
energy (G) for which the degree is always zero, it can be omitted;

l <expression> is the mathematical relation to describe the parameter;

l <xxx> and <yyy> are the low and high temperature limits respectively for the
applicable temperature range of the parameter expression;

l <keyword Y or N> is the indicator on if there is continuation for the parameter
expression or not;

l <zzz> is the reference index/number for the assessment of this parameter;

l The exclamation point ! is used to indicate that the current parameter definition is
ended.
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PARAMETER NAME

The GES parameter name has a general form of:

<identifier>(<phase>,<constituent array>;<digit>)

Examples of parameter names:

l G(GAS,C1O2): The Gibbs energy of formation of a CO2 molecule in gas.

l G(FCC,FE:VA): The Gibbs energy of formation of fcc Fe with interstitials.

l L(LIQ,Fe,Cr;0: The regular solution parameter for Fe and Cr in liquid.

l L(LIQ,Fe,Cr;1): The sub-regular solution parameter.

l TC(BCC,Fe:Va): The Curie temperature of bcc Fe.

l BMAGN(BCC,Fe:Va): The Bohr magneton number parameter of bcc Fe.

The parameter name consists of several parts. The first is a type-identifier and these can be
used:

l G: Standard energy parameter (Gibbs energy of formation) or for interaction
parameters;

l L: Excess energy parameter (Gibbs energy of interaction) always used for interaction
parameters;

l TC: Curie temperature for magnetic ordering;

l BMAGN or BM: Bohr magneton number for magnetic ordering (or Born function ωPr,Tr
for aqueous solute species).

l VO: Molar volume at 298.15 K and 1 bar (a numeric value only);

l VA: Integrated thermal expansivity;
l VB: Bulk modulus at 1 bar;

l VC: Isothermal compressibility;

l VK: High-pressure fitting parameter.

When necessary quantities as H (enthalpy), S (entropy), V (Volume), F
(Helmholtz energy), etc., can be calculated from the Gibbs energy.

PHASE NAME

Specifying the PHASE NAME in uppercase is recommended; however, if you prefer to write it
as a mixture of uppercase and lowercase, it automatically converts all lowercase to
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uppercase, as the GIBBS module only recognises uppercase phase names. It is important that
if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition
(already by the PHASE keyword; such as GAS:G, LIQUID:L,SLAG:L, IONIC-LIQ:Y, SPINEL:I, FCC_
L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code should not be
attached to the phase name when ENTER_PARAMETER is executed.

CONSTITUENT ARRAY

The constituent array consists of a list of constituent names. Interaction parameters have
two or more constituents from the same sublattice separated by a comma. If the phase has
sublattices, at least one constituent in each sublattice must be specified. The constituents in
different sublattices must be given in sublattice order and are separated by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess
energy model used for the phase. If no semicolon and digit are given, the sub-index value is
assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary
parameters, are multiplied with two or more fractions of the constituents from the same
sublattice of the solution phase. These additional constituents must be given as interacting
constituents (as the following prompt).

Solution phases with sublattices can have interacting constituents in each
sublattice.

INTERACTION PARAMETER

An interaction parameter, which is used to describe the excess term of a quantity, must have
two or more constituents that interact with each other on a specified sublattice site of the
given phase. It is arbitrary which of these constituents is given as the first constituent and
what is given as the interacting constituents. The software always sorts the constituents (in
each sublattice) in alphabetical order when the parameter name is written as a prompt (for
entering its parameter value) and when the parameter is listed (using the GIBBS commands
"LIST_PARAMETER" on page 147 or "LIST_PHASE_DATA (from GIBBS)" on page 148). This is
important for all asymmetric interaction parameters where the sign of the interaction
parameter must depend on the appearance order.

Use an asterisk* to denote that the excess interaction parameter is independent of the
constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that the
interaction parameter is for the binary interaction between constituents AL and NI on the
first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on
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the second sublattice. An interaction parameter in the list of constituents is always added to
the Gibbs energy and the asterisk * is calculated with the term of [1∑y(specified
constituents)], which implies that in an A-B binary system these L parameters are identical
(but in higher-order systems, these are different):

l L(phase,A,B) is multiplied with X(A)*X(B)

l L(phase,A,*) is multiplied with X(A)*(1-X(A))

l L(phase,B,*) is multiplied with X(B)*(1-X(B))

If you press <Enter> when you are asked for a parameter name or if you have improperly
input the entire parameter name, you are asked for each of these items in the name.

ENTER_PARAMETER
This command is for both the GES and PARROT modules.

Also see "About the ENTER_PARAMETER Command" on page 139 for details
about each of the options.

Use this command to enter TP-function(s) for a specific parameter for a phase interactively
with this command. If there is already a parameter expression defined (for this parameter),
that is deleted and replaced with newly entered one.

The entered TP-Function(s) for the parameter can be changed later with the command
"AMEND_PARAMETER" on page 82.

Syntax ENTER_PARAMETER

Prompts

Parameter: <Parameter name>

As explained in "About the ENTER_PARAMETER Command" on page 139,
specify a correct and complete Parameter Name, which should contain
all the necessary parts of the general form:

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter>, is pressed, a message
displays:

*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter
name.

Options Description or Information
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Syntax ENTER_PARAMETER

Identifier

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB
or VC or VK>

If this command is used one or more times, the previous value on this
prompt is set as default. Press <Enter> for the same type identifier or
specify a new type.

Phase name

Phase name (/ABCD/): <Phase name>

Each parameter is valid for a specific phase only. The name of that phase
must be supplied (maximum 24 characters). The name can be
abbreviated.

Constituent

Constituent (in sublattice # /ABC/): <Species name>

A parameter is identified by the constituents on a specified sublattice site
of the given phase, the stoichiometric coefficients of which are multiplied
with the parameter. The name of the constituent can be abbreviated.

It is the species name, not the stoichiometric formula
required here.

If this command is used one or more times, the previous value on this
prompt is set as default. Accept it by pressing <Enter> if the constituent is
the same, or specify a new species name.

Interacting
constituent

For phases with several sublattices, the program asks for one constituent
in each sublattice.

Interacting constituent (in sublattice # /XYZ/): <Species
name>

If this command is used one or more times, the previous value on this
prompt is set as default. Press <Enter> to accept it if the constituent is
the same, or specify a new species name.

To cancel the default value of the interacting constituent
type NONE or the name of another constituent.

This question is repeated until all the interested interacting constituent(s)
on a specific sublattice in the phase are specified, and finally an <Enter>
is enforced.

Degree
Degree /#/: <Degree>

Degree is model-dependent. Specify an integer number (a value from 0
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Syntax ENTER_PARAMETER

through 9) as the degree of composition-dependent interaction
contribution for the phase parameter. This is valid for excess energy (L),
Curie temperature (TC) and Bohr magneton number (BMAGN), as well as
for volume-related parameters (V0, VA, VB, VC or VK).

For binary interaction parameters, the degree is usually the power in the
Redlich-Kister expression. For ternary interaction parameters, it is usually
the Hillert ternary index.

For a standard G parameter for a pure component (end-member) its
degree should be always 0 and this prompt should not display.

Phase
parameter

After this prompt, the program echoes on the screen the full TP-Function
of the phase parameter.

Low temperature limit /298.15/: <Lowest temperature limit
in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure
limit (in Pascal but entered as a negative number), for the current TP-
Function.

Function: <Definition for a function>

A TP-Function consists of terms in T and P.

& <Continuation of the definition for the current function>

Continuation of a TP-Function definition.

High temperature limit /6000/: <High temperature limit in
K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit
(in Pascal; only if the lowest limit is entered as a negative number) for
the current TP-Function.

Any more ranges /N/: <Y or N>

Enter Y for more function(s) or N to end this command.

LIST_ALL_VARIABLES
This is a PARROT module command.
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Create a list of the values and status of all variables in the PARROT workspace on screen or
in a text file. After an optimization some statistical information is also written. The
correlation matrix is written if that option is chosen.

Also see "SET_OUTPUT_LEVELS" on page 160.

Syntax LIST_ALL_VARIABLES

Prompt

Output to screen or file /Screen/: <File name>

A list of the current values and status, as well statistical information (if after
optimization) and the correlation matrix (optionally), for all variables is written
on screen (by pressing <Enter>) or on the list file under a specific file name
which can later on be opened and edited by basic text editor.

Example Output

The following is the listed variables for the example TCEX36, after the first
optimization when having set all variables available for optimization.

== OPTIMIZING VARIABLES ==

AVAILABLE VARIABLES ARE V1 TO V00

VAR.  VALUE            START VALUE      SCALING FACTOR   
REL.STAND.DEV

V1     2.03729090E+04   2.03688352E+04   2.03688352E+04   
3.41524152E+00

V2    -2.94286372E+01  -2.94286372E+01  -2.94286372E+01   
2.37944771E+00

V11   -2.17373936E+04  -2.18095983E+04  -2.18095983E+04   
3.97086303E-02

V12    1.52107184E+01   1.51660547E+01   1.51660547E+01   
5.84552327E-02

V15    2.42082351E+04   2.45139169E+04   2.45139169E+04   
5.00914471E+00

V16   -8.38723972E+00  -8.83460472E+00  -8.83460472E+00   
1.60961318E+01

V17    3.08916533E+03   3.15802558E+03   3.15802558E+03   
9.63738108E+00

V19    2.20292586E+04   2.21385673E+04   2.21385673E+04   
4.14274011E+01 V20   -7.04217974E+00  -7.22424882E+00  -
7.22424882E+00   1.00561540E+02

NUMBER OF OPTIMIZING VARIABLES :  9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO

THE SUM OF SQUARES HAS CHANGED FROM  8.00002729E+04 TO  
8.00002719E+04
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Syntax LIST_ALL_VARIABLES

DEGREES OF FREEDOM  45. REDUCED SUM OF SQUARES  1.77778382E+03

LIST_CONDITIONS
This is a PARROT module command.

In the PARROT module, generate a list of the current values of optimization conditions, as
well the current status of listing, either on screen or in a basic text file which can be opened
and edited by a text editor.

Syntax LIST_CONDITIONS

Prompt
Output to screen or file /Screen/: <File name>

Press <Enter> to output to screen or on the list file under a specific file name.

LIST_PARAMETER
This command is for both the GIBBS and PARROT modules.

List the TP-function(s) of a specific parameter for a phase. You must supply the name of the
phase parameter:

The parameter name: <Identifier>(<Phase>,<Constituent array>;<Digit>)

For encrypted commercial databases, you may not be able to use this command
to list any retrieved parameter.
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Syntax LIST_PARAMETER

Prompts

Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the
necessary parts of the general form: <identifier>(<phase>,<constituent
array>;<digit>)

See "About the ENTER_PARAMETER Command" on page 139 to
learn how to define the Parameter Name.

If a parameter name is not acceptable or <Enter> is pressed, an error
message displays:

*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a
parameter name.

Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VB or VC
or VK>

Specify one of these types of legal identifiers.

Phase name (/ABCD/): <Phase name>

Specify the phase name.

Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name on the specified sublattice site of the given
phase.

Interacting constituent (in sublattice # /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the
given phase; if there is no interacting constituent, press <Enter>.

Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice
site of the given phase, specify them; otherwise press <Enter>.

Degree /#/: <Degree>

Specify a numerical number as the degree for the phase parameter.

LIST_PHASE_DATA (from GIBBS)
This is a PARROT module command.
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All data for a specific phase are written on screen. The thermochemical parameters listed
for each phase are always in SI units.

Syntax LIST_PHASE_DATA

Prompt
Phase name: <Phase name>

Specify a phase name.

LIST_RESULT
This is a PARROT module command.

List the result of the current optimization run on screen or in a specified file. The level of
detail listed can be prescribed by the command "SET_OUTPUT_LEVELS" on page 160.

The LIST_RESULT command has an option G for creation of an experimental data file with
two columns, one for the experimental value and the other for the calculated value. It allows
plotting a diagram and visualizing the fitting results. The plot is automatically plotted and
you can scale it giving commands in the POST module. The option D lists all experiments,
including those with fulfilled inequalities which are suppressed with the default option C.

Syntax LIST_RESULT

Prompt Full, condensed, detailed or graphic format: /C/: <C or D or F
or G>

Choose a format.

l C (condensed) is the default.

l D (detailed) lists all experiments, including those with fulfilled
inequalities (not included with the default condensed file).

l The G (graphical) format creates an experimental data file containing
two columns, one with the experimental value and the other with the
calculated value. This allows plotting of a diagram where all symbols
should be on the diagonal if the fit is perfect. The plot is automatically
plotted and you can scale it giving commands in the POST module.

l The F (full) format is obsolete but retained for backward compatibility.

Output to screen or file /Screen/: <File name>

A list of the current optimization results are written on screen (by pressing
<Enter>) or on the list file under a specific file name which can later on be
opened and edited by basic text editor.
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Syntax LIST_RESULT

The output normally consists of these parts:

l A title showing the data of the action;

l A message on successful optimization with the iteration number in the
last optimization;

l A paragraph describing the optimization condition;

l A list of the latest set of optimized and fixed variables;

l A paragraph describing the optimization quality (some statistical
information);

l A correlation matrix for all optimizing variables (optionally shown, pre-
set by the SET_OUTPUT_LEVELS command);

l A list of all parameters (including their symbol names, status and
current values or function expressions), and all phase descriptions
(including phase name, model names, constituents, and phase’s
G/L/TC/BM expressions) predefined for each phase in the system
(optionally shown, pre-set by the SET_OUTPUT_LEVELS command);

l A paragraph describing the alternate equilibria (and possible error
during optimization);

l A detailed list on all the equilibrium points used in the current
optimization. If the alternate-mode is used in the optimization, only an
error value is shown. For normal-mode calculations, a list is shown for
the experimental equilibrium numbers (first column) and corresponding
original experimental data (second column, in the form quantity =
value) which are used in optimization (i.e. non-zero weighted points).
Such experimental data are by each point compared by the calculated
value (third column) after the last optimization. Also listed are the
experimental error (column 4), the difference between the calculated
value and original experimental data (column 5), and the contribution
to the sum of least square (column 6).

Example Output

The following is the listed result in the example tcex36 ( in the Thermo-Calc Console Mode
Examples Guide), after the first optimization based on the prescribed definitions in the
TCEX36a.TCM and TCEX36b.TCM, but having set all variables available for optimization.

=====================================================
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OUTPUT FROM P A R R O T.            
=====================================================

*** SUCCESSFUL OPTIMIZATION. ***     NUMBER OF ITERATIONS: 10

== OPTIMIZING CONDITIONS ==

RELATIVE STANDARD DEVIATIONS FOR EXPERIMENTS: N

MINIMUM SAVE ON FILE: Y

ERROR FOR INEQUALITIES = 1.00000000E+00

RELATIVE STEP FOR CALCULATION OF DERIVATIVES = 1.00000000E-04

ARGUMENTS FOR SUBROUTINE VA05AD (HSL)

MAXFUN =  1  DMAX = 1.00000000E+02  H = 1.00000000E-04   ACC = (INITIAL
SUM OF SQUARES) * 1.00000000E-03

== OPTIMIZING VARIABLES ==

AVAILABLE VARIABLES ARE V1 TO V00

VAR.  VALUE            START VALUE      SCALING FACTOR   REL.STAND.DEV

V1     2.03749463E+04   2.03729090E+04   2.03729090E+04   3.41455863E+00

V2    -2.94286372E+01  -2.94286372E+01  -2.94286372E+01   2.37944774E+00

V11   -2.17395673E+04  -2.17373936E+04  -2.17373936E+04   3.98405298E-02

V12    1.52107184E+01   1.52107184E+01   1.52107184E+01   5.82861832E-02

V15    2.42106560E+04   2.42082351E+04   2.42082351E+04   5.07239609E+00

V16   -8.38723972E+00  -8.38723972E+00  -8.38723972E+00   1.69546796E+01

V17    3.08947424E+03   3.08916533E+03   3.08916533E+03   9.85220694E+00

V19    2.20314615E+04   2.20292586E+04   2.20292586E+04   4.16329629E+01 V20   
-7.04217974E+00  -7.04217974E+00  -7.04217974E+00   1.03161466E+02

NUMBER OF OPTIMIZING VARIABLES :  9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO

THE SUM OF SQUARES HAS CHANGED FROM  8.00002719E+04 TO  8.00002709E+04

DEGREES OF FREEDOM  45. REDUCED SUM OF SQUARES  1.77778380E+03

Number of alternate equilibria          14

SYMBOL       STATUS  VALUE/FUNCTION

R        80000000 8.3145100E+00

RTLNP    20000000 +R*T*LN(1E-05*P)

V1       48000000 2.0374946E+04

V2       48000000 -2.9428637E+01

V11      48000000 -2.1739567E+04

V12      48000000 1.5210718E+01

V15      48000000 2.4210656E+04

V16      48000000 -8.3872397E+00
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V17      48000000 3.0894742E+03

21 V19      48000000 2.2031462E+04  22 V20      48000000 -7.0421797E+00

LIQUID

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU                             CONSTITUENTS:
A,B

G(LIQUID,A;0)-G(BCC,A;0) =   500.00<T< 2000.00: +14000-10*T

G(LIQUID,B;0)-G(BCC,B;0) =   500.00<T< 2000.00: +18000-12*T

L(LIQUID,A,B;0) =   500.00<T< 2000.00: +V11+V12*T      L(LIQUID,A,B;1) =   
500.00<T< 2000.00: +V13+V14*T

A2B

2 SUBLATTICES, SITES 2: 1    CONSTITUENTS: A : B

G(A2B,A:B;0)- 2 G(BCC,A;0)-G(BCC,B;0) =

500.00<T< 2000.00: +V1+V2*T+V3*T*LN(T)

BCC

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU                             CONSTITUENTS:
A,B

G(BCC,A;0)-G(BCC,A;0) =   500.00<T< 2000.00: 0.0

G(BCC,B;0)-G(BCC,B;0) =   500.00<T< 2000.00: 0.0

L(BCC,A,B;0) =   500.00<T< 2000.00: +V15+V16*T

L(BCC,A,B;1) =   500.00<T< 2000.00: +V17+V18*T

FCC

EXCESS MODEL IS REDLICH-KISTER_MUGGIANU                             CONSTITUENTS:
A,B

G(FCC,A;0)-G(BCC,A;0) =   500.00<T< 2000.00: 408

G(FCC,B;0)-G(BCC,B;0) =   500.00<T< 2000.00: +3300-3*T

L(FCC,A,B;0) =   500.00<T< 2000.00: +V19+V20*T

L(FCC,A,B;1) =   500.00<T< 2000.00: +V21+V22*T

====== BLOCK NUMBER 1

DEFINED CONSTANTS

DX=2E-2, P0=101325, DH=500, DT=10

DEFINED FUNCTIONS AND VARIABLES%

HTR=HM(LIQUID)-HM(A2B)

Alternate equilibrium calculation                 0.4183

Alternate equilibrium calculation                 0.1932

Alternate equilibrium calculation                 0.1016

Alternate equilibrium calculation                 1.4354E-03

Alternate equilibrium calculation                 2.5063E-02
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Alternate equilibrium calculation                 8.3929E-03

Alternate equilibrium calculation                  141.4

Alternate equilibrium calculation                  141.4

Alternate equilibrium calculation                  141.4

Alternate equilibrium calculation                  141.4

Alternate equilibrium calculation                 1.2532E-03

Alternate equilibrium calculation                 5.4781E-04

Alternate equilibrium calculation                 1.5404E-03

Alternate equilibrium calculation                 1.2702E-03

ACR(B)=9.4E-1               0.9397     2.85E-02 -2.7745E-04 -9.7472E-03

ACR(B)=8.4E-1               0.8395     2.82E-02 -4.9038E-04 -1.7396E-02

ACR(B)=7.4E-1               0.7407     2.81E-02 7.3804E-04 2.6305E-02

ACR(B)=6.4E-1               0.6424     2.81E-02 2.3935E-03 8.5272E-02

ACR(B)=5.4E-1               0.5434     2.82E-02 3.4449E-03 0.1220

ACR(B)=4.4E-1               0.4428     2.85E-02 2.8265E-03 9.9024E-02

ACR(B)=3.4E-1               0.3394     2.90E-02 -5.8174E-04 -2.0040E-02

ACR(B)=2.3E-1               0.2320     2.97E-02 2.0260E-03 6.8208E-02

ACR(B)=1.2E-1               0.1194     3.06E-02 -6.4192E-04 -2.0981E-02

HMR(LIQUID)=-1964           -1957.     5.00E+02  7.439     1.4878E-02

HMR(LIQUID)=-3500           -3478.     5.00E+02  21.67     4.3338E-02

HMR(LIQUID)=-4588           -4565.     5.00E+02  22.69     4.5382E-02

HMR(LIQUID)=-5239           -5217.     5.00E+02  21.50     4.3008E-02

HMR(LIQUID)=-5454           -5435.     5.00E+02  19.11     3.8216E-02

HMR(LIQUID)=-5233           -5217.     5.00E+02  15.50     3.1008E-02

HMR(LIQUID)=-4575           -4565.     5.00E+02  9.691     1.9382E-02

HMR(LIQUID)=-3481           -3478.     5.00E+02  2.669     5.3385E-03  118 HMR
(LIQUID)=-1950           -1957.     5.00E+02 -6.561    -1.3122E-02

LIST_STORE_FILE
This is a PARROT module command.

Syntax LIST_STORE_FILE

Displays the name of the store file and its full path.
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LIST_SYMBOL_IN_GES
This is a PARROT module command.

Lists TP-function(s) for the entered model parameters for phases in the system on screen. In
many cases, the optimizing variables are parts of the TP-functions which in turn are entered
in model parameters for various phases in the GIBBS workspace.

This command is a way to find out how the functions depend on the optimizing variables. In
the PARROT module the list is only shown on screen, not written to any file (which the LIST_
SYMBOL command in the GIBBS module does).

Syntax LIST_SYMBOL_IN_GES

Prompt

Name: <Symbol name>

Specify a symbol name.

Only those symbols that match this name are listed. Or press
<Enter> for a list of all available symbols entered in the system.

OPTIMIZE_VARIABLES
Perform variable optimization. All system-definition data needed for the optimization is read
from the current work file (*.PAR). The result of the optimization is automatically stored in
the current work file.

Syntax OPTIMIZE_VARIABLES

Prompt

Number of iteration /N/: <Integral number of iteration>

Specify an integral number for the optimization iteration. The specified
iteration number is shown as the default number. The PARROT module tries
this number of different sets of values of the optimizing variables unless it has
converged earlier, or has given up earlier.

It initially takes a small step in each variable to find the steepest
slope. You can give zero iteration to calculate the error in all
selected experiments, and then use "LIST_RESULT" on page 149to
check how good (bad) the current fit is.

READ_PARROT_WORKSPACES
This command is used in the PARROT module.
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Read the previous PARROT/GIBBS/POLY3 workspaces back to replace the current
PARROT/GIBBS/POLY3 workspaces. It is useful if late changes made through various
PARROT/GIBBS/POLY commands are not satisfactory.

Syntax READ_PARROT_WORKSPACES

The previous PARROT/GIBBS/POLY3 workspaces are always associated with the
latest action to either open a work file by "SET_STORE_FILE" on page 162, or to
create a work file by "CREATE_NEW_STORE_FILE" on page 139 (either
interactively in the PARROT module or through a "MACRO_FILE_OPEN" on
page 5 of an *SETUP.TCM file), or to update the work file by "SAVE_PARROT_
WORKSPACES" on the next page.

Unlike the READ commands in other modules (e.g. GIBBS or PLOY), this
command in the PARROT module does not ask for the file name where to read a
previously opened/created/updated PARROT/GIBBS/POLY3 workspaces, for the
reason described above.

You cannot use this command if there is no work file opened or
created already.

RECOVER_VARIABLES

Syntax RECOVER_VARIABLES

The values of all variables are set back to the start values.

REINITIATE

This command should not be used unless you want to destroy the current
PARROT workspace. However, this PARROT command does not reinitiate the
GIBBS/POLY3 workspaces.

Syntax REINITIATE

The workspace used by the PARROT program is reinitiated. All output and
optimizing conditions are given their default values. All variables are set fixed
with their value equal to zero.
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RESCALE_VARIABLES

Syntax RESCALE_VARIABLES

The current values of all the parameters are copied to their start values and the
scaling factors for further optimization. Thus it should be done now and again,
in particular if you think the optimization results are improved after the
previous run(s), or if any variable changes more than a factor of 10.

SAVE_PARROT_WORKSPACES
This command is used in the PARROT module.

Syntax SAVE_PARROT_WORKSPACE

If the latest changes made through various PARROT/GIBBS/POLY commands are
as required, use this command to save the current workspace (i.e. data area)
used by the PARROT program (also including the current GIBBS and POLY3
workspaces), onto the present work *.PAR file which has already been opened
by "SET_STORE_FILE" on page 162 or been created by "CREATE_NEW_STORE_
FILE" on page 139 (either interactively in the PARROT module or through a
MACRO_FILE_OPEN of an *SETUP.TCM file).

The PARROT/GIBBS/POLY3 workspaces are updated after each
PARROT/GIBBS/POLY command. This means the current
PARROT/GIBBS/POLY3 workspaces are always updated onto the
latest work *.PAR file that is associated with the latest SET_STORE_
FILE or CREATE_NEW_STORE_FILE command.

Unlike the SAVE commands in other modules (e.g. GIBBS or PLOY),
this command in the PARROT module does not ask for the file name
where to save the current PARROT/GIBBS/POLY3 workspaces, for
the reason described above. You cannot use this command if there
is no work *.PAR file opened or created already.

SET_ALTERNATE_MODE
Turn the alternate mode on or off. The alternate mode is described in "Optimizing with the
PARROT Module" on page 130. It should be used only to optimize start values of the model
parameters in the beginning of the assessment.

With the ALTERNATE mode is possible to include functions to be evaluated together with an
alternate calculation and to select ALTERNATE mode for each experimental equilibrium.
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Syntax SET_ALTERNATE_MODE

Prompt
On /Y/: <Y or N>

The default Y turns on the alternate mode.

SET_EXTERNAL_PARAMETER
This is a PARROT module command.

Optimize model parameters of the so-called external models, which may not be as fully-
implemented/integrated parts inside the GIBBS system and thus are independently defined
within user-specified/written source codes. This command makes links between the PARROT
optimizing variables and external model parameters.

In order to be able to build the specified external model and to use this SET_
EXTERNAL_PARAMETER command, it requires you to first write codes for a
preferred external model (as it is not within the standard GIBBS system of the
Thermo-Calc software) and then provide it to the consultancy team
(consult@thermocalc.se) of Thermo-Calc Software Company in Stockholm for
the purpose of including the external model in a separate DLL that is
interactively connected to the Thermo-Calc software. Such a special service
can/should only be provided under the restrictive condition that a specific
Consultancy Project Contract is bilaterally agreed and signed in advance
between users and Thermo-Calc Software.

Syntax SET_EXTERNAL_PARAMETER

Prompt

External name: <Parameter name in the external model>

Correctly specify the parameter name defined within a specified/written
external model.

As optimizing variable number: <n>

Give the number of the PARROT optimizing variable, which should have a
unique link to the specified parameter name of the external model.

For example, @@ Link PARROT variables to CAM parameters:

SET-EXTER-PAR GT(SLAG_A,O-2,SI+4,CA+2) 1

SET-EXTER-PAR ET(SLAG_A,O-2,SI+4,CA+2) 2

SET-EXTER-PAR EXT(SLAG_A,O-2,SI+4,CA+2) 3

mailto:consult@thermocalc.se
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SET_FIX_VARIABLE
Prescribe a fixed value to a variable. The variable is considered as a constant at the
optimization, usually after successful optimization runs for some specific variables (for some
of the phases in the system). Such fixed variables can also be set back for further
optimization run by using "SET_OPTIMIZING_VARIABLE" on the next page.

Syntax SET_FIX_VARIABLE

Prompts

Variable number: <Variable number(s)>

Specify the number of the variable. It is possible to give a range by giving two
numbers with a hyphen in between (no spaces allowed), e.g. l. The
parameters within the limits are set fixed to their current values (no question
of values).

Start value /xxxx.xxxxx/: <A value to be fixed>

Specify a numerical value to be fixed for the selected variable (only when one
variable number is specified at the previous prompt). The current value for the
selected variable is shown as default.

If a range of variable numbers is specified at the previous prompt, this
question is not prompted, and the current values are used as fixed values.

SET_OPTIMIZING_CONDITION
Specify the conditions for the optimization. The default values are chosen automatically by
the PARROT program, and in most cases these should not be changed.

The optimization stops when the sum of errors decreases by this value, even
though it might be possible to increase it further with a new OPTIMIZE
command.

Syntax SET_OPTIMIZING_CONDITION

Relative standard deviation for experiments? /N/: <Y or N>

Choose whether the standard deviation of the experimental determinations are
absolute values (N) or if these are used as relative weighting factors (Y). The
estimated standard deviations of the optimized variables might be different for
the two cases.

Prompt

Min save on file? /Y/: <Y or N>

Specify whether the program should minimize the transfer of data to and from
the current work file during the optimization:
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Syntax SET_OPTIMIZING_CONDITION

If Y, it speeds up the optimization. After optimization use the "SAVE_PARROT_
WORKSPACES" on page 156 command to update the progress onto the current
work file.

If minimum saving on file is not specified (N), the workspaces are stored on the
current work file after every iteration in the optimization procedure.

Error for variable bounds: /1/: <Return >

This feature has not been implemented yet. Press <Enter>.

Relative step for calculation of derivatives: /1e-04/: <xxx>

In the calculation of the correlation matrix for equilibria with inaccuracy in the
independent state variables, some numerical derivatives might have to be
calculated.

Specify the relative step (xxx) for the calculation of these derivatives.

Maxfun (va05ad): /100/: <n>

The maximum number of iterations in the optimization. The same value set by
the OPTIMIZE command.

Dmax (va05ad): /100/: <n>

An estimate of the maximum distance between the start and the final values of
the variables. A smaller value makes the program vary the parameters with
smaller factors.

h (va05ad): /1e-04/: <xxx>

The step used in the scaled variables for calculating numerical derivatives
during the optimization.

acc/(initial sum of squares) (va05ad): /.001/: <xxx>

The break condition for the optimization. The accepted value is the difference
between the true minimum and the calculated one.

SET_OPTIMIZING_VARIABLE
Specify which variable value should be estimated at the optimization. Such a variable can
have a value of zero or another start value, or is fixed by "SET_FIX_VARIABLE" on the
previous page prior to the previous optimization run.



Thermo-Calc Documentation Set

Optimizing with the PARROTModule ǀ 160 of 370

For a good reference prior to this command, a list of all variables (which are used to define
various parameters for phases in the optimizing system, as pre-entered in the *SETUP.TCM
file or interactively entered in the GIBBS module) are obtained by using "LIST_ALL_
VARIABLES" on page 145.

Syntax SET_OPTIMIZING_VARIABLE

Prompts

Variable number: <Variable number(s)>

Specify the number(s) for the variable(s) to be set. Any non-zero parameter
within the range is allowed to be optimized. A parameter with a current value
equal to zero must be specified explicitly here in order to be optimized.

Specify a range by giving two numbers connected by a hyphen (no space
allowed!), e.g. 2-8. Under this circumstance, no question of start values are
asked.

Start value /xxxx.xxxxx/: <A guess value>

Specify a start guess of the optimum value (only when one variable number is
specified at the previous prompt). The current numerical value for the
selected variable is shown as default.

This guess is critical as the initial guess of all parameters must
make it possible to calculate the selected equilibria. If a range of
variable numbers is specified at the previous prompt, this
question is not prompted, and the current values (as start values)
are not changed.

SET_OUTPUT_LEVELS
Choose the type of information the PARROT module gives during the optimization procedure
and when listing results.

Syntax SET_OUTPUT_LEVELS

Prompts

List increment /1/: <Increment in iteration number>

Specify the increment in iteration number for which information is listed on
screen during the optimization. By giving a larger number it shortens the list.

List sum of squares: /Y/: <Y or N>

Choose whether the sum of squares is listed on screen during the optimization
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Syntax SET_OUTPUT_LEVELS

procedure.

List scaled variables: /Y/: <Y or N>

Choose whether the scaled variable values are listed on the terminal during
the optimization procedure.

List weightened residuals: /N/: <N or Y>

Choose whether the weighted residuals are listed on the terminal during the
optimization procedure.

List all parameters: /N/: <N or Y>

Choose whether all parameters in the models are listed in "LIST_RESULT" on
page 149.

List correlation matrix: /N/: <N or Y>

Choose whether the correlation matrix of the variables are listed with the
commands LIST_RESULT and "LIST_ALL_VARIABLES" on page 145.

SET_SCALED_VARIABLE
This command is similar to "SET_OPTIMIZING_VARIABLE" on page 159 in that it specifies
start values for optimizing variables. The difference being it is functional for only one
optimizing variable at one time. It also prescribes a minimum and maximum value for the
variable. During the optimization runs, the variable value is limited within this min-max
range.

Such a variable may have a value of zero or another start value, or may be fixed by "SET_
FIX_VARIABLE" on page 158 prior to the previous optimization run. For a good reference
prior to using this command, a list of all variables (which are used to define various
parameters for phases in the optimizing system, as entered in the *SETUP.TCM file or
interactively entered in the GIBBS module) is obtained by using "LIST_ALL_VARIABLES" on
page 145.

Syntax SET_SCALED_VARIABLE

Prompts

Variable number: <Variable number(s)>

Specify the number for an optimizing variable to be set. Any non-zero
parameter is allowed to be optimized, and a parameter with a current value
equal to zero must be specified explicitly here in order to be optimized.

Start value /xxxx.xxxxx/: <A guess value>
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Syntax SET_SCALED_VARIABLE

Specify a start guess of the optimum value. The current numerical value for
the selected variable is shown as default.

This guess is critical as the initial guess of all parameters must
make it possible to calculate the selected equilibria.

Min value /xxxx.xxxxx/: <A guess value>

Specify a minimum guess of the optimum value. It should be smaller than, at
least equal to, the current start value for the selected variable.

Max value /xxxx.xxxxx/: <A guess value>

Specify a maximum guess of the optimum value. It should be larger than, at
least equal to, the current start value for the selected variable.

SET_STORE_FILE
Specify a store file (work file) to be used for compilation and optimization. The *.PAR work
file must be created ("CREATE_NEW_STORE_FILE" on page 139) as a store file. The GIBBS,
POLY and PARROT workspaces are read from the specified store file (with a default
extension of PAR).

Syntax SET_STORE_FILE

Prompt

Enter an *.PAR file name in the File name field and specify the working
directory in the Look in field. Normally the default file-type in the Files of type
field is the correct one for the PARROT workspace format (i.e. *.PAR file). Click
Open or Cancel as applicable.
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Equilibrium Calculations with the POLY_3
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About POLY3 - The Equilibrium Calculation Module
Knowledge of the thermodynamic equilibrium is an important factor for understanding
properties of materials and processes. With a database of thermodynamic model
parameters, it is possible to predict such properties and also to obtain driving forces for
diffusion-controlled phase transformations and other dynamic processes.

With the Equilibrium Calculation module, POLY3, it is possible to calculate many different
kinds of equilibria and diagrams, in particular multicomponent phase diagrams.

Different types of databases can be used with the POLY module, and it can be used for alloys
or ceramic systems, as well as gaseous equilibria, aqueous solution involved heterogeneous
interaction systems. Up to 40 elements and 1000 species can be defined into a single system
for equilibrium calculations.

All normal thermodynamic state variables can be used to set as conditions in calculating
equilibria, and as axes in plotting diagrams. You can set the composition or any property of
an individual phase as a condition. Any state variable can be varied along an axis in order to
generate a diagram. During calculations of a diagram, complete descriptions of all
calculated equilibria are stored, and in the diagram any state variable can be used as an
axis.

The Global Minimization technique is used to ensure that the present minimum in an
equilibrium calculation is the most stable minima for the specified conditions. This is based
on the traditional GEM (Gibbs Energy Minimization) technique.

A Direct Global Minimization can be performed on conditions: N, n(comp), B, b(comp), w
(comp), x(comp), T, and P, but not when combined conditions as e.g. w(a)-3*w(b)=1 are used
or when an activity or potential condition is used. For all other types of conditions where
regular minimization converges, Indirect Global Minimization, i.e. global test and
corrections, if necessary, are performed until the lowest minimum is found.

l Direct Global Minimization: From the mesh of Gibbs energy, find the set of grid
points that gives the lowest energy solution under the specified conditions. This set of
grid points provides starting combination of phases and their constitutions for regular
minimization to find the exact equilibrium solution. This solution is then subject to a
global test as described below.

l Indirect Global Minimization: Under certain conditions, a direct approach is
impossible. In this case, regular minimization is performed first and then a check is
performed in order to see if the found local minimum is a global one by checking if
all grid points are above the equilibrium Gibbs energy plane. If not, then recalculate
by including these grid points until no grid point is above the equilibrium Gibbs
energy plane from the previous step.
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The full-scale and full-scope usage of the Global Minimization Technique has been extended
from for only single-point calculations for all types of calculations (of single-points, property
diagram stepping and phase diagram mapping)in Thermo-Calc.

The use of Global Minimization Technique may increase the computation time. The main
cost in time comes from the calculation of Gibbs energy at each grid point generated by
properly meshing the composition space for each entered phase. An additional (but much
smaller) cost in time comes from finding the set of grid points in the above mesh that give
the lowest energy solution. This solution is where POLY starts its ordinary minimization.
When POLY has found an equilibrium, the equilibrium Gibbs energy surface is compared to
the mesh to assure that no grid point is below the surface, i.e. a global minimization has
been reached.

Global Minimization is performed by default in single-point or stepping or mapping
equilibrium calculations.

Together with the PARROT module, the POLY module is also used for critical assessment of
experimental data in order to develop thermodynamic databases. The POLY module uses the
Gibbs Energy System (GES) for modeling and data manipulations of the thermodynamic
properties of each phase.

ADD_INITIAL_EQUILIBRIUM
Add initial equilibrium points from which a phase diagram is calculated (through the "MAP"
on page 212 command).

Syntax ADD_INITIAL_EQUILIBRIUM

Prompt

Direction /Default/: <Direction code>

direction code (s) 1 or 2 for positive direction of axis 1 or 2, respectively; -
1 or -2 for negative direction of axis 1 or 2, respectively; Default for all
directions.

The direction is important when the initial equilibrium point is in a single-phase
region or when the phase diagram is an isopleth (tie-lines not in the plane of
calculation). In such cases, the program searches for a line in the diagram (i.e.
a line where the amount of a phase is zero, imply that if it starts to become
stable on one side of the line and disappear on the other side) in the given
direction.

Normally, this command is not needed to calculate a property diagram (with the "STEP_
WITH_OPTIONS" on page 227 → NORMAL command-sequence). In many cases, the ADD_
INITIAL_EQUILIBRIUM command is not required for MAP commands either, as the mapping
procedure starts from the current equilibrium state already calculated. In order to calculate
a simple phase diagram, set the equilibrium conditions and the mapping axis variables, and
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then give a MAP command. But if a phase diagram has disconnected lines, the ADD_
INITIAL_EQUILIBRIUM command may still be needed to add two or more initial equilibria so
that the MAP calculation starts from such initial equilibria at the specified directions to find
all phase boundary lines.

This command becomes unnecessary in most cases, as the MAP routines that by default use
the Global Minimization Technique handles all the initial equilibrium points in a robust and
automatic way. Therefore, you do not need to have a good guess of the starting point and to
add any initial equilibrium point prior to the calculations of various types of phase diagrams.
However, if preferred, use this command to add any initial equilibrium points in certain
directions, the POLY module uses the specified starting point(s) and corresponding user-
added initial equilibrium point(s) for a mapping calculation; in such a case, the automatic
procedure in the rewritten MAP routines are not enforced while the Global Minimization
Technique can still be applied. Similar situations occur when a specific database, in which
there are some definitions of initial-equilibrium adding direction(s) for accessed binary
and/or ternary subsystems in its ACCESSED_SYSTEM section, is used in the BINARY or
TERNARY module for calculating a binary or ternary phase diagram.

The ADD_INITIAL_EQUILIBRIUM command with the default direction scans along the axis
variables and generates start points each time the scanning procedure crosses a phase
boundary. In addition, it generates four start points, scanning cross the middle of each axis,
if there is any solubility line that does not reach the axes. At the MAP command, a search for
lines in the diagram is made along each direction of the axis variables in the diagram. In this
way, it should guarantee that all possible phase boundary lines in a phase diagram are
found. Of course, it may take a little longer time to execute than using the minimum
number of start points, as some lines may be calculated more than once. But the POLY
module remembers all node points and subsequently stops calculations along a line when it
finds a known node point.

It is also possible to create a sequence of start points from one initial equilibria by
appending a > after the direction at the ADD command. For example:

Direction /Default/: 2>

Direction /Default/: -2>

This generates one start point for each set of phase change in the positive direction of the
axis 2 (or negative direction of the axis 2); this ensures finding all possible phase boundary
lines (not just the first one) along such an axis direction.

This is particularly useful when you have a phase diagram with several lines with no
intersection. It is thus possible to calculate e.g. an isopleth for a much more limited
composition range. It is also useful for calculating CVD diagrams and Pourbaix diagrams.

All the initial equilibrium points generated by the ADD_INITIAL_EQUILIBRIUM command
(previously and presently; saved in the current POLY workspace) can be easily listed out on
screen with "LIST_INITIAL_EQUILIBRIA" on page 210. A certain initial equilibrium point
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(including its conditions and equilibrium results) can be loaded into the current equilibrium,
if needed, with "LOAD_INITIAL_EQUILIBRIUM" on page 212. Any specific or all of the initial
equilibrium points can be deleted from current POLY workspace, if desired, with "DELETE_
INITIAL_EQUILIBRIUM" on page 204.

ADVANCED_OPTIONS Descriptions
Also see "ADVANCED_OPTIONS" on page 174 for information about the
command.

These ADVANCED_OPTIONS can be set:

EQUILIBRIUM_CALCUL

Designed to decide how to perform the Ordinary POLY Minimization (i.e. the traditional
Gibbs Energy Minimization) in the POLY module. By default, the Global Minimization
Technique for various single point equilibrium calculations and for stepping or mapping
calculations is used. You can use the advanced option "GLOBAL_MINIMIZATION" on
page 295 to permanently turn off (for all sequential calculations throughout the current TCC
run) the Global Minimization Technique and consequently use only the Ordinary POLY
Minimization, and additionally adjust the ways to proceed the normal minimization (mainly
in terms of how to control the steps in reaching Gibbs energy minima in an equilibrium
state). When enforcing the Global Minimization Technique in the equilibrium calculations,
you can further adjust the manners for assigning grid-points and for handling new possible
compositional set(s) for solution phases during stepping/mapping; since the Global
Minimization Technique also uses the normal POLY optimization routine for some
calculations, it is also possible to change the ways on how to control the steps in reach Gibbs
energy minima in an equilibrium state, in order to improve convergence.

GLOBAL_MINIMIZATION

Designed to decide how to perform the so-called Global Minimization in the POLY module.
By default, the POLY module uses the Global Minimization Technique for various single-point
equilibrium calculations and for stepping or mapping calculations. You can use this to
permanently (for all sequential calculations throughout the current TCC run) turn off the
Global Minimization Technique and consequently use only the Ordinary POLY Minimization,
and additionally adjust the ways to proceed the normal minimization (mainly in terms of
how to control the steps in reaching Gibbs energy minima in an equilibrium state). When
enforcing the Global Minimization Technique in the equilibrium calculations, you can adjust
the manners for assigning grid-points and for handling new possible compositional set(s) for
solution phases during stepping/mapping; since the Global Minimization Technique also uses
the normal POLY optimization routine for some calculations, it is also possible to change the
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ways on how to control the steps in reach Gibbs energy minima in an equilibrium state, in
order to improve convergence.
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LIST_PHASE_ADDITION

The values set as additional contributions (given by PHASE_ADDITION) to Gibbs energy Gm
(J/mol formula unit) to all the phases (stoichiometric or solution) are listed at the current
calculated equilibrium.
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MAJOR_CONSTITUENTS

Use this to set the major constituent(s) of a composition sets in a miscibility gap of a solution
phase. Normally, the major constituents are specified when a new composition set is created
by the NEW_COMPOSITION_SET option; but for the first composition set, this option may be
needed before using NEW_COMPOSITION_SET.

NEW_COMPOSITION_SET

A solution phase that can exist with two (or more) different compositions simultaneously
must have two (or more) composition sets in its phase descriptions. Normally the database
creates as many composition sets as is necessary but use this command to add or delete
more composition sets. A complex solution phase in a defined multicomponent system can
have up to 9 different composition sets for the purpose of appropriately handling its possible
miscibility gap(s) under various temperature-pressure-composition conditions.

This option is unnecessary if the Global Minimization Technique is in use, as it can
automatically detect all possible miscibility gap(s) for complex solution phases (normal or
disordered/ordered phases) and then automatically add required composition sets for such
phases in the defined system.

This option can automatically create composition sets also for disordered phase when it is
executed for the ordered phase.

If you have your own data file, this option must be used to indicate that a solution phase can
have a miscibility gap (or may exhibit some complex phase separations as to more than two
composition sets), unless that the possibly-additional composition set(s) for the solution
phase must have already been added inside the TDB file (through a TYPE_DEFINITION
command to amend composition-set) or been manipulated through the GIBBS module (using
the AMEND_PHASE_DESCRIPTION COMPOSITION_SET command-sequence). This option asks
for default major constituents for the new sets and it is important that this is set correctly,
otherwise the test for miscibility gaps may fail.

OUTPUT_FILE_FOR_SHOW

The name of a text file is asked for and all the results output from the command SHOW_
VALUE is written to this file.

PARAEQUILIBRIUM

This calculates a paraequilibrium between two specific phases in an alloy system with one or
more interstitial component(s) as fast diffusion species. Under the paraequilibrium state,
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two partially-equilibrated phases have the same chemical potential (but different contents)
for one or more interstitial components (such as C, N, O, S, etc., as individual or combined)],
along varied temperature or along a composition variable (of the matrix or one
substitutional component) which has already set as the stepping variable with "SET_AXIS_
VARIABLE" on page 218.

To ensure a successful point calculation of paraequilibrium state between two specific
phases in a defined alloy system, it is important that you first have made a single-point
equilibrium calculation with an initial overall composition in the current system before
performing this advanced-option calculation; however, it is unnecessary to obtain an
equilibrium in which either one or both of the target phases is stable. The initial overall
composition must have a reasonable setting for the desired paraequilibrium calculation for
the two target phases. This is especially true for cases where there are more than one
interstitial components to be considered in the paraequilibrium state, because different
interstitial components (for example C and N combined) may have significant different
behaviors as partitioning into different structured phases; otherwise, for one chosen
interstitial component the initial overall composition is OK for the paraequilibrium
calculation between the specified two phases, but for other chosen interstitial component(s)
it might be impossible to calculate the paraequilibrium state.

Note the following:

Always check if the chosen phases A and B have the exactly same definition of elements and
if the chosen interstitial components are all in the vacancy sublattice sites of the two phases;
otherwise the program cannot find the paraequilibrium state (as it is impossible to correctly
calculate u-fractions).

Always have a comprehensive understanding of the normal phase diagram for the currently
investigated system, so that you make the appropriate choice of the phase pair and staring
bulk composition for the system.

Always set the status of the chosen interstitial components as SPECIAL using the POLY
command: "CHANGE_STATUS" on page 186 Component <interstitial component> =
SPECIAL. By doing this, you get a clear picture of u-fractions of various substitutional and
interstitial components, which are different from the overall composition in the system. The
SPECIAL status means that specified component(s) are not included in summations for mole
or mass fractions. Therefore, all the composition variables plotted from paraequilibrium
calculations are u-fraction related quantities.

PHASE_ADDITION

Sometimes it is interesting to add a constant contribution to the Gibbs energy of a phase
(stoichiometric or solution). This can be done in the Database Module (DATA) or Gibbs
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Energy Module (GIBBS), for a stoichiometric phase, or for a pure end-member in a solution
phase. However, if the addition is related to the equilibrium state, for example, strain
energies or surface energies, interfacial energies or deformation energies, it may be more
convenient to have this quantity related to the equilibrium state rather than the
thermodynamic data.

Give a value of an addition to the Gibbs energy of a phase. The value should always be
constant (implying that the addition is not a function of phase composition or temperature-
pressure conditions in the equilibrium state) and always be given in the unit of J/mol
formula unit of the phase.

PRESENT_PHASE

The phase specified must be stable at all equilibria calculated during a "MAP" on page 212
command. It is a way to limit the calculations of the monovariant lines in a ternary system to
those in the liquidus surface. Normally such a calculation would have two compositional axes
and a temperature axis and all monovariant lines, also those between 3 solids, would be
mapped. If the liquid is set as PRESENT, only those with the liquid is mapped.

SHOW_FOR_T=

Display various thermodynamic properties (state variables, derived/partial variables or
entered symbols) of the currently calculated (stable/meta-stable) equilibrium state but
under a different temperature condition. This is useful for knowing, for example, a volume-
related property of a frozen (stable/meta-stable) equilibrium state at a certain temperature,
where the equilibrated phase assemblage and all the phase compositions are not adjusted
while only the temperature condition is changed.

Use this option carefully. You must have successfully calculated a real equilibrium state
under one temperature condition (normally the temperature for the last heat treatment).
This can then be used to obtain the value(s) of any specified state variable(s) or
derived/partial variable(s) or defined symbol(s) for thermodynamic properties of the entire
system, of components, or of phases for the currently-defined system (being in a frozen
state) under another temperature (normally at room temperature). No real equilibrium is
re-calculated through this option, and thus the phase amounts and compositions in the
system are the same as at the last real equilibrium calculation.

STABILITY_CHECK

In some composition ranges of a multicomponent system, it often happens that an unstable
solution phase region locates inside a miscibility gap, and the stability limit (the spinodal
curve or spinodal) may be not easy to find. A system inside a spinodal is thermodynamically
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unstable with respect to compositional fluctuations, and the system may experience the
spinodal decomposition (i.e. decomposing to a mixture of regions with the two stable
compositions, one on each side of the miscibility gap).

This option makes it possible to automatically check internal stability of both stable and
unstable phases in all subsequent single-point equilibrium and MAP/STEP calculations. It can
find out if any phase is subject to spinodal decomposition during the subsequent calculations.
If there is an unstable phase located inside a miscibility gap in a calculation, it gives a
warning so that you suspend the unstable phase, or use FORCED automatic start values for
phase constituents (i.e. "SET_ALL_START_VALUES" on page 217 → FORCE command-
sequence), or create other composition sets; you can also ignore the warning message if you
know that the unstable phase is not formed in the current calculations.

STEP_AND_MAP

This is the default and is used to determine how to perform Global Minimization test and
how to handle initial equilibrium points.

T-ZERO_TEMPERATURE

This calculates the temperature when two specific phases have the same Gibbs energy, i.e.
the so-called T0 temperature. You must calculate an equilibrium state at an estimated
temperature before performing this advanced-option calculation; however, it is unnecessary
to obtain an equilibrium state in which either one or both of the target phases is stable.

TOGGLE_ALTERNATE_MODE

Toggle the ALTERNATE mode for experimental equilibrium calculation between DEFAULT,
ALWAYS and NEVER, during data-assessments using the PARROT optimization.

ADVANCED_OPTIONS

Syntax ADVANCED_OPTIONS

Prompt Which option? /Step_and_Map/: <Option>

Also see "ADVANCED_OPTIONS Descriptions" on page 168.

LIST_PHASE_ADDITION has no additional prompt.

STEP_AND_MAP (the default)

Settings for MAP and STEP:
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Global test interval /0/: <Integer number>

Settings for MAP:

Automatically add initial equilibria /Y/: <Y or n>

Number of mesh along an axis /3/: <Integer number>

Use inside meshing points /N/: <Y or N>

Global test interval /0/: <Integer number>

The integer number determines how often the Global Minimization should be used during
STEP_WITH_OPTIONS and MAP calculations. If it is set to 0 (zero), the recommended global
test interval is used: i.e. every tenth step and at each phase change during STEP calculations,
and only at node points during MAP calculations. Any other positive integer number, n,
suggests it performs a Global Minimization test at every n-th step during STEP and MAP
calculations. Of course, the Global Minimization test is always carried out at a phase change
or a node point. The Thermo-Calc software is installed with 0 (zero) as the default value, but
such a configuration for the default value can be changed by using SET_TC_OPTIONS in the
SYS module.

Automatically add initial equilibria /Y/: <Y or N>

When "ADD_INITIAL_EQUILIBRIUM" on page 166 is not used before MAP, a mesh of initial
equilibrium points are added before the mapping itself takes place. This mesh is only
available when two (2) axes are already defined. The default on start-up may be changed by
SET_TC_OPTIONS in the SYS monitor.

Number of mesh along an axis /3/: <Integer number>

An integer for how many intervals of initial equilibrium points to be added along an edge in
the diagram. For example, if set to 2 (two), initial equilibrium points are added at the
beginning, center, and end of each axis-variable forming 2 intervals.

Use inside meshing points /N/: <Y or N>

If N the INITIAL_EQUILIBRIUM mesh consists of initial equilibrium points added only along
the edge/border of the diagram defined by the axis-variables. If Y, the initial equilibrium
points added are also added inside edge.

NONE

Take away any set advanced option in all subsequent single-point equilibrium and MAP/STEP
calculations.

If there is any convergence problem in finding a stable solution, at any stage of an advanced
option calculation conducted by an ADVANCED_OPTIONS command-sequence, these
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messages display:

Convergence problems, increasing smallest site-fraction from 1.00E-30  to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

The smallest site fraction in the current POLY3 workspace is automatically increased from
the default value 1.00E-30 to the hardware-dependent precision (under Linux, as 2.00E-14).
For other subsequent POLY-module calculation in the current TC run, you can use the POLY
command "SET_NUMERICAL_LIMITS" on page 296 to restore or reset the smallest site
fraction to the previous or another preferred value, as well as to reset other numerical
limits.

EQUILIBRIUM_CALCULATION

The following prompts affect the ways how the POLY optimization does the Ordinary POLY
Minimization to reach the minimum of an equilibrium state.

Settings for the minimization of an equilibria:

Force positive definite phase Hessian /Y/: <Y or N>

Control stepsize during minimization /Y/: <Y or N>

Force positive definite phase Hessian /Y/: <Y or N>

Choose Y or N to determine how to reach the minimum of an equilibrium state in a normal
POLY optimization procedure. This is related to the special quantity, the phase stability
function QF (phase), for all kinds of phases in an equilibrium state [A phase stability function
for a phase is negative when the phase composition is inside a spinodal, and positive
everywhere else].

If the composition of a solution phase is inside its spinodal, the enforcement of positive
definite eigenvalues of a Hessian matrix (i.e. by answering Y) makes the step be taken
towards the minima rather than the local maxima. Furthermore, if an eigenvalue (for a
phase) of the Hessian matrix is near 0.0, the step-size is large and the answering Y sets a
lower limit to this eigenvalue, and reduces the step-size and improves the convergence. The
POLY command-sequence SHOW_VALUE QF(phase) shows the size of the lowest eigenvalue of
a phase in an equilibrium state.

By answering Y it might help the Ordinary POLY Minimization to converge, if there is such a
problem, especially if QF(phase)=0 for phases.

By answering N the Ordinary POLY Minimization routine is applied.

For each phase in a defined system, the molar Gibbs energy of the phase is a function of the
temperature-pressure condition and its composition:
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Compute a Hessian matrix as which describes the curvature of the Gibbs energy curve of this
phase at the defined composition X:

Diagonalize this matrix and call the Eigenvalues as e1,e2,...,en . The QF(phase) quantity for
this phase is the lowest of these eigenvalues divided by the same values for a corresponding
ideal (stoichiometric) phase:

Here, se1,se2,...,sen are the eigenvalues for the ideal phase. Therefore, for an ideal
(stoichiometric) phase, the QF(phase) should always be 1.0.

Control stepsize during minimization /Y/: <Y or N>

Choose Y or N to determine whether to introduce a control of step-size while reaching the
minimum of an equilibrium state in a normal POLY optimization procedure. By answering Y
it might help the POLY optimization to converge, especially if when some site fractions are
less than 1E-4.

GLOBAL_MINIMIZATION

The following prompts affect how the Global Minimization is done. Settings for global
minimization:

Use global minimization as much as possible /Y/: <Y or N>

Use global minimization for test only? /N/: <Y or N>

Maximum number of gridpoints per phase /2000/: <Integer number>

Use global minimization as much as possible /Y/: <Y or N>

Choose Y or N to decide if using the Global Minimization Technique from start of calculation
or not. The default value on start-up may be changed by SET_TC_OPTIONS in the SYS module.

If Y the calculation is done when possible (depending on the condition settings), and a Global
Minimization test is always performed when an equilibrium is reached. This costs more
computer time but the calculations are more accurate.

If N the calculation is not used to reach the equilibrium state. Use global minimization
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for test only? determines if the Global Minimization test is made against the calculated
equilibrium states obtained by the Ordinary POLY Minimization calculation.

Use global minimization for test only? /N/: <Y or N>

If Y a calculated equilibrium state obtained by the Ordinary POLY Minimization calculation is
tested against the Global Minimization Technique after it is reached; and if found it as
unstable, there is an error message.

If N the Global Minimization Technique is never tested for or done for all sequential
calculations throughout the current TCC run. This implies that Global Minimization
Technique is permanently turned off, and that consequently only the Ordinary POLY
Minimization routine is used.

Maximum number of gridpoints per phase /2000/: <Integer number>

Specify the maximum number of grid points that are computed for each of the phases in the
currently defined system, during the calculations enforced by the global minimization. More
grid points give a higher robustness and take more computation time. The total number of
computed grid points in all phases is limited to 2E6.

IGNORE_COMPOSI_SET_ORDER

Ignore composition set order /N/

NEW_COMPOSITION_SET

The following prompts are to specify the additional composition set(s) to handle possible
miscibility gap(s) of a certain solution phase:

Phase with miscibility gap: <Name of a phase>

Specify the name of the phase with miscibility gap.

New highest composition set number /2/: <#>

The default value is usually one higher than the current value. Each phase has initially one
composition set. If a lower value is given, composition sets are deleted. You cannot take
away the first composition set.

A message displays to show that you need to specify the composition for the composition set
# (2,3,…).

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) in each sublattice can be given. This may simplify giving start
values when calculating the equilibrium as phases with miscibility gaps should have different
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major constituents for each composition set.

This prompt is repeated for each sublattice in the phase, sometimes even for all sublattices
in the first composition set if such major constituents have not been specified.

MAJOR_CONSTITUENT

The following prompts are to specify the major constituent(s) on each of the sublattice sites
for a composition set of a certain solution phase:

Phase name: <name of a phase>

Specify the name of the solution phase with a new set of major constituents.

Composition set number /1/: <#>

The default value for the composition set number (#) is usually /1/ as the other composition
sets are given major constituents when creating them. Each phase has initially one
composition set.

Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) on each sublattice of a solution phase can be given. This may
simplify giving start values when calculating the equilibrium as phases with miscibility gaps
should have different major constituents for each composition set.

This question is repeated for each sublattice in the phase.

PHASE_ADDITION

The following prompts are to specify the additional energy term (always being a constant) of
a given phase.

Phase name: <Name of a phase>

Specify the name of the (stoichiometric or solution) phase with the addition.

Addition to G per mole formula unit: <xxxxx>

The value (xxxxx) given is added to the Gibbs energy of the (stoichiometric or solution)
phase. It can represent a nucleation barrier, surface tension, elastic energy or whatsoever.

It is not composition-, temperature- or pressure-dependent.

PRESENT_PHASE

Specify the name of the present phase a the name of the phase that should be present at all
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calculated equilibria:

Present phase:

Phase name: <Name of a phase>

Console Mode examples tcex45, tcex46 and tcex47 use this advanced option.

T-ZERO_TEMPERATURE

Name of first phase: <Phase A>

Name of second phase: <Phase B>

The names of phases A and B must be given, for which the T0 temperature (where the Gibbs
energies are equal) is to be calculated.

If the T0 temperature between the two specified phases is successfully calculated, a
message displays, e.g.

The T0 temperature is 840.82 K. Note: LIST-EQUILIBRIUM is not relevant

The first message shows the calculated T0 temperature between the two specified phases.

The second message indicates that after this option calculation with LIST_EQUILIBRIUM is
irrelevant and does not list the equilibrium for the system at the T0-temperature.

PARAEQUILIBRIUM

Name of first phase: <Phase A>

Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium state is to
be calculated, must be entered subsequently or on the same (first) line at once then
separated by an empty space, e.g. FCC#1 BCC or FCC#2 M23C6.

You need to understand what you are dealing with in terms of calculating a
paraequilibrium state between the two specified phases.

Specifically, there are four distinguished cases to understand: (1) both chosen phases must
have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component
(s) occupy; (2) the choice on the target phase pair must be reasonable for the defined
system and specified initial overall composition; (3) both target phases should have phase
constitution definitions that cover all the defined substitutional and interstitial components
of the current alloy system; or (4) it is impossible to calculate the paraequilibrium state
between the target phase pairs with given interstitial component(s) in the currently defined



Thermo-Calc Documentation Set

Equilibrium Calculations with the POLY_3 Module ǀ 181 of 370

system.

Fast diffusing component: /c/: <interstitial component(s)>

Fast diffusing component: /none/: <interstitial component(s)>

The name(s) of the fast-diffusing component(s) (C as the default single component) must be
given at the above prompts subsequently or at the same (first) prompt. It is possible to
specify more than one interstitial component as fast diffusion species.

Note the following:

Such specified interstitial component(s) must be appropriately defined according to the
phase constitution definitions of the two selected phases: these must be located on the
interstitial/vacancy sublattices in both chosen phases;

If there is only one fast-diffusing component which is carbon, press the <Enter> key to accept
the default input at the first prompt; if the single fast-diffusing component is another
element (e.g. N), type its name at the first prompt;

If there are two or more fast-diffusing components (e.g. C and N), type their names at the
above prompts subsequently or at the same (first) prompt (separated by an empty space,
such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt, i.e. by
pressing <Enter> key to start the paraequilibrium point calculation;

If NONE or a non-existing component name is typed at the first prompt, it means no back
diffusion is to be considered, and the para-equilibrium calculation is thus canceled entirely.

If the paraequilibrium state between the two specified phases is successfully calculated, the
messages displays e.g.

NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N = 4.1548129E-03

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N = 2.3781027E-04

All other compositions the same in both phases

Note: LIST-EQUILIBRIUM is not relevant

The first and second lines list the phase amounts expressed in mole-percent [NP(phase)] and
the contents of the interstitial components C and N in a specific phase expressed in the so-
called u-fractions [u-f(phase,C) and u-f(phase,N)], for the phase A (in this case as FCC) and
phase B (in this case as BCC), respectively. The third line states that the compositions of the
matrix component and all the remaining compositions (regarding substitutional
components) in both the target phase A and target phase B are the same at the current
paraequilibrium state, while these are not shown on screen. The last line indicates that after
this advanced-option calculation the LIST_EQUILIBRIUM command is irrelevant and does not
list the paraequilibrium state for the system at the current condition.
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However, if the single-point calculation of the paraequilibrium state between the two
specified phases has failed, these messages display:

*** Error    4 in ns01ad

*** Numerical error

This implies that the chosen target phase pair may be unreasonable for the defined alloy
system or for the defined initial overall composition, or one or both phases may have
inappropriate phase constitution definitions regarding the specified interstitial component
(s). Then, you must either modify the settings of initial overall composition or specify the
reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in
the defined alloy system.
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STABILITY_CHECK

Stability check on? /y/: <y or n>

The default is Y to switch on the automatic stability check during all subsequent single-point
equilibrium and MAP/STEP calculations. By answering N, there is no stability check in various
calculations.

Check also for unstable phases? /Y/: <Y or N>

If the automatic stability-check option is switched on choose to also check the stability for
unstable phases. The default is Y and if an unstable phase is found to be located in a
miscibility gas during a subsequent single-point equilibrium or MAP/STEP calculation, a
warning message informs you to selectively make adjustments in the calculation settings
[e.g. suspending the unstable phase, or using FORCED automatic start values for phase
constituents by the S_A_S_V F command-sequence, or creating other composition sets, etc.].
By answering N the stability check is enforced only to stable phases in the system.

TOGGLE_ALTERNATE_MODE

Set alternate toggle to DEFAULT, ALWAYS, or NEVER?

Set global toggle to DEFAULT, ALWAYS, or NEVER?

DEFAULT means that the experiment points are calculated according to the Alternate
Technique depending on the SET_ALTERNATE command.

ALWAYS means the experiment points are always calculated according to the Alternate
Technique even if the Alternate Mode is switched off in the PARROT module.

NEVER means the experiment points are calculated as normal equilibria even if you SET_
ALTERNATE in the PARROT module.

SHOW_FOR_T=

Temperature (K) /298.15/: <temperature_in_K>

Specify the new temperature condition (in K) under which the values of some specific state
variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic
properties of the entire system, of components, or of phases) in the currently-defined system
(being in a frozen state) is shown on screen.

State Variable or symbol /VM/: <state variable or symbol name(s)>

Specify the name(s) of the desired state variable(s) or derived/partial variable(s) or defined
symbol(s) for various thermodynamic properties of the entire system, of components, or of
phases) in the currently-defined system. More than one state variable or symbol of interest
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can be simultaneously specified on the same line. For example, you can choose to show the
values of VM or GM (i.e. molar volume or molar Gibbs energy of the entire system), or of
VM(*) or HM(*).T (i.e. molar volumes or isobaric heat capacity of all phases), or of ACR(*),
DGM(*) and LNACR(*,FCC) [i.e. activities of all system components, driving forces for all
phases, and activities (in logarithm) of all system components in the FCC solution phase],
under the new temperature condition (being in a frozen state).

OUTPUT_FILE_FOR_SHOW

A window opens with a default name for the file tc_show.dat. Choose a location to save the
file and click Open.

AMEND_STORED_EQUILIBRIA
This command gives information about the calculated blocks (and phase regions included in
blocks) after the STEP or MAP calculation(s). It allows you to list all or part of the calculation
results, to suspend all or parts of the calculation results that are redundant or where
metastable equilibria are calculated, and to restore all or parts of the calculation results (if
having been suspended by another AMEND_STORED_EQUILIBRIA command).

The workspace for storing equilibria may overflow during stepping or mapping, and is then
written to a file as blocks. Each block usually contains one or more ranges of equilibrium
regions.

Use one these options:

l L to list the calculated equilibria (all or a specified block)

l S to suspend everything (all blocks and their regions)

l Q to suspend each set of equilibria individually (specified blocks and/or regions)

l R to restore everything (all blocks and their regions)

Syntax AMEND_STORED_EQUILIBRIA

Prompts

Name: <Name of a defined table>

List (L) the calculated equilibria, suspend everything (S) or suspend each set of
equilibria individually (Q), or restore everything (R).

Block /*/: <Block number>

Specify a block number in the option L, S, Q or R. Or include all the blocks in
the amending option, by accepting the wildcard * (press <Enter>).

For L, a block (if a block number is specified) or all the blocks (if the wildcard *
is accepted/used), with the regions and the equilibrium details, that are
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Syntax AMEND_STORED_EQUILIBRIA

calculated during stepping or mapping is listed on screen or in a textual file.

For Q, each ranger in a block (if a block number is specified) or in all blocks (if
the wildcard * is accepted/used) then choose:

S(uspend) K(eep) /K/: <S or K>

For S or R, if a block is specified, you are asked what region in the block should
be suspended or restored. However, if the wildcard * is accepted/used, you
are asked the following:

Really suspend all /N/: <Y or N>

Really restore all /N/: <Y or N>

If the answer is N, the program asks for which block(s) and which region(s) in a
certain block to execute the S or R action.

Really suspend all /N/: <Y or N>

Y suspends everything.

Really restore all /N/: <Y or N>

Y restore everything.

Range: <Range(s) of region>

Specify one or more ranges to be suspended (the S option) or restored (the R
option). The wildcard * suspends or restores all ranges in the specified block.

In order to know the ranges the LIST option must first be used.

S(uspend) K(eep) /K/: <S or K>

The Query suspend option (Q) asks for each region in a certain block if it
should be suspended or kept. Suspended regions are not included on
sequentially generated plots.

Output file: /Screen/: <File name>

This prompt is only for listing (the L option), and after it the command is
terminated. The file name must be given here; or accept the default Screen
(terminal) by pressing <Enter>. A list of stored equilibria as various blocks
(with all their ranges) are shown out on screen or the file.
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CHANGE_STATUS
In the POLY module, set the status for components, species and phases in the defined system
for all the sequential calculations (single-point, stepping and mapping) in equilibrium or
local/partial equilibrium state. Each component, species and phase has a status. The default
status is ENTERED.

The most important use is to calculate metastable equilibria and metastable phase diagrams
by setting some phases (that would otherwise be stable) to the SUSPENDED or DORMANT
phase-status. Another important applications is to calculate paraequilibria by setting some
components to the SPECIAL component-status.

For a component and for a species, the status can be one of the following:

l ENTERED - the component(s) or species are included in the calculation. This is the
default status.

l SUSPENDED - the component(s) or species are not considered in the calculation.

l SPECIAL means - specified component(s) are not included in summations for mole or
mass fractions. It only works for component(s).

Only component(s) can have the status SPECIAL, which implies that these are
not included in summations for mole or mass fractions.

For example, for the u-fractions or other normalized fractions, when one or more of the
components are excluded from the summation, you must specify which component(s) should
be excluded from the calculation of mole or mass fraction. This component status is
particularly useful when calculating paraequilibrium states. Such component(s) are normally
interstitial component, and must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command.

Syntax CHANGE_STATUS

Prompts
For phases, species or components? /Phases/: <keyword>

Keyword = phase or species or components

Phase name(s): <Name(s) of the phase(s)>

For phase as the keyword, the names of the phases that have their status
changed must be given (all on one line). A comma or space must be used as
separator. The status to be assigned to the phases can also be given on the
same line if preceded with an equal sign =.
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Syntax CHANGE_STATUS

An asterisk, *, can be used to denote all phases. The special
notations *S, i.e. a wildcard * directly followed by an S, sign,
means all suspended phases. In the same way, *D means all
dormant phases, and *E means all entered phases.

Name(s): <Name(s) of the Species or Component(s)>

For species or components as the keyword, the names of the species or
components that have their status changed must be given (all on one line). A
comma or space must be used as separator. Similarly to the case of phase as
the keyword, the status to be assigned to the species or components can also
be given on the same line if preceded with an equal sign =.

An asterisk, *, can be used to denote all species or components.
The special notations *S, i.e. a wildcard * directly followed by an
S, sign, means all suspended species or components. In the same
way, *E means all entered species or components.

Status /Entered/: <New status>

The new status to be assigned must be given.

For species, the values ENTERED or SUSPENDED can be used.

For components, the status ENTERED, SUSPENDED or SPECIAL can be given.
SPECIAL means that this component is excluded from sums for mole fractions
and mass fractions, which is useful when calculating the ufractions or other
normalized fractions of system components.

For phases, the status ENTERED, SUSPENDED, DORMANT or FIXED can be given.
DORMANT means the same as suspended but the driving force is calculated.
FIXED means that it is a condition that the phase is stable at a certain amount.

For example, for the ufractions, when one or more of the components are
excluded from the summation, you must specify which component should be
excluded from the calculation of the mole fraction. This component must have
the status SPECIAL. This is assigned by the CHANGE_STATUS command: Change_
Status comp C=special.

Start value, number of moles /0/: <Initial amount>

For ENTERED phases, an initial amount of the phase can be given.
Normally, 0 is given if the phase is not likely to be stable, and 0.5 or 1 or any
positive number if the phase could be stable, but such an initial amount is only
used as the rough starting estimation in the equilibrium calculations.
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Syntax CHANGE_STATUS

Number of moles /0/: <Equilibrium amount>

For FIXED phases, the equilibrium amount of the phase [always using an
initial estimation being the NPF(phase) value which it is the normalized mole
number of components (per mole formula unit) of the specific status-fixed
phase] must be given. If the equilibrium amount is zero, then the phase is at its
stability limit.

Special attentions should be paid when specifying a FIXED phase status in
equilibrium calculations (for single points, stepping or mapping calculations),
as described below:

The phase amount variables, NP(phase), BP(phase) and VP(phase), as well as
all their M/W/V-suffixed quantities, should not be used as conditions. Instead,
use the CHANGE_STATUS command to set a relevant condition, e.g. CHANGE_
STATUS phase <phase>=fix <amount> where the fixed <amount> is roughly
the same as the F-suffixed quantity NPF(phase).

The NPF(phase) quantity is the normalized mole number of components (per
mole formula unit) of the specific phase in the defined system, which unlike
other F-suffixed state variables [e.g. GF(phase), HF(phase) and DGF(phase)]
cannot be directly applied in any POLY command, implying that it cannot be
directly evaluated or listed/shown. If intended to shown such a normalized
phase amount value in an equilibrium state, you should use a properly-entered
symbol (function or variable), for example: NPFabc = NP(abc)/NA or NPFabc
= NPM(abc)/NA*N. N is the total system size (in mole). The NA value is a
quantity that is phase-dependent (and sometimes also equilibrium-dependent
for ionic solution phases), and is the total atomic number in a mole-formula-
unit of the specific phase abc (excluding interstitial component and, of course,
vacancy).  For example, the SIGMA, FCC, BCC and LIQUID phases (among
others) in a defined Fe-Cr-Ni-C-N-O system (retrieved from a specific
database) may be modeled by certain models, and their NA values must be
evaluated in different ways, as described below:

LIQUID (C,Cr,CrO3/2,Fe,FeO,FEO3/2,N,Ni,NiO)1 NA = 1

FCC_A1 (Cr,Fe,Ni)1(Va,C,N,O)1 NA = 1

BCC_A2 (Cr,Fe,Ni)1(Va,C,N,O)3 NA = 1

SIGMA (Fe,Ni)8(Cr)4(Cr,Fe,Ni)18 NA = 30

If in the same Fe-Cr-Ni-C-N-O system the liquid solution phase is modeled by
the Two-Sublattice Ionic Liquid Model, i.e.:

IONIC_LIQ (Cr+3,Fe+2,Ni+2)p(VA,C,N,O-2,FEO3/2)q,7
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then the evaluation of its NA value becomes even more complicated:

NA = p + q*yC2 + q*yN2 + q*yO2-2 + q*yFeO2 3/ 2

where the stoichiometric coefficients p and q are also dependent upon the
real equilibrium state (rather than having fixed values in the system). Similar
situations occur for other (solid) phases which are described by a multiple
sublattice model with ionic constituents, such as SPINEL and HALITE phases in
some databases.

There is no strange thing when using a zero value [i.e. 0] in a FIXED phase-
status, since it means the specified phase is stable in equilibrium state but has
a zero-amount of mass in the equilibrium calculations; in other words, on a
phase diagram, the specific phase is on a zero-fraction line (ZFL), i.e. it starts
becoming stable on one side of a corresponding phase-boundary line or
unstable on the other side of the same boundary. It is often and efficient to do
so when calculating e.g. solidus equilibrium states.

However, when a non-zero value [it must always be positive; e.g. 1 or 0.5 or
0.3 or 1.5] is to be specified in a FIXED phase-status, it is unnecessarily the
exactly same stable amount of the specific FIXED-status phase in a calculated
equilibrium state any longer; instead, the <equilibrium amount> value is the
NPF(phase) value that is only roughly used as the estimated starting-value of
the FIXED-status phase in the equilibrium calculations.

Therefore, a FIXED-status for a liquid phase being unity does not necessarily
imply that it is a liquidus equilibrium state (where the liquid phase is in
equilibrium with some solid phases but the liquid phase takes all the mass in
the defined system). A unity value for setting the liquid phase status in
calculating liquidus equilibrium state can only be used when the liquid mixture
phase is predefined as a single-sublattice solution phase (such as metallic
liquid phase in multicomponent alloy systems) and the total system size as one
mole (i.e. N=1).

When a phase is described by a solution model in which two or more
sublattices are considered and these sublattice sites may also have different
stoichiometric coefficients [meaning that the mixture phase could have more
than one atom in formula [NA>1; see some examples above], the unity value
should not be used when setting the FIXED status for the phase; instead, you
should use an appropriate value that ranges from 0 to a NPF(phase) value that
equals to or is smaller than 1/NA (if the total system size N=1) or 1/NA*N (if N
differs from unity). For this reason, if a multicomponent system bears an
IONIC_LIQUID phase that is described by the Two-Sublattice Ionic Liquid Model
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(or any other multiple-sublattice ionic solution phases), it is difficult to use a
proper NPF(ION_LIQ) value in setting its FIXED phase-status, because that
should be less than (or equal to) the complex value of

N/[p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2 ].

Examples

For example, to obtain the metallic fraction in a system with carbon as an interstitial
component, you can set the component status for carbon as SPECIAL:

Change_Status comp C=special

The SUSPENDED status for components and species does not always work as
expected.

For a phase, it may have one of these statues:

l ENTERED - the phase(s) are included in the equilibrium calculations and these are
stable if that minimizes the total Gibbs energy in the defined system. This is the
default status for all phases already retrieved from the chosen database(s). An
ENTERED phase-status is always associated with an initially-estimated amount [in
mole number; normally, as 0 if the phase is not likely to be stable, and as 0.5 or 1 or
any positive number if the phase could be stable] but it is only used as the rough
starting value in the equilibrium calculations.

l SUSPENDED - the phase(s) are not considered in the equilibrium calculations.

l DORMANT - the phase(s) are not considered in the equilibrium calculations but their
driving forces for precipitation are calculated.

l FIXED - it is an equilibrium condition that the status-fixed phase must be stable, and
be in equilibrium at a specified amount [always using an initial estimation being the
NPF(phase) value which it is the normalized mole number of components (per mole
formula unit) of the specific status-fixed phase]. See more descriptions at the end of
this command.

COMPUTE_EQUILIBRIUM
The full equilibrium state is calculated for the given set of conditions. The Global
Minimization Technique is by default enforced in this command (C_E), while it can be
disabled temporarily (for the current single-point equilibrium calculation) if using C_E – or
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C_E * command-combination, or permanently (for all the sub sequential single-point
calculations or stepping/mapping calculations within the current TCC run) if having
decisively switched it off by a user (or possibly in some special modules) through changing
the minimization option using the "ADVANCED_OPTIONS" on page 174 → MINIMIZATION_
OPTION command-sequence.
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Prompt

The C_E command can be used, in order to enforce the ordinary POLY
minimization routines in an equilibrium calculation; this is because of that the
ordinary C_E command is now associated with the Global Minimization
Technique, and only after the Global Minimization

If technique is permanently switched off the C_E command makes no
difference from the C_E – command-combination.

Only certain types of equilibrium conditions [e.g. T, P, N, N(<component>), X
(<component>), B, B(<component>), and W(<component>)] are fully supported in
the Global Minimization mode (called Direct Global Minimization); and when
other types of equilibrium conditions are used, after the initial POLY, a Global
Minimization test and corrections are performed until the lowest minimum is
found (called Indirect Global Minimization).

If there is any problem with convergence, you may try the C_E * command-
combination. The character * enforces the command to use an advanced
technique to obtain a complex equilibrium. However, after a successful C_E
*calculation, you may repeat the C_E command and can check the status of
phases, species or components (with "LIST_STATUS" on page 210 → CPS
command-sequence) and equilibrium conditions (with "LIST_CONDITIONS" on
page 209) and list out the calculation results (with "LIST_EQUILIBRIUM" on
page 209), because such actions may tell you how to further modify various
settings for your current calculation. This command-combination is not that
useful anymore, because the Global Minimization Technique that is always
associated with the C_E command is even more powerful and more precise in
finding the most-stable equilibrium state in a complex heterogeneous
interaction system; therefore, the C_E * command-combination is functional
and can be used only after the Global Minimization mode has already been
disabled temporarily or permanently.

Some phases that are not stable in the current equilibrium state may not have
their most favorable composition after this command, and thus their driving
forces may not be correct. You can force the program to correctly calculate the
driving forces of metastable phases, by giving repeated C_E commands until
the number of iterations (that is shown on screen after this command) is
reduced to 2.

Also see the POLY command "SET_NUMERICAL_LIMITS" on
page 296 which can set the approximate driving force for
metastable phases option on or off in all the subsequent POLY
calculations within the current TCC run.
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If an equilibrium state for the defined system is not found, an error
message is given.

You can try repeating this command a few times, or change some of settings
for the numerical limits, for starting variables and starting values, for starting
constitutions of certain phases and for reference states of certain components,
or to verify some of the defined conditions.

COMPUTE_TRANSITION
This command is a combination of the CHANGE_STATUS, SET_CONDITION and COMPUTE_
EQUILIBRIUM commands. It allows a direct calculation when a new phase may form by
varying one of the already-set conditions. It can be used only after at least one equilibrium is
calculated successfully; otherwise, you are informed on the necessity of first making an
equilibrium calculation to find out the stable phases under the current conditions.

When this command is used, the program calls the command "CHANGE_STATUS" on
page 100 to temporarily change the phase status of a specified phase as FIXED at the zero
amount, and at the same time to temporarily release one of the existing equilibrium
conditions (which is chosen by you). The program calculates a new equilibrium in which that
specific phase is stable but its equilibrium amount in the system is zero. The released
condition is then assigned with a calculated value that ensures the calculated equilibrium.
After wards, the program automatically changes the phase status of that specific phase back
to ENTERED, and resets the temporarily released condition as one of the conditions and
assigns it with the value that is calculated to ensure the zero-amount formation of that
specific phase.

This command is useful to find melting temperature, boiling temperature, or solubility
limits, and generally when you want to set the most optimal conditions for calculating an
equilibrium where a specific phase becomes stable. It can also be used when you want to
know exactly how far away the defined conditions are from the value that can ensure a zero-
amount of a specific phase in the system when other conditions remain the same.

After a successful COMPUTE_TRANSITION calculation, you can issue a "COMPUTE_
EQUILIBRIUM" on page 190 calculation to assure the calculated transitional equilibrium is a
really stable one, and can also use "LIST_EQUILIBRIUM" on page 209 to see the details of
transitional equilibrium state.
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Prompts

Phase to form: <Phase name>

A new phase name, e.g. BCC that is expected to form, is specified here. This
changes the status of this new phase to be FIXED as 0 amount, and the
program shows the information such as:

You must remove one of the these conditions

P=100000, T=800, N=1, X(FE)=.5   DEGREE OF FREEDOM 0

If the key word ANY is used when prompted for Phase to form (instead of a
specific phase name), it is possible to find out any new phase to be formed, in
a given varying direction sign and at an estimated change of the released
condition: a negative sign means at a lower value of the released condition
any new phase is to be found, and a positive sign at a higher value; an
estimated change of the released condition implies where any new phase is
expected (but it is only estimated value, so any value within its reasonable
scale would be enough). Such calculations can be repeated if required. This
feature is useful to find out all possible phase transformations along a certain
released condition.

Give the state variable to be removed /T/: <One condition>

One condition must be removed, in order to calculate the transition
equilibrium where the specified (or any) new phase to be formed at a
calculated value of this released variable.

Therefore, the message may display (after a successful calculation) if, for
example, X(Fe)is entered:

To form BCC the condition is set to X(FE)=.48605791769

This calculated value is assigned as the parameter of that removed condition,
in this case, the X(FE) variable. If the LIST_CONDITIONS command is typed
this message displays:

P=100000, T=800, N=1, X(FE)=4.86057918E-1

DEGREES OF FREEDOM 0

If the key word ANY (instead of a specific phase) is given as the phase name
when it is prompted for Phase to form, the line is prompted for a given varying
direction sign and an estimated change of the released condition before the
calculation of transition equilibrium:

Estimated change (with sign) /1/: <+/-#>
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A given varying direction sign and an estimated change of the released
condition, in this case as X(FE), must be given here: a negative sign means at
a lower value of the released condition any new phase is to be found, and a
positive sign at a higher value; an estimated change of the released condition
implies where any new phase is expected (but it is only estimated value, so
any value within its reasonable scale would be enough). For example, if a
combination of -0.02 is input, this message may display (after a successful
calculation):

To form BCC_A2#1 the condition is set to X(FE)=.493708756187

This calculated value is then assigned as the parameter of that removed
condition, in this case, the X(FE) variable. The message is shown if the LIST_
CONDITIONS command is typed:

P=100000, T=800, N=1, X(FE)=4.93708756E-1

DEGREES OF FREEDOM 0

CREATE_NEW_EQUILIBRIUM
During data-assessments using the PARROT/ED_EXP modules, you can, in the POLY module,
create several equilibria with different sets of conditions and phases (but normally with the
same set of components). By default, there is one equilibrium. To keep the set of conditions
and phase for this equilibrium, create another one using this command, and use another set
of conditions for that. Two equilibria may be useful to calculate easily the enthalpy
difference between two states. In the PARROT module, the experimental information is
stored as a sequence of equilibria.

Syntax CREATE_NEW_EQUILIBRIUM

Prompts

Equilibrium number /2/: <A new equilibrium number>

Each equilibrium in the POLY3 workspace is identified by a unique
integer number. Such an equilibrium number can be recalled with
"SELECT_EQUILIBRIUM" on page 216.

Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all
components and phases (initiation code 2), ENTER the components
only (initiation code 1) or SUSPEND everything (initiation code 0). No
other values are legal.
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The entered components and phases can later be
changed with "CHANGE_STATUS" on page 100.

DEFINE_COMPONENTS
Change the set of components. By default, the elements are used as components. The set of
components can be important because some conditions are set using components, for
example, the amounts, activities or chemical potentials.

For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components,
thus replacing the default FE, SI and O.

This implies a command "REINITIATE_MODULE" on page 215 and it should be
given as the first command in the POLY module.

Syntax DEFINE_COMPONENTS

Prompt

Give all new components / existing components/: <New components>

The new components must be specified all on one line. These replace the
existing component definitions.

The number of components cannot be changed with this command.
Use "CHANGE_STATUS" on page 100 instead.

To keep some existing components, it is recommended that you also enter
these on the line. Otherwise, the added new components may not be defined
correctly. This is especially important if some components are built out of
several elements.

The new components do not have to be present as species.

DEFINE_DIAGRAM
This allows automatic calculation and plotting of a diagram with a single command. It is the
same as the DEFINE_MATERIAL command up to when the first equilibrium is calculated. The
alloy OPTION feature is also available in this command to specify alloying compositions for a
special alloy predefined by the OPTION keyword in a selected database (e.g. the TCNI Ni-
based Superalloys Database).

Use this command to calculate all types of phase diagrams after specifying all composition
value and an initial temperature (if temperature is used as an axis). However, for binary and
ternary diagrams, the special BIN and TERN modules may be preferred.
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It then lists all the independent variables for the defined system (i.e. temperature and the
components) and asks for a variable as the X-axis. You must also specify a maximum and
minimum for the X-axis. The second axis (Y-axis) can be another composition (or the
temperature if that is not on the X-axis) from the independent variable list. The program
then calculates and plots a phase diagram, as there are two independent quantities on the
axes.

Alternatively, select a dependent quantity as the Y-axis variable from the second list on
screen (e.g. the amount of all phases, composition of a specific phase, or fractions of a
component in all phases), and the program calculates and plots how this quantity depends
on the condition on the X-axis. This is a property diagram.

This command ends up within the POST module monitor. You can refine the calculated
phase diagram or property diagram.

Moreover, many more property diagrams with axes other than compositions can also be
plotted (after the calculation), using "SET_AXIS_VARIABLE" on page 218 in the sequent POST
monitor.
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Prompts

These prompts are given:

Same elements as before /Y/? <Y or N>

Mole percent of <Element> /##/: <Value> 

or

Mass percent of <Element> /##/: <Value>

Database /ABCDE/: <Database name>

Major element or alloy: <Element name>

Composition in mass (weight) percent? /Y/: <Y or N>

1st alloying element: <Element name>

Mass (weight) percent: <Amount of the above specified element>

2nd alloying element: <Element name>

Next alloying element: <Element name>

Mass (weight) percent: <Amount of the above specified element>

Temperature (c) /1000/: <Temperature of interest in oc>

Reject phase(s) /none/: <List of phase(s) to be rejected>

Restore phase(s) /none/: <List of phase(s) to be restored>

OK? /Y/: <Y or N>

Should any phase have a miscibility gap check? /N/: <Y or N>

Phase with miscibility gap: <phase name>

Major constituent(s) for sublattice #: /aa/: <Constituent(s)>

Phase with miscibility gap: <Phase name>

The first equilibrium is calculated, as with "DEFINE_MATERIAL" on page 200.
Then a list of all independent conditions suitable to be chosen as X/Y-axis
variables is given by the program.

Quit? /y/: <y or n>

This question is asked only when the axis variables are already defined, or if
the command DEFINE_DIAGRAM is used. It then offers an opportunity to quit
(Y) the calculation or to continue (N) the calculation but by defining other axes.

Give the number of the condition to vary /1/: <a condition
index>
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Select one of the independent conditions by giving its index on the condition
list as the X-axis variable.

Minimum value /XXX/: <minimum value for X-axis>

Specify the minimum value of the chosen X-axis variable. A default value is
shown automatically by the program; press <Enter> to accept it or input
another value.

Maximum value /YYY/: <maximum value for X-axis>

Specify the maximum value of the chosen X-axis variable. A default value is
shown automatically by the program; press <Enter> to accept it or input
another value. Then another list with some dependent quantities is given by
the program, which can be selected as the Y-axis variable.

Give the number of the quantity on the second axis /#/: <##>

Select one of the independent conditions or dependent quantities as the Y-axis
variable, by giving its corresponding index given on the condition lists.

It must be different from the X-axis variable already selected.

If selecting one of dependent quantities (by giving the corresponding number
from the second list) as the Y-axis, then a property diagram is to be
automatically calculated (through a normal stepping procedure) and
generated. For composition of a phase the phase name is asked for further
specification subsequently.

If selecting any of the other independent variables (conditions) on the first list
as the Y-axis, then a phase diagram is automatically calculated (through a
mapping procedure) and plotted.

Name of phase: /ABC/: <phase name>

This is prompted only in case of that the composition of a phase is selected
as the Y-axis variable. The phase name for which the composition varied along
with X-axis variable should be specified.

Multiple start points? /Y/: <Y or N>

This question is to confirm whether or not to let the program to automatically
generate and use multiple start points for mapping the defined phase
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diagram.

Save file /RESULT/: <file name>

The file name where the calculations are stored (saved as a *.POLY3 file)
should be specified; the default file name is RESULT.POLY3 (Windows) or
RESULT.POLY3 (Linux).

DEFINE_MATERIAL
Read data for a system from a database in the POLY module. It is convenient to use for
alloys when there is a major component and the amount of the other elements is known in
mass (weight) fraction. The command reads the system from the specified database, sets
the composition and temperature (and pressure equal to 1 bar) and calculates the
equilibrium state before the prompting for a new command. You can list the results with
"LIST_EQUILIBRIUM" on page 209 or set a new composition or set axis for a STEP or MAP
command.

You cannot append data from different databases in this way. Use this command
with data from a USER database.

Syntax DEFINE_MATERIAL

Prompts

Same elements as before /Y/? <Y or N>

This question is asked only if some data is already read from the database, or
if the command DEFINE_MATERIAL or DEFINE_DIAGRAM is used. It then offers
a convenient way to change the composition and temperature with one
command.

This command only works properly in cases where the
composition of the material system is already defined as in the
mole-percent or mass-percent unit.

Mole percent of <Element> /##/: <Value>

or

Mass percent of <Element> /##/: <Value>

If you have decided to use the same materials system (available in the current
POLY3 workspace) by accepting the default answer (Y) to the previous prompt
Same elements as before /Y/?, one of the alternative prompts display for
each of the components in the defined system, depending on how the
composition is defined (either in mole-percent, or in mass-percent).
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Prompts are repeated until all the defined components are completed. Then,
the program prompts to specify the temperature condition.

Database /ABCDE/: <Database name>

The database with the description for the material must be given, or press
<Enter> if using the current database. It is possible to give a USER database.

Major element or alloy: <Element name>

The material must have a major element, usually the element which is present
in the largest amount. The fraction of this element is not set but is the rest.

In some databases there are the alloys predefined. An alloy has a default
major element and have limits of the amounts of the alloying elements. If you
stay within these limits the calculation gives reasonable results.

Composition in mass (weight) percent? /Y/: <Y or N>

The default is that input is taken as mass percent, but it is possible to change
to mole percent by answering N.

Composition should be given in PERCENT not FRACTION, as it is
required for the W and X state variables in the "SET_CONDITION"
on page 220 command.

1st alloying element: <Element name>

The first alloying element must be given.

All alloying elements are asked for in a sequence. These can be given in any
order. You must know if you are present as assessed systems in the database.
There is no error or warning messages if data are missing. Check the
documentation of the database selected.

If an alloy is selected, a list of legal alloying elements and their maximum
percent is listed on-line.

Mass (weight) percent: <Amount of the above specified element>

The amount of the alloying element in mass (weight) percent. Using the
DEFINE_MATERIAL command you cannot use the normal flexibility of Thermo-
Calc for conditions, but all must be given in mass percent. However, you can
after wards change the conditions using the SET_CONDITION command.
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2nd alloying element: <Element name>

The second alloying element must be given. If only one, press <Enter>. If an
element name is given then the program asks for its mass fraction.

Mass (weight) percent: <Amount of the above specified element>

The amount of the above specified alloying element in mass (weight) percent.

Next alloying element: <Element name>

Continue giving elements and mass (weight) fractions until all elements
specified. When all alloying elements and their compositions (as in the above
prompt) are specified, press <Enter> as answer to this question to finish the
materials definition.

Temperature (C) /1000/: <Temperature of interest in oC>

POLY makes the first calculation after retrieving the data for this temperature.
By pressing <Enter> to accept the default temperature. The value should be
given in Celsius (oC).

The pressure is set to 1 bar.

Reject phase(s) /None/: <List of phase(s) to be rejected>

This is a question generated by the database allowing you to select the phases.
Normally, all phases should be included when you press <Enter>. If a phase is
to be rejected, the name of the phase must be supplied. Several phase names
can be specified in one line. It is possible to reject all phase by giving an
asterisk *. If the number of phases to be included is much smaller than the
total number of phases, it may be convenient to first reject all phases and then
restore those that should be included. The question is repeated until you press
<Enter> after rejecting all unwanted phases or an asterisk *.

Restore phase(s) /None/: <List of phase(s) to be restored>

You can restore phases that are accidentally or deliberately rejected. It may
also be possible to restore some hidden phases.

If phases are to be restored the name of the phases must be supplied. Several
phase names can be specified in one line. It is possible to restore all phase by
giving an asterisk *. The question is repeated until you press <Enter> after
restoring all desired phases.

OK? /Y/: <Y or N>
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All phases to be selected from the database are listed and the selection
confirmed. If there are any errors or you want to amend the selection, answer
N and you are returned to the question about rejecting phase(s).

If the selection is confirmed by answering Y the software retrieves all
thermodynamic data and available references from the chosen database.

Should any phase have a miscibility gap check? /N/: <Y or N>

The database usually creates two or more composition sets for phases that can
have miscibility gaps. However, for some phases this is not done
automatically, for example the miscibility gap in the bcc phase in Fe-Cr is
usually ignored. But if it is important to include a Cr-rich bcc phase, specify
this here. It costs some computation time and may make the subsequent MAP
or STEP more difficult to converge.

If you do not want to have any phase with a miscibility gap in the calculation,
press <Enter>. Then, the DEFINE_MATERIAL command starts calculating the
equilibrium, and is terminated.

To set such a phase with miscibility gaps in the calculation, answer Y. Then the
software asks questions about the phase names and their constitutions, such
as:

Phase with miscibility gap: <Phase name>

You must supply the phase name, which has a miscibility gap under the
specified system and conditions.

Major constituent(s) for sublattice #: /AA/: <Constituent(s)>

The software shows a default constituent in the sublattice #(1,2,3,…),
according to the existing phase definition in the chosen database. You can
specify one or more major constituents for the sublattice # in the phase.

This question is repeated until all sublattices are specified.

Phase with miscibility gap: <Phase name>

You can supply another phase name with a miscibility gap under the specified
system and conditions, and answer the questions concerning the major
constituent(s) in associated sublattice(s).

By pressing <Enter>, the command starts calculating the equilibrium, and then
terminates.
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It is also possible to use this command to select an alloy from a
specific database (e.g. the TCNI Ni-based Superalloys Database).
Such alloys are predefined by the OPTION keyword inside the
database, and have their default major elements and composition
limits of their alloy elements.

Such alloys available in the selected database (at the prompt Database
/ABCDE/ can be listed on the screen if typing a ? mark on the prompt Major
element or alloy. When a specific predefined alloy (instead of a major
element) is selected, the major element is staked from the alloy definition and
shown on the screen (with a message like Alloy found with major
element NI).

You can only specify alloying elements and the compositions (weight percent
or mole percent). Typing a ? at any of the prompts for the alloying element
names, e.g. 1st alloying element, 2nd alloying element, lists all the
alloying elements and the composition limits in the alloy. If the composition of
an alloying element is outside of its limit, there is a message (such as Amount
above limit: 30.0000) and a prompt Override limit ? /N/. If you decide
to enforce the override by answering Y on this prompt (i.e. accepting the over-
limit alloying composition), another warning message (such as Amount of
major element below limit: 70.0000) and prompt Override limit ?
/N/. Then further decide if enforcing the overriding: if Y then accepting the
major element’s composition below the limit; if N then using the predefined
major element composition limit.

DELETE_INITIAL_EQUILIBRIUM
Delete ONE specific initial equilibrium point or ALL of the initial equilibria. The initial
equilibria are used as starting points for all the sub-sequential MAP and STEP calculations.

Also see "ADD_INITIAL_EQUILIBRIUM" on page 166.

Syntax DELETE_INITIAL_EQUILIBRIUM

Prompt Number /All/: <Number of an initial equilibrium>

Specify the number of an initial equilibrium (as a specific digit e.g. 3, or ALL) to
be deleted from the POLY3 workspaces. It is recommended to use "LIST_
INITIAL_EQUILIBRIA" on page 210 to figure out the numbers for all the existing
initial equilibrium points that have already been added (manually through
"ADD_INITIAL_EQUILIBRIUM" on page 166, or automatically by some other
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Syntax DELETE_INITIAL_EQUILIBRIUM

POLY commands) and stored in the current POLY3 workspace. By default, ALL
the initial equilibrium points are deleted.

DELETE_SYMBOL
This is a POLY3 module command.

Delete symbols (i.e. constants, variables, functions or tables. These symbols are entered with
"ENTER_SYMBOL" on page 113.

Syntax DELETE_SYMBOL

Prompt

Name: <Name of a symbol>

Specify the name of the symbol to be deleted. Only one symbol can be deleted
each time.

ENTER_SYMBOL
This command is for both the POST and POLY modules in Console Mode.

Symbols are a useful feature of the POLY and POST modules to define quantities that are
convenient. Symbols can be constants, variables, functions or tables.

Functions or tables (with defined functions as values) can be entered in the POST module
after a stepping or mapping calculation, for purposes of plotting such entered functions or
tables as axis variables.

Within the POLY module, symbols are normally defined prior to an equilibrium calculation
(enforced by a C_E command), stepping calculation (enforced by the command "STEP_
WITH_OPTIONS" on page 227) or mapping calculation (enforced by "MAP" on page 212).
These can be entered after an equilibrium calculation; however, for defined functions,
variable or tables, it requires using "EVALUATE_FUNCTIONS" on page 208 before showing
the corresponding values in the calculated equilibrium state.

The symbols entered in the POST module are not saved in the currently-loaded POLY3
workspaces. Therefore, if you want to apply such symbols in other similar calculations for
the same defined system, you must use the ENTER_SYMBOL command prior to the
STEPPING or MAPPING calculation in the POLY module.

Also see "ENTER_SYMBOL" on page 113 for the GIBBS Module.
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See example 44 in the Thermo-Calc Console Mode Examples Guide for an
example of using variables and functions.

Syntax ENTER_SYMBOL

Prompt

Constant, Variable, Function or Table? /Function/: <keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.

l CONSTANTS can only be entered once and is a means of using a name
for a numeric value. For example, the value of 1 atmosphere in Pascal
can be denoted by P0 after the command ENTER CONSTANT
P0=101325. Defined constants can be used as values in condition
assignments, for example, SET-COND P=P0.

l FUNCTIONS are expressions of state variables or other functions. These
expressions are saved, and whenever a function value is requested all
functions are evaluated. The reason for this is that they may depend on
each other.

l VARIABLES are similar to functions because they can also be
expressions of state variables. However, contrary to functions, they are
only evaluated when they are entered or if they are explicitly named in
an "EVALUATE_FUNCTIONS" on page 208 command. It is possible to
enter a variable with a new expression any time. This expression is
evaluated directly and its value stored as the value of the variable.
Defined variables can be used as values in the SET-CONDITION
command.

l TABLES are used for listing results from the STEP or MAP commands. A
table consists of a list of any number of state variables, functions or
variables. Defined tables can also be used in the post-processor POST.

There is a special connection between tables and variables. If a
variable is used in a table, it is evaluated for each line of the table
in the TABULATE command or when the table is used in a plot.

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have
maximum 8 characters.

Legal characters include letters (either UPPER or lower case), digits and
underscore _. Any other special character, such as parentheses ( and ), plus +,
minus -, slash / or \, full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line,
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Syntax ENTER_SYMBOL

these must be separated with an equal sign =, for example, TC=T-273.15 or T_
C=T273.15 which stands for a definition of temperature in Celsius. Otherwise,
these questions are asked.

For different types of symbol (constant, function, variable or table),
the questions have different prompts.

Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or
other functions, constants or variables. The expression is a FORTRAN-like
expression and operators +,  -, *, = and ** can be used (** only with integer
powers).

Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An
expression can be continued on more than one line. An expression should be
terminated by a semicolon (;) or an empty line (by pressing <Enter> at the next
prompt).

Examples of function expressions:

l GM(LIQUID): The Gibbs energy of liquid per mole component

l H.T/4.184: The heat capacity of the system in calories

l ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

l T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the
new line if one line is not enough for the function. If you finish the function
press <Enter> again.

Value: <Value for a constant>

A constant can only be assigned a numeric value once.

Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is
evaluated immediately and discarded. Only the numeric value is kept. This
gives a possibility to save a value between calculations with different
conditions because all state variables and functions are evaluated for the new
conditions.
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Syntax ENTER_SYMBOL

Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain
results from a STEP command is through a table. 

Example:

ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the
temperature, the mole fractions of C and Cr in the LIQUID phase, and the
activity of C.

To show the temperature in Celsius in a table, give the command ENTER
FUNCTION TC=T-273; and then use the symbol TC in the table.

& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new
line if one line is not enough for the table. If you finish the table press <Enter>
again.

EVALUATE_FUNCTIONS
The value of one or more or all entered functions or variables are evaluated and listed.

Syntax EVALUATE_FUNCTIONS

Prompt

Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By
typing a wildcard *, all functions and variables are evaluated.

Variables are evaluated only if these are explicitly named.

LIST_AXIS_VARIABLE
This is a POLY3 module command.

Syntax LIST_AXIS_VARIABLE

Lists all the axis variables for a stepping or mapping calculation that have
already been set by "SET_AXIS_VARIABLE" on page 218.
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LIST_CONDITIONS
This is a POLY3 module command.

All the conditions that are set by the command SET_CONDITION and the command-sequence
CHANGE_STATUS PHASE =FIXED <0 or 1 or alike>, are listed.  The current conditions are also
listed by the command LIST_EQUILIBRIUM. The degree of freedom in the defined system is
also shown up. If this is zero, you can perform a COMPUTE_EQUILIBRIUM command. If it is
larger than zero, some more conditions are required, and you must further set additional
ones, using "SET_CONDITION" on page 220 or "CHANGE_STATUS" on page 186. If it is
negative, a user has defined too many conditions and needs to take away the unnecessary
ones, using the SET_CONDITION command (with a value of NONE for the to-be-deleted
condition) or CHANGE_STATUS command (i.e. changing a FIXED status of a phase to another
type of phase status, ENTERED or DORMANT or SUSPENDED).

Syntax LIST_CONDITIONS

Example
P=100000, T=800, N(NI)=1E-1, N=1

FIXED PHASES

FCC_A1=1 LIQUID=0  DEGREE OF FREEDOM 0

LIST_EQUILIBRIUM
This is a POLY3 module command.

The result (always in SI units) from the last calculated equilibrium is listed on screen or in a
textual file.

You can also execute this command if no calculation is made or if the
calculation fails. It is your responsibility to interpret the results accordingly.

Syntax LIST_EQUILIBRIUM

Prompt

Output to screen or file /Screen/: <File name>

The name of the text file where the list of the calculation results shall be
written.

Options /VWCS/: <Option(s)>

Select the output units and formats by optionally specifying a combination of
these letters.
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Syntax LIST_EQUILIBRIUM

l Fraction order:V means VALUE ORDER; A means ALPHABETICAL ORDER.

l Fraction type: W means MASS FRACTION; X means MOLE FRACTION.

l Composition: C means only COMPOSITION; N means CONSTITUTION and
COMPOSITION.

l Phase: S means including only STABLE PHASES; P means including ALL
NON-SUSPENDED PHASES.

Default options are VWCS. If the output fraction type should be in mole fraction
(rather than mass fraction), then give VXCS or type X (implying that in this case
the options V, C and S are accepted as the listing manners for fraction order,
composition and phase).

If accepting all the default options, or if accepting all the altered options that
had already changed when using this command previously, you can type L_
E,,, or LIST_EQUILIBRIUM ,,,

LIST_EQUILIBRIUM displays ORD (ordered) or DISORD (disordered)
(when available). See "CHANGE_LEGEND" on page 246 for details.

LIST_INITIAL_EQUILIBRIA
This is a POLY3 module command.

List all the equilibria added with "ADD_INITIAL_EQUILIBRIUM" on page 166.

Syntax LIST_INITIAL EQUILIBRIA

All the initial equilibria are used for the MAP (and STEP) calculations.

LIST_STATUS
This command is for the POLY and ED-EXP modules.

List the status of components, species or phases.
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Syntax LIST_STATUS

Prompt

Specify what to list:

Option /CPS/: <keyword(s)>

keyword = C or P or S, or any combination

l C means list component status

l P means list phase status

l S means list species status

l CS for both components and species

Default is CPS.

The results depend on the key word specified in the options for "CHANGE_
STATUS" on page 100, a table with the current status of phases or species or
components, or the combinations, is shown:

l For components, the statuses and reference states are listed.

l For species, only the status is listed.

l For ENTERED and FIXED phases, the status, driving forces and
equilibrium amounts are listed.

The metastable phases are listed in descending order of stability.
To avoid long outputs only 10 metastable phases (in ENTERED
status) are listed by lines, while all other less stable phases are
merged onto one line. For DORMANT phases, their phase names
and driving forces are listed. For SUSPENDED phases, only the
phase names are listed.

LIST_SYMBOLS
For both the POLY and POST modules, list the definitions for all constants,
functions, variables and tables.

In order to find the value of a function or variable, use "SHOW_VALUE" on page 227 or
"EVALUATE_FUNCTIONS" on page 208. A table is tabulated with the TABULATE command.

Syntax LIST_SYMBOLS

The defined variables are listed up together with the defined functions, but
variable names are followed by a percentage sign %.
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LOAD_INITIAL_EQUILIBRIUM
Copies all conditions and calculated results from a specific added initial equilibrium to the
current equilibrium. The current conditions and calculation results are lost, and the newly
loaded initial equilibrium point gets into the POLY workspace.

Syntax LOAD_INITIAL_EQUILIBRIUM

Prompt

Number: <Number of an initial equilibrium>

Specify the number of an initial equilibrium to be loaded as current. The
number can be found with "LIST_INITIAL_EQUILIBRIA" on page 210.

MAP
This command starts the mapping procedure for making a calculation of phase diagrams in
a defined multicomponent heterogeneous system, from one or more initial equilibria. A
phase diagram is usually mapped within a specific space that is constructed by two (or
more) defined independent mapping axis-variables.

Syntax MAP

A phase diagram consists of mapped phase boundary lines/curves;
on one side of each such phase-boundary line/curve, the amount of
one specific stable phase is zero (i.e. the zero-fraction lines). From a
single MAP calculation, many different types of phase diagrams in
the defined multicomponent heterogeneous system can be plotted,
with some desired properties (that vary along the calculated phase-
region boundaries) plotted as X/Y-axis variables. All different types
of phase diagrams are generated by the mapping calculations
through this command.

Normally, you need to have calculated at least one initial equilibrium point and have also
defined at least two independent varying variables (i.e. the controlling conditions in the
system) that are set with "SET_AXIS_VARIABLE" on page 218. You can also have three, or
four or maximum five independent varying variables that are defined by the SET_AXIS_
VARIABLE command).

This lists the current values of each of the independent axis variables for each of the
calculated equilibrium points along each of the mapped phase boundaries, and also lists the
corresponding information when the set of stable phases changes.
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The Global Minimization Technique is by default enforced in this command while it can be
disabled if having decisively switched it off (or possibly in some special modules) through
changing the minimization option using the "ADVANCED_OPTIONS" on page 174 →
MINIMIZATION_OPTION command-sequence. You can choose how often to do a Global
Minimization test (via the Global Test Interval option) in the ADVANCED_OPTIONS STEP_
AND_MAP command-sequence.

During a MAP calculation, the values of mapped axis-variables for presenting each phase
boundary (lines/points) of the calculated phase-regions are listed, and the corresponding
stable-phase sets are shown up. You can terminate the mapping of a line by pressing a single
<Ctrl-A> (Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish
calculation without losing what is already calculated.

If there is any convergence problem in finding a stable solution at a certain stage during a
calculation procedure enforced by this command, these messages display on screen:

Convergence problems, increasing smallest site-fraction from 1.00E-30  to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run,
you can use the POLY command "SET_NUMERICAL_LIMITS" on page 296 to restore or reset
the smallest site fraction to the previous or another preferred value, as well as to reset
other numerical limits.

In particular, for phase diagrams with tie-lines in the plane (i.e. most binary systems and
ternary isotherms), there is a MAP procedure which checks for the best phase to use as axis
variables in order to ensure reasonable increments between the tie-lines. This produces
smoother curves and also gives a better stability in finding adjacent phase-regions.

Complex miscibility gaps of various solution phases are automatically detected during a
mapping calculation, and two or more composition sets for each of such solution phases are
automatically generated as well, through an automatic Global Minimization Test procedure
(by specifying a Global Test Interval value and confirming the Automatically add initial
equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a
particular case, such an automatic Global Minimization Test ensures that you can start
calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase)
where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1
miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.)
are not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may
first become metastable with a composition different from the metallic FCC_A1 phase and
later also stable. The advanced mapping procedure (enforced by the Global Minimization
Technique) inside the Thermo-Calc software (both the Console Mode and Graphical Mode)
can efficiently and effectively handle complex miscibility gaps in multicomponent
heterogeneous systems.
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To get a complete phase diagram, sometimes it may be necessary to have multiple starting
equilibrium-points, and/or to have added multiple initial-equilibrium points (through "ADD_
INITIAL_EQUILIBRIUM" on page 166) inside various phase-region boundaries under certain
direction(s).

POST

Syntax POST

Switches to the post-processor (the POST module), which has its own command
set.

See "Plotting and Visualization with the POST Module " on page 240
for all details.

READ_WORKSPACES
This command is used in both the POLY and GES (GIBBS) modules.

The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP
commands can be READ from a file where they are saved with "SAVE_WORKSPACES " on
page 54. Such an *.POLY3 file is not printable.

Syntax READ_WORKSPACES

Options

File name is the name of a saved POLY3-file where the POLY3 and GIBBS
workspaces shall be read from must be specified. You do not need to type the
extension if it is the default *.POLY3 (Windows) or *.poly3 (Linux), otherwise
type the whole POLY-file name.

A window opens so that the path (in the Look in field) and File name can be
specified. The Files of type (i.e. POLY3) cannot be changed. Click Open to open
the POLY3 and GIBBS workspaces from the saved *.POLY3 file.

When reading back an original POLY3 workspace that has already been saved
as an *.POLY3 file in the current Thermo-Calc (Console Mode) run or had been
read from an existing POLY3 file under the current work area, while some
additional changes in the settings may be made but do not need to be kept in
further steps in the current Thermo-Calc (Console Mode) run or any diagram is
plotted in the POST module, you can type READ,, or READ_WORKSPACE ,,
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RECOVER_START_VALUES

Syntax RECOVER_START_VALUES

Recovers the start values in equilibrium calculations.

REINITIATE_MODULE
Ensures that the whole POLY module (and thus the entire POLY workspace) is reinitiated to
the state as it was when first entered.

Syntax REINITIATE_MODULE

All the defined components, defined conditions, changed status, entered
symbols, defined independent axis-variables, calculated starting equilibrium-
points, added initial equilibrium points, stepped/mapped equilibrium data, and
so forth, are removed completely. The saved file name is restored to the
default.

SAVE_WORKSPACES
This command is for both the POLY3 and GES (GIBBS) modules.

Thermo-Calc allows saving the current status and workspaces of the program, including
thermodynamic data, conditions, options and results from a single, stepping or mapping
calculation on an *.POLY3 file. Do this for later use or when you need to terminate the
current Thermo-Calc (Console Mode) run.

The POLY3 and GIBBS workspaces are saved on a file with this command. In the GIBBS
workspace, all thermochemical data are stored. In the POLY3 workspace, all
thermochemical data, all the last set of conditions and equilibrium state, changed status,
entered symbols, advanced options, defined stepping/mapping variables, added initial
equilibria, stepped/mapped results, etc., are stored, so it also contain the GIBBS workspace.
After a SAVE_WORKSPACE command, you can always come back to exactly the state you
had when you issued the SAVE_WORKSPACE command by giving a READ_WORKSPACE
command.

After saving the POLY3 and GIBBS workspaces on a file, you can leave the program and at a
later time READ the file and continue from the saved state.

A STEP or MAP command automatically saves the work file with the most lately
specified name. Do not SAVE after a MAP or STEP.
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The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE
command. You may append several results obtained by sequential STEP or MAP calculations
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping
this in mind is important and useful particularly for calculating various isothermal (or
isoplethal) sections and plotting them on the same diagram in a single Thermo-Calc run.

You may append several results by STEP or MAP without destroying the previous results but
the SAVE command erases them all. To suspend some of the STEP or MAP results, use the
AMEND_STORED_EQUILIBRIA command.

When you go to a response-driven module such as POTENTIAL or SCHEIL for example, a
workspace file is automatically opened. In the workspace file, system definitions, conditions
for the calculation, calculation results, and plot settings is saved. The file is saved in the
current working directory, and is named after the name of the module that created it. For
example, the POTENTIAL module saves a workspace file called POT.POLY3 (or POT.poly3 in
Linux); the POURBAIX module saves a file called POURBAIX.POLY3; etc.

Syntax SAVE_WORKSPACES

Options

A file name must be specified. The default extension of the POLY workspace
file is *.POLY3 (Windows) or *.poly3 (Linux), while you can have any other
extension.

A Save window displays, so that the path (in the Save in field) and File name
can be specified. The file type (i.e. POLY3) in the Files of type cannot be
changed.

When saving a POLY3 workspace under a name that already exists
under the current work area, which is saved by default (after
running a special module, e.g. BIN, TERN, POT, SCHEIL and
POURBAIX) or in an earlier stage of the current Thermo-Calc
(Console Mode) run or in a previous run (which is READ into the
current POLY3 workspace), you can type SAVE,,y or SAVE_
WORKSPACE ,,y. However, this must also be avoided if some
results from previous MAP or STEP calculations shall not be
destroyed.

SELECT_EQUILIBRIUM
If you create more than one initial equilibrium (during data-assessments using the
PARROT/ED_EXP modules), you can switch between them using this command.
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Syntax SELECT_EQUILIBRIUM

Prompt

Number /Next/: <Choice on equilibrium>

Answer FIRST, LAST, NEXT, PREVIOUS or PRESENT.

Most commands affect only the PRESENT equilibrium. However, the commands
"REINITIATE_MODULE" on page 215 and "DEFINE_COMPONENTS" on page 196
remove all the stored equilibria.

SET_ALL_START_VALUES
Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If
temperature and pressure are not conditions, you are asked for values of them. Then for
each phase prompt on if it should be stable and on its constitution.

Syntax SET_ALL_START_VALUES

T /XXXX/: <Temperature in K>

If the temperature is not a condition, supply a guess of its final value (in K).

P /100000/: <Pressure in Pa>

If the pressure is not a condition supply a guess of its final value (in pa).

Prompts

Automatic start values for phase constitutions? /N/: <Y, N or F>

Answer N (the default), Y or F (for force).

The reason for the F option is that in some cases the calculation has failed
because impossible conditions are set, e.g. W(C)=1.5 [W(C) is mass fraction
and must thus be less than unity]. The program tries to fulfil this condition by
putting maximum amount of carbon in all phases, but can fail anyway. When
you detect the error and set W(C) to 0.015, the calculation may still fail
because it could start from the previous values. To get back to ‘fresh’ start
values, give the answer F for FORCE.

If Y this command immediately terminates, and the program automatically
sets the start values for phase constitutions in all possible phases.

For N supply an initial amount of each entered phase and the major
constituents or site fraction of each constituent.

Should <phase> be stable /N/: <Y/1 or N/2>

A guess on if this phase should be stable or not is requested. All entered
phases are prompted for this question and next two.
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Syntax SET_ALL_START_VALUES

You cannot have more phases stable than you have components,
but at least one (which dissolves all constituents) must be set as
stable. For backward compatibility, this question can be answered
by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2.
For phases with miscibility gaps, there should be two phases with the same
name but with different numbers after the hash sign.

Major constituent(s): <Name of major constituent(s) in the
phase>

The constituent with the largest fraction in the phase should be specified. If
there are more than one constituent with a large fraction, give them all on the
same line. If the default major constituents should be used answer with an
asterisk (*). By giving $ the constitution is not changed. If there should be no
major constituent give NONE and or if the major constituent(s) are improperly
specified, you are asked for individual fractions in the phase.

Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by
pressing <Enter> or give a new value (.YYYYY).

The phase name or constituent name may have a hash sign # followed by a
digit, e.g. Y(BCC_A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility
gaps, there should be two phases with the same name but with different
numbers after the hash sign. For phases with sublattices, the constituents in
sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.

SET_AXIS_VARIABLE
In order to calculate a diagram, set at least one axis variable in a stepping calculation, or at
least two axis variables in a mapping calculation. For property diagrams, one axis is enough;
for phase diagrams two or more are necessary. Any condition that can be set to calculate an
equilibrium can be used as an axis variable (with its lower and upper limits and step length)
by using the SET_AXIS_VARIABLE command, and the POLY program does, after a STEP or
MAP command, vary the value of the condition between the limits set on its related axis
variable.  As an extraordinarily unique and powerful feature of the Thermo-Calc software,
up to five independent axis variables can possibly be used in a mapping calculation of a
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multicomponent heterogeneous system; however, the axis numbers 3, 4 and 5 must have
chemical potentials of components (or temperature or pressure) as conditions.

Syntax SET_AXIS_VARIABLE

Axis number /#/: <An axis number>

Specify a number between 1 and 5. The axis numbers 3, 4 and 5 must have
chemical potentials of components (or temperature or pressure) as conditions.

Prompts

Condition /None/: <One condition>

Here the condition that should be varied along the axis must be given. The
condition is specified as in "SET_CONDITION" on the next page, for example W
(C) for mass fraction of carbon. By accepting NONE, the axis is removed.

Min value /0/: <Min value>

Specify the minimum value of the axis condition.

Max value /1/: <Max value>

Specify the maximum value of the axis condition.

Increment /.025/: <Step length>

Specify the maximum step length. By default, this is 1/40 of the total axis
length.

You can give the SET_AXIS_VARIABLE command without having set a condition on the axis
variable. Under such circumstances, the relevant condition is automatically created and the
value set between the minimum and maximum axis limits; however, as a side effect, the
POLY module creates two conditions, P=1e5 and N=1 (these have not been defined as a
condition yet), in case you set an axis variable which is not already a condition.

You can use a logarithmic axis during calculations. This is useful for low fractions like in a
gas phase where 1e-7 to 1e-2 might be an interesting range. The pressure is also suitable
for logarithmic step. You specify the logarithmic axis by giving an asterisk * after the
increment value.

The increment in this case is treated as a factor.

For example,

S-A-V 1 P 1E5 1E25 5*

This makes axis 1 a logarithmic axis where the difference between two calculated values
makes a factor 5.

The factor must be larger than 1.0.
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In some cases, such as when the DEFINE_DIAGRAM command is used or a special advanced
module (e.g. BIN, TERN, POT, SCHEIL or POURBAIX) is called, some axis variables are
automatically set by the program, not necessarily by this command.

SET_CONDITION
Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as
most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state
variables (with respect to chosen reference states), can be used as conditions. Beside
temperature and pressure conditions, a multicomponent system can have mixed types of
conditions; this brings the extreme flexibility and powerfulness to the complex calculations
with the Thermo-Calc software system. You should repeat this command for a
multicomponent system, till the degree of freedom in the defined system becomes zero.
When a FIXED phase status is used on a specific phase (use "CHANGE_STATUS" on page 186),
it is equivalent to one condition (implying that particular phase is stable in the defined
system).

Syntax SET_CONDITION

Each condition must be given explicitly, but can be given on the same line
(separated by a comma (,) or an empty space) or on separate lines with each
one started with the command.

Example
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2

or

SET_COND T=1273, P=1E5

SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5
Pascal), the mass (weight) fraction of C to 0.0015 and the mole fraction of Cr to
0.22 and the activity of N to 0.2.

Prompt

State variable expression: <State variable name or linear
expression> or a linear expression of state variables.

Some of the state variables that can be used in conditions are:

l T: temperature in the system (in K)

l P: pressure in the system (in Pascal)

l N: system size (mole number in moles)

l B: system size (mass in grams)
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Syntax SET_CONDITION

l N(<component>): mole number of a component in the system

l X(<component>): mole fraction of a component in the system

l W(<component>): mass fraction of a component in the system

l ACR(<component>): activity of a component in the system

l MUR(<component>): chemical potential of a component in the system

l X(<phase>,<component>): mole fraction of a component in a phase

l W(<phase>,<component>): mass fraction of a component in a phase

l ACR(<species>,<phase>): activity of a species in a solution phase

l MUR(<species>,<phase>): chemical potential of a species in a solution
phase

l H: enthalpy in the system (in J)

l HM(<phase>): enthalpy of a phase (in J/mol)

There are many state variables that can be used in conditions. For more
information, enter an INFO STATE_VARIABLES command. A condition is
normally a value of a single state variable with its value.

Example
T=1273.15 P=1E5

X(C)=.002

W(CR)=0.5

ACR(CR)=0.85

X(FCC,C)=.001

H=-250000

HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one
state variable. For example,

X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S component should
be the same in the LIQUID and PYRRHOTITE phases. In practice, that should be
the congruent melting point.
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Syntax SET_CONDITION

After the equal sign only a numeric value is allowed in the
expression.

Factor: <A factor for the state variable, or a continuation>

This question means you did not answer the previous question. The program is
then expecting a single state variable or a complete state variable expression,
or the numeric factor in an expression with only one state variable. In a state
variable expression a state variable may be preceded by a constant factor. An
example of this is:

2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential
of FE plus three times the chemical potential of O should be -35000 J/mol.

State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either
the prompt State variable expression or Factor, or a state variable
expression is given but the expression is incomplete, for example, T- or 2*MUR
(FE)+, for which the program is then expecting a continuation of the unfinished
expression. You need to specify a state variable or a complete state variable
expression, or complete the unfinished state variable expression. If a numeric
factor is given before this prompt, only one state variable can be specified;
otherwise, the program only takes the first state variable to complete the
expression (i.e. the factor times the state variable).

Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a
variable. A suggestion is given as the default value. The special value NONE
means that the condition is removed; for example T=NONE takes away the
temperature condition.

SET_INPUT_AMOUNTS
Specify how a system is made up from mixing of various substances. It is useful with a
substance database. In the C-H-O-N system, you can, for example, give:

S-I-A N(H2)=10, N(H2O)=25, N(C1O2)=5, N(N2)=100

The POLY module automatically converts this into conditions for the current set of
components. In the case when the elements are defined as the components, the command
above is equivalent to

SET-CONDITION N(H)=70, N(O)=35, N(C)=5, N(N)=200
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Syntax SET_INPUT_AMOUNTS

Prompts

Quantity: <N(<specie>) or B(<specie>)>

You can give the amount also preceded with an equal sign = [e.g. N(H2)=10
or B(H2O)=1000], or press <Enter> for the next prompt on the amount of the
quantity.

Amount: <Value of the quantity>

Specify the numerical value of the quantity.

You can give negative amounts in the SET-INPUT-AMOUNTS
command.

SET_NUMERICAL_LIMITS
Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by "COMPUTE_EQUILIBRIUM" on page 190, "STEP_WITH_
OPTIONS" on page 227, "MAP" on page 212 or "ADVANCED_OPTIONS" on page 174), this
message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current Thermo-
Calc (Console Mode) run, you can use this command to restore or reset the smallest site
fraction to the previous or another preferred value, as well as to reset other numerical
limits.

Syntax SET_NUMERICAL_LIMITS

Prompt

Maximum number of iterations /200/: <xxx>

By default, the program tries 500 iterations before it gives up. As some models
give computation times of more than 1 CPU second/iteration, this number is
also used to check the CPU time and the calculation stops if 500 CPU
seconds/iterations are used.

Required accuracy /1E-6/: <yyy>

This is a relative accuracy, and the program requires that the relative
difference in each variable must be lower than this value before it has
converged. A larger value normally means fewer iterations but less accurate
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Syntax SET_NUMERICAL_LIMITS

solutions. The value should be at least one order of magnitude larger than the
machine precision.

Smallest fraction /1E-12/: <zzz>

This is the value assigned to constituents that are unstable. It is normally only in
the gas phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except
for IDEAL phase with one sublattice site (such as the GAS mixture phase in
many databases) for which the default value is always as 1E-30 (unless you
have used the SET_NUMERICAL_LIMITS command to reset an even-lower value
(e.g. 1E-45, that is naturally enforced to all the phases in the system).

Approximate driving force calculation for metastable phases /Y/:
<Y or N>

Normally the POLY module only requires that the set of stable phases is in
equilibrium in order to terminate the iterations. The metastable phases are
included in all iterations but these may not have reached their most favourable
composition and thus their driving forces may be only approximate
[corresponding to Y]. You can also force the calculation to converge for the
metastable phases by answering N if it is important that these driving forces
are correct, which may require more iterations, and the STEP and MAP
command may also terminate due to bad convergence in a metastable phase.

SET_REFERENCE_STATE
The reference state for a component is important when calculating activities, chemical
potentials and enthalpies. The reference state for a component is determined by the
database. For each component the data must be referred to a selected phase, temperature
and pressure, i.e. the reference state. All data in all phases where this component dissolves
must use the same reference state. However, different databases may use different
reference states for the same element. Thus you must be careful when, for example, mixing
data from different databases.

By default, activities, chemical potentials, etc. are computed relative to the reference state
used by the database and this may thus differ depending on the database. With this
command select the reference state for a component if the reference state in the database
does not suit.

You can set the reference state for a component as SER, i.e. the Stable Element Reference
(which is usually set as default for a major component in alloys that is dominated by the
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component). Under such a case, the temperature and pressure for the reference state is not
needed and thus is not prompted.

In order to specify conditions in the specified reference state, you can append an R to the
state variables. Thus, AC is the activity (of a system component or of a species in a phase)
with respect to the default reference state, and ACR is the activity with respect to the
selected reference state; MU is the chemical potential of a system component with respect
to the default reference state, and MUR stands for the chemical potential with respect to
the selected reference state. The AC and ACR variables, for both components in a system
and species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).

Syntax SET_REFERENCE_STATE

Prompts
Component: <Name of the component>

The name of the component must be given.

Reference phase: <Name of a phase used as the new reference
state>

The Name of a phase, that must be either ENTERED or DORMANT or
SUSPENDED, must be given here. The component must, of course, be a
constituent of this phase.

For a phase to be usable as reference for a component the component need to
have the same composition as an end member of the phase. The reference
state is an end member of a phase. For example, in the Fe-C system, BCC can
be a reference state for Fe but not for C since BCC cannot exist as pure C.

If a component has the same composition as several end members of the
chosen reference phase, then the end member is selected that at the specified
temperature and pressure has the lowest Gibbs energy. For example, setting
the reference state for component O as gas (one sublattice) with constituents
O1, O2 and O3 results in O2 being the reference state if, at the present
temperature, pure O2 has the lowest energy of O1, O2 and O3. If the
reference state is set above a critical higher temperature, then O1 has the
lowest energy and consequently become the reference state.

The actual calculation of the reference state is only performed
when SET_REFERENCE_STATE is executed. For example, if GAS is
chosen as the reference phase of component O at such a high
temperature that O1 has the lowest energy, then O1 remains the
reference state even at calculations performed at lower
temperatures where O2 has a lower energy than O1.

Temperature /*/: <Temperature for the reference state>
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Syntax SET_REFERENCE_STATE

Select the temperature (in K) for the reference state. The wildcard value *
means the current temperature is used for the calculation.

Pressure /1E5/: <Pressure for the reference state>

Select the pressure (in Pa) for the reference state. The wildcard value * means
the current pressure is used for the calculation.

Examples
S-R-S Fe SER

S-R-S Cr FCC * 100000

S-R-S H2O AQUEOUS * 100000

S-R-S ZE REF_ELECTRODE * 100000

SET_START_CONSTITUTION
This command is similar to "SET_ALL_START_VALUES" on page 217, but is used for an
individual phase that may have a wrong constitution.

Syntax SET_START_CONSTITUTION

Prompts

Phase name: <Name of a phase, and possible major
constituent(s)>

Specify the name of a phase for which the constitution shall be set.

If there is a major constituent of the phase, you must specify this on
the same line as the phase name. By giving an*, select the default
major constituents. A $ means keeping the same constitution, and
NONE means to give individual site-fractions.

Y(<Phase>#<Composition_set>,<Constituent>#<Sublattice>)
/xxx/: <SF>

The site fraction (SF) of the constituent shall be given. The default
value xxx is the last calculated one.

SET_START_VALUE
Set a start value of an individual variable.

This command is not often required as the automatic start values can be
handled for most problems.
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Syntax SET_START_VALUE

Prompts
State variable: <Name of a state variable>

The state variable must be given.

Value

Specify the value to be assigned the state variable as start value.

SHOW_VALUE
Show the current value of any state variable, function or variable.

Syntax SHOW_VALUE

Prompt

State variable or symbol: <Name(s) of state variable(s) or
symbol(s)>

A single or several state variables or symbols (entered functions or variables)
can be specified.

The wildcard * can be used to denote all phases or all components.

You can use the dollar-sign $ to denote all stable phases. Thus, the command
SHOWW(*,*)lists the mass fraction of all phases, whereas SHOW W($,*)lists the
mass fraction of all stable phases.

If you SHOW a function, all functions are evaluated using the
current values of the state variables. But if you SHOW a variable, it
retains its value from the time it was ENTERED or last EVALUATED.

Therefore to save a value from one calculation to another, ENTER it to a
variable. This is frequently done in the PARROT module to transfer values
between equilibria.

STEP_WITH_OPTIONS
The STEP_WITH_OPTIONS (short name, STEP) command initiates the stepping procedure to
make a calculation of property diagrams in a multicomponent heterogeneous system. A
property diagram is usually stepped under one defined independent stepping axis-variable,
and is often constructed by the defined independent mapping axis-variable against a chosen
property (for the system, or for a specific phase, or for a certain species).

In the POLY module, it is possible to compute a series of equilibria with one condition as the
stepping axis variable. This is achieved by first calculating a single equilibrium, and then
selecting one of the conditions as the axis variable. The minimum and maximum value and
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the incremental step along the axis must also be given. By default, the global minimization
technique is used .

A property diagram consists of property lines that change (normally) along with
the stepping axis-variable. From a single STEP calculation, many different types
of property diagrams in the defined multicomponent heterogeneous systems
can be plotted. Various types of property diagrams are generated by the
stepping calculations. Also see "About Property Diagrams" on page 174 in the
Thermo-Calc User Guide.

Normally, before the command can be invoked, you need to have already calculated an
initial equilibrium point and set one independent variable (i.e. the controlling condition in
the system) . This is done using "SET_AXIS_VARIABLE" on page 218. You then list the current
values of the axis variable for each calculated equilibrium, as well as the corresponding
information when the set of stable phases changes.

By default, the global minimization technique is enabled, You can turn this off by using the
command-sequence "ADVANCED_OPTIONS" on page 174 → GLOBAL_MINIMIZATION.

You can choose how often to do a global minimization test using the command-
sequence ADVANCED_OPTIONS → STEP_AND_MAP → GLOBAL TEST INTERVAL.

Syntax STEP_WITH_OPTIONS

Prompt

Option? /Normal/: <a chosen option, N, I, S, O, E, M, T, or P>

N = Normal, I = Initial equilibria, S = Separate phases, O = One phase at a time,
E = Evaluate, M = Mixed Scheil, T= T0, and P = Paraequilibrium

Normal (N)

When you accept the default, Normal (N), it allows a stepping calculation with the chosen
independently-varying equilibrium condition (axis-variable). Only the step axis value is
changed between each step.

When you repeat the STEP → NORMAL command-sequence, you can make several stepping
calculations while still keep all the stepping-calculation results in the current POLY3
workspaces.

The calculation results are saved in the default RESULT.POLY3 file or you can
specify to save it in the <MyName>.POLY3 file. This is as long as there is no SAVE_
WORKSPACES command before the second set of command sequences (STEP →
NORMAL). Repeated stepped results can be restored into the same current
POLY3 workspaces/file.
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The addition of several steps enables you to generate special types of property diagrams and
to calculate and plot special phase boundary lines on phase diagrams, such as:

l The missing part(s) of a specific property [that are calculated under another
controlling condition inside the range of the stepping-variable] on the same property
diagram.

l Two or more sets of a specific property [that are calculated under different
controlling conditions and stepped over the same stepping-variable range] on the
same property diagram for the same system.

l Calculate some special phase-boundary lines [especially for some defined secondary
phase transformations or alike, e.g. the BCC_A1 <--> BCC_B2 phase-boundary, or
equal-Gm for two specific phases, or equal-fraction or equal-activity for a certain
species in two specific phases, that shall be calculated under different controlling-
conditions and also be stepped over different stepping variable(s)], and then plot (or
impose) them onto a corresponding phase diagram (which can be resulted from
several such STEP → NORMAL calculations or  even from a separate MAP
calculation) for the same system.

Initial_Equilibria (I)

An initial equilibria is added at each calculated point. This can be useful, for instance, to
generate a set of isothermal calculations.

When you choose I, an initial equilibrium is stored at each calculated equilibria. It is
intended to generate a matrix of calculated initial equilibria, first stepped under a STEP
INITIAL_EQUILIBRIA command-sequence and then repeated by another STEP NORMAL
command-sequence (or even continued by a MAP command).

For example, you can first use the temperature condition as the stepping axis-variable with
this option, which calculates a number of initial equilibrium points and automatically adds
each one as an initial equilibria for another STEP → NORMAL command-sequence (or even
for a MAP command). Before the second STEP command (i.e. the STEP → NORMAL
command-sequence), you can chose a compositional condition as the new stepping axis-
variable; then the STEP → NORMAL command-sequence uses those created starting
equilibrium points (at different temperatures) and steps in such a new compositional
variable. As a result, these two STEP commands together give a matrix of values.

Separate_Phases (S)

In this way, you can calculate how the Gibbs energy for a number of phases varies for
different compositions. This is particularly useful to calculate Gibbs energies for complex
phases with miscibility gaps and for an ordered phase that is never disordered (e.g.
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SIMGMA-phase, G-phase, MU-phase, etc.).

One_Phase_at_Time (O)

This option is recommended for STEPPING heterogeneous systems with both ordered phases
and the disordered pairs.

When you choose O, the stepping calculation is conducted individually for one phase at a
time. That is, it is stepped over the whole stepping variable range, but the stepping is
repeated for all the entered phases in the defined system. This is particularly useful to
properly step in composition for an equilibrium heterogeneous system with both ordered
phases and the disordered pairs. Thus, instead of calculating for the same composition for
each of the phases at each composition step, it starts the stepping in each of the phases in
the default most-stable compositions (the major constitutions).

Evaluate (E)

For Scheil-Gulliver simulations it is recommended you use the SCHEIL module.

Evaluate E is an advanced option and is useful when additional conditions (instead of the
stepping variable) require changing during a stepping calculation. It allows a stepping
calculation in a single axis with simultaneous evaluation of one or more variables after each
step. As variables can be used as conditions, it means that you can change the conditions
during the stepping. After a successful EVALUATE calculation, you can go to the POST
module to manually define and plot property diagrams.

The variables given are evaluated after each step, which may change other
conditions. This can be useful to perform the Ordinary ScheilGulliver Approach
(non-equilibrium transformations) for simulating alloy solidification without
back diffusion of fast-diffusing interstitial components in solid phases. However,
it is recommended you use the "SCHEIL Module" on page 293.

Specify the prompt:

Variable name(s): <Variable name>

The names of the variables that shall be evaluated after each step must be typed here.

The miscibility gap test is automatically used during stepping (see "ADVANCED_
OPTIONS" on page 174) if a phase has two or more composition sets.

The miscibility gap test means that you can start calculating from high temperatures in a
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steel where the MC carbide is not stable. During the calculation, the MC carbide first
becomes metastable with a composition different from the metallic FCC phase and later
also becomes stable.

See Console Mode example tcex30A.

Mixed_Scheil (M)

For Scheil-Gulliver simulations it is recommended you use the SCHEIL module.

This is an advanced stepping calculation designed for the Extended Scheil-Gulliver Approach
(partial-equilibrium transformations) to simulate alloy solidifications with back-diffusion of
one or more fast-diffusing interstitial components (such as C, N, O, S, etc.) in solid phases is
performed. It also will consider BCC-->FCC phase transformation (practically for steels)
along the alloy solidification process.

To ensure a successful stepping calculation of mixed Scheil-Gulliver simulation of
solidification process of a defined alloy system with a certain initial overall composition, it is
important to note the following:

l For solution phases with possibility of miscibility gap existence, you have
appropriately added the necessary composition set(s);

l You have already set the temperature condition as the stepping SET_AXIS_VARIABLE
command, with minimum and maximum temperature points as well as an
appropriate s temperature step for the cooling process).

l There must be a composition condition for each of the back-diffusion components
(i.e. fast-diffusing interstitial components, such as C, N and/or other elements) that
are already defined in terms of mole-fraction or mass-fraction, e.g. X(C) and W(N).
Otherwise, a stepping calculation with this option can fail.

l An initial equilibrium in which the LIQUID mixture phase is the only stable must be
calculated. This is why it is good to start with a relatively high temperature condition
for the initial equilibrium calculation. It is always necessary to reject or suspend the
GAS mixture phase (if it exists) before the C-E and STEP commands, to avoid its
formation along with LIQUID.

l In cases where fast-diffusing interstitial components are specified as back-diffusion
components, you can choose to allow BCC>FCC phase transformation (practically for
steels) during the alloy solidification process.
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These are the prompts for this option:

Fast diffusing components: <Fast diffusion interstitial(s)>

Specify one or more interstitial component(s) as the back-diffusion component(s).

l If there is only one fast-diffusing interstitial component (e.g. C or N), type its name;

l If there are two or more fast-diffusing interstitial components (e.g. C, N and S),
always type the names on the same line at once (separated by an empty space in
between, e.g. C N S);

l If there is no fast-diffusing interstitial component to be considered, type NONE to
ignore back diffusion entirely, meaning a normal Scheil-Gulliver simulation is
performed.

Such specified back-diffusion interstitial component(s) must be appropriately
defined according to the phase constitution definitions of some major alloy
solution phases (e.g. FCC, BCC, HCP, etc.). These are located on the
interstitial/vacancy sublattices in such alloy solution phases; otherwise, such a
Scheil-Gulliver simulation may not make sense at all.

Allow BCC -> FCC ? /Y/: <Y or N>

Type Y or N to allow or not allow the BCC-->FCC phase transformation (which is usually a
typical phenomenon along the cooling processes of steels/Fe-alloys).

During the calculation the simulated solidification path, including the locally-equilibrated
phase assemblage (region), captured temperature condition (T in K), remaining liquid phase
(NL, mole fraction), overall formed solid phases (NS, mole fraction) and latent heat
formation (NH, J/mol) along the cooling process are shown after the information on starting
temperature point of the alloy solidification process, e.g.

Solidification starts at 1743.15 K

Phase Region from  1.744150E+03 for:     LIQUID

Phase Region from  1.742525E+03 for:

LIQUID

FCC_A1#1

1742.5250         0.9960         0.0040        -1.1824

1742.4000         0.9795         0.0205      -202.1585   . . . . . .

Phase Region from  1.733150E+03 for:

LIQUID

BCC_A2

FCC_A1#1

1733.1500         0.3294         0.6707     -8032.6240
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1733.0250         0.3237         0.6763     -8095.1490   . . . . . .

After a successful calculation, you can go to the POST module to manually define and plot
property diagrams for the alloy solidification process according to the chosen Scheil-Gulliver
model, or to impose existing relevant experimental information or other types of calculated
solidification results [e.g. Scheil-Gulliver simulation with or without considering fast-diffusing
interstitial component(s), full-equilibrium approach, or Diffusion Module (DICTRA)-type
simulation with moving-boundary conditions] onto the same plotted property diagrams. 
Normally, the solidus temperature (T in Celsius) is set as one of the axis variables (usually as
Y-axis in most cases), while the other plotted quantity on the other axis can be the amount of
overall formed solid alloy phases (NS in mole-fraction or BS in mass-fraction), the amount of
remaining liquid phase (NL in mole-fraction or BL in mass fraction), the heat of latent along
the solidification process (NH in J/mol or BH in J/gram), among many other properties in the
solidified alloy phases or in the whole alloy system.

T-zero (T)

For an example see Console Mode example 41.

This advanced option allows a stepping calculation of the so-called T0 (T-zero) line in a
diffusionless transformation (where two specific partially-equilibrated phases have the same
Gibbs energy) along a composition variable which has already set as the stepping variable
with "SET_AXIS_VARIABLE" on page 218.

The temperature condition cannot be set as the stepping variable if you want to
make a STEP T-ZERO calculation.

Prior to performing the step T0 command sequence, and to ensure a successful
calculation of T0 line between two specific phases after an initial equilibrium
calculation in the current system, it is sometimes recommended to make a
single T0 point calculation using ADVANCED_OPTIONS → T-ZERO.

Specify these prompts:

Name of first phase: <Phase A>

Name of second phase: <Phase B>

The names of the target phases, for which the Gibbs energies equal to each other at each
point on the T0 line, must be entered.

During the calculation, the T0 values are shown after the corresponding scanned conditions
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(of the stepping composition variable), e.g.

Phase Region from  1.000000E-01 for:

BCC_A2

FCC_A1

1.000000E-01        940.24

9.250000E-02        941.20

. . . . . .

2.500000E-03        977.61

7.500000E-09        979.34

Phase Region from  1.000000E-01 for:

BCC_A2

FCC_A1

1.000000E-01        940.24

1.075000E-01        939.62

. . . . . .

2.950000E-01       1084.87

3.000000E-01       1080.99

After a successful calculation, you can go to the POST module to plot the T0 line against the
stepping composition variable or another varying axis, or to impose the calculated T0 line
onto a normal phase diagram [normally plotted as a T-X isopleth].

Paraequilibrium (P)

For an example see Console Mode examples 42 and 43.

This is an advanced option. Select P to calculate the paraequilibrium state between two
specific phases (the paraequilibrium lines). It allows a stepping calculation of
paraequilibrium lines where the chemical potential for one or more interstitial components
(that are considered as back-diffusion elements, such as C and N) but not for the other (s) in
two partially equilibrated phases are equal.

More than one interstitial component can be treated as fast-diffusion species (such as C, N,
O, S, etc., as individual or combined) in a paraequilibrium stepping calculation.

The composition condition for the interstitial components cannot be set as the
stepping variable if you want to make this calculation.

To ensure a successful stepping calculation of paraequilibrium states between two specific
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phases in a defined alloy system, it is important to first make a starting-point equilibrium
calculation with an initial overall composition in the current system. However, it is
unnecessary to obtain an equilibrium in which either one or both of the target phases is
stable.

The initial overall composition must have a reasonable setting for the desired
paraequilibrium calculation for the two target phases. This is especially true where there is
more than one interstitial component to be considered in the paraequilibrium state, because
different interstitial components (for example C and N combined) may have significant
different behaviours as partitioning into different structured phases; otherwise, for one
chosen interstitial component the initial overall composition is OK for the paraequilibrium
calculation between the specified two phases, but for other chosen interstitial component(s)
it might be impossible to calculate the paraequilibrium state.

Always check if the chosen phaseA and phaseB have the exact same definition of elements
and if the chosen interstitial components are all in the vacancy sublattice sites of the two
phases; otherwise the program cannot find the paraequilibrium state (as it is impossible to
correctly calculate u-fractions).

Always have a comprehensive understanding of the normal phase diagram for the currently
investigated system, so that you make the appropriate choice of the phase pair and staring
bulk composition for the system.

Always set the status of the chosen interstitial components as SPECIAL using the command:

CHANGE_STATUS COMPONENT <interstitial component> = SPECIAL

By doing this, you get a clear picture on u-fractions of various substitutional and interstitial
components, which are different from the overall composition in the system. The SPECIAL
status means that specified component(s) are not included in summations for mole or mass
fractions. Therefore, all the composition variables plotted from the paraequilibrium
calculations are u-fraction related quantities.

Always make a single-point paraequilibrium calculation by the command-sequence of
ADVANCED_OPTIONS → PARAEQUILIBRIUM, prior to performing this STEP →
PARAEQUILIBRIUM command-sequence, although this might not be always necessary for
some systems.

With this stepping calculation specify the following:

Name of first phase: <Phase A>

Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium states
establish, must be typed at the above two prompts subsequently or on the same (first) line at
once (separated by an empty space, e.g. FCC BCC, FCC#2 M23C6).
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It is important to understand that this is the calculation of a paraequilibrium
state between the two specified phases.

Particularly, there are these issues to consider:

1. Both chosen phases must have similar interstitial/vacancy sublattices where the fast-
diffusion interstitial component(s) occupy.

2. The choice on the target phase pair must be reasonable for the defined system and
specified initial overall composition.

3. Both target phases should have phase constitution definitions that cover all the
defined substitutional and interstitial components of the current alloy system; or

4. It is impossible to calculate the paraequilibrium state between the target phase pairs
with given interstitial component(s) in the currently defined system.

Fast diffusing component: /C/: <Interstitial component(s)>

Fast diffusing component: /None/: <Interstitial component(s)>

The name(s) of the fast-diffusing interstitial component(s) (C as the default single
component) must be given either one by one at each of the above prompts subsequently or
in a combination (separated by an empty space in between, e.g. C N S) at the same (first)
prompt; otherwise, press <Enter> key to start the paraequilibrium line stepping-calculation.

Note the following:

Such specified fast-diffusing interstitial component(s) must be appropriately defined
according to the phase constitution definitions of the two selected phases: These must be
located on the interstitial/vacancy sublattices in both chosen phases.

If there is only one fast-diffusing component which is carbon, press <Enter> to accept the
default value (C) at the first prompt; if the single fast-diffusing interstitial component is
another element (e.g. N), appropriately type interstitial component the name at the first
prompt;

If there are two or more fast-diffusing components (e.g. C and N), type their names at the
above prompts subsequently or at the same (first) prompt (separated by an empty space,
such as C N);

To finish the input of fast-diffusing elements, accept NONE at a repeated prompt;

If NONE or a non-existing component name is typed at the first prompt, it means no back
diffusion is to be considered, and the para-equilibrium calculation is thus cancelled entirely.

During the STEP → PARAEQUILIBRIUM calculation procedure, the calculated
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paraequilibrium states include the:

l corresponding stepping conditions (e.g. temperature in K, or the stepping
composition variable of the matrix component or of one of substitutional
components) which has already set as the stepping variable by the SET_AXIS_VAR
command);

l amounts of the phase A in mole number [i.e. NP(phaseA)];

l amounts of the phase B in mole number [i.e. NP(phaseB)];

l contents of the interstitial component(s) in the phase A expressed in u-fractions [i.e.
u-f(phaseA,component(s))];

l contents of the interstitial component(s) in the phase B expressed in u-fractions [i.e.
u-f(phaseB,component(s))];

l LNACR(component) value(s) for the interstitial(s).

After a successful STEP → PARAEQUILIBRIUM calculation, you can go to the POST module to
plot a paraequilibrium phase diagram, or to impose the calculated paraequilibrium states
onto a normal phase diagram [normally plotted as a T-X isopleth with one of the considered
interstitial component(s) as the x-axis variable].

However, the stepping calculation procedure for the currently specified paraequilibrium
states between the two specified phases may find difficulties at some steps due to some
possible numerical problems (normally regarding to the u-fractions of the interstitial
components under some composition ranges), or it may completely fails. In the latter case,
it implies that the chosen target phase pair may be unreasonable for the defined alloy
system or for the defined initial overall composition, or one or both phases may have
inappropriate phase constitution definitions regarding the specified interstitial component(s)
and substitutional components. Then, you must either modify the settings of initial overall
composition or specify the reasonable target phase pair with an appropriate choice of the
fast diffusion interstitials in the defined alloy system.
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The figure above shows the plot of a paraequilibrium calculation of isopleths: Formation of
para-pearlite in two Fe-based alloys, with equilibrium results appended.

The calculated paraequilibrium phase boundaries (black lines) are shown with
tie-lines (in green-colour). In the Fe-2.5Mn-C alloy system, C is considered as
fast diffusing interstitial component in the BCC+FCC and FCC+Cementite
paraequilibrium stepping calculations; while in the Fe-3Cr-N alloy system, N is
treated as fast diffusing interstitial components in the BCC+FCC and FCC+FCC_
M1N (i.e. FCC#1+FCC#2) paraequilibrium stepping calculations.

During a STEP calculation, the value of the stepping axis variable for each
calculated equilibrium is listed and also the set of stable phases.

You can stop the mapping of a line by pressing a single <Ctrl-A> (Windows) or <Ctrl-C>
(Linux). This can be useful in order to stop a longish calculation without losing what is
already calculated.

If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by a STEP_WITH_OPTIONS command-sequence, this message
displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30  to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run,
you can use the POLY command "SET_NUMERICAL_LIMITS" on page 296 to restore or reset
the smallest site fraction to the previous or another preferred value, as well as to reset
other numerical limits.

Complex miscibility gaps of various solution phases are automatically detected during a
stepping calculation, and two or more composition sets for each of such solution phases are
automatically generated as well, through an automatic Global Minimization Test procedure
(by specifying a Global Test Interval value and confirming the Automatically add
initial equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a
particular case, such an automatic Global Minimization Test ensures that you can now start
calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase)
where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1
miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.) are
not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may first
become metastable with a composition different from the metallic FCC_A1 phase and later
also stable.

Occasionally, it may be necessary to have a specified increment other than the default value
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for the defined stepping axis-variable, in order to calculate/plot a smoother property
diagram.

To get a complete property diagram, sometimes (especially in some earlier Thermo-Calc
versions) it may also be required to have more than one starting equilibrium-points (under
another starting equilibrium condition), and repeat the stepping calculation over the same
stepping axis-variable range (while without over-writing the same POLY3 workspaces via a
SAVE_WORKSPACE command). However, using the current STEP procedure such a
requirement become less necessary.

TABULATE
For any entered table, this command gives a table of values from equilibria calculated with
a STEP command. It works only for a table that is entered in either the POLY or POST
module.

Unlike the TAB module's command (also called "TABULATE" on page 315) it is
not possible to plot columns from the tabulated tables. For this use normal POST
commands.

Syntax TABULATE

Prompts
Name: <Name of a table entered in either POLY or POST>

Specify a table name that is entered in either the POLY or POST module.

Output on screen or file /Screen/: <File name or return>

Specify a file name if you want to save on a file the table values along the
defined STEP calculation, or press <Enter> if want to see the table values
displayed.
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Plotting and Visualization with the POST Module
The POST module (post-processor) is available from the POLY module. See "Equilibrium
Calculations with the POLY_3 Module" on page 163 for other information about the POLY
module. Read "Using the POST Module" on page 242 before beginning.

In this section:

Using the POST Module 242

ADD_LABEL_TEXT 243

APPEND_EXPERIMENTAL_DATA 245

CHANGE_LEGEND 246

DUMP_DIAGRAM 246

ENTER_SYMBOL 247

FIND_LINE 250

LIST_DATA_TABLE 251

LIST_PLOT_SETTINGS 251

LIST_SYMBOLS 251

MAKE_EXPERIMENTAL_DATAFILE 252

MODIFY_LABEL_TEXT 252

PLOT_DIAGRAM 253

PRINT_DIAGRAM 254

QUICK_EXPERIMENTAL_PLOT 254

REINITIATE_PLOT_SETTINGS 255

RESTORE_PHASE_IN_PLOT 255

SELECT_PLOT 255

SET_AXIS_LENGTH 256

SET_AXIS_PLOT_STATUS 256

SET_AXIS_TEXT_STATUS 256

SET_AXIS_TYPE 257



Thermo-Calc Documentation Set

Plotting and Visualization with the POSTModule ǀ 241 of 370

SET_COLOR 257

SET_CORNER_TEXT 259

SET_DIAGRAM_AXIS 259

SET_DIAGRAM_TYPE 261

SET_FONT 262

SET_INTERACTIVE_MODE 263

SET_LABEL_CURVE_OPTION 263

SET_PLOT_FORMAT 264

SET_PLOT_OPTIONS 264

SET_PLOT_SIZE 266

SET_PREFIX_SCALING 267

SET_RASTER_STATUS 267

SET_REFERENCE_STATE 267

SET_SCALING_STATUS 268

SET_TIC_TYPE 269

SET_TIELINE_STATUS 269

SET_TITLE 270

SET_TRUE_MANUAL_SCALING 270

SUSPEND_PHASE_IN_PLOT 270

TABULATE 271
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Using the POST Module
Use the POST module after a "STEP_WITH_OPTIONS" on page 227 or "MAP" on page 212
calculation to generate graphical or tabulated presentations on screen or into files.

The graphical files are available in different formats (e.g. PS, EMF, PNG, BMP, PDF, JPG, TIF)
or data forms (e.g. EXP, TAB and WRL). The graphical output can be phase diagrams,
property diagrams, diffusion profiles and other types of plots. The tabulated presentation is
into a basic text file (TXT) or a spreadsheet (e.g. an MS Excel file with an extension of .XLS).

The POST module is available through these modules:

l POLY

l TAB

l BIN

l TERN

l POT

l SCHEIL

l POURBAIX

Within the POST module, you can choose any state variable, any derived variable, or any
entered symbol (functions or variable) as the X/Y-axis.

Also see "Thermodynamic Variables and Units" on page 332.

When a diagram is plotted, appearance parameters for defining a high-standard graph can
be further specified, e.g. curve labelling options, diagram titles and subtitles, plot size, axis
length, axis types, axis-tic type, tie-line status, automatic or manual scaling and zooming,
semi-automatic or manual labelling on phase boundaries and phase regions, graphic
formats, text fonts, colours, raster plot, etc.

You can append experimental data onto a plotted diagram. You can also save the
coordinates onto a textual file, which can be edited and used as an experimental data file to
be merged onto another diagram or as a part of a setup file for PARROT-module
assessment.

Phases can be suspended or restored in a plotted diagram. The reference states for
components can also be modified for the resulted diagrams. Moreover, you can translate a
plotted property diagram (after a stepping calculation) into a tabulated form, such as a
simple list on screen or a textual file, and a spreadsheet .



Thermo-Calc Documentation Set

Plotting and Visualization with the POSTModule ǀ 243 of 370

ADD_LABEL_TEXT
Add a text to an area in a phase diagram or a property diagram. The label is written starting
from the specified coordinates. Optionally, you can also let the program automatically add
the text by first calculating an equilibrium state at the specified coordinates and then
making a label out of the stable phase names.

The label texts and coordinates, either added by this command or modified with "MODIFY_
LABEL_TEXT" on page 252 (or manually edited in the Console Results window), are stored in
the workspace, and these may later be saved onto an *.EXP file (with "MAKE_
EXPERIMENTAL_DATAFILE" on page 252).

In some cases such an optional calculation for automatic phase region labeling
may not work. It is not possible to automatically add labels for certain sets of
axes, like entropy, enthalpy, pH, Eh, etc.

"Adding and Editing Plot Labels " on page 119 in the Thermo-Calc User Guide.

Syntax ADD_LABEL_TEXT

Prompts
Give X coordinate in axis units: <Value of the X coordinate>

Specify the value of the X coordinate where the label is to start.

Give Y coordinate in axis units: <Value of the X coordinate>

The labels disappear if any axis is changed after wards.

Specify the value of the Y coordinate where the label is to start.

Automatic phase labels? /Y/: <Y or N>

If you answer Y, the program automatically calculates the equilibrium at the
given coordinates and generates a label with the names of the stable phases.
However, the automatic calculation works only for phase diagrams that are
mapped with two axes in the POLY module, and sometimes it may not work
correctly especially for complex heterogeneous interaction systems; in such
cases, a message displays.

Text: <Text for the label>

If you answer N enter text at the prompt. You can enter simple text, use
LaTeX, rotate the text, as well as adjust the font size.
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Syntax ADD_LABEL_TEXT

LaTeX: You can use LaTeX commands to enter text and symbols. First enter the
command followed by the expression or string, for example to display Al2O3
as subscripts:

\latex Mole-fraction Al_2O_3

For a list of supported LaTeX commands, see
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-
mode.html .

By default when using the LaTeX command, you are in math
mode and Thermo-Calc automatically interprets the entered text
as math. The above link uses the dollar sign ($) in all the
examples but this is NOT required. For example, if you enter
$E=mc^2$ this is displayed including the $ instead of the equation.

To add a mixture of plain text and equation text, you can exit
math mode using the string \textrm followed by the text to
display enclosed in curly brackets. For example \latex \textrm
{Mole-fraction }Al_2O_3 displays this label .

Rotate the text: If you want to rotate the label, start a text string with the
rotation command (which is case sensitive and must be in lower case letters)
then enter the number of degrees to rotate the label. For example, to rotate
the label 45 degrees enter:

\rotation 45

To rotate the text and use LaTeX, the rotation command must be used first.
For example:

\rotation 45 \latex Mole-fraction Al_2O_3

Rotates the text 45° and includes subscripts in the title Mole-fraction Al2O3.

Text size: /.35/: <Size for the label>

A smaller size of the text may be necessary to fit the label text into the
diagram. A default size is given using the latest size in adding label texts, or
.35 if the command is called for the first time. A recommended size is e.g.
0.25.

http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
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Syntax ADD_LABEL_TEXT

These changes to plot labels can also be manually edited in the
Console Results window.

APPEND_EXPERIMENTAL_DATA
Add experimental data and text onto a calculated diagram. This is done by placing the
experimental data and text on a formatted textual file (always having an extension of EXP)
that is prepared outside of Thermo-Calc software (Console Mode and Graphical Mode),
according to the syntax of the DATAPLOT Graphical Language.

The picture generated from the data is superimposed on the ordinary graphical output from
the postprocessor. Such an experimental data file (*.EXP) may be created by an ordinary
textual editor.

Another important usage of this command is to superimpose plots from several independent
calculations. For this purpose, there is a command "MAKE_EXPERIMENTAL_DATAFILE" on
page 252, which dumps a calculated diagram on an EXP file according to the DATAPLOT
syntax. With the aid of a normal text editor, many such files may be merged together.
Remember that you can only have one prologue section on each such EXP file.

Also see the DATAPLOT User Guide included with this documentation set.

Syntax APPEND_EXPERIMENTAL_DATA

Prompts

Use experimental data (Y or N) /N/: <Y or N>

Specify whether the data from an experimental data file should be included in
the next plot. If the answer is c, no experimental data are plotted.

An Open window displays to specify the name of the file with the
experimental data.

Prologue number: /0/: <Prologue number>

Select which prologue to use. In a prologue, you can, for example, give the
scaling of an axis, the axis texts, and so on.

By answering -1, a list of all prologues on the file is given; and by
0, no experimental data are appended.

Dataset number(s) /-1/: <Dataset number(s)>

Select from which dataset(s) data should be read. Several datasets may be
given separated with commas or spaces. By answering -1, a list of all datasets
on the file is given; and by 0, no experimental data are appended.
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CHANGE_LEGEND
When there is a legend in the diagram you can append constitution and/or ordering
descriptions to the phase name.

"LIST_EQUILIBRIUM" on page 209 also displays ORD (ordered) or DISORD
(disordered) (when available).

In some cases the legend only shows the phase name for a line when the "SET_
LABEL_CURVE_OPTION" on page 263 option is set to F.

Syntax CHANGE_LEGEND

Prompt

Set suffix for phase names in legend? (All, None, Constitution,
Ordering)/None/:

When you select None the legend includes the standard information about the
phases.

When you select All the Constitution description and the Ordering description
(when there is ordering) are also included.

When you select Constitution, this is added to the standard description.

When you select Ordering and when there is ordering, this is added to the
standard description.

Also see "About Legend Styles" on page 117 in the Thermo-Calc
User Guide for examples of these labels.

DUMP_DIAGRAM
After a Thermo-Calc graph is created (and displays with the PLOT_DIAGRAM command) you
can save (dump) a diagram to a file so you can quickly print it. It is similar to the PRINT_
DIAGRAM command.

Similar to "PRINT_DIAGRAM" on page 254, it does not matter what graphic
device is set up for the graph, this command is always able to convert the graph
shown on screen to the selected graphic format.
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Syntax DUMP_DIAGRAM

Prompt

Output format/: <Format or return>

Specify an appropriate graphic format for dumping the graph or pressing
<Enter> to accept the default format.

A Save window opens if you have not specified a file name. Select a directory
path and enter a File name. If a file with the specified name already exists,
then you are prompted whether to overwrite the old file or not. The third
argument of the command allows you to specify whether to overwrite (Y) the
old file or not (N).

After the printing process is finished, the temporarily set graphic device for
conversion and printing is switched back to the one set by the command "SET_
PLOT_FORMAT" on page 264, so that you can save the graph in file(s) using
"PLOT_DIAGRAM" on page 253.

ENTER_SYMBOL
This command is for both the POST and POLY modules in Console Mode.

Symbols are a useful feature of the POLY and POST modules to define quantities that are
convenient. Symbols can be constants, variables, functions or tables.

Functions or tables (with defined functions as values) can be entered in the POST module
after a stepping or mapping calculation, for purposes of plotting such entered functions or
tables as axis variables.

Within the POLY module, symbols are normally defined prior to an equilibrium calculation
(enforced by a C_E command), stepping calculation (enforced by the command "STEP_
WITH_OPTIONS" on page 227) or mapping calculation (enforced by "MAP" on page 212).
These can be entered after an equilibrium calculation; however, for defined functions,
variable or tables, it requires using "EVALUATE_FUNCTIONS" on page 208 before showing
the corresponding values in the calculated equilibrium state.

The symbols entered in the POST module are not saved in the currently-loaded POLY3
workspaces. Therefore, if you want to apply such symbols in other similar calculations for
the same defined system, you must use the ENTER_SYMBOL command prior to the
STEPPING or MAPPING calculation in the POLY module.

Also see "ENTER_SYMBOL" on page 113 for the GIBBS Module.
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See example 44 in the Thermo-Calc Console Mode Examples Guide for an
example of using variables and functions.

Syntax ENTER_SYMBOL

Prompt

Constant, Variable, Function or Table? /Function/: <keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.

l CONSTANTS can only be entered once and is a means of using a name
for a numeric value. For example, the value of 1 atmosphere in Pascal
can be denoted by P0 after the command ENTER CONSTANT
P0=101325. Defined constants can be used as values in condition
assignments, for example, SET-COND P=P0.

l FUNCTIONS are expressions of state variables or other functions. These
expressions are saved, and whenever a function value is requested all
functions are evaluated. The reason for this is that they may depend on
each other.

l VARIABLES are similar to functions because they can also be
expressions of state variables. However, contrary to functions, they are
only evaluated when they are entered or if they are explicitly named in
an "EVALUATE_FUNCTIONS" on page 208 command. It is possible to
enter a variable with a new expression any time. This expression is
evaluated directly and its value stored as the value of the variable.
Defined variables can be used as values in the SET-CONDITION
command.

l TABLES are used for listing results from the STEP or MAP commands. A
table consists of a list of any number of state variables, functions or
variables. Defined tables can also be used in the post-processor POST.

There is a special connection between tables and variables. If a
variable is used in a table, it is evaluated for each line of the table
in the TABULATE command or when the table is used in a plot.

Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have
maximum 8 characters.

Legal characters include letters (either UPPER or lower case), digits and
underscore _. Any other special character, such as parentheses ( and ), plus +,
minus -, slash / or \, full stop (.), are illegal for symbol names.

You can enter the symbol name and the value or function on the same line,
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Syntax ENTER_SYMBOL

these must be separated with an equal sign =, for example, TC=T-273.15 or T_
C=T273.15 which stands for a definition of temperature in Celsius. Otherwise,
these questions are asked.

For different types of symbol (constant, function, variable or table),
the questions have different prompts.

Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or
other functions, constants or variables. The expression is a FORTRAN-like
expression and operators +,  -, *, = and ** can be used (** only with integer
powers).

Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An
expression can be continued on more than one line. An expression should be
terminated by a semicolon (;) or an empty line (by pressing <Enter> at the next
prompt).

Examples of function expressions:

l GM(LIQUID): The Gibbs energy of liquid per mole component

l H.T/4.184: The heat capacity of the system in calories

l ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

l T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the
new line if one line is not enough for the function. If you finish the function
press <Enter> again.

Value: <Value for a constant>

A constant can only be assigned a numeric value once.

Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is
evaluated immediately and discarded. Only the numeric value is kept. This
gives a possibility to save a value between calculations with different
conditions because all state variables and functions are evaluated for the new
conditions.
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Syntax ENTER_SYMBOL

Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain
results from a STEP command is through a table. 

Example:

ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the
temperature, the mole fractions of C and Cr in the LIQUID phase, and the
activity of C.

To show the temperature in Celsius in a table, give the command ENTER
FUNCTION TC=T-273; and then use the symbol TC in the table.

& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new
line if one line is not enough for the table. If you finish the table press <Enter>
again.

FIND_LINE
Identifies various property curves on a plotted property diagram (after a stepping
calculation); it also works well in find stable phase regions on a phase diagram (after a
mapping calculation).

Syntax FIND_LINE

Prompts

X coordinate /.484623611/: <Value of the X coordinate>

Specify the value of the X coordinate where you want to find the details
of property curve (or phase region).

Y coordinate /.5153737962/: <Value of the Y coordinate>

Specify the value of the Y coordinate where you want to find the details
of property curve (or phase region).

The POST module displays the identified property (for a property curve on a
property diagram), or the identified stable phase-assemblage (for a phase
region on a phase diagram).
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LIST_DATA_TABLE
This is a POST module command.

This command is used for listing various properties (i.e. the Y-axis variable on a property
diagram) that change with an independent variable (i.e. the X-axis variable on a property
diagram), which have already been defined in the POST module (and often are plotted on
the Console Results window), but only after a STEP calculation.

The listing output can be either on screen or in a spreadsheet file in the MS Excel format
(under specified file name with the default file extension of XLS), which can be further
edited or used for graphical handling by opening the file (using the MS-Excel program)
outside of the Thermo-Calc software system.

Syntax LIST_DATA_TABLE

Prompt

Output to screen or file /Screen/: <File name or return >

Specify a file name if you want to save on a spreadsheet file (in the MS Excel
format, with the default extension of XLS) on which the already-defined
properties on a property diagram (after a STEP calculation) is saved, or press
<Enter> if want to see a simple textual table on screen (for the already-defined
properties that change alone with an independent variable).

This command only works for a property diagram after a stepping
calculation but not for any phase diagram after a mapping
calculation.

LIST_PLOT_SETTINGS
This is a POST module command.

Syntax LIST_PLOT_SETTINGS

Lists the present values of most parameters specifying the type of diagram to be
plotted.

LIST_SYMBOLS
For both the POLY and POST modules, list the definitions for all constants,
functions, variables and tables.
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In order to find the value of a function or variable, use "SHOW_VALUE" on page 227 or
"EVALUATE_FUNCTIONS" on page 208. A table is tabulated with the TABULATE command.

Syntax LIST_SYMBOLS

The defined variables are listed up together with the defined functions, but
variable names are followed by a percentage sign %.

MAKE_EXPERIMENTAL_DATAFILE
Write the graphical information onto screen or a formatted text file (always having an
extension of .EXP) using the DATAPLOT graphical format. In order to merge two or more
diagrams from separate calculations, you can write them out on files with this command,
and then add/edit them together with a normal text editor.

Also see the DATPLOT User Guide included with this documentation set.

Syntax MAKE_EXPERIMENTAL_DATAFILE

Prompt

Output to screen or file /Screen/: <Name of a file or return>

Specify the name of the desired file. Accept SCREEN (press <Enter>) for a list
Otherwise, a file name where the graphical information is written must be
given here. The default file extension is EXP (under MS Windows) or exp (under
Linux).

MODIFY_LABEL_TEXT
Move a label created with the command "ADD_LABEL_TEXT" on page 243 to another
position, or replace its text with another one.

The label texts and the coordinates, either added by ADD_LABEL_TEXT command or
modified by this command or manually edited on the Console Results window, are stored in
the workspace, and can be saved onto an *.EXP file (through "MAKE_EXPERIMENTAL_
DATAFILE" above).
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Syntax MODIFY_LABEL_TEXT

Prompts

Which label to modify? /#/: <number of the label>

Before this prompt, all the labels created by the ADD_LABEL_TEXT command
is listed with an identifying number. Specify the number of the label you
want to modify. The default one (#) is the last added label.

New X coordinate: /xxx/: <new X position>

Specify the new X position. The previous X coordinate is displayed. Press
<Enter> to accept.

New Y coordinate: /yyy/: <new Y position>

Specify the new Y position. The previous Y coordinate is displayed. Press
<Enter> to accept.

New text /ABCDEFGH.../: <New labeling text>

Specify the new labeling text. The previous text is displayed. Press <Enter>
to accept.

The new label text must not be longer than the previous text.

PLOT_DIAGRAM
With this command, a calculated/plotted diagram is displayed if the default graphic device
has already been defined by the "SET_PLOT_FORMAT" on page 264 command. It can also be
saved onto a file.

The diagram axes must be set first.

The functionality of this command is shared in two ways: 

l in PLOT_DIAGRAM for normal screen display and file saving and

l in "PRINT_DIAGRAM" on the next page (under MS-Windows environment) for direct
hard-copy printing.
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Syntax PLOT_DIAGRAM

Prompt Output to screen or file /Screen/: <Name of a file or return for
screen>

Specify the name of the desired file (Note that under Linux, the prompt is
PLOTFILE /SCREEN/). Consequently, a file with a proper extension for the
selected graphic format (set by the SET_PLOT_FORMAT command) is saved
under the current working directory. If no extension is given in the file name,
the default extension e.g. ps for Postscript portrait/landscape modes, P7 or p7
for HPGL landscape, P8 or p8 for HPGL portrait, etc.) is automatically given to
the file name.

If the default device is set (by the command SET_PLOT_FORMAT), you can
either accept SCREEN to plot the graph in the Thermo-Calc Graph window on
screen by pressing <Enter>, or save it on a file by giving a file name.

PRINT_DIAGRAM

Syntax PRINT_DIAGRAM

Print with high quality to a file after a Thermo-Calc graph is created (and is
displayed with "PLOT_DIAGRAM" on the previous page). It has the same
function as the Print Plot option on the Console Results windows.

QUICK_EXPERIMENTAL_PLOT
This is similar to "APPEND_EXPERIMENTAL_DATA" on page 245 but can be used when there
is no graphical information to be plotted in the POLY3 workspace. It defines a pair of axis,
sets the axis labels to X and Y, and scales both X- and Y-axes between 0.0 and 1.0 unless a
prologue is read from the DATAPLOT (*.EXP) data file.

Also see the DATPLOT User Guide included with this documentation set.

Syntax QUICK_EXPERIMENTAL_PLOT

Prompts

Prologue number: /0/: <Prologue number>

An Open window displays. Select the prologue to use. In a prologue, you can,
for example, give the scaling of an axis, the axis texts, and so on. By answering
-1, a list of all prologues on the file is given; and with 0, no experimental data
are appended.

Dataset number(s) /-1/: <Dataset number(s)>
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Syntax QUICK_EXPERIMENTAL_PLOT

Select from which dataset(s) data should be read. Several datasets may be
given separated with commas or spaces. By answering -1, a list of all datasets
on the file is given; and with 0, no experimental data are appended.

REINITIATE_PLOT_SETTINGS
All parameters describing the diagram are given default values.

Syntax REINITIATE_PLOT_SETTINGS

All plot settings made in the POST module are deleted, and it returns to the
initial settings when the POST module is entered.

RESTORE_PHASE_IN_PLOT
Restores a phase previously suspended from the plot with "SUSPEND_PHASE_IN_PLOT" on
page 270. It works only after at least one phase is suspended.

Syntax RESTORE_PHASE_IN_PLOT

Prompt
Phase name: <Name of a phase>

Give the name of the phase to be restored.

SELECT_PLOT
Select a plot within the current Results tab in the Console Results window.

Syntax SELECT_PLOT

Prompt

Plot <N/New>

Where N is a positive integer. Enter the number of the plot that is selected in
the Console Results window (in the currently selected Results tab). If a plot
with that number does not exist, it is created.

The default parameter value is NEW. If this is entered, then a new plot is
created. Create a new plot can also be done by pressing <Ctrl+Shift+T>.
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SET_AXIS_LENGTH
Change the real length of an axis in inches. The default number of tic-marks on an axis is 10
when the relative length is 1. The number and units per tic-mark must be a multiple of 1, 2
or 5 to obtain a reasonable scaling of an axis.

Syntax SET_AXIS_LENGTH

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis to set the length.

Axis length /11.5/: <New relative axis length>

Specify the new real axis length in inches. The relative length 1 corresponds to
10 tic-marks on the axis.

SET_AXIS_PLOT_STATUS
Specify whether the axis title texts and axis label texts are to be plotted or not on a diagram.
It does not work for the axis lines and tic-marks. If you want to plot a diagram without tic-
marks, use "SET_TIC_TYPE" on page 269 first.

This can be used to merge different diagrams on a pen-plotter or to obtain the diagram
faster. The default status is that all the set axes are to be plotted.

Syntax SET_AXIS_PLOT_STATUS

Prompt
Axis plot (Y or N) /Y/: (Y or N)

Specify to plot axis texts (Y) or no (N).

SET_AXIS_TEXT_STATUS
Change the axis text from the automatic text given by the axis specification to a text.

Syntax SET_AXIS_TEXT_STATUS

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis text status to change.

Automatic axis text (Y or N) /N/: <Y or N>

Specify if automatic axis text is to be used (Y) or (N). If you answer N, enter axis
text.
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Syntax SET_AXIS_TEXT_STATUS

Axis text: <Enter axis text>

You can enter simple text, use LaTeX, rotate the text, as well as adjust the font
size.

Also see "ADD_LABEL_TEXT" on page 243.

SET_AXIS_TYPE
Change the axis type among linear, logarithmic and inverse axis.

Syntax SET_AXIS_TYPE

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis to change the axis type.

Axis type /Linear/: <New axis type>

Specify which new axis type to set. Select LINear (default), LOGarithmic or
INVerse. Only the three first characters are relevant.

SET_COLOR
Some devices support colours or line thickness. With this command, select different colors or
line types on some types of information on a diagram.

This command can fail if a chosen device does not support colors or line
thickness.

This command gives four sequential prompts (i.e. Text and axis, Invariant equilibria, Tie-
lines, and All other lines), with the Keyword and default option (both listed below).
Depending on if the switched-on graphic device (by the SET_PLOT_FORMAT command)
supports colors or line types, the POST automatically switches on the appropriate Keyword.
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Syntax SET_COLOR

Prompt

Text and axis keyword /Default option/

<Return or new option>

Invariant equilibria keyword /Default option/: <Return or new
option>

Tie-lines color keyword /Default option/: <Return or new option>

Keyword of all other lines /Default option/: <Return or new
option>

This is usually for the solubility lines.

The Keyword is either Color or LineType, depending on if color or
line type is supported by the switched-on graphic device (by the
"SET_PLOT_FORMAT" on page 264 command); the POST module
automatically switches on the appropriate Keyword .

Color Options

The options for Color are:

BACKGROUND BLUE PURPLE GRAY

FOREGROUND (default) YELLOW GOLD4 ORANGERED3

RED (default for invariant equilibria) MAGENTA TURQUOISE4 MAROON

GREEN (default for tie lines) CYAN PINK PLUM

SIENNA OLIVEDRAB SEAGREEN

ORANGE1 CORAL1 USERDEF

LineType Options

The options for LineType are:
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INVISIBLE VERY_THICK  (default for invariant equilibria)

NORMAL (default) THIN (default for tie lines)

THICK VERY_THIN

DASHED DOTTED

SET_CORNER_TEXT
Adds text to the corners on a plotted diagram. Normally, you can write such texts as a
subtitle.

The primary database (not the appended ones) used in calculations and the calculated
conditions are automatically plotted at the upper-left corner as a part of the header on all
plotted diagram. Unless the plotting option WRITE CONDITIONS is switched off by the
command "SET_PLOT_OPTIONS" on page 264, the calculated conditions are always written
on plotted diagrams; and only when the plotting option PLOT HEADER is switched off by the
command SET_PLOT_OPTION, the used database also always appear. Under such
circumstance, avoid writing texts at the UPPER_LEFT corners.

Syntax SET_CORNER_TEXT

Prompt

Corner/Lower_Left/: <Return or new option>

Choose an option:

l LOWER_LEFT

l UPPER_LEFT

l UPPER_RIGHT

l LOWER_RIGHT

l TOP_OF_TRIANGLE

Text: <Texts as a subtitle or a note>

Write the texts that are to be written on the specified diagram corner.

SET_DIAGRAM_AXIS
Specify an axis variable for a plot or a listing. To be able to plot a diagram, at least two axis
variables (X and Y) must be specified. In the Thermo-Calc Console Mode, three axes (X, Y
and Z) can be specified for a diagram.
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The axis variables in the plot can be different from the number of axis used for
the mapping.

If you want to plot a phase diagram with tie-lines in the plane after a MAP calculation, then
the composition axis must be mole-fraction or weight-fraction, or mole-percent or
weight-percent of one specific component. You must not use the stable variable x(comp)
or w(comp) even if that is what you used when calculating the diagram, because that only
gives one side of the two-phase region. It may be sufficient to indicate that mole-fraction is
the same as the stable variable x(*,comp), and weight-fraction is the same as the stable
variable w(*,comp).

If you plot a phase diagram where the tie-lines are not in the plane after a MAP calculation,
then mole-fraction and x(comp) are identical.

When you plot a property diagram after a STEP calculation and want a composition axis
variable, you should normally use x(comp) and not mole-fraction.

The axis must have exactly the same number of columns, or one axis must have one column.
In the first case the columns are plotted matching them one by one; in the latter all columns
on one axis is plotted against the single column. For example, you can have the temperature
on one axis and the amount of each phase on the other. The amount of each phase is the
state variable NP(*) in mole fraction or BPW(*) for mass fractions of phases.

Automatic diagram axis:  The POST module can set automatic diagram axis identical to
those used in the "MAP" on page 212 command.

If the state variable x(comp) is used in a MAP calculation, then mole-fraction of the
component is used as diagram axis; if a potential or some other state variables are used,
then that is used as a diagram axis.

After a STEP calculation, automatic diagram axis is not set as there is only one axis used in
the calculation.

Syntax SET_DIAGRAM_AXIS

Axis (X, Y or Z): <Axis name>

Specify which axis (X or Y or Z) to set with a variable.

Prompts

Variable type: <Variable name>

Specify a variable for the chosen axis here.

The valid variables are:

l TEMPERATURE-CELSIUS as temperature in oC

l TEMPERATURE as temperature in K
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Syntax SET_DIAGRAM_AXIS

l PRESSURE as pressure in Pa

l ACTIVITY for a component

l LNACTIVITY for a component  [ln(ACR(component)]

l MOLE-FRACTION  for a component

l MOLE-PERCENT for a component

l WEIGHT-FRACTION  for a component

l WEIGHT-PERCENT  for a component

l NONE  to clear the axis

l Any valid state variable including those with wildcards, e.g. NP(*) or x
(*,component). Due to the use of wildcard * in such a state variable,
the program asks for a column number.

l Any entered function or variable.

l Any entered table.

If you specify an entered table as the variable, then you are given these
prompts:

For component: <Component name>

When an activity, mole or weight fraction or percent of a component shall be
plotted, the component name must be supplied here.

Column number: <Column number(s)>

Specify the column number(s) in the chosen table that are to be plotted onto
the earlier specified axis.  For example:

l 1 for column 1

l 2,3 for columns 2 and 3

l 2,3 >5 for column 2,3 and all columns above column 5

l * for all columns

SET_DIAGRAM_TYPE
Choose the diagram type as perpendicular plot or triangular plot (Gibbs triangle, especially
for ternary systems). The default is with a perpendicular axes.
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For phase diagrams of ternary or pseudo-ternary systems, it is usually need to plot
isothermal sections as triangular grams. If desired, all lines outside the region limited by a
line joining the end points of the X- and Y-axis is removed.

In order to create a 3D-plot file (in the VRML format, *.WRL) for a tetrahedron
diagram, this command in the sequence SET_DIAGRAM_TYPE N Y should be
used first.

Syntax SET_DIAGRAM_TYPE

Prompts

Triangular diagram (Y or N) /N/: <Y or N>

Specify a triangular plot Y. Otherwise (by pressing <Enter> to accept N),
perpendicular axis is set and this command is terminated. By default,
perpendicular diagrams have (almost) the same scaling on both axes.

Create tetrahedron WRML file (Y or N) /N/: <Y or N>

If a triangular plot is not selected (at the above prompt), answer Y in case a
tetrahedron diagram is used to generate VRML (*.WRL) file by sequentially
using the CREATE_3D_PLOTFILE command.

Plot 3rd axis (Y or N) /N/: <Y or N>

If a triangular plot is selected, specify if a 3rd axis (by answering Y here),
connecting the end points of the X- and Y-axes, is plotted.

Clip along 3rd axis (Y or N) /N/: <Y or N>

If a triangular plot is selected, all lines outside the region limited by a line
joining the end points of the X- and Y-axis are removed by answering Yes (Y).

SET_FONT
Select the font to use for labels and numbers when plotting the diagram under the currently
selected graphic device ("SET_PLOT_FORMAT" on page 264). For some devices there may
be other fonts available and these are selected by the SET_PLOT_FORMAT command.

Syntax SET_FONT

Prompts

Select font number /1/: <#>

Specify an available font number # as the default font for the
current graphic device, or accept the font number 1 by pressing
<Enter>. By typing a question mark ? here, the program lists the
available fonts under the currently selected graphic device.

Font size /.34/: <##>
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Syntax SET_FONT

The size of the chosen font is specified. A value around 0.34 is
recommended.

SET_INTERACTIVE_MODE

Syntax SET_INTERACTIVE_MODE

Resets the input and output units to their initial values, i.e. keyboard and screen.

Remember to add this as the last command to your MACRO files, in
order to stop execution of the command file in the POST module. It
has no meaning in interactive mode.

SET_LABEL_CURVE_OPTION
Identify the curves drawn in the post-processor by marking each curve with a digit and then
list the meaning of these digits beside the plot.

The number of digits can be quite large in some cases. If so, use the SET_FONT
command and reduce the font size; usually, 0.2 is sufficient.

Syntax SET_LABEL_CURVE_OPTION

Prompt Curve label option (A, B, C, D, E, F OR N) /A/: <Option>

The options:

l A: List stable phases along line

l B: As A but curves with same fixed phase have same number

l C: List axis quantities

l D: As C but curves with same quantities have same number

l E: As B with changing colors

l F: As D with changing colors

l N: No labels

This question is rather cryptic but usually the option B or E is good for phase
diagrams (after a MAP command) and option D or F for property diagrams
(after a STEP command). Those interested can try out the option A and C by
themselves.
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Syntax SET_LABEL_CURVE_OPTION

Option B or E lists the fixed phases along each curve, whereas
option D or F gives the axis variables used along each curve. E
provides varied colors for different stable-phase curves on phase
diagrams (after a MAP command); F provides varied colors for
different property curves on property diagrams (after a STEP
command). The option N (NONE) disables all curve labels and lists.

If, for example, you use T (temperature in K) as the variable axis in a STEP
command and then plot the amount of stable phases (with "SET_DIAGRAM_
AXIS" on page 259 Y NP(*)) on the Y-axis versus T-C on the X-axis, then the list
may have lines like:

1: T-273.15, NP(LIQUID)

2: T-273.15, NP(FCC_A1)

This means that for curve 1 the X-axis is T-273.15 (the same for all curves, of
course) and NP(LIQUID) on the Y-axis. Curve 2 has the same X-axis but NP
(FCC_A1) on the Y-axis.

SET_PLOT_FORMAT
Set the format of the graphical output to different graphical devices. The default graphic
device is normally for screen output (number 22 - TCUNITE Driver). Legacy devices can still
be used (1 for Windows and 9 for XWindow for Linux). This default graphic device value may
also be altered with "SET_PLOT_ENVIRONMENT" on page 303 in the system monitor or by
your TC.INI file.

Syntax SET_PLOT_FORMAT

Prompt

Graphic device number /#/: <Number of the device>

Specify a graphic device number. Depending on the hardware, different plot
formats (graphic devices) may be available. These are listed online by giving a
question mark ?.

For some formats there can be additional sub-prompts, asking for if using (YES)
or not using (NO) the fonts available for the chosen format, and if YES for
further specifications, e.g. font type and size.

SET_PLOT_OPTIONS
You are prompted for and can toggle on (Y) or off (N) the plotting of some options on all
subsequently generated diagrams.
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For the Always initiate POST on re-entering prompt, the default is Y which implies
that the POST module automatically reinitiates whenever the POLY3 workspace is changed
upon re-entering. If answered N the same diagram axis variables are kept even if the
workspaces in the POLY module are read from or written to an *.POLY3 file. The N answer is
useful when there are several sets of *.POLY3 files with the same calculation but for
different sets of model parameters.

For the Always solid line prompt, the default answer is N which means that the POST
module plots solid lines for stable phases but dashed lines for metastable phases. This is
normally for plotting property diagram after a STEPPING calculation; however, when there is
a metastable extrapolation in a phase region on a phase diagram after a MAPPING
calculation, this is also enforced. When the alternative answer Y is chosen, all the lines are
always plotted in solid lines.

Syntax SET_PLOT_OPTIONS

Prompts

Plot header /Y/: <Y or N>

Toggle the plotting of the Thermo-Calc header text above a
diagram.

Plot logo /Y/: <Y or N>

Toggle the plotting of the Thermo-Calc logotype at the lower-left
corner of a diagram.

Plot footer /Y/: <Y or N>

Toggle the plotting of the footer identifier text at the right margin
of a diagram.

White-Contoured-PS-CHARS /Y/: <Y or N>

This makes it possible to write PostScript characters in white
contoured status.

Plot remote exponent(s) /Y/: <Y or N>

This sets (Y) or removes (N) the plotting of the remote exponent on
the axis.

Plot symbols at node points /0/: <#>

This makes it possible to plot symbols at the node points on plotted
lines on a diagram.

Symbol size /.1/: <.#>

Set the size of symbols which are plotted at the node points.
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Syntax SET_PLOT_OPTIONS

Write condition? /Y/: <Y or N>

The initial equilibrium conditions for the current calculations are
automatically plotted at the upper-left corner as a part of the
header. With this option switched off (by answering N), it makes
possible to not write the calculated conditions on a plotted diagram.

Write database name? /Y/: <Y or N>

Primary database (not the appended ones) used in the current
calculations are automatically plotted at the upper-left corner as a
part of the header. With this option switched off (by answering N), it
makes possible to not write the database name on a plotted
diagram.

Always initiate POST on re-entering: /Y/: <Y or N>

Y lets the POST module automatically reinitiate whenever the
POLY3 workspaces are changed upon re-entering. If answered N,
the same diagram axis variables are kept even if the workspaces in
the POLY module is read from or written to an *.POLY3 file.
Answering N is useful when there are several sets of *.POLY3 files
with the same calculation but for different set of model
parameters.

Always solid line: /N/: <Y or N>

N allows the POST module to plot solid lines for stable phases but
dashed lines for metastable phases. This is normally for plotting
property diagram after a STEPPING calculation; however, when
there is a metastable extrapolation in a phase region on a phase
diagram after a MAPPING calculation, this is also enforced. When
answered Y all the lines are always plotted in solid lines.

SET_PLOT_SIZE
Change the size of the diagram by specifying a global plot size (as a relative scaling factor).
The default value of the relative scaling factor is 1, while the real size of the plotted diagram
depends on what output device is chosen with "SET_PLOT_FORMAT" on page 264. The
default plot size (corresponding to the default global plot size 1) is adjusted to the chosen
device.
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Syntax SET_PLOT_SIZE

Prompt

Global plot size /1/: <Relative scaling factor>

Enter the relative scaling factor as a numerical number (e.g. 0.5, 0.8, 1.0,
1.5, etc.). By pressing <Enter>, the default relative scaling factor (1) is
accepted.

SET_PREFIX_SCALING
Set the prefix scaling of remote exponents with certain powers (default is 3), by taking as
argument with an axis name and a YES, or NO, or an integer number # (as the powers for
the remote exponents):

NO switches off its action.

YES arranges the prefix scaling so that the axis scaling is done with the remote exponents
being powers of three, i.e. ...,-6,-3,0,3,6,...

# sets the remote exponents as being powers of #.

Syntax SET_PREFIX_SCALING

Prompt
Axis (X, Y or Z): <Name of an axis>

Specify which axis is to have a prefix scaling.

Use prefix scaling /Y/: (Y or N or #)

Answer either Y or N or an integer number as described above.

SET_RASTER_STATUS
Plot a raster (i.e. with gridlines on both axis directions) in the diagram. The default status is
no raster plotted.

Syntax SET_RASTER_STATUS

Prompt
Raster plot (Y or N) /N/: <Y or N>

Enable (Y) or disable (N) the raster plot.

SET_REFERENCE_STATE
The reference state for a component is important when calculating activities, chemical
potentials and enthalpies. After calculating with "STEP_WITH_OPTIONS" on page 227 or
"MAP" on page 212, the reference state for a component can also be changed for plotting
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various properties of the component in the entire system or in a specific phase by using this
command. Afterwards, you can set diagram axes as chemical potential or activity quantities
with the R suffix, i.e. MUR(comp), MUR(comp,ph), ACR(comp),  ACR(comp,ph) or their
common logarithms [e.g. LNACR(comp,ph)].

Syntax SET_REFERENCE_STATE

Prompts
Component: <Name of the component>

The name of the component must be given.

Reference state: <Name of a phase used as the new reference
state>

The Name of a phase, that must be either ENTERED, DORMANT or
SUSPENDED, is given here. The component must, of course, be a constituent of
this phase.

A subtle problem is that if the component exists in several species in the
phase, for example, oxygen as O, O2 and O3 in a gas. Normally, you would like
to have the most stable species as reference state of oxygen, i.e. O2 in this
case. When setting the reference state, a one-time calculation is made for the
Gibbs energy. This is for all possible states with the pure component phase at
the current temperature and the command selects the most stable one as the
reference state.

Temperature /*/: <Reference temperature>

Select the temperature (in K) for the reference state. The value * means the
current temperature is used for the calculation.

Pressure /1E5/: <Reference pressure>

Select the pressure (in Pa) for the reference state. The value * means the
current pressure is used for the calculation.

SET_SCALING_STATUS
When an axis variable is selected by "SET_DIAGRAM_AXIS" on page 259, the scaling status
for the axis is always set to automatic scaling. By this command, choose between manual or
automatic scaling on a specified axis. If manual scaling is chosen, specify a minimum and a
maximum value. Manual scaling can be used to magnify interesting parts of a diagram.
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Syntax SET_SCALING_STATUS

Prompts
Axis (X, Y or Z): <Name of an axis>

Specify which axis that you want to set the scaling status.

Automatic scaling (Y or N) /N/: <Y or N>

Choose between automatic (Y) and manual scaling (N). For manual
scaling specify these parameters:

Min value: <Minimum value>

The minimum value at the start point of the specified axis.

Max value: <Maximum value>

The maximum value at the end point of the specified axis.

SET_TIC_TYPE
Change the drawing of the axis tics. You may alter the placement of tic marks on the axis,
e.g. inside or outside or no tic marks. The size of tic marks cannot be altered by this
command, but these are adjusted based on the selected graphic device and the defined
relative scaling factor (global plot size).

Syntax SET_TIC_TYPE

Prompt

TIC Type /1/: <1 or -1 or 0>

The tic type 1 is default, i.e. the tics are drawn outside the diagram. -1 means
that the tics are inside the diagram and 0 means no tics.

SET_TIELINE_STATUS
If the tie-lines are in the plane of the calculation, you can select to plot the tie-lines in two-
phase fields with this command.

Syntax SET_TIELINE_STATUS

Prompt

Plotting every tie-line no. /0/: <Number of tie-lines>

The tie-lines plotted are not equally spaced by the graphics software. Instead,
you can select to plot a subset of the calculated tie-lines, i.e. every one (1),
every second (2), every three (3), etc. By accepting the default value 0, no tie-
line is plotted.
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SET_TITLE
Specify a title that displays on all listed tables and plotted diagrams from the POST module
in the same run of Console Mode.

Syntax SET_TITLE

Prompt

Ttitle <Title>

Enter the title you want to appear on all tabulation or graphic outputs.

There is a maximum length of about 60 characters for the title.
You can enter simple text, use LaTeX, rotate the text, as well as
adjust the font size.

Also see "ADD_LABEL_TEXT" on page 243.

SET_TRUE_MANUAL_SCALING
The tic-marks on the axes are normally placed in even intervals using the whole axis length.
The scaling routine adjusts the given minimum and maximum values slightly to accomplish
this. If such an automatic adjustment behaviour is unwanted, it can be avoided by using this
command (followed by a message showing the TRUE MANUAL SCALING set for a specific
axis).

The command works like a toggle. To reset the automatic scaling behaviour, repeat the
command a second time for that specific axis (followed by a message saying the SEMI_
MANUAL SCALING set for the specific axis.

Syntax SET_TRUE_MANUAL_SCALING

Prompt

Axis (X, Y or Z): <Name of an axis>

Specify which axis (X or Y or Z) you want to toggle between automatic
adjustments or avoid the adjustment of the given maximum and minimum
values.

SUSPEND_PHASE_IN_PLOT
Specify that lines originating from the presence of a certain phase shall not be plotted on a
diagram. If you want to bring the suspended phase back to the diagram, use "RESTORE_
PHASE_IN_PLOT" on page 255.
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Syntax SUSPEND_PHASE_IN_PLOT

Prompt
Phase name: <Name of a phase>

Specify the name of the phase to be suspended from the diagram.

TABULATE
For any entered table, this command gives a table of values from equilibria calculated with
a STEP command. It works only for a table that is entered in either the POLY or POST
module.

Unlike the TAB module's command (also called "TABULATE" on page 315) it is
not possible to plot columns from the tabulated tables. For this use normal POST
commands.

Syntax TABULATE

Prompts
Name: <Name of a table entered in either POLY or POST>

Specify a table name that is entered in either the POLY or POST module.

Output on screen or file /Screen/: <File name or return>

Specify a file name if you want to save on a file the table values along the
defined STEP calculation, or press <Enter> if want to see the table values
displayed.
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POTENTIAL_DIAGRAM Module
In this section:

POTENTIAL_DIAGRAM 273



Thermo-Calc Documentation Set

POTENTIAL_DIAGRAMModule ǀ 273 of 370

POTENTIAL_DIAGRAM
The POTENTIAL_DIAGRAM module (short name, the POTENTIAL module) is a potential phase
diagram calculation module.

If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a so-
called potential phase diagram given certain temperature and pressure. A potential diagram
uses the activities of two major species in the gaseous mixture phase as mapping variables.
The activities (that is, the fugacities at 1 bar) of these two species are typically set as the X-
and Y-axis when the diagram is plotted. The phase relations between the gaseous mixture
and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are
represented by different fields controlled by these two potential quantities.

To enter the module, at the SYS prompt type GOTO_MODULE POTENTIAL.

There are no commands for this module. Follow the prompts and see "About
Potential Diagrams" on page 195 in the Thermo-Calc User Guide for details
about how to calculate using potential diagrams.

See example tcex35 in the Thermo-Calc Console Mode Examples Guide.

Syntax POTENTIAL_DIAGRAM

Prompts

Database: /POT/

Press <Enter> and the program lists the available databases. Type one of the
database names and press <Enter> to select. The following default elements
are then based on the chosen database.

Matrix element: /Fe/

First potential species: /S1O2/

Second potential species: /O2/

Temperature: /1000/
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POURBAIX_DIAGRAM Commands
Also search the online help or see the Pourbaix diagrams educational material
and the Thermo-Calc User Guide.

In this section:

POURBAIX_DIAGRAM Commands 275

Pause Options 277



Thermo-Calc Documentation Set

POURBAIX_DIAGRAM Commands ǀ 275 of 370

POURBAIX_DIAGRAM Commands
Also search the online help or see the Pourbaix diagrams educational material
and the Thermo-Calc User Guide.

See examples tcex40 and tcex53 in the Thermo-Calc Console Mode Examples
Guide.

After you enter the POURBAIX_DIAGRAM module, you are prompted with the following:

Need any instruction on the Pourbaix module? /N/:Y

If you answer Y the following notes are displayed.

l The Pourbaix diagram is actually a calculated equilibrium phase diagram mapped
and plotted with the independently-varied electropotential (Eh, as defined with
regard to the standard hydrogen electrode as its reference) and acidity (pH), that
represents all the equilibrated phase boundaries among aqueous solution, gaseous
mixture, and various primary and secondary solids (modelled as either complex
solution or simple stoichiometric phases) in a certain multicomponent heterogeneous
interaction system, under a defined T-P condition and a specific initial bulk
composition (which is, by default, always set as 1 kg of water dissolving a specified
amount of metals/alloys and other acids/alkalines/salts).

l At least one database is required that contains an AQUEOUS solution phase (with
thermodynamic data for water and various aqueous solutes), that shall be selected
from TCAQ (PAQ) or AQS (PAQS) [which use the SIT Model or the Complete Revised
HKF Model, respectively] within the Thermo-Calc database spectrum, or be chosen
from an appropriate USER-specified database (it must be in the Thermo-Calc TDB
format).

l Due to the restrictions of aqueous solution model used within Thermo-Calc, such a
database must be designed in the same format as in the default TCAQ (PAQ) or AQS
(PAQS) for AQUEOUS solution phase. Among others, one should keep in mind the
following regulations:

l The ELECTRON is defined as an special element (ZE) and as the only
constituent in its reference phase REFERENCE_ELECTRODE (for determining
the electro-potential that is defined as Eh with the standard hydrogen
electrode as the reference), but it is not defined as an aqueous species;

l The vacancy (VA) is unnecessary for AQUEOUS solution phase and it should be
avoided in the definition of phase-constituents in the AQUEOUS phase;

l The AQUEOUS solution phase should always be defined as a constitutional solution
phase, implying that all the aqueous solution species must be included in a single
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site, rather than in two or multiple sublattices.

l Beside the AQUEOUS solution phase, there shall exist a GAS mixture phase
containing at least H2O1, O2 and H2; and for multicomponent systems, normally
there shall also contain some solid (stoichiometric or solution) phases. Of course, if
desired, you could also choose to calculate and generate a Pourbaix diagram
without considering the GAS mixture phase entirely; however, such a plot is not
really a complete Pourbaix diagram, due to the fact that thermodynamically-stable
phase boundaries between the AQUEOUS solution phase and GAS mixture phase will
then not be calculated at all!

l All the required thermodynamic data for calculations of Pourbaix diagrams or other
diagrams must be retrieved either from one (Single) database which consists of an
AQUEOUS solution phase, a GASeous mixture phase, a REF_ELECTRODE phase, and
some SOLID phases (being solutions and/or stoichiometric compounds; for primary
metals/alloys and for secondary products formed from heterogeneous
chemical/electrochemical interactions, or from several (Multiple) databases that
respectively contain various solutions/compounds (as listed above).

Such databases suitable for calculations of aqueous-bearing heterogeneous
interaction systems can be those default-prompted ones [i.e., in the Single-Database
case, the PAQ or PAQS; and in the Multiple-Database case, the TCAQ or AQS as
primarily-switched database, plus the SSUBx as firstly-appended one and the SSOLx as
secondly-appended one if it is necessary; even more databases can be appended). Of
course, you could also choose to append required data from other appropriate
databases (such as TCFE, TCSLD, TCNI/TTNi, TCAL/TTAl, TCMG/TTMg, TTZr, TCMP,
SLAG, etc.) for GASeous mixture phase and for varous solid solution and
stoichiometric compound phases. Furthermore, an experienced user can also utilize
his/her own USER-specified databases in various cases.

l The current advanced POURBAIX-Module has been designed and developed in an
efficient and effective way that it only requires the user to just answer some simple and
necessary questions, rather than to go through basic modules (i.e., TDB, GES5, POLY3
and POST) and type the ordinary command-lines. Beside the default plotted Pourbaix
diagram, it also allows the user to easily and quickly plot many different properties of
the system, stable phases and aqueous species, varied along the calculated phase
boundaries for the same defined heterogeneous interaction system. Moreover, it
permits the user to directly change some plotting settings and manipulate all kinds of
plotted diagrams.

l The current advanced POURBAIX-Module has been extended so that it is additionally
able to directly perform a normal STEPPING calculation (varied with a specified
independent variable) and to easily generate various types of property diagrams, for
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the same heterogeneous interaction system that has been defined in a previous
POURBAIX or TDB-GES5-PLOY3-POST calculation. 

Pause Options
After this information is displayed, you are prompted:

Enforce a PAUSE after plotting when running a MACRO? /N/:

If you answer Y the following options are displayed.

1. Start a completely new Pourbaix diagram calculation

2. Open an old file & plot other property diagrams

3. Open an old file & make another Pourbaix calculation

4. Open an old file & make another stepping calculation

Option 1: Start a completely new Pourbaix diagram calculation

Make a completely new POURBAIX diagram calculation and automatically plot a pH-Eh
diagram. i.e., define a new chemical system; specify the T-P-X conditions; calculate the
initial equilibria; perform the pH-Eh mapping calculation; plot pH-Eh & various property
diagrams.

Consider the GAS phase in calculating a Pourbaix diagram? /Y/

Use single database? /Y/:

Combined database: /PAQ2/:

DEFINE A CHEMICAL SYSTEM AND ITS INITIAL BULK COMPOSITION:

Normally a Pourbaix diagram and related equilibrium property in a heterogeneous
interaction system are calculated under a certain bulk composition which is usually 1 kg of
water with defined amounts of dissolving solute substances. The solutes may either be
completely dissolved into the aqueous solution, or be partially dissolved and simultaneously
form some solid  phases.

CHEMICAL SYSTEM (ELEMENTS):

Default defined elements  (solvent  H2O): H  &  O and specially assigned ZE(electron) & VA
(vacancy).

Prompt specified elements (solutes  ELEM): Fe  Ni  Co  Cr  C   N   S   Na  Cl

INITIAL BULK COMPOSITION:  Default defined composition  (solvent):    1.0 kg of H2O 

Prompt specified composition (solutes):    x mole of ELEM
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Notes: For accepting a default value, just RETURN at prompt; 

For changing to a specific value, enter it at prompt. 

IMPORTANT NOTE for Entering Solutes in Chemical Formulas:

First element letter in UPPER case, and second lower case! such as  NaCl  CO2  CoCl3 
Fe0.93S  NaSO4-1  H2SO4

Mass of Water (weight) = 1 kg

Option 2: Open an old file and plot other property diagrams

Open an existing POLY3 file created by POURBAIX Module (from a previous POURBAIX
calculation Option 1 or 3 or  a previous STEPPING calculation Option 4), and just selectively
plot other property diagrams. i.e., open the old GES and POLY3 workspaces; plot pH-Eh or
various property diagrams.

File name /Pourbaix/

X-axis Variable: /PH/:

Y-axis Variable: /EH/:

Change axis type? /N/:

Zoom in? /N/:

Change curve-label option for the diagram? /N/:

Add label-texts onto the specified diagram? /N/:

Change the subtitle of the diagram? /N/:

Change axis-texts? /N/:

Further refine the diagram in POST module? /N/:

Hard copy of the diagram? /N/:

Save X-Y coordinates of curve on text file? /N/:

Modify the diagram? /N/:

Any more diagram? /N/:

Option 3: Open an old file and make another POURBAIX calculation

Open an existing POLY3 file created by POURBAIX Module and make another POURBAIX
diagram calculation i.e., open the old GES and POLY3 workspaces; adopt the defined
chemical system; modify the T-P-X conditions; calculate the initial equilibria; perform the
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pH-Eh mapping calculation; plot pH-Eh & various property diagrams.

Consider the GAS phase in calculating a Pourbaix diagram? /Y/:

File name /C:\Users\hilary\DOCUME~1\POURBA~1.POL/:

Enforce Global Minimization Technique in calculations? /N/:

Save all functions, variables and tables in POLY3 file? /Y/:

Set numerical limits? /N/:

Set calculating parameters:

List of default and pre-defined calculation conditions:

Units: T in K, P in Pascal, B(H2O) in gram, N(ELEM) in mole 

T=298.15, P=1E5, B(H2O)=1000, N(H+1)=0, N(ZE)=0

Degrees of freedom 0

Confirm defined conditions? /Y/:

Additional Information About Option 3

The default definitions of the Eh and pH quantities in the advanced POURBAIX-Module (and
in the ordinary TDB-GES-POLY calculation routines) should ALWAYS be as below:

Eh = MUR(ZE)/RNF

pH = -log10[AI(H+1,AQUEOUS)]

= -log10[ACR(H+1,AQUEOUS)*AH2O]

where RNF is the Faraday constant (96485.309 C/mol), and AH2O is the molecular weight of
H2O (55.508435 g). MUR(ZE) is the electrochemical potential (ECP; in the unit of J/mol;
w.r.t. the standard hydrogen electrode). ACR(H+1,AQUEOUS) is the site-fraction-based
activity of the H+1 aqueous species in AQUEOUS solution phase, but AI(H+1,AQUEOUS) [that
equals ACR(H+1,AQUEOUS)*AH2O] is the molality-based activity of the H+1 aqueous species
that should be used for defining the pH quantity.

Within an aqueous-bearing heterogeneous interaction system, the fundamental system-
components must be H2O, H+1 and ZE, which are corresponding to the basic elements O &
H and the hypothetical electron (ZE) in the aqueous solution phase. For the additional
chemical elements in the system, their corresponding system-components shall be defined
as in their element forms (such as Fe, Cr, Mn, Ni, Na, Cl, S) or (for some) in their molecular
forms (e.g., NaCl, H2S). The reference state for the H2O component must always be defined
as the solvent species H2O in the AQUEOUS solution phase under the current temperature
(*) and 100000 Pascal (i.e., 1 bar). The reference states for the H+1 and ZE components are
by default set as their SER.
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Various conventional properties of aqueous solute species I are converted in the following
manners: 

ML = Y(AQUEOUS,I)*AH2O/YH2O

RC = ACR(I,AQUEOUS)*YH2O/Y(AQUEOUS,I) 

AI = RC*ML

= ACR(I,AQUEOUS)*AH2O

where YH2O [i.e., Y(AQUEOUS,H2O)] and Y(AQUEOUS,I) are the site-fractions of solvent
H2O and solute species I.

LIST THE DEFINED AXIS-VARIABLES:

Axis No 1: LNACR(H+1)Min: -34.532525Max: 2.3025851 Inc: 0.8

Axis No 2: MUR(ZE)  Min: -150000  Max: 200000   Inc: 7718.85

NOTE: The default settings (listed above) for two mapping variables [in terms of lnACR(H+1)
and MUR(ZE), and their minimum/maximum values and increment steps] are covering the
following pH-Eh ranges/steps:

pH: 0.00 -> 14.00, at a step of 0.35   

Eh: -1.55 -> 2.07, at a step of 0.08 (V)

The maximum pH limit has been calculated precisely and determined automatically by the
POURBAIX-Module, as a function of the temperature-pressure conditions and initial bulk
compositions of the current defined interaction system.

Accept the default settings for two mapping variables? /Y/:

Any missing phase boundary you could possibly think of? /N/:

Change the pH/Eh steps for smoother curves? /N/:

Zoom in? /N/:

Change curve-label option for the diagram? /N/:

Add label-texts onto the Pourbaix diagram? /N/:

Change the subtitle of the diagram? /N/:

Change axis-texts? /N/:

Further refine the diagram in POST module? /N/:

Hard copy of the diagram? /N/:

Save X-Y coordinates of curve on text file? /N/:

Modify the diagram? /N/:

Any more diagram? /N/:
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Option 4: Open an old file and make another STEPPING calculation

Open an existing POLY3 file created by POURBAIX Module (from a previous POURBAIX
calculation Option 1 or 3 or  a previous STEPPING calculation Option 4), and make a normal
STEPPING calculation. i.e., open the old GES and POLY3 workspaces; adopt the defined
chemical system; specify one of the T-P-X conditions as the stepping variable; calculate the
initial equilibria; perform the stepping calculation; plot various property diagrams.

Because of that in a STEPPING calculation will change some system definitions in a
POURBAIX-type POLY3 file, it is highly advisable to make a backup of the existing POURBAIX-
type POLY3 file (which you are going to open in this STEPPING calculation) before you
proceed the further steps; otherwise, the structure of the loaded POLY3 file will be
alternated by the option "4", and consequently the existing POLY3 file may be not suitable
for other POURBAIX-type calculation any longer. Therefore, if you have not done so, you
should make the copy right now!

However, a POLY3 file which is modified by this option can be further used for another
STEPPING calculation inside the POURBAIX Module (by a repeated Option 4) or in normal
POLY3 Module.

File name /C:\Users\hilary\DOCUME~1\POURBA~1.POL/:

Enforce Global Minimization Technique in calculations? /N/:

Save all functions, variables and tables in POLY3 file? /Y/:

Set numerical limits? /N/:

Set calculating parameters:

List of Default and Pre-defined Calculation Conditions:

--------------------------------------------------------------

Units: T in K, P in Pascal, B(H2O) in gram, N(ELEM) in mole 

--------------------------------------------------------------

T=298.15, P=1E5, B(H2O)=1000, N(H+1)=0, N(ZE)=0

DEGREES OF FREEDOM 0

Further modify system definitions & conditions in POLY3 module? /N/:

Confirm defined conditions as the starting point? /Y/:

The following parameters are suitable for a STEPPING calculation for the defined aqueous-
bearing system. Choose one of them as the stepping variable:

T Temperature (C)

P Pressure (bar)

pH Acidity
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Eh Electronic Potential (V)

N(Comp) Mole of One Component

where "Comp" is the name of a specific component as listed below. One should not use any
key component (H2O or H+1 or ZE) as such a stepping variable, because of that their
compositional definitions and variations are determined by the AQUEOUS solution phase in
the POURBAIX Module.

An interacting component defined as an element (such as Fe or Na or Cl) can be selected as
a stepping variable.

However, if you want to make a stepping calculation with a non-element chemical formula
(such as NaCl or CaS2) as the stepping variable, one must have made some necessary
modifications in the POLY3 Module, before reaching this point, by  conducting some POLY3
commands as given below (as an example for the system Fe-Na-Cl-H-O):

POLY_3: def-component H2O H+1 ZE Fe NaCl Cl

POLY_3: set-ref-state H2O AQUEOUS * 1E5

POLY_3: set-ref-state ZE REF_ELEC * 1E5

POLY_3: change-status phase REF-ELEC=SUSPEND

POLY_3: set-cond b(H2O)=1000 n(H+1)=0 n(ZE)=0

POLY_3: set-cond P=1E5 T=298.15**

POLY_3: set-cond n(Fe)=1E-3 n(Cl)=0 n(NaCl)=3 **

** Here the P-T-n(Fe) conditions can be set as what you wanted, while the initial n(NaCl)
value must be set as between its minimum and maximum values that you are interested in.
Later on, it will be prompted for specifying the n(NaCl) Min-Max-Step values of the stepping
calculation.

Stepping variable: /T/:

Minimum temperature (C) /15/:

Maximum temperature (C) /35/:

Increment in temperature (C) /1/:

Change axis type? /N/:

Zoom in? /N/:

Change curve-label option for the diagram? /N/:

Add label-texts onto the specified diagram? /N/:

Change the subtitle of the diagram? /N/:

Change axis-texts? /N/:

Further refine the diagram in POST module? /N/:
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Hard copy of the diagram? /N/:

Save X-Y coordinates of curve on text file? /N/:

Modify the diagram? /N/:

Any more diagram? /N/:
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REACTOR_SIMULATOR_3 Commands
In this section:

CREATE_DIVIDERS 285

CREATE_PIPES 285

CREATE_STAGE_BOXES 286

EXECUTE_POLY3_COMMAND 288

LIST_RECORDS 288

READ_WORKSPACE 288

SAVE_WORKSPACE 289

START_SIMULATION 290
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CREATE_DIVIDERS
This is a command used with the REACTOR module.

Define the segment boundaries and the ways on how to distribute phases between various
segments and to split the feeds of heat and mass.

Syntax CREATE_DIVIDERS

Prompts

Number of dividers /4/: <The number of dividers>

Specify the number of dividers (boundaries between various
segments) in the reactor. It is normally the segment number plus
one: for example, if the stage box number is defined as 4, the
divider number should be defined as 5.

Number of outputs for divider # /3/: <The number of
outputs>

Specify the number of outputs for a specific divider #.

Percent of input to output 1 /100/: <Percent of input>

Define the percentage of input to the output 1 in the current divider
#.

Percent of input to output ## /100/: <Percent(s) of
input(s)>

Define the percentages of inputs to the outputs ## in the current
divider #. It is repeated till the last output is specified.

CREATE_PIPES
This is a command used with the REACTOR module.

Define the pipes between various segments and the ways on how the mass and heat
transport between the surroundings (with the record number as 0) and the reactor, among
various segments in the reactor, and along various dividers (segment boundaries in the
reactor).
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Syntax CREATE_PIPES

Prompts

From record: <A record number>

Specify a record number. If there are four segments in the reactor, these
records are available:

l 0 surroundings

l 1-4 stage boxes (segments)

l 5-9 dividers (segment boundaries)

Pipe to record: <Another record number>

Specify another record number to which the mass or heat flows from the
current record (specified above).  Before this prompt, a message shown on the
screen indicates what kind of mass or heat flow (according to the definitions of
stage boxes and dividers, which have already been created prior to this
command) should be specified in the pipe. This is repeated for all inputs
and/or outputs for mass and/or heat in current record.

CREATE_STAGE_BOXES
This is a command used with the REACTOR module.

Create several reaction stages as boxes (segments), where the you define the feed in either
mass input and initial temperature or heat input from surroundings, as well as the mass out
and initial temperature in each of the segments.

Syntax CREATE_STAGE_BOXES

Prompts

Number of stage boxes /4/: <The number of stage boxes>

Specify the number of stage boxes in the reactor. Then define the feed of mass
and/or energy (from surroundings to) the rector.

Give feed to system: <Feed>

One feed (of mass or heat) to the reactor must be specified here. Two types of
feeds can be used:

l As input amount of heat (enthalpy): H=Value.

l As input amount of specific species or element and its initial
temperature: N(SPECIES)=Value, Input temperature (in one line,
or the input temperature in the next prompt).
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Syntax CREATE_STAGE_BOXES

Input temperature /298.15/: <Input temperature>

Give feed to system: <Feed>

Specify other feeds (mass or energy) to the reactor. Press <Enter> to finish the
feed inputs, and then:

Give for stage box #

Now start to define the type of stage box (segment is specifically numbered as
#), and to specify a guess of initial temperature and an output for each phase
in the segment.

Type of box/Equilibrium/: <Type of box>

Only the EQUILIBRIUM type is allowed. Press <Enter> to accept it.

Is the stage heat controlled? /Y/: <Yes or No>

Y means the current segment is heat controlled.

Initial guess of temperature? /1000/: <Initial temperature>

Give a guess of initial temperature (in K) for the current segment; press
<Enter> to accept the default.

Give initial amount: <Initial amount of mass or heat>

The initial amount of mass and/or heat in the current segment can be
specified here. Two types of initial amount can be used:

l As initial amount of heat (enthalpy): H=Value.

l As initial amount of specific species or element and its initial
temperature: N(SPECIES)=Value, Input temperature (in one line,
or the input temperature in the next prompt).

Input temperature /298.15/: <Input temperature>

Give initial amount: <Initial amount of mass or heat>

Specify initial amount (mass or energy) in the current segment. Press <Enter>
to finish the initial amount inputs, and then this message displays:

Each phase may have a separate output, give these

Now start to define the output for each phase.

Phase name /Rest/: <Name of phase>



Thermo-Calc Documentation Set

REACTOR_SIMULATOR_3 Commands ǀ 288 of 370

Syntax CREATE_STAGE_BOXES

Specify a phase that has a separate output, e.g. GAS; by pressing <Enter> to
accept that all REST phases do not have separate outputs. Then the program
asks for further definitions of all the other segments (one by one), repeating
some of the above questions, till the last segment in the reactor is defined.

EXECUTE_POLY3_COMMAND
This is a command used with the REACTOR module.

Syntax EXECUTE_POLY3_COMMAND

To directly use all kinds of POLY commands inside the REACTOR module. Any
legal "Equilibrium Calculations with the POLY_3 Module" on page 163 can be
entered.

LIST_RECORDS
This is a REACTOR_SIMULATOR_3 module command.

Syntax LIST_RECORDS

Lists all the already-created records for the reactor (including stage boxes,
dividers, pipes, etc.).

READ_WORKSPACE
This is a command used with the REACTOR module.

The REACTOR workspace (along with the related POLY3 and GIBBS workspaces) and the
simulated results from the SIMULATE command can be read by this command from a binary
file where they must be saved with "SAVE_WORKSPACE" on the next page. The *.RCT file is
not printable.
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Syntax READ_WORKSPACE

Options

File name: The name of a saved *.RCT file where the REACTOR and
POLY3/GIBBS workspaces shall be read from must be specified. You do not
need to type the extension if it is the default .RCT, otherwise type the whole
*.RCT file name.

An Open window displays if a file name is not given after the command or its
path is incorrect, so that the path (in the Look in field) and File name can be
specified. The Files of type (i.e. RCT) cannot be changed.

SAVE_WORKSPACE
This command is for the POLY3, GES (GIBBS), and REACTOR_SIMULATOR_3
modules.

The REACTOR (and POLY3/GIBBS) workspaces are saved on a file with this command. In the
GIBBS workspace, all thermochemical data are stored. In the POLY3 workspace, all
thermochemical data, all conditions, changed status, entered symbols, etc., are stored. In
the REACTOR workspace, all definitions of multi-stage steady-state rector and its distribution
coefficients are saved, together with the GIBBS and POLY3 workspaces. After a SAVE
command, you can always return to the state when you issued the SAVE command by giving
a READ command.

After saving the REACTOR (and POLY3/GIBBS) workspaces on a file, you can leave the
program and at a later time READ the file and continue from the saved state.

A START_SIMULATE command automatically saves on the work file with the
most lately specified name. To avoid destroying the simulated results, do not
SAVE after a START_SIMULATE command is enforced, similar to that you should
not SAVE after a STEP or MAP command! You may append several results by
START_SIMULATE without destroying the previous results but SAVE erases them
all.

Syntax SAVE_WORKSPACE

File name

A file name must be specified. The default extension of the RCT file is .RCT,
while or any other extension as required.

A Save window displays if a file name is not given after the command, so that
the path (in the Save in field) and File name can be specified. The Files of type
(i.e. RCT) cannot be changed. If there is already a file with the same file name
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Syntax SAVE_WORKSPACE

under the directory a warming message displays. Click OK to overwrite the
current REACTOR (and POLY3/GIBBS) workspaces onto the existing *.RCT file.
Click Cancel to return to the REACTOR module. You can use the SAVE command
with an unspecified name (i.e. through SAVE ,,, command-sequence) to save
the REACTOR (and POLY3/GIBBS) workspaces.

START_SIMULATION
This is a command used with the REACTOR module.

Start the reactor simulation, and list the results for all iterations. The output for each
iteration consists of the conditions set in each segment, and you can also select some state
variables to list. After each loop, the temperatures in all segments are listed.

Syntax START_SIMULATION

Prompts

Max number of loops /10/: <The max number of loops>

Give the max number of loops. The REACTOR module repeats the reactor
simulation until this loop number is reached.

Output to screen or file /Screen/: <File name or return>

Decide on either listing simulation results on the screen (by pressing <Enter>)
or saving them on an experimental file (with the default extension .EXP).

The conditions in each segment are not saved in the file, only on
the screen.

Output variables /T BP($)/: <Variable name(s)>

Specify the variable name(s) that is also listed on the screen together with the
conditions in each segment, or in the output experimental file.

Example Output

For a four-stage reactor, the output at a certain iteration may look like this:

H=-991745.1, P=100000, N(C)=2.8468936, N(N)=6.78399966E-4, N(O)=3.8171615,

N(SI)=1.77031

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588099,
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BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

H=-924751,87, P=100000, N(C)=2.0594558, N(N)=5.17999978E-4, N(O)=4.0142358,

N(SI)=2.7551438

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

H=-813239., P=100000, N(C)=1.6592668, N(N)=3.59999988E-4, N(O)=3.7549293,

N(SI)=2.896635

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03

BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

H=7374.6403, P=100000, N(C)=8.84911857E-1, N(N)=1.99999996E-4, N(O)=1.9379203,N
(SI)=1.853872

DEGREE OF FREEDOM 0

BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175982, BP(C_S)=8.1588097,

BP(QUARTZ_S3)=68.193896

1.78803E+03

BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
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BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292

2.08691E+03

BP(GAS)=71.23129, BP(SI_L)=22.471787

2.20831E+03

10 1788.03 2065.69 2086.91 2208.31    0.00    0.00    0.00
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SCHEIL Module
Search the online help or see the Thermo-Calc User Guide included with this
PDF documentation set for details about how to calculate using Scheil either in
Graphical Mode (the Scheil Calculator) and Console Mode (the wizard Scheil
module).

If you also have a license for the Diffusion Module (DICTRA), you can import a
previously calculated Scheil segregation profile into the software using the
command INPUT_SCHEIL_PROFILE. Search the online help or see the Diffusion
Module (DICTRA) Command Reference Guide.

In this section:

BCC_TO_FCC_TRANSFORMATION 294

EVALUATE_SEGREGATION_PROFILE 294

GLOBAL_MINIMIZATION 295

LIQUID_PHASE_NAME 295

SAVE_FILE_NAME 295

SET_INTERACTIVE 295

SET_NUMERICAL_LIMITS 296

START_WIZARD 297

TEMPERATURE_STEP 298

TERMINATION_CRITERIA 298
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BCC_TO_FCC_TRANSFORMATION
Use this command for the Scheil module to allow transformations in the solidified part of the
alloy caused by each of the components specified to be Fast Diffuser. It is recommended that
you only select this for steels.

Syntax BCC_TO_FCC_TRANSFORMATION

Prompt
Allow bcc → fcc ? /N/

The default is N. Enter Y to allow transformations.

EVALUATE_SEGREGATION_PROFILE
Use this command in order to evaluate a segregation profile while performing the Scheil
calculation. The Scheil calculation itself does not contain a spatial dimension. However, if it
is assumed that the molar volume is constant and equal for all elements, and if a length is
provided over which solidification occurs (for example the secondary dendrite arm spacing)
then the generated profile corresponds to the segregation that would be obtained under the
assumptions of a Scheil calculation. The grid is then equidistant and can be used as input for
a DICTRAsimulation.

The generated text file contains, on each line, the mole fractions of all elements in
alphabetical order at a certain grid point. If the composition is the same on several
consecutive lines it means that the composition of the then remaining liquid has reached a
state in which there are no degrees of freedom.

Syntax EVALUATE_SEGRATION_PROFILE

Prompt

Evaluate segregation profile? /N/

If the answer is Ya segregation profile will be evaluated and saved
to disc. Note that this feature is not supported with back
diffusion; if back diffusion is enabled no segregation profile will be
generated.

Number of grid points /100/

Enter the number of grid points for the segregation profile.

A file dialogue window opens and allows you to specify the name of the file in
which the segregation profile is written.

In a macro file it is possible to enter all arguments on a single line, e.g.
EVALUATE_SEGREGATION_PROFILE Y 100 XF.TXT, meaning that the
segregation profile is evaluated over 100 grid points and saved to a file
(XF.TXT) in the current working directory.
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GLOBAL_MINIMIZATION
Use this command for the Scheil module to use global minimization.

Also see the POLY commands topic "ADVANCED_OPTIONS Descriptions" on
page 168 for information about that GLOBAL_MINIMIZATION command.

Syntax GLOBAL_MINIMIZATION

Prompt

Use global minimization? /N/

If Y, the Global Minimization is done when possible (depending on the
conditions setting), and a Global Minimization test is performed when an
equilibrium is reached. This costs more computer time but the calculations are
more robust. If N the Global Minimization is not used to reach the equilibrium.

LIQUID_PHASE_NAME
Use this command for the Scheil module to use the liquid phase name from the database
definitions or enter another phase name.

Syntax LIQUID_PHASE_NAME

Prompt
Liquid phase name /Default/

Default selects the liquid phase from the database definitions, otherwise enter
a phase name.

SAVE_FILE_NAME
Use this command for the Scheil module to save the file. The files get the console number
added to this name, e.g. 005.->Scheil_006.poly3 and Scheil_segregation_profile.txt).

Syntax SAVE_FILE_NAME

Prompt Name of files to be saved, poly3 and segregation profiles.

SET_INTERACTIVE

Syntax SET_INTERACTIVE

Resets the input and output units to the initial values, i.e. keyboard and screen.
Add this as the last command to the macro files.
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SET_NUMERICAL_LIMITS
Change the criteria for convergence. This is to speed up a calculation in a complex system.

If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by "COMPUTE_EQUILIBRIUM" on page 190, "STEP_WITH_
OPTIONS" on page 227, "MAP" on page 212 or "ADVANCED_OPTIONS" on page 174), this
message displays:

Convergence problems, increasing smallest site-fraction from 1.00E-30 to hardware
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current Thermo-
Calc (Console Mode) run, you can use this command to restore or reset the smallest site
fraction to the previous or another preferred value, as well as to reset other numerical
limits.

Syntax SET_NUMERICAL_LIMITS

Prompt

Maximum number of iterations /200/: <xxx>

By default, the program tries 500 iterations before it gives up. As some models
give computation times of more than 1 CPU second/iteration, this number is
also used to check the CPU time and the calculation stops if 500 CPU
seconds/iterations are used.

Required accuracy /1E-6/: <yyy>

This is a relative accuracy, and the program requires that the relative
difference in each variable must be lower than this value before it has
converged. A larger value normally means fewer iterations but less accurate
solutions. The value should be at least one order of magnitude larger than the
machine precision.

Smallest fraction /1E-12/: <zzz>

This is the value assigned to constituents that are unstable. It is normally only in
the gas phase you can find such low fractions.

The default value for the smallest site-fractions is 1E-12 for all phases, except
for IDEAL phase with one sublattice site (such as the GAS mixture phase in
many databases) for which the default value is always as 1E-30 (unless you
have used the SET_NUMERICAL_LIMITS command to reset an even-lower value
(e.g. 1E-45, that is naturally enforced to all the phases in the system).
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Syntax SET_NUMERICAL_LIMITS

Approximate driving force calculation for metastable phases /Y/:
<Y or N>

Normally the POLY module only requires that the set of stable phases is in
equilibrium in order to terminate the iterations. The metastable phases are
included in all iterations but these may not have reached their most favourable
composition and thus their driving forces may be only approximate
[corresponding to Y]. You can also force the calculation to converge for the
metastable phases by answering N if it is important that these driving forces
are correct, which may require more iterations, and the STEP and MAP
command may also terminate due to bad convergence in a metastable phase.

START_WIZARD
Use this command for the Scheil module to use the wizard with step-by-step prompts to
create a Scheil simulation.

This wizard walks you through a basic Scheil simulation. You are prompted for settings
including the major element or alloy, composition input in mass (weight) percent, the
alloying elements, the temperature, fast diffusing components, and whether any phase
should have a miscibility gap check.

Use the other commands to make changes to settings that are not included in this wizard.

l BCC_TO_FCC_TRANSFORMATION

l EVALUATE_SEGREGATION_PROFILE

l GLOBAL_MINIMIZATION

l LIQUID_PHASE_NAME

l SAVE_FILE_NAME

l STORED_COMPOSITION_TYPE

l TEMPERATURE_STEP

l TERMINATION_CRITERIA
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Syntax START_WIZARD

Prompt

Database /<Default>/:

Major element or alloy:

Composition input in mass (weight) percent? /Y/:

1st alloying element: Cr 10 C 1

Next alloying element:

Temperature (C) /2000/:

Fast diffusing components: /None/: C

Should any phase have a miscibility gap check? /N/:

TEMPERATURE_STEP
Use this command for the Scheil module to define a temperature step.

Syntax TEMPERATURE_STEP

Prompt Set temperature step (C) /1/

TERMINATION_CRITERIA
Use this command for the Scheil module to define the termination criteria for the fraction of
liquid or temperature.

Syntax TERMINATION_CRITERIA

Prompts Fraction of liquid or Temperature (F or T)? /F/

Fraction of liquid /.01/
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System Utilities Commands
In this section:

ABOUT 300

CLOSE_FILE 300

DISPLAY_LICENSE_INFO 300

HP_CALCULATOR 300

OPEN_FILE 301

SET_COMMAND_UNITS 301

SET_ECHO 302

SET_GES_VERSION 302

SET_INTERACTIVE_MODE 302

SET_LOG_FILE 303

SET_PLOT_ENVIRONMENT 303

SET_TC_OPTIONS 304

STOP_ON_ERROR 305
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ABOUT

Syntax ABOUT

Lists basic information about the development history and ownership of the
Thermo-Calc software as well as version information.

CLOSE_FILE
Close an opened text file.

Syntax CLOSE_FILE

Prompt
Unit number: <Unit number>

A unit number given in an OPEN_FILE command must be specified.

DISPLAY_LICENSE_INFO
Use this command to launch a license diagnostics program implemented in the SYS module.
It detects the license information for the Thermo-Calc installations on the current client
computer (and on the connected license server), and lists the details, including the current
status of available license file and all its included license features for the current installation
(s), as well as the Safenet Environment Variables and detailed Local (Client) Information, on
screen or into a textual file (*.TXT).

This is useful for a list of license details, and to obtain basic technical support by sending the
*.TXT file to support@thermocalc.se. If you are running a network client installation of
Thermo-Calc, you can see how many of the client example licenses that are currently
checked out and how many of them are left. You can also see which clients computers it is
that have checked these client example licenses out.

Syntax DISPLAY_LICENSE_INFO

Prompt

Output to screen or file /Screen/: <Mylicenseinfo.txt>

Press <Enter> to display a list of license information or into a *.TXT file under a
specific file name which can later on be opened and edited by any basic text
editor.

HP_CALCULATOR
This is the QBA simple interactive calculator using reverse Polish notations.

mailto:support@thermocalc.se
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Syntax HP_CALCULATOR

Available OPCODEs (HPC codes) are listed by entering the command HELP.

Use the BACK command to quit the HP_CALCULATOR and go back to the SYS
module.

Input are numbers, + - * / and ^ and OPCODEs. Several numbers an operations
can be given on one line. The content of the X register is displayed after each
operation.

For example, to compute 2*EXP(1.5**3-30000/(8*1273)), you should input the
following: 30000 8/1273/chs 1.5 3 ^ + exp 2 *

OPEN_FILE
A text file is opened for use in other commands where a unit number is necessary. The
program automatically assigns a unit number.

Syntax OPEN_FILE

Prompt
File name: <File name>

A legal file name must be specified.

SET_COMMAND_UNITS
This command is useful for reading inputs already prepared by a textual editor on a file.
Such inputs can be a table of values or a large number of parameters. The file must be
opened with "OPEN_FILE" above.

The first two lines of an input file are skipped before any input is read.

Syntax SET_COMMAND_UNIT

Prompt

Input unit number /5/: <Input unit number>

Specify the input unit number returned from an OPEN_FILE command. The next
command is taken from the file connected to this unit number. The last
command on such a file must be EXIT or SET_INTERACTIVE when you are in
POLY, POST or SYS module, in order to go back to read input from the
keyboard. The default value is the current input unit.

Output unit number /6/: <Output unit name>

Specify the output unit number returned from an OPEN_FILE command.
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SET_ECHO

Syntax SET_ECHO

Add this command at the beginning of a Console Mode MACRO *.TCM file (or
to the primary MACRO file on the top level if any sub-level(s) of MACRO files
are used).

Automatically displays on screen the complete details of various commands in
all the sequential operations in the software, that are enforced according to the
MACRO file(s).

This command is not applicable if MACRO files are not used.

SET_GES_VERSION
This command enables switching between the default standard version (5) Gibbs Energy
System (GES) calculation engine and an experimental version (6).

If you are interested in participating and helping to test the experimental
version of the calculation engine, please contact Thermo-Calc Software AB at
info@thermocalc.se for more information about the changes. Make sure you
compare/check your results as GES6 continues to be developed and improved.

Syntax SET_GES_VERSION

Prompt
USE GES VERSION 5 OR 6 /5/:

The default is version 5.

SET_INTERACTIVE_MODE

Syntax SET_INTERACTIVE_MODE

Resets the input and output units to their initial values, i.e. keyboard and screen.

Remember to add this as the last command to your MACRO files, in
order to stop execution of the command file in the POST module. It
has no meaning in interactive mode.
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SET_LOG_FILE
Use it to save, in a basic text file, everything typed in the Thermo-Calc software. When
having problems executing a command sequence, this command can be used to save the
command typed onto a log file. The manager can then check what the problem might be.

This command also makes the system echo the full command for all commands typed. This
feature is useful when demonstrating the system since the abbreviated commands are often
difficult.

The saved log file can then be edited as a MACRO file by using a basic text editor. This is
useful to run the MACRO file(s) for similar calculations (the same system but slightly varied
temperature-pressure-composition conditions), or run the example MACRO files.

"Macro Files" on page 160 in the Thermo-Calc User Guide.

Syntax SET_LOG_FILE

Prompt

A Save window opens to specify a file name for the *.LOG file, so that the path
(in the Save in field) and File name can be specified. If an *.LOG file with the
same name exists in the current working directory, it is overwritten. The Files
of type (i.e. LOG) cannot be changed. Click Save or Cancel as applicable.

SET_PLOT_ENVIRONMENT
Allows you, preferably in the initiation file tc.ini, to set the plot devices you normally have
access to as this can vary for different Thermo-Calc installations.

This command must be terminated with an empty line or two commas.

Syntax SET_PLOT_ENVIRONMENT

Prompts

Default plotdevice number /Default number/: <Device number>

The number given is unique for each type of graphical device. For plotting
various types of Thermo-Calc graphs on screen, the default graphical device
number should normally be selected. A question mark ? gives you a list of all
available graphical devices used in the Thermo-Calc Console Mode.

Pseudo file name: <Pseudo-file name>

The name given here is a symbol which can be used to refer to a physical
graphics device when asked for graphical output file.
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Syntax SET_PLOT_ENVIRONMENT

Plotdevice number /1/: <Device number>

The number that specifies the type of graphical device.

Plot file name: <File name or printer name>

The name of the graphical device on system level (name of file or printer).

Example
SET_PLOT_ENVIRONMENT 1 lasp 5 a0tr,,

This example sets the default plot device number to 1, and defines an alias
named lasp with plot device 5 and connected to a printer named a0tr.

SET_TC_OPTIONS
Predefine the default values of three general Thermo-Calc options for performing all the
sequential single-points, stepping and mapping calculations.

Syntax SET_TC_OPTIONS

Prompts

Use_global_minimization /Y/: <Y or N>

If Y, it is done when possible (depending on the conditions setting), and a
Global Minimization test is performed when an equilibrium is reached. This
costs more computer time but the calculations are more robust. For N Global
Minimization is not used to reach the equilibrium.

Global_test_interval /0/: <An integer value>

The integer number determines how often the Global Minimization should be
used during calculations with "STEP_WITH_OPTIONS" on page 227 and "MAP"
on page 212. If it is set to 0 (zero), the recommended global test interval is
used: i.e. every tenth step and at each phase change during STEP calculations,
and only at node points during MAP calculations. Any other positive integer
number, n, suggests it performs Global Minimization tests at every nth step
during STEP and MAP calculations. Of course, the Global Minimization test is
always carried out at a phase change or a node point. The Thermo-Calc
Console Mode is initially configured with 0 (zero) as the default value, but such
a configuration for the default value can be changed by this option.

Automatically_add_initial_equilibria /Y/: <Y or N>

When "ADD_INITIAL_EQUILIBRIUM" on page 166 is not used before a MAP
calculation, a mesh of INITIAL_EQUILIBRIUM are automatically added before
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Syntax SET_TC_OPTIONS

the mapping procedure itself takes place. This mesh is only available when the
two independent axis-variables have already been defined by the POLY
command.

Set_axis_variable

For Y the POLY module always enforces the automatic procedures for adding
initial equilibrium points during mapping. For N no initial equilibrium points
are then added during mapping.

STOP_ON_ERROR
Useful for batch jobs in order to prevent that an erroneous sequence of commands to the
program causes waste of computer activity.

Syntax STOP_ON_ERROR

Give the preferred argument (ON or OFF) after the STOP command. If the
default argument ON is given, the program terminates after an illegal or
ambiguous command. It is possible to reset the effect of this command by giving
the argument OFF.
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TABULATION_REACTION Commands
"Tabulation of Chemical Substances, Phases or Reactions" on page 209 in the
Thermo-Calc User Guide.

In this section:

ENTER_FUNCTION 307

ENTER_REACTION 308

LIST_SUBSTANCES 310

SET_ENERGY_UNIT 312

SET_PLOT_FORMAT 312

SWITCH_DATABASE 313

TABULATE 315

TABULATE_DERIVATIVES 315

TABULATE_REACTION 320

TABULATE_SUBSTANCE 322
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ENTER_FUNCTION
Used to define a new thermodynamic function to be included in the sixth column of tabular
output. The last entered function is listed in the 6th column of all tables, and can be plotted
(if choosing the Plot Column value 6) in all graphs, for all subsequently tabulated substances
or reactions.

Syntax ENTER_FUNCTION

Prompt
Name: <Name>

Function: <Definition>

A limited number of state variables, G, H, S, T, P, V and H298 can be used in
the function definition. For example, -(G-H)/T can be defined as a function
which is identical to S for a substance or ΔS for a reaction, G+T*S-P*V can be
defined as a function which is U (internal energy) for a substance or ΔU
(internal energy change) for a reaction.

Options
Nameof the function (maximum 8 characters) and Definition of the function.
A long function can be typed over several lines. A function should be
terminated by a semicolon (;) or an empty line.

Example Output

For the pure substance Fe (using the SSUB database), by entering a function as G+T*S-P*V,
the following table is obtained by typing <Enter> in the prompt Output file /SCREEN/:,
and the figure by typing 6 in the prompt Plot column /2/:

TAB: ENTER-FUNCTION

Name: InEnergy

Function: G+T*S-P*V;

TAB: TABULATE_SUBSTANCE

Substance (phase): Fe

Pressure /100000/: <Enter>

Low temperature limit /298.15/: <Enter>

High temperature limit /2000/: <Enter>

Step in temperature /100/: <Enter>

Output file /try1/: try2

Graphical output? /Y/: <Enter>

Plot column? /2/: 6



Thermo-Calc Documentation Set

TABULATION_REACTION Commands ǀ 308 of 370

This gives the following output:

O U T P U T F R O M T H E R M O - C A L C

Column 6: InEnergy G+T*S-P*V

Phase : FE_S                      Pressure :     100000.00

Specie: FE

***************************************************************

T     Cp           H            S            G            InEnergy

(K)   (Joule/K)     (Joule)     (Joule/K)     (Joule)

***************************************************************

298.15  2.48446E+01  2.17972E-06  2.72800E+01 -8.13353E+03  2.17972E-06

300.00  2.48905E+01  4.60049E+01  2.74338E+01 -8.18414E+03  4.60049E+01

400.00  2.71299E+01  2.64957E+03  3.49085E+01 -1.13138E+04  2.64957E+03

500.00  2.93561E+01  5.47211E+03  4.11976E+01 -1.51267E+04  5.47211E+03

600.00  3.19293E+01  8.53245E+03  4.67701E+01 -1.95296E+04  8.53245E+03

700.00  3.50985E+01  1.18777E+04  5.19207E+01 -2.44667E+04  1.18777E+04

800.00  3.92042E+01  1.55830E+04  5.68623E+01 -2.99068E+04  1.55830E+04

900.00  4.49645E+01  1.97726E+04  6.17903E+01 -3.58387E+04  1.97726E+04

1000.00  5.42147E+01  2.46891E+04  6.69619E+01 -4.22728E+04  2.46891E+04

1100.00  4.55851E+01  2.99025E+04  7.19412E+01 -4.92328E+04  2.99025E+04 $ 
Stable phase is FE_S2

1200.00  3.40840E+01  3.51037E+04  7.64466E+01 -5.66322E+04  3.51037E+04

1300.00  3.49398E+01  3.85549E+04  7.92086E+01 -6.44162E+04  3.85549E+04 
1400.00  3.57994E+01  4.20918E+04  8.18293E+01 -7.24692E+04  4.20918E+04

1500.00  3.66636E+01  4.57149E+04  8.43287E+01 -8.07780E+04  4.57149E+04

1600.00  3.75330E+01  4.94247E+04  8.67226E+01 -8.93314E+04  4.94247E+04 $ 
Stable phase is FE_S3

1700.00  4.05217E+01  5.41173E+04  8.95609E+01 -9.81363E+04  5.41173E+04

1800.00  4.12595E+01  5.82055E+04  9.18975E+01 -1.07210E+05  5.82055E+04 $ 
Stable phase is FE_L

1900.00  4.60000E+01  7.74165E+04  1.02377E+02 -1.17099E+05  7.74165E+04 
2000.00  4.60000E+01  8.20165E+04  1.04736E+02 -1.27456E+05  8.20165E+04

ENTER_REACTION
This is the same as "TABULATE_REACTION" on page 320 in that both the chemical reaction
can be specified and the thermodynamic property changes for the reaction can be
generated as a table, and plotted as a graph or saved as an experimental file (with an
extension of .EXP). The thermodynamic data are automatically retrieved from the SSUB5
database (by default), or the current database set by "SWITCH_DATABASE" on page 22 (thus
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there is no need to use the DATA module before this command). You can select any other
database by using the SWITCH_DATABASE command in the TAB module. The rules to specify
a reaction are the same as in the command TABULATE_REACTION.

Syntax ENTER_REACTION

Prompts

Same reaction? /Y/: <Y or N>

This displays if there is at least one reaction already defined either by the
command ENTER_REACTION or TABULATE_REACTION. For Y the next prompt
for defining reaction is not asked.

Reaction: <Chemical reaction equation> & <RA+RB=PC+PD>

A long reaction can be typed over several lines. A reaction should be
terminated by a semicolon (;) or an empty line. A list showing the used
database, defined elements, getting-data sequence, references, etc.:

Pressure /100000/: <Pressure of interest, in pa>

Low temperature limit /298.15/: <T-low, in K>

High temperature limit /2000/: <T-high, in K> Step in temperature
/100/: <T-step>

Output file /SCREEN/: <RETURN for SCREEN, or type a file name>

If you type Return for screen a list of thermodynamic property changes for
the defined/chosen reaction is shown up as a table (which is demonstrated in
the example outputs given below), and the command is terminated.

If typing a file name, the table is displayed and saved as an *.EXP or an *.TAB
file. Then prompts:

Graphical output /Y/: <Y or N>

For N a table is output to the screen and this table is saved as a basic text file
with the default extension .TAB under the current working directory. In this
case, the graph cannot be plotted.

For Y a table is created with all thermodynamic functions as normal (which is
displayed on screen) and generates a graph with temperature on the X-axis
and a chosen property on a certain column in the table on the Y-axis (which is
plotted on screen and saved as an *.EXP file), and it further asks which column
is to be plotted on the resulting graph:

Plot column? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus
temperature as X-axis) as a graph on the screen. Simultaneously, all tabulated
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Syntax ENTER_REACTION

properties and the Y-axis setting (i.e. the plotted column) for the graph is
written into an *.EXP file using the DATAPLOT format. The default column 2 is
heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional
column 6 is a user-entered function. The table displays on the screen. The plot
then displays on the screen, followed by a POST prompt. The POST module
(postprocessor) automatically opens, and all types of the POST-module
commands to refine the plotted diagram may be used. Possibilities include
scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or
EXIT at the POST prompt always takes you back to the TAB module.

LIST_SUBSTANCES
This is a TAB module command.

List all species in the current database with a certain set of elements. This is useful to specify
species as pure substances in the command "TABULATE_SUBSTANCE" on page 322.

Syntax LIST_SUBSTANCES

Prompts

With elements /*/ <* or a set of elements>

The elements building up various species must be specified. The wildcard *
means all elements in the current database.

If some elements are specified, it also prompts for how to list species with
such elements.

Exclusively with those elements /Y/: <Y or N>

All species (not phases) in the current database are searched. If the answer is
Y (the default), no other elements are allowed in searching, except for those
specified. If N all species containing at least one of the specified elements are
listed.

Example Output

For the SSOL5 database, there are different lists, as shown below:

TAB: l-sub

With elements /*/: <Enter>

VA                     AG                     AL
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AM                     AS                     AU

B                      BA                    BE BI BR C

CA                     CD                     CE

CL                     CO                     CR

CS                     CU                     DY

ER                     EU                     F

FE                     GA                     GD

GE                     H                      HF

HG                     HO                     I

IN                     IR                     K

LA                     LI                     LU

MG                     MN                     MO

NA                     NB

ND                     NI                     NP

OS                     P

PA                     PB                     PD

PR                     PT                     PU

RB                     RE                     RH

RU                     S                      SB

SC                     SE                     SI

SM                     SN                     SR

TA                     TB                     TC

TE                     TH                     TI

TL                     TM                     U

V                      W                      Y

YB                     ZN                     ZR

C1                     C2                     C3

C4                     C5                     C6

C7                     N2                     O2

P1                     P2                     P4

NA/+1                  K/+1                   CL/-1

H2O                    H1/+                   LI1/+

CS1/+                  RB1/+                  O1H1/-

F1/- BR1/- I1/-

H1/+1                  H1O1/-1                SI1O2 CA1O1 TAB:

TAB: l-sub
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With elements /*/: fe cr ni c n o

Exclusively with those elements? /Y/: <Enter>

C              CR                   FE

N              NI                   O

C              C2                   C3

C         C5                   C6

C              N2                   O2

TAB:l-sub fe cr ni c n o

Exclusively with those elements? /Y/: n

C              CR                   FE N  NI O

C1             C2                   C3

C4             C5                   C6

C7             N2                   O2

H2O            O1H1/- H1O1/-1 SI1O2 CA1O1 TAB:

SET_ENERGY_UNIT
Set the energy unit as calories or Joule, in all the subsequent outputs (tables, graphs, and
files) in the current calculation operation.

Syntax SET_ENERGY_UNIT

Prompt Energy unit (C=Cal, J=Joule) /J/: <Unit>

SET_PLOT_FORMAT
Set the plotting format while the result is plotted on screen or the file is saved as EXP file
[using DATAPLOT graphical format] and TAB file (as a basic text file and as displayed on
screen).

This command is different from "SET_PLOT_FORMAT" on page 264 in the POST
module, but is identical to "SET_PLOT_ENVIRONMENT" on page 303 in the SYS
(system utility) monitor.
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Syntax SET_PLOT_FORMAT

Options

The default set Unitis 1 (Windows) or 9 (Linux) for graphical presentation on
screen, or all other units for outputs as *.EXP and *.TAB files.

Also set the format of the graphical output to different graphical devices. The
default unit 22 (1 for legacy Windows, and 9 for legacy Linux) may be altered
with the SET_PLOT_ENVIRONMENT command in the SYS monitor or by the
TC.INI file.

SWITCH_DATABASE
By default, the TAB module always automatically retrieves thermodynamic data for
substances or reactant/product substances in a defined reaction, or for pure phases or ideal
solution phases, from the SSUB Substances Database. However, you can select
thermodynamic data for complex non-ideal solution phases from another database. This is
possible with this command.

This command switches (or changes) from the current database to a new one, and
reinitializes the entire TAB module for defining a substance or reaction and the GIBBS
workspace for storing retrieved data. All the directly connected databases as predefined by
the original database initiation file (TC_INITD.TDB file in the /DATA/ area for Windows
environments, or the initd.tdb file in the \data\ area for Linux) are listed by pressing the
<Enter> key without giving any argument. You can also supply your own database by giving
the argument USER and then the database name and, if it is not located in the current
working directory, its correct path.

This command (when required to use another database for subsequent tabulations) must be
used before executing the TAB commands "TABULATE_SUBSTANCE" on page 322 for
substances, and "ENTER_REACTION" on page 308 or "TABULATE_REACTION" on page 320
for reactions.

When a predefined database or an appropriate USER database is switched on, the DATA
command "GET_DATA" on page 16 is automatically executed; therefore, the TAB module
immediately displays a message

Example

Example of TAB module message with the PSUB database specified

TAB: SW PSUB

THERMODYNAMIC DATABASE Module running on PC/Windows NT

Current database: TC Public Substances Database
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VA DEFINED

REINITIATING GES5

VA DEFINED

ELEMENTS

SPECIES

PHASES

PARAMETERS

FUNCTIONS

-OK- TAB:

Syntax SWITCH_DATABASE

Prompt

Database /XYZ/: <new database name>

Specify a New database name. XYZ stands for the default SSUB database or the
current database which is switched on. If an appropriate database name is not
given and the USER option is not used, this list displays:

Use one of these databases

PURE4 = SGTE Pure Elements Database v4

SSUB3 = SGTE Substances Database v3

USER = user defined database

DATABASE NAME /XYN/: <new database name>

Notes

DATABASE NAME: The new database is specified by typing the abbreviation
given in the front of one of the available predefined databases. For
convenience when switching/appending databases or recently purchased
databases from Thermo-Calc Software or its agents, you can add them to the
predefined database list in the database initiation file TC_INITD.TDB or
initd.tdb of your installed software.

When this command is used in a MACRO (*.TCM) file, if the USER option is
selected, the database setup file name (*setup.TDB) containing the setup
definitions of the USER database, and its correct path, must be provided.

If a USER database name or its path is not given on the same line of the
SWITCH_DATABASE command, or if it is incomplete or incorrect, an Open
window displays to specify the filename of the database setup file name
(*setup.TDB) of the to-be-switched USER database.

Unlike in the DATA module, if a USER database is used, the Gibbs
energy system is also reinitialized and only data from the USER
databases are retrieved for tabulations.
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Syntax SWITCH_DATABASE

After this command, those commands to define systems (in terms of either
elements or species), to reject/restore phases or species, retrieve data, as well
as to append data from additional database(s), can be done.

TABULATE
Gives the values of an already-defined table (with various properties varied with the
stepping axis variable) from equilibria calculated with a STEP command. You can tabulate a
table even if the table is entered after the STEP calculation.

Syntax TABULATE

Prompts
Name: <Name of a defined table>

The name of the table must be given. The table must be ENTERED.

Output to Screen or file /Screen/: <File name>

The table can be listed on the screen (by pressing <Enter>), on a file
(the file name must be specified here).

TABULATE_DERIVATIVES
This command is mainly for system debugging purposes and for experienced users. It
automatically calculates all partial derivatives for a pure phase or solution phase at a given
composition.

This is not the same as the chemical potential.

Before using this command, the system must be defined and thermodynamic data retrieved
from an appropriate solution database in the DATA module. The phase name can be given in
either upper, lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc, BCC,
cem, Liq, etc. as the SSOL database is used for the tabulations, or GAS, FE-S, wustite, Fe2O3-
hem, etc. as the SSUB database is used. The module then optionally goes through a specific
sublattice or all the possible sublattices for the specified phase, as well as through the whole
framework of a currently defined system (including all the defined elements/species, as well
as the default defined vacancy and electron if necessary for the current database), when it
prompts for inputs of site fractions for various species possibly occupying such sublattices.
Therefore, thermodynamic properties can be tabulated for a pure phase, or for a solution
phase as a pure end-member (with a composition definition for the corresponding non-
interacting species on all necessary sublattices in the end-member), or for a solution phase
as a real solution (with a composition definition for related interacting species on all
necessary sublattices in the solution).
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Syntax TABULATE_DERIVATIVES

Prompts

Phase name /XXXX/: <Name of the phase>

Specify the phase name of a pure phase or a solution phase.

XXXX is the last phase the TAB module accounted for. It automatically prompts
for other options and necessary inputs for the definition of the composition of
the specified phase.

For a pure phase (such as Fe-S, Wustite, and Fe2O3-Hematite), no further
composition definition is needed. For a solution phase with one sublattice
(such as AQUEOUS solution, GAS mixture and SLAG solution), it requests n-1 site-
fraction inputs for the phase constituents (if there are n species in the defined
phase within the whole framework of currently defined system, including all
the defined elements/species, as well as the default defined vacancy and
electron if necessary for the current database); the nth species is
automatically assigned as the rest.

The sum of input site fractions must not exceed unity.

Example

For example, these prompts and inputs can be seen for a LIQUID solution
phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O framework (Note
that by default, the unprompted Ni species are assigned as the rest):

FRACTION OF CONSTITUENT (RETURN FOR PROMPT): <RETURN> C /1/: .05

CR /1/: .1

FE /1/: < RETURN>

SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER

FE /1/: .8

N /1/: .005

For a solution phase with two or more sublattices (such as FCC alloy solution,
and ION_LIQ ionic liquid solution), it first asks for which sublattice the site-
fractions of constituents shall be specified: the default value 0 for all possible
sublattices, and a given positive number for a specific sublattice (of course,
this number must be reasonable for the currently specified phase, i.e. it must
be smaller than the total sublattice number of the phase). Then, for the given
sublattice or for all sublattices, it prompts for all the necessary inputs of site-
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fractions for the possible constituents on each sublattice n-1 times if there are
n species on such a sublattice in the defined phase; the nth species on each of
the sublattices is automatically assigned as the rest. For example, the
following prompts and inputs can be seen for an FCC solution phase (from the
SSOL5 database) within the Fe-Cr-Ni-C-N-O framework (Note that by default,
the unprompted O species on its sublattice 1 and VA on its sublattice 2 are
assigned as the rest):

SPECIFY SUBLATTICE (0 FOR ALL) /0/: <RETURN>

FRACTIONS IN SUBLATTICE 1

CR /1/: .1

FE /1/: .8

NI /1/: .0995

FRACTIONS IN SUBLATTICE 2

C /1/: .05

N /1/: .05

Temperature /2000/: <Temperature of interest, in K>

Specify the temperature of interest in K.

Pressure /100000/: <Pressure of interest, in pa>

Specify the pressure of interest in Pa.

Example Output

For the FCC phase in the Fe-Cr-Ni-C-N-O system (using the SSOL database), the following
table is obtained at a specified composition:

TAB: TAB_DER

Phase name /BCC/: FCC

SPECIFY SUBLATTICE (0 FOR ALL) /0/: <Enter>

FRACTIONS IN SUBLATTICE 1

CR /1/: .1

FE /1/: .8

NI /1/: .3

SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER

NI /0/: .0995
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FRACTIONS IN SUBLATTICE 2

C /1/: .05

N /1/: .05

Temperature /1800/: <Enter>

Pressure /100000/: <Enter>

Gibbs energy: ..................... -1.27432533E+05

Helmholz energy: .................. -1.27433205E+05

Enthalpy: ......................... 5.95773994E+04

Internal energy: .................. 5.95767279E+04

Entropy: .......................... 1.03894407E+02

Molar volume: ..................... 6.71473258E-06

Thermal expansivity: .............. 7.63886416E-05

Isothermal compressibility: ....... 6.02925387E-12

Heat capacity at constant pressure: 4.33555074E+01

First partial derivative with respect to CR in sublattice 1    of Gibbs energy:
................ -1.26034739E+05    of enthalpy: .................... 
4.63000206E+04    of entropy: ..................... 9.57415334E+01    of volume:
...................... 6.87203263E-06

Second partial derivative of Gibbs energy with respect to also

CR                      in 1: 1.54392858E+05

FE                      in 1: -1.53353158E+04

NI                      in 1: -1.71750366E+04

O                       in 1: 0.00000000E+00

C                       in 2: -1.82016870E+05

in 2: -3.73062665E+05

VA                      in 2: -9.36260878E+04

irst partial derivative with respect to FE in sublattice 1    of Gibbs energy:
................ -1.02869265E+05

of enthalpy: .................... 6.11738912E+04    of entropy:
..................... 9.11350866E+01    of volume: ...................... 
7.53441165E-06

Second partial derivative of Gibbs energy with respect to also

FE                      in 1: 1.82508696E+04

NI                      in 1: -3.07043434E+03

in 1: 0.00000000E+00

C                       in 2: -1.36027071E+05

in 2: -2.13007485E+05

VA                      in 2: -1.11741180E+05
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First partial derivative with respect to NI in sublattice 1    of Gibbs energy:
................ -1.32427029E+05    of enthalpy: .................... 
5.21563580E+04    of entropy: ..................... 1.02546326E+02    of volume:
...................... 0.00000000E+00

Second partial derivative of Gibbs energy with respect to also

NI                      in 1: 1.48390257E+05

in 1: 0.00000000E+00

C                       in 2: -7.70620431E+04

in 2: -1.61551726E+05

VA                      in 2: -1.12772206E+05

First partial derivative with respect to O in sublattice 1    of Gibbs energy:
................ -2.62929308E+05    of enthalpy: .................... 
5.02555370E+04    of entropy: ..................... 1.73991581E+02    of volume:
...................... 0.00000000E+00

Second partial derivative of Gibbs energy with respect to also

in 1: 2.99322360E+07

C                       in 2: 0.00000000E+00

N                       in 2: 0.00000000E+00

VA                      in 2: -1.82377137E+05

First partial derivative with respect to C in sublattice 2    of Gibbs energy:
................ -1.59508417E+05    of enthalpy: .................... 
1.21269096E+05    of entropy: ..................... 1.55987507E+02    of volume:
...................... 1.06885187E-05

Second partial derivative of Gibbs energy with respect to also

C                       in 2: 2.99322360E+05

N                       in 2: -1.90144000E+04

VA                      in 2: -2.78465070E+04

First partial derivative with respect to N in sublattice 2    of Gibbs energy:
................ -2.39671400E+05    of enthalpy: .................... 
4.04456947E+04    of entropy: ..................... 1.55620608E+02    of volume:
...................... 0.00000000E+00

Second partial derivative of Gibbs energy with respect to also

N                       in 2: 2.99322360E+05

VA                      in 2: -3.30383665E+04

First partial derivative with respect to VA in sublattice 2    of Gibbs energy:
................ -9.52042686E+04    of enthalpy: .................... 
5.37142294E+04    of entropy: ..................... 8.27324989E+01    of volume:
...................... 6.86700739E-06

Second partial derivative of Gibbs energy with respect to also

VA                      in 2: 1.66290200E+04
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TABULATE_REACTION
Tabulate thermodynamic property changes for a chemical reaction as a table, or variation
of one chosen property can be plotted against temperature as a graph, or saved as an
experimental file (with an extension of .EXP). The thermodynamic data are automatically
retrieved from the SSUB5 database (by default), or the current database set by the SWITCH_
DATABASE command (thus there is no need to use the DATA module before this command).
You can select any other database by using "SWITCH_DATABASE" on page 313 in the TAB
module.

It is important to remember the rules to specify a reaction:

l The reaction is specified, by giving the reactants and products, such as Ga+S=GaS,
5Al+2Fe=Al5Fe2.

l Under Linux environments, the notation for a chemical formula treats upper and
lower cases as the same (such as ga+s=GaS, 5Al+2Fe=al5fe2); but under Windows,
the TAB module only accepts upper cases, e.g. GA+S=GAS, 5AL+2FE=AL5FE2.

l Elements with a single letter symbol must be followed by a stoichiometry factor,
even if it is 1; thus, the symbol CO is taken as cobalt, carbon monoxide must be given
as C1O1 (or O1C1).

l All the reactants and products must be defined as species-stoichiometries in the
currently-used database; in other words, the reaction definition only accepts already-
defined species-stoichiometries as reactants and products. For example, if a
database does not have a species defined with a stoichiometry of Al5Fe2 {e.g. the Al
and Fe (but not Al5Fe2) may be defined as species, and the Al5Fe2 phase may be
defined as a two-sublattice stoichiometric phase [Al]5[Fe]2, rather than a single
sublattice stoichiometric phase [Al5Fe2]}, then the reaction 5Al+2Fe=Al5Fe2 cannot
be tabulated.

l Make sure that the Gibbs free energy expression for a stoichiometric phase is really
corresponding to the species-stoichiometry. For example, if a database has a
definition of Function GAL5FE2 for 1/7 of the AL5FE2 formula, then the relation G
(Al5Fe2)=7*GAL5FE2 must be defined; otherwise, the tabulated thermodynamic
properties for the reaction 5Al+2Fe=Al5Fe2 is wrong.

Syntax TABULATE_REACTION

Prompts

Same reaction? /Y/: <Y or N>

This prompt displays if there is at least one reaction already defined either
with the commands "ENTER_REACTION" on page 308 or TABULATE_
REACTION. If you answer Y, then the next prompt is not asked.

Reaction: <Chemical reaction equation> & <RA+RB=PC+PD>
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A long reaction can be typed over several lines. A reaction should be
terminated by a semicolon (;) or an empty line. A list showing the used
database, defined elements, getting-data sequence, references, etc.

Pressure /100000/: <pressure of interest, in pa>

Low temperature limit /298.15/: <T-low, in K> Specify the starting
temperature K.

High temperature limit /298.15/: <T-high, in K> Specify the ending
temperature K. Step in temperature /100/: <T-step> Specify the
temperature step for the tabulation.

Output file /Screen/: <Return for screen, or type a file name>

If you type Return for screen, a list of thermodynamic property changes for
the defined/chosen reaction is shown as a table (which is demonstrated in the
example outputs given below), and the command is terminated.

If typing a file name, the table is both displayed on screen and saved as an
*.EXP or a *.TAB file, and the program prompts:

Graphical output /Y/: <Y or N>

l For N a table is output to the screen, and the same table is saved as a
basic text file with the default extension .TAB under the current
working directory. In this case, the graph cannot be plotted.

l For Y a table is created with all thermodynamic functions as normal
(which is displayed on screen) and generates a graph with temperature
on the X-axis and a chosen property on a certain column in the table on
the Y-axis (which is plotted on screen and saved as an *.EXP file), and it
also asks which column is to be plotted on the resulting graph:

Plot column? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus
temperature as X-axis) as a graph on the screen. Simultaneously, all tabulated
properties and the Y-axis setting (i.e. the plotted column) for the graph is
written into an *.EXP file using the DATAPLOT format. The default column 2 is
heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional
column 6 is a user-entered function. The table displays on the screen. The plot
then displays on the screen, followed by a POST: prompt. The POST module
(postprocessor) automatically opens, and all types of the POST-module
commands to refine the plotted diagram may be used. Possibilities include
scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or
EXIT at the POST: prompt always takes you back to the TAB module.
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Also see the DATPLOT User Guide included with this
documentation set.

Example Output

For the reaction Ga+S=GaS (using the SSUB5 database), the following table is obtained by
typing <Enter> in the prompt Output file /SCREEN/, and the figure by typing 2 in the prompt
Plot column /2/:

O U T P U T F R O M T H E R M O - C A L C

Reaction: S+GA=GA1S1

stable as S_S

GA stable as GA_S

GA1S1 stable as GA1S1_S

Delta-Cp     Delta-H      Delta-S      Delta-G

(K)   (Joule/K)     (Joule)     (Joule/K)     (Joule)

***************************************************************

298.15 -2.79489E+00 -2.09200E+05 -1.50580E+01 -2.04710E+05

300.00 -2.87516E+00 -2.09205E+05 -1.50755E+01 -2.04683E+05

302.  ---- GA becomes GA_L ,delta-H =  5589.80

367.  ---- S becomes S_S2 ,delta-H =   401.00

389.  ---- S becomes S_L ,delta-H =  1721.00

400.00 -1.22278E+01 -2.17521E+05 -4.07488E+01 -2.01222E+05

500.00 -1.57686E+01 -2.19323E+05 -4.47280E+01 -1.96959E+05

600.00 -1.02518E+01 -2.20583E+05 -4.70410E+01 -1.92359E+05

700.00 -6.58954E+00 -2.21430E+05 -4.83534E+01 -1.87583E+05

800.00 -4.46246E+00 -2.21963E+05 -4.90686E+01 -1.82709E+05

900.00 -2.82671E+00 -2.22328E+05 -4.94995E+01 -1.77778E+05

1000.00 -1.21787E+00 -2.22530E+05 -4.97138E+01 -1.72816E+05

1100.00  3.71702E-01 -2.22572E+05 -4.97552E+01 -1.67841E+05

TABULATE_SUBSTANCE
Tabulate thermodynamic properties of a substance (with a given chemical formula but it is
not certain in which phase/state it may form) or a pure stoichiometric phase (getting data
from a specific substance database such as SSUB5, or from a specific solution database such
as SSOL5 and TCFE8), or of a solution phase with a fixed composition (getting data from a
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specific solution database such as SSOL5 and TCFE8), under a constant pressure and various
temperatures.

In case of a pure stoichiometric phase or a solution phase with a fixed composition, you must
already define the system and get thermodynamic data from an appropriate solution
database in the DATA module before using this TAB command. The phase name can be given
either upper or lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc,
BCC, Liq, cem, Al5Fe2, etc. as the SSOL database is used for the tabulations, or GAS, FE-S,
wustite, Fe2O3-hem, etc. as the SSUB database is used. The module then optionally goes
through a specific sublattice or all the possible sublattices for the specified phase, as well as
through the whole framework of a currently defined system (including all the defined
elements/species, as well as the default defined vacancy and electron if necessary for the
current database), when it prompts for inputs of site fractions for various species possibly
occupying such sublattices. Therefore, you can tabulate thermodynamic properties for a
pure phase, or for a solution phase as a pure end-member (with a composition definition for
the corresponding non-interacting species on all necessary sublattices in the end-member),
or for a solution phase as a real solution (with a composition definition for related
interacting species on all necessary sublattices in the solution).

Moreover, the variation for one of the tabulated properties for a substance, a pure
stoichiometric phase, or a solution phase with a fixed composition can be plotted against
temperature as a graph or saved as an experimental file (with an extension of .EXP).
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Prompt

Substance (phase): <Name of the species or phase>

In case of a substance, give its chemical formula, e.g. Fe, H2, C1H6, FeC1,
CaC1O3, MgSiO3, etc. When the TABULATE_SUBSTANCE<SUBSTANCE>
command sequence is used for the first time in the TAB module, it always uses
the SSUB Substances Database as the default database. If the SSUB database is
not available for the current Thermo-Calc installation and a specific database
has not been switched on yet, it may prompt to specify an appropriate
substance or solution database (e.g. typing SSUB2, SSUB3, SSUB4, SSUB5; SSOL2,
SSOL4, SSOL5; TCFE3, TCFE4, TCFE5, TCFE6, TCFE7, TCFE8 etc.). Prior to this
command, you can also use the "SWITCH_DATABASE" on page 313 command in
the TAB module to set the current database. If a solution database is set as the
current database, only the neutral species that are valid substance standing by
themselves as phases can be tabulated.

Before other prompts, a list of the used database, defined
elements, getting-data sequence, references, etc. is displayed on
screen. From such information, you know what the TAB module is
performing.

In case of a pure stoichiometric phase or a solution phase, give its phase name,
e.g. FCC, CEMENTITE, LIQUID, SLAG, AQUEOUS, GAS, Al5Fe2, Fe-S, Wustite,
Fe2O3-Hematite, etc.

REMEMBER: It is important that you have already defined the
system and gotten thermodynamic data from an appropriate
solution database in the DATA module before using this TAB_SUB
command. It automatically prompts for other options and
necessary inputs for the definition of the composition of the
specified phase.

For a pure stoichiometric phase defined with one single sublattice (such as Fe-S,
Wustite, and Fe2O3-Hematite), no further composition definition is needed.

For a solution phase defined with one sublattice (such as AQUEOUS solution,
GAS mixture and SLAG solution), it requests n-1 site-fraction inputs for the
phase constituents (if there are n species in the defined phase within the whole
framework of currently defined system, including all the defined
elements/species, as well as the default defined vacancy and electron if
necessary for the current database); the nth species is automatically assigned
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as the rest.

The sum of input site fractions must not exceed unity. For example,
the following prompts and inputs can be seen for a LIQUID solution
phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O
framework (Note that by default, the unprompted Ni species is
assigned as the rest):

Fraction of constituent (return for prompt): <Return>

C /1/: .05

CR /1/: .1

FE /1/: <RETURN>

Sum of fractions exceed unity, please reenter

FE /1/: .8

N /1/: .005

For a pure stoichiometric phase defined with two or more sublattices (such as
Al5Fe2 inter-metallic stoichiometric phase) and for a solution phase defined
with two or more sublattices (such as FCC alloy solution, and ION_LIQ ionic
liquid solution, Al5Fe4 inter-metallic solution phase), it first asks for which
sublattice the site-fractions of constituents shall be specified: the default value
0 for all possible sublattices, and a given positive number for a specific
sublattice (this number must be reasonable for the currently specified phase,
i.e. it must be smaller than the total sublattice number of the phase). Then, for
the given sublattice or for all sublattices, it prompts for all the necessary inputs
of site-fractions for the possible constituents on each sublattice n-1 times if
there are n species on such a sublattice in the defined phase; the nth species on
each of the sublattices are automatically assigned as the rest. For example,
these prompts and inputs can be seen for an FCC solution phase (from the SSOL
database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the
unprompted O species on its sublattice 1 and VA on its sublattice 2 is assigned as
the rest):

Specify sublattice (0 for all) /0/: <Return>

FRACTIONS IN SUBLATTICE           1

CR /1/: .1

FE /1/: .8
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NI /1/: .0995

FRACTIONS IN SUBLATTICE           2

C /1/: .05

N /1/: .05

Pressure /100000/: <Pressure of interest, in pa>

Specify the constant pressure condition in Pa.

Low temperature limit /298.15/: <T-low, in K>

Specify the starting temperature K.

High temperature limit /298.15/: <T-high, in K>

Specify the ending temperature K.

Step in temperature /100/: <T-step> Specify the temperature step
for the tabulation.

Output file /Screen/: <Return for screen, or type a file name>

If you type Return for screen a list of basic thermodynamic functions for the
chosen substance or for the specified pure or solution phase with the fixed
composition is shown up as a table (which is demonstrated in the example
outputs given below), and the command is terminated.

If typing a file name, the table is both displayed on screen and saved as an
*.EXP or a *.TAB file, and the program further prompts:

Graphical output /Y/: <Y or N>

l For N a table is output to the screen, and the same table is saved as a
basic text file with the default extension .TAB under the current working
directory. In this case, the graph cannot be plotted.

l For Y a table is created with all the thermodynamic functions as normal
(which is displayed on screen) as well as generates a graph with
temperature on the X-axis and a chosen property on a certain column in
the table on the Y-axis (which is plotted on screen and saved as an *.EXP
file), and it also ask which column is to be plotted on the resulting
graph:

Plot column ? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus
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temperature as X-axis) as a graph on the screen. Simultaneously, all tabulated
properties and the Y-axis setting (i.e. the plotted column) for the graph is
written into an *.EXP file using the DATAPLOT format. The default column 2 is
heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional
column 6 is a user-entered function. The table displays on the screen. The plot
then displays on the screen, followed by a POST: prompt. The POST module
(postprocessor) automatically opens, and all types of the POST-module
commands to refine the plotted diagram may be used. Possibilities include
scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or
EXIT at the POST: prompt always takes you back to the TAB module.

Also see the DATPLOT User Guide included with this documentation
set.

Example Output 1

For the FCC alloy phase as a non-ideal solution with a fixed composition

[Fe0.80,Cr0.10,Ni0.0995,O0.005][C0.05,N0.05,VA0.90]

The following table is obtained by typing Return for screen at the prompt Output file
/SCREEN/:

O U T P U T F R O M T H E R M O - C A L C

Phase : FCC                       Pressure :     100000.00

Specie: CR1/--2

***************************************************************

T     Cp           H            S            G

(K)   (Joule/K)     (Joule)     (Joule/K)     (Joule)

***************************************************************

298.15  2.70517E+01  6.23824E+03  4.40241E+01 -6.88755E+03

300.00  2.70889E+01  6.28832E+03  4.41916E+01 -6.96915E+03

400.00  2.87304E+01  9.08420E+03  5.22235E+01 -1.18052E+04

500.00  2.99904E+01  1.20222E+04  5.87742E+01 -1.73649E+04

600.00  3.10889E+01  1.50770E+04  6.43408E+01 -2.35275E+04

700.00  3.21116E+01  1.82375E+04  6.92106E+01 -3.02100E+04

800.00  3.30994E+01  2.14982E+04  7.35633E+01 -3.73524E+04

900.00  3.40742E+01  2.48569E+04  7.75182E+01 -4.49094E+04
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1000.00  3.50483E+01  2.83130E+04  8.11586E+01 -5.28456E+04

1100.00  3.60268E+01  3.18667E+04  8.45449E+01 -6.11327E+04

1200.00  3.70143E+01  3.55187E+04  8.77219E+01 -6.97476E+04

1300.00  3.80149E+01  3.92700E+04  9.07241E+01 -7.86713E+04

1400.00  3.90311E+01  4.31222E+04  9.35784E+01 -8.78875E+04

1500.00  4.00649E+01  4.70768E+04  9.63064E+01 -9.73827E+04

1600.00  4.11174E+01  5.11358E+04  9.89256E+01 -1.07145E+05

1700.00  4.21896E+01  5.53010E+04  1.01450E+02 -1.17165E+05

1800.00  4.33555E+01  5.95774E+04  1.03894E+02 -1.27433E+05

1900.00  4.58528E+01  6.40379E+04  1.06306E+02 -1.37943E+05

2000.00  4.75402E+01  6.87138E+04  1.08704E+02 -1.48694E+05

Example Output 2

For a phase, as either an end-member or real solution, the listed species name
is irrelevant.

For the H2 species as a pure substance (using the SSUB5 database), the following table is
obtained by typing Return for screen at the prompt Output file /SCREEN/, whilst the
figure is generated by typing 5 at the prompt Plot column /2/:

O U T P U T F R O M T H E R M O - C A L C

Phase : GAS                       Pressure :     100000.00

Specie: H2

***************************************************************   T     Cp           
H            S            G

(K)   (Joule/K)     (Joule)     (Joule/K)     (Joule)

*************************************************************** 298.15  
2.88369E+01  3.17684E-06  1.30680E+02 -3.89622E+04

300.00  2.88473E+01  5.33580E+01  1.30858E+02 -3.92042E+04

400.00  2.91591E+01  2.95686E+03  1.39209E+02 -5.27268E+04

500.00  2.92650E+01  5.87874E+03  1.45729E+02 -6.69856E+04

600.00  2.93441E+01  8.80908E+03  1.51071E+02 -8.18336E+04

700.00  2.94579E+01  1.17488E+04  1.55602E+02 -9.71730E+04

800.00  2.96320E+01  1.47027E+04  1.59547E+02 -1.12935E+05

900.00  2.98786E+01  1.76776E+04  1.63050E+02 -1.29068E+05

1000.00  3.02043E+01  2.06810E+04  1.66214E+02 -1.45533E+05

1100.00  3.05319E+01  2.37171E+04  1.69108E+02 -1.62302E+05
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1200.00  3.09281E+01  2.67897E+04  1.71781E+02 -1.79348E+05

1300.00  3.13615E+01  2.99040E+04  1.74274E+02 -1.96652E+05

1400.00  3.18115E+01  3.30625E+04  1.76614E+02 -2.14197E+05

1500.00  3.22641E+01  3.62664E+04  1.78824E+02 -2.31970E+05

1600.00  3.27094E+01  3.95151E+04  1.80921E+02 -2.49958E+05

1700.00  3.31406E+01  4.28078E+04  1.82917E+02 -2.68151E+05

1800.00  3.35526E+01  4.61426E+04  1.84823E+02 -2.86539E+05

1900.00  3.39415E+01  4.95175E+04  1.86648E+02 -3.05113E+05

2000.00  3.43045E+01  5.29300E+04  1.88398E+02 -3.23866E+05
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TERNARY_DIAGRAM Commands
In this section:

TERNARY_DIAGRAM Module 331
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TERNARY_DIAGRAM Module
The TERNARY_DIAGRAM module (short name, the TERN module) enables you to quickly
calculate a simple ternary phase diagram.

To enter the module, at the SYS prompt type GOTO_MODULE TERNARY. There are no other
commands for this module. Follow the prompts to plot a diagram.

Also see the Graphical Mode equivalent to this command, "Ternary Calculator"
on page 139 as described in the Thermo-Calc User Guide.

Syntax TERNARY_DIAGRAM

Prompts Database: /FEDEMO/

First element:

Second element:

Third element:

Phase diagram, Monovariants, or Liquidus Surface: /Phase_
Diagram/

Temperture (C) /1000/

Global minimization on: /Y/
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Thermodynamic Variables and Units
The following topics are about the different thermodynamic variables recognised by
Thermo-Calc. The topics have information about how to define new derived variables and
functions and how to express thermodynamic variables in non-default units. The POLY
module only recognises default units, which are the SI units.

See example 44 in the Thermo-Calc Console Mode Examples to learn about
using variables and functions.

In this section:

Thermodynamic Variables 333

Common Thermodynamic Variables 333

Derived Variables and Partial Derivatives 350

Defining New Derived Variables and Functions 352

Derived Variables for Aqueous Solutions 352

Defining New Derived Variables for Aqueous Solutions 356

Thermodynamic Variables and Wildcard Characters 357

Units of State Variables and Derived Variables 358
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Thermodynamic Variables
There are different thermodynamic variables in Thermo-Calc. Some are state variables, for
example temperature, pressure and mole fraction. These characterize the equilibrium state
of a system. You set them when you define your system in the POLY module before
performing a calculation. They are also used in other modules such as DATA, GIBBS and
PARROT. State variables that involve components can be used for the defined components,
but not for any species. (To define new components in a defined system, use "DEFINE_
COMPONENTS" on page 196).

Other useful thermodynamic variables are derive from state variables with a mathematical
function. Some derived variables are pre-defined by Thermo-Calc, such as normalized
energetic and compositional extensive state variables for example. You use these by
appending various normalizing suffixes to abbreviations that are associated with the state
variables.

Thermodynamic variables can also be divided into extensive variables and intensive
variables. An extensive variable is a variable whose value depends on the size of the system,
whereas an intensive variable is a variable whose value is independent of system size.

More information about thermodynamic variables is available in the online help in Thermo-
Calc Console Mode. Use the command "INFORMATION" on page 5, with a subject keyword
such as one of the following as argument: STATE VARIABLES, INTENSIVE VARIABLES,
EXTENSIVE VARIABLES, DERIVED VARIABLES, CONDITIONS (for condition settings), AXIS-
VARIABLES (for stepping/mapping variable settings).

Common Thermodynamic Variables
The tables below list common thermodynamic variables. Most of these can be used to define
equilibrium conditions in the POLY module unless otherwise indicated.

The variables are divided into the following tables:

l Intensive variables

l Energy-related extensive variables for whole system or for a phase

l Compositional extensive variables (overall amount of components in the whole
system, or amount of a component in system or in a phase)

l Constitutional composition-related extensive variables (amount of a
constituent/species on a sublattice site in a phase)

l Special quantities
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How to read the tables

l The Abbrev. column shows the abbreviation that you use in the POLY module for
referring to the variable. If the variable must be given any arguments, then these are
given in parenthesis directly after the abbreviation. For most variables, this is also
the abbreviation that you use to refer to the variable in other modules. However,
some variables are referred to with a different abbreviation in the POST module. If
this is the case, then this is noted at the bottom of the table.

l Variables that are specific to a species, in which case the species is specified as an
argument (sp in the table below). If there are two or more sublattices in a given
phase, then this argument is given as constituent#sublattice. This indicates a
constituent on a specific sublattice or site in the phase (referred to by the # sign and
a digit). For example, y(BCC,C#2) stands for the site fraction of the C species on the
second sublattice site of the BCC_A2 solution phase.

l The Unit column show which unit that you can use to express the variable in the POLY
module. This unit is always the SI unit. In other modules, state variables may be
expressed in other units.

l The Suffix column shows the suffixes you can append to the variables. The R-suffix
can be used with all compositional extensive state variables, but the suffix does not
always change the value of the variable. This is indicated by putting the R in
parenthesis.

These types of variables are listed in the following topics:

l "Intensive Variables" below

l "Extensive Variables" on the next page

l "Special Quantities" on page 339

l "The u-Fraction Variable" on page 340

l "Suffixes" on page 341

Intensive Variables

V Abbrev. Unit Descript. Domain Suffix

T T1 K Temperature System

P P Pa Pressure System
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V Abbrev. Unit Descript. Domain Suffix

µ

MU(comp)

J/mol Chemical
potential

Component R

MU(sp,ph)2
Species
relative to
a solution
phase

R

a

AC(comp)

N/A

Activity

Component R

AC(sp,ph)2
Species
relative to
a solution
phase

R

LNAC
(comp)3

ln(Activity)

Component R

LNAC
(sp,ph) 2

Species
relative to
a solution
phase

R

1 When plotting in POST, besides T (Kelvin), you can also use T_C or T_F to plot
temperature in °C or °F.
2 Only for single-substitutional-lattice solution phases such as AQUEOUS solution and
GASeous mixture phases and for interacting species on the substitutional sublattice of
two-sublattice solution phases (such as the phases BCC_A2 and M6C phases).
3 In natural logarithm (lnAC=MU/RT)

Extensive Variables

Energy-Related Extensive Variables for Whole System or for a Phase

See example tcex44 in the Thermo-Calc Console Mode Examples Guide for an
example of using variables and functions.
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V Abbrev. Unit Descript. Domain Suffix

V

V

m3 Volume

System M, W, V, R

V(ph)1 Phase M, W, F, R

VP(ph) 2 Phase M, W, V, R

G

G

J Gibbs energy

System M, W, V, R

G(ph) 1 Phase M, W, V, F,
R

A

A

J Helmholtz
energy

System M, W, V, R

A(ph) 1 Phase M, W, V, F,
R

U

U

J Internal energy

System M, W, V, R

U(ph) 1 Phase M, W, V, F,
R

H
H

J Enthalpy
System M, W, V, R

H(ph) Phase M, W, V, F

S

S

J/K Entropy

System M, W, V, R

S(ph) 1 Phase M, W, V, F,
R

Cp

HM.T3

J/mol/K
Heat capacity at
constant
pressure

System R

HM(ph).T3 Phase R

Cv HM.T4 J/mol/K Heat capacity at
constant volume System R
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V Abbrev. Unit Descript. Domain Suffix

HM(ph).T4 Phase R

D DG(ph) 5 N/A
Driving force
(thermodynamic
factor)

Phase

Always use
with M, W,
V or F. R
can also be
used.

1 For this variable, if the phase is unstable, then the variable gets a value of zero.

2 Do not use VP(ph) as a condition in POLY. Instead, use CHANGE_STATUS PHASE
<PHASE>=FIX <AMOUNT> where the fixed <AMOUNT> is roughly equal to VPF(ph), which
cannot be directly evaluated or listed. If the phase is unstable, then VP(ph) and its
normalized quantities get zero value.
3 Use only if pressure has been set as a condition.

4 Use only if volume has been set as a condition.

5 Already divided by RT.

Compositional Extensive Variables

These are for the overall amount of components in whole system, or amount of a
component in system or in a phase.

Do not use NP(ph) or BP(ph) as conditions in the POLY module. Instead use CHANGE_STATUS
PHASE <PHASE>=FIX <AMOUNT> where the fixed <AMOUNT> is roughly equal to NPF(ph) or
BPF(ph), which cannot be directly evaluated or listed. If the phase is unstable, then NP(ph) or
BP(ph) (and its normalized quantities) get zero value.

When plotting the following quantities in POST, refer to each as indicated:

l X(comp) -> Mole-Fraction <comp> (or M_F)

l W(comp) -> Weight-Fraction <comp> (or W_F)

l X%(comp) -> Mole-Percent <comp> (or M_P)

l W%(comp) -> Weight-Percent <comp> (or W_P).

l u-f(ph,comp) -> U-F
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V Abbrev. Unit Descript. Domain Suffix Comment

n

N

mole Moles

All components M, W,
V, (R)

N(comp) Component M, W,
V, (R)

N
(ph,comp)

Component in a
phase

M, W,
V, (R)

NP(ph)1 Phase M, W,
V, (R) See above

b

B

gram Mass

All components M, W,
V, (R)

B(comp) Component M, W,
V, (R)

B
(ph,comp)

Component in a
phase

M, W,
V, (R)

BP(ph) 1 Phase M, W,
V, (R) See above

x

X(comp)

N/A Mole fraction

Component (R) See above

X
(ph,comp)

Component in a
phase (R)

w

W(comp)

N/A
Mass
(weight)
fraction

Component (R) See above

W
(ph,comp)

Component in a
phase (R)

x% X%
(comp)2 N/A Mole percent Component (R) See above



Thermo-Calc Documentation Set

Thermodynamic Variables and Units ǀ 339 of 370

V Abbrev. Unit Descript. Domain Suffix Comment

w% W%
(comp)2 N/A

Mass
(weight)
percent

Component (R) See above

u
u-f
(ph,comp)
1

N/A u-fraction Component in a
stable phase (R) See above

in IN(sp)2 mole Input mole
number

Phase species in
the system (R) See above

im IM(sp)2 gram Input mass
unit

Phase species in
the system (R) See above

1 Do not use as a condition in the POLY module.

2 Only available in TQ-Interface and TC-API.

Constitutional Composition-Related Extensive Variable

This is the amount of a constituent/species on a sublattice site in a phase.

V Abbrev. Unit Descript. Domain

y Y
(ph,cons#sub) N/A Site

fraction
Constituent on a sublattice site (denoted
by # and a digit) in a phase

Special Quantities

V Abbrev. Unit Descript. Domain Suffix

Q QF(ph)1 N/A
Phase
stability
function

Phase

R

Under a condition
and system
definition, QFR(ph)
= QF(ph)
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V Abbrev. Unit Descript. Domain Suffix

Tc TC(ph) 2 K Curie
temperature Phase

R

Under a condition
and system
definition, TCR(ph)
= TC(ph)

Mb BMAG
(ph)3 N/A

Bohr
magneton
number

Phase

R

Under a condition
and system
definition, BMAGR
(ph) = BMAG(ph)

1 Negative when phase composition is inside a spinodal, otherwise positive. Can be used
to find out if an equilibrium is within the miscibility gap for a solution phase. Cannot be
used as a condition.
2 Calculated for phases with magnetic contributions in an equilibrium state. Cannot be
used as a condition, but can be plotted in POST or evaluated in POLY using SHOW_
VALUE.
3 Calculated for phases with magnetic contributions in an equilibrium state.

The u-Fraction Variable

The u-fraction is an important quantity in some single-point or stepping paraequilibrium
calculations in the POLY module and in the DICTRA module. You can apply the variable in a
paraequilibrium calculation to the substitutional matrix component, the substitutional
alloying components or the interstitial component. The u-fraction is denoted as ui for the i-th
system component n of a whole system or of a specific phase in various equilibrium states
(such as full-equilibria, partial-equilibria, para-equilibria, local-equilibria).

Generally, the u-fraction is defined as:

The sum of xj in the denominator is calculated for all substitutional alloying elements in the
whole system or in a specific phase. The variable xi in the numerator stands for the mole-
fraction of the i-th component in the whole system or in the specific phase.
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Suffixes

Suffixes may be appended to all extensive variables and to some intensive variables. Some
suffixes can be used to enter the value of variables in normalized form. These are referred
to as normalizing suffixes. If the variable that you create with a normalizing suffix is based
on a state variable that can be set as a condition in POLY, then the normalized variable can
also be set as a condition in POLY.

The normalizing suffixes are M (per mole), W (per mass in gram), V (per volume in m3) and
F (per mole formula unit). There is also a reference state suffix R, which you can use if you
want the value of a thermodynamic variable to be calculated with respect to a reference
state that have previously set.

Normalizing Suffixes

When variables that express system and phase quantities are normalized, the following
general rules are used:

l System quantities are normalized by the total system size (in terms of N, B or V).

l Phase quantities are normalized by the phase amount [in terms of NP(ph), BP(ph) or
VP(ph)].

The normalized quantities of G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) are calculated
according to the thermodynamic model used for the phase (e.g. GM(ph), AM(ph), UM(ph),
HM(ph), SM(ph) and VM(ph)). These quantities are calculated using the first derivatives of
the Gibbs energy expressed for the phase with respect to the current composition of the
system.

The tables describe the normalizing suffixes for the different state variables.

G, A, U, H, S and V of a Whole System

Suffix Description Example(s)

M (per
mole)

First derivative of the variable with regard
to the total system size in terms of N.

GM is the Gibbs energy per
mole of the system (J/mol).

GM = ∂G/∂N

W (per
mass in
gram)

First derivative of the variable with regard
to the total system size in terms of B.

GW is the Gibbs energy per
mass of the system (J/g).

GW = ∂G/∂B
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Suffix Description Example(s)

V (per
volume in
m3)

First derivative of the variable with regard
to the total system size in terms of V.

VV does not have to be evaluated.

GV is the Gibbs energy per
volume of the system (J/m3).

GV = ∂G/∂V
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G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) of a Phase

Suffix Description Example(s)

M (per
mole)

First derivative of the variable with regard to the
phase amount in terms of NP(ph).

GM(ph) is Gibbs energy of
the phase per mole of the
phase (J/mol).

GM(ph) = ∂G(ph)/∂NP(ph)

W (per
mass in
gram)

First derivative of the variable with regard to the
phase amount in terms of BP(ph).

GW(ph) is Gibbs energy of
the phase per mass of the
phase (J/mol).

GW(ph) = ∂G(ph)/ ∂BP(ph)

V (per
volume
in m3)

First derivative of the variable with regard to the
phase amount in terms of VP(ph).

VV(ph) does not have to be evaluated.

GV(ph) is Gibbs energy of
the phase per volume of
the phase (J/mol).

GV(ph) = ∂G(ph)/∂VP(ph)

F (per
mole
formula
unit)

First derivative of the variable with regard to the
phase amount in terms of NP(ph) and NA (NA is
the total atomic number in the phase formula)

GF(ph) is the Gibbs energy
of the phase per formula
unit of the phase (J/mol).

GF(ph) = ∂G(ph)/∂NP
(ph)*NA
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DG(ph) of a Phase

Suffix Description Example(s)

M (per
mole)

Theoretically, the first derivative of the variable
with regard to the phase amount in terms of NP
(ph). Since DG(ph) is not directly calculated, the
second derivative of the Gibbs energy expressed
for the phase in question with respect to the
current compositions in the equilibrium state of
the system is calculated instead.

DGM(ph) cannot not be set as a condition since it
is only calculated under a certain type of
equilibrium state.

DGM(ph) is driving force
for precipitation of the
phase per mole of
components.

DGM(ph) = ∂DG(ph)/∂NP
(ph)

W (per
mass in
gram)

Theoretically, the first derivative of the variable
with regard to the phase amount in terms of BP
(ph). Since DG(ph) is not directly calculated, the
second derivative of the Gibbs energy expressed
for the phase in question with respect to the
current compositions in the equilibrium state of
the system is calculated instead.

DGW(ph) cannot not be set as a condition since it
is only calculated under a certain type of
equilibrium state.

DGW(ph) is driving force
for precipitation of the
phase per mass of
components.

DGW(ph) = ∂DG(ph)/∂BP
(ph)

V (per
volume
in m3)

Theoretically, the first derivative of the variable
with regard to the phase amount in terms of VP
(ph). Since DG(ph) is not directly calculated, the
second derivative of the Gibbs energy expressed
for the phase in question with respect to the
current compositions in the equilibrium state of
the system is calculated instead.

DGV(ph) cannot not be set as a condition since it is
only calculated under a certain type of equilibrium
state.

DGV(ph) is driving force
for precipitation of the
phase per volume of
components.

DGV(ph) = ∂DG(ph)/∂VP
(ph)
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Suffix Description Example(s)

F (per
mole
formula
unit)

Theoretically, the first derivative of the variable
with regard to the phase amount in terms of NP
(ph) and NA (NA is the total atomic number in the
phase formula). Since DG(ph) is not directly
calculated, the second derivative of the Gibbs
energy expressed for the phase in question with
respect to the current compositions in the
equilibrium state of the system is calculated
instead.

DGF(ph) cannot not be set as a condition since it is
only calculated under a certain type of equilibrium
state.

DGF(ph) is driving force
for precipitation of the
phase per formula unit of
components.

DGF(ph) = ∂DG(ph)/∂NP
(ph)*NA
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N and B of a System

Suffix Description Example(s)

M (per
mole)

First derivative of the variable with
regard to the total system size in terms
of N.

NM does not have to be evaluated.

BM cannot be set as a condition.

BM is mass (gram) of components
per mole of the system (g/mol).

BM = ∂B/∂N

W (per
mass in
gram)

First derivative of the variable with
regard to the total system size in terms
of B.

BW does not have to be evaluated.

NW cannot be set as a condition.

NW is mole number of
components per mass of the
system (mol/g).

NW = ∂N/∂B

V (per
volume in
m3)

First derivative of the variable with
regard to the total system size in terms
of V.

BV is the density of the entire system.

NV is mole number of components
per volume of the system
(mol/m3).

NV = ∂N/∂V

BV is the density of the entire
system (g/m3).

BV = ∂B/∂V

N (comp) and B(comp) of a Component in the System

Suffix Description Example(s)

M (per
mole)

First derivative of the variable
with regard to the total
system size in terms of N.

BM(comp) cannot be set as a
condition. 

NM(comp) is the mole of a component per
mole of the system (i.e. mole fraction, which
also is expressed as X(comp)).

NM(comp) = ∂N(comp)/ ∂N

W (per
mass
in
gram)

First derivative of the variable
with regard to the total
system size in terms of B.

NW(comp) cannot be set as a
condition.

BW(comp) is mass (gram) of a component per
mass of the system (i.e. mass fraction, which
also is expressed as W(comp)).

BW(comp) = ∂B(comp)/∂B
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Suffix Description Example(s)

V (per
volume
in m3)

First derivative of the variable
with regard to the total
system size in terms of V.

NV(comp) is mole number of a component per
volume of the system (mol/m3).

NV(comp) = ∂N(comp)/ ∂V
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NP(ph), BP(ph) and VP(ph) of a Phase in the System

Suffix Description Example(s)

M (per
mole)

BPM(ph) and VPM(ph): First derivative of
the variable with regard to the phase
amount in terms of NP(ph).

NPM(ph): First derivative of the variable
with regard to the total system size in terms
of N.

BPM(ph) is mass (gram) of a
phase per moles of the system
(g/mol).

BPM(ph) = ∂BP(ph)/∂N

NPM(ph) is number of moles of
a phase per moles of the system
(mole fraction).

NPM(ph) = ∂NP(ph)/∂N

W (per
mass in
gram)

NPW(ph) and VPW(ph): First derivative of
the variable with regard to the phase
amount in terms of BP(ph).

BPW(ph): First derivative of the variable
with regard to the total system size in terms
of B.

VPW(ph) is volume (m3) of a
phase per mass of the system
(m3/g)

VPW(ph) = ∂VP(ph)/∂B

BPW(ph) is mass (gram) of a
phase per mass of the system
(mass fraction)

BPW(ph) = ∂BP(ph)/∂B

V (per
volume
in m3)

NPV(ph) and BPV(ph): First derivative of the
variable with regard to the phase amount in
terms of VP(ph).

VPV(ph): First derivative of the variable
with regard to the total system size in terms
of V.

NPV(ph) is number of moles of a
phase per volume of the system
(mol/m3).

NPV(ph) = ∂NP(ph)/∂V

VPV(ph) is volume (m3) of a
phase per volume of the system
(volume fraction).

VPV(ph) = ∂VP(ph)/∂V
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N(ph,comp) and B(ph,comp) of a Component in a Phase

Suffix Description Example(s)

M (per
mole)

First derivative of the
variable with regard to the
phase amount in terms of NP
(ph) of the phase.

NM(ph,comp)is number of moles of a
component per mole of a phase (i.e. mole
fraction of a component in a phase, which is
equivalent to X(ph, comp)).

NM(ph,comp) = ∂N(ph,comp)/∂NP(ph)

W (per
mass
in
gram)

First derivative of the
variable with regard to the
phase amount in terms of BP
(ph) of the phase.

BW(ph,comp) is mass (gram) of a component
per mass of a phase (i.e. mass fraction of a
component in a phase, which is equivalent to W
(ph,comp)).

BW(ph,comp) = ∂B(ph,comp)/∂BP(ph)

V (per
volume
in m3)

First derivative of variable
with regard to the phase
amount in terms of VP(ph) of
the phase.

NV(ph,comp) is mole number of a component
per volume of a phase (mol/m3).

NV(ph,comp) = ∂N(ph,comp)/∂VP(ph)

The Reference State Suffix R

You can use the reference state suffix R for some thermodynamic variables to calculate their
value with respect to a reference state that you have previously set for a system component
with the "SET_REFERENCE_STATE" on page 224 command in POLY (or in a response-driven
modules such as the POURBAIX module). The value of energy-related variables that are used
with the R suffix depends on the reference states of all the components in the defined
system.

It is possible to use an R suffix on all compositional extensive state variables as
well, but the value of the state variable is always the same, with or without the
suffix.

If the reference state for a system component is the default reference state (the stable
reference state (SER) which is defined in a Thermo-Calc database), then MUR(comp)= MU
(comp), ACR(comp)= AC(comp) and LNACR(comp)= LNAC(comp).

In the case of some thermodynamic variables, you can also use the R suffix to express
chemical potentials and activities of species relative to some single-substitutional-lattice
solution phases (such as aqueous solution, gaseous mixture, metallic liquid solution, slag
mixture or MO solid solution). These state variables are MU(sp,ph),  MUR(sp,ph),  AC(sp,ph), 
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ACR(sp,ph), LNAC(sp,ph) and LNACR(sp,ph).

The reference states and standard states of various solution species are pre-defined for
some solution phases in some databases. For all solution species in any solution model in any
database, it is always the case that MUR(sp,ph)= MU(sp,ph), ACR(sp,ph)= AC(sp,ph) and
LNACR(sp,ph)= LNAC(sp,ph).

Derived Variables and Partial Derivatives
Many derived variables can be obtained easily by using partial derivatives of state variables,
such as heat capacity, thermal expansivity, isothermal compressibility, among others.

Derivatives of state variables can be defined or evaluated by putting a dot (.) between two
state variables. The variable after the dot must be a condition that you have set when you
defined your system. For example, the heat capacity (at constant pressure or volume) of a
system is the partial derivative of the state variable enthalpy with respect to temperature.
To evaluate this derivative, use the designation HM.T, where temperature is a state variable
that you have set already.

Any partial derivative of a state variable with respect to another can be defined or evaluated
as a derived variable by using the dot (.) notation.

Derived Variables Dot Notation Examples

The following table shows some examples:

Derived variable Description

HM.T = ∂HM/∂T
Heat capacity for the system at either constant P if
pressure is a condition or constant V if volume is a
condition.

HM(ph).T = ∂HM(ph)/ ∂T
Heat capacity for a phase at either constant P if
pressure is a condition or constant V if volume is a
condition.

H.T = ∂H/∂T

Heat capacity for the system multiplied by total mole
number of components, i.e., ∂H/∂T = Cp*N if pressure is
a condition in a closed system or ∂H/∂T = Cv*N if
volume is a condition in a closed system.
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Derived variable Description

H(ph).T = ∂H(ph)/ ∂T

Heat capacity for a phase multiplied by the sum of NP
(ph) and HM(ph)*∂NP(ph)/∂T, i.e., Cp(ph)*NP(ph)+HM
(ph)*∂NP(ph)/∂T if pressure is a condition or Cv(ph)*NP
(ph)+HM(ph)*∂NP(ph)/ ∂T if volume is a condition.

VM.T = ∂VM/∂T Thermal expansivity of the system (already multiplied
by the total molar volume), i.e., ∂VM/∂T = α*VM.

VM(ph).T = ∂VM(ph)/∂T Thermal expansivity of a phase (already multiplied by
its molar volume), i.e., ∂VM(ph)/ ∂T = α(ph)*VM (ph).

V.T = ∂V/∂T Thermal expansivity of the system (already multiplied
by the total volume), i.e., ∂V/∂T = α*V.

V(ph).T = ∂V(ph)/∂T

Thermal expansivity of a phase (already multiplied by
the phase volume) plus the VM(ph)*∂NP(ph)/∂T term,
i.e., ∂V(ph)/∂T = α(ph)*V(ph)= α(ph)*VM (ph)*NP
(ph)+VM (ph)*∂NP(ph)/∂T.

VM.P = -∂VM/∂P
Isothermal compressibility of the system (already
multiplied by the total molar volume), i.e., ∂VM/∂P = -
κ*VM.

VM(ph).P = -∂VM(ph)/ ∂P
Isothermal compressibility of a phase (already
multiplied by its molar volume), i.e., ∂VM(ph)/∂P = -κ
(ph)*VM (ph).

V.P = -∂V/∂P Isothermal compressibility of the system (already
multiplied by the total volume), i.e., ∂V/∂P = -κ*V.

V(ph).P = -∂V(ph)/∂P

Isothermal compressibility of a phase (already
multiplied by the phase volume) plus the VM(ph)*∂NP
(ph)/∂P term, i.e., ∂V(ph)/∂P = -κ(ph)*V(ph) = -κ
(ph)*VM (ph)*NP(ph)+VM (ph)*∂NP(ph)/∂P.

T.X(comp) = ∂T/∂X(comp)
Slope of a phase boundary on a T-X(comp) phase
diagram with respect to mole fraction of the
component in the system.

T.W(comp) = ∂T/∂W(comp)
Slope of a phase boundary on a T-W(comp) phase
diagram with respect to mass of the component in the
system.
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Derived variable Description

T.X(ph,comp) = ∂T/∂X(ph,comp)
Slope of a phase boundary on a T-X(ph,comp) phase
diagram with respect to mole fraction of the
component in the phase.

T.W(ph,comp) = ∂T/∂W
(ph,comp)

Slope of a phase boundary on a T-W(ph,comp) phase
diagram with respect to mole fraction of the
component in the phase.

P.T = ∂P/∂T
Slope of a phase boundary on a P-T phase diagram
(Note that the equilibrium with phase assemblage must
be calculated first).

Defining New Derived Variables and Functions
You can define additional derived variables or functions based on a state variable by using
"ENTER_SYMBOL" on page 247. Any derived variable or function must have a unique name
that starts with a letter and has a maximum number of eight characters. These characters
can include both uppercase and lowercase letters, numerical digits and the underscore (_).
No other characters are allowed.

The difference between new derived variables introduced with the ENTER_SYMBOL
command and new functions introduced with the same command is as follows. Whenever
Thermo-Calc calculates the value of a function (as part of an equilibrium calculation for
example), all functions related to the defined system is evaluated. An entered derived
variable, on the other hand, is only evaluated when it is defined and when it is re-evaluated
with "EVALUATE_FUNCTIONS" on page 208.

Derived Variables for Aqueous Solutions
Standard state variables used for other phases can be directly applied to the aqueous
solution phase. In addition, there are pre-defined derived variables for the aqueous solution
phase in particular.

Examples of predefined derived variables for the aqueous solution phase are listed and
briefly described in the following tables. Some derived variables for a gaseous mixture
phase are also shown. This is because EOS (Equation of State) expressions, standard
thermodynamic properties and transport properties of the pure solvent H2O are also
expressions and properties of the pure gaseous species H2O.
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For Aqueous Solution Phase

Name Abbrev. Units Description Comments

pH PH N/A Acidity

of the aqueous
solution phase

pH = -log10(AC(H+)) =
-log10(ACR(H+,AQ))

Eh EH V, mV Hypothetical
electric potential

of the aqueous
solution phase

Eh = u(ZE)/96485.309

Pe PE N/A
Logarithm of the
hypothetical
electron activity

of the aqueous
solution phase

pe = u(ZE)/
(2.3025851*RT)

Ah AH kJ, kcal Thermodynamic
affinity per electron

of a redox couple wrt
the standard
hydrogen electrode 
in the aqueous
solution phase

Ah = u(ZE)

yw YH2O N/A Mole fraction

of the solvent H2O in
the aqueous solution
phase

YH2O = Y(AQ,H2O)

Nw AH2O mole Mole number
of 1.0 kg of solvent
H2O

AH2O = 55.508435

Nsp NSH2O mole
Mole number,

NS(AQ,H2O)

of the solvent (H2O)
in the aqueous
solution phase

NS(AQ,H2O) =
YH2O*NP(AQ)
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Name Abbrev. Units Description Comments

NS#
Mole number,

NS(AQ,sp)

of a solute species in
the aqueous solution
phase

NS(AQ,sp) = Y
(AQ,sp)*NP(AQ)

M ML# mol/kg_
H2O

Molality,

ML(AQ,sp)

of a solute species in
the aqueous phase

ML(AQ,sp) = Y
(AQ,sp)*AH2O/YH2O

m* TIM equivalent
molality Total molality

of all solute species in
the aqueous solution
phase

TIM = sum[ML
(AQ,sp)]ions + sum
[ML
(AQ,sp)]complexes

mt TIC# equivalent
molality

Total ionic
concentration, TIC
(AQ,sp)

of a cation I in the
aqueous phase

TIC(AQ,spI) = sum[ML
(AQ,spJ)*V(spI-in-
spJ)]

I ISTR N/A Ionic strength

of the aqueous
solution phase

ISTR=1/2*sum[ML
(AQ,sp)*Z(AQ,sp)**2]

γ

RCH2O

N/A

Activity coefficient, 

RC(H2O,AQ)

of the solvent (H2O)

RC(H2O,AQ) = ACR
(H2O,AQ)/YH2O

RC#
Activity coefficient, 

RC(sp,AQ)

of a solute species

RC(sp,AQ) = ACR
(sp,AQ)/Y
(AQ,sp)*YH2O

αi AIH2O N/A Activity, of the solvent (H2O),
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Name Abbrev. Units Description Comments

AI(H2O,AQ) AI(H2O,AQ) = ACR
(H2O,AQ)

AI#
Activity,

AI(sp,AQ)

of a solute species
related to the
aqueous solution
phase,

AI(sp,AQ) = ACR
(sp,AQ)*AH2O

LogAI#
Log10 Activity,
LogAI(H2O,AQ),

LogAI(sp,AQ)

of the solvent or a
solute species related
to the aqueous
solution phase in
common logarithm,

LogAI(H2O,AQ) =
log10[AI(H2O,AQ)]

LogAI(sp,AQ)  =
log10[AI(sp,AQ)]

αw AW N/A Activity

of H2O in the
aqueous solution
phase

AW = ACR(H2O,AQ)

φ OS N/A Osmotic coefficient

of aqueous solution
phase

OS = -
55.508435*lnAW/TIM

At1 AT1
equil_
mol/kg_
H2O

Titration alkalinity
(definition 1)

of the aqueous
solution phase

Generally defined as
the equivalent
molality of carbonate
and bicarbonate at
the methyl orange
endpoint (pH=4.5).
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Name Abbrev. Units Description Comments

At2 AT2
equil_
mol/kg_
H2O

Titration alkalinity
(definition 2)

of the aqueous
solution phase

Generally defined as
the equivalent
molality of carbonate
and bicarbonate, plus
sulfide, at the methyl
orange endpoint
(pH=4.5).

For Gaseous Mixture Phase

Name Abbrev. Units Description Comments

γ RA# N/A
Activity
coefficient,

RA(sp,GAS)

of a gaseous species in the gaseous
mixture

RA(sp,GAS) = function(Y,T,P)

γ* RF# N/A
Fugacity
coefficient,

RF(sp,GAS)

of a pure gaseous species under TP

RF(sp,GAS) = function(T,P/V)

F FUG# pa, bar,
psi

Fugacity,

FUG(sp,GAS)

of a gaseous species in the gaseous
mixture

FUG(sp,GAS) = RA(sp,GAS)*RF(sp,GAS)*Y
(GAS,sp)*P

ft TFUG pa, bar,
psi

Total gas
fugacity

of the gaseous mixture phase

TFUG = sum[FUG(sp,GAS)]

Defining New Derived Variables for Aqueous Solutions
You can define many different additional derived variables and functions. For instance, the
partition coefficient of a component between two phases is defined as follows:

Pc<name> = X(phase1,component)/X(phase2,component)

Another example is the activity coefficient of a component in the system. It is defined as
follows:

Rc<name> = ACR(component)/X(component)
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The activity coefficient of a species in a solution phase depends on which model definitions
on the reference states that are used and it depends on the standard states for the species. If
the standard state of a species is defined to be the same as the pure species in a
substitutional phase, then the activity coefficient of the species can be calculated as:

RC<name> = ACR(species,phase)/Y(phase,species)

In some cases, there are more than one sublattice in the phase and the reference states for
the phase species cannot be presented by the pure species, as in the case of C in FCC [(Fe)1
(C,N,VA)1], where the model may end at fifty percent C and fifty percent Fe. In those cases,
the chemical potential and activity of all phase constituents is not well defined and you
cannot properly define the activity coefficients of the species in the phase.

For an aqueous solution phase, no matter what model is used, the reference state and
standard state for both the solvent and solutes are defined in a special way in the Thermo-
Calc software. The reference state for the solvent is set as pure water, the same as its
standard state (according to Raoults's Law). The standard state for a solute species is set the
hypothetical solute species, whilst its reference state is defined as the hypothetical state at
unit molality (one mole dissolved into 1.0 kg of solvent) but in which the environment of
each molecular is the same as at infinite dilution (according to Henry's Law). Under these
definitions, the activity coefficients for solvent species can be calculated as follows:

RC<H2O> = ACR(H2O,aqueous)/ Y(aqueous,H2O)

The coefficients for the solute species can be calculated as follows:

RC<spec> = AI(species,aqueous)/ML(aqueous,species)
= ACR(species,aqueous)/ Y(aqueous,species)*Y(aqueous,H2O)

AI is here the activity of solute species calculated from the model, and ML is the molality of
the species.

Thermodynamic Variables and Wildcard Characters
The ACR (species,phase) and the MUR (species,phase) quantities can only be appropriately
and meaningfully applied to substitutional solution phases (such as GAS, AQUEOUS, LIQUID)
and to solution phases without an interstitial sublattice set. This means that the wild card
characters * and $ normally don’t work properly for the activity and/or chemical potential
properties.

For example, do not use ACR(*,*) or MUR(*,*) for all the species relative to all phases, nor
ACR(*,phase) or MUR(*,phase) for all the species relative to a specific phase, nor ACR
(species,*) or MUR(species,*) for a specific species relative to all phases.

Instead, use specific names for species and (applicable) phase, as in the following examples:

SHOW_VALUE acr(fe+2,aqueous)Lists activity of the Fe+2 species in AQUEOUS solution
phase



Thermo-Calc Documentation Set

Thermodynamic Variables and Units ǀ 358 of 370

SHOW_VALUE mur(c2,gas)Lists chemical potential of the C2 species in GAS mixture
phase

SET_AXIS_VAR y ac(o2,gas)Sets activity of the O2 species in GAS mixture phase as Y-
axis

Units of State Variables and Derived Variables
The units for the state variables in the Units column in the table in "User-Specified Units"
below are the SI units that are used in the POLY module. However, in the POST module, you
can both use pre-defined symbols and define your own symbols which are based on state
variables and derived variables. By doing this, you can express the value of the
thermodynamic variables in non-default units. The following topic briefly describes how you
can create your own symbols and suggests expressions that you can use to convert default
units into other standard units which are not default units in Thermo-Calc.

The topic "Examples of User-Defined Units" on the next page describes some variables of
specific species in a phase and the units in which they are expressed. These variables are not
used in POLY or POST, but in the GIBBS, DATA, PARROT and ED_EXP modules.

User-Specified Units

You do not always need to use the default units for variables. Using "ENTER_SYMBOL" on
page 247, you can convert the value of variable from the default unit to your preferred unit.
(Some response-driven modules also allow you to set conditions in non-default units.) User-
defined symbols in the form of functions can be used for plotting in the POST module, but
they cannot be used as conditions in POLY. User defined symbols in the form of variables can
be used as conditions.

For example, if you want pressure to be plotted in bar rather than Pa, then you define the
following function PB:

Enter_symbol function PB = P/1E5 ;

If you wanted heat capacity of a system to be shown as in terms of J/mol/K, then you can
define the following function Cp:

Enter_symbol function Cp = Hm.T ;

If the variable you want to convert is a function of one or more derivatives, then you must
enter the symbol as a variable rather as a function. For instance, a symbol expressing heat
capacity of a system in a unit of cal/mol/K can be defined as the following variable Cp2:

Enter_symbol variable Cp2 = Hm.T/4.1858 ;

Also see "Examples of User-Defined Units" on the next page for information
about entering conventional functions and the associated units.
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Examples of User-Defined Units

The following tables give examples of expressions you can use to enter symbols. This enables
you to show the values of thermodynamic variables in a variety of units.

"Units of State Variables and Derived Variables" on the previous page and
"User-Specified Units" on the previous page

You can also use thermodynamic variables with normalizing suffixes in the
expression when you enter a symbol. However, the tables do not have examples
of these expressions.

In the expressions these are defined as follows:

l i is for an auxiliary index or letter that corresponds to the component c

l j is for an auxiliary index or letter that corresponds to the phase ph, and

l ij stands for an auxiliary index or letter that corresponds to the component c in the
phase ph.

Intensive and Extensive Variables of a Defined System

Quantity Suggested name and
expression Unit

For intensive variables of a defined system

Temperature

TempC = T-273.15 Celsius (C)

TempF = 1.8*T-459.67
Fahrenheit (F)

TempF = 1.8*TempC+32
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Quantity Suggested name and
expression Unit

Pressure

PB    = P/1E5 bars (bar)

PKb   = P/1E8 kilobars (kbar)

PAtm  = P/101325 atmosphere (atm)

PSI   = P/6894.76 pounds/sq. inch (psi)

PIHg  = P/3342.11 inches of Hg

PTor  = P/133.322 Tors (millimeters of Hg)

For extensive variables of a defined system

Amount
BKg  = 1E-3*B kilograms (kg)

BTon = 1E-6*B tons

Volume

VDM = 1E-3*V cubic decimeters (dm3,
l)

VCM = 1E-6*V cubic centimeters (cm3)

VMM = 1E-9*V cubic millimeters
(mm3)

VCI = 1.6387064E-5*V cubic inches (in3)

VLi = 1E-3*V liters (l)
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Quantity Suggested name and
expression Unit

Energy

GCal = G/4.1858 cal

ACal = A/4.1858 cal

UCal = U/4.1858 cal

HCal = H/4.1858 cal

SCal = S/4.1858 Cal/K

Heat Capacity

Cp2 = HM.T/4.1858 cal/mol/K

Cp3 = HW.T/4.1858 cal/g/K

Cp4 = HV.T/4.1858 cal/m3/K

Thermal Expansion
A2 = VM.T*1E-6*VM cm3/mol/K

A3 = VW.T*1E-6*VM cm3/g/K

Isothermal
Compressibility

B2 = -VM.P*1E-9*VM mm3/mol/Pa

B3 = -VW.P*1E-9*VM mm3/g/Pa

Intensive and Extensive Variables of a System Component

Quantity Suggested name and expression Unit

For intensive variables of a system component

Chemical Potential
MUi  = MU(c)/4.1858 cal/mol

MURi = MUR(c)/4.1858 cal/mol
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Quantity Suggested name and expression Unit

Special quantity for aqueous
solution

pH = -LOG10(ACR(H+1)) dimensionless

Eh = MUR(ZE)/RNF where
RNF=96485.309 volts (V)

For extensive variables of a system component

Amount

MFi = N(c)/N = X(c) dimensionless

MPi = N(c)/N*100 dimensionless

WFi = B(c)/B = W(c) dimensionless

WPi   = B(c)/B*100 dimensionless

BKgi  = 1E-3*B(c) kilograms
(kg)

BToni = 1E-6*B(c) tons
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Extensive Variables of a Phase

Quantity Suggested name and
expression Unit

Amount

MFj   = NP(ph)/N dimensionless

MPj   = NP(ph)/N*100 dimensionless

WFj   = BP(ph)/B dimensionless

WPj   = BP(ph)/B*100 dimensionless

BKgj  = 1E-3*BP(ph) kilograms (kg)

BTonj = 1E-6*BP(ph) tons

Volume

VCMj = 1E-3*V(ph) cubic decimeters (dm3, l)

VCMj = 1E-6*V(ph) cubic centimeters (cm3)

VMMj = 1E-9*V(ph) cubic millimeters (mm3)

Energy

GCalj = G(ph)/4.1858 cal

ACalj = A(ph)/4.1858 cal

UCalj = U(ph)/4.1858 cal

HCalj = H(ph)/4.1858 cal

SCalj = S(ph)/4.1858 Cal/K
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Quantity Suggested name and
expression Unit

Driving Force

DG2j = DGM(ph)/4.1858 cal/mol

DG3j = DGW(ph)/4.1858 cal/g

DG4j = DGV(ph)/4.1858 Cal/m3

DG5j = DGF(ph)/4.1858 cal/mole_formula_unit

Heat Capacity

Cp2j = HM(ph).T/4.1858 cal/mol/K

Cp3j = HW(ph).T/4.1858 cal/g/K

Cp4j = HV(ph)/.T/4.1858 cal/m3/K

Cp5j = HF(ph)/.T/4.1858 cal/mole_formula_unit/K

Thermal Expansion

A2j = VM(ph).T*1E-6*VM cm3/mol/K

A3j = VW(ph).T*1E-6*VM cm3/g/K

A4j = VF(ph).T*1E-6*VM cm3/mole_formula_
unit/K

Isothermal
Compressibility

B2j = -VM(ph).P*1E-9*VM mm3/mol/Pa

B3j = -VW(ph).P*1E-9*VM mm3/g/Pa

B4j = -VF(ph).P*1E-9*VM mm3/mole_formula_
unit/Pa
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Extensive Variables of a Component in a Phase

Quantity Suggested name and expression Unit

Amount

MFij   = N(ph,c)/NP(ph)   = X(ph,c) dimensionless

MPij   = N(ph,c)/NP(ph)*100 dimensionless

WFi    = B(ph,c)/BP(ph)  = W(ph,c) dimensionless

WPij   = B(ph,c)/BP(ph)*100 dimensionless

BKgij  = 1E-3*B(ph,c) kilograms (kg)

BTonij = 1E-6*B(ph,c) tons

Intensive and Extensive Variables of a Species in a Phase

Quantity Suggested name and expression Unit

For intensive variables of a species in a phase

Chemical
Potential

MUCalij = MU(sp,ph)/4.1858 cal/mol

MUErgij = MU(sp,ph)*1E7 cal/mol

Fugacity

FAij   = AC(sp,ph)*PATM atmosphere
(atm)

FBij   = AC(sp,ph)*PB bars (bar)

FCij   = AC(sp,ph)*PKB kilobars
(kbar)

FTij   = AC(sp,ph)*PTOR
Tors
(millimeters
of Hg)
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Quantity Suggested name and expression Unit

ln(Fugacity)

LnFAij = LNAC(sp,ph)+LN(PATM) atmosphere
(atm)

LnFBij = LNAC(sp,ph)+LN(PB) bars (bar)

LnFCij = LNAC(sp,ph)+LN(PKB) kilobars
(kbar)

LnFTij = LNAC(sp,ph)+LN(PTOR)
Tors
(millimeters
of Hg)

Special
quantity for
aqueous
solution

AIij=ACR(FE+3,AQ)*AH2O dimensionless

RCij=ACR(FE+3,AQ)*YH2O/Y(AQ,FE+3)

where AH2O=55.508435 and YH2O=Y(AQ,H2O)
dimensionless

WRCalij = WR(AQ,sp)/4.1858

(WR(AQ,sp) is only valid for aqueous species in a
system in which the AQUEOUS solution phase is
considered)

cal/mol

For extensive variables of a species in a phase

Special
quantity for
aqueous
solution

MLij=Y(AQ,FE+3)*AH2O/YH2O molality (m)

ISTR=1*IS1+1*IS2+1*IS3

where AH2O=55.508435, YH2O=Y(AQ,H2O) and
ISn=.5*MLi*Zi**2+.5*MLj*Zj**2+.5*MLk*Zk**2

molality (m)

Units for Variables of Specific Species in a Phase

In the GIBBS, DATA, PARROT and ED_EXP modules, there are quantities that describe various
thermodynamic, physical, chemical and transport properties for a compound phase, and for
a certain species or a given species combination in a specific solution phase. The following
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table describes the units for those variables.

These variables cannot be directly used in the POLY or POST modules.

Variables Description and unit

G(ph,sp)

G(ph,sp;0)

G(ph,sp1;sp2;...;0)

Gibbs energy (J/mol) of a pure substance or end-member.

G(ph,sp1,sp2,...)

L(ph,sp1,sp2,...)

G(ph,sp1,sp2,...;0)

L(ph,sp1,sp2,...;0)

G
(ph,sp1,sp2,...;...;0)

L
(ph,sp1,sp2,...;...;0)

Zero-order interaction parameter (J/mol) of a specified binary,
ternary or higher-order interactions on a certain sublattice site in
a solution phase.

G(ph,sp1,sp2,...;i)

L(ph,sp1,sp2,...;i)

G
(ph,sp1,sp2,...;...;i)

L
(ph,sp1,sp2,...;...;i)

The ith -order interaction parameter (J/mol) of a specified binary,
ternary or higher-order interactions on a certain sublattice site in
a solution phase.

TC(ph,sp)

TC(ph,sp;0)

TC
(ph,sp1;sp2;...;0)

Curie temperature (K) of a pure substance or end-member.

TC(ph,sp1,sp2,...)

TC
(ph,sp1,sp2,...;0)

TC
(ph,sp1,sp2,...;...;0)

Zero-order Curie-temperature contribution (K) to a specified
binary, ternary or higher-order interactions on a certain sublattice
site in a solution phase.
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Variables Description and unit

TC(ph,sp1,sp2,...;i)

TC
(ph,sp1,sp2,...;...;i)

The ith -order Curie-temperature contribution (K) to a specified
binary, ternary or higher-order interactions on a certain sublattice
site in a solution phase.

BMAGN(ph,sp)

BMAGN(ph,sp;0)

BMAGN
(ph,sp1;sp2;...;0)

Bohr magneton number (dimensionless) of a pure substance or
end-member.

BMAGN
(ph,sp1,sp2,...)

BMAGN
(ph,sp1,sp2,...;0)

BMAGN
(ph,...;sp1,sp2,...;0)

Zero-order Bohr magneton number (dimensionless) to a specified
binary, ternary or higher-order interactions on a certain sublattice
site in a solution phase.

BMAGN
(ph,sp1,sp2,...;i)

BMAGN
(ph,sp1,sp2,...;...;i)

The ith -order Bohr magneton number (dimensionless) to a
specified binary, ternary or higher-order interactions on a certain
sublattice site in a solution phase. 

V0(ph,sp)

V0(ph,sp;0)

V0
(ph,sp1;sp2;...;0)

Molar volume (m3) at 1 bar and reference T0 of a pure substance
or end-member.

V0(ph,sp1,sp2,...)

V0
(ph,sp1,sp2,...;0)

V0
(ph,sp1,sp2,...;...;0)

Zero-order composition-dependent molar volume (m3) of a
specified binary, ternary or higher-order interactions on a certain
sublattice site in a solution phase.

V0(ph,sp1,sp2,...;i)

V0
(ph,sp1,sp2,...;...;i)

The ith-order composition-dependent molar volume (m3) of a
specified binary, ternary or higher-order interactions on a certain
sublattice site in a solution phase. 
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Variables Description and unit

VA(ph,sp)

VA(ph,sp;0)

VA
(ph,sp1;sp2;...;0)

Integrated thermal expansivity (m3/mol/K) of a pure substance or
end-member.

VA(ph,sp1,sp2,...)

VA
(ph,sp1,sp2,...;0)

VA
(ph,sp1,sp2,...;...;0)

Zero-order composition-dependent thermal expansivity
(m3/mol/K) of a specified binary, ternary or higher-order
interactions on a certain sublattice site in a solution phase. 

VA(ph,sp1,sp2,...;i)

VA
(ph,sp1,sp2,...;...;i) 

The ith -order composition-dependent thermal expansivity
(m3/mol/K) of a specified binary, ternary or higher-order
interactions on a certain sublattice site in a solution phase.

VC(ph,sp)

VB(ph,sp;0)

VB
(ph,sp1;sp2;...;0)

Isothermal compressibility (m3/mol/Pa) of a pure substance or
end-member.

VC(ph,sp1,sp2,...)

VB
(ph,sp1,sp2,...;0)

VB
(ph,sp1,sp2,...;...;0)

Zero-order composition-dependent isothermal compressibility
(m3/mol/Pa) of a specified binary, ternary or higher-order
interactions on a certain sublattice site in a solution phase. 

VC(ph,sp1,sp2,...;i)

VB
(ph,sp1,sp2,...;...;i)

The ith -order composition-dependent isothermal compressibility
(m3/mol/Pa) of a specified binary, ternary or higher-order
interactions on a certain sublattice site in a solution phase.

VK(ph,sp)

VB(ph,sp;0)

VB
(ph,sp1;sp2;...;0)

High-pressure fitting parameter (m3/mol) of a pure substance or
end-member.
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Variables Description and unit

VK(ph,sp1,sp2,...)

VB
(ph,sp1,sp2,...;0)

VB
(ph,sp1,sp2,...;...;0)

Zero-order composition-dependent high-pressure fitting
parameter (m3/mol) of a specified binary, ternary or higher-order
interactions on a certain sublattice site in a solution phase.

VK(ph,sp1,sp2,...;i)

VB
(ph,sp1,sp2,...;...;i)

The ith -order composition-dependent high-pressure fitting
parameter (m3/mol) of a specified binary, ternary or higher-order
interactions on a certain sublattice site in a solution phase.

WR(ph,sp)

WR(ph,sp;0)

Standard Born function (J/mol) of a specific aqueous species in the
AQUEOUS solution phase (always with a single sublattice) under
the reference-state temperature and pressure.



Graphical Mode Examples Guide
Thermo-Calc Version 2017a



Thermo-Calc Documentation Set

Graphical Mode Examples Guide ǀ 2 of 39

About the Graphical Mode Examples
Graphical Mode examples are available for Thermo-Calc and the add-on Diffusion Module
(DICTRA) and Precipitation Module (TC-PRISMA). These are in the format of project files
(*.tcu) and are included together in the same folder.

Also search the online help for "Opening Graphical Mode Project Files", which is
in the Thermo-Calc User Guide.

This guide includes the example descriptions and information about how to open a Graphical
Mode project file.

Watch the Video Tutorials
Many of the Graphical Mode examples have video tutorials available either on our website
or on our YouTube channel.

http://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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Opening a Project File
To open an example project file for Thermo-Calc and the add-on Diffusion Module (DICTRA)
and/or Precipitation Module (TC-PRISMA):

1. Open Thermo-Calc.

2. Confirm you are in Graphical Mode. If not, click the Switch to Graphical Mode
button.

3. From the main menu, select File → Open Examples or Help → Open Examples.

4. Navigate to the project file you want and double-click to open.

5. The Graphical Mode examples are stored without calculated results so you will want
to run the example calculation and generate a plot or table. To do this, click the first
node in the tree at the top of the Project window. Then right-click and select
Perform now.

All Graphical Mode examples are in the same folder. This includes add-on
Diffusion Module (DICTRA) and/or Precipitation Module (TC-PRISMA) as well as
the Thermo-Calc examples. However, some add-on module examples require
additional licenses to run for more than two elements.
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Graphical Mode Examples by Category
This guide includes descriptions of these examples:

Category Example number

"Binary System Examples" on the next page 1, 2, 3

"Ternary System and User-Defined Function Examples" on
page 9 4, 7

"Equilibrium Calculator Examples" on page 13 5, 6, 9 (a property grid
calculation)

"Property Model Calculator Examples" on page 17 10, 11, 12

"Scheil Calculator Example" on page 11 8

"Diffusion Calculator Examples" on page 20 19, 20, 21 (the Quick Start
Guide Examples)

"Precipitation Calculator Examples" on page 23 13, 14, 15, 16, 17, 18



Thermo-Calc Documentation Set

Graphical Mode Examples Guide ǀ 5 of 39

Binary System Examples

Ex_01: Calculating a Single-Point Equilibrium

Project File and Video Tutorial Information

l File name: Ex_01_Single-point_equilibrium.tcu

l This example is included in the tutorial on our YouTube channel.

This example shows the result from a single-point equilibrium calculation in the Fe-C system.
It demonstrates the use of the Equilibrium Calculator and generates a Table Renderer in the
Results window. The number of equilibrium conditions is C+2 where C is the number of
components, meaning that four conditions are needed in this example:

l Temperature is 1000 K

l Pressure is 101325 Pa

l System size is 1 mole

l Mass percent carbon is 0.1%

The displayed results of the calculation show that the BCC_A2 (ferrite) and GRAPHITE phases
are stable for this set of equilibrium conditions.

https://youtu.be/3j4xQYdS_TM
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Table Result

Ex_02: Stepping in Temperature in the Fe-C System

Project File and Video Tutorial Information

l File name: Ex_02_Step_in_temperature_in_Fe-C.tcu

l This example is included in the tutorial on our YouTube channel.

This example shows how the fractions of stable phases vary for an Fe-0.1 mass-% C alloy
when the temperature is varied between 500 and 2000 K. It demonstrates the use of the
Equilibrium Calculator. To allow temperature to vary, the corresponding Axis Definition
check box is selected. In this example, results are displayed graphically using a Plot
Renderer activity. If you want, you can use a Table Renderer to generate text results instead.

https://youtu.be/_BlSlWxeF_g
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Plot Result

Ex_03: Fe-C Phase Diagrams

Project File and Video Tutorial Information

l File name: Ex_03_Fe-C_phase_diagram.tcu

l This example is included in the tutorial on our YouTube channel.

This example shows the stable Fe-C phase diagram (stable meaning that the graphite phase
is entered in the calculation). The same diagram is calculated using the Binary Calculator
activity and then using a System Definer and Equilibrium Calculator.

In both cases, a Plot Renderer is used to display results. The purpose of the Binary Calculator
is to simplify common calculations for binary systems. In the Equilibrium Calculator two axes
are defined:Mass percent C and Temperature. An axis variable must also be an equilibrium
condition.

Plot Result

This shows the plot result of the System Definer and Equilibrium Calculator system.

https://youtu.be/dPizjmGPyh4
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Ternary System and User-Defined Function Examples

Ex_04: Fe-Cr-C Ternary Phase Diagram at 1000 K

Project File and Video Tutorial Information

l File name: Ex_04_Fe-Cr-C_ternary_phase_diagram.tcu

l This example is included in the tutorial on our YouTube channel.

This example shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. Similar to
Example 3 (in "Binary System Examples" on page 5), the same diagram is calculated using a
Ternary Calculator and then using a System Definer and Equilibrium Calculator. Two Plot
Renderer activities are added to create two plots.

Plot Result

This plot example shows the result of using the Ternary Calculator activity node.

Try practicing with two features on the Plot Renderer Configuration window. To
toggle between a triangular and a rectangular diagram, click the Show
Triangular button. To toggle the X and Y axis variables, press the Switch Axes
button.

https://youtu.be/sqfhr9sNwfQ
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Ex_07: User-Defined Functions

Project File Information

File name: Ex_07_User_defined_functions.tcu

This example shows how to implement user-defined functions.

A series of equilibria for an Fe-Cr-C alloy are calculated by varying temperature between
500 and 3000 K. In the configuration window of the Equilibrium Calculator under the
Functions tab, two identically meaning functions are defined, fraction solid and f solid, the
values of which are plotted against temperature in two Plot Renderer activities. Functions
can be entered in terms of QuantitiesQ1, Q2, Q3 and so forth, or by using the Thermo-Calc
syntax.

Plot Result

This plot example shows the result of the fraction solid function.
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Scheil Calculator Example

Ex_08: Scheil and Equilibrium Solidification

Project File and Video Tutorial Information

File name: Ex_08_Scheil_and_equilibrium_solidification.tcu.

For other examples of using Scheil, see our YouTube channel:

l Modified Austenitic Stainless Steel 18/8 Scheil Solidification Simulation

l Applications to Welding and Joining with Bonus Scheil Example

This example shows a comparison for an Al-Si alloy solidified under full local equilibrium and
under the Scheil assumptions, i.e. zero diffusion in the solidified material and infinitely fast
diffusion in the liquid. The example uses the Scheil Calculator and adds a Plot and Table
Renderer.

Plot and Table Results

The plot compares the mole fraction of a solid vs temperature. The table provides the data,
which you can export.

https://youtu.be/VRL_SsKLca0
https://youtu.be/Q-527CeTrH0


Thermo-Calc Documentation Set

Graphical Mode Examples Guide ǀ 12 of 39



Thermo-Calc Documentation Set

Graphical Mode Examples Guide ǀ 13 of 39

Equilibrium Calculator Examples
Other examples also use the Equilibrium Calculator. See "Binary System
Examples" on page 5 and "Ternary System and User-Defined Function Examples"
on page 9.

Ex_05: Stable and the Metastable Fe-C Phase Diagrams

Project File Name

File name: Ex_05_Fe-C_stable_and_metastable_phase_diagram.tcu

This example shows how to overlay results from two calculations in the same plot using the
Equilibrium Calculator.

In Equilibrium Calculator 1 the stable phase diagram is calculated and in Equilibrium
Calculator 2 the metastable phase.
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Plot Results

The Plot Renderer activity is first created as a successor to Equilibrium Calculator 1. Then
right-click the Plot Renderer node and select Add predecessor and the results from both
equilibrium calculators are in the same plot. The metastable diagram is obtained by
deselecting the graphite phase in the System Definer under the Phases and phase
constitution tab.

Ex_06: Serially Coupled Equilibrium Calculators

Project File Name

File name: Ex_06_Serial_equilibrium_calculators.tcu

Sometimes there are multiple solutions for a given set of equilibrium conditions. In other
cases the equilibrium calculation does not converge. You can then aid the final calculation
by, in effect, telling the software where it should start the search for the equilibrium.

This example shows how to serially couple two Equilibrium Calculator nodes together for
more complex equilibrium conditions. For each calculation, the output is to a Table
Renderer.

Equilibrium Calculator 1

In the first example, the objective is to calculate the equilibrium at 850°C where the mole
fractions of the FCC A1 and BCC A2 phases are 0.5 each for an Fe-Cr-C steel with 10%
chromium. In Equilibrium Calculator 1 a simple set of equilibrium conditions (temperature,
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pressure, system size and composition) are used to find a carbon content where only the FCC
A1 and BCC A2 phases are stable. The results from this preliminary calculation are displayed
in Table Renderer 1.

Equilibrium Calculator 2

In Equilibrium Calculator 2 the carbon content equilibrium condition is replaced by the
condition that the numbers of moles of the BCC A2 phase should be 0.5. The final result is
displayed in Table Renderer 2. In this case, the final objective is to calculate the solidus
temperature of an Fe-Cr-C steel with 10% Cr and 0.01% C.

Equilibrium Calculator 3

In Equilibrium Calculator 3 the state at 2000 K is calculated and the result is displayed in
Table Renderer 3.

Equilibrium Calculator 4

In Equilibrium Calculator 4 the temperature equilibrium condition is replaced by the
condition Fix phase / liquid / 0.0, meaning that liquid should be stable in an amount of zero
moles, i.e. the solidus temperature. The final result is displayed in Table Renderer 4.

Ex_09: Carbide Driving Force Heat Map

Project File Name

File name: Ex_09_Heat_map_of_carbide_driving_force.tcu

This is an example of using property grid calculations to plot the driving force for a carbide
as a function of two composition variables. With the property grid calculation type, a 2D grid
is generated from the two calculation axes. After the calculation is done, an equilibrium is
calculated in each grid point. A Plot Renderer connected to a property grid calculator plots
the z-axis property for each equilibrium as a function of the two calculation axes. The final
plot can be either a heat map or a contour plot.
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Plot Result
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Property Model Calculator Examples
Experienced users can also create custom property models for use with the
Property Model Calculator. See the "Introduction to the Property Model
Development Framework" on page 2 for details.

Ex_10: Phase Transition

Project File and Video Tutorial Information

l File name: Ex_10_Phase_Transition.tcu

l This example is included in the tutorial on our YouTube channel. Also see the video
introduction to this feature.

The example uses the Property Model Calculator to predict the transition temperature to
the unwanted brittle Sigma phase. The example shows how the temperature is influenced by
changes to a steel alloy’s composition using the uncertainty calculation type and how to
create either a histogram or probability plot.

Ex_11: Coarsening and Interfacial Energy

Project File and Video Tutorial Information

l File name: Ex_11_Coarsening_and_Interfacial_energy.tcu

l This example is included in the tutorial on our YouTube channel. Also see the video
introduction to this feature.

The example uses the Property Model Calculator and both thermodynamic and kinetic
demonstration steel databases. Using a grid calculation type it produces these plots: a heat
map, a contour plot and a cross plot with contour (where both the interfacial energy and
coarsening rate is shown). It also creates a property diagram to show the phase fractions vs
time.

Plot Result Examples

Heat Map

https://youtu.be/l0OW8FNenZ4
https://youtu.be/855VdP1JSS4
https://youtu.be/855VdP1JSS4
https://youtu.be/THAXL_iPrx4
https://youtu.be/855VdP1JSS4
https://youtu.be/855VdP1JSS4
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Property Diagram

Ex_12: Driving Force and Interfacial Energy

Project File and Video Tutorial Information

l File name: Ex_12_Driving_force_and_Interfacial_energy.tcu

l See the video introduction to this feature.

The example uses the Property Model Calculator and a thermodynamic demonstration steel
database. Using a grid calculation type it produces a contour plot comparing the driving

https://youtu.be/855VdP1JSS4
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force and interfacial energy.

Plot Result

A contour plot
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Diffusion Calculator Examples

Examples 19 and 20 are available to all users. The other examples require a
Diffusion Module (DICTRA) license to calculate and plot results.

All examples use demonstration database packages included with your
installation.

Homogenization of a Binary Fe-Ni Alloy
The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in
a planar domain. At this temperature the material is fully austenitic, i.e. the only phase
present is the so-called fcc (face centered cubic) phase. Initially, there is a linear variation in
Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.

This example is available as a video tutorial on our website and YouTube
channel.

Project File Name and availability

File name: Ex_19_Diffusion_Single_Phase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.

Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy
The moving phase example simulates the growth of ferrite (bcc) into austenite (fcc). The
austenite is assumed to be initially homogeneous with the composition Fe - 0.15 mass-% C.
The transformation temperature is 1050 K. The initial thickness of the austenite is 2 mm and
an initially very thin ferrite (1 nm) is also present at the start of the simulation.

http://www.thermocalc.com/training/video-tutorials/
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
https://www.youtube.com/channel/UCLTh3apGItuaVK69mrwcpJg
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Project File Name and availability

File name: Ex_20_Diffusion_Moving_Boundary.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.

Evolution of an Fe-Cr-Ni Diffusion Couple
The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100
hour heat treatment at 1100 °C (1373.15 K). Both end members of the diffusion couple are
duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and
austenite on the right.

With this type of simulation it is assumed that the material is fully equilibrated at each grid
point, i.e. the local phase fractions, phase compositions and so forth are obtained from an
equilibrium calculation with the local overall composition as a condition.

More details about the homogenization model for multiphase simulations can be found in
Larsson and Engström (2006)1 and Larsson and Höglund (2009)2. Experimental data is from
Engström (1995)3.

Project File Name and availability

File name: Ex_21_Diffusion_Multiphase.tcu

This example is part of the Diffusion Module (DICTRA) Quick Start Guide and
uses more than two elements, enabling it to be available to users with a valid
license. A version of the example is also available for Console Mode.

Fe-C Moving Boundary: Austenite to Ferrite
This example simulates the Austenite to Ferrite transformation in a Fe-0.15mass%C steel
during continues cooling. The simulation starts at a temperature where only Austenite is
stable, Ferrite nucleates and grows into during cooling in the two phase region. Plots of the
carbon composition profile and a thermal profile are generated.

1H. Larsson and A. Engström, “A homogenization approach to diffusion simulations applied to α + γ Fe–Cr–Ni diffusion
couples,” Acta Mater., vol. 54, no. 9, pp. 2431–2439, May 2006.
2H. Larsson and L. Höglund, “Multiphase diffusion simulations in 1D using the DICTRA homogenization model,” Calphad
Comput. Coupling Phase Diagrams Thermochem., vol. 33, no. 3, pp. 495–501, 2009.
3"Interdiffusion in multiphase, Fe-Cr-Ni diffusion couples", Scandinavian Journal of Metallurgy, 24(1), 12–20. 
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Project File Name and availability

File name: Ex_22_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu

This example uses more than two elements enabling it to be available to users
with a valid license.
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Precipitation Calculator Examples

Examples 13 and 16 are available to all users. The other examples require a
Precipitation Module (TC-PRISMA) license to calculate and plot results.

All examples use demonstration database packages included with your
installation. You can open the examples from the main menu: File → Open
Examples or Help → Open Examples.

Ex_13:  Isothermal Precipitation of Al3Sc

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase.
The simulation results can be compared with experimental data collected from Marquis
and Seidman1 and Novotny and Ardell2.

This example is available as a video tutorial on our website and YouTube
channel.

Details and Plot Example

System

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Matrix phase FCC_A1

Precipitate phases AL3SC

Conditions

Composition Al-0.18Sc Mole percent

Temperature 350° C

Simulation time 1.0E7 seconds

1E. Marquis, D.. Seidman, Nanoscale structural evolution of Al3Sc precipitates in Al(Sc) alloys, Acta Mater. 49 (2001) 1909–
1919.
2G.M. Novotny, A.J. Ardell, Precipitation of Al3Sc in binary Al–Sc alloys, Mater. Sci. Eng. A Struct. Mater. Prop. Microstruct.
Process. 318 (2001) 144–154.

http://www.thermocalc.com/training/video-tutorials/
https://youtu.be/MQBtESaDRPk
https://youtu.be/MQBtESaDRPk
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Nucleation sites Bulk

Precipitate Phase Data Parameters

Interfacial energy Calculated

Other

Calculation type Isothermal

File name Ex_13_Precipitation_Al-Sc_AL3SC.tcu

Plot Results

Ex_14: Stable and Metastable Carbides - Isothermal

This example simulates the kinetics of precipitation of both stable and
metastable carbides from ferrite phase. It demonstrates that metastable
carbides (cementite, M7C3) may first emerge and then disappear and the stable
phase (M23C6) prevails.
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Details and Plot Example

This example uses the Equilibrium Calculator and a property diagram to determine how the
phases change with temperature. We are interested in the carbide precipitation at 1053K
where only the carbide M23C6 is stable according to the equilibrium calculation. The
Precipitation Calculator is used to do an isothermal calculation of the three phases
(cementite, M23C6 and M7C3) where cementite and M7C3 are metastable phases.

System

Database package Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements Fe, C, Cr

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Conditions

Composition Fe-0.1C-12Cr Mass percent

Temperature 1053 K

Simulation time 400 000 seconds

Nucleation sites Grain boundaries

Matrix Phase Data Parameters

Grain radius 1.0E-4 m

Precipitate Phase Data Parameters

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 J/m2

Other

Calculation type Isothermal

File name Ex_14_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6
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Plot Results

Ex_15: Stable and Metastable Carbides - TTT Diagram

In this example, the kinetics of precipitation of both stable and metastable
carbides is calculated from the ferrite phase. It demonstrates that metastable
carbides may first emerge and then disappear and the stable phase prevails.

Details and Plot Example

This example uses the Equilibrium Calculator and a property diagram to determine how the
phases change with temperature. Using this result, the Precipitation Calculator is used to do
a TTT (Time-Temperature-Transformation) diagram calculation of the three phases
(cementite, M23C6 and M7C3) at the grain boundaries.

System

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)
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Elements Fe, C, Cr

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Conditions

Composition Fe-0.1C-12Cr Mass percent

Temperature 500° to 800° C with 25°C steps

Max. simulation time 1.0E8 seconds

Nucleation sites Grain boundaries

Matrix Phase Data Parameters

Grain radius 1.0E-4 m

Precipitate Phase Data Parameters

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 J/m2

Other

Calculation type TTT diagram

Stop criterium Volume fraction of phase is set to 0.0001

File name Ex_15_Precipitation_Fe-C-Cr_TTT_Cementite-M7C3-M23C6
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Plot Results

Ex_16: Precipitation of Iron Carbon Cementite

Simulate the kinetics of precipitation of carbides from a BCC Fe solution phase. This example
is based on Wert (1949)1.

Details and Plot Example

This example uses two Experimental File Reader activities with the Precipitation Calculator
and an isothermal calculation, to plot the volume fraction of the cementite phase.

System

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

1Wert, C. A. (1949). Precipitation from Solid Solutions of C and N in α-Iron. Journal of Applied Physics, 20(10), 943.
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Elements Fe, C

Matrix phase BCC_A2

Precipitate phase Cementite

Conditions

Composition Fe-0.016C mass percent

Temperature 102° C

Simulation time 600 000 seconds

Nucleation sites Dislocations

Matrix Phase Data Parameters

Grain aspect ratio 1.0

Precipitate Phase Parameters

Interfacial energy 0.24 J/m2

Dislocation density 1.5e11m-3

Other

Calculation type Isothermal

Growth rate model Advanced (on the Options tab)

File name Ex_16_Precipitation_Fe-C_Cemetite
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Volume Fraction

Ex_17: Precipitation of γ’ in Ni Superalloys - Isothermal

This example simulates the kinetics of precipitation of γ’ phase from γ phase.
The simulation results can be compared with experimental data collected from
Sudbrack et al.1.

Details and Plot Examples

This example uses three Experimental File Reader activities with the Precipitation
Calculator. It does an isothermal calculation to plot the volume fraction, mean radius and
number density of the cementite phase.

1C.K. Sudbrack, T.D. Ziebell, R.D. Noebe, D.N. Seidman, Effects of a tungsten addition on the morphological evolution, spa-
tial correlations and temporal evolution of a model Ni–Al–Cr superalloy, Acta Mater. 56 (2008) 448–463.
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DIS_FCC_A1 needs to be selected on the System Definer. Search the online help
for About Ordered Phases in the Precipitation Module (TC-PRISMA) User Guide
for details.

System

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al Cr

Matrix phase DIS-FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Conditions

Composition Ni-9.8Al-8.3Cr Mole percent

Temperature 800° C

Simulation time 1 000 000 seconds

Nucleation sites Bulk

Precipitate Phase Data Parameters

Interfacial energy 0.012 J/m2

Other

Calculation type Isothermal

File name Ex_17_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime
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Volume Fraction
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Number Density
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Mean Radius

Ex_18: Precipitation of γ’ in Ni Superalloys - Non-isothermal

This example simulates the kinetics of precipitation of γ’ phase from γ phase in
Ni-8Al-8Cr and Ni-10Al-10Cr at.% alloys during continuous cooling. The
simulation results can be compared with experimental results from
Rojhirunsakool et al.1 .

Details and Plot Examples

In these examples the Separate multimodal PSD check box is selected on the Plot Render to
plot the mean radius and size distributions of the two compositions.

Plotting the size distribution from the final simulation time of 1470 seconds, you can see
there are several peaks, although these are not completely separated. Use the 'Separate

1T. Rojhirunsakool, S. Meher, J.Y. Hwang, S. Nag, J. Tiley, R. Banerjee, Influence of composition on monomodal versus mul-
timodal γ′ precipitation in Ni–Al–Cr alloys, J. Mater. Sci. 48 (2013) 825–831.
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multimodal PSD' check box on the Plot Renderer to separate the peaks. Then adjust the
Valley depth ratio setting to 0.05 to separate into two peaks as shown in the Ni-10Al-10Cr
plot example. You can experiment with this setting to see how the size distribution evolves
with time, for example, try entering several values as plot times '400 600 1470'.

DIS_FCC_A1 needs to be selected on the System Definer. Search the online help
for About Ordered Phases in the Precipitation Module (TC-PRISMA) User Guide
for details.

System

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Matrix phase DIS_FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Conditions

Composition (Ni-8Al-8Cr) Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr) Ni-10Al-10Cr Mole percent

Temperature 0.23 K/s cooling rate

Simulation time 1470 s (Ni-8Al-8Cr), 3300 s (Ni-10Al-10Cr)

Nucleation sites Bulk

Matrix Phase Data Parameters

Mobility enhancement prefactor 5.0

Precipitate Phase Data Parameters

Interfacial energy 0.023 J/m2

Other

Calculation type Non-isothermal

Separate multimodal PSD for 8Al-8Cr
On the Plot Renderer, the Valley depth ratio is set to 0.05 for both
plots. The number of points is increased to 200 for an average
radius plot.

Separate multimodal PSD for 10Al-
10Cr

On the Plot Renderer, the Valley depth ratio is set to 0.18 for both
plots.

File name Ex_18_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_
prime



Thermo-Calc Documentation Set

Graphical Mode Examples Guide ǀ 36 of 39

Mean Radius Ni-8Al-8Cr
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Mean Radius Ni-10Al-10CR
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Size Distribution (PSD) Ni-8Al-8Cr
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Size Distribution (PSD) Ni-10Al-10Cr



Thermo-Calc Console Mode Examples
Guide
Thermo-Calc Version 2017a



Thermo-Calc Documentation Set

Thermo-Calc Console Mode Examples Guide ǀ 2 of 39

About the Thermo-Calc Console Mode Examples
"About the Graphical Mode Examples" on page 2

There are many examples to examine and to help you learn Thermo-Calc in Console Mode.

Opening the Macro File

To open an example macro file for Thermo-Calc:

1. Open Thermo-Calc.

2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.

3. From the main menu, select File → Open Examples or Help → Open Examples. The
Console Mode folder opens with the Thermo-Calc examples in separate folders.

For the Diffusion Module (DICTRA) examples (*.DCM macro files), click the Up

One Level button and then double click the DICTRA folder.

4. In the folder, double-click the *.TCM file or click Open.

5. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the
macro and produce a plot in the Console Results window.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

Each topic below has a brief description of the example and includes some or all of the
commands used in the macros. As you progress through the examples, sometimes only new
commands are highlighted.
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Topic TCEX Examples included

"Examples of Binary Systems" on the next page 1, 4, 10, 11, 13, 16, 18, 26, 34,
51

"Examples Using Functions and Variables" on page 19 2, 44

"Examples of the Gibbs Energy System (GES) Module"
on page 22 31, 38, 39, 49, 52

"Examples of Multicomponent Systems" on page 17 6, 7, 47

"Example using the PARROT and EDIT_EXPERIMENT
Modules" on page 27 36a

"Pourbaix Module Examples" on page 33 40, 53

"Examples of Property and Potential Diagrams" on
page 16 8, 35,

"Examples of Scheil-Gulliver Calculations" on page 25 15, 30a, 30b, 31, 48

"Examples with Specialized Databases" on page 31 20, 22, 25, 27, 29, 50,

"General Examples Using the Steel Database" on
page 13 9, 23, 28, 32, 37, 41

"Example of the Tabulate Reaction (TAB) Module" on
page 29 12, 24

"Examples of Ternary Systems" on page 9 3, 5, 14, 17, 19a, 19b, 21, 33,
42, 43, 45, 46,
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Examples of Binary Systems
The commands are described in the Thermo-Calc Console Mode Command Reference. All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex01 - Calculating the binary Fe-C phase diagram

This example calculates the binary Fe-C phase diagram using the BINARY module.

These commands are used:

"BINARY_DIAGRAM
Module" on page 10

"LIST_EQUILIBRIUM" on
page 209 "LIST_STATUS" on page 210

"INFORMATION" on page 5 "LIST_CONDITIONS" on
page 209

"CHANGE_STATUS" on
page 186

"COMPUTE_EQUILIBRIUM"
on page 190

"SET_DIAGRAM_AXIS"
on page 259

"SET_TIELINE_STATUS" on
page 269

"PLOT_DIAGRAM" on
page 253

"SET_SCALING_STATUS"
on page 268

"SET_LABEL_CURVE_
OPTION" on page 263

"ADD_LABEL_TEXT" on
page 243

"MODIFY_LABEL_TEXT"
on page 252 "HELP" on page 5

tcex04 - The Fe-Cr miscibility gap

This example calculates the miscibility gap in the Fe-Cr system.

These commands are used:

"SWITCH_DATABASE"
on page 22 "DEFINE_SYSTEM" on page 15 "REJECT" on page 18

"GET_DATA" on "AMEND_PHASE_ "LIST_STATUS" on page 210



Thermo-Calc Documentation Set

Thermo-Calc Console Mode Examples Guide ǀ 5 of 39

page 16 DESCRIPTION" on page 93

"LIST_EQUILIBRIUM" on
page 209

"SET_CONDITION" on
page 220

"COMPUTE_EQUILIBRIUM"
on page 190

"SET_AXIS_VARIABLE"
on page 218

"SAVE_WORKSPACES " on
page 54

"SET_TIELINE_STATUS" on
page 269

tcex10 - How to avoid Cr2O3 clogging in a continuous casting process

The example calculates an equilibrium with suspended or dormant phases and shows how to
avoid Cr2O3 clogging in a continuous casting process.

This uses the SLAG database. A license is required to run the example.

The origin of this example is that a manufacturer wanted to increase the Cr content of a
material from 18 to 25 weight percent but the continuous casting of this material was
problematic because solid Cr2O3 was formed. Using Thermo-Calc to calculate the equilibria
in the steel/slag system, a simple correction was found: modify the Mn or Si content to
decrease the oxygen potential.

In Thermo-Calc, you can FIX a phase with zero amount to simulate how to avoid forming this
phase. You then release one of the conditions, usually one of the compositions, and this
composition is determined by the equilibrium calculation.

These commands are used:

"DEFINE_SYSTEM" on
page 15

"AMEND_PHASE_
DESCRIPTION" on page 93 "GET_DATA" on page 16

"SET_CONDITION" on
page 220

"LIST_CONDITIONS" on
page 209 "LIST_STATUS" on page 210

"CHANGE_STATUS" on
page 186

"COMPUTE_EQUILIBRIUM" on
page 190

"SET_NUMERICAL_LIMITS"
on page 296

"LIST_EQUILIBRIUM"
on page 209

"SET_REFERENCE_STATE" on
page 224

"SHOW_VALUE" on
page 227

tcex11 - Oxidation of Cu2S with H2O/O2 gas mixture

This example demonstrates the oxidation of Cu2S with H2O/O2 gas mixture. Thermo-Calc is
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used to find the optimum O/H ratio (i.e. oxygen potential) as certain oxygen potential values
can desulphurize Cu2S without forming copper oxides.

In Thermo-Calc, the problem reduces to perform equilibria calculations in a Cu-S-H-O
system. The amounts of the components should be kept to correct ratio corresponding to
Cu2S and H2O using a command SET_INPUT_AMOUNTS in POLY3. Initially, O/H = 0.5 is
given. Optimum O/H ratio is calculated with the desired calculation conditions. For example,
to simulate one phase disappearing, you can FIX the phase with zero amount.

These commands are of also of note and used in this example:

l "SET_NUMERICAL_LIMITS" on page 296

l "SET_REFERENCE_STATE" on page 224

l "SHOW_VALUE" on page 227
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tcex13 - The binary Al-Ti phase diagram and its G curve

This example calculates an Al-Ti binary phase diagram and G curve using the BINARY
module.

These commands are of note and used in this example:

l "BINARY_DIAGRAM Module" on page 10

l "SET_ALL_START_VALUES" on page 217

tcex16 - Second order transition of the Al-Fe system

This example calculates the second order transition line in the Bcc field of the Al-Fe system.

This uses the SSOL database. A license is required to run the example.

These commands are of note and used in this example:

"REJECT" on page 18 "RESTORE" on page 20 "ADVANCED_OPTIONS"
on page 174

"SET_SCALING_STATUS"
on page 268

"MAKE_EXPERIMENTAL_
DATAFILE" on page 252

"DEFINE_SYSTEM" on
page 15

"LIST_EQUILIBRIUM" on
page 209

"APPEND_EXPERIMENTAL_
DATA" on page 245

"STEP_WITH_OPTIONS"
on page 227

tcex18 - A3 temperature of a steel

This example calculates the A3 temperature of a steel and examines the influence of each
alloying element on this temperature.

A3 temperature is the temperature where ferrite starts to form from austenite. You can
easily read A3 from an Fe-C phase diagram. However, for complex multicomponent steels
no simple diagram can be used. Using POLY, it is easy to find out the influence of each
alloying element on the A3 temperature. This information is useful if you want to modify the
compositions of a steel but keep A3 unchanged.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:
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"DEFINE_ELEMENTS"
on page 14

"AMEND_PHASE_
DESCRIPTION" on page 93

"COMPUTE_TRANSITION"
on page 193

"DEFINE_MATERIAL"
on page 200

"ENTER_SYMBOL" on
page 247

"SHOW_VALUE" on
page 227

tcex26 - The As-Ga phase diagram: Plotting the partial pressures of a gas species

This is an example of plotting the partial pressures of a gas species along the solubility lines
in the As-Ga phase diagram. The calculation makes it possible to monitor the input gases to
a process of depositing solid As-Ga.

These commands are of note and used in this example:

"REJECT" on page 18 "RESTORE" on page 20 "SET_DIAGRAM_AXIS" on
page 259

"SET_SCALING_STATUS"
on page 268

"SET_AXIS_TEXT_STATUS"
on page 256

"SET_LABEL_CURVE_
OPTION" on page 263

tcex34 - The Al-Zn phase diagram and its G curve

This example uses the BINARY module to calculate the phase diagram and G curves in the
Al-Zn system.

tcex51 - Calculation of molar volume, thermal expansivity and density

This example uses the POLY3 module to calculate the molar volume, thermal expansivity
and density of the FCC_A1, BCC_A2 LIQUID and liquid phases of C-Fe.

This uses the TCFE database. A license is required to run the example.
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Examples of Ternary Systems
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex03 - Calculating an isothermal section with the TERNARY module

This example calculates an isothermal section using the TERNARY module.

These commands are used:

"TERNARY_DIAGRAM
Module" on page 331

"AMEND_PHASE_
DESCRIPTION" on page 93

"ADD_LABEL_TEXT" on
page 243

"PLOT_DIAGRAM" on
page 253

"SET_DIAGRAM_AXIS" on
page 259

"SET_DIAGRAM_TYPE"
on page 261

"SET_AXIS_TYPE" on
page 257

"SET_REFERENCE_STATE" on
page 224

"CHANGE_STATUS" on
page 186

"SET_SCALING_STATUS" on
page 268

tcex05 - Calculating a vertical section in the Al-Cu-Si system

This example calculates a vertical section in the Al-Cu-Si system as well as a vertical section
from Al to 30% Mg2Si.

In addition to various commands used in the previous examples, the "LIST_AXIS_VARIABLE"
on page 208 command is used.

tcex14 - Variations in solidification of an Al-Mg-Si alloy

This example calculates the heat and heat capacity variations during solidification of an Al-
Mg-Si alloy.

These commands are of note and used in this example:
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l "LIST_SYSTEM" on page 17

l "LIST_CONDITIONS" on page 209

l "SET_AXIS_TEXT_STATUS" on page 256

tcex17 - The pseudo-binary system - CaO-SiO2

This example calculates the pseudo-binary system CaO-SiO2 using the Oxide Demo
database.

The oxide demo (Oxdemo) database can be used both for pseudobinary systems like the one
in this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O.

These commands are of note and used in this example:

"LIST_SYSTEM" on page 17 "REJECT" on page 18 "RESTORE" on page 20

"AMEND_PHASE_
DESCRIPTION" on page 93

"LIST_STATUS" on
page 210

"DEFINE_COMPONENTS"
on page 196

"SET_CONDITION" on
page 220

"COMPUTE_
EQUILIBRIUM" on
page 190

"LIST_EQUILIBRIUM" on
page 209

tcex19a and tcex19b - Mapping of univariant equilibria with the liquid in Al-Cu-Si

This example shows how to map univariant equilibria with the liquid in Al-Cu-Si.

l Part A. Step-by-step calculation using POLY.

l Part B. Using the TERNARY module, you can get the information on invariant
reactions, such as temperature and compositions.

These commands are of note and used in these examples:

"DEFINE_SYSTEM" on
page 15 "GET_DATA" on page 16 "AMEND_PHASE_

DESCRIPTION" on page 93

"SET_CONDITION" on
page 220

"LIST_CONDITIONS" on
page 209

"ADVANCED_OPTIONS" on
page 174
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"SAVE_WORKSPACES " on
page 54

"READ_WORKSPACES" on
page 214

"MAKE_EXPERIMENTAL_
DATAFILE" on page 252

"APPEND_EXPERIMENTAL_
DATA" on page 245

"TERNARY_DIAGRAM
Module" on page 331

tcex21 - Calculating a ternary isotherm in Fe-Cr-Ni

This example calculates a ternary isotherm in Fe-Cr-Ni with a user-defined database.

These commands are of note and used in this example:

l "DEFINE_SYSTEM" on page 15

l "GET_DATA" on page 16

l "SET_CONDITION" on page 220

l "SET_DIAGRAM_TYPE" on page 261

tcex33 - An Fe-Cr-C isopleth

This example is a benchmark calculation of an isopleth in the Fe-Cr-C system.

tcex42 - Paraequilibrium calculation - Formation of Para-pearlite - Isopleth

This example uses an Fe-Mn-C system at 2.5%Mn Mass u-fraction to show a paraequilibrium
calculation where there is formation of para-pearlite. It is an isopleth calculation and shows
the STEP_WITH_OPTIONS command using the PARAEQUILIBRIUM option.

"About Paraequilibrium" on page 191 in the Thermo-Calc User Guide.

This uses the TCFE database. A license is required to run the example.

tcex43 - Paraequilibrium calculation - Formation of Para-pearlite - Isothermal

This example uses an Fe-Mn-C system at 700 C to show a paraequilibrium calculation where
there is formation of para-pearlite. It is an isothermal calculation and shows the STEP_
WITH_OPTIONS command using the PARAEQUILIBRIUM option.

"About Paraequilibrium" on page 191 in the Thermo-Calc User Guide.
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This uses the TCFE database. A license is required to run the example.

tcex45 - 3D-plot with the gamma volume in the Fe-Cr-C system

This example calculates the gamma volume in the Fe-Cr-C system and plots it in 3D.

To view the generated file, tcex45.wrl, install a WRML (Wirtual Reality
Modelling Language) viewer to the web browser. WRML viewers can be
downloaded from various sites, e.g. www.parallelgraphics.com or www.sim.no.

The "ADVANCED_OPTIONS" on page 174 (present phase option) command is of note and
used in this example.

tcex46 - 3D-plot with the liquidus surface of the Fe-Cr-C system

This example calculates the liquidus surface of the Fe-Cr-C system and plots it in 3D.

The "ADVANCED_OPTIONS" on page 174 (present phase option) command is of note and
used in this example.

To view the generated file, tcex46_tri.wrl and tcex46_sqrt, install a WRML
(Wirtual Reality Modelling Language) viewer to the web browser. WRML
viewers can be downloaded from various sites, e.g. www.parallelgraphics.com
or www.sim.no.

This uses the TCFE database. A license is required to run the example.

http://www.parallelgraphics.com/
http://www.sim.no/
http://www.parallelgraphics.com/
http://www.sim.no/
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General Examples Using the Steel Database
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.
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tcex09 - Calculating a dew point with the POLY3 module

This is an example calculating the dew point in the POLY3 module.

The "STEP_WITH_OPTIONS" on page 227 and "MAP" on page 212 commands are of note and
used in this example.

tcex23 - Calculating a paraequilibrium and the T0 temperature in a low alloyed steel

This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.

This uses the TCFE database. A license is required to run the example.

tcex28 - Pitting Resistance Equivalence (PRE) for a duplex stainless steel

This example calculates the Pitting Resistance Equivalence (PRE) for a duplex stainless steel.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

"REJECT" on page 18 "RESTORE" on page 20 "DEFINE_ELEMENTS" on
page 14

"AMEND_PHASE_
DESCRIPTION" on page 93

"EVALUATE_
FUNCTIONS" on
page 208

"SET_START_
CONSTITUTION" on
page 226

"COMPUTE_TRANSITION" on
page 193

tcex32 - Calculating oxide layers on steel

This example calculates oxide layers on a steel and shows how to append databases.

This uses the TCFE and SSUB5 databases. These licenses are required to run the
example.

These commands are of note and used in this example:

l "SET_START_CONSTITUTION" on page 226

l "SET_REFERENCE_STATE" on page 224
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l "APPEND_DATABASE" on page 12

tcex37 - Calculating an isothermal section in Console Mode

This example shows how the command lines to enter to calculate an isothermal section
using Console Mode and the POLY3 module.

tcex41 - Calculating a solubility product

Calculation of a solubility product. Shows the STEP_WITH_OPTIONS command using the T-
ZERO option.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

l "DEFINE_ELEMENTS" on page 14

l "REINITIATE_PLOT_SETTINGS" on page 255

l "SET_DIAGRAM_AXIS" on page 259
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Examples of Property and Potential Diagrams
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

Property Diagrams

tcex08 - Property diagrams for a high speed steel

This example shows how to calculate property diagrams for a high speed steel i.e. phase
fraction plots, activity vs temperature, and so forth.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

l "DEFINE_DIAGRAM" on page 196

l "DEFINE_ELEMENTS" on page 14

l "AMEND_PHASE_DESCRIPTION" on page 93

l "REINITIATE_PLOT_SETTINGS" on page 255

Potential Diagram

tcex35 - Calculating a potential diagram

"About Potential Diagrams" on page 195 in the Thermo-Calc User Guide.

This example uses the POTENTIAL module to calculate a potential diagram. Note that there
are no commands for this module, you just follow the prompts.
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Examples of Multicomponent Systems
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex06 - An isopleth in low alloyed Fe-Mn-Si-Cr-Ni-C steel

This example calculates a multicomponent phase diagram using the DEFINE_MATERIAL
command in POLY and the TCFE steel database. The material contains 1.5 %Cr + 0.4 %Mn +
3.5 %Ni + 0.3 %Si and 1 %C (by weight). These conditions and the temperature are set by the
DEFINE_MATERIAL command.

After the first equilibrium results, a phase diagram is calculated with one axis variable as
temperature and the other as the carbon content.

This uses the TCFE database. A license is required to run the example.

tcex07 - Single equilibria in low alloyed Fe-Mn-Si-Cr-Ni-C steel

This example shows how to calculate a single equilibria in a low alloyed Fe-Mn-Si-Cr-Ni-C
steel. There are two general ways to perform a single equilibrium calculation:

l Get data from a database, then in POLY use SET_CONDITION and COMPUTE_
EQUILIBRIUM.

l Go directly to POLY and use DEFINE_MATERIAL.

The COMPUTE_TRANSITION command is also used to determine the temperature or
composition where one phase forms or disappears. It is the same as the CHANGE_STATUS →
SET_CONDITION→ COMPUTE_EQUILIBRIUM sequence of commands.

A "STEP_WITH_OPTIONS" on page 227 command using the option normal is also used in
addition to the other commands that should be becoming more familiar as you work through
the examples.

This uses the TCFE database. A license is required to run the example.

tcex47 - 3D-quaternary plot with the gamma volume in the Fe-Cr-V-C system at 1373K

3D-quaternary diagram that calculates the gamma volume in the Fe-Cr-V-C system at
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1373K.

To view the generated file, tcex47.wrl, install a WRML (Wirtual Reality
Modelling Language) viewer to the web browser. WRML viewers can be
downloaded from various sites, e.g. www.parallelgraphics.com or www.sim.no.

http://www.parallelgraphics.com/
http://www.sim.no/
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Examples Using Functions and Variables
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.
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tcex02 - Plotting thermodynamic functions

This example shows how to plot thermodynamic functions in unary, binary and ternary
systems. It also involves working with partial derivatives and partial quantities.

This uses the SSOL database. A license is required to run the example.

These commands are used:

"GOTO_MODULE" on
page 4 "GET_DATA" on page 16 "SET_CONDITION" on

page 220

"SWITCH_DATABASE"
on page 22

"AMEND_PHASE_
DESCRIPTION" on page 93

"LIST_EQUILIBRIUM" on
page 209

"DEFINE_SYSTEM" on
page 15

"COMPUTE_EQUILIBRIUM"
on page 190

"SET_AXIS_VARIABLE" on
page 218

"SAVE_WORKSPACES "
on page 54

"STEP_WITH_OPTIONS" on
page 227

"SET_DIAGRAM_AXIS" on
page 259

"ENTER_SYMBOL" on
page 247

"PLOT_DIAGRAM" on
page 253

"SET_LABEL_CURVE_
OPTION" on page 263

"REJECT" on page 18 "RESTORE" on page 20 "LIST_SYSTEM" on page 17

"LIST_STATUS" on
page 210

"CHANGE_STATUS" on
page 186 "SHOW_VALUE" on page 227

"SET_INTERACTIVE" on
page 295

tcex44 - Exploring variables and functions

This example uses variables and functions to predict properties e.g. proof strength for an
austenitic stainless steel at elevated temperatures (20-550C). The example was created
using an expression from Eliasson, J., & Sandström, R. (2000). Proof strength values for
austenitic stainless steels at elevated temperatures. Steel Research, 71(6–7), 249–254.
https://doi.org/10.1002/srin.200001224.1

1
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This uses the TCFE database. A license is required to run the example.
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Examples of the Gibbs Energy System (GES) Module
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex31 - Using the GES module to calculate CVM

Using the Gibbs energy system (GES) module, this example calculates the CVM and
compares it with the sublattices of a fictitious A B system. You also learn how to overlay
diagrams from two calculations.

These GES commands are of note and used in this example:

l "ENTER_ELEMENT" on page 101

l "ENTER_SPECIES" on page 112

l "ENTER_SYMBOL" on page 113

l "ENTER_PHASE" on page 110

l "ENTER_PARAMETER" on page 143

l "LIST_PHASE_DATA (from GIBBS)" on page 148

tcex38 - Calculating the Morral “rose”

This example uses the Gibbs energy system (GES) module to calculate the Morral rose,
which are miscibility gaps.

These commands are of note and used in this example:

l "REINITIATE" on page 127

l "ENTER_ELEMENT" on page 101

l "AMEND_ELEMENT_DATA" on page 81

l "ENTER_PARAMETER" on page 143

l "ENTER_PHASE" on page 110

tcex39 - Calculating reversible Carnot cycles of a heat engine

This example shows how to calculate the reversible Carnot cycle of a heat engine using one
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mole of an ideal gas with two fictitious species A and A2. The GES, POLY3 and POST modules
are used.

One application of the Second Law is to the efficiencies of heat engines, pumps and
refrigerators. Whenever there is a difference of temperature, work can be produced - the
principle of heat engines. The Gibbs energy also enables the prediction of the maximum
work that a process may achieve. The goal of this example is to help relate the results to
different thermodynamic quantities. 

These commands are of note and used in this example:

"REINITIATE" on page 127 "ENTER_SPECIES" on
page 112

"ENTER_PHASE" on
page 110

"ENTER_PARAMETER" on
page 143

"SET_PLOT_FORMAT" on
page 264

tcex49 - Quasichemical model using the Gibbs energy system (GES) module

This example shows how to enter parameters for a FACT quasichemical liquid model and
how to calculate the sulfur activity using the GIBBS_ENERGY_SYSTEM (GES) module
commands.

"Solution Models in the GIBBS Module" on page 85

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

"ENTER_ELEMENT" on
page 101

"AMEND_ELEMENT_DATA"
on page 81

"ENTER_SPECIES" on
page 112

"ENTER_SYMBOL" on
page 113

"ENTER_PARAMETER" on
page 143

"SET_REFERENCE_STATE" on
page 224

"SHOW_VALUE" on
page 227

tcex52 - Changing the excess models for interaction parameters in a solution phase

"Solution Models in the GIBBS Module" on page 85
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This example shows how to change the excess models for binary and ternary interactions in
a solution phase, either

l through direct interactive amendments of phase descriptions within the GIBBS_
ENERGY_SYSTEM (GES) module, or

l enforced by specific type-definitions given in a database file retrieved by the
DATABASE_RETRIEVAL module (also called the TDB module).

For binary excess models, the example changes it from the default R-K model to a Mixed-
Excess-Model. The phase has to be a substitutional phase in this case.

For ternary extrapolation models, the example changes it from the default R-K-M model to a
Toop_Kohler model.
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Examples of Scheil-Gulliver Calculations
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex15 - Simulating the solidification of a Cr-Ni alloy with the SCHEIL module

This is an example of a solidification simulation of a Cr-Ni alloy. There is no back diffusion in
the solid, i.e. Scheil-Gulliver model is used.

This uses the TCFE database. A license is required to run the example.

These commands are of note and used in this example:

"START_WIZARD" on page 297
"COMPUTE_
TRANSITION" on
page 193

"ADD_INITIAL_
EQUILIBRIUM" on
page 166

"ENTER_SYMBOL" on
page 247

"ADVANCED_OPTIONS"
on page 174

"STEP_WITH_OPTIONS" on
page 227

"MAKE_EXPERIMENTAL_
DATAFILE" on page 252

"CHANGE_STATUS" on
page 186

tcex30a and 30b - Scheil calculation for an Al-4Mg-2Si-2Cu alloy

"About Equilibrium Calculations" on page 169 and "About Scheil Simulations" on
page 182 in the Thermo-Calc User Guide.

These examples show two ways to do a Scheil calculation for an Al-4Mg-2Si-2Cu alloy. In
part A, you use the POLY3 module and the STEP_WITH_OPTIONS command with an
EVALUATE option. Then in part B you use the SCHEIL module commands to do the same
thing.

tcex31 - Using the GES module to calculate CVM

Using the Gibbs energy system (GES) module, this example calculates the CVM and
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compares it with the sublattices of a fictitious A B system. You also learn how to overlay
diagrams from two calculations.

These GES commands are of note and used in this example:

l "ENTER_ELEMENT" on page 101

l "ENTER_SPECIES" on page 112

l "ENTER_SYMBOL" on page 113

l "ENTER_PHASE" on page 110

l "ENTER_PARAMETER" on page 143

l "LIST_PHASE_DATA (from GIBBS)" on page 148

tcex48 - SCHEIL solidification with C back diffusion

This is an example of Scheil solidification with C back diffusion in solid phases. The results
are compared between a simple Scheil and equilibrium calculations. See "SCHEIL Module"
on page 293 for a list of the commands for this module.
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Example using the PARROT and EDIT_EXPERIMENT
Modules
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex36a - Using the PARROT and EDIT EXPERIMENTS modules

The example is divided into parts corresponding to the files in the tcex36a
folder. It is recommended you read tcex.36.readme before continuing with this
advanced exercise.

Also see the Data Optimization User Guide.

Each problem has "selected" experimental data. The example uses a fictitious binary A-B
system where element A is BCC until it melts. Element B is BCC up to 1100 K and FCC above.
There is a compound A2B stable in a limited temperature range.

l The creation of the "setup" file is described (tcex36a.TCM) where you enter the
elements and phases into the Gibbs Energy System (GES) module

l The creation of the experimental data file is described (tcex 36b.TCM). When you run
the TCEX36a macro, the contents of this macro file is automatically launched and the
experimental data file created.

l The actual run in the PARROT module in order to obtain the result (tcex 36cpd.TCM)

There are many commands used in this advanced example ( listed in alphabetical order):

"ADVANCED_OPTIONS" on
page 174

"AMEND_ELEMENT_
DATA" on page 81

"AMEND_PHASE_
DESCRIPTION" on page 93

"APPEND_EXPERIMENTAL_
DATA" on page 245

"COMPILE_
EXPERIMENTS" on
page 137

"COMPUTE_ALL_
EQUILIBRIA" on page 37



Thermo-Calc Documentation Set

Thermo-Calc Console Mode Examples Guide ǀ 28 of 39

"CONTINUE_
OPTIMIZATION" on
page 138

"CREATE_NEW_
EQUILIBRIUM" on
page 195

"CREATE_NEW_STORE_
FILE" on page 139

"DEFINE_COMPONENTS"
on page 196

"EDIT_EXPERIMENTS" on
page 139

"ENTER_PARAMETER" on
page 143

"ENTER_PHASE" on
page 110 "LABEL_DATA" on page 48 "LIST_ALL_VARIABLES" on

page 145

"LIST_PHASE_DATA" on
page 122

"LIST_RESULT" on
page 149

"MACRO_FILE_OPEN" on
page 5

"OPTIMIZE_VARIABLES" on
page 154

"QUICK_EXPERIMENTAL_
PLOT" on page 254

"READ_WORKSPACES" on
page 214

"RESCALE_VARIABLES" on
page 156

"SAVE_PARROT_
WORKSPACES" on
page 156

"SAVE_WORKSPACES " on
page 54

"SELECT_EQUILIBRIUM" on
page 216

"SET_ALL_START_
VALUES" on page 217

"SET_ALTERNATE_
CONDITION" on page 57

"SET_ALTERNATE_MODE"
on page 156

"SET_FIX_VARIABLE" on
page 158

"SET_OPTIMIZING_
VARIABLE" on page 159

"SET_STORE_FILE" on
page 162

"SET_WEIGHT" on
page 66
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Example of the Tabulate Reaction (TAB) Module
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex12 - Tabulation of thermodynamic data for reactions

This example shows a number of independent cases using the TABULATE_REACTION (TAB)
module to tabulate thermodynamic data for reactions.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

"TABULATE_REACTION" on
page 320

"DEFINE_SPECIES" on
page 14

"ENTER_FUNCTION" on
page 307

"QUICK_EXPERIMENTAL_PLOT"
on page 254

"SET_SCALING_STATUS"
on page 268

"LIST_SUBSTANCES" on
page 310

"TABULATE_SUBSTANCE" on
page 322

tcex24 - Simulation of the silicon arc furnace using the REACTOR module

This is a simple reactor model with output of gases at the top and output of condensed
phases at the bottom. The gas phase from one segment flows to higher segments, 80 %
reacts in the first above, 15% in the second above and 5 % in the third above.

The condensed phases flow downwards and all of it goes to the next lowest segment. Heat
can be added at any module. The only way to specify the initial state of the reactants added
to the reactor is to specify their heat content.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:
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"DEFINE_SPECIES" on
page 14

"CREATE_STAGE_BOXES" on
page 286

"CREATE_DIVIDERS" on
page 285

"CREATE_PIPES" on
page 285

"START_SIMULATION" on
page 290
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Examples with Specialized Databases
The commands are described in the Thermo-Calc Console Mode Command Reference . All
the links are to that guide (unless indicated otherwise), which is part of this documentation
set. Or use the online help to navigate more easily.

All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex20 - Adiabatic decompression in a geological system

This example calculates the adiabatic decompression in a geological system using the
geochemical database (PGEO.TDB).

These commands are of note and used in this example:

"DEFINE_SYSTEM" on
page 15

"DEFINE_COMPONENTS" on
page 196

"SET_INPUT_AMOUNTS" on
page 222

"LIST_CONDITIONS" on
page 209

"SET_CONDITION" on
page 220

"SHOW_VALUE" on
page 227

tcex22 - Calculating an adiabatic flame temperature

This example examines a heat balance when C3H8 is burned in oxygen by calculating the
adiabatic flame temperature.

This uses the SSUB database. A license is required to run the example.

tcex25 - Simulating the refinement of steel

This example is based on a typical steel refining process. Raw iron used to produce steel
usually has high carbon and silicon content, which is why oxygen is blown into the furnace to
burn off carbon. Lime (CaO) is added to form a slag with silica, and the slag can be
removed. Alloying elements, such as Mn, Ni, Cr and V are added to produce the desired
steel. Since the reaction between O and C increases the temperature, scrap iron is added in
order to keep the temperature constant (it is assumed the furnace is isolated and no heat is
lost to the environment).

This example simulates blowing oxygen into a liquid steel of one metric ton (1e6 grams)
with 4 w/o C, 2 w/o Si and 1 w/o Mn. 100 moles of CaO (equivalent to 5.6 kg) is added.
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Keeping the enthalpy constant is the way to simulate the isolation of the furnace. The oxygen
reacts with carbon and increases the temperature. After blowing a certain amount of
oxygen, scrap iron is added to keep the temperature constant.

This uses the SLAG database. A license is required to run the example.

tcex27 - Calculating chemical vapor depositions (CVD)

This example calculates the chemical vapor deposition (CVD).

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

"DEFINE_COMPONENTS"
on page 196

"SET_CONDITION" on
page 220

"ADD_INITIAL_
EQUILIBRIUM" on page 166

"LIST_AXIS_VARIABLE" on
page 208

"LIST_INITIAL_EQUILIBRIA"
on page 210

tcex29 - Calculating the speciation of a gas

This example shows how to calculate the speciation of a gas.

This uses the SSUB database. A license is required to run the example.

These commands are of note and used in this example:

l "SET_INPUT_AMOUNTS" on page 222

l "LIST_CONDITIONS" on page 209

l "SET_CONDITION" on page 220

tcex50 - Quasichemical Model using the Database Retrieval (TDB) module

This example shows the quasichemical model using the DATABASE_RETRIEVAL module (also
called the TDB module).

The example replicates figures 3 and 4 from Kongoli, F., Pelton, A. D., and Dessureault, Y.
(1998)1. 

1Thermodynamic modeling of liquid Fe-Ni-Cu-Co-S mattes. Metallurgical and Materials Transactions B, 29(3), 591–601.
https://doi.org/10.1007/s11663-998-0094-y
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Pourbaix Module Examples
All the macro files and the outputs are also combined into one file that you can
search and read. This is available as a PDF.

tcex40 - Using the POURBAIX Module

This is the first in a series of examples to demonstrate the advanced POURBAIX module
calculations and graphical processing.

It is recommended you read the text file TCEX40-README.txt, which is located
in the Extended subfolder.

Also see the Pourbaix Diagrams Educational Material Guide.

Example TCEX40 automatically calculates and plots a Pourbaix diagram for 0.001 m Fe in a
0.1 m NaCl aqueous solution at 25C and 1 bar. A so-called Pourbaix diagram is actually a
phase diagram with independently-varied acidity (pH) and electropotential (Eh), for a
heterogeneous interaction system at a certain bulk composition (that is by default always set
as 1 kg of water dissolving a specified amount of metals and other solutes), under a defined
temperature and pressure condition.

For details about the additional examples in the Extended folder, see "Pourbaix
Module Examples" above.

tcex53 - Pourbaix diagram calculations for a heterogeneous interaction system

Also see the Pourbaix Diagrams Educational Material Guide.

This example uses the PAQ2 or PAQS2 databases to calculate some Pourbaix diagrams. The
DATABASE_RETRIEVAL (TDB), GIBBS_ENERGY_SYSTEM (GES), POLY3, and POST modules are
used for the Fe-X-H2O-NaCl heterogeneous interaction system, where X = Cr-Ni-Co.

Step 1: Single-Point Calculations for H2O-NaCl system

To demonstrate how to define the molality of NaCl in an aqueous-bearing heterogeneous
interaction system.
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Step 2: Single-Point Calculations for Fe-X (X = Cr-Ni-Co) system

To demonstrate how to define the initial amount of alloy in an aqueous-bearing
heterogeneous interaction system. In this example, we are interested in only the BCC_A2
and FCC_A1 phases in the Fe-based alloy.

Step 3: Single-Point Calculations for Fe-Cr-Ni-Co + H2O-NaCl system

Step 4: Pourbaix Diagram Mapping for Fe-Cr-Ni-Co + H2O-NaCl system - define the
variables

From the same mapping calculations you arrive at by the end of the example, you can plot
more diagrams using a variety of X-Y axis variables.

For a list of pre-defined symbols, go to the end of the tcex53.TCM macro file
(open it in a text editor).

Extended Information about TCEX40A and TCEX40E

In order to be able to subsequently run the TCEX40B (Main Option 2), TCEX40C (Main
Option 3) and TCEX40D (Main Option 4), which open the previously-saved POURBAIX-
type calculation POLY3 file, the user should make four copies of the resulting
POURBAIX.POLY3 as TCEX40A.POLY3, TCEX40B.POLY3, TCEX40C.POLY3 and
TCEX40D.POLY3.

However, this has to be properly done outsides of the TCCS software after the
TCEX40A is executed. The reason is that, if saving the POLY3 workspace of the
POURBAIX calculation results in the POLY3-module monitor (through the command
sequence "GO PLOY3" and "SAVE TCEX40A.POLY3 Y"), all the initial equilibrium points
and the mapping/stepping calculation results will be lost, and parts of the POLY3 file
structure (e.g., some definitions of the previously defined POURBAIX-type calculation
system) will be destroyed. In principle, before executing any Main Option (for
calculations and graphical processing), it is highly recommended that the user shall
save/rename/copy the previously-generated POLY3 file as another POLY3 file. Only in
this way, it can avoid destroying the previous-saved POURBAIX-type calculation
results. 

Under Windows DOS-session (outside TCCS):

l copy POURBAIX.POLY3 TCEX40A.POLY3 (or TCEX40E.POLY3)

l copy POURBAIX.POLY3 TCEX40B.POLY3

l copy POURBAIX.POLY3 TCEX40C.POLY3
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l copy POURBAIX.POLY3 TCEX40D.POLY3

or inside TCCS (under Windows NT/2000/XP, but not Windows 95/98/ME):

l @copy POURBAIX.POLY3 TCEX40A.POLY3 (or TCEX40E.POLY3)

l @copy POURBAIX.POLY3 TCEX40B.POLY3

l @copy POURBAIX.POLY3 TCEX40C.POLY3

l @copy POURBAIX.POLY3 TCEX40D.POLY3

Under Linux/UNIX platforms (outside TCCS):

l cp POURBAIX.poly3 TCEX40A.poly3 (or TCEX40E.poly3)

l cp POURBAIX.poly3 TCEX40B.poly3

l cp POURBAIX.poly3 TCEX40C.poly3

l cp POURBAIX.poly3 TCEX40D.poly3

Example TCEX40

l Using PAQ2 or PAQS2 database;

l For the Fe-H2O-NaCl heterogeneous interaction systems

l With the Main Option 1

l Using the Single-Database Option, i.e., retrieving data from the PAQ2 [TCS Public
Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous solution model] or
PAQS2 [TCS Public Aqueous Solution Database, v2.4; using the Complete Revised HKF
aqueous solution model]; both of which contain an AQUEOUS solution phase and
REF_ELECTRODE phase (as a reference for electron in aqueous electrolyte systems),
as well as some data for various solid phases (solution or stoichiometric) and gaseous
mixture phase. The PAQ2 and PAQS2 are specially designed for demonstrations of
calculations of the so-called Pourbaix diagrams (i.e., pH-Eh plots) and other types of
phase diagrams or property diagrams in some aqueous-bearing multicomponent
heterogeneous interaction systems within the limited chemical framework of Fe-Co-
Cr-Ni-C-N-S-H2O-NaCl, via the Single-Database Option in the advanced POURBAIX
module or through the normal TDB-GES-PLOY-POST routine.

To further run the following Main Options:

l Main Option 2 for plotting many other property diagrams of the calculated
interaction system;
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l Main Option 3 for making another POURBAIX calculation of the same chemical
system but under a different P-T-X condition;

l Main Option 4 for making a POLY3 STEPPING calculation of the same chemical
system but varied with only one independent variable;

** The Main Options 2, 3 and 4 are not illustrated in this TCEX40 example.

Five more examples (TCEX40A, TCEX40B, TCEX40C, TCEX40D and TCEX40E) are also
provided to demonstrate various options and features in the POURBAIX module and to show
more advanced applications of the TCAQ2 and AQS2 aqueous solution databases [in the
Multiple-Database Option, i.e., with appended data from the SSOL5 and SSUB5 databases].

Example TCEX40A

l Option 1

l Using the Single-Database Option, i.e., retrieving data from the PAQ2 [TCS Public
Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous solution model] or PAQS2
[TCS Public Aqueous Solution Database, v2.4; using the Complete Revised HKF aqueous
solution model]; both of which contain an AQUEOUS solution phase and REF_
ELECTRODE phase (as a reference for electron in aqueous electrolyte systems), as well
as some data for various solid phases (solution or stoichiometric) and gaseous mixture
phase. The PAQ2 and PAQS2 are specially designed for calculations of the so-called
Pourbaix diagrams  (i.e., Eh-pH plots) and other types of diagrams in aqueous-bearing
multicomponent heterogeneous interaction systems, via the Single-Database Option in
the POURBAIX module or through the normal TDB-GES-PLOY-POST routine.

l A POLY3 file called POURBAIX.POLY3 is automatically saved.

l For the purposes of recalling this file in other Main Options (as in the TCEX40B,
TCEX40C & TCEX40D), the POURBAIX.POLY3 has to be renamed or copied as another
file name (in this particular example, as TCEX40A.POLY3, and TCEX40B.POLY3,
TCEX40C.POLY3 & TCEX40D.POLY3). Note that the renaming or copying has to be done
outside TCCS, otherwise the POLY3 file structure will be destroyed. However, under
WindowsNT/2000/XP environments, one can use MS-DOS commands to do so, e.g.,
@copy POURBAIX.POLY3 TCEX40B.POLY3

l The Main Option 1 also provides the opportunity to plot many property diagrams along
phase boundaries, after the default Pourbaix diagram is generated and refined (not
necessarily going through the Main Option 2).

Example TCEX40B

l Demonstration of the Main Option 2 Graphical Processing (by plotting more diagrams);
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various options for refining a plotted diagram (including direct interactions with the
POST Module); Graphical processing of related property diagrams.

l Reading a previously saved POURBAIX.POLY3 file (or renamed as another name, for
instance, the TCEX40B.POLY3), and then plotting some property diagrams for the
previously calculated system.

l The loaded POLY3 file will not be modified by this Main Option. It is thus not necessary
to save the file in another name; however, it is still recommended that the user to copy
the TCEX40A.POLY3 (or TCEX40E.POLY3) as TCEX40B.POLY3 before the Main Option 2
is executed in this particular example.

Example TCEX40C

l Demonstration of the Main Option 3 Calculation (by modifying T-P-X conditions);
graphical processing of a Pourbaix diagram.

l Reading a previously saved POURBAIX.POLY3 file (or renamed as another name, for
instance, the TCEX40C.POLY3), and then making another POURBAIX-type calculation
and graphical processing of a new Pourbaix diagram for the same chemical system but
under a different P-T-X condition.

l The loaded POLY3 file will be rewritten according to the T-P-X settings in the new
POURBAIX-type calculation. It is thus recommended to save the file in a new name
outside of TCCS before this Main Option is proceeded (in this particular example, the
TCEX40A.POLY3 is copied to TCEX40C.POLY3).

l The Main Option 3 also provides the opportunity to plot many property diagrams along
phase boundaries, after the default Pourbaix diagram is generated and refined (not
necessarily going through the Main Option 2).

Example TCEX40D

l Demonstration of the Main Option 4 Calculation (by utilizing various stepping
variables); graphical processing of related property diagrams.

l Reading a previously saved POURBAIX.POLY3 file (or renamed as another name, for
instance, the TCEX40D.POLY3), and then making some normal POLY3 STEPPING
CALCULATIONs.

l The loaded POLY3 file will be rewritten according to the T-P-X and stepping variable
settings in the stepping calculation. It is thus recommended to save the file in a new file
name outside of TCCS before this Main Option is proceeded (in this particular example,
the TCEX40A.POLY3 is copied to TCEX40D.POLY3).

l The resulting POLY3 file (in this example, TCEX40D.POLY3) can be subsequently called



Thermo-Calc Documentation Set

Thermo-Calc Console Mode Examples Guide ǀ 38 of 39

by a Main Option 2 for plotting more property diagrams, or by another Main Option 4
for making other stepping calculations.

l The Main Option 4 also provides the opportunity to plot many property diagrams after
the default Pourbaix diagram is generated and refined (not necessarily going through
the Main Option 2).

l Exploration of the possibility of modifying the definitions for some desired system-
components, through the direct and internal POURBAIX-POLY3 intersection, for a
STEPPING (and/or MAPPING) calculation inside the POURBAIX Module.

Example TCEX40E

l Demonstration of the Main Option 1 Calculation with the Multiple-Database Option;
graphical processing of a Pourbaix diagram.

For a more complex application than in Example 40A.

This example requires licenses to three types of commercial Thermo-Calc databases
otherwise it cannot be run, i.e.,

l A: TCAQ2 (TCS Aqueous Solution Database, v2.5; SIT model) or AQS2  (TGG
Aqueous Solution Database, v2.5; HKF model);

l B: SSUB4 (SGTE Pure Substances Database, v4) or TCMP2 (TCS Materials
Processing Database, v2);

l C: SSOL4 (SGTE Alloy Solutions Database, v4) or TCFE6 (TCS Steels/Fe-Alloys
Database, v6) or ALIKE.

l This particular example uses the multiple-database combination of
TCAQ2+SSUB4+SSOL4; among them, TCAQ2 database contains only an AQUEOUS
solution phase (using the SIT model) and REF_ELECTRODE phase (as a reference state
for electron in aqueous electrolyte systems), SSUB4 database is appended for the
GASeous mixture phase and some pure solid phases (so-called secondary phases
formed during aqueous-involving interaction processes), and SSOL database is also
appended for various solid solution phases.

l A POLY3 file called POURBAIX.POLY3 is automatically saved. By reading this
POURBAIX.POLY3 file (or renamed as another name), one can further run the following
Main Options:  Main Option 2 for plotting many other property diagrams of the
calculated interaction system; Main Option 3 for making another POURBAIX calculation
of the same chemical system but under a different P-T-X condition; Main Option 4 for
making a POLY3 STEPPING calculation of the same chemical system but varied with
only one independent variable; The Main Options 2, 3 and 4 are illustrated in the
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TCEX40B, TCEX40C and TCEX40D examples.

l For the purposes of recalling this file in other Main Options (as in the TCEX40B,
TCEX40C & TCEX40D), the POURBAIX.POLY3 has to be renamed or copied as another
file name (in this particular example, as TCEX40A.POLY3, and TCEX40B.POLY3,
TCEX40C.POLY3 & TCEX40D.POLY3). Note that the renaming or copying has to be done
outside TCCS, otherwise the POLY3 file structure will be destroyed. However, under
Windows environments, one can use MS-DOS commands to do so, e.g., @copy
POURBAIX.POLY3 TCEX40B.POLY3

l The Main Option 1 also provides the opportunity to plot many property diagrams along
phase boundaries, after the default Pourbaix diagram is generated and refined (not
necessarily going through the Main Option 2).

l The POURBAIX module inside the TCCS software also accepts the AQS2 aqueous
solution database (using the complete Revised HKF model) in the Multiple-Database
Option, in addition to the TCAQ2 aqueous solution database (using the SIT model).

Example TCEX53

l Using PAQ2 or PAQS2 database; for the Fe-X-H2O-NaCl heterogeneous interaction
systems (X = Cr-Ni-Co)

Note: The PAQ2 (TCS Public Aqueous Solution (SIT) Database, v2.4; using the SIT aqueous
solution model) or PAQS2 (TCS Public Aqueous Solution Database, v2.4; using the Complete
Revised HKF aqueous solution model) contains an AQUEOUS solution phase and REF_
ELECTRODE phase (as a reference for electron in aqueous electrolyte systems), as well as
some data for various solid phases (solution or stoichiometric) and gaseous mixture phase.
Therefore, it can be used, via the Single-Database Option in the POURBAIX module or
through the normal TDB-GES-PLOY-POST routine, for calculations of the so-called Pourbaix
diagrams (i.e., pH-Eh plots) and other types of diagrams in aqueous-bearing multicomponent
heterogeneous interaction systems.

Note: The initial bulk composition of Fe-based alloy in this demonstrating calculation is just
preliminarily assigned, in which the BCC_A2 and/or FCC_A1 solution phase(s) are considered
as of primarily interest. For practical calculations, one shall have more precise inputs for the
initial bulk compositions of alloys.
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Introduction to Data Optimization
This user guide describes the basic idea behind data optimization, contains brief descriptions
of the modules and file types that you work with while doing your optimization, as well as
rough outline of overarching workflow that you typically follow when working with
optimization.

This guide assumes that you are familiar with using the Thermo-Calc Console Mode. It also
assumes that you understand the principles of thermodynamics and are familiar with the
theoretical foundations of computational thermodynamics.

Also see the Thermo-Calc Console Mode Command Reference included with this
documentation set, which has information about all the commands available in
the Thermo-Calc Console Mode, including PARROT and ED_EXP. Note that the
commands listed under PARROT and ED_EXP are only commands that are
specific to PARROT and/or ED_EXP. These modules also contain some
commands that are also available in POLY.

Thermo-Calc Console Mode example tcex36 in the Console Mode Examples
Guide is a detailed example of assessment and optimization in Thermo-Calc.

Data Optimization
In a thermodynamic database, each phase in a system is characterised using a mathematical
model of its Gibbs energy. The Gibbs energy of a phase depends on various state variables. It
can be defined individually even in a heterogeneous system with many stable phases since
the properties of one phase are completely independent of the properties of the other
phases in the system. In most alloy systems, the thermodynamic properties of a phase can
be modelled by expressing how the Gibbs energy depends on temperature and composition.
State variables such as pressure, volume or entropy can also serve as parameters in the
Gibbs energy expression. The Gibbs energy of the whole system is the sum of the products of
the Gibbs energy of each phase multiplied by the amount of that phase.

How the Gibbs energy of the phase varies with various state variables is determined by a
mathematical model and how various adjustable parameters of the model is set. By
optimizing these parameters, you can calculate the thermodynamic properties of a system
under various conditions (by calculating phase diagrams for example). The thermodynamic
properties themselves are functions of temperature, pressure or composition. They include,
among other properties, standard enthalpy of formation, entropy, heat capacity, molar
volume, thermal expansivity, compressibility and Curie temperature for magnetic
transformations.
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Data optimization is about adjusting the model parameters so that calculated equilibria fit
well with experimental data. An important part of a data optimization is therefore collecting
and assessing available experimental and theoretical information about phase equilibria and
thermochemical properties of a system.

When you optimize the parameters of the model of a phase, you put what is called
optimizing variables into the Gibbs energy expressions of those parameters. During the
optimization, the values of these variables are varied in order to find a fit between the
calculated equilibria and the experimental data that you base the optimization on. Once you
have settled on a Gibbs energy expression for a certain parameter of a phase of the
element, then you must stick to this expression in all future optimizations involving the
element. If you do not do this, then you must re-optimize all previous systems that involve
this element when the expression is changed.

The Thermo-Calc software allows you to optimize parameters that characterize not only
binary systems, but also ternary system and systems of even higher orders. You can even
optimize parameters that characterise systems of different orders at the same time.

The Least-Squares Method
Data optimization in Thermo-Calc is based on the least-squares method for fitting values
calculated on the basis of a model with observed quantities. The software is accordingly
trying to find the optimizing variable values that lead the minimized sum of the squares of
the differences between the calculated values and the observed quantities (that is, of the
errors or residuals).

The least-squares method works best under the following conditions:

l The observed quantities have a Gaussian probability distribution.

l The observed quantities are only subject to random errors.

l The different observations (experiments) are uncorrelated

l The standard deviation of each observation can be estimated.

l The number of observations is large.

l The models used give precise predictions.

Of course, these conditions are usually not all met in a normal thermodynamic assessment.
But even in non-ideal conditions, there is no known method that works better than the least-
squares method.

The CALPHAD Approach
The data optimization functionality in Thermo-Calc works according to the CALPHAD
approach to computational thermodynamics. This approach builds on the development of
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models that accurately represent thermodynamic properties for various phases. These
models enable you to predict the thermodynamic properties of multicomponent systems-
based data concerning binary and ternary subsystems. The predictions can take many
factors into accounts, such as, for example, crystallography, type of bonding, order-disorder
transitions and magnetic properties.

CALPHAD is originally an abbreviation of CALculation of PHAse Diagrams, but as the
approach has expanded in scope, it now stands for computer coupling of phase diagrams and
thermochemistry.

References

For in-depth information about CALPHAD as well as data optimization, see Computational
Thermodynamics – The Calphad Method by Hans Leo Lukas, Suzana G. Fries and Bo Sundman
(Cambridge University Press, 2007). CALPHAD was given its first general description in
Computer Calculations of Phase Diagrams by Larry Kaufman and Harold Bernstein (Academic
Press, 1970). The book contains some case studies of optimizations using Thermo-Calc.

Information about the concept of ‘lattice stability’ (which is important for the development
of multicomponent thermodynamic databases) can also be found in the paper Hume-Rothery
and Calphad Thermodynamics by Larry Kaufman, published in Calphad and Alloy
Thermodynamics, edited by Patrice E.A. Turchi, Antonios Gonis, Robert Shull (The Minerals,
Metals & Materials Society, 2002), pp. 3-19.
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Data Optimization in Thermo-Calc
The actual performance of the optimization of a system is primarily done in the PARROT
module, and in its sub-module ED_EXP. The POLY and POST modules are used to calculate
and plot property or phase diagrams based on the optimized variables. This allows you to
visually assess how good a fit you have achieved between your calculated results and your
experimental data.

The end result of a successful optimization is typically an updated Thermo-Calc database file
(with filename extension *.TDB) or a new database file.

Data Optimization Workflow
When you carry out an optimization using Thermo-Calc, you typically follow a workflow as
outlined below.

1. Collect experimental data about your system from various sources such as journal
articles and reports.

2. Create a POP-file in which you enter the experimental data you have collected.

3. Create a setup macro file in which you define your system and the variables you
want to optimize. A useful general procedure is to first find a minimum set of
variables that allows you to calculate most of the experiments.

4. Run the setup macro file.

5. Compile your POP-file. This file often contains errors, which need to be corrected,
and the file recompiled several times before the compilation is completed without
errors.

6. In the ED_EXP module, check that the experiments in your POP-file reach equilibrium
with reasonable results. If any experiments do not reach equilibrium with reasonable
results, then try changing the starting values on equilibrium conditions (such as
composition) to see whether the equilibrium can be computed after all. If this does
not work, then you can temporarily exclude the experiment from the optimization. At
a later stage in the optimization, when the optimizing variables have different values,
you can check whether the experiments can be computed with reasonable results.

7. Back in the PARROT module, run the first optimization cycle and evaluate the
feedback in the console. You can also plot diagrams in the POLY module that allow
you to visually inspect the fit between calculated optimization results and the
experimental data. If you are not satisfied with the fit, then enter the ED_EXP module
again and adjust the weights of the experiments in a way that is likely to improve the
fit and run another optimization cycle. Reiterate until you are satisfied with the fit.
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8. Once you get the optimization stable and smooth with the minimum set of variables
chosen in step 3 above, try using different sets of variables to see whether
improvements are possible.

9. When you are satisfied with the fit between calculated results and experimental data
with your final set of optimizing variables, update your setup file and POP-file. In the
setup file, enter the calculated optimizing variable values as the variables’ start
values. In the POP-file, enter the final weights of the experiments. With these files
updated, you can easily regenerate the parameter values of your optimized system.
Having the files updated also makes it easier to optimize the system again in light of
new data or new theoretical models.

10. Finally, update the database with your calculated results or create a new database
with information about the system that you have optimized.

The PARROT Module
The PARROT module consists of a comprehensive subroutine package for data evaluation of
thermodynamic model parameters from experimental data. The module has 99 variables
that you can use for optimization and the module can handle a thousand experimental
measurements in an optimization. However, there are limits on the simultaneous numbers
of variables and experiments. These limits are listed at each optimization.

The PARROT module is part of the Thermo-Calc software. The module is not
included in the software development kits TQ-Interface, TC-API or TC-Toolbox
for MATLAB®.

The experimental data is entered and edited in a sub-module of PARROT: "The EDIT_
EXPERIMENTS Module" below.

The EDIT_EXPERIMENTS Module
The EDIT_EXPERIMENTS module, or ED_EXP for short, is used for entering, evaluating and
editing experimental data. To enter the module, go to "The PARROT Module" above and
then issue the command "EDIT_EXPERIMENTS" on page 139.

Since ED_EXP uses the POLY module for doing equilibrium calculations of experimental data
points, many POLY commands are also available in the ED_EXP module. However, the
commands may work somewhat differently in the two modules. There are also unique ED_
EXP commands which are not found in POLY.

When you execute ED_EXP commands, the PARROT workspace is modified. However, note
that you must always first use "READ_WORKSPACES" on page 214 in ED_EXP before doing
anything in the module. The command loads the experimental data that you are going to
work with during the optimization. Furthermore, before leaving ED_EXP you must use
"SAVE_WORKSPACES " on page 54 or the results of your work in the ED_EXP module is lost.
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Data Optimization in Other Modules
All kinds of thermodynamic data, calculated equilibrium states or dynamic parameters are
transferred back and forth between the PARROT and the GIBBS module as well between
these and the POLY module. Whenever an optimization run is performed, PARROT calls the
GIBBS module for stored system definition data and model parameters.

In Thermo-Calc, the GIBBS module (the Gibbs Energy System) handles the models of the
various phases that can form in a multicomponent system. It stores thermodynamic data and
performs various Gibbs energy equilibrium calculations. It contains subroutines to
analytically calculate the first and second partial derivatives of integral Gibbs energy with
respect to any set of variables. Many thermodynamic models for various types of substances
are implemented in the module. Some commands that are available in the PARROT module
are also available in the GIBBS module.

In the GIBBS module, parameters of the Gibbs energy models are referred to as TP-
functions.

PARROT calls the POLY module for equilibrium calculations. The POLY module is used for
calculating and storing complex heterogeneous equilibria.

Optimization File Types
These are the important files you work with when optimizing.

File type Description

POP-file

The POP-file (Parrot OPtimization file) is the file that contains all the
experimental data that you use for optimizing Gibbs energy values for your
system. The POP-file is a plain text file that contains ED_EXP commands. By
default, the file has the filename extension *.POP in Thermo-Calc.

Setup file
The setup file is a Thermo-Calc macro file (*.TCM). This file typically
contains commands that define your system, opens the PARROT workspace
(and associated GIBBS and POLY workspaces) and sets optimizing variables.

Other
macro
files

It is often useful to have other macro files than the setup file at hand while
you are doing your optimization. For example, it is convenient to have a
macro file that automatically plots phase diagrams or other diagrams
based on the latest values of your optimizing variables. An optimization
process typically involves many optimization cycles, so this operation needs
to be done many times during a typical optimization.
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File type Description

Workspace
files

The PARROT module has its own workspace with dynamic memories,
similar to the workspaces of POLY and GIBBS. It is stored and updated in a
PARROT workspace file with the filename extension *.PAR. The workspace
file is a binary file whose format is hardware dependent. This means that
the format is unique for each type of CPU. Hence, a workspace file saved on
a computer with one type of CPU cannot be used on a computer with
another type of CPU.

EXP-file

The EXP-file is a plain text file with information in the form of DATAPLOT
Graphical Language commands. These commands can specify some or all
of the data points in your POP-file. This allows you to plot these data points
on top of your plotted optimization results (with the POST commands
"APPEND_EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_
PLOT" on page 254). You can then visually assess the fit between these
results and the experimental data. The PARROT workspace is not influenced
in any way by the creation or use of EXP-files.

Also see the DATPLOT User Guide included with this
documentation set.

Optimization Workspaces
When writing the setup file, you enter a "CREATE_NEW_STORE_FILE" on page 139 command
which creates a PARROT workspace file. Alternatively, select an existing PARROT workspace
file with "SET_STORE_FILE" on page 162. The workspace file is automatically updated and
saved with the latest optimization results (after each use of the "OPTIMIZE_VARIABLES" on
page 154 command). You can also explicitly instruct Thermo-Calc to save the workspace
using "SAVE_PARROT_WORKSPACES" on page 156. If you want to get rid of your latest
changes and return to the state of your workspace when it was last saved, use "READ_
PARROT_WORKSPACES" on page 154.

When the PARROT workspace is saved, parts of the POLY and GIBBS workspaces are also
saved to the PARROT workspace file, along with the PARROT workspace itself. Using the
POLY command "SAVE_WORKSPACES" on page 215 creates a new POLY3 file, nothing is
saved to the PARROT workspace file.

If you do any POLY calculations based on data in the current workspace file, then a *.POLY3
file is created, which contains a copy of the current set of parameters. If you continue on
your optimization and read the old *.POLY3 file, then the new set of parameters is
overwritten with the old set. It is therefore recommended that you never read a *.POLY3 or
*.GES5 file while you are doing an optimization.
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Method for Optimization and Simulation
The PARROT module typically uses ordinary POLY minimization for equilibrium calculations.
The global minimization technique that is used in POLY cannot be used because it
automatically creates new composition sets which corrupt the PARROT workspace.
Furthermore, the equilibrium definitions that you use as input for your optimization must
each be attributed to a specific phase. Some of these definitions may specify some local or
partial equilibrium state rather than a global minimum. However, it is possible to use the
global minimization technique for some equilibrium calculations by using the ED_EXP
command "ADVANCED_OPTIONS" on page 174 with the Toggle_Alternate option.

Optimization in PARROT is performed on the basis of a ‘maximum likelihood’ principle.
According to this principle, the best fit between various calculated results and all the input of
experimental data is found where the sum of the square of the weighted residuals is at its
minimum.

Typically, the results of an optimization is considered to be better the fewer optimizing
variables that are needed to get the same level of fit between computed results and
experimental data. If you can get almost the same fit using eight instead of twelve
parameters, then this should be considered to be a significant improvement. When more
parameters are used, the values of the individual parameters tend to become unrealistic.
This is particularly true when it comes to temperature-dependent parameters. However,
relatively small differences in the number of parameters are often insignificant. For
example, it does not typically matter whether you used 24 or 25 parameters to reach a
certain degree of fit.

It is often difficult to compare the quality of different optimizations based on the number of
optimizing variables that have been optimized. Since you may rely more or less heavily on
different pieces of available experimental data (and do so with good reason), it is possible
that two different users could end up with very different numbers of parameters for the
same system. For example, suppose you optimize the Fe-Al system to incorporate it into an
Al database, while someone else optimizes the same system to incorporate it into an Fe
database. In this situation, the two of you would probably make different judgements about
which experimental information your calculated results must have a good fit with.
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Creating the POP-File
Before starting an optimization in Thermo-Calc, you must collect relevant experimental data
about your system that is available in the research literature. This data is then entered in the
POP-file. The experimental data points and measurements are entered in this plain text file
in the form of ED_EXP commands. 

The syntax of the POP-file is in principle independent of the models used for describing the
phases in the system.

In this section:

Experimental Information 13

POP-File Syntax 16

Entering Experimental Information 17

Using Stability Conditions 24

Grouping Equilibria with Labels 24

Dividing the POP-File into Several Blocks 25
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Experimental Information
An optimization of thermodynamic model parameters should be based on a range of reliable
experimental results that is as wide as possible, as well as on empirical or semi-empirical
correlations and theoretical considerations. During an optimization in Thermo-Calc, many
kinds of thermochemical and thermophysical data can be mixed and used together.

The information needed for an optimization represent measurements of thermodynamic
parameters in the system at equilibrium. These can be measurements of any of the
thermodynamic quantities that can be set as conditions in Thermo-Calc. The information
may represent measurements of activities or enthalpies in single-phase regions for example,
or solubilities or transformation temperatures in a multi-phase region.

For each equilibrium that is used in the optimization, at least one quantity must have been
measured and you also need to know the conditions that must be set to compute the
system’s equilibrium state. For example, consider a binary system in a single-phase region.
Suppose that you have measured the temperature, pressure, composition and the chemical
potential. Three of these quantities are necessary to specify the equilibrium state and the
forth can be used as experimental information to model the phase.

If you have a two-phase region and know the temperature and pressure conditions, as well
as which the stable phases are, then you could use the compositions of one or both phases as
experimental data. The former information about the conditions is sufficient to determine
the equilibrium. The experimental information can then be used to optimize the parameters
that are used to characterise and model the system.

For examples how to enter various kinds of experimental data in the POP-file,
see "Experiments and Experimental Data" on page 54.
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Conflicting or Missing Information

You are likely to sometimes have inconsistent or conflicting experimental information. In
principle, all available experimental data should still be entered into the POP-file, unless you
have good reasons to exclude some information. For example, if you have reason to believe
that the samples used in some experiments were not pure, then these experiments could be
excluded from the POP-file.

For some systems, you have very little experimental data to go on. When this is the case, do
not try to fit the available data uncritically with high accuracy without considering possible
errors. You can look for data in systems with similar elements to get an idea about what the
reasonable estimates of data that is lacking could be. Or you can use calculations from first
principles or semi-empirical methods to get reasonable estimates that can be used as
experimental data.



Thermo-Calc Documentation Set

Creating the POP-File ǀ 15 of 72

Invariant Equilibria Information

The most valuable experimental information for an optimization is information about stable
invariant equilibria. An invariant equilibrium is such that neither pressure, temperature nor
composition can be changed without there being a change in the set of phases present in the
system. It is recommended that all information about invariant equilibria for a system is
included in the POP-file. These equilibria need not all be based on explicit experimental
measurements of thermodynamic properties.

Reasonable estimates from available experimental data are often useful to include in the
POP-file. Such estimates, which should be based on the available experimental data, helps
Thermo-Calc find a good set of start values on the optimization variables. However, at the
end of the assessment, these estimated equilibria should be excluded and you should
complete the optimization based only on the experimental information that is based on
measurements.

With some experience from phase diagram evaluation, it is possible to make reasonable
estimates of metastable invariant equilibria. Such estimates helps reduce the number of
phases that are assessed simultaneously during the optimization. For example, you may
assume that a certain intermediate phase does not form in a system. Then extrapolate the
liquidus curves below the stable three-phase equilibria and finally, estimate temperatures
and compositions of metastable three-phase equilibria between two other phases and the
liquid.

Another useful technique is to extrapolate a liquidus line from a peritectic equilibrium to
estimate the congruent melting temperature of a compound. This estimate may be more
useful than the information about the peritectic equilibrium itself as the equilibrium involves
only two phases.
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Equilibria in Higher-Order Systems Information

When you optimize a binary system, the available experimental information can often be
described equally well by very different sets of parameters. Information about ternary and
higher order systems that include the components of the binary system are then often useful
for optimizing the binary system (the same is true of information about quaternary system
with respect to optimizing ternary systems). Often, it is only when you extrapolate the
optimized parameters to a higher-order system that you can judge which of the sets of
model parameters that is best. Sometimes information from several ternary systems is
required to make a reliable judgement about which set of parameters best describes a
particular binary system.

Heat Capacities Information

If you want to optimize your system based on data about heat capacities, then the
corresponding parameters should first be optimized separately before you perform the
general optimization of your system. The parameters should be kept fixed during the
general optimization. This is because it is normally not possible to optimize heat capacity
data together with other data in a meaningful way. If you do this, then it is very likely that
the parameters related to the heat capacity are badly determined.

POP-File Syntax
It is recommended that you specify an experimental equilibrium as close as possible to
actual experimental conditions. Ideally, there is information about the set of stable phases,
temperature, pressure and some or all compositions for the equilibrium.

In addition, it is recommended that you keep the POP-file well-organised and extensively
commented. This is especially important if someone else reassesses the system when new
experimental information is available.

If you have too many equilibria defined in your file, or if you define equilibria with different
sets of components in the same file, then you must divide the POP-file in blocks (using the
"FLUSH_BUFFER" on page 77 command). You know whether you have defined too many
equilibria for one block when you compile the file. A too large number of equilibria leads to
an error message when the file is compiled.

If you use the "DEFINE_COMPONENTS" on page 196 command, then it must be the first
command in the POP-file (or if you have several blocks, DEFINE_COMPONENTS can also be
put as the first command after FLUSH_BUFFER). This is because the command automatically
reinitiates the current workspace, so the effect of any commands placed before it are not
saved.

The last command in the POP-file should always be "SAVE_WORKSPACES " on
page 54.
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Legal Commands in a POP-File

The following commands can be used in a POP-file.

Also see the Thermo-Calc Console Mode Command Reference Guide for
information about all these commands.

l "ADVANCED_OPTIONS" on page 174

l "CHANGE_STATUS" on page 186

l "COMMENT" on page 77

l "CREATE_NEW_EQUILIBRIUM" on page 195

l "DEFINE_COMPONENTS" on page 196

l "ENTER_SYMBOL" on page 247

l "EVALUATE_FUNCTIONS" on page 208

l "EXPERIMENT" on page 44

l "EXPORT" on page 46

l "FLUSH_BUFFER" on page 77

l "IMPORT" on page 47

l "LABEL_DATA" on page 48

l "SAVE_WORKSPACE" on page 289

l "SET_ALL_START_VALUES" on page 217

l "SET_ALTERNATE_CONDITION" on page 57

l "SET_CONDITION" on page 220

l "SET_NUMERICAL_LIMITS" on page 296

l "SET_REFERENCE_STATE" on page 224

l "SET_START_VALUE" on page 226

l "SET_WEIGHT" on page 66

l "TABLE_HEAD, TABLE_VALUES and TABLE_END" on page 75

Entering Experimental Information
A POP-file in Thermo-Calc (*.POP) mainly consists of descriptions of equilibria, each
equilibrium describing a data point that is based on an experiment from the existing
literature on your system. An equilibrium is specified using ED_EXP commands.
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The following is an example of a specification of an equilibrium with a single stable phase in
the Au-Cu system. Equilibria with a single stable phase are often from experiments where
enthalpies of mixing or chemical potentials have been measured.

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID=FIX 1

SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563

SET_REFERENCE_STATE AU LIQ * 1E5

SET_REFERENCE_STATE CU LIQ * 1E5

EXPERIMENT HMR=-1520:200

COMMENT Measurement by Topor and Kleppa, Met trans 1984

Creating a New Equilibrium

The first command in an equilibrium specification is always "CREATE_NEW_EQUILIBRIUM"
on page 195. This command takes two integers as arguments. The first integer should
specify a unique identifier that can be used later to refer to the equilibrium in question. The
second integer is an initialisation code 0, 1 or 2:

l Code 1: This means that all components are entered but all phases are suspended.
This code is appropriate in most cases.

l Code 0: This means that all components and phases in the equilibrium are suspended
initially. This code is needed if you are using experimental data about systems of
different orders simultaneously, such as data about both binary and ternary systems
for example.

l Code 2: This means that all components and phases are initially entered.

Example

For example, the first command in the example above creates an equilibrium data point
with the unique identifier 1. All components of the system are entered but all phases are
suspended:

CREATE_NEW_EQUILIBRIUM 1 1

Setting Equilibrium Conditions and its Uncertainty

All the equilibrium-related commands that are placed in between two "CREATE_NEW_
EQUILIBRIUM" on page 195 commands are interpreted as specifying the conditions of the
equilibrium created by the first command. The values of these conditions should be based on
the conditions specified in the experiment that you base the equilibrium definition on.
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Example

In the example, the "CHANGE_STATUS" on page 100 command specifies that the equilibrium
is a single-phase equilibrium with the liquid phase.

CHANGE_STATUS PHASE LIQUID=FIX 1

Furthermore, the temperature is 1379 K, the pressure is 1 bar (1E5 Pa) and the mole
fraction of Au is 0.0563.

SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563

Sometimes you have reason to think that some information about an equilibrium condition
may not be accurate. If this is the case, then you specify the degree of uncertainty for a
condition with a colon after the condition quantity, directly followed by either an absolute
value or a percentage. For example, if you have reason to doubt the reliability of the Au
mole fraction measurement, then you could write:

SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563:10%

This indicates that you think the Au mole fraction is between 0.0507 and 0.0619. PARROT
calculates the equilibrium twice, once for 0.0507 and once for 0.0619, and then computes
the change of each experimental value between these two equilibria. This change is used to
modify the uncertainty specified for the experimental value.

Also see "Entering the Experimental Value and its Uncertainty" on the next
page.

The possibility of specifying uncertainties on conditions may be useful when you have
experimental data about a ternary system. In a binary system, a tie-line is determined by the
two phases, the temperature and the pressure. Measurements of the compositions of both
phases can then be used as experimental data. To specify the tie-line in a ternary two-phase
equilibrium one of the four compositions must also be set as a condition. If the
measurement of this composition has the same uncertainty as the other compositions, then
you can assign this same degree of uncertainty both to the composition selected as a
condition and the compositions selected as experimental data. Alternatively, the sample
(overall) composition could be used as a condition and all four phase compositions could be
used as experiment values. These phases must have the status entered (not fixed) since the
relative amount of each is unknown.

Setting Reference States

If you want to specify a non-default reference state for one or several of your system
components, then you do this with the "SET_REFERENCE_STATE" on page 224 command. In
the following example, the reference state for the liquid phase is set to current temperature
(*) and a pressure of 1E5 Pa.



Thermo-Calc Documentation Set

Creating the POP-File ǀ 20 of 72

Example

SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5

Note that in order for these reference states to be taken into account when the
measurement of the enthalpy per mole of the system is entered with experiment, the R-
suffix must be used.

Entering the Experimental Value and its Uncertainty

The "EXPERIMENT" on page 44 command is used to specify the quantity that the calculated
results should be fitted to. When specifying this quantity, you both specify the measured
quantity itself and your estimation of the uncertainty of this value.

Example

In the example, the EXPERIMENT command specifies the enthalpy per mole of the system,
where this value is specified with respect to non-default reference states that you have set in
the equilibrium specification:

EXPERIMENT HMR=-1520:200

The value before the colon is the quantity of the variable. The value after the colon is an
assessment of the uncertainty of this quantity. A higher value means a greater uncertainty.
In the example, the uncertainty has been specified with an absolute value but it could also
be specified in percent of the quantity:

EXPERIMENT HMR=-1520:13%

Several experiments can be specified after the experiment command. Besides assigning
values to conditions, it is also possible to specify that a certain quantity is greater than or
less than a certain value. For instance, the following command would specify that the
activity of the C-component is less than 0.01 and the mass fraction of the BCC phase of Ag is
greater than 0.05:

EXPERIMENT ACR(C)<0.01:0.001 W(BCC,AG)>0.05:10%

Note that an experimental quantity can typically also be treated as an equilibrium condition,
and vice versa. Which measured quantities that you treat as conditions and which quantities
you treat as experimental data should be based on the accuracy of the different
measurements. In most cases, the quantity that is based on the experimental technique with
the lowest accuracy should be used as the experimental value.

Entering Many Equilibria as a Table

When one thermodynamic variable (e.g. heat capacity) has been measured as a function of
another (e.g. temperature), then experimental data is often presented as a table. By using
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the TABLE_HEAD, TABLE_VALUES and TABLE_END commands, you can enter such experimental
information into the POP-file in the form of a table. These three commands should always
be used together and must be entered in the right order. See "TABLE_HEAD, TABLE_VALUES
and TABLE_END" on page 75.

The TABLE_HEAD command is followed by a number. This number identifies the table as a
whole, but also uniquely identifies the first equilibrium that is included in the table. This
numeric identifier is incremented by one for each additional equilibrium in the table. Each
row in the table represents one equilibrium. Thus, the equilibrium defined by the first row in
the table above (on the line immediately below TABLE_VALUE) is uniquely identified with
the number 1, the equilibrium defined by the second row by number 2, and so on until the
last equilibrium on the sixth row, which is identified by the number 6.

Since the unique identifiers of the equilibria in the table are automatically generated from
the unique numerical identifier that you give to the table, the unique numerical identifier
that is normally given to the "CREATE_NEW_EQUILIBRIUM" on page 195 command is
replaced by two at signs (@@).

At least one of the equilibria conditions specified with the "SET_CONDITION" on page 220
command must be a condition whose value is set by the numbers in one of the table
columns. To assign the numbers in a column to a condition, use the syntax SET_CONDITION
<condition>=@<column number>. For instance, in the example above, the mole fraction of
X(ALO3/2) is for each equilibrium given by the number in the first column of the table.

At least one of the measured variables that are entered with the experiment command must
be a variable whose value is set by the numbers in a table column. To assign the numbers in
a column to a measured variable, use the syntax EXPERIMENT <variable>=@<column
number>. In the example above, the measured temperature for each equilibrium is given by
the number in the second table column.

The actual table should be entered between TABLE_VALUES and TABLE_END. Separate the
columns with tabs or any number of spaces. The columns do not have to contain numbers,
but can also contain other types of values, such as phase names for example. If a column
contains text with spaces or special characters, then the text must be surrounded by double
quotes (“ABC DEF&ghi”, for example). The table may have columns that are not used, but
each row must have exactly the same number of columns.

Example

The following block of commands exemplifies how a table can be entered into a POP-file:

TABLE_HEAD 1

CREATE_NEW_EQUILIBRIUM @@ 1

CHANGE_STATUS PHASE TETR=FIX 0
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CHANGE_STATUS PHASE ION=ENT 1

SET_CONDITION P=101325 N=1 ACR(O2,GAS)=.21 X(ALO3/2)=@1

EXPERIMENT T=@2:5

TABLE_VALUE

0.46082476

0.57142380

0.66822276

0.7496 2176

0.50382426

0.63132249

TABLE_END

Setting Site Fraction Start Values

In some systems, you have to set non-default composition start values on some experiments
in order to get them to converge properly during optimization. This may be important if your
system has a miscibility gap for example, in which case several equilibria with different
compositions exist at certain temperatures. In such cases, you have to make sure it is
specified in the POP-file which side of the miscibility gap the equilibrium is on. The
calculated equilibrium could otherwise end up on the wrong side, resulting in a large error.

In the POP-file, you can set the site fraction of a constituent on an equilibrium with "SET_
START_VALUE" on page 226.
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Example

For example, the following command sets the composition start value of VA constituent of
the FCC_A1 phase to 0.99:

SET_START_VALUE Y(FCC_A1,VA#2)=0.99

Setting the mole fraction for a component in a phase is not as reliable as setting the site
fraction.

Additional equilibria entered after the last SET_START_VALUE command are automatically
given a similar start value if the following command appears previously in the POP-file:

SET_ALL_START_VALUES Y

If start values are not set automatically for phase constituents, then you may have to set the
composition start value for each equilibrium (or table of equilibria) separately.

Commenting About an Equilibrium

The COMMENT command inserts a comment about the equilibrium that is saved to the
PARROT workspace file when the POP-file is compiled. The comment must be entered on
one line.

Comments can also be entered immediately after a dollar sign ($), but these are not saved
to the PARROT workspace. Instead, these comments are ignored by Thermo-Calc when the
POP-file is compiled.

Simultaneous Use of Binary and Ternary Experiments

You can use experimental information about binary and ternary systems (as well as systems
of even higher order) in the same POP-file and optimization. To do this, you must inform the
PARROT module that not all components of the ternary system (or system of even higher
order) should be considered. This allows you, for example, to use experimental information
about a binary equilibrium that exists within a ternary system.

Use "CHANGE_STATUS" on page 100 with the keyword component and which components
that should be entered. You should also give the initialization code 0 (rather than 1) to the
"CREATE_NEW_EQUILIBRIUM" on page 195 command. This code indicates that all
components must be entered.

Example

For example, the following set of ED_EXP commands characterises a binary (A-B) three-
phase equilibrium (FCC-BCC-LIQ) in a ternary system (A-B-C). It can be used in a POP-file



Thermo-Calc Documentation Set

Creating the POP-File ǀ 24 of 72

that otherwise only contain experimental information about the ternary system (A-B-C):

CREATE_NEW_EQUILIBRIUM 1 0

CHANGE_STATUS COMPONENT A B = ENTERED

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1

SET_CONDITION P=1E5

EXPERIMENT T=1177:10

COMMENT from A-B

Using Stability Conditions
Early in the optimization when parameter values are not so good it is often useful to set the
driving force for precipitation of a phase (per mole of components) to make sure that it
appears where it should. The DGM condition is very useful for making sure that phases
appear where they should. It can be removed when the optimization becomes stable.

The DGM condition is also useful for suppressing phases that appear where they should not
appear. Do this by setting the value and the uncertainty to something reasonable. For
example, the driving force for precipitation of the BCC phase could be set as follows:

DGM(BCC)<-0.1:0.1

This produces an error even before BCC becomes stable and the weight of the experiment in
question can be adjusted as needed. If you specify that the driving force for the BCC phase
should be below 0 (DGM(BCC)<0:1E-4 for example), then the optimization converges
extremely slowly (if at all). With such a sharp error condition, calculating the equilibrium is
like finding the minimum point on a lawn that gently slopes towards a rock wall. The
optimization keeps bouncing into the wall.

Another useful stability condition is the phase stability function, abbreviated QF. This can be
used to specify that a phase is outside the miscibility gap for a solution phase. If QF(phase) is
negative, then the phase is inside the miscibility gap; if QF(phase) is positive, then it is
outside the miscibility gap.

Grouping Equilibria with Labels
If you have several equilibria describing experiments that you want to be able to treat
collectively, you can give all of the equilibria one and the same label.

Use LABEL to give an equilibrium a label. The label must start with the letter A and can only
be up to four characters long. For example, you can insert the following command in several
equilibria specifications:

LABEL ALH
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During the optimization, you could use this label to, for example, set all the equilibria that
have it to the same weight in the ED_EXP module.

Dividing the POP-File into Several Blocks
For two different reasons, you may have to divide your POP-file into different blocks:

l PARROT uses a buffer for storing compiled experimental data. If there is not enough
memory in this buffer for storing all the experiments from the POP-file, then the
POP-file can be divided into several blocks. When PARROT encounters the end of a
POP-file block, it saves the experimental data that has been compiled to PARROT
workspace, clears out the memory buffer and then proceeds to read the next block in
the POP-file. This goes on until the experimental data from all the blocks have been
saved to the PARROT workspace.

l If you want to put equilibria with different sets of components in one and the same
POP-file, then you must divide the file up into blocks. Each block should only contain
equilibria that all have the same set of components.

To divide the equilibria in the POP-file into different blocks, enter the "FLUSH_BUFFER" on
page 77 command between two equilibria. This command marks the beginning of new
block. When the command is encountered during the compilation of the POP-file, the
compilation of the current block is terminated, the equilibria saved to the PARROT
workspace file and a new block is initiated. That the buffer is reinitiated means that all
functions and constants that were entered in the previous block must be entered again in
new block in order to be used.

When editing your experimental data in the ED_EXP module, you can select which block to
load and edit using "READ_WORKSPACES" on page 214 <block number>. The block before
the first instance of FLUSH_BUFFER is block number 1, the block after the first instance and
before the second instance is block number 2, and so on.
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Creating the Setup File
The second step is to create the setup file. This is an ordinary Thermo-Calc macro file
(*.TCM). Typically, your setup file should contain the following:

l A system definition.

l A section where you enter model parameters and optimizing variables.

l A GO PARROT command.

l A section where initial values are assigned to the optimizing variables for the first
optimization cycle.

l A "CREATE_NEW_STORE_FILE" on page 139 <filename.par> which creates the
PARROT workspace file onto which the results of your optimization are continuously
saved and updated. By default this workspace file has the same filename as the setup
file, but with the *.PAR filename extension.

l A "COMPILE_EXPERIMENTS" on page 137 <filename.pop> command. Since you
often encounter syntax errors when you first try to compile a POP-file, it may be
useful to execute this command from the console rather than as part of the setup
macro file.

l Normally, you also have a "SET_INTERACTIVE" on page 295 at the end of the setup
file. This command returns control over Thermo-Calc to the console.

It is possible to interactively execute all these commands one at a time in the console. It may
be instructive to enter the commands that would normally go into the setup file interactively
while using the on-line help while you are learning to use the PARROT module.

Defining the System
If you have an existing database with information about your system, then you can write the
system definition part of your setup file in two different ways.

l If you have an unencrypted user database, then you can define your system by
entering DATA module commands directly in the setup file. Use the DATA commands
that you normally use to define a system when doing equilibrium calculations in
Thermo-Calc Console Mode.

l Define your system by entering DATA module commands directly in the console, then
generate a macro file with the GIBBS command "LIST_DATA" on page 120 <name of
setup file>.tcm p . This command saves all the data that has been loaded in the
GIBBS workspace as a macro file. This file can then be modified as required into an
optimization setup file.
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Creating Additional Composition Sets of a Phase
If you need several composition sets of a phase, then these should be created with the GIBBS
command "AMEND_PHASE_DESCRIPTION" on page 93 <phase name> composition_sets
<composition set number> in the setup file.

If you add composition sets of a phase after the POP-file has been compiled, the
data structure in the workspace is corrupted and you have to recompile the
POP-file.

Entering the Optimizing Variables
When you have retrieved the data about your system for the setup file, you must manually
enter the model parameters that you want to optimize. This is done using the GIBBS
command "ENTER_PARAMETER" on page 143, but when you specify the Gibbs energy
expression for the parameter, you enter variables that can be given various values into the
expression. It is the values of these variables (and thus, the Gibbs energy of the parameter)
that you are optimizing.

How you in detail specify the optimizing variables in your set up file depends on which phase
you are trying to optimize and what thermodynamic model that is used in the optimization.

Also see "Thermodynamic Models" on page 64 for a range of examples.

Entering Optimizing Variables in Parameter Specifications

There are ninety-nine predefined variables in the PARROT module which you can use in your
optimization. These variables are referred to as V1, V2, V3, … V98 and V 99. When the GIBBS
workspace is initialised, all optimizing variables are set to a fixed numerical value of zero.
When you do an optimization, there is always some variable for which you want to evaluate
the best value, but you can assign fixed values to optimizing variables too. It is often useful
to enter all the variables that you can conceivably want to optimize, and then you can
interactively select and change which variable to focus at various stages of the optimization.

The setup file excerpts that follow show how optimizing variables are entered. However,
before the optimizing variables are introduced in this example, the following command
enters an ionic liquid solution phase (a phase for which you have some experimental
information):

ENTER_PHASE IONIC_LIQ Y,
AL+3,ZR+4 ; ALO2-1,O-2 ; N N

This "ENTER_PHASE" on page 110 command enters a phase called IONIC_LIQ into the GIBBS
workspace. This phase is of the type ionic liquid solution, which is specified by type code Y.
Such a phase is modelled by the Ionic Two Sublattice Liquid Model. The next two arguments
specify the two sublattices, in this case the cations AL+3,ZR+4 and the anions ALO2-1,O-2.
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Components that interact in a sublattice are separated by a comma. The first N at the end
means that no additional constituents are added to the phase. The second N means that a list
of possible parameters for the phase should not be shown in the console.

There are model parameters that describe the phase which you do not want to optimize, in
which case the Gibbs energy expression of the parameter does not contain any optimizing
variables.

Example 1

For example, the following parameters of the IONIC_LIQ phase do not contain any
optimizing variables:

ENTER_PARAMETER G(IONIC_LIQ,AL+3:ALO2-1;0) 298.15 +2*GAL2O3_L;
6000 N

ENTER_PARAMETER G(IONIC_LIQ,AL+3:O-2;0) 298.15 +GAL2O3_L+400000;
6000 N

ENTER_PARAMETER G(IONIC_LIQ,ZR+4:O-2;0) 298.15 +2*GZRO2L; 6000 N

These parameters define the Gibbs energy expressions for three constituents in the
constituent array, namely AL+3:ALO2-1, AL+3:O-2 and ZR+4:O-2. The names that occur in
these expressions—that is, GAL2O3_L and GZRO2L—are the names of complex functions of
temperature that are entered in the GIBBS workspace with the "ENTER_SYMBOL" on
page 113 command.

The numbers that frame the Gibbs energy expressions specify the temperature range within
which the expression should be applied. In the above, the expressions are applied in a
temperature range from 298.15 K to 6000 K.

Example 2

In this example, suppose that you want to optimize the model parameter for the ZR+4:ALO2-
1 combination, then you could enter the variables V1 and V2 in the Gibbs energy expression
for that parameter in the following way:

ENTER_PARAMETER G(IONIC_LIQ,ZR+4:ALO2-1;0) 298.15 +GZRO2L
+2*GAL2O3_L +V1+V2*T; 6000 N

You normally have different optimizing variables in different parameters, but in some cases
you may want several parameters to vary together, in which case you can use the same
variable in the Gibbs energy expressions of several parameters.

Entering Interaction Parameters

For some systems, you have to consider interaction parameters in order to take excess Gibbs
energy into account and correctly model the phase. By default, the software uses a Redlich-
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Kister expression for the excess Gibbs energy. The coefficient is entered after the constituent
array when you use the "ENTER_PARAMETER" on page 143 command. In the last section, all
the parameters were entered with a coefficient of zero (0).

Example

To take account of the excess Gibbs energy, you might enter the following:

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;0) 298.15 +V11+V12*T;
6000 N

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;1) 298.15 +V13+V14*T;
6000 N

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;2) 298.15 +V15+V16*T;
6000 N

Parameters with interaction coefficients are referred to as interaction parameters. The
regular parameter has a coefficient of 0. The subregular parameter has a coefficient of 1. It
is possible to interaction coefficients up to a value of 9, but you are advised not to use more
than three coefficients (that is, with coefficient values of 0, 1 and 2).

Initializing Optimizing Variables in PARROT
Variables that have been entered into Gibbs energy expressions for model parameters in the
setup file has to be initialized and given start values before they are optimized.

You have to estimate what start values to give to the optimizing variables based on your
knowledge of the system or of relevantly similar systems. There are no general rules for
what start values your optimizing variables should have. If you are not able to make any
informed estimation about what start values to use, then you may not be able to find a good
fit between your experimental data and your calculated results.  In this case, it is often best
to start the optimization in the so-called alternate mode. In alternate mode, the PARROT
module helps you find some reasonable start values for your optimizing variables.

Also see "About Alternate Mode" on page 47.

Even if you are starting your optimization in alternate mode, you still have to initialize the
optimizing variables though (you can all give them a start value of 0).

To initialize an optimizing variable and to give it a start value, use either "SET_OPTIMIZING_
VARIABLE" on page 159 or "SET_SCALED_VARIABLE" on page 161. Using SET-OPTIMZING_
VARIABLE results in a scaling factor equal to the current value of the parameter unless the
current value is zero, in which case the scaling factor is 1000. This is typically appropriate
for enthalpic parameters, but not necessarily for other parameters. The scaling factor is the
factor by which the optimizing variable value is varied during the optimization.
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Example

For example, if you want to optimize the variables V1, V2, V11, V13 and V17, then you could
enter the following in the setup file:

SET_OPTIMIZING_VARIABLE 1 +43000

SET_OPTIMIZING_VARIABLE 2 -35.2

SET_OPTIMIZING_VARIABLE 11 +72000

SET_OPTIMIZING_VARIABLE 13 +27000

SET_OPTIMIZING_VARIABLE 17 -100000

The value given to each optimizing variable (+43000 for variable V1 for example) is also that
variable’s initial scaling factor. If you want to set the initial scaling factor of a variable to a
value that is lower or higher than its start value, then use SET-SCALED_VARIABLE <start
value><scaling factor><min value><max value>.

Creating the Workspace File
In the setup file, after the system definition and the entered optimizing variables, use the
PARROT command "CREATE_NEW_STORE_FILE" on page 139 to create and save a PARROT
workspace file for the system defined in the setup file. For example, the following command
saves all current data on system definitions (elements, species, components, phases), symbol
definitions (constants, variables, functions, tables) and parameters that are stored in the
workspace used by GIBBS, POLY and PARROT into a file called AL2O3-ZRO2.PAR:

CREATE_NEW_STORE_FILE AL2O3-ZRO2

The experimental information in the POP-file is not saved to this PARROT
workspace file.

Compiling the POP-file
At the end of the setup file, use the command "COMPILE_EXPERIMENTS" on page 137
followed by the name of your POP-file to compile the data in that file and save it to the
current PARROT workspace file. Note that you must first have opened or created a new
PARROT workspace file before you compile your POP-file. The other argument to the
command can typically be given default values with comma signs (,):

COMPILE_EXPERIMENTS AL2O3-ZRO2.POP,,,

If Thermo-Calc encounters errors in the syntax of the POP-file, then error messages are
displayed in the console. Normally, the compilation also stops when syntax errors are
encountered. If this happens, then you must correct the errors and recompile the file. It is
useful to have two console windows open when you do this. That way, you can use one
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console for editing the experimental data and another console for compiling and reading
any further error messages.

Returning Control to the Console
Put the command "SET_INTERACTIVE" on page 295 at the end of the setup file if you want to
return control to the console when the commands in the setup file have all been executed.



Thermo-Calc Documentation Set

Optimizing in PARROT ǀ 33 of 72

Optimizing in PARROT
In this section:

Optimizing the System in PARROT 34

Changes that Require POP-file Recompilation 34

Optimization Workflow 34

Ensuring Computation of all Equilibria 35

Setting Weights 36

Optimizing and Evaluating Results 37

The Critical Set of Experiments 38

Continuing the Optimization and Resetting Variables 38

Updating the Set of Optimizing Variables 40

Reducing the Number of Optimizing Variables 41

Plotting Intermediate Results 41



Thermo-Calc Documentation Set

Optimizing in PARROT ǀ 34 of 72

Optimizing the System in PARROT
When you have created a POP-file, a setup macro file and (optionally) EXP-files, you should
start doing optimization runs interactively in the console. This process can be divided into a
number of steps (such as running optimization, evaluating optimization results, modifying
weights and models and adding new information), but usually, you have to go through many
optimization cycles before achieving a satisfactory fit between calculation results and
experimental data.

Typically, it is not obvious when an optimization is finished. You must exercise your
judgement about when the fit you have achieved is good enough.

It is possible to interactively change almost everything in the initial setup macro
file and in the POP-file. For example, you can add more parameters to be
optimized and modify or add more experimental information.

Changes that Require POP-file Recompilation
Some changes that you do interactively in the PARROT module or the ED_EXP sub-module
destroys the data structure in the workspace. For example, if you add more composition sets
to a phase, then the number of phases actually change and the links break between the
experimental data and the thermodynamic models. Note that if the global minimization
technique is used in POLY, then new composition sets that corrupts the PARROT workspace
may be created automatically. If this happens, then you have to compile the POP-file again.

If you recompile the POP-file, then the experimental equilibria are calculated with the
default start values.

Optimization Workflow
Normally, the workflow during an optimization is the following:

1. In the PARROT module, run the setup macro file using "MACRO_FILE_OPEN" on
page 5.

2. Go to ED_EXP with "EDIT_EXPERIMENTS" on page 139, use "READ_WORKSPACES" on
page 214 to load your experimental data and then execute "COMPUTE_ALL_
EQUILIBRIA" on page 37.

3. If an equilibrium cannot be computed, then this either means that the start values
(site fractions, for example) were inappropriate or that the equilibrium cannot be
calculated with the current set of parameters. If the latter, then the equilibrium may
have to be excluded from the optimization. However, you should make an effort to
exclude the possibility that the reason is just that you do not have the appropriate
start values for the equilibrium.
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4. When each equilibrium is either successfully computed or excluded from the
calculation, go back to the PARROT module and run the "OPTIMIZE_VARIABLES" on
page 154 command. Give the number of optimization iterations you want the
Thermo-Calc program to carry out as an argument to the command. This number
specifies how many different sets of values for the optimizing variables that PARROT
tries to fit with the experimental data. It is recommended that you run 0 iterations
first to see the discrepancy between the experimental data and the initial calculated
results. The current workspace file is automatically updated with the last set of
optimized variables and calculated results.

5. List and evaluate the result of the optimization using "LIST_RESULT" on page 149.
Typically, what is of interest in the results are the relative standard deviation of the
optimizing variables and the error values in the list of calculated experimental data
results. If the relative standard deviation for an optimizing variable is very large, this
means that the variable doesn’t have any effect on the computed results and that the
variable should not be used (you can make PARROT ignore the variable by setting its
value to 0 with "SET_FIX_VARIABLE" on page 158). If the relative standard deviation
is close to zero for a variable, then this might indicate that you need to use more
variables. When it comes to errors in the calculated equilibrium results, these can be
decreased by lowering the weight that PARROT gives the experiment in the
calculation (the more weight, the more the experiment affects the calculated
results).

6. Use "OPTIMIZE_VARIABLES" on page 154 or "CONTINUE_OPTIMIZATION" on
page 138 to carry out a new optimization cycle. Go back to step 5 above and continue
to do optimization cycles until you judge that there is a good enough fit between your
calculated results and your experimental data. It is recommended that you do not
only rely on feedback from "LIST_RESULT" on page 149 but also frequently plot
various diagrams and compare them visually to some of your experimental data.

Ensuring Computation of all Equilibria
When you have run the setup macro file, you should start by trying to compute all the
equilibria that were created when your POP-file was compiled. To do this, you must first go
to the ED_EXP submodule, and load the experimental data from the current PARROT
workspace file with the "READ_WORKSPACES" on page 214<block #> command (normally,
the block number is 1).

When you have loaded all equilibria, you should try to compute them all using the ED_EXP
command "COMPUTE_ALL_EQUILIBRIA" on page 37. A list of calculated equilibrium results
are shown in the console, but the software is not able to reach an equilibrium for an
experiment, then the program cancels the calculations and displays an error message.

The following list shows an example output where the first two experiments in the POP-file
have been successfully computed, but an equilibrium is not reached for the third
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experiment. No other equilibria are computed, since the calculations are aborted when the
error occurs.

Eq Lab Iter Weight Temp  Exp Fix phases or comments

1 A1   22  1.   2575.3     IONIC_ FLUORI TETR

2 A1   18  1.   2156.9     IONIC_ CORUND TETR

*** ERROR 1614 IN QTHISS

*** CONDITIONS CAN NOT BE FULLFILLED

When this happens, try to find out why the equilibrium calculation fail. Are the condition
start values that you have given the equilibrium inappropriate for example? If you have a
similar equilibrium that has already been successfully computed, then you can select the
equilibrium that does not work, use the ED_EXP command "SET_ALL_START_VALUES" on
page 217 and accept all the suggestions for the site fractions. Alternatively, use
"TRANSFER_START_VALUES" on page 70<equilibrium number> to make the currently
selected equilibrium inherit the start values of the indicated equilibrium. Run "COMPUTE_
EQUILIBRIUM" on page 190 again to see if the equilibrium can be computed with the
inherited start value.

If you cannot find an explanation of why the equilibrium cannot be computed, then it may be
that the experiment is faulty. If so, then this experiment should be excluded from the
optimization by being given a weight of 0. You should then runCOMPUTE_EQUILIBRIUM
again to make sure that all equilibria can be computed. However, experiments that fail to
reach equilibria could succeed in doing so if the optimizing variables have other values. It is
therefore sometimes worth trying to include experiments later in the optimization process
(when the optimizing variables are relatively close to their final values), even if they had to
be excluded at its start. In some cases, it might also be appropriate to change the error
tolerance for in an experiment (using the ED_EXP command "EXPERIMENT" on page 44).

You must save the PARROT workspace with "SAVE_WORKSPACES " on page 54
before you exit the ED_EXP module.

Setting Weights
To change the weight of an experiment, first enter the ED_EXP module from PARROT using
"EDIT_EXPERIMENTS" on page 139. Then use the "SET_WEIGHT" on page 66 command to set
the weight for a specific equilibrium (equilibrium number 3 for example), for a range of
equilibria (the equilibria 10-19) or all the equilibria that have a certain label (such as all the
equilibria with the label A1). To save the new weight(s), use "SAVE_WORKSPACES " on
page 54.
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By default, all the experimental information in your POP-file is treated equally: each
experiment has a weight of 1. However, experiments that you excluded because they did not
reach equilibrium now have a weight of 0. The higher the weight of an experiment is, the
more Thermo-Calc tries to ensure that the computed result fits the condition measured in
that experiment.

The contribution of an experiment’s error to the sum of errors is multiplied by the square of
the weight set for that experiment. In other words, if you want to cut the error of an
experiment with weight 1.0 by half, then you should use a weight of 0.7. This makes the
experiment’s error 0.49. Setting the weight to 1.4 instead makes the error twice as large
(1.96).

Note that if you use "READ_WORKSPACES" on page 214 after you have changed weights on
the experiments, your changes are lost unless you have saved those changes. In the ED_EXP
module, you can get a list of all the experiments in the console if you first read the
experimental data from the workspace file (with READ_WORKSPACES) and then use "LIST_
ALL_EQUILIBRIA" on page 48.

Optimizing and Evaluating Results
When you have ensured that all the experimental data points can reach equilibrium, go back
to the PARROT module and use "OPTIMIZE_VARIABLES" on page 154 <number of
iterations> with 0 iterations. Present the result of this initial optimization by using "LIST_
RESULT" on page 149.

When evaluating the optimization results, the most important information is found in the list
of experiments at the end of the listed results. The rightmost column shows the difference
between the value of the experimental data and the value computed by Thermo-Calc in the
last optimization cycle.

The following shows part of list of experiments in the output of a LIST_RESULT command:

The experiments for which the optimization has not found a good fit are marked with an
asterisk (*) or a hash sign (#) in the rightmost column. An asterisk in this column indicates
that the experiment has an error that is larger than the error tolerance and a hash sign
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indicates that the error is much larger. The error tolerance depends on the degree of
accuracy set for that particular piece of experimental information. The error values are
presented in the next to rightmost column.

Note that if you are optimizing in alternate mode, then you usually do not need to change
the weights for the experiments. Instead, you can simply run OPTIMIZE_VARIABLES again,
specifying, say, thirty iterations, evaluate the results again, and continue in that way until
you are satisfied with the results.

Also see "About Alternate Mode" on page 47. 

The Critical Set of Experiments
The set of weighted experiments that you end up with as a result of your optimization is
referred to as the critical set of experiments. When you work to determine this set and the
weights of the experiments, the following factors should be reflected in both the selection of
experiments and the weights of those experiments:

l The reliability of the experimental technique.

l The extent of agreement/disagreement between independent measurements of the
same quantity.

l The extent of agreement/disagreement between data obtained with different
experimental methods.

Continuing the Optimization and Resetting Variables
To continue the optimization after you have used "OPTIMIZE_VARIABLES" on page 154, you
can either use this command and enter <Number of iterations> again or "CONTINUE_
OPTIMIZATION" on page 138 <Number of iterations>.

If you use "CONTINUE_OPTIMIZATION" on page 138, then PARROT continues the
optimization using the same Hessian matrix. If the optimization is going well but you run out
of iterations, then continuing with the same Hessian matrix may be useful.

As before, use "LIST_RESULT" on page 149 to inspect the fit between the calculated and the
experimental values for your experiments. If necessary, adjust the weights of the
experiments again in the ED_EXP module. You may even discover that you have to exclude
additional experiments from the optimization.

Besides looking at the rightmost column in the list of experiments (that is produced when
you use LIST_RESULT), it is also useful to look at the sum of squares of the errors of all the
variables. This is shown in the output of OPTIMIZE_VARIABLES and CONTINUE_
OPTIMIZATION. This sum should be as low as possible.
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Example Output

The following shows part of the output that you get when using "LIST_RESULT" on page 149:

In the example you can see that the sum of squares have decreased slightly. (The final sum
of squares that you get after an optimization run is also presented directly in the output
from OPTIMIZE_VARIABLES and CONTINUE_OPTIMIZATION.) As long as the sum of squares
figure is decreasing, the optimization is working as it should.

When your calculated results have been improving for a while, that is, when the sum of
squares has been decreasing, and you are confident that you are making definitive progress,
then you should use the PARROT command "RESCALE_VARIABLES" on page 156 to reset the
starting values of the optimizing variables to their current values. When you do this, the start
values and scaling factors of the optimizing variables (shown in the table’s third column in
the preceding screen shot), are all set to the current values (shown in the table’s second
column).

If your optimization is not going well, then you may want to reset the values of your
optimization variables to their current start values. To do this, use "RECOVER_VARIABLES"
on page 155.

After rescaling the variables, continue the optimization using OPTIMIZE_VARIABLES again.
Cycle through calls of the commands OPTIMIZE_VARIABLES/CONTINUE_OPTIMIZATION,
CONTINUE_OPTIMIZATION, RESCALE_VARIABLES and OPTIMIZE_VARIABLES again until your
set of optimizing variables does not seem to improve anymore. Even when it seems to you
that you have reached this point, it is recommended that you use OPTIMIZE_
VARIABLES/CONTINUE_OPTIMIZATION a few extra times to make sure that the variable
values cannot be further improved, that is, that the sum of squares of the errors of all the
variables cannot be reduced further. If the final solution is repeatedly calculated after the
same number of iterations and reaching the same result, then it is generally reasonable to
accept the current variable values.
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Updating the Set of Optimizing Variables
Besides evaluating the fit between the calculated results and the experimental data, you
should also ensure that you have the right number of optimizing variables. If you have too
many or too few optimizing variables, then you may not be able to use your model to
accurately extrapolate thermodynamic properties in a wide range of temperature, pressure
and composition conditions.

With more optimization parameters, the sum of errors usually decrease, but the parameters
also tend to become less precisely determined. A measure of this precision is the Relative
Standard Deviation (RSD) of each optimizing variable. However, the RSD is only significant if
you have used "RESCALE_VARIABLES" on page 156 followed by an optimization which
converges and the values of the variables do not change much. The RSD tells you how much
the parameter can be changed in either a positive or in a negative direction without
changing the reduced sum of errors with more than one unit.

Example

A large RSD value thus means that the parameter has not been determined well.

If such a significant RSD has a value larger than 1, then this typically means that you are
using too many optimizing variables. However, the RSD values also depend on the weighting
of the experiments, so it is sometimes possible to reduce the RSD by changing weights.

The RSD should not be too low either. If one or more of them is very close to 0, then this
suggests that you are trying to optimize the system with too few optimizing variables. You
can add optimizing variables interactively using "ENTER_PARAMETER" on page 143 in
GIBBS. However, it is recommended that you add a sufficient number of variables in the
setup file from the start so that do not need to do this. You can fix variables to a value of 0
until you discover that they are needed.
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Besides the RSD, you should also keep an eye on the variable values themselves (shown in
the VALUE column, next to the leftmost column in the table shown in the preceding
screenshot). If the value of a variable is in the order of 1E5 or higher and this variable has
been put in the temperature-independent part of an interaction parameter’s Gibbs energy
expression, then you may not have the right weights on your experiments or you are using
too many optimizing variables. This is also typically the case if a variable with a value in the
order of 10 or more (per mole atoms) is in the temperature-dependent part of the Gibbs
energy expression of an interaction parameter. Such a high parameter value may lead to
inverted miscibility gaps or re-stabilisation of a phase at high temperature. It is important to
keep an eye on this since the temperature-independent and the temperature-dependent
interaction parameter often varies together. If the temperature-dependent interaction
parameter cannot be reliably determined, you may have to fix its value.

Note that even if you have found a good enough fit between calculated and experimental
values after an optimization run, a parameter value may suddenly start to change by several
orders of magnitude when you use "OPTIMIZE_VARIABLES" on page 154 is used again. If this
happens, then careful reconsideration of the weighting of the experiments of the set of
optimizing variables is required. However, when the optimization has converged and the
parameter values remain stable after repeated use of OPTIMZE_VARIALBES, this should
usually not happen.

Reducing the Number of Optimizing Variables
If you have one or more optimizing variables with RSD larger than 1, then you should
remove one or more of the variables by setting them to a value of 0, or alternately, set them
to a reliably estimated value (estimated based on, for example, semi-empirical methods).

To fix an optimizing variable to certain value, use the PARROT command "SET_FIX_
VARIABLE" on page 158 <variable number> <value>.

Plotting Intermediate Results
It is typically not sufficient to look at the plain text output of "LIST_RESULT" on page 149 to
reliably judge how the optimization is progressing. Plotting a phase or property diagram of
the system you are optimizing using the POLY and POST modules is often very useful.

It is recommended that you create a macro file for plotting the diagram since you probably
want to repeatedly plot the diagram as you progress with the optimization. This macro file
can then be called directly from the PARROT module with the "MACRO_FILE_OPEN" on
page 5 command.

Superimposing Experimental Data from EXP-files

If you create one or several EXP-files based on the experiments in your POP-file, you can
visually compare the fit your plot and the experimental data you are optimizing the system
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against. An EXP-file contains data points specified in the DATAPLOT format. You could make
an EXP-file for each type of data that you are using in the optimization.

Use the POST command "APPEND_EXPERIMENTAL_DATA" on page 245 to superimpose the
data points in an EXP-file on a phase or property diagram that you have plotted. For
example, to put the experimental data points from a file entitled DP.EXP onto a plotted
diagram, you could enter the following:

APPEND_EXPERIMENTAL_DATA Y DP.EXP 0 1

Such a command call tells Thermo-Calc to superimpose the data points in dataset 1 of
DP.EXP onto the plot in the Console Results window, but not to impose any information about
axis scaling, labels and other information which is normally found in the prologue of the
DP.EXP file.

The POST command "QUICK_EXPERIMENTAL_PLOT" on page 254 can also be used to
superimpose data points on a plotted phase or property diagram.

Also see the DATPLOT User Guide included with this documentation set.



Thermo-Calc Documentation Set

Finalizing the Optimization ǀ 43 of 72

Finalizing the Optimization
In this section:

Finishing the Optimization 44

Rounding off Optimizing Variable Values 44

Updating the Database File 44

Creating a Database File 45

Updating the Setup File and the POP-file 45



Thermo-Calc Documentation Set

Finalizing the Optimization ǀ 44 of 72

Finishing the Optimization
When to stop optimizing is a matter of judgement. It is rarely the case that you finish
optimizing a system with the feeling that it cannot be improved.

The final step is to update your files with the final results. Besides updating your database
file (or alternatively, creating a new database file), it is advised that you also update your
setup and POP-files with the final weights and optimizing variable values.

Rounding off Optimizing Variable Values
When you save the optimizing variable values, it is important that you round off the values
correctly. When you have a metallic system, it is usually best to keep whatever number of
decimal digits that you need to make less than one J/mol difference at 1000 K. When you
have an aqueous system or a system that you are optimizing based on data from very
different temperature ranges, then this is not always the only appropriate guideline.
However, rounding off the values in such a way that it gives a difference that is larger than
one J/mol may lead to differences in the phase diagram.

Another approach you can take when rounding off variable values is by progressively fixing
the value of more and more of the variables. This allows you to round-off all but one of the
variables values so that each only has a few significant digits. Variables whose values have
been rounded off in this way are easier to handle compared with those that that are
rounded off so that they continue to have many significant (non-zero) digits.

To round off the variable values according to this second approach, first use "SET_FIX_
VARIABLE" on page 158 to set the variable(s) with the highest RSD to a rounded off value
(such as, say, 0.4). When you then re-optimize using "OPTIMIZE_VARIABLES" on page 154,
the sum or errors changes. However, you should get almost exactly the same sum of errors
as before after you rescale the variable values using "RESCALE_VARIABLES" on page 156. (If
the sum of errors is different, then this means that the variable with the highest RSD was not
rounded off in a good way.) If you successfully round off the first variable value, then
continue to round of the optimizing variable which now has the highest RSD. Continue doing
this until you have fixed all but one of the optimizing variables to their rounded-off values.
The final sum of errors that you get after having fixed the variable values should not deviate
significantly from the initial sum of errors you had before starting to round-off the variable
values.

Updating the Database File
To update the database file (with filename extension TDB) open it in a text editor and enter
or update each of the parameters that you have optimized.

For example, suppose you have the following command in your setup file:

ENTER_PARAMETER L(IONIC_LIQ,AL+3,ZR+4:O-2;0) 298.15 +V17; 6000 N
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If you then end up with a value for optimizing variable V17 of -100000, then you should enter
the following under the IONIC_LIQ phase in the database file:

PARAM L(IONIC_LIQ,AL+3,ZR+4:O-2;0) 298.15 -100000; 6000 N REF !

If you often need to round-off the optimizing variable value in some way, see
"Rounding off Optimizing Variable Values" on the previous page.

When you have updated or entered the parameters that you optimized, save the database
file.

Creating a Database File
In some circumstances you may want to save all the information about your system into a
new database file. To do this, go to the GIBBS module and use LIST_DATA <Filename> N.
This creates a new user database file that contains all the information about the system that
is in the workspace.

The N-argument tells the "LIST_DATA" on page 120 command to save the output into
database file rather than some other type of file, such as a macro file for example. Note that
the output database file that you get from LIST_DATA have to undergo some manual editing
before it can be used as proper database file.

Updating the Setup File and the POP-file
It may be useful for you to be able to recreate your optimization from scratch. It is therefore
recommended that you do the following when you are done with the optimization:

l Update your POP-file so that it contains the weights of your critical set of
experiments. Use "SET_WEIGHT" on page 66 to set the weights directly in the POP-
file. You may also have to use "SET_START_VALUE" on page 226 for some conditions
in the POP-file. Otherwise, you may not be able to compute the equilibria with
"COMPUTE_ALL_EQUILIBRIA" on page 37.

l Copy the final values of your optimizing variables and set them as start values of the
variables in the setup macro file (with "SET_FIX_VARIABLE" on page 158).

It is important that you round off the values of the optimizing variables
correctly. See "Rounding off Optimizing Variable Values" on the previous page.
When you have done this, you can run the setup macro file to recreate the final
result of the optimization.
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About Alternate Mode
To turn Alternate Mode ON or OFF, use the PARROT command "SET_ALTERNATE_MODE" on
page 156.

When you have one or more multi-phase equilibria (that is, with the fixed phase-status) in
your POP-file and the optimizing values lack appropriate starting values (such as the default
value of 0 for example), then Thermo-Calc may not be able to compute the equilibria for the
experiments. In these cases, a common tangent cannot be found, that is, a state where the
chemical potentials for all components are the same in all phases cannot be found. A
common tangent may not exist or it be found at the wrong composition or temperature
given the initial set of model parameters.

If you are not able to estimate reasonable starting values for the optimizing variables, then
this problem can be overcome by initially running your optimization in alternate mode. The
alternate mode in PARROT module should help you find reasonable starting values for the
optimizing variables. Note that you are only supposed to use alternate mode in the
beginning of the optimization. Once you have achieved a reasonable fit between calculated
results and experimental data, turn off alternate mode and calculate all equilibria again in
the normal mode.

In alternate mode, PARROT modifies multi-phase equilibria so that the chemical potentials
for each stable phases is calculated separately. For example, consider the following
experimental equilibrium:

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQ FCC=FIX 1

SET_CONDITION T=1000 P=1E5

EXPERIMENT X(LIQ,B)=.2:.01 X(FCC,B)=.1

When PARROT optimizes in alternate mode, the computation of this equilibrium is done by
way of the following two calculations:

CHANGE_STATUS PHASE LIQ=FIX 1

SET_CONDITION T=1000 P=1E5 X(LIQ,B)=.2

CHANGE_STATUS PHASE FCC=FIX 1

SET_CONDITION T=1000 P=1E5 X(FCC,B)=.1

The difference between the chemical potentials in every pair of phases is calculated and
PARROT tries to adjust the parameters of the phases so that these differences are
minimized. In other words, PARROT tries to make the chemical potentials equal in all
phases. For PARROT to be able to do this, some additional information about the
experimental multi-phase equilibria is required, at least for all invariant equilibria.
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Optimizing in Alternate Mode
When you are optimizing in the alternate mode, you usually do not need to enter the ED_
EXP module and manually change the weights of experiments that the computed results
have not been fitted well with. Instead, after using "OPTIMIZE_VARIABLES" on page 154
initially with no iterations, and listing the result with "LIST_RESULT" on page 149, simply run
OPTIMIZE_VARIABLES again specifying, say, thirty iterations. Continue to optimize until your
optimization seems to be going in the right direction, then set the optimizing variables’
starting values to their current values use "RESCALE_VARIABLES" on page 156 before you
turn alternate mode off by answering N at the "SET_ALTERNATE_MODE" on page 156
prompt.

Preparing the POP-file for Alternate Mode
Information in your POP-file that concerns equilibria with ENTERED or DORMANT phases is
ignored when you optimize in alternate mode.

To use the alternate mode, ensure that there is enough information about each phase in a
given equilibrium. In addition to the temperature and pressure of the system, you should
specify the composition of all phases in a given equilibrium. This is done with, "SET_
CONDITION" on page 220, "EXPERIMENT" on page 44or "SET_ALTERNATE_CONDITION" on
page 57.

If both compositions of a binary tie-line have been measured, then you could specify this in
the POP-file in the following way:

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC BCC=FIX 1

SET_CONDITION P=1E5 T=1000

EXPERIMENT X(BCC,B)=.2:.01 X(FCC,B)=.3:.01

This equilibrium could be calculated with alternate mode without any modification. The
compositions specified with the experiment command is used as condition when the
thermodynamic properties of each phase are calculated.

Examples of SET_ALTERNATE_CONDITION
The following topics demonstrate how "SET_ALTERNATE_CONDITION" on page 57 is used to
prepare different kinds of equilibria for optimization in alternate mode.

Specifying the Composition of One Side of a Binary Tie-Line

If only one side of the tie-line has been measured, then you must provide an estimate of the
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composition of the other phase. You can make such an estimate with SET_ALTERNATE_
CONDITION. This command has no effect unless alternate mode is turned on. The
equilibrium described could thus be specified in the following way:

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC BCC=FIX 1

SET_CONDITION P=1E5 T=1000

EXPERIMENT X(BCC,B)=.2:.01

SET_ALTERNATE_CONDITION X(FCC,B)=.3

When the alternate mode is turned on, the composition given by the SET_ALTERNATE_
CONDITION command is used for the FCC phase. The properties of the BCC phase is
calculated using the composition specified by experiment as a condition.

Specifying the Compositions of a Three-Phase Equilibrium

If you have a three-phase equilibrium in your POP-file, then one of its compositions can be
specified as experimentally determined, while two can be provided as alternate conditions:

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1

SET_CONDITION P=1E5

EXPERIMENT T=912:5 X(LIQ,B)=0.2:.02

SET_ALTERNATE_CONDITION X(FCC,B)=0.1 X(BCC,B)=.4

Specifying the Composition of a Stoichiometric Phase

When you specify the composition of stoichiometric phase with SET_ALTERNATE_
CONDITION, the value must be given with at least seven decimal digits, as in the following
example:

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQ A2B=FIX 1

SET_CONDITION P=1E5 X(LIQ,B)=0.2

EXPERIMENT T=992:5

SET_ALTERNATE_CONDITION X(A2B,B)=.6666667

Entering Other Experiments in the POP with Alternate Mode
The following table shows some additional examples of how to enter different kinds of
experiments in the POP-file when you are using the alternate mode.
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Example ED_EXP commands

Two-phase equilibrium:
The melting
temperature of an Au-
Cu alloy

CHANGE_STATUS PHASE LIQUID FCC=FIX 1 SET_CONDITION X
(FCC,CU)=0.14 P=1E5 EXPERIMENT T=970:2 SET_ALTERNATE_
CONDITION X(LIQUID,CU)=0.16

Invariant equilibrium
experiment: A three-
phase equilibrium in a
binary system

CREATE_NEW_EQUILIBRIUM 1 1 CHANGE_STATUS PHASE FCC
BCC LIQUID=FIX 1 SET_CONDITION P=1E5

EXPERIMENT T=912:5 SET_ALTERNATE_CONDITION X
(FCC,B)=0.1SET_ALTERNATE_CONDITION X(BCC,B)=0.4SET_
ALTERNATE_CONDITION X(LIQ,B)=0.2

Ternary system, with
two compositions
measured (both with
uncertainty 0.02)

CREATE_NEW_EQUILIBRUM 1 1 CHANGE_STATUS PHASE FCC
BCC=FIX 1 SET_CONDITION T=1273 P=1E5 SET_CONDITION X
(FCC,B)=0.1:0.02 EXPERIMENT X(FCC,C)=0.12:.02 SET_
ALTERNATE_CONDITION X(BCC,B)=0.17 SET_ALTERNATE_
CONDITION X(BCC,C)=0.07



Thermo-Calc Documentation Set

Troubleshooting ǀ 51 of 72

Troubleshooting
During an optimization, you are likely to run into many different problems and challenges.
This topic gives some general guidelines that can help avoid common mistakes and
problems.

In this section:

Useful Guidelines 52

Excluding and Including the Correct Equilibria 53

Conflicting Data 53
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Useful Guidelines
The following rules of thumb are generally good to adhere to when you are planning and
executing an optimization:

l Do not use data from thermochemical tables of unknown origin.

l Use experimentally determined properties; avoid converted quantities.

l Carefully estimate the accuracy of the experiments.

l Correct systematic errors (by adjusting a temperature scale for example).

l Use negative information such as, for example, the information that a phase should
not be stable in a composition or temperature region.

l With a hundred activity measurements in a system but only ten composition points
from the phase diagram, it is often appropriate to decrease the weights on the
activity experiments.

l If you initially exclude any intermediate phases to only optimize the liquid and the
terminal or end-member phases for the pure components, then it is often useful to
compute a metastable phase diagram with just these phases.  In the metastable
phase diagram, the metastable solubility lines should not have any strange kinks or
turns. Such a diagram is often also useful to compute at later stages in the
optimization.

l When you have fitted the liquid phase and some solution phases reasonably well,
then you can fix the optimizing variables that characterise these phases. You can
then go on and optimize the variables for the intermediate phases.

l Phases with miscibility gaps are always difficult to optimize. Try to keep control of
the miscibility gaps by using real or estimated experimental information. (Note that
it is not possible to calculate the top of a miscibility gap as a single equilibrium.)

l Phases with order/disorder transformation are often difficult to optimize. It may be
difficult to find the right start values on the optimizing variables. The TABULATION
module (see "TABULATION_REACTION Commands" on page 306) can be useful
sometimes. Properties for specified site fractions can be calculated in the
TABULATION module. This is not possible in the POLY module since this module only
calculates for equilibrium site fractions. The ordered state may also disappear during
the optimization of these phases. If this happens, you may be able to add an
experiment that controls the state of order.

l Only use the alternate mode to find an initial set of model parameters that can then
be make it possible to calculate the experimental equilibria in the normal mode.

l When you have achieved a satisfactory fit between calculated results and
experimental data with an appropriate number of optimization variables, perform a
couple of final optimization runs to make sure that your results are stable.
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l Make sure that the values of the optimizing variables keep within a reasonable
range. If a variable starts to change several orders of magnitudes, then you must
consider whether you have the right weights on the experiments and whether you
are using too many optimizing variables.

Excluding and Including the Correct Equilibria
Use as few experiments as possible initially to get a reasonable overall fit. It is generally
best to first focus on the invariant equilibria, as well as metastable states that can be
estimated by excluding some phases. Crucially, any experiments for which the computed
results are clearly faulty should be excluded from the final critical set, while all important
invariant equilibria are calculated and included in this critical set.

If you cannot compute some invariant equilibria with intermediate phases, then it may be
best to first exclude those phases from the optimization and only optimize the liquid and the
most important solution phases. After you have obtained reasonable results for these
phases, you can enter the intermediate phases back in again. With the variables for the
optimized liquid and solid phases set fixed, you can finally optimize the intermediate phases.

Conflicting Data
It is important that you do not include conflicting sets of data at the same time during an
optimization. After all, if they are genuinely conflicting, then at least one of the sets must be
incorrect. If you have conflicting sets of data, then only use one of these sets at a time
together with the rest of the data. Often, the optimization makes it clear which dataset
coheres best with the other information that is available about the system.

Sometimes, conflicting data cannot be detected directly. For example, you may have activity
data which is inconsistent with solubility data from the phase diagram. This would be
indicated by large errors in the fit when both the activity data and the solubility data are
included. To find these inconsistencies, let alone correct the errors, you may thus have to
optimize with some datasets excluded.
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Experiments and Experimental Data
These topics contain examples of different kinds of equilibria in different kinds of systems.
They are intended to help you figure out how to use various kinds of experimental data when
creating POP-files. The topics that follow contain examples how to enter various kinds of
experimental data into a POP-file.

In this section:

Phase Diagram Data 55

Data for Individual Compounds 56

Single Phase Mixing Enthalpies or Partial Enthalpies 58

Enthalpies of Formation and Enthalpies of Reactions 58

Chemical Potentials via EMF Measurements 59

Driving Force for Metastable Phases 60

Pressure-Temperature-Volume EOS Data 60

Crystal Structure, Lattice Parameters and Site-Occupancy 61

Magnetism and Other Atomistic Properties 62

Data About Systems of Different Orders 62
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Phase Diagram Data
P-T-X phase diagram data for binary and ternary systems, or systems of even higher order
can be used in the POP-file. This includes data of the following types:

l Data about the temperature- and composition-dependence of various properties
(obtained from differential thermal analysis (DTA) measurements for example),
including enthalpy, lattice parameter, dilatometric length, electronic conductivity
and magnetic susceptibility;

l Data about reaction types (invariant/monovariant) and phase relations obtained
from qualitative or quantitative metallographic studies;

l Data about phase amounts or compositions obtained from microprobe
measurements (using X-ray spectroscopy or transmission electron microscopy
(TEM));

l Data about the positions or directions of two-phase tie-lines and three-phase
equilibria for ternary systems.

Example

The following table shows a POP-file excerpt that demonstrates how some kinds of phase
diagram data can be entered:

Example ED_EXP commands

Solidus (melting
temperature) of an Au-
Cu alloy

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID FCC=FIX 1

SET_CONDITION X(FCC,CU)=0.14 P=1E5

EXPERIMENT T=970:2

Three-phase
equilibrium in a binary
A-B system

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1

SET_CONDITION P=1E5

EXPERIMENT T=912:5

Congruent
transformation in a
binary A-B system

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE BCC LIQUID=FIX 1

SET_CONDITION P=1E5 X(BCC,B)-X(LIQ,B)=0

EXPERIMENT T=1213:10
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Example ED_EXP commands

Tie-line in a ternary A-
B-C system

An uncertainty factor is set not only for the experimental
measurement, but also for the X(FCC,B) condition. The factor is
0.02.

CREATE_NEW_EQUILIBRUM 1 1

CHANGE_STATUS PHASE FCC BCC=FIX 1

SET_CONDITION T=1273 P=1E5 X(FCC,B)=0.1:0.02

EXPERIMENT X(FCC,C)=0.12:.02

Data for Individual Compounds
You can use data about individual components in the POP-file. Such data includes activity,
heat capacity, heat content, entropy, Gibbs energy of phase transformations, heat of
transition and heat of melting.

Examples

Example ED_EXP commands

Carbon activity data in the
fcc phase

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1=FIX 1

CHANGE_STATUS PHASE GRAPHITE=D

SET_REFERENCE_STATE C GRAPHITE,,,,

SET_CONDITION P=101325 T=1273 X(MN)=0.03

SET_CONDITION X(C)=0.03

EXPERIMENT ACR(C)=0.29:5%

Ln(activity coefficient for O)

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE IONIC_LIQ=FIX 1

CHANGE_STATUS PHASE GAS=D

SET_CONDITION X(O)=0.02 T=1523 P=101325

SET_REFERENCE_STATE O GAS,,,,

ENTER_SYMBOL FUNCTION LNFO=LOG(ACR(O)/X(O));

EXPERIMENT LNFO=-1.5:0.01
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Example ED_EXP commands

Entropy at 298.15 K of
Cu2O

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE CU2O=FIX 1

CHANGE_STATUS PHASE CUO=FIX 0

SET_CONDITION P=101325 T=298.15

EXPERIMENT S=92.36:1

Gibbs energy of formation
of NiAl2O4

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

CHANGE_STATUS PHASE FCC O2GAS=DORM

SET_REFERENCE_STATE NI FCC,,,,

SET_REFERENCE_STATE AL FCC,,,,

SET_REFERENCE_STATE O O2GAS,,,,

SET_CONDITION P=101325 T=1000 N(NI)=1 N(AL)=2

SET_CONDITION N(O)=4

EXPERIMENT GM=-298911:5%

Heat capacity of MgFe2O4

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 N(FE)=2 N(MG)=1 N(O)=4

SET_CONDITION T=800

ENTER_SYMBOL FUNCTION CP=H.T;

EXPERIMENT CP=207:5%

Heat content (H-H298) for
MnFe2O4

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 T=298.15 N(MN)=1 N(FE)=2

SET_CONDITION N(O)=4

ENTER_SYMBOL VAR H298=H;

ENTER_SYMBOL FUN HMNFE2O4=H-H298;

CREATE_NEW_EQUILIBRIUM 2 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 N(MN)=1 N(FE)=2 N(O)=4
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Example ED_EXP commands

SET_CONDITION T=400

EXPERIMENT HMNFE2O4=16610:5%

Single Phase Mixing Enthalpies or Partial Enthalpies
You can use calorimetric data for mixing in the POP-file. This data could be the result of, for
example, drop calorimetry or scanning calorimetry. This includes data about, for example,
enthalpy of mixing of liquids, series of mixing-enthalpy and about partial enthalpy.
Information about enthalpies of mixing can also be derived from theoretical principles using
special quasi-random structures (SQSs).

Example

Example ED_EXP commands

Enthalpy of mixing in the
liquid state of an Au-Cu
alloy

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID=FIX 1

SET_CONDITION T=1379 P=1E5

SET_CONDITION X(LIQUID,AU)=0.0563

SET_REFERENCE_STATE AU LIQ * 1E5

SET_REFERENCE_STATE CU LIQ * 1E5

EXPERIMENT HMR=-1520:200

Enthalpies of Formation and Enthalpies of Reactions
You can use calorimetric data for phase transformations in the POP-file. This data could be
the result of, for example, direct-reaction calorimetry, solution calorimetry or combustion
calorimetry. Information about enthalpies of formation can also be derived from theoretical
principles.
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Examples

Example ED_EXP commands

Enthalpy of melting of the
eutectic in the Al2O3-ZrO2
binary (J/g)

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE CORUNDUM ZRO2_TETR=FIX 0

CHANGE_STATUS PHASE IONIC_LIQ=ENT 1

SET_CONDITION P=101325 N=1 LNAC(O)=-80

SET_REFERENCE_STATE ZRO2 TETR,,,,,,

SET_REFERENCE_STATE AL2O3 CORUND,,,,,,

EXPERIMENT HWR=1080:90

Enthalpy of formation of o-
CaZrO3 from the
component oxides

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE ZRO2_MONO HALITE CAZRO3_
O=ENT 1

SET_CONDITION T=298.15 P=101325 N(CAO)=.5

SET_CONDITION N(ZRO2)=.5 LNAC(O)=-20

SET_REFERENCE_STATE CAO HALITE,,,,

SET_REFERENCE_STATE ZRO2 ZRO2_MONO,,,,

EXPERIMENT HMR(CAZRO3_O)=-15960:5%

Chemical Potentials via EMF Measurements
You can use chemical potentials and activities/activity coefficients from electromagnetic
field (EMF) measurements in the POP-file.
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Example

Example ED_EXP commands

Emf data on Cu
(s)/Cu2O(s)

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC CU2O=FIX 1

CHANGE_STATUS PHASE O2GAS=DORM

SET_CONDITION P=101325 T=1000

SET_REFERENCE_STATE O O2GAS,, 100000

EXPERIMENT MUR(O)=-95387:1000

Driving Force for Metastable Phases
You can use chemical driving forces for metastable phases in the POP-file.

Examples

Example ED_EXP commands

To prevent BCC_A2 to be stable

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1 M7C3 M23C6=FIX
1

CHANGE_STATUS PHASE BCC_A2=D

SET_CONDITION P=101325 T=1473

EXPERIMENT DGM(BCC)<-0.1:0.1

To promote CEMENTITE to be
stable

CHANGE_STATUS PHASE BCC M7C3 GRAPHITE=FIX
1

CHANGE_STATUS PHASE CEMENTITE=DORMANT

SET_CONDITION P=P0 T=973

EXPERIMENT DGM(CEM)>0.1:0.01

Pressure-Temperature-Volume EOS Data
You can use Pressure-Temperature-Volume Equation of State (EOS) data in the POP-file.
Such data includes, for example, molar volume, density, thermal expansion and bulk-
modulus/compressibility.
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Examples

Example ED_EXP commands

Volume of liquid Pt

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE LIQUID=ENT 1

SET_CONDITION P=101325 N=1 T=1873

EXPERIMENT VM=1.00758E-5:5%

Thermal expansion

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1=ENT 1

SET_CONDITION P=101325 N=1 T=400

ENTER_SYMBOL FUNCTION ALPHA=VM.T/VM/3;

EXPERIMENT ALPHA=2.35E-5:5%

Crystal Structure, Lattice Parameters and Site-
Occupancy
You use information about defects, ordering or site occupancy, as well as information about
crystal structures in the form of lattice parameter values. This information may come from
measurements made by X-ray, neutron diffraction, Mössbauer spectroscopy or perturbed
angular-correlation.

Examples

Example ED_EXP commands

Lattice parameter for
fcc

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE FCC_A1=ENT 1

SET_CONDITION P=101325 N=1 T=298.15

SET_CONDITION X(CR)=0.05

ENTER_SYMBOL FUNCTION LPFCC=((4*VM/6.02214179E23)**
(1/3))*1E10;

EXPERIMENT LPFCC=4.02:5%

Lattice parameter for
bcc

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE BCC_A2=ENT 1
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Example ED_EXP commands

SET_CONDITION P=101325 N=1 T=298.15

SET_CONDITION X(AL)=0.08

ENTER_SYMBOL FUNCTION LPBCC=((2*VM/6.02214179E23)**
(1/3))*1E10;

EXPERIMENT LPBCC=2.90:5%

Site-occupancy, degree
of inversion for spinel

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION P=101325 N(MG)=1 N(AL)=2 N(O)=4

SET_CONDITION T=1073

EXPERIMENT Y(SPINEL,AL+3#1)=0.31:5%

Magnetism and Other Atomistic Properties
You can use data about atomistic properties such as magnetism and Curie temperatures in
the POP-file.

Example

Example ED_EXP commands

Curie temperature
of MnxFe3-xO4,
x=1.26

CREATE_NEW_EQUILIBRIUM 1 1

CHANGE_STATUS PHASE SPINEL=ENT 1

SET_CONDITION T=520 P=101325 N(O)=4

SET_CONDITION N(FE)+N(MN)=3 N(MN)=1.26

EXPERIMENT TC(SPINEL)=520:5

Data About Systems of Different Orders
You might want to use data about systems of different orders in the same optimization, such
as data about a binary equilibrium with components A and B in a ternary system with
components A, B and C, together with data about equilibria in the binary system with
components A and B. To do this, you must first suspend all components in the ternary system
(A, B and C), and then set the two components you want binary information on (A and B) to
status ENTERED.

Suspending all components is done by giving the initialization code 0 to the "CREATE_NEW_
EQUILIBRIUM" on page 195 command. The components about which you want to use binary
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information must then be entered again using the "CHANGE_STATUS" on page 100
command.

Example

Example ED_EXP commands

A binary (A-B) three-phase
equilibrium (FCC-BCC-LIQ) in a
ternary system (A-B-C)

CREATE_NEW_EQUILIBRIUM 1 0

CHANGE_STATUS COMPONENT A B = ENTERED

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1

SET_CONDITION P=1E5

EXPERIMENT T=1177:10
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Thermodynamic Models
The most common models used in assessments are described briefly in these topics.
Examples of how to write the phase definitions in the setup-file are also given for each of
these models. In addition to the models described here, a large number of thermodynamic
models for various phases in different states have been implemented.

In this section:

Gas 65

Compound Energy Formalism 65

Substitutional Liquid 66

Ionic Two-Sublattice Liquid Model 66

Models for Ordered Phases 67

4SL Model for FCC, HCP and BCC 68

2SL Model for FCC, HCP and BCC 69

Magnetic Ordering 70

Molar Volumes and High Pressure 70

Excess Models 71
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Gas
The gaseous mixture phase is usually treated as a substitutional phase without sublattice. In
the gaseous mixture phase, there are usually molecules formed, and the number of
constituents of the gas phase is often much larger than the number of elements. These
complex constituents have to be defined as species. The ideal gas model may handle a gas
phase under low pressures (and low temperatures). This implies that the P-V-T relations and
thermodynamic properties of pure gaseous species are calculated as for ideal gas, and that
there is interaction between gaseous species in the mixture. In a defined system, there may
only exist one gaseous mixture phase. Type code G is used for the gas phase:

ENTER_PHASE GAS G, 1 H,H1O1,H1O2,H2,H2O1,H2O2,O,O2,O3; N N

Compound Energy Formalism
If the atoms are sufficiently different in size, electronegativity or charge, they may prefer
different types of sites in the lattice of crystalline solids. In some cases, a solute atom may
even occupy interstitial sites between the normal lattice sites. All such phenomena are
treated in Thermo-Calc by the sublattice concept. The Compound Energy Formalism (CEF)
has proved to be the most general formalism for many different types of solution phases. It
is therefore by default applied to various solid solution phases in the Thermo-Calc software
package. CEF can also take ionic constraints (charged cation/anion species) into account. For
a comprehensive description on the CEF, please see Hillert (2001), Frisk and Selleby (2001),
Sundman and Ågren (1981).

Since the CEF is used by default, no special notation is needed in the phase definition, except
for ionic phases, where type code I is given.
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Examples

Examples of phase definitions in a setup-file using the CEF:

ENTER_PHASE SPINEL I, 4 1 2 2 4

FE+2,FE+3; FE+2,FE+3,VA; FE+2,VA; O-2; N N

ENTER_PHASE SIGMA, 3 10 4 16

AL,CO,CR,FE,NB; AL,CO,CR,FE,NB; AL,CO,CR,FE,NB; N N

ENTER_PHASE FCC_A1, 2 1 1

CR,FE,MN; C,N,VA; N N

ENTER_PHASE BCC_A2, 2 1 3

CR,FE,MN,VA; C,N,VA; N N

Substitutional Liquid
The liquid phase is normally (but not always) modelled as a substitutional phase with no
sublattice, which is occupied by two or more constituents. The constituents are normally the
elements, but molecules or associates can also be used. Type code L is used for the liquid
phase.

Example

ENTER_PHASE LIQUID L, 1  

AL,C,CR,FE,MO,NI,SI ; N N

ENTER_PHASE LIQUID L, 1  

C,FE,FEO,FEO3/2,NI,NIO ; N N

Ionic Two-Sublattice Liquid Model
Within the framework of the CEF, the ionic two-sublattice liquid (I2SL) model was developed
to be used when there is a tendency for ionization in the liquid, which happens in liquid
oxides and sulphides for example. The same model can be used both for metallic and oxide
melts. At low levels of oxygen, the model becomes equivalent to a substitutional solution
model between metallic atoms. Two sublattices are assumed, one containing charged
cations and one containing charged anions, neutrals and vacancies. The complication for an
ionic liquid is that the numbers of sites on the cation sublattice and anion sublattice vary
with the composition to preserve electroneutrality. For a comprehensive description on the
I2SL model, see Hillert et al. (1985), Sundman (1991). In these references, the possible
excess parameters are also discussed. Type code Y is used for the I2SL model.
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Example

Examples of phase definitions in a setup-file:

ENTER_PHASE LIQUID Y,

AL+3,CR+2,FE+2,NI+2; VA; N N

ENTER_PHASE IONIC_LIQ Y,

CA+2,MG+2; O-2; N N

ENTER_PHASE IONIC_LIQ Y,

AL+3,CA+2,FE+2,MG+2,SI+4;

ALO2-1,O-2,SIO4-4,VA,FEO3/2,SIO2; N N

Models for Ordered Phases
Some solution phases have chemical order-disorder transformations: for example, the
disordered FCC_A1 phase can transform to the ordered L12 or L10 structure where the
atoms of different kinds occupy different sublattices. In some cases, it may be advantageous
and easy to describe such ordered structures as completely different phases; but in some
other cases, like the B2-ordered BCC structure in Al-Fe, the disordered and ordered
structures must be described as one singe phase because the transformation is of second
order along a line in temperature and composition.

The ordering can easily be described by the CEF. For instance, an ordered FCC phase with
only L12 or L10 ordering can be efficiently handled by the so-called Two Substitutional-
Sublattice Ordering Model (2SL model), while an ordered FCC with both L12 and L10
ordering must be described with four sublattices using the so-called Four Substitutional-
Sublattice Ordering Model (4SL model). Please note that in both these models, all the
substitutional constituents must enter into these sublattices. In addition, you may also have
one sublattice for interstitials.

Thermo-Calc supports a feature of splitting the parameters of a chemically ordered phase
onto two different phase descriptions. This is very convenient. In this way, you can have one
phase for all parameters describing the disordered state (the configuration independent
state) and in the other phase only those parameters needed to describe the remaining part
(the configuration dependent part), that is, the Gibbs energy contribution due to the
ordering transformation. This has been implemented in such a way that the contribution
from the configuration dependent part is zero when the solution phase is disordered. The
optimization of the disordered phase is independent of the order-disorder transformation;
the ordering energy is an add-on to the disordered part. This is particularly useful in higher
order systems, as an ordered phase can dissolve several elements that have no particular
contribution to the actual ordering. The phases Gibbs energy add together by giving this
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command in the setup-file: "AMEND_PHASE_DESCRIPTION" on page 93 <ordered phase>
disordered_part <disordered phase>

Since PARROT does not automatically create new composition sets, it is necessary to create
composition sets for both the ordered and disordered phases in the setup-file: Amend_
phase_description <phase> composition_sets <new highest set number>,,,,

Example

Example of phase definitions for the corresponding disordered and ordered parts in a setup-
file:

ENTER_PHASE FCC_A1, 2 1 1

AL,CR,FE,NI; VA; N N

ENTER_PHASE FCC_L12, 3 .75 .25 1

AL,CR,FE,NI ; AL,CR,FE,NI; VA; N N

AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART FCC_A1

4SL Model for FCC, HCP and BCC
Ordered FCC, HCP and BCC solution phases handled by the 4SL model requires four
sublattices for substitutional ordering and can additionally have an interstitial sublattice. A
4SL model is especially useful for modelling different kinds of ordered phases that are based
on the same disordered phase, such as L10 and L12 based on FCC_A1, and B2, D03, L21 and
B32 based on BCC_A2 etc.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners
of the regular tetrahedron on these lattices, all of which are the nearest neighbours. These
corners are equivalent lattice points, thus all G parameters for each end-member with the
same elements, but distributed on different sites, must be identical. It should be emphasized
that the end-member energy here represents the ordering energy rather than the formation
energy of the compound.

The constraints on the parameters in the 4SL model can be derived based on the symmetry
of the lattice:

GA:B:B:B=GB:A:B:B=GB:B:A:B=GB:B:B:A

GA:A:B:B=GA:B:A:B=GA:B:B:A=GB:A:A:B=GB:A:B:A=GB:B:A:A

GB:A:A:A=GA:B:A:A=GA:A:B:A=GA:A:A:B

LA,B:*:*:*=L*:A,B:*:*=L*:*:A,B:*=L*:*:*:A,B
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The asterisk * means that the interaction parameter is independent of the occupation of that
sublattice. For the disordered phase to be completely disordered, i.e. that all site fractions
are equal on all four sublattices, all constraints must be correct.

For ordered BCC phases, the situation is a bit more complicated, as the four sublattice
ordering phase represents an irregular tetrahedron with two pairs of sites that are next
nearest neighbours. Thus, for an A-B binary solution phase, with A located on two sublattice
sites and B on the other two, the end-member described by GA:A:B:B has four nearest
neighbour bonds between A and B atoms, whereas the end-member described by GA:B:A:B
has two nearest neighbour bonds between A and B atoms and two next nearest neighbour
bonds. Many parameters thus have a relation:

GA:B:B:B=GB:A:B:B=GB:B:A:B=GB:B:B:A

GB:A:A:A=GA:B:A:A=GA:A:B:A=GA:A:A:B

GA:A:B:B=GB:B:A:A

GA:B:A:B=GA:B:B:A=GB:A:A:B=GB:A:B:A

LA,B:*:*:*=L*:A,B:*:*=L*:*:A,B:*=L*:*:*:A,B

The GA:B:B:B term represents D03, GA:A:B:B B2 and the GA:B:A:B B32 ordering. There are also
two kinds of reciprocal interaction parameters:

LA,B:A,B:*:*;0…9

LA,B:*:A,B:*;0…9

Kusoffsky et al. (2001) have shown the influence of different parameters available in the 4SL
model applied to fcc ordering. The possibility to use the 4SL model to BCC ordering has been
studied by Sundman et al. (2009) in the Al-Fe system.

2SL Model for FCC, HCP and BCC
The reason for using a 2SL model instead of a 4SL model is that the calculations are faster,
but on the other hand it can only model one kind of ordered phase(s). For instance, it is not
possible to model FCC with both L10 and L21, or BCC with D03 and B2, etc.

In order to get the fully disordered phase to form, constraints are needed as for the 4SL
model. For the symmetric phases, e.g. B2 and L10, the relation between parameters are:

GA:B=GB:A

LA,B:*=L*:A,B
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For a 2SL asymmetric model including, but not limited to, L12, more constraints are needed.
This model has many complicated relations between the parameters. The relation between
the parameters for the 2SL L12 model can be derived from a 4SL model. The conversion
from 4SL model parameters to 2SL parameters for L12 can be found in Dupin et al. (2001)
and for L10 in Yuan et al. (2012). Higher-order systems with an L12 phase modelled with two
sublattices require a lot of ternary and some quaternary interaction parameters in order to
make the disordered state stable. These parameters have been derived by e.g. Dupin (1995),
also found in Kusoffsky et al. (2001).

Many publications exist on how to model order/disorder transformations using a two-
sublattice model, see e.g. Dupin, Ansara (1999), De Keyzer et al. (2009).

Magnetic Ordering
The magnetic contribution to the Gibbs energy is given by a model proposed by Inden (1975)
and adapted by Hillert and Jarl (1978), and is described by:

G=RTln(b+1)f(t)

where t=T/TC.

The values of the Curie temperature, TC, and Bohr magneton number, b, at a certain
composition are then used in an optimization procedure to calculate the contribution to
Gibbs energy due to magnetic ordering. Curie temperature and Bohr magneton number are
given in the command "ENTER_PARAMETER" on page 143 for phases that undergo a
magnetic transition:

AMEND_PHASE_DESCRIPTION BCC_A2 MAGNETIC -1.0 0.4

ENTER_PARAMETER TC(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N

ENTER_PARAMETER BMAGN(BCC_A2,FE:VA;0) 298.15 +V2; 6000 N

The arguments -1 and 0.4 specify the values of parameters in the magnetic model: -1 is the
antiferromagnetic factor and 0.4 is the structure factor. Usually the antiferromagnetic
factor =-1 for bcc and =-3 for fcc (and other non-bcc phases). The structure factor
corresponds to the short range order fraction of the enthalpy. This factor is 0.4 for bcc and
0.28 for non-bcc phases.

Molar Volumes and High Pressure
Including volumes in a thermodynamic database enable calculations of volume changes,
volume fraction, lattice mismatch in cubic structures and phase diagrams at increased
pressure. Pressure independent volumes can be used up to about 1 GPa. At pressures above
1 GPa the pressure dependence of the volumes must be included by using a proper equation
of state (EOS). An EOS has been developed by Lu et al. (2005), based on the EOS from Jacobs



Thermo-Calc Documentation Set

Thermodynamic Models ǀ 71 of 72

and Oonk (2000). Four parameters are used in the implementation of the model in Thermo-
Calc:

l V0: Volume at 1 bar and at reference temperature T0

l VA: Integrated thermal expansivity

l VK: Isothermal compressibility at 1 bar

l VC: Parameter to fit high pressure data

All parameters can be composition dependent in the same way as all other model
parameters in Thermo-Calc. Experimental information about the temperature, pressure and
composition dependence of the volume can be assessed using these model parameters. To
evaluate V0, VA and VK experimental data at 1 bar only are needed.

Example

Examples on modelling molar volume in a setup-file:

ENTER_PARAMETER V0(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N

ENTER_PARAMETER VA(BCC_A2,FE:VA;0) 298.15 +V2*T+V3*T**2; 6000 N

ENTER_PARAMETER VC(BCC_A2,FE:VA;0) 298.15 +V4+V5*T; 6000 N

ENTER_PARAMETER VK(BCC_A2,FE:VA;0) 298.15 +V6+V7*T; 6000 N

ENTER_PARAMETER V0(FCC_A1,CR,FE:VA;0) 298.15 +V8; 6000 N

ENTER_PARAMETER VA(FCC_A1,CR,FE:VA;0) 298.15 +V9*(T-298.15); 6000
N

Excess Models
Unless specifically amended, the excess Gibbs energy terms are modelled by the Redlich-
Kister-Muggianu Model. Other excess models for the Gibbs energy are also implemented in
Thermo-Calc, such as e.g. Kohler and Toop-Kohler extrapolation models.

More information about different excess models can be found in the Thermo-
Calc Console Mode example tcex51.

Thermo-Calc is not restricted to binary interaction parameters. Ternary, quaternary and
higher-order interaction parameters can also be used if there is enough information to
evaluate these from experimental data. The ternary interaction parameters are identified
by the degrees of the so-called ternary L parameter (i.e. 0, 1 and 2) in the command
"ENTER_PARAMETER" on page 143. If the parameter is composition-independent, you only
need a single interaction parameter with a degree of zero, i.e. only the 0L term. If there is a
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ternary composition-dependent interaction parameter, you must enter all three parameters
(0,1 and 2). If such a ternary interaction parameter should be zero, then assign it a function
which is zero. If the three interaction parameters have the same value, then that is identical
to having a composition-independent ternary parameter.

Example

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;1) 298.15 +1000; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;2) 298.15 +1000; 6000 N

is identical to

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

This also means that

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;1) 298.15 +ZERO#; 6000 N

ENTER_PARAMETER L(LIQUID,A,B,C;2) 298.15 +ZERO#; 6000 N

is NOT identical to

ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N
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About Pourbaix Diagrams in Thermo-Calc
This guide is for Thermo-Calc software users who know the basics of thermodynamics and
want to know more about "Pourbaix Diagrams" below.

You are introduced to the concept of a Pourbaix diagram and shown how to interpret such
diagrams through a series of examples.

Materials corrosion occurs almost everywhere. It may lead to serious material damages,
unexpected application failures, tremendous economic costs and environmental
degradations.  Consequently, scientists and engineers must often conduct expensive and
time-consuming corrosion experiments as part of failure analyses, risk evaluations, quality
improvements and application enhancements.

Under certain conditions, when a metal or alloy is exposed to an aqueous solution with a
concentration of inorganic/organic mixture, corrosion phenomena occur at a corresponding
degree. During corrosion, some metallic phases dissolve, the metal or alloy surface gets
damaged and some secondary solid phases form at the solid-liquid interfaces (such as
oxides, hydroxides, silicates, sulphides, sulphates, carbonates, nitrates, phosphates, borates,
or halides). Such corrosive chemical or electrochemical reactions can be studied by means
of the so-called Pourbaix diagrams if the reactions reach their equilibrium states (Pourbaix,
1973, 1974; Cramer and Covino, 2003; Verink, 2011; Thompson et al., 2011).

Pourbaix Diagrams
Marcel Pourbaix applied thermodynamics to predict materials corrosion resistance. He
determined the phase stability relations in terms of varied pH and Eh values for an
interaction system of metal and pure water or dilute aqueous solution. He presented the
stability regions of metal and secondary phases (such as metal-oxides/hydroxides) on a pH-
Eh diagram, which is now known as a Pourbaix diagram.

A Pourbaix diagram is a kind of phase diagram that shows the stability boundaries for a
metal-aqueous interaction system. The phase boundaries are shown as a function of pH
(acidity) and Eh (standard hydrogen electronic potential). An aqueous solution phase is
always present in such a system. At a given pH and Eh, a metal may lose its stability to a
soluble or corrosive aqueous solution, or be in equilibrium with either the aqueous solution
(insoluble/immune) or with a secondary-phase file that has formed (consisting of oxides,
hydroxides, sulphides or other solids). In the latter case, further dissolution of the passive or
protective metal is prevented.

The speciation and partition in the aqueous solution and the interacting phases depend not
only on pH and Eh, but also on other factors such as the bulk composition, temperature and
pressure in the system. The interacting phases may be gas mixtures, stoichiometric solids or
solid solutions.
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A Pourbaix diagram is divided in regions of immunity, corrosion and passivity. These regions
provides information about the stability of a particular metal or alloy in a specific aqueous
electrochemical environment under certain pH, Eh, pressure and temperature conditions.

l The immunity region is the region in which there is no metal dissolution.

l The corrosion region is the region in which there is active metal dissolution.

l The passivation region is the region in which a protective metal-oxide film that
prevents metal dissolution is formed.

The following shows these three regions in a Pourbaix diagram for the heterogeneous
interaction between 0.001 mole of austenite steel (Fe-19Cr-9Ni [at%]) and 1 kg of water
(with 3 m NaCl), at 200°C and 100 bar:

Depending on the system’s bulk chemical composition, secondary phases may form during
the transformation process. These can not only be oxides, but also be, for example,
hydroxides, sulphides, sulphates, carbonates, nitrates, phosphates, borates, silicates, hydrous
silicates and halides. Information about these secondary phases may help one understand
the passivation behaviours in corrosion processes. For example, it may be important to
understand whether any secondary phases are formed in different pH-Eh regions during
hydrolysis, oxidation, reduction or other reaction processes.

In a Pourbaix diagram, the predominant ion boundaries are often represented by dashed
and straight lines imposed on a traditional Pourbaix diagram for a simple interaction system
(Pourbaix, 1973, 1974; Cramer and Covino, 2003; Verink, 2011; Thompson et al., 2011). Such
a predominance boundary is normally an equal molality (or equal activity) line for a pair of
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two most-concentrated aqueous solute species (charged or neutral) involving a common
metal. A line is then simply determined by a reaction constant of its corresponding
electrochemical reaction in the homogeneous aqueous solution phase. However, this is not
the case in Thermo-Calc.

You cannot get any information about predominant ion boundaries from a
Pourbaix diagram in Thermo-Calc.

Working with Pourbaix Diagrams
With the Thermo-Calc software package, Pourbaix diagrams can be calculated over a wide
range of pressure, temperature and composition conditions for complex heterogeneous
interactions between multicomponent primary alloy solution or compound phases,
concentrated aqueous solutions (with dissolved inorganic and organic substances),
complicated secondary solids and oxidizing/reducing gaseous mixtures. In the Console
Mode, diagrams can be calculated and plotted either using the response-driven POURBAIX
module or directly using the DATA, GIBBS, POLY and POST modules.

Note that it is possible in Thermo-Calc to set aqueous properties other than pH and Eh as
axis variables. For example, the following properties can also be set as axis variables: Ah
(electronic affinity), pe (electronic activity log10ACRe), IS (ionic strength), TM (total aqueous
concentration, in molality), OC (Osmotic coefficient), activity or activity coefficient of solvent
H2O, and activities or activity coefficients or concentrations in m (molality) of charged or
neutral solute species.

Beside a concentrated aqueous solution phase handled by a proper thermodynamic model
named SIT, HKF or PITZ, it is also possible to consider complex alloy solution phases or
compound phases, as well as secondary solid phases and gaseous mixtures, which are
treated by specific solution models.

Most frequently, a Poubaix diagram is calculated for a specific alloyed phase with the initial
alloying composition, such as the FCC solution phase in an austenite steel. However, it is
possible to calculate a Pourbaix diagram for two co-existing phases, such as the FCC+BCC
solution phases in a duplex steel for example, or even for more than two co-existing phases
in a steel/alloy.

Note that each point on the lines in a pH-Eh diagram in Thermo-Calc represents a certain
minimum state of Gibbs energy. When a line is crossed, a phase transformation should
occur. This means that a Pourbaix diagram in Thermo-Calc does not provide any information
about any predominant ion boundary. 

Key Concepts
The following are two key concepts important for understanding how aqueous solutions
behave and how an aqueous-bearing heterogeneous interaction system is properly defined
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and calculated in Thermo-Calc.

Effective Interaction Ratio
A pH-Eh plot is always related to a certain amount of initial alloys or other condensed
materials that has effectively reacted with an aqueous solution in the system. This is the
amount of condensed material that is fully in equilibrium with the defined aqueous solution
phase. The amount is specified relative to an aqueous solution that is normally comprised of
1 kg of water with certain specified solute concentrations at certain temperature and
pressure conditions. (This is why a calculated Pourbaix diagram is typically presented for an
initial amount of the interacting metal or alloy at a certain level, such as 10-6, 1E-3, 0.1 or 1
mole of metal or alloy.) It is called the Effective Interaction Ratio (between the initial alloy
or alloyed phases and the initial aqueous solution) and it is expressed in terms of molality
(mol/kg).

The Effective Interaction Ratio is important for two reasons. First, the ratio has implications
for kinetic or dynamic effects such as chemical reaction mechanism and kinetics, fluid flow
dynamics, surface area and interaction time. Secondly, the ratio, being expressed as 10-6
mole of metal (or alloy), is the solubility limit that can be detected for cathodic corrosion
protection by immunity.

One should always be careful when setting initial amounts and compositions in the original
condensed materials, as well as when setting the initial concentrations of dissolved solutes in
the original aqueous solution phase. It is often useful to make a series of calculations for
different levels of initial amount of the interacting metal/alloy while the conditions are fixed
for other settings (such as initial aqueous concentration, pressure, temperature, pH, and Eh).

Solubility
When a heterogeneous equilibrium has a dissolving solution or mixture phase and a
stoichiometric or solution phase, then the concept of solubility becomes important. A
solubility of a phase (the solute) is its property of dissolving in the solvent phase. This
concept concerns the constitution of a phase and is applied where one or several of the
constituents are dominant (which is highly concentrated and dissolving) while there are only
small amounts of the other remaining species (which are less concentrated and dissolved).
The dissolving solution or mixture phase can be liquid, gas, aqueous or solid, as long as it has
dissolving capacity. The stoichiometric or solution phase has some constituents which tend to
be dissolved into the dissolving solution or mixture phase.

Key Points about Solubility

l Under certain temperature, pressure and composition conditions, a Fe- or Cr-
dominant BCC phase can dissolve certain amounts of Ni and C from a carbide phase
such as M23C6, M7C3 or M3C. The Ni and C elements in the carbides have the
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solubility defined relative to the BCC phase.

l An aqueous solution phase is always dominant in the solvent water, that is, H2O.
Under specific temperature, pressure and aqueous composition conditions, any other
element (such as Fe and C) or substance (such as a pure SO2 gas, stoichiometric
phase Cu2S and solution phase (Fe,Ni)1(O,Va)1) have a certain solubility limit in the
defined aqueous solution.

l Under certain temperature and pressure conditions, and under given certain
concentrations of other dissolved species in the mixture, an O2-dominant gaseous
mixture phase can dissolve certain amounts of Fe+2 or Fe+3 species from magnetite
(Fe3O4). The magnetite solid has solubility defined relative to the gaseous mixture
under the given conditions.

l Under certain temperature and pressure condition, under specific concentrations of
other dissolved species in the liquid phase, a Fe-dominant liquid mixture phase can
dissolve certain amounts of, for example, Cr and O. The Cr and O components have
the solubility defined in the liquid mixture.

Basic Settings and Definitions
In a homogeneous aqueous solution or an aqueous-bearing heterogeneous interaction
system, the most essential definition is for system-components there must be H2O, H+1 and
ZE (electron) plus those for elements dissolved in aqueous solution (such as Na, Cl, S) and
associated in interacting metals/alloys (such as Fe, Cr, Mn, Mg, Ni, Al, Si, Zn). Three
fundamental phases in a system are the AQUEOUS solution, the GAS mixture and the REF_
ELECTRODE. The REF_ELECTRODE phase is used for setting the reference state for
electrostatic potential in the system and for calculating the Eh condition (defined as MUR
(ZE)/RNF). Other phases should be appropriately selected and retrieved from critically-
assessed databases that cover not only the target phases (solution or stoichiometric) in
interacting metals/alloys but also the secondary phases (solution or stoichiometric). The two
public databases PAQ and PAQS are specially designed as single-database choices that cover
all kinds of phases necessary for calculations. However, these databases are each limited to
a framework of a very small number of elements. When it comes to simulations of complex
multicomponent systems with a wide variety of elements and phases, the thermodynamic
data must be selected and retrieved from several databases: AQUEOUS solution and REF_
ELCTRODE phases must be retrieved from TCAQ or AQS; alloy phases (such as FCC_A1, BCC_
A2, HCP_A3, CEMENTITE) from alloy solution databases (such as SSOL for general alloy
phases, TCFE for steel/Fe-alloy phases, TCAL for Al-based alloy phases; TCMG for Mg-based
alloy phases, and TCNI for Ni-based superalloy phases); gaseous mixture phase and
secondary phases from specific substance or solution databases (such as SSUB for GAS phase
and various solid compound phases or TCOX for oxide solution phases). Note that the REF_
ELECTRODE phase should always be suspended in equilibrium calculations, while GAS phase
could be set as ENTERED, SUSPENDED or DORMANT, depending on the purpose of the
calculation.
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When defining an interaction system, the initial condition for the H2O component is always
set as 1 kg of water. The initial composition conditions for dissolving and interacting
elements are normally defined in moles (such as n(Fe)=0.009, n(Cr)=5E-4, n(Ni)=3E-4, n
(Mn)=5E-5, n(S)=5E-5, n(Na)=3, n(Cl)=3). This makes it straightforward and convenient to
count various related aqueous solution properties based on molality. The initial conditions
for the H+1 and ZE components can be given as molar compositions (such as n(H+1)=0, n
(ZE)=0) or their activities or potentials (such as lnACR(H+1)=-9.21, MUR(ZE)=8400).

The pH and Eh properties of the aqueous solution in the interacting system are always
defined in the following way:

pH = -log10[ACR(H+1,AQUEOUS)*AH2O]]Eh = MUR(ZE)/RNF

The symbol AH2O is the molecular weight of solvent H2O (equals 55.508435) and RNF is the
Faraday constant (equals 96485.309).

The activity of the solvent water (ACRH2O, Aw), the osmatic coefficient of aqueous solution
(OSMC, Os), electronic affinity (Ah), electronic activity log10ACRe (pe), ionic strength (IS),
total aqueous concentration, in molality (TM) and total alkaline concentrations under two
definitions (At1/AT2) are calculated and listed for each equilibrium state.

POLY3 calculations for mass balances in Thermo-Calc are always based on site-fractions.
Consequently, when functions for describing various properties of aqueous solutes are
defined, such as molality (MLi), activity coefficient (RCi) and activity (AIi), they should be
converted to molality-based quantities:

MLi = Y(AQUEOUS,i)*AH2O/YH2O

RCi = ACR(i,AQUEOUS)*YH2O/Y(AQUEOUS,i)

AIi = ACR(i,AQUEOUS)*AH2O

Here, YH2O is the site-fraction of solvent H2O and AH2O equals 55.508435.

Many more variables, functions and tables can be entered for various purposes. For
instance, an equilibrium constant for a homogeneous reaction or a solubility product for a
solid dissolution reaction can be entered.
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Thermodynamic Data Requirements
In this section:

Required Thermodynamic Data 10

Including or Excluding the Gas Phase 10
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Required Thermodynamic Data
To calculate a Pourbaix diagram, thermodynamic data for at least the following four types
of phases must be available:

l The aqueous solution phase which applies a certain aqueous solution model. In
Thermo-Calc, information about this phase could be retrieved from, for instance, the
TCAQ or AQS database (these also include data for the REF_ELECTRODE phase that is
used for setting the reference state of the standard hydrogen electrode).

l The alloy solution and/or compound phases for the primary matrix phases (and
possibly also for the precipitated phases in the alloy. Examples of such phases include
FCC_A1, BCC_A2, HCP_A3, SIGMA and CEMENTITE. In Thermo-Calc, information
about such phases could be retrieved from, for example, the TCFE database for
steels/Fe-alloys, the TCNI database for Ni-based superalloys, the TCAL database for
Al-based alloys, the TCMG database for Mg-based alloys, the TCSLD for Sn-/Au-/Bi-
/Zn-based solder alloys or the SSOL for general alloys.

l The secondary solid phases that would form as a result of the heterogeneous
chemical or electrochemical reactions. These phases could be, for example, oxides,
hydroxides, silicates, hydrous silicates, sulphides, sulphates, carbonates, nitrates,
phosphates, borates or halides. In Thermo-Calc, information about such phases could
be retrieved from, for example, the SSUB database for pure solid compounds or the
TCOX database for complex oxide solids.

l The gaseous mixture phase. Information about this phase could be retrieved from,
for example, the SSUB database. However, note that is also possible to perform
Pourbaix diagram calculations that ignore the gaseous mixture phase.

All this thermodynamic data about the various phases must be critically assessed and
internally consistent. Furthermore, when the data is retrieved from several databases, the
data taken from each database must be consistent with the data taken from the other
databases. When Pourbaix diagrams and other diagrams of steel corrosion processes are
calculated, it is typically recommended that the TCAQ, TCFE, SSUB and TCOX databases or
the AQS, TCFE, SSUB and TCOX are used in combination.

The public PAQ and PAQS databases each contains thermodynamic data for all four phase
types and can be used for calculating Pourbaix diagrams. They have been designed
specifically for the purpose of demonstrating the POURBAIX module functionality in Thermo-
Calc. However, these databases only allow you to perform test calculations for simple cases
with major phases in which only a few elements can be considered.

Including or Excluding the Gas Phase
Under defined pressure and temperature conditions, the solvent water’s thermodynamic
stability limits are determined by the following two electrochemical reactions:
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H2O(water) + 2e- = H2(gas) + 2OH-1

2H2O(water) = O2(gas) + 4H+1 + 4e-

The first reaction describes the formation of H2-dominated gaseous mixture, under reducing
conditions. The second reaction describes the formation of O2-dominated gaseous mixture,
under oxidising conditions.

If the system reaches global equilibrium, then the water component is electrolyzed to H+
and O-2 at all pH conditions. The degree of electrolysis depends on the pH value in the
aqueous solution phase. If Eh gets high enough, then the O-2 anion is oxidized to O2 (aqs).
On the other hand, if Eh gets low enough, then the H+ cation is reduced to H2 (aqs). The
major electrolysis and redox reactions are the following:

H2O (water) = H+ + OH- à Electrolysis of water at all pH.

H2O (water) = 2H+ + O-2 à Electrolysis of water at all pH.

O-2 - 2e- = 0.5O2 (aqs)àOxidation or de-electronization of O-2 at high Eh.

2H+ + 2e- = H2 (aqs) à Reduction or electronization of H+ at low Eh.

At a critically high Eh value under a given pH condition, an aqueous solution phase with a
high enough O2 activity becomes less stable than an O2-dominated gaseous mixture phase.
At this point, the gas phase replaces the aqueous solution phase in the system. The
replacement process can be characterised by the following phase-transformation on the
aqueous-gas phase boundary and oxidation of remaining water:

O2 (aqs) = O2 (gas)

H2O (water) - 2e- = 2H+(gas) + 0.5O2 (gas)

Similarly, at a critically low Eh value under a given pH condition, an aqueous solution phase
with a high enough H2 activity becomes less stable than a H2-dominated gaseous mixture
phase. At this point, the gas phase replaces the aqueous solution phase in the system,
through the following phase-transformation on the aqueous-gas phase boundary and
reduction of remaining water:

H2 (aqs) = H2 (gas)

H2O (water) + 2e- = O-2 (gas) + H2 (gas)

The phase transformation from an aqueous solution phase to an O2- or H2-dominated
gaseous mixture phase also depends on the total molar Gibbs energies of the phases (which
are complex functions of the phase constituents, the temperature and the pressure). The
Gibbs energy minimization technique used in Thermo-Calc ensures that the phase
transformation is accurately simulated.

The following Pourbaix diagrams show the result of a calculation where the gaseous mixture
phase was included. In the upper region (high Eh) and lower region (low Eh), the aqueous
solution phase has been oxidized and reduced, respectively, to an O2- or H2-dominated
gaseous mixture phase.
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The two example diagrams show that the upper and lower boundaries between the aqueous
phase (water) and the gas phase (dominated by either O2 or H2) can shift when solutes
dissolve or when the temperature and pressure change. 

Accordingly, if one does not take a gaseous mixture phase into account when performing a
calculation of Pourbaix diagram (as above), then the aqueous solution phase may end up
with an extremely high O2 (aqs) concentration at high Eh condition, or an extremely high H2
(aqs) concentration at low Eh condition. Under either of these two extreme circumstances,
the concept of “aqueous solution phase” is no longer valid and consequently no proper
aqueous solution model can actually be applied. Therefore, from a restrictive
thermodynamic equilibrium point of view, one shall normally include a gaseous mixture
phase in an aqueous-bearing heterogeneous interaction system. This is true for all types of
equilibrium calculations for an aqueous-bearing heterogeneous interaction system, not only
of Pourbaix diagram calculations.

Hence, to perform a completely accurate Pourbaix diagram calculation, the gaseous mixture
phase must be taken into account. However, since these electrochemical reactions normally
have much higher kinetic barriers and are slower than other electrochemical and chemical
reactions in the interaction system, one can sometimes ignore the gaseous mixture phase in
the calculation. Note that if the gaseous mixture phase is ignored in this way, then the
Pourbaix diagram does not show the H2O-stability limiting lines.

Example Diagrams

The first diagram is a pH-Eh diagram for pure water at 25°C and 1 bar:
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The second diagram is a pH-Eh diagram for 3mNaCl-0.001mCO2-0.001mSO2 aqueous
solution at 150°C and 100 bar.
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Examples of Pourbaix Diagrams for Fe
The following two topics are examples of Pourbaix diagrams for Fe. For the first example,
the calculations on which the diagrams are based have not taken the gas phase into account.
The diagrams in the second example are based on calculations that have taken the gas
phase into account.

In this section:

Pourbaix Diagrams with Gas Phase Excluded 16

Pourbaix Diagrams with Gas Phase Included 16
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Pourbaix Diagrams with Gas Phase Excluded
This is an example of a Pourbaix diagram of Fe, in which the gas phase has not been
considered in the calculation. The system has 0.001 mole of Fe in 1 kg of pure water at a
temperature of 25oC and a pressure of 1 bar. Magnetite (Mt, Fe3O4) and hematite (Hm,
Fe2O3) co-exist with the Fe-containing dilute aqueous solution. The formation of magnetite
and hematite represent the passivation of iron in the upper right pH-Eh field.

If pH is low and Eh is relatively high, then Fe eventually completely dissolves into the
aqueous solution phase. Under conditions of low Eh, Fe remains in its stable solid state, the
BCC phase, and neither dissolves into water nor into alternates to Fe (the immunity of Fe).

Pourbaix Diagrams with Gas Phase Included
With all the possible redox reactions involving the aqueous solution phase and gaseous
mixture phase being considered in the equilibrium system, that is, the gaseous mixture
phase is included in the calculation, the Pourbaix diagram of Fe in a system with 0.001 mole
of Fe in 1 kg of pure water at 25oC and 1 bar.
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Comparing this Pourbaix diagram with that from "Basic Settings and Definitions" on page 7,
you can see that both diagrams are for the same interaction system under the same
temperature-pressure condition, but the present diagram shows the results of calculations
where the gaseous mixture phase has been included. It presents the complete Pourbaix
diagram for the defined interaction system, in a full thermodynamic equilibrium. In the
upper region (high Eh) and lower region (low Eh), the aqueous solution phase is oxidised and
reduced to the O2- or H2-dominated gas phase. Hematite coexists with the O2-dominated
gas, while Fe-BCC is stable with the H2-dominated gas. The stability field of magnetite may
extend slightly into the H2-dominated gas region, where it coexists with the gaseous mixture
instead of the aqueous solution. Its boundary with Fe (BCC) cannot be drawn due to the
absence of aqueous solution phase.

It is not possible to calculate the pH value in both the O2- and H2-dominated gaseous
mixture phase stability regions where the aqueous solution phase is absent. Hence, in a
normal Pourbaix diagram, no line is drawn that indicates a phase boundary between the gas
phase and the metallic phases or secondary phases (that is, metal-oxides).
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Other Examples of Pourbaix Diagrams
In this section:

Variations of Pourbaix Diagrams 19

Pourbaix Diagrams for Complex Alloys 21

Pourbaix Diagram References 23
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Variations of Pourbaix Diagrams
The shape of a Pourbaix diagram of an alloy or condensed material and the stability
relations of various secondary phases depend upon the following system factors: 

l Initial amount of the alloy or other condensed materials

l Initial composition of the alloy or other condensed materials

l Initial amount of the interacting aqueous solution phase

l Initial composition of the interacting aqueous solution phase

l Temperature and pressure conditions

In the interaction system that the diagrams in "Pourbaix Diagrams with Gas Phase Excluded"
on page 16 and "Pourbaix Diagrams with Gas Phase Included" on page 16 are based on, the
initial amount of pure Fe that was taken to have effectively reacted with 1 kg of pure water
at 25°C and 1 bar was 0.001 m. The following diagrams are Pourbaix diagrams of Fe where
other initial amounts of pure Fe have been used, or where the interacting aqueous solution
compositions have been alternated, or the temperature and/or pressure have been changed.
Gaseous mixture phases have been included in all the calculations that these diagrams are
based on.

In the first diagram, 1E-3 m Fe actively reacted with 1 kg of pure water at 25°C and 1 bar (as
in the calculation in Pourbaix Diagrams with Gas Phase Included):

In the second diagram, 1E-6 m Fe actively reacted with 1 kg of pure water at 25°C and 1 bar.
Note that the active metal corrosion region gets enlarged as the initial Fe amount decreases
from 1E-3m to 1E-6m:
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In the third diagram, 1E-6 m Fe actively reacted with 1 kg of water, 3m NaCl and 1E-5 m
SO2 at 25°C and 1 bar. Introducing SO2 into the system leads to the formation of various
metal-sulphides (Py-pyrite, Popyrrhotite, Tr-troilite). In addition, the passivation region
becomes larger.

Finally, in the fourth diagram, 1E-6 m Fe actively reacted with 1 kg of water, 3m NaCl and
1E-5 m SO2 at 150°C and 100 bar. Here, changing the temperature and pressure affects the
stability fields of various Fe-oxides/sulphides.
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As you can see from the four diagrams, the aqueous-gas phase boundaries shift as the initial
bulk compositions, pressure and temperature conditions in the interaction system change.

Pourbaix Diagrams for Complex Alloys
Thermo-Calc can not only be used to simulate how pure metals interact with pure water or
simple aqueous solutions under normal pressure and temperature conditions. It can also be
used to calculate how complex alloys and concentrated aqueous solutions interact over a
very wide pressure, temperature and composition ranges. This is illustrated with the two
examples.

The first example is a Pourbaix diagram calculated for the heterogeneous interaction
between 0.001 mole of steel (Fe-7.676Cr-5.0Ni-2.1887Mn-1.0Cu [at%]) and 1 kg of water
(and with 1.2 m H3BO3, 0.022 m Li and 0.001 m NH3), at 25°C and 1 bar. This application is
particularly useful for safety assessments of nuclear reactors and nuclear waste repositories.
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The next example is a Pourbaix diagram calculated for the heterogeneous interaction
systems between 0.1 mole of AISI4340 stainless steel (Fe-0.80Cr-1.85Ni-0.70Mn-0.25Mo-
0.25Si-0.40C [wt%]) and 1 kg of seawater (with the equivalent of 0.6054 m NaCl), at 25°C
and 1 bar. This application is particularly useful for failure analysis of petroleum exploitation
industry.



Thermo-Calc Documentation Set

Other Examples of Pourbaix Diagrams ǀ 23 of 24

Pourbaix Diagram References
1. Andersson J-O, Helander T, Höglund L, Shi Pingfang, and Sundman B (2002): Thermo-

Calc and DICTRA, Computational tools for materials science. Calphad, 26: 273-312.

2. Ciavatta L (1990): The specific interaction theory in equilibrium analysis. Some
empirical rules for estimating interaction coefficients of metal ion complexes. Ann
Chim. (Rome), 80, 255-263.

3. Cramer SD and Covino BS Jr. (2003): Corrosion: Fundamentals, Testing, and
Protection. ASM Handbook, Volume 13A.

4. Helgeson HC, Kirkham DH, and Flowers GC (1981): Theoretical prediction of the
thermodynamic behavior of aqueous electrolytes at high pressures and
temperatures: IV. Calculation of activity coefficients, osmotic coefficients, and
apparent molal and standard and relative partial molal properties to 600oC and 5 kb.
Am. J. Sci., 281, 1249- 1516.

5. Johnson JM and Norton D (1991): Critical phenomena in hydrothermal system: State,
thermodynamic, electrostatic, and transport properties of H2O in the critical region.
Am. J. Sci., 291, 541-648.

6. Kaufman L (2002) Calculation of Pourbaix diagrams for C22 in various well water
chemistries. In: Proceedings for the 5th Nickel Development Institute Workshop on
Fabrication of Welding of Nickel Alloys (R. Moeller, ed.), Nickel Development
Institute, Las Vegas, Nevada, 16-17 Oct., 2002.

7. Kaufman L, Perepezko JH, Hildal K, Farmer J, Day D, Yang N, and Branagan D (2009):
Transformation, stability and Pourbaix diagrams of high performance corrosion
resistant (HPCRM) alloys. Calphad, 33: 89-99.

8. Pourbaix M (1973): Lectures on Electrochemical Corrosion. Plenum Press, New York.

9. Pourbaix M (1974): Atlas of Electrochemical Equilibria in Aqueous Solutions, 2nd Ed,
Houston, Tex., National Association of Corrosion Engineers.

10. Shi Pingfang (2013a): Thermo-Calc 3.0 (Console Mode) Manual (including TC3-CM
User’s Guide, and Thermo-Calc Software System), Thermo-Calc Software, Stockholm,
Sweden.

11. Shi Pingfang (2013b):Materials Corrosion Applications with Thermo-Calc Software.
Thermo-Calc Software, Stockholm, Sweden.

12. Shi Pingfang, Engström A, and Sundman B (2011a): Thermodynamic investigations on
materials corrosion in some industrial and environmental processes. Journal of
Environmental Sciences, 23 (Supplement): S1-S7.

13. Shi Pingfang, Engström A, Sundman B, and Ågren J (2011b): Thermodynamic
calculations and kinetic simulations of some advanced materials. Materials Science
Forum, 675-677: 961-974.



Thermo-Calc Documentation Set

Other Examples of Pourbaix Diagrams ǀ 24 of 24

14. Thompson WT, Kaye MH, Bale CW, and Pelton AD (2011): Pourbaix diagrams for
multielement systems. In: Uhlig's Corrosion Handbook, 3rd Edition (Revie RW, Ed.),
The Electrochemical Society and Jon Wiley & Sons, New Jersey.

15. Verink ED (2011): Simplified procedure for constructing Pourbaix diagrams. In:
Uhlig's Corrosion Handbook, 3rd Edition (Revie RW, Ed.), The Electrochemical Society
and Jon Wiley & Sons, New Jersey.



DATAPLOT User Guide
Thermo-Calc Version 2017a



Thermo-Calc Documentation Set

Introduction to the DATAPLOT User Guide ǀ 2 of 45

Introduction to the DATAPLOT User Guide
In this section:

Using this Guide 3

About the DATAPLOT Graphical Language 3

DATAPLOT Examples 3



Thermo-Calc Documentation Set

Introduction to the DATAPLOT User Guide ǀ 3 of 45

Using this Guide
The DATAPLOT User Guide gives all the details on the graphical language DATAPLOT that a
phase diagram or property diagram calculated by Thermo-Calc or a kinetic profile simulated
by the Diffusion Module (DICTRA) can be defined.

This guide

l Discusses the important features of the DATAPLOT language.

l Describes the commands to define PROLOGUE and DATASET.

l Several examples and the standard codes for formatting are provided.

A topic introduce the method of formatting DIGLIB symbols in LaTeX documents, for the
purpose of necessarily/appropriately referring to the corresponding LaTeX symbols (closest
to those DIGLIB symbols which have been plotted on a diagram using the DATAPLOT
Graphical Language) in the texts of LaTeX documents for publications/reports.

About the DATAPLOT Graphical Language
In order to obtain graphical output of any numerical data and informative strings, a
graphical language called DATAPLOT was developed in connection with the graphical
software DIGLIB. Using this graphical language, you can store information in a normal text
file (*.EXP), which can be plotted as graphical symbols, lines, texts or Greek letters on any
plot device support by DIGLIB.

You can generate and plot DATAPLOT (*.EXP) files together with various calculation and/or
experimental results from, for example, phase and property diagrams calculated with the
Thermo-Calc software composition profiles or other diagrams simulated by the Diffusion
Module (DICTRA).

An EXP file automatically generated by the POST-processor (using the "MAKE_
EXPERIMENTAL_DATAFILE" on page 252 command) in the Thermo-Calc software is a
DATAPLOT (*.EXP) file and may contain all types of legal DATAPLOT commands and
parameters. With a text editor, you can modify or add some DATAPLOT commands and
related parameters in an existing EXP file. This is useful when appending experimental
information to calculated/simulated plots, and when specifying user-defined texts, symbols,
colors, fonts, filled patterns, diagram types, diagram sizes, symbol/character sizes, titles,
special characters, etc.

DATAPLOT Examples
To help you prepare your EXP (experimental) files to use for your plotted diagrams
generated by Thermo-Calc simulations, there are examples of EXP files using the DATAPLOT
graphical language standard, which are normally independent of software versions.
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DATAPLOT File Structure
A DATAPLOT file is a normal text file with the extension EXP that can be created with a text
editor or by a program. The file must contain one or more DATASETS and possibly also one
or more PROLOGUES. Each PROLOGUE/DATASET is an entity that can be individually selected
for plotting.

A PROLOGUE/DATASET is identified by a unique positive number in the file. A PROLOGUE
normally contains various DATASET commands for defining information about axis scaling,
axis text, axis length, title and so on. A PROLOGUE is terminated by another PROLOGUE or
by the first DATASET. This means that all PROLOGUES must be placed at the beginning of the
file, before the first DATASET.

A DATASET normally contains DATASET commands that are associated to separate data
points, as well as with one or more BLOCKS of data (calculated or experimental). A DATASET
is terminated by another DATASET command or the end of file.

DATAPLOT Language Syntax
The DATAPLOT language consists of commands with or without parameters:

COMMAND {parameter(s)}

The basic graphical command consists of an X/Y coordinate pair and a Graphical Operation
Code (GOC). With other commands, the interpretation of this basic command can be
modified. There are separate commands to draw a polygon or a function and ways to get
texts in different fonts.

To edit a DATAPLOT file, the graphical commands can be abbreviated.

A command (with parameters) must not exceed 80 characters. If it is too long
(normally as writing necessary codes in a command’s parameters for a complex
expression), two or more lines can be edited.

Coordinate Systems
The DATAPLOT language accepts coordinates in three different coordinate systems, which
are called word, virtual and normalized.

l The word coordinates are selected to represent any kind of data and be of “any”
magnitude.

l The virtual coordinate system uses centimeters as units. However, the actual size of
one unit is dependent on the implementation of the device driver in DIGLIB. It is not
recommended to use this coordinate system if different output devices are used for
preliminary and final plots.
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l The normalized coordinate system goes from zero to one. When plotting, you
interactively scale each axis by selecting the minimum and maximum word
coordinates on the axis. In the normalized coordinate system, the minimum axis
value is represented by zero and the maximum by one. DIGLIB draws a square
between the four points (of the X and Y axes) that are determined by the coordinates
zero and one in the normalized coordinates.

It is also possible to draw triangular plots as described below. However, in most
places, it only references square diagrams. All data points within the minimum
and maximum word coordinates are plotted inside this square. DIGLIB also
writes tic marks and corresponding word values at such tic marks.

It may be convenient to use normalized coordinates to draw boxes and texts. You can give
normalized coordinates outside zero and one if you want to write texts outside the area
enclosed by the square. To ensure proper operation outside the normalized box, the clipping
must be turned off.

Graphical Operation Codes
The Graphical Operation Code (GOC) determines how the coordinates are interpreted and
what is done at the point determined by the coordinates. For an individual data point, its
GOC codes must be given. For each data "BLOCK" on page 19, you define a default GOC that
is used for the whole BLOCK, unless a GOC is explicitly defined for a specific point.

l If S is omitted, no symbol is plotted. A number selecting the symbol can optionally
follow the character S. The DIGLIB software determines which symbol the number
represents. See "Plotting a Symbol" on page 9.

l If any of the other characters are omitted, the default defined for the BLOCK is used.
Absolute values imply the current coordinates; relative values mean that these are
added to the current coordinates. The GOC must be written without any space
between various characters, but the order for the characters is irrelevant.

l If no GOC is defined for a BLOCK, the system default is MWA, (Move Word Absolute),
i.e., move to the given point that is interpreted as absolute word coordinates.
GOC=DNA means draw a line from the current point to the new one interpreting the
coordinates as normalized. After each draw or move operation, the so-called current
point is the new point.

l The "TEXT" on page 28 following the ’ command is interpreted and expanded by the
DIGLIB software, if it includes any ^ operator or "STRING" on page 26 names using
the ~ descriptor. To get PostScript outputs, the TEXT must be edited by the LaTeX
Text Formatting Program instead (see "LaTeX Formatting Codes" on page 12).
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GOC Character Definitions

The GOC is a combination of the following characters:

Character Meaning

W, V or N To use word (W), virtual (V) or normalized (N) coordinates. W is the default.

A or R XY are absolute (A) or relative (R) values. A is the default.

M or D To perform a move (M) or draw (D) operation to XY. M is the default.

B
To apply “soft” splines on a line drawn between the coordinate pairs (used
only on BLOCK data).

S To plot default symbol at XY.

S# To change default symbol to No # symbol and plot it at XY.

‘TEXT

To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT
following the ’ command is interpreted and expanded by the DIGLIB
software, if it includes any ^ operator or STRING names using the ~
descriptor.

Tables or Blocks
In many cases, you have (calculated or experimental) data in the form of tables, and want to
plot one or several columns as X-axis and one or more columns as Y-axis. A single table can
contain many sets of data records of the same kind of information for a specific data
"BLOCK" on page 19. There can be many data BLOCKS in a "DATASET" on page 19.

By enclosing these tables in a data BLOCK, you can select which column(s) is the X-axis and
which is the Y-axis. For example,

BLOCK X=C1; Y1=C3; Y2=C2; GOC=C4,DAW

Where the X-axis values are in column 1, the Y-axis values are in columns 2 and 3, and any
GOC codes are in column 4. The default GOC for this BLOCK is Draw Absolute Word. The
GOC code inside the table is only necessary if the default GOC is not applicable.

A more elaborate use of the table is shown in this example:

BLOCK X=C3; Y=1E3/(C3+273); GOC=C8,MAWS1

Where the X-axis values are in column 3, the Y-axis values are in column 1 with some
additional calculations applied. Any GOC is in column 8, and the default GOC is Move
Absolute Word and plot the symbol no. 1.
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Columns in a table must be separated by one or more space characters and do not have to
be justified.

It is possible to have tables with mixed text and numbers, but each word followed by a space
is counted as one column. The columns used for plotting also must be numerical. An
example of a legal line in a table is

298.15 This_is_the_second_column 11.5 This_is_the_fourth_column

A line in the table must not exceed 80 characters. A BLOCK must be terminated
by a line with the "BLOCKEND" on page 20 command.

Drawing a Polygon
Normally, each point is written on a separate line. But in order to draw a line in a more
compact way, use the command "DRAWLINE" on page 21. DRAWLINE is followed by a couple
of X/Y number pairs. The X/Y pairs must be separated by a space, and there must be a
comma sign between the X and Y values. DRAWLINE makes a move operation to the first
pair of X/Y coordinates, and then draws a line among all pairs up to the last one. All pairs
must fit on one line of 80 characters, but there can be several consequent DRAWLINE
commands.

Drawing an Analytical Function
Use a "BLOCK" on page 19 command to set an axis to a function. It is not necessary to use a
value from any column in order to compute the function value to be plotted. Use the
"FUNCTION" on page 28 command to plot a function with an even increment of the
independent variable.

Painting of an Enclosed Area
Use the "PAINT" on page 29 command to paint or fill an area in a specified pattern in the
plot. Available patterns are determined by the DIGLIB software. A related command to
PAINT is "PCFUNCTION" on page 28.

Writing a Text
Use the "TEXT" on page 28 command to write a text at the current point. You can write a
text at any X/Y pair by appending a single quote followed by the text on the same line. For
example:

1.1 1.0 NAM’This is a text

writes This is a text at the normalized coordinates (1.1, 1.0).
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Use the command "FONT" on page 24 to select the font used for the text, and "CHARSIZE" on
page 22 to select the size of the characters. Set this size of the symbols with "SYMBOLSIZE"
on page 22.

If a text or a single character should be of a different font than all the other text, or to use
subscripts or superscripts in a text, use the ^ operators or STRING command to create the
text. The command "STRING" on page 26 stores the text in a specified variable that includes
all text-formatting information defined by the DIGLIB software. See "Example 3 – Using
Strings and Various Line Types" on page 33 and "Example 5 – Use Included Files for
Predefined Symbols" on page 35.

However, if a graphical output is done on a PostScript device using the PostScript hardcopy
fonts, special text formatting codes as "LaTeX Formatting Codes" on page 12 should be used
and the STRING formatting syntax is then not valid.

Plotting a Symbol
As described in "Graphical Operation Codes" on page 6, a GOC code in a data BLOCK may
contain an S option to plot a symbol for an X/Y pair or the same symbols for the data BLOCK.
A number selecting the symbol can optionally follow the character S. You can plot a symbol
at any current X/Y position by appending a quote specified by the symbol number in the GOC
code (e.g., 1.1 1.0 MANS5’This is a text).

You can also insert DIGLIB symbols into LaTeX-edited documents.

DIGLIB symbols available in Thermo-Calc

The image summarizes all the standard symbols available in the DIGLIB software. A default
symbol is the current symbol in the run of the software (it is usually the No 1 symbol if the
POST-processor is switched on for the first time). S (i.e., # is not specified) means that the
current symbol is plotted. S0 (i.e., #=0) means that no symbol is plotted.

All the DIGLIB symbols work properly and give good output results for the
PostScript format.
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Other Commands
Use the "LINETYPE" on page 21 command to define line types as solid, long dashed, short
dashed or dotted. If you are using a color device, use the "COLOR" on page 22 command to
change color of the lines. On some black and white devices, colors are simulated with
different width and dashing of the lines.

l Use the "CLIP" on page 20 command to change the default where all data outside the
normalized coordinates zero and one are not plotted.

l When plotting symbols representing various experimental data, it is important that
the symbols are centered around the coordinate values.

l Use the "ATTRIBUTE" on page 21 command to change the coordinates where text is
displayed. The default is the lower left corner of the first character in the text.

l Use the "INCLUDE" on page 29 command to create libraries with texts and include
these in similar plots.

l The dollar sign $ as the first character of a line stands for a comment character,
which means the whole line is ignored when plotting.
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Interactive Plotting
The DATAPLOT file is read into the POST module in the workspace with "APPEND_
EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on page 254. These
commands ask for the name of the DATAPLOT file and also which PROLOGUE(S) and
DATASET(S) are to be plotted.

See the Thermo-Calc Command Mode Reference Guide for details about these commands.

By giving the PROLOGUE/DATASET number as -1, you get a list of the available
PROLOGUES/DATASETS in the file. Note that if DATASET 0 is in a DATAPLOT file, its data is
always used even if other DATASETS are chosen.

Formatting DIGLAB Symbols in LaTeX Documents
When using the LaTeX editor, you can use the DIGLIB symbols in texts and in figures. This
then refers to the corresponding LaTeX symbols (closest to those DIGLIB symbols which are
plotted on a plot using the DATAPLOT Graphical Language) in the texts of LaTeX documents
for publications/reports.

This topic shows how to generate some DIGLIB symbols in texts, through the attached LaTeX
source file and its converted jpg file.

DIGLIB_Sym.tex
\documentclass[dvips,12pt]{article}

\textwidth 165mm

\textheight 225mm

\oddsidemargin 1mm

\evensidemargin 1mm

\topmargin 1mm

%%\usepackage{amssymb}

%% next replace amssymb and to get udtimes

\usepackage[utopia]{mathdesign}

\usepackage{rotating}

\usepackage[latin1]{inputenc}

\usepackage{graphics}

\usepackage{graphicx,subfigure}% with figures

%\usepackage[draft]{graphicx}% without figures

\usepackage{subfigure}% with figures
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\topmargin 1mm

\oddsidemargin 1mm

\evensidemargin 1mm

\begin{document}

{\Large \bf Diglib symbols and their corresponding LaTeX symbols}

\vspace{5mm}

The information below gives the closest corresponding LaTeX symbol. All symbols (except +)
must be generated in math mode. Most of these require the package amssymb, i.e., you
need a directive usepackage{amssymb} in the preamble. Two of the symbols require the
more extensive mathdesign that can be included with usepackage[utopia]{mathdesign}.

\vspace{5mm}

{\Large

\begin{tabular}{llll}

Diglib & Latex & Latex name & Note\\

1& $\vartriangle$& $\backslash$vartriangle & amssymb \\

2& $\square$& $\backslash$square\\

3& {\Huge $\diamond$} & $\backslash$diamond & size $\backslash$Large \\

4& $\udtimes$& $\backslash$udtimes & mathdesign \\

5& $\triangledown$& $\backslash$triangledown & amssymb\\ 6 & +& normal + \\

7& $\ast$& $\backslash$ast & amssymb\\

8& $\times$& $\backslash$times \\

9& {\Huge $\circ$}& $\backslash$circ & size $\backslash$Large \\

10& {\Huge $\star$}& $\backslash$star & size $\backslash$Large, amssymb\\

11& $\curlyvee$& $\backslash$curlyvee & amssymb\\

12& $\Join$& $\backslash$Join\\

13&& - & nothing similar, overlapping $> <$\\

14&& - & nothing similar, 10-edged star \\

15& $\maltese$& $\backslash$maltese& mathdesign \\

16&& - & nothing similar, a pentagon \\

17& $\curlywedge$& $\backslash$curlywedge & amssymb\\

\end{tabular}}

\end{document}

LaTeX Formatting Codes
For a list of supported LaTeX commands, see:
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html

http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html
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By default when using the LaTeX command, you are in math mode and Thermo-
Calc automatically interprets the entered text as math. The above link uses the
dollar sign ($) in all the examples but this is NOT required. For example, if you
enter $E=mc^2$ this is displayed including the $ instead of the equation.

As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For
existing users who may have plots and files that use the LTEXT format, and
especially when using Console Mode, the following examples show the
command changes from LTEXT and its LaTeX equivalent:

LTEXT vs LaTeX Commands for Labels

Symbol or text
format LTEXT LaTeX

Subscripts in an
axis text

S-A-TEXT Y N Mole-fraction
Al^DO2$O^DO3$

S-A-TEXT Y N \latex Mole-
fraction Al_2O_3

Label with
subscript add .13 .15 n c-ZrO^DO2$ add .13 .15 n \latex c-ZrO_2

Greek symbol ADD .05 .50 N ^GRd$ ADD .05 .50 N \latex \delta
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PROLOGUE Commands
In this section:

PROLOGUE 15

XSCALE 15

YSCALE 15

XTEXT 15

YTEXT 15

XTYPE 16

YTYPE 16

XLENGTH 16

YLENGTH 16

TIC_TYPE 16

TITLE 17

DIAGRAM_TYPE 17
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PROLOGUE
PROLOGUE is the beginning of a number of consequent lines of user-defined diagram layout
commands. The lines are displayed with the optional text when using the -1 option in the
POST-processor as prompted for the PROLOGUE number with "APPEND_EXPERIMENTAL_
DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on page 254.

Syntax PROLOGUE # optional text

# is an unsigned integer identifying the PROLOGUE.

XSCALE
XSCALE sets the scaling in word coordinates of the X-axis.

Syntax XSCALE min max

min and max are real numbers.

YSCALE
YSCALE sets the scaling in word coordinates of the Y-axis.

Syntax YSCALE min max

min and max are real numbers.

XTEXT
XTEXT sets the X-axis text.

Syntax XTEXT text

text is an arbitrary text string that may contain text-formatting
codes.

YTEXT
YTEXT sets the Y-axis text.

Syntax Y TEXT text

text is an arbitrary text string that may contain text-formatting
codes.
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XTYPE
XTYPE sets the X-axis type as linear (default), logarithmic or inverse.

Syntax XTYPE type

type is a character string reading LIN, LOG or INV.

YTYPE
YTYPE sets the Y-axis type as linear (default), logarithmic or inverse.

Syntax Y TYPE type

type is a character string reading LIN, LOG or INV.

XLENGTH
XLENGTH sets the X-axis length to approximately # centimeters.

Syntax XLENGTH #

# is a positive real number (the approximate X-axis length in
centimeters).

YLENGTH
YLENGTH sets the Y-axis length to approximately # centimeters.

Syntax Y LENGTH #

# is a positive real number (the approximate Y-axis length in
centimeters).

TIC_TYPE
TIC_TYPE sets the relative length of the tic marks.

Syntax TIC_TYPE #

# is a real number. Default value is 1. Negative number gives tics on
the inside of the diagram frame. 0 gives no tics.
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TITLE
TITLE sets the title text string to be printed above the diagram.

Syntax TITLE text

text is an arbitrary text string that may contain text-formatting
codes

DIAGRAM_TYPE
DIAGRAM_TYPE sets the diagram type to square (the default) or triangular.

Syntax DIAGRAM_TYPE type plot_3rd_axis clip_along_third-axis

type is  a character string reading SQUARE (default) or
TRIANGULAR. If type reads TRIANGULAR, then two additional
parameters are given: plot_3rd_axis and clip_along_third-
axis that are characters strings reading YES or NO.
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DATASET Commands
In this section:

DATASET 19

BLOCK 19

BLOCKEND 20

DATAPOINT 20

CLIP 20

ATTRIBUTE 21

LINETYPE 21

DRAWLINE 21

CHARSIZE 22

SYMBOLSIZE 22

GLOBALSIZE 22

COLOR 22

FONT 24

STRING 26

TEXT 28

FUNCTION 28

PCFUNCTION 28

PAINT 29

INCLUDE 29
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DATASET
DATASET indicates the beginning of a number of consequent lines comprising a set of user-
defined data. The DATASET lines are displayed on the terminal along with the optional
text when using the -1 option in the POST-processor as prompted for the DATASET number
in the "APPEND_EXPERIMENTAL_DATA" on page 245 or "QUICK_EXPERIMENTAL_PLOT" on
page 254 command.

Syntax DATASET # optional text

# is an unsigned integer identifying this set of data.

BLOCK
BLOCK defines how the following numeric data block shall be interpreted. The definitions of
X and Y coordinates may also be expressed as a function of the column values, making it
possible to perform transformations.

Syntax BLOCK X&=C#; ...; Y&=C#; ...; GOC=C#,@@@...

&’ are optional unsigned integers that make it possible to plot
several (maximum 9) X- or Y- axis columns. #’ are unsigned
integers identifying the column numbers. The column number #
in “GOC=C#” is the location of any possible GOC codes in the
current data BLOCK; @@@ stands for the default Graphical
Operation Code (GOC) for the current BLOCK. The GOC code
inside the current table is only necessary if the current default
GOC is not applicable.

GOC Characters

The GOC is a combination of the following characters:

Character Meaning

W, V or N To use word (W), virtual (V) or normalized (N) coordinates. W is the default.

A or R XY are absolute (A) or relative (R) values. A is the default.

M or D To perform a move (M) or draw (D) operation to XY. M is the default.
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Character Meaning

B
To apply “soft” splines on a line drawn between the coordinate pairs (used
only on BLOCK data).

S To plot default symbol at XY.

S# To change default symbol to No # symbol and plot it at XY.

‘TEXT

To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT
following the ’ command is interpreted and expanded by the DIGLIB
software, if it includes any ^ operator or STRING names using the ~
descriptor.

BLOCKEND

Syntax BLOCKEND

BLOCKEND terminates the local definition of the graphical operation
code defined by the earlier BLOCK command.

DATAPOINT
DATAPOINT is not a DATASET command, but the basic DATAPLOT command (see synopsis
below) performs an action at the current point determined by the specified X/Y- coordinates.
A DATASET may contain various data points, in addition to one or more data "BLOCK" on the
previous pages. Such data points are separated and independent on each other.

Syntax X Y GOC

X and Y are unsigned real numbers identifying the X/Y-coordinates
for the current data point. GOC stands for Graphical Operation
Code (GOC) for the current point. Legal GOC characters.

Example
0.7 0.95 N'Example 6

0.5 0.08 MNA'E^FS18^SQ(^SK^FS10A+5#8*C#^FS10
-!a^FS18)^FS11+B^DIa#b#$

CLIP
CLIP turns clipping on or off. If it is OFF, it allows output outside the ordinary plot area
defined by normalized coordinates zero and one.
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Syntax CLIP CLP

clp is a character string reading ON or OFF.

ATTRIBUTE
ATTRIBUTE specifies where the current XY position is in the character or symbol plotbox.

Syntax ATTRIBUTE

Prompts attribute

attribute may be TOP, CENTER or BOTTOM. ATTRIBUTE CENTER
is default for symbols; ATTRIBUTE BOTTOM is default for
characters.

LINETYPE
LINETYPE redefines the current linetype in the plot.

Syntax LINETYPE #

# must be an unsigned integer. Legal linetypes are (for both normal
graphical outputs and for PostScript formats):

l Solid (default)

l Long dashed

l Short dashed

l Dotted

DRAWLINE
DRAWLINE draws a line starting at (x1,y1) to (xn,yn) through (x2,y2)à (x(n-1), y(n-1)).
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Syntax DRAWLINE x1,y1 x2,y2 .... xn,yn

x and y may be reals or integers of any value. This is the same as
connecting all points in a table:

CHARSIZE
CHARSIZE redefines the default size of the characters in the plot. The character size has an
initial default value, which may vary with the current font setting and the output device (the
plot format).

Syntax CHARSIZE $$

$$ must be an unsigned real.

SYMBOLSIZE
SYMBOLSIZE redefines the current symbol size setting. The symbol size  has an initial default
value.

Syntax SYMBOLSIZE $$

$$ must be an unsigned real.

GLOBALSIZE
GLOBALSIZE redefines the default global size of the plot. The global size has an initial default
value.

Syntax GLOBALSIZE $$

$$ must be an unsigned real.

COLOR
COLOR redefines the current color setting. There are 22 legal color codes (from 0 to 21).
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Syntax COLOR code

code is an unsigned integer number (from 0 to 21) identifying the
color, or a character string specifying the color.

DIGLIB Color Codes

Code Color Equivalent Character

0 Background Invisible

1 Black Normal

2 Red Very_Thick

3 Green Thin

4 Blue Thick

5 Yellow Very_Thin

6 Magenta Dashed

7 Cyan Dotted

8 Purple

9 Gold

10 Turquoise

11 Pink

12 Gray

13 Orangered

14 Maroon

15 Plum

16 Seagreen

17 Olivedrab

18 Sienna

19 Orange
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Code Color Equivalent Character

20 Coral

21 UserDef

22 and
higher

Any digit larger than 21 has the color effect
as 1 (black).

DIGLIB Color Effects

FONT
FONT redefines the default font setting in the POST-processor.

Syntax FONT #

# is an unsigned integer.
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Font Numbers

Number Font Name

1 Cartographic Roman (the default)

2 Bold Roman script

3 Bold Roman

4 Bold italic

5 Script

6 Bold script

7 UNCIAL

8 Bold Greek

9 Gothic English

10 Gothic Greek
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Examples of all the DIGLIB fonts and line types

STRING
STRING defines a string containing a text and operation codes (e.g., to change the default
font settings).
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Syntax STRING name text_with_each_character_in_
^S#^G^F#^U#^D#^R#^L#^N

name is a valid alphanumeric name (variable) to represent the text
including all text formatting codes. It is highly recommended that
all the characters in the name are in CAPITAL CASE (e.g. ACA2SO4);
otherwise, the defined STRING can be incorrectly plotted.

text_with_each_character_in_^S#^G^F#^U#^D#^R#^L#^N

means the text is coded with each of its characters (and/or numeric
numbers) that are formatted with various operators (^S#, ^G, ^F#,
^U#, ^D#, ^R#, ^L# and/or ^N). #’ are unsigned integers. ^ is the
caret character and does not mean a control character. Between an
# (in an operator) and a numeric number (as a part of the text),
there must always be a comma sign (,) or the number is not plotted
in the text, because the # with the number is interpreted as another
incorrect #. In some of the commands, #=0 resets the option to
previous (or default) value.

String operation codes in the DIGLIB software

For the PostScript hardcopy fonts, these operation codes are not valid; see "LaTeX
Formatting Codes" on page 12:

Operator Operation

^S# Set character size to size #

^G Set font to Greek

^F# Set font to font number #

^U# Move up # units

^D# Move down # units

^R# Move right # units

^L# Move left # units

^N Do not move, remain at current

Examples
STRING Alpha1 ^Ga^F0^D0^S8,1^S0^U0
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is set to α1

STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0

is set to M23C6

STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0

is set to Ca2CO3

TEXT
TEXT outputs, at the current position, the text following the keyword TEXT or the text in the
string string_name that is defined with "STRING" on page 26.

Syntax TEXT text or ~string_name

It is possible to mix ^ operators and previously defined string names
using the ~ operator.

FUNCTION
FUNCTION defines and plots a user-defined function.

Syntax
FUNCTION Y=f(X); start end number_of_XY_pairs; GOC;

FUNCTION X=f(Y); start end number_of_XY_pairs; GOC;

f(X) or f(Y) are legal mathematical functions of X or Y,
understandable by a FORTRAN program. start and end are
unsigned real  numbers, and number_of_XY_pairs an unsigned
integer. GOC is a legal graphical operation code as defined with
"BLOCK" on page 19.

PCFUNCTION
PCFUNCTION appends a user-defined function to the current path. It is used with "PAINT" on
the next page.
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Syntax
PCFUNCTION Y=f(X); start end number_of_XY_pairs; GOC;

PCFUNCTION X=f(Y); start end number_of_XY_pairs; GOC;

f(X) or f(Y) are legal mathematical functions of X or Y,
understandable by a FORTRAN program. start and end are
unsigned real  numbers, and number_of_XY_pairs an unsigned
integer. GOC is a legal graphical operation code as defined with
"BLOCK" on page 19.

PAINT
PAINT paints the area enclosed by the current path in the current pattern. The current path
starts at the last MOVETO given and includes all subsequent DRAWs. This command only
works for the PostScript format (as graphical files or on printed hardcopy).

Also see "PCFUNCTION" on the previous page.

Syntax PAINT <code> <video> <mode>

<> denotes optional parameters. To set a new current pattern,
supply any or all of the optional parameters.

l <code> is a single letter 0-9, A-Z or a-t (if <code>=t, also
supply a space and a number in the range 0.00-1.00). The
default is 0.

l <video> is a string reading NORMAL (the default) or
INVERSE.

l <mode> is a string reading TRANSPARENT (the default) or
OPAQUE.

INCLUDE
INCLUDE adds a file into the current input stream See "Example 5 – Use Included Files for
Predefined Symbols" on page 35.

Syntax INCLUDE filename

filename is a legal filename (with its correct path) for the
operation system.
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Example 1 – Draw Lines and Symbols
$DATAPLOT Example 1

PROLOG 1 EXAMPLE 10<X<100, 0<Y<100

XSCALE 0.00000100

YSCALE 0.00000100

XTYPE LINEAR YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE EXAMPLE 1 XTEXT X

YTEXTY

DATASET 1 Two lines started with two symbols

ATTRIBUTE CENTER

0.050.95 N'Example 1

0.70.95 NS'Line 1

0.70.90 NS2'Line 2 1010S1

2080D

8080S2

8010D

5060
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Example 2 – Draw Polygons and Symbols
$DATAPLOT Example 2

PROLOG 2 EXAMPLE 20<X<100, 0<Y<100

XSCALE 0.00000100

YSCALE 0.00000100

XTYPE LINEAR YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE EXAMPLE 2 XTEXT X

YTEXTY

DATASET 2 Two polygons with three types of symbols ATTRIBUTE CENTER

CLIP OFF

0.050.95 N'Example 2

1.10.95 NS1'SYMBOL 1

1.10.90 NS2'SYMBOL 2

1.10.85 NS3'SYMBOL 3

BLOCK X=C1; Y=C2; GOC=C3,DSWA

4040M

4060

6060S2'CHANGE OF SYMBOL

6040

4040S0

BLOCKEND

BLOCK X=C1*100; Y=C2*100; GOC=C3,DSWA 0.20.2 MS1

0.20.8

0.80.8

0.80.2

0.20.2

BLOCKEND
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Example 3 – Using Strings and Various Line Types
$DATAPLOT Example 3

PROLOG 3 EXAMPLE 3 0<X<10, 0<Y<100

XSCALE 0.0000010

YSCALE 0.00000100

XTYPE LINEAR

YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE EXAMPLE 3 XTEXT X

YTEXT Y

DATASET 3 Draw curves; plot formatted texts and symbols

$Define some strings: STRING BCC ^Ga^F0

STRING BCC1 ^Ga^F0^D0^S8,1^S0^U0

STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0

STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0 STRING AMG2SO4
^Ga^F0^D0^S8Mg^D0^S4,2^S0^U0^S8SO^D0^S4,4^S0^U0

$ Note: if as PostScript output:

$STRING BCC !a

$STRING BCC1 !a^do1$

$STRING M23C6 M^do23$C^do6$

$STRING ACA2CO3 !a^doCa^do2$^doCO^do3$
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$STRING AMG2SO4 !a^doMg^do2$^doSO^do4$ ATTRIBUTE CENTER

CLIP OFF FONT 2

0.05 0.95 N'Example 3

1.10.95 NS1'SYMBOL 1 CHARSIZE 0.2

1.10.90 NS2' SYMBOL 2 CHARSIZE 0.3

1.10.85 NS3'SYMBOL 3 1.10.80 N' ~BCC

1.10.75 NS1'~BCC1+~M23C6

SYMBOLSIZE 0.4

CHARSIZE 0.4

0.41 0.50 N'~ACA2CO3

0.56 0.30 N'~AMG2SO4 CLIP ON

LINETYPE 1

BLOCK X=C1; Y=C1*C1; GOC=C2, DWA

1 2 3 4 5 6 7 8 9          10

BLOCKEND LINETYPE 2

BLOCK X=C1; Y=C1*C1+10; GOC=C2, DWA

0 M 1 2 3 4 5 6 7 8 9          10

BLOCKEND

0 M

Example 4 – Draw Curves Defined by Functions
$DATAPLOT Example 4
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PROLOG 4 EXAMPLE 40<X<100, 0<Y<100

XSCALE 0.00000100

YSCALE 0.00000100

XTYPE LINEAR YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE EXAMPLE 4 XTEXT X

YTEXTY

DATASET 4 Plot two functions as lines: ATTRIBUTE CENTER

0.050.95 N'Example 4

$ Draw two lines defined by FUNCTIONS:

FUNCTION Y=10+0.5*X+20*Sin(X/5); 0 100 100; DWA;

FUNCTION Y=50+0.5*X; 0 100 10; DS1WA;

$ Write functions beside the lines:

$Note the real rotation angle (27 degree) can be seen

$only on the PostScript hardcopy! 0.250.68 N'^RO27Y=50+0.5*X

0.250.45 N'^RO27Y=10+0.5*X+20*Sin(X/5)

Example 5 – Use Included Files for Predefined
Symbols

$DATAPLOT Example 5
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PROLOG 5 EXAMPLE 50<X<100, 0<Y<100

XSCALE 0.00000100

YSCALE 0.00000100

XTYPE LINEAR YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE EXAMPLE 5 XTEXT X

YTEXTY

DATASET 5 Write characters in various fonts, and defined symbols FONT 2

INCLUDE <DATAPLOT-EXAMPLE-PATH>INCLUDE.EXP ATTRIBUTE CENTER

0.050.95 N'Example 5 CLIP OFF

0.010.85 N'~TEST1A

0.010.75 N'~TEST1B

0.010.65 N'~TEST2A

0.010.55 N'~TEST2B

0.010.40 N'~BCC ~BCC1 ~M23C6

0.010.30 N'~ACA2CO3 ~AMG2SO4

The INCLUDE.EXP file has the following content:

STRING TEST 1A ^Ga b c d e f g h i j k^F0

STRING TEST 1B ^Gl m n o p q r s t u v w x y z^F0 STRING TEST2Aa b c d e f g h i j
k

STRING TEST 2B1 m n o p q r s t u v w x y z STRING BCC ^Ga^F0
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STRING BCC1 ^Ga^F0^D0^S8,1^S0^U0

STRING BCC2 ^Ga^F0^D0^S8,2^S0^U0 STRING FCC ^Gc^F0

STRING FCC1 ^Gc^F0^D0^S8,1^S0^U0 STRING FCC2 ^Gc^F0^D0^S8,2^S0^U0

STRING L Liquid STRING SIGMA ^Gs^F0 STRING MU ^Gm^F0 STRING LAVES ^Gl^F0 STRING CHI
^Gx^F0 STRING KSI ^Gr^F0

STRING MCETA ^S12^Gh^F0^S0 STRING M2CM^D0^S8,2^S0^U0C STRING M2CT M^D0^S10,2^S0^U0C
STRING M6CM^D0^S8,6^S0^U0C

STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0 STRING M7C3
M^D0^S8,7^S0^U0C^D0^S8,3^S0^U0 STRING M3C2 M^D0^S8,3^S0^U0C^D0^S8,2^S0^U0 STRING
MC1-X MC^D0^S8,1-x^S0^U0

STRING XC x^D0^S7,C^S0^U0 STRING XFE x^D0^S7,Fe^S0^U0 STRING XMO x^D0^S7,Mn^S0^U0
STRING XW x^D0^S7,W^S0^U0 STRING UW ~XW/(~XMO+~XW)

STRING ac a^D0^S7,C^S0^U0 STRING ACC a^D0^S7,C^S0^U0

STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0 STRING AMG2SO4
^Ga^F0^D0^S8Mg^D0^S4,2^S0^U0^S8SO^D0^S4,4^S0^U0

$ Note: if as PostScript output:

$STRING TEST 1A !a !b !c !d !e !f !g !h !i !j !k^fo27

$STRING TEST 1B !l !m !n !o !p !q !r !s !t !u !v !w !x !y !z^fo27

$STRING TEST 2Aa b c d e f g h i j k

$STRING TEST 2B1 m n o p q r s t u v w x y z

$STRING BCC !a

$STRING BCC1 !a^do1$

$STRING BCC2 !a^do2$

$STRING FCC !c

$STRING FCC1 !c^do1$

$STRING FCC2 !c^do2$

$STRING L Liquid

$STRING SIGMA !s

$STRING MU !m

$STRING LAVES !l

$STRING CHI !x

$STRING KSI !r

$STRING MCETA !h

$STRING M2CM^do2$C

$STRING M2CT M^do2$C

$STRING M6CM^do6$C

$STRING M23C6 M^do23$C^do6$

$STRING M7C3 M^do7$C^do3$

$STRING M3C2 M^do3$C^do2$
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$STRING MC1-X MC^do1-x$

$STRING XC x^doC$

$STRING XFE x^doFe$

$STRING XMO x^doMo$

$STRING XW x^doW$

$STRING UW ~XW/(~XMO+~XW)

$STRING ac a^doC$

$STRING ACC a^doC$

$STRING ACA2CO3 !a^doCa^do2$^doCO^do3$

$STRING AMG2SO4 !a^doMg^do2$^doSO^do4$

Example 6 – Plot Triangular Diagrams for Ternary
Systems

$DATAPLOT Example 6

PROLOG 6 EXAMPLE 6 0<X<0.969224, 0<Y<1.00000

XSCALE 0.000000.969224

YSCALE 0.307492E-011.00000

XTYPE LINEAR YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000 TITLE A-B-C at T=1000 K XTEXT MOLE_FRACTION B YTEXT MOLE_FRACTION
C

DIAGRAM_TYPE TRIANGULAR YES YES

DATASET 6 Plot a ternary phase diagram CLIP OFF

0.70 0.95 N'Example 6 0.85 0.30 N'B2C

0.54 0.87 N'Diamond CHARSIZE 0.25

1.4E+01 1.10E+01 MVA'1:*B2C Liquid

1.4E+01 1.05E+01 MVA'2:*Diamond Liquid

0.10 0.10 N'Liquid

0.48 0.45 N'Diamond+

0.48 0.40 N' B2C+Liquid 5.80E-01 5.40E-02 MWA' 1

1.90E-01 2.40E-01 MWA' 1

0.65E-01 2.50E-01 MWA' 2

CHARSIZE 0.45

-0.10 -0.05 N'A

1.06 -0.05 N'B

0.500.95 N'C

CHARSIZE 0.35
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$$ Calculated A-B-C Phase Equilibrium Data:

$ PHASE REGION FOR:

$F0 LIQUID

$E DIAMOND_A4

$F0 B2C

$ INVARIANT EQUILIBRIUM COLOR2

BLOCK X=C1; Y=C2;GOC=C3,WAD; 2.4555855989E-013.5568857193E-01M

0.0000000000E+009.9999523163E-01

2.4555855989E-013.5568857193E-01M

6.6666668653E-013.3333334327E-01

0.0000000000E+009.9999523163E-01M

6.6666668653E-013.3333334327E-01 COLOR1

BLOCKEND

$ PHASE REGION FOR:

$E LIQUID

$F0 B2C

BLOCK X=C1; Y=C2;GOC=C3,WAD;

$ PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)

2.2030337155E-011.2340000272E-01M

2.2632879019E-011.1058768630E-01

2.3371633887E-019.9345825613E-02

2.4253317714E-018.9345827699E-02

2.6429468393E-017.2744041681E-02

2.8429466486E-016.2814079225E-02

2.9617273808E-015.8319382370E-02

3.2811737061E-014.9470417202E-02

3.6353862286E-014.3130427599E-02

3.9895987511E-013.8979098201E-02

4.5209178329E-013.5266116261E-02

5.2293431759E-013.3152002841E-02

6.1148744822E-013.3077053726E-02

6.4690870047E-013.3490389585E-02

6.8232995272E-013.4017231315E-02

7.3546189070E-013.4814555198E-02

7.5317251682E-013.5033416003E-02

8.0630439520E-013.5373892635E-02

8.5943627357E-013.4983776510E-02
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9.1256815195E-013.3575300127E-02

9.6747112274E-013.0857827514E-02

9.6922445297E-013.0749246478E-02

2.2030337155E-011.2340000272E-01M

2.1294665337E-011.5308913589E-01

2.1171525121E-011.8851040304E-01

2.1532440186E-012.2393165529E-01

2.2180187702E-012.5935292244E-01

2.2992117703E-012.9477417469E-01

2.3888295889E-013.3019542694E-01

2.4555855989E-013.5568857193E-01

$ PLOTTED COLUMNS ARE : X(B2C,B) and X(B2C,C) 6.6666668653E-013.3333334327E-01M

6.6666668653E-013.3333334327E-01

$ TIELINES COLOR3

6.6666668653E-013.3333334327E-01M

8.7775242329E-013.4625384957E-02

6.6666668653E-013.3333334327E-01M

7.9250496626E-013.5342670977E-02

6.6666668653E-013.3333334327E-01M

2.4555824697E-013.5568737984E-01

6.6666668653E-013.3333334327E-01M

2.3944084346E-019.2542596161E-02

6.6666668653E-013.3333334327E-01M

2.3359020054E-013.0954307318E-01

6.6666668653E-013.3333334327E-01M

2.2585247457E-012.7766343951E-01

6.6666668653E-013.3333334327E-01M

2.1618695557E-011.3621240854E-01

2.2632879019E-011.1058768630E-01M

6.6666668653E-013.3333334327E-01 COLOR1

BLOCKEND

$ PHASE REGION FOR:

$F0 DIAMOND_A4

$E B2C

BLOCK X=C1; Y=C2;GOC=C3,WAD;

$ PLOTTED COLUMNS ARE : X(DIAMOND_A4,B) and X(DIAMOND_A4,C)
0.0000000000E+009.9999523163E-01M
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0.0000000000E+009.9999976158E-01 BLOCKEND

$ PHASE REGION FOR:

$E LIQUID

$F0 DIAMOND_A4

BLOCK X=C1; Y=C2;GOC=C3,WAD;

$ PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)

2.45558E-01 3.55688E-01 M

2.02635E-01 3.34830E-01

1.62439E-01 3.13753E-01

1.22439E-01 2.91531E-01

8.24390E-02 2.68542E-01

4.24390E-02 2.45480E-01

2.43905E-03 2.23138E-01

2.49999E-07 2.21816E-01

$ TIELINES COLOR3

0.00000E+00 9.99995E-01 M

2.35291E-01 3.50859E-01

0.00000E+00 9.99994E-01 M

1.98265E-01 3.32609E-01

0.00000E+00 9.99994E-01 M

1.32400E-01 2.97160E-01

0.00000E+00 9.99993E-01 M

1.14399E-01 2.86953E-01 BLOCKEND
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Example 7 – Color Codes and Effects
$DATAPLOT Color Codes & Color Effects

PROLOG 10 Color Codes 0<X<1.0, 0<Y<1.0

XSCALE 0.01.0

YSCALE 0.01.0

XTYPE LINEAR

YTYPE LINEAR

XLENGTH 11.5000

YLENGTH 11.5000

TITLE Color Outputs XTEXT Color Codes YTEXT Color Effects

DATASET 10 Various Color Codes for Color Outputs: CHARSIZE 0.3

LINETYPE 1

BLOCK X=C1; Y=C2;GOC=C3,WAD;

0.05 0.95 MNA'Color Code: Color Effect

0.55 0.95 MNA'Color Code: Color Effect CHARSIZE 0.25

COLOR 1

0.05 0.88 MNA'1: Black CLIP ON

0.22 0.88 M

0.45 0.88

CLIP OFF COLOR 2

0.05 0.82 MNA'2: Red CLIP ON
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0.22 0.82 M

0.45 0.82

CLIP OFF COLOR 3

0.05 0.76 MNA'3: Green CLIP ON

0.22 0.76 M

0.45 0.76

CLIP OFF COLOR 4

0.05 0.70 MNA'4: Blue CLIP ON

0.22 0.70 M

0.45 0.70

CLIP OFF COLOR 5

0.05 0.64 MNA'5: Yellow CLIP ON

0.22 0.64 M

0.45 0.64

CLIP OFF COLOR 6

0.05 0.58 MNA'6: Magenta CLIP ON

0.22 0.58 M

0.45 0.58

CLIP OFF COLOR 7

0.05 0.52 MNA'7: Cyan CLIP ON

0.22 0.52 M

0.45 0.52

CLIP OFF COLOR 8

0.05 0.46 MNA'8: Purple CLIP ON

0.22 0.46 M

0.45 0.46

CLIP OFF COLOR 9

0.05 0.40 MNA'9: Gold CLIP ON

0.22 0.40 M

0.45 0.40

CLIP OFF COLOR 10

0.05 0.34 MNA'10: Turquoise CLIP ON

0.22 0.34 M

0.45 0.34

CLIP OFF COLOR 11

0.05 0.28 MNA'11: Pink CLIP ON

0.22 0.28 M
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0.45 0.28

CLIP OFF COLOR 12

0.05 0.22 MNA'12: Gray CLIP ON

0.22 0.22 M

0.45 0.22

CLIP OFF COLOR 13

0.05 0.16 MNA'13: Orangered CLIP ON

0.22 0.16 M

0.45 0.16

CLIP OFF COLOR 14

0.05 0.10 MNA'14: Moroon CLIP ON

0.22 0.10 M

0.45 0.10

CLIP OFF COLOR 15

0.05 0.04 MNA'15: Plum CLIP ON

0.22 0.04 M

0.45 0.04

CLIP OFF COLOR 16

0.55 0.88 MNA'16: Seagreen CLIP ON

0.72 0.88 M

0.95 0.88

CLIP OFF COLOR 17

0.55 0.82 MNA'17: Olivedrab CLIP ON

0.72 0.82 M

0.95 0.82

CLIP OFF COLOR 18

0.55 0.76 MNA'18: Sienna CLIP ON

0.72 0.76 M

0.95 0.76

CLIP OFF COLOR 19

0.55 0.70 MNA'19: Orange CLIP ON

0.72 0.70 M

0.95 0.70

CLIP OFF COLOR 20

0.55 0.64 MNA'20: Coral CLIP ON

0.72 0.64 M

0.95 0.64
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CLIP OFF COLOR 21

0.55 0.58 MNA'21: UserDef CLIP ON

0.72 0.58 M

0.95 0.58

CLIP OFF COLOR 22

0.55 0.52 MNA'22 = 1 CLIP ON

0.72 0.52 M

0.95 0.52

CLIP OFF COLOR 23

0.55 0.46 MNA'23 = 1 CLIP ON

0.72 0.46 M

0.95 0.46

CLIP OFF

BLOCKEND
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Thermodynamic and Kinetic/Mobility Databases
This guide describes how to define and construct a thermodynamic or kinetic database. It
includes details about the data structures and formats of the Thermo-Calc databases as well
as the Diffusion Module (DICTRA) database-extensions.

The Thermo-Calc databases are created and maintained in the Thermo-Calc Database
Format (TDB) which is an international standard for the CALPHAD-type thermodynamic
calculations and kinetic simulations. This document gives a full description of the TDB
format (with the Diffusion Module (DICTRA) database extension) and is a comprehensive
guide about how to create and manage a Thermo-Calc (and Diffusion Module (DICTRA))
database.

Usually, a Thermo-Calc or Diffusion Module (DICTRA) database is constructed as a single
text file with an extension of TDB, for example, PAQS2setup.TDB. For some databases
(especially large databases used with older versions of Thermo-Calc or Diffusion Module
(DICTRA)) a database may consist of one primary-definition file (***setup.TDB) and several
additional-definition TDB files (such as ***param.TDB, ***funct.TDB, ***refer.TDB, etc.
These are built for a variety of defined parameters, functions, references and so forth, and
are linked to the ***setup.TDB file through the correct use of the "TYPE_DEFINITION " on
page 21 and/or "FTP_FILE" on page 24 commands inside the ***setup.TDB file.

With Thermo-Calc, Precipitation Module (TC-PRISMA) and Thermo-Calc
Software Development Kits (SDKs), you can code everything into a single
***setup.TDB file for a database at any scale.

Initialization of the DATA Module
The following explains how a database initiation file (or a database directory file) is
constructed to work with the DATA module. When you start, DATA looks for this file that has
information about the available predefined databases.

The database initiation file is called:

l Windows: TC_INITD.TDB (or TC_INITD)

l Linux/UNIX: initd.tdb

You can have your own file, but it is more efficient to define an environment variable with
the default name as above, and then during installation, translate it to a common initiation
file name. The common file is automatically copied by the Thermo-Calc installation script to
the following directories:
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l Windows: \DATA\ under the directory defined by the TCPATH parameter

l Linux/UNIX:/data/ under the directory defined by the TC_DATA parameter.

The database manager can find the file on a local computer (independent installations) or a
connected server (server installations).

When editing or modifying the definitions of initiation parameters (including short-names,
paths and subdirectories, database definition file names, and instructive database
descriptions) for the available databases in the database initiation file a specific format is
used with the fields:

l The first field gives the abbreviated name for the database (to a maximum of five
characters)

l The second field specifies a path and filename (maximum 78 characters) containing
the database path definition and the actual database definition (setup) file name,
where the extension is either TDB (which stands for original textual TDB file) or TDC
(which is encrypted from the original TDB file). There are differences between
platforms with respect to entering parameters as listed in the table.

l The third field (maximum 60 characters) details an optional full name (and
version/subversion numbers) for the brief database description.

Initiation Parameter Examples

Parameter Windows Linux/Unix

The setup file name must consist of a
main part and an extension of a
maximum of three characters:

For example,
SSOL5SETUP.TDB

For example,
ssol5setup.tdb

Database path definition Use a back-slash \
Use a forward-
slash /

All databases should be normally
located in subdirectories that are under
the directory defined by the:

TCPATH parameter or
under its subdirectory
\DATA\

TC_DATA
parameter or
under its
subdirectory
/data/
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Each entry record (i.e. for a single database) must finish with an exclamation
mark !. There should be no spaces or commas within the first and second fields
since these characters are taken as field separators, while spaces or commas
can be used in the third field.

You can write each database entry on one or two lines (up to the!), it is recommended that
the third field is added as follows:

l Windows: on the same line as the first and second fields.

l Linux/UNIX: on the following line.

The following are examples of an initiation file defining two databases named SSOL6 and
TCFE8.

Windows

SSOL6 TCPATH\DATA\SSOL6\SSOL6SETUP.TDC SGTE Solutions Database
version 6.0 !

TCFE8 TCPATH\DATA\TCFE8\TCFE8SETUP.TDC TCS Steels/Fe-Alloys
Database version 8.0 !

Linux/UNIX

ssol5 TC_DATA/data/ssol5/ssol5setup.tdc

SGTE Solutions Database version 5.1 !

Tcfe8 TC_DATA/data/tcfe8/tcfe8setup.tdc

TCS Steels/Fe-Alloys Database version 8.0 !
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Database Definition File Syntax
The database definition (*.TDB) file (normally named ***setup.TDB) consists of a set of
keyword codes each followed by one or several parameters (arguments).

l A complete keyword entry must end with an exclamation mark (!).

l A single keyword entry can be up to 2000 characters long. However, the maximum
length of a line in an *.TDB file is 78 characters--it may be necessary to continue the
keyword parameter (arguments) on several lines. The ! must be at the end of the last
line.

l It is recommended to always have at least one empty space at the beginning of each
continuation line for the keyword parameters (arguments); otherwise, the DATA
module can misunderstand the parameters (or arguments), or issue an error
message.

l The keyword and its various parameters (arguments) are separated by a space or a
comma.

l A dollar sign ($) in the first position of the line indicates that the line is a comment
line, which is ignored by the DATA module.

When the database is selected the DATA module only reads the database definition file
(***setup.TDB) once, from beginning to end. The DATA module checks continuously when
reading the definition file. This implies that (nearly) everything must be declared or defined
before it is used in any other way.

For example, if the GRAPHITE phase is to be included in the database definition, the element
C (carbon) and the phase GRAPHITE must be defined before declaring that carbon dissolves
in graphite. This definition order is necessary to build the internal data structure acceptable
by the DATA module (during its consistency checking).

This topic gives a description of the available keywords and the appropriate arguments. A
basic knowledge of the Gibbs Energy System (GIBBS) module is assumed.

This syntax is used:

KEYWORD [arg.1]*# [arg.2]*## {optional arg.3}!

The keywords are written in full length but can be abbreviated as long as the abbreviation is
unique. A keyword may have syntax consisting of several arguments and optional
arguments. The number, # or ##, in the notation, [...]*# or [...]*##, indicates an argument
with a maximum length of # ASCII characters.
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Arguments within square brackets [...] must always be given, but are optional
when enclosed in curly brackets {...}.

ELEMENT
ELEMENT [element name]*2 [ref. state]*24 [mass] [H298] [S298] !

The element name (maximum two characters) is the one found in the periodic chart but
there are no naming restrictions. However, the GIBBS module only recognizes UPPER-case
element names (if the Upper Case Mode is selected by the GIBBS command "REINITIATE" on
page 127), which means that lower-case (if defined in a database) is automatically
converted to UPPER-case by the DATA/GIBBS module.

The elements are automatically entered as species using the same names of the elements.
If, for example, the species corresponding to FE needs to be named FE1, you can define the
species as FE1, which results in an element named FE and a species named FE1. Vacancies
(VA) and electrons (denoted either as /- in gaseous, liquid or solid phases, or ZE in an
aqueous solution phase), need to be entered as special elements for correct handling by the
DATA module.

The reference (ref.) state (maximum 24 characters) is the stable phase (at 298.15 K and 1
bar) that should contain this element and be used as the reference state for all element
thermodynamic data. The mass, given in gram per mole, is used in various calculation
programs and should always be given the correct value. H298 and S298 denote the enthalpy
and entropy difference between 0 and 298.15 K for the element in SI units. If these are
unknown, the values can be set to zero. All this information (reference state, H298 and S298)
define the SER (Stable Element Reference state).

Examples

ELEMENT /- ELECTRON_GAS      0.0 0.0 0.0 !

ELEMENT VA VACUUM            0.0 0.0 0.0 !

ELEMENT ZE UNIT_CHARGE       0.0000000001 0.0 0.0 !    

ELEMENT AL FCC_A1            26.98154 4577.296 28.3215 !

ELEMENT C GRAPHITE          12.011 1054.0   5.74 !   

ELEMENT FE BCC_A2            55.847 4489    27.28 !   

ELEMENT O 1/2_MOLE_O2(G)    15.9994 4341   102.5158 ! 

ELEMENT TI HCP_A3            47.88  4810    30.648 !  
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ELEMENT ZR HCP_A3            91.224 5566.27 39.181 !  

ELEMENT ZY DUMMY              1        1        1 !   

SPECIES
SPECIES [species name]*24 [stoichiometric formula] !

This keyword defines species in the data structure. Every species name (maximum 24
characters) must be unique. The species are built from the predefined set of elements in the
stoichiometric formula. If an undefined element is referenced, DATA displays an error
message and the data structure is probably damaged.

The species names do not have to be the same as the stoichiometry formula, although in
general this is recommended. The elements are automatically entered as species using the
same names of the elements.

You can define a species name as a mixture of UPPER-case and lower-case
letters in a database, but the DATA module automatically converts all lower-
case to UPPER-case because the GIBBS module only recognizes UPPER-case
species names.

When naming the species in a database, use special characters (such as +, -, _, / and .) in
species names. Avoid using other special characters (such as ( and )).

The stoichiometric formula is written with a simplified chemical notation, in which the
chemical elements should always be given in UPPER-case and in any preferred order, and
the stoichiometric coefficients are written in either real numerical factors or integer digits.

It is important that the numerical factor of 1 is not left out. Subgroups are not
allowed in a stoichiometry formula; however, while specifying the stoichiometry
formula for a specific species in a database, you can specify it in a way that
some elements (always together with the corresponding partial stoichiometric
coefficients) are repeated (as in the examples below).

Examples

SPECIES AL2O3     AL2O3 !

SPECIES Silica    SI1O2 !

SPECIES NaSb_6OH  NA1SB1O6H6 !

SPECIES FE+2       FE/+2 !
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SPECIES SB-3       SB/-3 !

SPECIES AlCl2/3           AL.33333CL.666667 !

SPECIES AL1CL1H2O2        AL1CL1H2O2 !

SPECIES AlCl3_3H2O        AL1CL3H6O3 !

SPECIES AlO2H2Cl.H6O3     AL1O2H2CL1H6O3 !

SPECIES AlCl2-OH.3H2O     AL1CL2O1H1H6O3 !

SPECIES AlCl2OH.3Water    AL1O1H1CL2H6O3 !

PHASE
PHASE [phase name]*24 [data-type code]*8 [numb. subl.] [sites in
subl. 1] [sites in subl. 2] etc... {auxiliary text string} !

This keyword defines a phase and its properties (except for what species are allowed to
enter it and for its parameters).

The phase name (maximum 24 characters) must be unique; otherwise the DATA module
sees it as an attempt to redefine a previously defined phase. This causes DATA to display an
error message and ignore the rest of the line. A phase name can be suffixed by an
underscore (_and letters to identify the physical state(s) or structure type(s) of the phase.

Examples of Recommended Suffixes

Suffix Definition

ABC_S The ABC phase in solid state.

ABC_S2 The ABC phase in solid state 2.

ABC_S3 The ABC phase in solid state 3.

ABC_LT The ABC phase in solid state at low temperatures.

ABC_HT The ABC phase in solid state at high temperatures.

ABC_L The ABC phase in liquid state.

ABC_LIQ The ABC phase in liquid state.

FCC_A1 The FCC phase in disordered structure type A1.

FCC_L12 The FCC phase in ordered structure type L12.

The phase name can also be attached with a colon sign (:) and a letter for a legal GIBBS
phase-type code (e.g. IONIC_LIQ:Y and GAS:G).
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GIBBS Phase-type Codes

Code Definition

G Bit set for a gaseous mixture phase.

A Bit set for an aqueous solution phase.

Y
Bit set for an ionic liquid solution phase (specially treated by the Ionic Two-
Sublattice Liquid Model).

L Bit set for a liquid solution phase (but not A (aqueous) or Y (ionic liquid)).

I
Bit set for a phase with charged species (but not G (gaseous), A (aqueous) or Y
(ionic liquid)).

F
Bit set for an ordered FCC or HCP solution phase using the Four Substitutional-
Sublattice Ordering Model (additionally, such a phase can also have interstitial
sublattices).

B
Bit set for an ordered BCC solution phase using the Four Substitutional-Sublattice
Ordering Model (additionally, such a phase can also have interstitial sublattices).

Other invalid characters (e.g. M or P) are eventually treated, together with the
colon (:) as a part of a phase name.

A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a
substitutional phase without sublattice, and an L phase (ordinary liquid solution) is normally
(but not always) modelled as a substitutional phase without sublattice, too.

For ordered FCC or HCP phases, these four substitutional sublattices represent four corners
of the regular tetrahedron on these lattices, all of which are the nearest neighbours, as
shown.

FCC Unit Cell Example

An FCC unit cell with the lattice positions indicated that correspond to the G (FCC,A:B:C:D)
end member. All lattice positions are equivalent for a four substitutional-sublattice ordering
model.
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A Normal 4-Sublattice Model requires that all the G parameters for each of the end-
members with the same elements but distributed on different sites be given separately.
However, as these corners are identical lattice points, the phase-type option F means that
the G parameters need be given only once. The possible permutations are handled
automatically.

Additional clarification

An A-B binary solution phase (with the element A located on one sublattice site and B on the
other three sublattice sites) treated by the Normal 4-Sublattice Model has to have four G
parameters for four end-members, i.e.

l G(phase,A:B:B:B)

l G(phase,B:A:B:B)

l G(phase,B:B:A:B, and

l G(phase,B:B:B:A)

This is because in the general case these G parameters can be different from each other. But
for the FCC and HCP orderings, they are identical and thus all G parameters of such end-
members need to be given only once, and the possible permutations are then automatically
handled by the GIBBS module. Also, only one of the identical permutations is listed; in this
example, G(phase,A:B:B:B)where it is alphabetically the first in the list of permutations.
This significantly simplifies the usage of this model (Four Substitutional-Sublattice Ordering
Model) in multicomponent alloys.
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For ordered BCC phases, the phase-type option B means the same thing but it is more
complicated since the 4-substitutional-sublattice ordering phase represents an irregular
tetrahedron with two pairs of sites that are next nearest neighbours as shown:

BCC Unit Cell Example

Two BCC unit cells with the lattice positions indicated that correspond to the G
(BCC,A:B:C:D,0) end member. Lattice positions (A) and (B) are equivalent, as are lattice
positions (C) and (B) for a four substitutional-sublattice ordering model.

For an end member described by the parameter G (phase,A:B:C:D) A and B are next
nearest neighbours, as are C and D. And the nearest neighbours of A (or B) are C and D.
Thus, for an A-B binary solution phase (with the element A located on two sublattice sites
and B on two sublattice sites) treated by the Normal 4-Sublattice Model, the end-member
described by the G(phase,A:A:B:B) term has four nearest neighbour bonds between A and
B atoms, whereas the end-member described by the G(phase,A:B:A:B) term has two
nearest neighbour bonds between A and B atoms and three next nearest neighbour bonds.

The first end-member (described by the G(phase,A:A:B:B) term) represents B2-ordering
and the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There
are two permutations of the G(phase,A:A:B:B) term and four permutations of the G
(phase,A:B:A:B) term, automatically conducted in the Four Substitutional-Sublattice
Ordering Model. If you enter the unary, binary, ternary and quaternary parameters you are
dealing with 1, 6, 21, 55 parameters for BCC:B, 1, 5, 15, 35 parameters for FCC:F and 1, 16,
81, 256 parameters for phases without F/B.

An additional feature with the phase-type options F and B is that a composition set that
represents the solution phase has a suffix (indicating what ordering the phase has) that is
automatically added to its phase name in some listings of equilibrium calculations (when
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performing either single-point or stepping or mapping calculations, and when plotting the
calculated property diagrams or phase diagrams).

Such suffix indications can be:

Solution Phase Suffix for Disordered
Phase

Suffix for Ordered
Phase

FCC PHASE FCC_A1
FCC_L12

FCC_L10

BCC PHASE BCC_A2

BCC_B2

BCC_B32

BCC_D03

BCC_L21

HCP PHASE HCP_A3
HCP_D019

HCP_B19

If you want to convert an existing database TDB-file to use the F/B feature, add
the phase-type code to the corresponding phase name in the PHASE and
CONSTITUENT commands in the TDB-file, then when running the LIST_DATA
command in the GES module. The created database file is in this less verbose
format.

The data-type code consists of 1 to 8 characters where each character must stand for an
action, which is to be coupled to this phase. The keyword "TYPE_DEFINITION " on page 21,
described below, must be used in the current database to specify what action should be
taken by DATA for each character code.

The data entries [numb. subl.] [sites in subl. 1] [sites in subl. 2] etc., specify
the total number of sublattices (always as an integer digit) and the sites (i.e. stoichiometric
coefficients) of each of the sublattices (given in either integer digits or real numerical
factors) for the phase.

Optionally, an auxiliary text string (maximum 78 characters) can be given after the last [sites
in sublattice #] but before the exclamation mark !. This string displays in connection with
the phase name in some listings within the DATA module.

Examples

PHASE GAS:G % 1 1.0 !
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PHASE LIQUID:L %ZCDQ 2 1.0 1.0

> Metallic liquid solution, modelled by CEF Model. !

PHASE IONIC-LIQ:Y %ZCDQ 2 1.0 1.0

> Ionic liquid solution, modelled by Ionic Two-Sublattice Model. !

PHASE SPINEL:I   %ZA  4  1 2 2 4 

> Complex Spinel Solution, by CEF model with ionic constraints. !

PHASE M23C6 % 3 20.0 3.0 6.0 !

PHASE FCC_A1   %&A 2 1 1

> Disordered FCC phase; also as MX carbides/nitrides. !

PHASE FCC_L10  %&AX 3 0.75 0.25 1

> Ordered FCC phase, modelled by 2-Sublattice Model for Ordering.
!

PHASE FCC_L12:F %&AX 5 0.25 0.25 0.25 0.25 1.0

> Ordered FCC phase, modelled by 4-Sublattice Model for Ordering.
!

PHASE AQUEOUS:A %HIJMR 1 1.0

> Aqueous Solution: using the Complete Revised HKF Model. !

CONSTITUENT
CONSTITUENT [phase name]*24 [constituent description]*2000 !

This keyword (and the "ADD_CONSTITUENT" on the next page keyword for large solution
phase) defines the phase-constitution as a list of constituents (for a substitutional phase with
no sublattice) or of constituent arrays (for a sublattice phase).

The phase name (maximum 24 characters) must be a predefined phase (i.e. already through
the "PHASE" on page 11 keyword).

It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F
and B) in its phase definition (already by the PHASE keyword; such as GAS:G,
SLAG:L, LIQUID:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B,
AQUEOUS:A), such a valid phase-type code must also always be attached to the
phase name in the CONSTITUENT keyword (and the ADD_CONSTITUENT
keyword).
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Specifying the phase name in UPPER-case is recommended. You can define a
phase name as a mixture of UPPER-case and lower-case letters in a database,
but the DATA module automatically converts all lower-case to UPPER-case
because the GIBBS module only recognizes UPPER-case phase names.

The constituent description (maximum 2000 characters) is a list of the species that enter a
phase. The list starts with a colon (:), indicating the start of the sub-list of species for the
first sublattice, and different sublattices are separated by colons. The complete sequence
ends with a final colon.

Optionally, each sublattice may specify which species are considered to be major
constituents. This is done by adding a percent sign (%) directly to the species name. The start
values on the site fractions of the major constituents should sum to 0.99 on a specific
sublattice. Thus, the minor constituents (i.e. those without a %) add up to 0.01. A maximum
of 2000 characters can be coded in the constituent description, continuing in sequent lines. If
the phase has a constituent description longer than 2000 characters, the rest can be coded
in one or several ADD_CONSTITUENT keywords.

Examples

CONSTITUENT BCC_A2 :FE

CONSTITUENT IONIC-LIQ:Y :FE+2 : SB-3: !

CONSTITUENT M23C6 :CR FE :FE CR W MO : C: !

CONSTITUENT AQUEOUS:A :H2O% AG+1 AGF AGCL AGCL2-1 AGI3-2 AGSO4-1
AGC2H4+1

AGN2H6+1 AGC2N2-1 AGC2H4NO2 AL+3 ALF3 ALO2-1, ... : ! 

CONSTITUENT SPINEL:I : AL+3% CR+3 FE+2% FE+3 MG+2% NI+2

: AL+3% CA+2 CR+3 FE+2 FE+3 MG+2% NI+2 VA

: FE+2 MG+2 VA%

: N-3 O-2% :!

ADD_CONSTITUENT
ADD_CONSTITUENT [phase name]*24 [constituent description]*2000 !

This keyword adds more constituents to a phase that already has some constituents. Its
syntax is the same as for the "CONSTITUENT" on the previous page keyword. This keyword
can be used several times, if the phase is very large, e.g. a gaseous mixture or a complex
aqueous solution. This is useful when there are so many constituents in a phase that the
2000 characters available for the constituent description list is not enough.

Constituents are not necessary on all sublattices. In the second example below,
no addition is made to the first sublattice.
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Examples

ADD_CONSTITUENT GAS :S1 S2 S3 ... : !

ADD_CONSTITUENT IM-PHASE : :CR:W ... : !

ADD_CONSTITUENT AQUEOUS:A :CUCL+1 CUCL2 CUCL2-1 CUCL3-2 CUOH+1
CUO2H2 CUO3H3-1

CUO4H4-2 CU2OH+3 CU2O2H2+2 CU3O4H4+2 NIO2H2 NIO3H3-1 NIO4H4-2
NI2OH+3

NI4O4H4+4 ZNOH+1 ZNO2H2 ZNO3H3-1 ZNO4H4-2 ... : !

COMPOUND_PHASE
COMPOUND_PHASE [phase name]*24 [data-type code]*8 [constituent] !

The keyword is a compact way to simultaneously define a species, a compound phase
(maximum 24 characters) and its phase-constituent. It is useful for stoichiometric phases
with constant compositions. The species name and stoichiometric formula must be identical,
i.e. being the given constituent. The phase has this species as its only constituent. This
keyword allows the database definition file for a large substance database to be more
compact; it is a combination of the "SPECIES" on page 10, "PHASE" on page 11 and
"CONSTITUENT" on page 16 keywords.

Examples

COMPOUND_PHASE AL2O3 % AL2O3 !

COMPOUND_PHASE MAGNETITE %MF FE3O4 !

COMPOUND_PHASE QUARTZ % SIO2 !

ALLOTROPIC_PHASE
ALLOTROPIC_PHASE [phase name]*24 [data-type code]*8 [constituent]
!

This keyword does the same as the "COMPOUND_PHASE" above keyword for entering an
allotropic phase (maximum 24 characters), but does not enter the constituent as a species to
the data structure. Use this if the species is already defined.
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Examples

ALLOTROPIC_PHASE BETHA-AL2O3 % AL2O3 !

ALLOTROPIC_PHASE CRISTOBALITE % SIO2 !

ALLOTROPIC_PHASE TRIDYMITE % SIO2 !

TEMPERATURE_LIMITS
TEMPERATURE_LIMITS [lower limit] [upper limit] !

This keyword sets the default upper and lower temperature limits used by the GIBBS module
for Gibbs energy parameters and functions. It can be used only once in one database
definition file and all its sequential files.

Example

TEMPERATURE_LIMITS 500.0 1800.0 !

DEFINE_SYSTEM_DEFAULT
DEFINE_SYSTEM_DEFAULT [keyword] {G-ref. type index} !

This keyword sets the default value to ELEMENT or SPECIES in the DATA command "DEFINE_
SYSTEM" on page 15 in the Thermo-Calc Console Mode Command Reference.

For a substance database, it can be appropriate to have ELEMENT as a default value
whereas a large solution database can benefit from having SPECIES as a default value. A
proper default value is useful for beginners. An advanced user is more likely to use the DATA
commands DEFINE_ELEMENT and DEFINE_SPECIES to override the default value.

{G-ref. type index} is an integer indicating the reference state type for an element when
entering and listing data in the GIBBS module. The following lists legal numbers and the
corresponding meaning (the reference state type for an element):

Number Definition

1 symbol: G

2 symbol: H298

3 symbol: H0
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Example

DEFINE_SYSTEM_DEFAULT element 2 !

DEFAULT_COMMAND
DEFAULT_COMMAND [secondary keyword and parameters] !

This keyword specifies commands to be executed by the DATA module at database
initialization. The syntax of the available command is currently not the same as the user
available DATA commands but the actions are similar. The available secondary keyword and
parameters in syntax are:

DEFINE_SYSTEM_ELEMENT [element names]

DEFINE_SYSTEM_SPECIES [species names]

DEFINE_SYSTEM_CONSTITUENT [phase] [sublattice] [species]

REJECT_SYSTEM_ELEMENT [element names]

REJECT_SYSTEM_SPECIES [species names]

REJECT_SYSTEM_CONSTITUENT [phase] [sublattice] [species]

REJECT_PHASE [phase names]

RESTORE_PHASE [phase names]

Examples

DEFAULT_COMMAND DEFINE_SYSTEM_ELEMENT FE VA !

DEFAULT_COMMAND REJECT_SYSTEM_CONSTITUENT LIQUID 2 C !

DEFAULT_COMMAND REJECT_PHASE LIQUID !

DEFAULT_COMMAND RESTOR_PHASE GAS !

DATABASE_INFORMATION
DATABASE_INFORMATION [text]*10000 !

This keyword defines a text for the detailed description of the current database. The text can
be listed with the DATA command DATBASE_INFORMATION. An apostrophe (') can be used
in the text to indicate a new line; and two apostrophes, ('') can be used in the text to
indicate a new line plus an empty line.

The continuous text length (each line with max 78 characters) is 10,000
characters.
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Example

DATABASE_INFORMATION This is the XXX-Alloy Solution Database '

in the A-B-C-D-...... System. '

Developed by TCS, released in May 2001. ''

... more ... !

TYPE_DEFINITION
TYPE_DEFINITION [data-type code]*1 [secondary keyword with
parameters] !

This keyword couples phases to an action performed by the DATA module when the DATA
command "GET_DATA" on page 16 is executed.

Secondary Keywords

The secondary keywords and associated parameters in syntax are:

SEQ [filename]

RND# [filename]

GES [valid GIBBS command with parameters]

POLY3 [valid POLY command with parameters]

TDB [valid DATA command with parameters]

IF [conditional statement] THEN [keyword with parameters]

AFTER [valid GIBBS command with parameters]

The secondary keyword SEQ specifies a sequential file that stores parameters belonging to
the phases using the associated data type code (which is defined by this keyword). A special
case where the filename is given as an asterisk (*) implies that the database definition file
also acts as a sequential data storage file. This case makes it possible to have a single file for
a small database, which is especially suited for personal databases.

The secondary keyword RND should be concatenated with a positive integer # to indicate the
type of the random file. Currently, there are these types of random files:

l RND0, the default, is used for complete Gibbs energy expressions (G0 parameters),
where the search field is the unabbreviated parameter name.

l RND1 is designated for functions, where the function name is used as the search field.
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l RND2 is reserved for binary interaction parameters, where its search field is also the
unabbreviated parameter name without any interaction order notation.

Ternary and higher order interaction parameters must be specified on a
sequential file. Moreover, the internal structures of these random files are
subject to changes with different versions of DATA, and with implementations of
DATA on various computer systems. For more information, see the FORTRAN
program TDBSORT, which is available from Thermo-Calc Software AB.

The secondary keywords GES, POLY3, or TDB specifies a modification of, or addition to,
phases having the associated data type code, such as magnetic contribution, another excess
model, or any other valid GIBBS/POLY/DATA command that applies to a certain phase. By
implementing this as a call to the interactive GIBBS/POLY/DATA module, flexibility is
achieved. If a new type of addition is implemented in a GIBBS/POLY/DATA module, it can be
immediately used in the database definition file without reprogramming the DATA module.

In several examples below, the use of the at (@) sign indicates any phase to
which the relevant type definition (e.g. A, B, 4, or E) applies.

The secondary keywords IF and THEN allow specification of a conditional statement
structured with respect to the phase constitution that controls the execution of a following
type-definition (keyword with parameters) string. See the last four examples.

The secondary keyword AFTER is similar to the GES keyword except the defined GIBBS
command is executed after all parameters are entered. The reason for this is that the
command has no effect unless there is a parameter. Following the AFTER keyword, a GIBBS
command must be given and it is executed after entering the parameters of the phase.

The data-type code (always as one string) can be any normal or special character, e.g. 0, 5,
A, F, M, %, &, and so forth, and is referred in the definition keywords "PHASE" on page 11,
"COMPOUND_PHASE" on page 18 and "ALLOTROPIC_PHASE" on page 18 for various phases.

A phase can have several ADDITIONAL parts of different types (that are enforced by certain
TYPE_DEFINITIONS which call the GIBBS command AMEND_PHASE_DESCRIPTION for
describing various contributions to Gibbs energy). However, the DATA/GIBBS module
automatically deletes any early-defined ADDITIONAL part(s) of the same type.

The DATA module can selectively retrieve functions that are necessary for a defined system
from a database that has functions stored in its setup file or SEQ sequential function file,
while all other functions irrelevant for the defined system are ignored and are not saved in
associated GIBBS and POLY workspaces.

Examples

TYPE_DEF % SEQ TCPATH\DATA\[DATABASE]\PARAMETERS.TDB !
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TYPE_DEF I SEQ TCPATH\DATA\[DATABASE]\INTERACTION-PARAMS.TDB !

TYPE_DEF G RND0 TCPATH\DATA\[DATABASE]\GZERO-PARAMS.TDB !

TYPE_DEF F RND1 TCPATH\DATA\[DATABASE]\FUNCTIONS.TDB !

TYPE_DEF & RND2 TCPATH\DATA\[DATABASE]\BINARY-INTERACTIONS.TDB !

TYPE_DEF A GES AM_PH_DES @ MAGNETIC -1 0.40 !

TYPE_DEF B GES AM_PH_DES @ MAGNETIC -3 0.28 !

TYPE_DEF 4 GES AM_PH_DES @ EXCESS_MODEL REDLICH-KISTER_KOHLER !

TYPE_DEF 5 GES AM_PH_DES AQUEOUS EXCESS_MODEL HKF !

TYPE_DEF 6 GES AM_PH_DES AQUEOUS HKF_ELECTROSTATIC !

TYPE_DEF 7 GES AM_PH_DES AQUEOUS STATUS 02084000,,, !

TYPE_DEF 8 GES AM_PH_DES AQUEOUS MAJOR_CONST 1 H2O !

TYPE_DEF E AFTER AM_PH_DES LIQUID EXCESS MIXED-EXCESS

A B LEGENDRE  C A POLYNOM ,,,, !

TYPE_DEF T AFTER AM_PH_DES LIQUID TERN-EXT TOOP-KOHLER B A C ,,,,
!

TYPE_DEF Q AFTER AM_PH_DES LIQUID TERN-EXT KOHLER FE CR NI !

TYPE_DEF C IF (PD AND PT AND SN) THEN TDB RESTORE_PHASE BCT_A5 !

TYPE_DEF D IF (PD AND (PT OR SN)) THEN TDB REJECT_PHASE BCC_A2 !

TYPE_DEF E IF ((NB OR TI OR V) AND (C OR N)) THEN

GES AM_PH_DES @ COMP_SET ,, CR NB TI V: C N: !

TYPE_DEF F IF (ALO3/2 OR CRO3/2 OR FEO OR MNO OR SIO2) THEN

GES AM_PH_DES LIQUID COMP_SET ,, ALN%,ALO3/2%,CRO3/2%,

FEO%,FEO3/2,MNO3/2%,MNS%,SIO2%,TIO2% : !

TYPE_DEF R GES AM_PH_DES FE_LIQUID FRACTION_LIMITS Fe 0 0.6

Ag 0 0.01 Al 0 0.05 Ca 0 0.05 Co 0 0.01 Cr 0 0.01 

Cu 0 0.02 Mg 0 0.05 Mn 0 0.05 Mo 0 0.05 Nb 0 0.05 

Ni 0 0.05 Pb 0 0.05 Si 0 0.10 Sn 0 0.02 Ti 0 0.05 

U 0 0.01 V 0 0.02 W 0 0.02 Zr 0 0.03 

B 0 0.01 C 0 0.01 H 0 0.01 N 0 0.01 O 0 0.01 

P 0 0.01 S 0 0.01 !
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Ordered Phase Restores Disorder Contribution

When an ordered phase with disordered contribution is restored, the disordered contribution
is automatically restored as well. You can also restore the disordered phase without
restoring the ordered phase.

However the DIS_PART TYPE_DEFINITION must always be set on the ordered
phase. It is important that the disordered phase is declared before the ordered
phase. Otherwise it causes an error when DIS_PART TYPE_DEFINITION is
executed and then either the ordered or disordered phase is rejected.

Example

TYPE_DEFINITION & GES A_P_D FCC_A1 MAGNETIC -3.0   2.80000E-01 !

PHASE FCC_A1 %& 2 1  1 !

CONSTITUENT FCC_A1 :CR,NI% : C%,VA : !

$ THIS PHASE HAS A DISORDERED CONTRIBUTION FROM FCC_A1

TYPE_DEFINITION ' GES AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART
FCC_A1,,,!

TYPE_DEFINITION ( GES A_P_D FCC_L12 MAGNETIC -3.0   2.80000E-01
!

PHASE FCC_L12 %'( 3 .75  .25  1 !

CONSTITUENT FCC_L12 :CR,NI% : CR,NI% : C,VA% : !

For example a GES command such as the following only affects phases defined above or at
the phase with this TYPE_DEFINITION in the TDB file:

TYPE_DEFINITION ( GES A_P_D FCC_L12 DIS_PART FCC_A1,,, !

For example a TDB command such as the following only affects phases defined below the
phase with this TYPE_DEFINITION in the TDB file:

TYPE_DEFINITION ( TDB RESTORE_PHASE FCC_A1 !

FTP_FILE
FTP_FILE [filename] !

FTP_FILE is a special function random file and the function names correspond to the record
numbers where these record names and the functions are stored. The FTP_FILE decreases
search time for the associated database in the DATA module. The file is used for large
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substance databases along with a SEQ sequential or RND0 random file for storage of G0
parameters referring the functions named FxxxxT that are stored in the FTP file. The
integer number xxxx is a search code used by DATA when such files are processed.

No modification of this file type is allowed.

Example

FTP_FILE TCPATH\DATA\[DATABASE]\FTP-FILE.DATA !

FUNCTION
FUNCTION [function name]*8 [lowest temp. limit]

[expression 2]; [upper temp. limit 2] Y

[expression 1]; [upper temp. limit 1] Y

[expression 3]; [upper temp. limit 2] Y

.......... ; ..... Y

[expression n-1]; [upper temp. limit n-1] Y

[expression n]; [upper temp. limit n] N {Ref. Index} !

GIBBS can use predefined functions in the expression (TP-Function) of a Gibbs energy
parameter or in other functions. This is often used when several parameters (or functions)
have a common sub-expression, such as for metastable modifications of elements. This
keyword can appear in both files for database definition and sequential storage, but not in
FTP files. A valid function name can have up to 8 characters.

A function always starts with a lowest temperature limit of its applicability, followed by one
or more (up to 10) expressions (TP-Functions) that are coded as mathematical relations of
constants, functions of stable variables (T and P) and other entered functions (normally with
a # suffix, e.g. +3*GHSERAL#).

Also see the "ENTER_PARAMETER" on page 143 in the Thermo-Calc Console
Mode Command Reference.

The expression is a FORTRAN-like expression and operators +,  -, *, = and ** can be used (**
only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP
(for exponential) can also be used. Each expression (TP-Function) should end with a
semicolon (;), and be followed by its upper applicable temperature limit and a continuation
indicator (Y to continue with the next expression or N to end the function’s expression). If
there is no continuation after a specific expression (TP-Function), the reference index can
optionally be given after the N indicator.
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A complete/valid function entry can be written in several continuation lines if the function’s
expression (TP-Function) is too long or if there is more than one applicable expression (TP-
Function), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of
each continuation line. Otherwise, the DATA module may misunderstand the
expression or issue some error messages when reading the function entry.
Avoid entering functions like the one below.

FUNCTION GHSERXY 298.15

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

Such a function is read by the DATA module as

1000+1058*T-38.9*T*LOG(T)+GFUNXY#

rather than

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#

This is because the DATA module concatenates all lines and removes extra spaces before
trying to enter the function in the GIBBS workspace. Thus, the - sign is taken as a delimiter
between 298.15 and 1000, and the function incorrectly becomes:

FUNCTION GHSERXY 298.15 1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N
!

Avoid this mistake by giving at least one empty space as the first character of a new line,
such as

FUNCTION GHSERXY 298.15

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

which is read correctly as

FUNCTION GHSERXY 298.15 -1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000
N !

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a
function is normally set by default as 298.15 K, in most cases. However, you can set another
limit when it is applicable (according to experimental data and assessments).

An upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each
TP-Function in a function must be given after the semicolon (;) immediately following the
specific TP-Function. The highest-temperature limit (in Kelvin) for the applicability of the
current function is always followed by the N sign. If a negative number is given as the lowest-
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temperature limit, it assumes there are breakpoints in pressure for this function. In these
cases, it is interpreted as the lowest-pressure limit (in Pascal), and the other limits in the
current function is also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the functions are checked during calculations. An
indicator is set if the actual temperature/pressure condition is below the lowest
temperature/pressure limit or above the highest temperature/pressure limit. In these cases,
an extrapolation is done using the TP-Function valid in the nearest temperature/pressure
range.

The optional reference index {Ref. Index} is an integer number indicating where to find the
particular function in a special reference file. The references are listed when doing the GET_
DATA command in the DATA module. They can also be listed in the GIBBS module with the
command LIST_DATA with the option R.

For accounting for the reference indices, also see the keyword "REFERENCE_
FILE" on page 38.

The reference index field can also be an abbreviation (such as REF:250, REF_002, or REF-
SGTE) which denotes the original reference. In this case, the reference cannot be obtained
when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the
option R).

However, the references directly coded in the database definition file (***setup.TDB)
starting with a letter can be shown when issuing the DATA command GET_DATA or the
GIBBS command LIST_DATA (with the option N or R). Normally, such references must be
located after the LIST_OF_REFERENCE keyword. It is recommended to use reference code
names such as REF001, REF018, etc. The reference list, which is generated by the GIBBS
command "LIST_DATA" on page 120 <file> with the N or R option, is also possible to be
directly read by the DATA module.

The DATA module can selectively retrieve functions which are necessary for a defined
system from a database that has functions stored in its setup file or SEQ sequential function
file, while all other functions irrelevant for the defined system are ignored and are not saved
in associated GIBBS and POLY workspaces. Previously, this can only be done for large
databases that have functions stored in RND1 random or FTP function files.

Examples

FUNCTION GFREE 298.15 1000+GFUNXY#; 6000 N !

FUNCTION GFUNXY 298.15 -1000+200*T+30*T*LOG(T); 6000 N 505 !

FUNCTION G0_CAO 298.15 -663538.11+352.67749*T-57.7533*T*LN(T)

+5.3895E-03*T**2-8.879385E-07*T**3+575530*T**(-1);
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1400.00 Y -625196.99+78.896993*T-20.40145*T*LN(T)

-1.112923E-02*T**2+5.1896733E-07*T**3-6917350*T**(-1);

2900.00 Y -499226.55-490.37695*T+51.95912*T*LN(T)

-2.961051E-02*T**2+1.4033905E-06*T**3-48114685*T**(-1);

3172.00 Y -587711.89+375.04117-62.76*T*LN(T); 

6000.00 N REF020 !

PARAMETER
PARAMETER [GIBBS parameter name] [lowest temp. limit]

[expression 1]; [upper temp. limit 1] Y

[expression 2]; [upper temp. limit 2] Y

[expression 3]; [upper temp. limit 2] Y

.......... ; ..... Y

[expression n-1]; [upper temp. limit n-1] Y

[expression n]; [upper temp. limit n] N {Ref. Index} !

This keyword can appear in both files for database definition and sequential storage, but not
in FTP files. After the keyword, a valid GIBBS parameter name should be given.

It is used to define standard Gibbs energies (i.e. the G parameters for Gibbs energy of
formations) of all valid end-members of various stoichiometric and solution phases, and
excess Gibbs energies (i.e. the L parameters for Gibbs energy of interactions) of all binary,
ternary, quaternary or higher-order interactions in various solution phases; both standard
Gibbs energies and excess energies can also have parameters for contributions from PT-
depended volume variations (i.e. the V0, VA, VB, VC and VK parameters for molar volume,
thermal expansivity, bulk modulus, isothermal compressibility and high-pressure fitting
parameter), magnetic ordering (i.e. the TC and BM parameters for Curie temperature and
Bohr magneton number) and hypothetical electrostatic interactions (i.e. BM parameter for
Born functions ωPr,Tr of aqueous solute species).

The general form of a parameter is:

<identifier>(<phase>, <constituent array>; <digit>) <xxx>
<expression> <yyy> <keyword Y or N> <zzz> !
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General Form

Name Description

identifier The parameter type.

phase The phase name (maximum 24 characters).

constituent
array The specific constituent array in the phase.

digit

The degree of composition-dependent interaction contribution (an integer
number from 0 through 9), that is only for excess energy (L), Curie
temperature (TC) and Bohr magneton number (BMAGN), as well as for
volume-related parameters (V0 or VA or VB or VC or VK); if it is valued as
zero, or if it is for the standard Gibbs energy (G) for which the degree is
always zero, it can be omitted.

expression The mathematical relation to describe the parameter.

xxx and
yyy

The low and high temperature limits respectively for the applicable
temperature range of the parameter expression

keyword Y
or N The indicator on if there is continuation for the parameter expression or not

zzz The reference index/number for the assessment of this parameter;

! The exclamation mark is used to indicate that the current parameter
definition is ended

GIBBS Parameter Name
The GIBBS parameter name has a general form of:

<identifier>(<phase>,<constituent array>;<digit>)

Name Examples

Parameter Definition

G(GAS,C1O2) The Gibbs energy of formation of a CO2 molecule in gas.

G(FCC,FE:VA) The Gibbs energy of formation of fcc Fe with interstitials.
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Parameter Definition

L(LIQ,Fe,Cr;0) The regular solution parameter for Fe and Cr in liquid.

L(LIQ,Fe,Cr;1) The sub-regular solution parameter.

TC(BCC,Fe:Va) The Curie temperature of bcc Fe.

BMAGN(BCC,Fe:Va)
The Bohr magneton number parameter of bcc Fe.

'

The GIBBS parameter name consists of several parts. The first is a type-identifier. The
following type-identifiers are legal:

Type-
Identifier Definition

G Standard energy parameter (Gibbs energy of formation)

L Excess energy parameter (Gibbs energy of interaction)

TC Curie temperature for magnetic ordering

BMAGN or
BM

Bohr magneton number for magnetic ordering (or Born
function ωPr,Tr for aqueous solute species).

V0 Molar volume at 298.15 K and 1 bar (a numeric value
only)

VA
Integrated thermal expansivity

VB Bulk modulus at 1 bar

VC Isothermal compressibility

VK High-pressure fitting parameter

You can also use G for interaction parameters; and on output list (performed by the GIBBS
command LIST_PARAMETER or LIST_PHASE_DATA) the type-identifier L is always used for
interaction parameters. Note that the type-identifier BM is also used for Born functions
ωPr,Tr of aqueous solute species.

The identifier must be followed by an opening parenthesis, a phase name, a comma and a
constituent array. Optionally, the constituent array can be followed by a semicolon and a
digit. The parameter name is terminated by a closing parenthesis.
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It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F
and B) in its phase definition (already by the PHASE keyword; such as GAS:G,
LIQUID:L, SLAG:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_
B2:B, AQUEOUS:A), such a valid phase-type code should not be attached to the
phase name in the PARAMETER keyword.

Specifying the phase name in UPPER-case is recommended. You can define a
phase name as a mixture of UPPER-case and lower-case letters in a database,
but the DATA module automatically converts all lower-case to UPPER-case
because the GIBBS module only recognizes UPPER-case phase names.

The constituent array consists of a list of constituent names. Interaction parameters have
two or more constituents from the same sublattice separated by a comma. If the phase has
sublattices, at least one constituent in each sublattice must be specified. The constituents in
different sublattices must be given in sublattice order and are separated by a colon.

After the component array, a sub-index digit can be specified after a semicolon. This digit
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess
energy model used for the phase. If no semicolon and digit are given, the sub-index value is
assumed to be as zero.

The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary
parameters, are multiplied with two or more fractions of the constituents from the same
sublattice of the solution phase. These additional constituents must be given as interacting
constituents.

Be careful about the sign of odd terms, for example, L(BCC, B, A:VA;1) is
treated as L(BCC,A,B:VA;1), i.e. it is always put into alphabetical order.

Solution phases with sublattices may have interacting constituents in each
sublattice.

You can use an asterisk (*) to denote that the excess interaction parameter is independent
of the constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that
the interaction parameter is for the binary interaction between constituents AL and NI on
the first sublattice in the FCC_L12 solution phase, while it is independent of all constituents
on the second sublattice. A interaction parameter in the list of constituents is always added
to the Gibbs energy and the asterisk (*) is calculated with the term of [1-∑y(specified
constituents)], which implies that in an A-B binary system the following three L
parameters are identical (but in higher-order systems, they are different):
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l L(phase,A,B)is multiplied with X(A)*X(B)

l L(phase,A,*)is multiplied with X(A)*(1-X(A))

l L(phase,B,*)is multiplied with X(B)*(1-X(B))

A parameter always starts with a lowest temperature limit of its applicability, followed by
one or more (up to 10) expressions (TP-Functions) coded as mathematical relations of
constants, functions of stable variables (T and P) and entered functions (normally with a #
suffix, e.g. +3*GSERAL#).

The expression is a FORTRAN-like expression and operators +,  -, *, = and ** can be used (**
only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP
(for exponential) can also be used. Each expression (TP-Function) should ends with a
semicolon (;) and be followed by its upper applicable temperature limit and a continuation
indicator (Y to continue with the next expression, or N to end the parameter’s expression). If
there is no continuation after a specific expression (TP-Function), the reference index can be
optionally given after the N indicator.

A complete/valid parameter entry can be written in several continuation lines if the
parameter’s expression (TP-Function) is too long or if there is more than one applicable
expression (TP-Function), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of
each continuation line. Avoid entering parameters such as:

PARAMETR G(LIQUID,A,B) 298.15

-2000+4568*T+2*GFUNAB#; 6000 N !

Such a parameter is read by the DATA module as 2000+4568*T+2*GFUNAB#, rather than as -
2000 +4568*T+2*GFUNAB#.

Avoid this mistake by giving at least one empty space as the first character of a new line,
such as

PARAMETR G(LIQUID,A,B) 298.15

-2000+4568*T+2*GFUNAB#; 6000 N !

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a
parameter is normally set by default as 298.15 K, in most cases; however, you can set
another limit when it is applicable (according to experimental data and assessments). An
upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each TP-
Function in a parameter must be given after the semicolon (;) immediately following the
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specific TP-Function; and the highest-temperature limit (in Kelvin) for the applicability of the
current parameter is always followed by the N sign. If a negative number is given as the
lowest-temperature limit, it is assumed that there are breakpoints in pressure for this
parameter. In such cases, it is interpreted as the lowest-pressure limit (in Pascal), and the
other limits in the current parameter are also taken as pressure limit values (in Pascal).

The temperature/pressure limits for the parameters are checked during calculations. An
indicator is set if the actual temperature/pressure condition is below the lowest
temperature/pressure limit or above the highest temperature/pressure limit. In these cases,
an extrapolation is done using the TP-Function valid in the nearest temperature/pressure
range.

The optional reference index {Ref. Index} is an integer number indicating where to find the
particular parameter in a special reference file. The references are listed when doing the
GET_DATA command in the DATA module. These can also be listed in the GIBBS module with
the command LIST_DATA and the option R or N.

For accounting the reference indices, also see the keyword "REFERENCE_FILE"
on page 38.

The reference index field can also be an abbreviation (such as REF:250, REF_002, or REF-
SGTE) denoting the original reference. In this case, the reference cannot be obtained when
issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option R
or N).

However, the references directly coded in the database definition file (***setup.TDB) that
starts with a letter can be shown when issuing the DATA command GET_DATA or the GIBBS
command LIST_DATA (with the option R or N). Normally, such references must be located
after the LIST_OF_REFERENCE keyword. It is recommended to use reference code names
such as REF001, REF018, etc. The reference list, which is generated by the GIBBS command
LIST_DATA <file> with the N option, is thus also possible to be directly read by the DATA
module.

Examples

PARAMETER G(BCC,FE:VA) 298.15 1000+200*T+...; 6000 N 91DIN !

PARAMETER TC(BCC,FE:VA)   298.15 +1043; 6000 N 91DIN !

PARAMETER BMAGN(BCC,FE:VA) 298.15 +2.22; 6000 N 91DIN !

PARAMETER G(SIGMA,FE:CR:CR;0) 298.15 1000+200*T+...; 6000 N 101 !

PARAMETER G(LIQUID,AL;0) 298.15 +11005.553-11.840873*T

+7.9401E-20*T**7+GHSERAL#; 
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933.60 Y +10481.974-11.252014*T+1.234264E+28*T**(-9)+GHSERAL#; 

2900.00 N REF:283 !

PARAMETER G(BCC_A2,PB:C)  298.15 UN_ASS#; 300 N REF:0 !

PARAMETER G(BCC_A2,NI:C;0) 298.15 +GHSERNI#+3*GHSERCC#

+400000-100*T; 6000 N REF071 !

PARAMETER G(BCC_A2,MN:VA) 298.15 +GMNBCC#; 6000 N REF285 !

PARAMETER BM(AQUEOUS,OH-1) 298.15 +Z0002PW0#; 1600 N 155 !

PARAMETER L(BCC,FE,CO:VA;0) 298.15 1000+200*T+...; 6000 N !

PARAMETER L(BCC,FE,CO:VA;1) 298.15 1000+200*T+...; 6000 N !

PARAMETER L(BCC,FE,CO:VA;2) 298.15 1000+200*T+...; 6000 N !

PARAM   TC(BCC_A2,CO,MO:VA;0) 298.15 -3700;   6000 N R454 !

PARAM   TC(BCC_A2,CO,MO:VA;1) 298.15 +2300;   6000 N R454 !

PARAM BMAGN(BCC_A2,CO,MO:VA;0) 298.15 -3.445;   6000 N R454 !

PARAM V0(BCC_A2,CR,FE:VA;0) 298.15 +ZERO#; 6000 N REF06V !

PARAM V0(BCC_A2,CR,FE:VA;1) 298.15 -1.10524097E-7; 6000 N REF06V !

PARAM V0(BCC_A2,CR,FE:VA;2) 298.15 +1.40024130E-7; 6000 N REF06V !

PARAM VA(BCC_A2,CR,FE:VA;0) 298.15 -6.49444634E-6*DELTAT#; 6000 N
REF06V !

PARAM VA(BCC_A2,CR,FE:VA;1) 298.15 +2.91269321E-5*DELTAT#; 6000 N
REF06V !

OPTIONS
OPTIONS /[alloy name]([composition limitations for all alloying
elements]) !

This keyword defines an alloy in a database. An alloy has a name, a major component and a
number of alloying elements. The purpose for defining an alloy is to be able to tell you about
applicable composition limits of the current database in applications to that particular type
of alloy. It is possible to have several alloys in the same database. The alloys are given after
the keyword in the database.

The alloy name must be proceeded by a slash (/) and terminated by the opening
parenthesis, with no spaces are allowed in between.

l The alloy name is maximum 8 characters.

l After the parenthesis, follows the major element and a parenthesis with its minimum
mass and minimum mole percent given inside.
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l Then, the alloying element names, each with its maximum mass and mole percent
are given within parenthesis.

l There must a space between definitions for each alloying element.

l The alloy definition is terminated by a closing parenthesis, and the whole OPTIONS
keyword by the exclamation mark (!).

Example

OPTIONS /SSteel(Fe(60,60) CR(30,30) NI(15,15) SI(1,1) N(.1,1)) !

TABLE

It is recommended to always have at least one empty space at the beginning of
each continuation line. Otherwise, the DATA module may issue some error
messages when reading the table entry.

TABLE [name]*8 [start temp] [end temp] [delta temp] [table values]
!

This keyword can appear in both files for database definition and sequential storage, but not
in FTP files. It makes a table of Gibbs energy as a function of temperature where the values
are given from the start temperature to the end temperature, at a step of the delta
temperature.

Example

TABLE DEMTAB 1000.0 1500.0 100.0 -2912.9008 -2834.2416 -2755.5824

-2677.7600 -2600.7744 -2524.2072 !

ASSESSED_SYSTEMS
ASSESSED_SYSTEM [descriptions on special treatments for specific
assessed systems]*8000 !

This keyword can be included in the database definition file (the ***setup.TDB file). A
maximum of 8000 characters after the keyword (to describe some special options when the
DATA, GIBBS and POLY models deal with the existing systems with assessed data) is allowed
until the exclamation mark (!).

Several ASSESSED_SYSTEMS keywords can be used in the same TDB file in order to have
more lists of assessed systems. There is no limit to the number of the entries in the same
TDB file.
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The assessed systems in the database, and the special treatment options, are typed after the
keyword. The elements (always in UPPER CASE) in each assessed system must be in
alphabetical order and be separated by a hyphen, such as C-FE for the Fe-C binary system,
and C-CR-FE for the Fe-Cr-C ternary system. A space must be between each assessed
system. Information on assessed binary, ternary or higher-order systems may also be given
in this way.

A ternary system like C-CR-FE does not imply that the binary C-CR, C-FE and CR-
FE are assessed. There is no way to indicate partially assessed systems.

l There is a field to give some descriptive information for a specific system, with
various options about how to:

l Reject or restore phase(s) from the current database in the DATA module;

l Set major constituent(s) in the first composition set and to set a second composition
set for a specific phase available in the current database in the GIBBS module; and

l Calculate this specific system in the POLY module.

l This is the facility used by the BIN (binary phase diagrams) and TERN (ternary phase
diagrams) modules in the Thermo-Calc software/database package.

The descriptive information must immediately follow the specific system name, and must be
enclosed within parenthesis ( and ), and the left parenthesis must follow directly after the
system, such as :

AL-NI(TDB +L12 ;G5 C—S:L12/NI:AL:VA ;P3 STP:.8/1200/1
STP:.2/600/1)

The syntax TDB means that the commands to the DATA module proceed, and +L12 in the
example means that the phase called L12 should be restored (it has been rejected by
default).

The directive ;G5 means that the following are commands to the GIBBS module. C_S:
means creating a second composition set, after the colon follows the phase name and after
the slash the major constituents.

After the directive ;P3 follows commands to the POLY module. STP: means setting a start
point with the value of the X-axis first (composition for the second element in a binary
system), the slash separates the Y-axis value (temperature), and possibly one or more
directions (-1, 1, -2 or 2).

A summary of the allowed syntax is:

TDB accepts



Thermo-Calc Documentation Set

The Database Definition File and Keywords ǀ 37 of 74

l +phase and -phase for restore/reject.

l ;G5 accepts

l MAJ:phase/constituent-array for major constituents of the first composition set.

l C_S:phase/constituent-array for a second composition set.

l ;P3 accepts

l TMM:lt/ht for the low-/high-temperature limits (lt and ht; for instance
TMM:500/4000) suitable for calculating phase diagrams and property diagrams of a
binary system.

l * for a default start point which is set as:

l for a binary system: at the composition X(2nd element)=.1234, temperature
T=1100 K and with the default directions; or

l for a ternary system: at the compositions X(2nd element)=.1234 and X(3rd

element)=.1234 and with the default directions.

l STP:x/t/d1/d2/d3 for a specific start point in a binary system which is set as at the
composition X(2nd element)=x and temperature T=t (in K), and with the directions
d1, d2 and/or d3.

l STP:x1/x2/d1/d2/d3 for a specific start point in a ternary system which is set as at
the compositions X(2nd element)=x1 and X(3rd element)=x2 and with the
directions d1, d2 and/or d3.

l The direction(s) can be defined as -1, 1, -2 or 2. If no direction is specified, all
default directions are used (meaning no ADD command is enforced in the POLY
module).

l If only one start point is specified, the direction(s) may be omitted; if more than one
start points are specified, at least one direction for each start point must be given for
all start points.

Each entry for a specific binary or ternary sub-system can be written in one or several lines
(each line with 78 characters).

Other Examples

ASSESSED_SYSTEMS

AL-NI(TDB +L12 +BCC_B2 ;G5 C_S:L12/NI:AL:VA

;P3 STP:.8/1000/1 STP:.45/700/1 STP:.7/700/1)

AL-PB(TDB -HCP -BCC
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;G5 MAJ:LIQ/AL MAJ:FCC/AL:VA C—S:LIQ/PB C—S:FCC/PB:VA ;P3
*)

CR-FE(;G5 C—S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)

AG-CU(;G5 MAJ:FCC/AG:VA C_S:FCC/CU:VA ;P3 STP:.3/1000)

C-NB(;P3 STP:.9/1100/1)

C-SI(;P3 *)

CO-CR(;G5 MAJ:FCC/CO:VA C_S:FCC/CR:VA ;P3 STP:.1/1100)

CR-FE(TDB -HCP ;G5 C_S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)

CR-NI(;P3 *)

CR-W(;G5 MAJ:BCC/W:VA C_S:BCC/CR:VA

;P3 TMM:500/4000 STP:.3/700/1 STP:.3/1800/2 )

CU-FE(TDB -HCP ;G5 MAJ:LIQ/CU MAJ:FCC/FE:VA C_S:FCC/CU:VA

;P3 STP:.9/1400)

FE-N(TDB +FE4N ;P3 *)

FE-O(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:O-2 MAJ:ION_
LIQ/FE+2:VA

;P3 STP:.2/2000/1 )

FE-S(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:S MAJ:ION_LIQ/FE+2:S-
2 ;P3 *)

AL-MG-SI(;P3 *)

C-CR-FE ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA ;P3 *) !

The semicolon (;) is a part of the ;G5 and ;P3 directives. A long descriptive
information can be written in more than one line, such as for the AL-NI, AL-PB ,
CU-FE and FE-O systems shown above.

The directive ;P3 * is needed if the default start point should be used. If there is no P3
directive, the BIN or TERN module generates some 20 different start points in order to cover
all possible compositions and temperatures (for a binary system) or all possible compositions
(for a ternary system under any specific temperature). 

REFERENCE_FILE
REFERENCE_FILE [file name] !

This keyword takes a reference file name as its argument. This reference file (that must be
edited in a restrictive way and be saved as a blocked file with a fixed line-length for each
line in the file, as described below) contains a complete list of the references for the various
parameters (and sometimes functions) in the database. The file must have a fixed record
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structure: each reference entry with one or several records, and each record with exactly 78
characters written in one single blocked line; and no empty space is allowed at the
beginning of all lines in the file. If there are more than one record entered for a reference
entry, all the continuation lines must start with an ampersand (&). The line number of the
first record for a specific reference entry is then accounted as the unique integer for that
specific reference, which is referred when a parameter or function calls this integer as the
optional {Ref. Index}.

Also see keyword "PARAMETER" on page 28 or "FUNCTION" on page 25 about
specifying a reference index.

Example

/-1<G>           T.C.R.A.S. Class 1

AG1.64TE1        THERMODATA 01/93

&28/01/93

&SILVER 1.64-TELLURIDE. Solid Standard State.

AG1              HULTGREN SELECTED VAL.       SGTE **

&AT.WEIGHT 107.870,STANDARD STATE:CODATA KEY VALUE.MPT=1234.93K.
&--U.D. 30/10/85.

AG1<G>           T.C.R.A.S Class: 1

AG1/+1<G>        T.C.R.A.S Class: 1

AG1BR1           N.P.L.                       SGTE **

&Tfusion uncertain and heat vaporization estimated.

AG1BR1<G>        THERMODATA 01/93

&28/01/93

&Gaseous Standard State.

AG1BR1O3         BARIN & KNACKE.SUPPL.REF:62,* SGTE **

&AGO3BR  SILVER OXYTRIBROMIDE

In the example, the unique integers of related references (for assessed elements, species,
phases, interactions, etc.) are:

1/-1<G>

2AG1.64TE1

5 AG1

8AG1<G>
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9AG1/+1<G>

10AG1BR1

12AG1BR1<G>

15AG1BR1O3

LIST_OF_REFERENCE
LIST_OF_REFERENCE

NUMBER SOURCE

[REFxxx] '[Detailed reference]'

..........

.......... !

This keyword starts a reference list that is directly coded in the database definition file
(***setup.TDB). Its argument begins on the following line, and normally has an explanation
line (NUMBER SOURCE) that is followed by various reference codes. Each reference code
may occupy one or more lines (each line with maximum 78 characters), but must have a
reference code name (that starts with a letter) and the detailed reference information (that
is written within two single-quotation marks, ''). It is recommended to use reference code
names such as REF001, REF018, etc. A maximum of 400,000 characters after the keyword is
allowed until the exclamation mark (!).

Such a reference list can be shown when issuing the DATA command "GET_DATA" on
page 16 or the GIBBS command "LIST_DATA" on page 120 (with the R option). The reference
list, which is generated by the GIBBS command LIST_DATA <file> with the N option, has this
structure, and is thus possible to be directly read by the DATA module.

Example

LIST_OF_REFERENCES

NUMBER SOURCE

REF283 'Alan Dinsdale, SGTE Data for Pure Elements,

Calphad Vol 15(1991) p 317-425,

also in NPL Report DMA(A)195 Rev. August 1990'

REF224 'P-Y Chevalier, Thermochimica Acta, 130 (1988) p 33-41; AG-
SI'

!

ADD_REFERENCE
ADD_REFERENCE
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[REFxxx] '[Detailed reference]'  

..........

.......... !

Use this keyword to have an unlimited number of references. The use of this is the same as
that of "LIST_OF_REFERENCE" on the previous page, and is used after it. Several ADD_
REFERENCES sections can be used in a single database if there are too many references.

It is recommended to always start with a so-called empty reference (such as the DUMP0
reference in the following example) as the first entry in each of the ADD_REFERENCE sections
to make sure that all references are listed appropriately as retrieving data by issuing the
"GET_DATA" on page 16 command.

Example

ADD_REFERENCE

DUMP0 'Empty reference 0'

REF4 'J-O Andersson, B. Sundman, CALPHAD Vol 11, (1987), p 83-
92

TRITA 0270 (1986); CR-FE'

REF5 'J-O Andersson, Met. Trans A, Vol 19A, (1988) p 627-636

TRITA 0207 (1986); C-CR-FE'

REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys
Database,

v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters

at high temperatures.'

... ...

!

ADD_REFERENCE

DUMP1 'Empty reference 1'

REF275 'A. Fernandez Guillermet, Z. Metallkde. Vol 79(1988)
p.524-536,

TRITA-MAC 362 (1988); C-CO-NI AND C-CO-FE-NI'

REF393  'K. Frisk, Metall. Trans. Vol 21A (1990) p 2477-2488,

TRITA 0409 (1989); CR-FE-N'

REF1096 'P. Gustafson, Metall. Trans. 19A(1988) p 2547-2554,
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TRITA-MAC 348, (1987); C-CR-FE-W'

... ...

!

CASE and ENDCASE
CASE [ELEMENT/SPECIE/PHASE] !

IF (boolean algebra on element, species or phase names) THEN

[GIBBS/POLY/DATA command] !

ENDCASE !

This keyword takes as its argument, a definition on which type of the following Boolean
algebra operates. A simple Boolean algebra using AND and OR with a maximum of four levels
of parentheses works. The CASE construction must end with the ENDCASE keyword. This
makes it possible to have additional GIBBS or POLY commands executed depending on the
user selection of elements, species or phases. The DATA commands that can be given as
secondary keyword to "DEFAULT_COMMAND " on page 20 can also be executed.

Example 1

CASE ELEMENT !

IF((CR OR TI OR V) AND N)

THEN GES AM_PH_DES @ C_S ,, CR MO TI V:C N: !

ENDCASE !

Example 2

CASE ELEMENT !

IF(O) THEN TDB DEFINE_SYSTEM_ELEMENT /- !

ENDCASE !

Example 3

CASE ELEMENT !

IF(AL AND FE)

THEN TDB DEF_SYS_ELEMENT VA !

ENDCASE !

VERSION_DATA
VERSION_DATE [string]*78 !
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The string is denoted as the version/revision date and database manager of the database.
Nowadays, this directive is used mainly for the purpose of keeping the development and
revision history mostly updated.

Example

VERSION_DATE Last update and adjustment: Database Manager, 2015-
09-25 !
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Working with the Mobility Databases
In this section:

About the Diffusion Module (DICTRA) and the Databases 45

Extensions to Database Definition File Syntax 46

PARAMETER 46

DIFFUSION 47

ZERO_VOLUME_SPECIES 48
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About the Diffusion Module (DICTRA) and the
Databases
A Diffusion Module (DICTRA) installation shares directories with Thermo-Calc, including the
\DATA\ (or /data/) area and the database initiation file (TC_INITD.TDB or initd.tdb).

When you want to switch or add self-generated databases/data-sets or any new database,
use the predefined database list in the database initiation file as part of the Thermo-Calc
installation packages.

You can add comment lines in the database initiation file, which must start with
a $ sign. These lines are ignored by the DATA module. This is also applicable if
the database manager or user wants to temporarily disable a database in the
predefined database list. If there are too many databases in the \DATA\ area
that the DATA module cannot handle properly, the $ sign can be used to
temporarily comment about the uncommon databases. However, this does not
often happen.

If Thermo-Calc is used with a Windows platform, such additional database initiation files can
be located at any directory of any driver, on either a local computer or connected server.
The NEW_DICTORY_FILE command displays an Open window to access a database initiation
file if the file name or its path is not given on the same line of the NEW_DICTORY_FILE
command, or if it is incomplete or incorrect, so that the path (in the Look in box) and
database initiation file name (in the File name box) can be appropriately selected. However,
if Thermo-Calc is run on a Linux/UNIX platform, these files must be located in the current
working directory (where Thermo-Calc is started).

In an additional database initiation file, the first database entry may need to have the same
path definition structure as in the ordinary database initiation file. Copy the entry line(s) for
common databases from the original file to a database initiation file. The entries of the
additional databases follow. Similar to the standard databases predefined in the database
initiation file, all databases should normally be located in subdirectories under the directory
as defined by the TCPATH parameter (Windows) or the TC_DATA parameter (Linux/UNIX), or
under its subdirectory \DATA\ or /data/.

Windows Database Initiation File Example

For a Windows platform, the following example is an additional database initiation file,
called MYINITD1.TDB:

$

$ DATABASES TCC (Additional TCC Databases)
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PURE5 TCPATH\DATA\PURE5\PURE5SETU.TDB  SGTE Pure Elements
Database, version 5 !

AD1  TCPATH\DATA\ADD1\AD1SETUP.TDB    TCS ADD1 Solution
Database, version 1 !

AD2  TCPATH\ADDDATA\ADD2\AD2SETUP.TDB TCS ADD2 Solution Database
!

$AD2o TCPATH\ADDDATA\ADD2old\AD2SETUP.TDB TCS ADD2 Database
(old) !

AD3  TCPATH\DATA\NEWDATA\ADD3\AD3SETUP.TDB TCS ADD3 Solution
Database !

AD4  TCPATH\DATA\NEWDATA\MYPROJ1\ADD4\AD4SETUP.TDB

MYPROJECT1 ADD4 Solution Database !

$

$ DATABASES DIC (Additional DICTRA Databases)

DCAD1 TCPATH\DICDATA\DCADD1\DCAD1SET.TDB 

TCS DCADD1 Mobility Database !

Extensions to Database Definition File Syntax
Software packages for simulation of diffusional phase transformations, such as the Diffusion
Module (DICTRA) and Precipitation Module (TC-PRISMA), need both thermodynamic data
and kinetic data (i.e. diffusivities or mobilities). Naturally, the handling and storage of kinetic
data also benefits from the use of some kind of database management. Thus, the TDB
database definition file syntax has been extended to incorporate some new keywords
needed for storing kinetic data - "PARAMETER" on page 28, "DIFFUSION" on the next page,
and "ZERO_VOLUME_SPECIES " on page 48.

PARAMETER
PARAMETER [special GIBBS parameter name] [low temp. limit]

[expression 1]; [upper temp. limit 1] Y

[expression 2]; [upper temp. limit 2] Y

[expression 3]; [upper temp. limit 2] Y

.......... ; ..... Y

[expression n-1]; [upper temp. limit n-1] Y

[expression n]; [upper temp. limit n] N {Ref. Index} !
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This keyword allows you to enter all types of normal GIBBS parameters for thermodynamic
data as well as five special extensions suitable for kinetic data used in the Diffusion Module
(DICTRA).

Valid extensions to special GIBBS parameter names are:

l MQ: Activation enthalpy for mobility equation.

l MF: Pre-exponential factor for mobility equation.

l DQ: Activation enthalpy for diffusivity equation.

l DF: Pre-exponential factor for diffusivity equation.

l VS: Volume counted per mole of volume carrying species.

Examples

PARAMETER MQ(BCC,FE:VA) 298.15 1000+200*T+...; 6000 N !

PARAMETER MF(BCC,CO:VA) 298.15 1000+200*T+...; 6000 N !

PARAMETER DQ(FCC,FE:VA) 298.15 1043+...; 6000 N 10 !

PARAMETER DF(FCC,CR:C ) 298.15 1000+200*T+...; 6000 N 10 !

PARAMETER VS(FCC) 298.15 1000+200*T+...; 6000 N 11 !

DIFFUSION
DIFFUSION [model keyword] [phase name] [additional parameter(s)] !

This keyword specifies the type of diffusion model to use for a phase if the default model is
not desired. The default model calculates the full diffusion matrix. A diffusivity is calculated
from the different mobilities and the thermodynamic factors. The former ones are
calculated as:

M = exp (∑MF/RT) exp (∑MQ/RT) / RT

where ∑ stands for a weighted summation of the different MF’s and MQ’s plus possibly a
Redlich-Kister term.
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Valid Model Keywords

Keyword Description

NONE No diffusion in this phase

DILUTE
Constitution list of dependent species in each sublattice must be given as an
additional parameter. Only the diagonal terms in the diffusion matrix are
calculated. D = exp (∑ DF/RT) exp (∑DQ/RT).

SIMPLE
Constitution list of dependent species in each sublattice must be given as
additional parameter. Only the diagonal terms in the diffusion matrix are
calculated. D = ∑ DF + ∑ DQ.

MAGNETIC

The so-called ALPHA and ALPHA2 parameters must be given as additional
parameters. ALPHA is for the substitutional magnetic model and ALPHA2
for the interstitial one. By appending an & sign and a species name after the
alpha keyword one can supply individual values for the different species.
The full diffusion matrix is calculated.

Examples

DIFFUSION NONE SIGMA !

DIFFUSION DILUTE CEMENTITE : FE : C : !

DIFFUSION MAGNETIC BCC_A2 ALPHA=0.3 ALPHA2&C=1.8 ALPHA2&N=0.6 !

ZERO_VOLUME_SPECIES
ZERO_VOLUME_SPECIES [list of species] !

In the Diffusion Module (DICTRA), the assumption that the volume is carried by the
substitutional elements only is applied. The interstitial elements are assumed to have zero
molar volumes. This keyword uses a list of which species are to be considered as zero
volume ones for an argument.

Example

ZERO_VOLUME_SPECIES VA C N !
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Database Definition File Examples
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Example 1: A Steel Database
TEMP-LIM 500.0 2000.0 !

$ 

$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 !

ELEMENT VA VACUUM           0.0   0.0 0.0 !

ELEMENT C GRAPHITE        12.011 0.0 0.0 !

ELEMENT V BCC             50.9415 0.0 0.0 !

ELEMENT CR BCC-PARAMAGNETIC 51.996 0.0 0.0 !

ELEMENT FE FCC-PARAMAGNETIC 55.847 0.0 0.0 !

ELEMENT NI FCC-PARAMAGNETIC 58.69  0.0 0.0 !

ELEMENT MO BCC             95.94  0.0 0.0 !

ELEMENT W BCC            183.85  0.0 0.0 !

$ 

$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !

PHASE BCC      B1M 2 1.0 3.0 !

PHASE FCC      F2M 2 1.0 1.0 !

PHASE HCP      0   2 2.0 1.0 !

PHASE LIQUID   3   2 1.0 1.0 !

PHASE CEMENTITE 4   2 3.0 1.0 !

PHASE M23C6    4   2 23.0 6.0 !

PHASE M7C3     4   2 7.0 3.0 !

PHASE M6C      4   4 2.0 2.0 2.0 1.0 !

PHASE SIGMA    0   3 10.0 4.0 16.0 !

PHASE MU-PHASE 0   3 7.0 2.0 4.0 !

PHASE R-PHASE  0   3 27.0 14.0 12.0 !

PHASE GRAPHITE 4   1 1.0 !

$

$CONSTITUENT, PHASE-NAME : CONSTITUENTS !

CONSTITUENT BCC :V CR FE NI MO W:VA C: !

CONSTITUENT FCC :V CR FE NI MO W:VA C: !

CONSTITUENT HCP :CR FE NI:VA C N: !

CONSTITUENT LIQUID :C V CR FE NI MO W VA:VA C: !

CONSTITUENT CEMENTITE :CR FE:C: !

CONSTITUENT M23C6 :CR FE:C: !

CONSTITUENT M7C3 :CR FE:C: !

CONSTITUENT M6C :FE:W:FE W:C: !
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CONSTITUENT SIGMA :FE:V CR MO:FE V CR MO: !

CONSTITUENT MU-PHASE :FE:MO W:FE MO W: !

CONSTITUENT R-PHASE :FE:MO :FE MO: !

CONSTITUENT GRAPHITE :C: !

$ 

$TYPE_DEFINITIIONS:

TYPE-DEFINITION 0 SEQ TCPATH\DATA\METDATA\TC-THEREST.TDB !

TYPE-DEFINITION 1 SEQ TCPATH\DATA\METDATA\TC-BCC.TDB !

TYPE-DEFINITION 2 SEQ TCPATH\DATA\METDATA\TC-FCC.TDB !

TYPE-DEFINITION 3 SEQ TCPATH\DATA\METDATA\TC-LIQUID.TDB !

TYPE-DEFINITION 4 SEQ TCPATH\DATA\METDATA\TC-CARBIDES.TDB !

TYPE-DEFINITION M SEQ TCPATH\DATA\METDATA\TC-CURIE-BOHR.TDB !

TYPE-DEFINITION B GES AM-PH BCC MAGNETIC -1 .4 !

TYPE-DEFINITION F GES AM-PH FCC MAGNETIC -3 .28 !

$

$DEFAULT_COMMANDS:

DEFAULT-COMMAND DEF_ELEMENT VA !

DEFAULT-COMMAND REJ_SYS-CONST LIQUID 1 VA !

$DATABASE_INFORMATION:

DATABASE-INFO The following binary and ternary systems are available: '

FE-CR-NI by Hertzman'

FE-MO      Fernandez'

FE-CR-C    Andersson'

FE-W-C     Gustafson'

FE-W       Andersson & Gustafson' !

Example 2: A Custom Database for the Sb-Sn Binary
System

$ 

$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 !

ELEM VA VACUUM            0.0  0.0 0.0 !

ELEM MG HCP(A3)          24.305 0.0 0.0 !

ELEM SB RHOMBOHEDRAL(A7) 121.75 0.0 0.0 !

ELEM SN BCT(A5)         118.69 0.0 0.0 !

ELEM /- ELECTRON-GAS      0    0  0 !

$



Thermo-Calc Documentation Set

Database Definition File Examples ǀ 52 of 74

$SPECIES, NAME, STOICHIOMETRIC-FORMULA !

SPECIE MG1 MG1!

SPECIE MG2 MG2!

SPECIE MG2+ MG/+2!

SPECIE SB1 SB1!

SPECIE SB2 SB2!

SPECIE SB4 SB4!

SPECIE SB3- SB/-3!

SPECIE SB5- SB/-5!

SPECIE SN1 SN1!

SPECIE SN4- SN/-4!

$ 

$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !

PHASE BCT       Z 1 1.0!

PHASE HCP       Z 1 1.0!

PHASE RHOMBO    Z 1 1.0!

PHASE GAS:G     Z 1 1.0!

PHASE LIQUID:L  Z 1 1.0!

PHASE IONICLIQ:Y Z 2 1 1!

PHASE SPLIQ:Y   Z 2 1 1!

PHASE BMG3SB2:I Z 2 3 2!

PHASE AMG3SB2:I Z 2 3 2!

PHASE MG2SN:I   Z 2 2 1!

PHASE SBSN      Z 2 1 1!

PHASE SB2SN3    Z 2 2 3!

$ 

$CONSTITUENT, PHASE-NAME : CONSTITUENTS !

CONSTITUENT RHOMBO :SB SN:!

CONSTITUENT HCP :MG SN:!

CONSTITUENT BCT :SB SN:!

CONSTITUENT GAS:G :MG1 MG2 SB1 SB2 SB4 SN1:

> Gas phase, using the Ideal EOS and Mixing Model. !

CONSTITUENT LIQUID:L :SB SN:!

CONSTITUENT IONICLIQ:Y :MG2+:SB SB3- SN SN4- VA:

> This is the Ionic Liquid Solution Phase. !

CONSTITUENT SPLIQ:Y :MG2+:SB SB3- SN SN4- VA:!

CONSTITUENT BMG3SB2:I :MG2+:SB3- SB5- VA SN4-:!
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CONSTITUENT AMG3SB2:I :MG2+:SB3- VA SN4-:!

CONSTITUENT MG2SN:I :MG2+ VA:SB3- SN4-:!

CONSTITUENT SBSN :SB SN:SB SN:!

CONSTITUENT SB2SN3 :SB:SN:!

$ 

$DEFAULT_COMMANDS:

DEFAULT-COM DEF-ELEM VA /-!

DEFAULT-COM REJ-PHASE LIQUID!

DEFAULT-COM REJ-PHASE SPLIQ!

$ 

$TYPE_DEFINITIIONS:

TYPE-DEFINITION Z SEQ * !

$ 

$DATABASE_INFORMATION:

DATABASE_INFO The Sb-Sn system with isentropic temperatures!

$ 

$VERSION_DATE:

VERSION_DATE Last update 1986-05-18 11:39:49 !

$ 

$ 

$ HERE COMES THE THERMODYNAMIC DATA (expressed in functions & parameters):

$ 

FUNCTION MGLIQUID 298.15 -4630.90976+192.994374*T-34.0888057*T*LOG(T)

-36544605.6*T**(-2); 6000 N!

$ 

FUNCTION MGSOLID 298.15 -8367.34+143.677876*T-26.1849785*T*LOG(T)

+4.858E-4*T**2-1.393669E-6*T**3+78950*T**(-1);

923.00 Y -13804.4772 +202.909445*T-34.0888057*T*LOG(T)

-3.65446056E7*T**(-2) +1.06753982E28*T**(-9); 6000 N!

$ 

FUNCTION SBLIQUID 298.15 9071.98+146.800*T-31.38*T*LOG(T)

-2.441646E8*T**(-2); 6000 N!

$ 

.....

..... <more>

$ 

FUNCTION LFCT 298.15 -17325.6+5.03600*T; 6000 N!
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FUNCTION GFCTSBSN 298.15 LFCT+SBSOLID+SNSOLID+2948.291+3721.286;

6000 N!

FUNCTION ISB 298.15 15000; 6000 N!

FUNCTION ISN 298.15 47199.9-95.6270*T; 6000 N!

$ 

.....

..... <more>

$ 

PARAMETER G(RHOMBO,SB;0) 298.15 SBSOLID; 6000 N!

PARAMETER G(RHOMBO,SN;0) 298.15 2035+SNSOLID; 6000 N!

$ 

PARAMETER G(HCP,MG;0) 298.15 MGSOLID; 6000 N!

PARAMETER G(HCP,SN;0) 298.15 32000+SNSOLID; 6000 N!

PARAMETER G(HCP,MG,SN;0) 298.15 -69566-9.23183*T; 6000 N!

$ 

PARAMETER G(BCT,SN;0) 298.15 SNSOLID; 6000 N!

PARAMETER G(BCT,SB;0) 298.15 1000+SBSOLID; 6000 N!

PARAMETER G(BCT,SB,SN;0) 298.15 0.5*ISB+0.5*ISN; 6000 N!

PARAMETER G(BCT,SB,SN;1) 298.15 0.5*ISB-0.5*ISN; 6000 N!

$ 

PARAMETER G(IONICLIQ,MG2+:SB3-;0) 298.15 -204389-4.98506*T

-2.75637E9*T**(-2)+3*MGLIQUID+2*SBLIQUID; 6000 N!

PARAMETER G(IONICLIQ,MG2+:SN4-;0) 298.15 -98639.5+881.073*T

-174.523*T*LOG(T)-1.79808E9*T**(-2); 6000 N!

PARAMETER G(IONICLIQ,MG2+:SB;0) 298.15 SBLIQUID; 6000 N!

$ 

......

...... <more>

$ 

Example 3: A Public Database for the Fe-Cr-C
Ternary System

$ 

$  Revision history:

$      Created as PDEMO by Pingfang Shi on 2004-10-05

$      Renamed to DFeCrC by Pingfang Shi on 2006-10-25



Thermo-Calc Documentation Set

Database Definition File Examples ǀ 55 of 74

$

$ FURTHER MODIFICATIONS:

$ ======================

$ pfs: /20041005 (PDEMO)

$      * Retrieved all definitions from PTERN for the Fe-Cr-C ternary !

$

$ pfs: /20061025 (DFeCrC)

$      * Ignore ELEMENT /- definition.

$      * Modify the L(BCC_A2,FE:C,VA;0) [and L(BCC_A2,CR:C,VA;0)]

$        parameters, in order to avoid BCC-appearance (Fe-C)

$        at temperatures higher than 3900 K.

$          $L(BCC_A2,CR:C,VA;0) 298.15 -190*T;          6000 N REF1 !

$           L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REF1 !

$          $L(BCC_A2,FE:C,VA;0) 298.15 -190*T;          6000 N REF3 !

$           L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REF3 !

$      * Add Cr into HCP_A3 phase, and

$        add all necessary G0/L parameters (according to SSOL2/TCFE3):

$          G(HCP_A3,CR:VA;0)

$          TC(HCP_A3,CR:VA;0)   

$          BMAGN(HCP_A3,CR:VA;0)

$          G(HCP_A3,FE:C;0)

$          G(HCP_A3,CR:C;0)

$          L(HCP_A3,CR:C,VA;0) 

$          L(HCP_A3,CR,FE:VA;0)

$      * Add "TMM:300/3000" limits to all three binary joins in the 

$          ASSESSED_SYSTEM section.

$      * Change the reference indices, e.g., 101 to REF1, in order to

$          always get the reference list correctly.

$      * Re-arrange database format slightly.

$      * Updated the DATABASE_INFO section.

$------------------------------------------------------------------------

$

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ DATABASE INFORMATION:

$************************************************************************

$ 

DATABASE_INFO                                  DFeCrC '
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TCS Demo Fe-Cr-C Alloy Solutions Database'

(only for demonstration purposes in TCC-Demo/TCW-Demo)'

************************************************************ '

(Version 1.2, Oct. 2006) ''

Copyright @ 2004-2012: Thermo-Calc Software AB, Sweden ''

The DFeCrC database (previously called PDEMO) is the TCS Demo Fe-Cr-C '

Alloy Solutions Database, which is especially designed for primarily '

demonstrating the uses of: '

* TCC-Demo software: BIN, TERN, SCHEIL and some other modules; '

* TCW-Demo software: '

"Binary" module calculations of phase diagrams and property diagrams'

in available binary systems; '

"Ternary" module calculations of phase diagrams (e.g., isothermal'

sections, monovariant lines involving liquid, liquidus'

surface projections) and property diagrams in available'

ternary systems; '

"Scheil" module simulations of alloy solidifications; and/or '

"Equilibrium" calculation routines for phase diagrams and property'

diagrams in available binary or ternary systems. '

It can also be used for other types of calculations/simulations in both'

TCC and TCW software, and in their application programming interfaces.''

It includes critically-assessed data for all possible three binary joins'

(i.e. Cr-C, Fe-Cr and Fe-Cr) and one complete ternary alloy solutions '

within the Fe-Cr-C system. However, due to the fact that experimental'

data for the Fe-C and Cr-C binary joins and Fe-Cr-C ternary system at '

extremely-high temperatures are not sufficient, the available assessed'

data can not be applied to temperature conditions higher than 4000 K.''

Included thermodynamic data are available for various stoichiometric '

and solution phases, e.g. liquid mixture, various alloy solutions and '

intermetallic phases. But the gaseous mixture phase is excluded in this'

DEMO version.''

The DFeCrC database can be used not only in calculating various types '

of phase diagrams (binary phase diagrams, ternary isothermal sections,'

ternary monovariant lines involving liquid, ternary liquidus surface '

projections, ternary isopleth sections, etc.) and property diagrams '

(the easiest ways are through the BIN and TERN modules), but also in '

simulating alloy solidification processes (with the SCHEIL module) of'
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Fe-based or Cr-based alloys (but limited within the Fe-Cr-C ternary '

system in this DEMO version). Many unique features of the TCC/TCW '

software can be demonstrated using this and other specially-designed '

DEMO databases. ''

However, this DFeCrC database (similar to other DEMO and/or PUBLIC TC '

databases) is provided within the TCC-Demo/TCW-Demo software only for '

the purposes of demonstration, testing and evaluation. For R&D projects'

and teaching activities, you are highly encouraged to only use the FULL'

versions of the TCC and/or TCW software together with some commercial '

databases that are appropriate for your specific applications. Please '

contact us for all kinds of details. ''

Release History: Version 1.1 with minor improvements, Oct. 2004 '

Version 1.2 with minor modifications, Oct. 2006 ''

Edited by: Dr. Pingfang Shi (Thermo-Calc Software, Oct. 2006). ''

!

$ -----------------------------------------------------------------------

$VERSION_DATE Last update and adjustment: Pingfang Shi, 2004-10-05 !

VERSION_DATE Last update and adjustment: Pingfang Shi, 2006-10-25 !

$

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ Definition of Elements in the Database System: 

$------------------------------------------------------------------------

$ELEM NAME STABLE_ELEMENT_REF        ATOMIC MASS H298-H0    S298 !

$------------------------------------------------------------------------

$ELEMENT /- ELECTRON_GAS           0.0000E+00 0.0000E+00 0.0000E+00!

ELEMENT VA  VACUUM                 0.0000E+00 0.0000E+00 0.0000E+00!

ELEMENT C   GRAPHITE               1.2011E+01 1.0540E+03 5.7400E+00!

ELEMENT CR  BCC_A2                 5.1996E+01 4.0500E+03 2.3560E+01!

ELEMENT FE  BCC_A2                 5.5847E+01 4.4890E+03 2.7280E+01!

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ TYPE_DEFINITIONS for data inclusions:

$------------------------------------------------------------------------

TYPE_DEFINITION % SEQ *!



Thermo-Calc Documentation Set

Database Definition File Examples ǀ 58 of 74

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ TYPE_DEFINITIONS for phase descriptions:

$------------------------------------------------------------------------

$... For magnetic contributions:

TYPE_DEFINITION A GES AMEND_PHASE_DES @ MAGNETIC -1.0 4.00000E-01 !

TYPE_DEFINITION B GES AMEND_PHASE_DES @ MAGNETIC -3.0 2.80000E-01 !

$... For Cr/Fe-C in FCC phase and Cr/Fe-C in HCP phase:

TYPE_DEFINITION C IF(C) THEN GES AMEND_PHASE_DES @ C_S ,, :C: !

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ Default Commands:

$------------------------------------------------------------------------

$DEFINE_SYSTEM_DEFAULT SPECIES 2 !

DEFINE_SYSTEM_DEFAULT ELEMENT 2 !

DEFAULT_COMMAND DEF_SYS_ELEMENT VA !

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ FUNCTIONS for various phases: 

$------------------------------------------------------------------------

$

FUNCT GHSERCC 298.15 -17368.441+170.73*T-24.3*T*LN(T)

-4.723E-04*T**2+2562600*T**(-1)-2.643E+08*T**(-2)

+1.2E+10*T**(-3); 6000 N!

FUNCT GHSERCR 298.15 -8856.94+157.48*T-26.908*T*LN(T)

+.00189435*T**2-1.47721E-06*T**3+139250*T**(-1); 2180 Y

-34869.344+344.18*T-50*T*LN(T)-2.88526E+32*T**(-9); 6000 N!

FUNCT GHSERFE 298.15 +1225.7+124.134*T-23.5143*T*LN(T)

-.00439752*T**2-5.8927E-08*T**3+77359*T**(-1); 1811.00 Y

-25383.581+299.31255*T-46*T*LN(T)+2.29603E+31*T**(-9); 6000 N!

FUNCT GFELIQ  298.15 +GHSERFE#+12040.17-6.55843*T



Thermo-Calc Documentation Set

Database Definition File Examples ǀ 59 of 74

-3.6751551E-21*T**7; 1811 Y

-10839.7+291.302*T-46*T*LN(T); 6000 N!

FUNCT GFEFCC  298.15 +GHSERFE#-1462.4+8.282*T

-1.15*T*LN(T)+6.4E-04*T**2; 1811 Y

-27098.266+300.25256*T-46*T*LN(T)+2.78854E+31*T**(-9); 6000 N!

FUNCT GFECEM  298.15 +GPCEM1#-10745+706.04*T-120.6*T*LN(T); 6000 N!

FUNCT GFEM23C6 298.15 +7.666667*GFECEM#-1.666667*GHSERCC#

+66920-40*T; 6000 N!

FUNCT GCRFCC  298.15 +GHSERCR#+7284+.163*T; 6000 N!

FUNCT GCRM23C6 298.15 -521983+3622.24*T-620.965*T*LN(T)

-.126431*T**2;  6000 N!

FUNCT GCRM3C2 298.15 -100823.8+530.66989*T-89.6694*T*LN(T)

-.0301188*T**2; 6000 N!

FUNCT GCRM7C3 298.15 -201690+1103.128*T-190.177*T*LN(T)

-.0578207*T**2; 6000 N!

FUNCT GPCLIQ  298.15 +YCLIQ#*EXP(ZCLIQ#);   6000 N!

FUNCT ACLIQ   298.15 +2.32E-05*T+2.85E-09*T**2; 6000 N!

FUNCT BCLIQ   298.15 +1+3.2E-10*P;              6000 N!

FUNCT CCLIQ   298.15 1.6E-10;                   6000 N!

FUNCT DCLIQ   298.15 +1*LN(BCLIQ#);             6000 N!

FUNCT ECLIQ   298.15 +1*LN(CCLIQ#);             6000 N!

FUNCT VCLIQ   298.15 +7.626E-06*EXP(ACLIQ#);    6000 N!

FUNCT XCLIQ   298.15 +1*EXP(.5*DCLIQ#)-1;       6000 N!

FUNCT YCLIQ   298.15 +VCLIQ#*EXP(-ECLIQ#);      6000 N!

FUNCT ZCLIQ   298.15 +1*LN(XCLIQ#);             6000 N!

FUNCT GPCGRA  298.15 +YCGRA#*EXP(ZCGRA#);   6000 N!

FUNCT ACGRA   298.15 +2.32E-05*T+2.85E-09*T**2; 6000 N!

FUNCT BCGRA   298.15 +1+3.6E-10*P;              6000 N!

FUNCT CCGRA   298.15 3.3E-10;                   6000 N!

FUNCT DCGRA   298.15 +1*LN(BCGRA#);             6000 N!

FUNCT ECGRA   298.15 +1*LN(CCGRA#);             6000 N!

FUNCT VCGRA   298.15 +5.259E-06*EXP(ACGRA#);    6000 N!

FUNCT XCGRA   298.15 +1*EXP(.9166667*DCGRA#)-1; 6000 N!

FUNCT YCGRA   298.15 +VCGRA#*EXP(-ECGRA#);      6000 N!
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FUNCT ZCGRA   298.15 +1*LN(XCGRA#);             6000 N!

FUNCT GPCFCC  298.15 +YCFCC#*EXP(ZFEFCC#);  6000 N!

FUNCT ACFCC   298.15 +1.44E-04*T;             6000 N!

FUNCT VCFCC   298.15 +1.031E-05*EXP(ACFCC#);  6000 N!

FUNCT YCFCC   298.15 +VCFCC#*EXP(-EFEFCC#);   6000 N!

FUNCT GPCRLIQ 298.15 +YCRLIQ#*EXP(ZCRLIQ#);   6000 N!

FUNCT ACRLIQ  298.15 +1.7E-05*T+9.2E-09*T**2; 6000 N!

FUNCT BCRLIQ  298.15 +1+4.65E-11*P;           6000 N!

FUNCT CCRLIQ  298.15 3.72E-11;                6000 N!

FUNCT DCRLIQ  298.15 +1*LN(BCRLIQ#);          6000 N!

FUNCT ECRLIQ  298.15 +1*LN(CCRLIQ#);          6000 N!

FUNCT VCRLIQ  298.15 +7.653E-06*EXP(ACRLIQ#); 6000 N!

FUNCT XCRLIQ  298.15 +1*EXP(.8*DCRLIQ#)-1;    6000 N!

FUNCT YCRLIQ  298.15 +VCRLIQ#*EXP(-ECRLIQ#);  6000 N!

FUNCT ZCRLIQ  298.15 +1*LN(XCRLIQ#);          6000 N!

FUNCT GPCRBCC 298.15 +YCRBCC#*EXP(ZCRBCC#); 6000 N!

FUNCT ACRBCC  298.15 +1.7E-05*T+9.2E-09*T**2; 6000 N!

FUNCT BCRBCC  298.15 +1+2.6E-11*P;            6000 N!

FUNCT CCRBCC  298.15 2.08E-11;                6000 N!

FUNCT DCRBCC  298.15 +1*LN(BCRBCC#);          6000 N!

FUNCT ECRBCC  298.15 +1*LN(CCRBCC#);          6000 N!

FUNCT VCRBCC  298.15 +7.188E-06*EXP(ACRBCC#); 6000 N!

FUNCT XCRBCC  298.15 +1*EXP(.8*DCRBCC#)-1;    6000 N!

FUNCT YCRBCC  298.15 +VCRBCC#*EXP(-ECRBCC#);  6000 N!

FUNCT ZCRBCC  298.15 +1*LN(XCRBCC#);          6000 N!

FUNCT GPFELIQ 298.15 +YFELIQ#*EXP(ZFELIQ#); 6000 N!

FUNCT AFELIQ  298.15 +1.135E-04*T;                          6000 N!

FUNCT BFELIQ  298.15 +1+4.98009787E-12*P+3.20078924E-14*T*P; 6000 N!

FUNCT CFELIQ  298.15 +4.22534787E-12+2.71569924E-14*T;      6000 N!

FUNCT DFELIQ  298.15 +1*LN(BFELIQ#);                        6000 N!

FUNCT EFELIQ  298.15 +1*LN(CFELIQ#);                        6000 N!

FUNCT VFELIQ  298.15 +6.46677E-06*EXP(AFELIQ#);             6000 N!

FUNCT XFELIQ  298.15 +1*EXP(.8484467*DFELIQ#)-1;            6000 N!
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FUNCT YFELIQ  298.15 +VFELIQ#*EXP(-EFELIQ#);                6000 N!

FUNCT ZFELIQ  298.15 +1*LN(XFELIQ#);                        6000 N!

FUNCT GPFEFCC 298.15 +YFEFCC#*EXP(ZFEFCC#); 6000 N!

FUNCT AFEFCC  298.15 +7.3097E-05*T;                         6000 N!

FUNCT BFEFCC  298.15 +1+3.25236341E-11*P+3.36607808E-16*T*P; 6000 N!

FUNCT CFEFCC  298.15 +2.62285341E-11+2.71455808E-16*T;      6000 N!

FUNCT DFEFCC  298.15 +1*LN(BFEFCC#);                        6000 N!

FUNCT EFEFCC  298.15 +1*LN(CFEFCC#);                        6000 N!

FUNCT VFEFCC  298.15 +6.688726E-06*EXP(AFEFCC#);            6000 N!

FUNCT XFEFCC  298.15 +1*EXP(.8064454*DFEFCC#)-1;            6000 N!

FUNCT YFEFCC  298.15 +VFEFCC#*EXP(-EFEFCC#);                6000 N!

FUNCT ZFEFCC  298.15 +1*LN(XFEFCC#);                        6000 N!

FUNCT GPFEBCC 298.15 +YFEBCC#*EXP(ZFEBCC#); 6000 N!

FUNCT AFEBCC  298.15 +2.3987E-05*T+1.2845E-08*T**2;         6000 N!

FUNCT BFEBCC  298.15 +1+2.80599565E-11*P+3.06481523E-16*T*P; 6000 N!

FUNCT CFEBCC  298.15 +2.20949565E-11+2.41329523E-16*T;      6000 N!

FUNCT DFEBCC  298.15 +1*LN(BFEBCC#);                        6000 N!

FUNCT EFEBCC  298.15 +1*LN(CFEBCC#);                        6000 N!

FUNCT VFEBCC  298.15 +7.042095E-06*EXP(AFEBCC#);            6000 N!

FUNCT XFEBCC  298.15 +1*EXP(.7874195*DFEBCC#)-1;            6000 N!

FUNCT YFEBCC  298.15 +VFEBCC#*EXP(-EFEBCC#);                6000 N!

FUNCT ZFEBCC  298.15 +1*LN(XFEBCC#);                        6000 N!

FUNCT GPFEHCP 298.15 +YFEHCP#*EXP(ZFEHCP#); 6000 N!

FUNCT AFEHCP 298.15 +7.3646E-5*T;                          6000 N!

FUNCT BFEHCP 298.15 +1+32.5236341E-12*P+3.36607808E-16*P*T; 6000 N!

FUNCT CFEHCP 298.15 +26.2285341E-12+2.71455808E-16*T;      6000 N!

FUNCT DFEHCP 298.15 +LOG(BFEHCP#);                         6000 N!

FUNCT EFEHCP 298.15 +LOG(CFEHCP#);                         6000 N!

FUNCT VFEHCP 298.15 +6.59121E-6*EXP(AFEHCP#);              6000 N!

FUNCT XFEHCP 298.15 +EXP(0.8064454*DFEHCP#)-1;             6000 N!

FUNCT YFEHCP 298.15 +VFEHCP#*EXP(-1*EFEHCP#);              6000 N!

FUNCT ZFEHCP 298.15 +LOG(XFEHCP#);                         6000 N!

FUNCT GPCEM1  298.15 +VCEM1#*P;    6000 N!
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FUNCT ACEM1   298.15 -1.36E-05*T+4E-08*T**2;   6000 N!

FUNCT VCEM1   298.15 +2.339E-05*EXP(ACEM1#);   6000 N!

FUNCT GPSIG1  298.15 +1.09E-04*P;       6000 N!

FUNCT GPSIG2  298.15 +1.117E-04*P;      6000 N!

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ Define the various Phase and their Constituents, and

$ Assign parameters to phases:

$------------------------------------------------------------------------

$PHASE NAME:TYPE MARKCODE #SUBL SITES_IN_EACH_SUBL. !

$------------------------------------------------------------------------

$***** LIQUID (Solution) ************************************************

PHASE LIQUID:L % 1 1.0 

> This is metallic liquid solution phase, with C species !

CONST LIQUID:L : C,CR,FE : !

PARAM G(LIQUID,C;0) 298.15 +GHSERCC#+GPCLIQ#

+117369-24.63*T; 6000 N REF0 !

PARAM G(LIQUID,CR;0) 298.15 +GHSERCR#+GPCRLIQ#

+24339.955-11.420225*T+2.37615E-21*T**7; 2180 Y

+GHSERCR#+GPCRLIQ#

+18409.36-8.563683*T+2.88526E+32*T**(-9); 6000 N REF0 !

PARAM G(LIQUID,FE;0) 298.15 +GFELIQ#+GPFELIQ#; 6000 N REF0 !

PARAM L(LIQUID,C,CR;0) 298.15 -90526-25.9116*T; 6000 N REF1 !

PARAM L(LIQUID,C,CR;1) 298.15 +80000;          6000 N REF1 !

PARAM L(LIQUID,C,CR;2) 298.15 +80000;          6000 N REF1 !

PARAM L(LIQUID,C,FE;0) 298.15 -124320+28.5*T; 6000 N REF3 !

PARAM L(LIQUID,C,FE;1) 298.15 +19300;        6000 N REF3 !

PARAM L(LIQUID,C,FE;2) 298.15 +49260-19*T;   6000 N REF3 !

PARAM L(LIQUID,CR,FE;0) 298.15 -14550+6.65*T;  6000 N REF4 !

PARAM L(LIQUID,C,CR,FE;0) 298.15 -496063; 6000 N REF2 !

PARAM L(LIQUID,C,CR,FE;1) 298.15 +57990; 6000 N REF2 !

PARAM L(LIQUID,C,CR,FE;2) 298.15 +61404; 6000 N REF2 !
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$***** FCC_A1 (Solution) ************************************************

$PHASE FCC_A1 %BC 2 1  1 !

$ Note the C TYPE_DEF for 2nd FCC composition-set (MC) is not necessary

$   for the (Fe,Cr)-C system.

PHASE FCC_A1 %B  2 1  1 !

CONST FCC_A1 : CR,FE%

: C,VA% : !

PARAM G(FCC_A1,CR:VA;0) 298.15 +GCRFCC#+GPCRBCC#; 6000 N REF0 !

PARAM TC(FCC_A1,CR:VA;0)    298.15 -1109; 6000 N REF0 !

PARAM BMAGN(FCC_A1,CR:VA;0) 298.15 -2.46; 6000 N REF0 !

PARAM G(FCC_A1,FE:VA;0) 298.15 +GFEFCC#+GPFEFCC#; 6000 N REF0 !

PARAM TC(FCC_A1,FE:VA;0)    298.15 -201; 6000 N REF0 !

PARAM BMAGN(FCC_A1,FE:VA;0) 298.15 -2.1; 6000 N REF0 !

PARAM G(FCC_A1,CR:C;0) 298.15 +GHSERCR#+GHSERCC#

+1200-1.94*T;    6000 N REF2 !

PARAM G(FCC_A1,FE:C;0) 298.15 +GFEFCC#+GHSERCC#+GPCFCC#

+77207-15.877*T; 6000 N REF3 !

PARAM TC(FCC_A1,FE:C;0)    298.15 -201; 6000 N REF3 !

PARAM BMAGN(FCC_A1,FE:C;0) 298.15 -2.1; 6000 N REF3 !

PARAM L(FCC_A1,CR:C,VA;0) 298.15 -11977+6.8194*T; 6000 N REF2 !

PARAM L(FCC_A1,FE:C,VA;0) 298.15 -34671;         6000 N REF3 !

PARAM L(FCC_A1,CR,FE:VA;0) 298.15 +10833-7.477*T; 6000 N REF4 !

PARAM L(FCC_A1,CR,FE:VA;1) 298.15 +1410;         6000 N REF4 !

PARAM L(FCC_A1,CR,FE:C;0) 298.15 -74319+3.2353*T; 6000 N REF2 !

$***** BCC_A2 (Solution) ************************************************

PHASE BCC_A2 %A 2 1  3 !

CONST BCC_A2 : CR%,FE%

: C,VA% : !

PARAM G(BCC_A2,CR:VA;0) 298.15 +GHSERCR#+GPCRBCC#; 6000 N REF0 !

PARAM TC(BCC_A2,CR:VA;0)    298.15 -311.5; 6000 N REF0 !
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PARAM BMAGN(BCC_A2,CR:VA;0) 298.15  -.01; 6000 N REF0 !

PARAM G(BCC_A2,FE:VA;0) 298.15 +GHSERFE#+GPFEBCC#; 6000 N REF0 !

PARAM TC(BCC_A2,FE:VA;0)    298.15 1043; 6000 N REF0 !

PARAM BMAGN(BCC_A2,FE:VA;0) 298.15 2.22; 6000 N REF0 !

PARAM G(BCC_A2,CR:C;0) 298.15 +GHSERCR#+3*GHSERCC#+GPCRBCC#+3*GPCGRA#

+416000;           6000 N REF1 !

PARAM TC(BCC_A2,CR:C;0)    298.15 -311.5; 6000 N REF1 !

PARAM BMAGN(BCC_A2,CR:C;0) 298.15 -.008; 6000 N REF1 !

PARAM G(BCC_A2,FE:C;0) 298.15 +GHSERFE#+3*GHSERCC#+GPFEBCC#+3*GPCGRA#

+322050+75.667*T;  6000 N REF3 !

PARAM TC(BCC_A2,FE:C;0)    298.15 1043; 6000 N REF3 !

PARAM BMAGN(BCC_A2,FE:C;0) 298.15 2.22; 6000 N REF3 !

$ PF-20061025: Modify the L(BCC_A2,FE:C,VA;0) [and L(BCC_A2,CR:C,VA;0)]

$        parametera, in order to avoid BCC-appearance (Fe-C)

$        at temperatures higher than 3900 K.

$PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T;          6000 N REF1 !

PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REFS !

$PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T;          6000 N REF3 !

PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REFS !

$

PARAM L(BCC_A2,CR,FE:VA;0) 298.15 +20500-9.68*T;  6000 N REF4 !

PARAM TC(BCC_A2,CR,FE:VA;0)    298.15 1650; 6000 N REF4 !

PARAM TC(BCC_A2,CR,FE:VA;1)    298.15 550; 6000 N REF4 !

PARAM BMAGN(BCC_A2,CR,FE:VA;0) 298.15 -.85; 6000 N REF4 !

PARAM L(BCC_A2,CR,FE:C;0) 298.15 -1250000+667.7*T; 6000 N REF2 !

PARAM TC(BCC_A2,CR,FE:C;0)   298.15 1650; 6000 N REF5 !

PARAM TC(BCC_A2,CR,FE:C;1)   298.15 550; 6000 N REF5 !

PARAM BMAGN(BCC_A2,CR,FE:C;0) 298.15 -.85; 6000 N REF5 !

$***** HCP_A3 (Solution) ************************************************

$PHASE HCP_A3 %BC 2 1  .5 !

$ Note the C TYPE_DEF for 2nd HCP composition-set (M2C) is not necessary

$   for the (Fe,Cr)-C system.

PHASE HCP_A3 %B  2 1  .5 !
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CONST HCP_A3 : CR,FE,

: VA%,C : !

PARAM G(HCP_A3,CR:VA;0) 298.15 +GHSERCR#+4438;          6000 N REF1 !

PARAM TC(HCP_A3,CR:VA;0)   298.15 -1109; 6000 N REF1 !

PARAM BMAGN(HCP_A3,CR:VA;0) 298.15 -2.46; 6000 N REF1 !

PARAM G(HCP_A3,FE:VA;0) 298.15 +GHSERFE#+GPFEHCP#

-3705.78+12.591*T-1.15*T*LN(T)+6.4E-04*T**2; 1811 Y

+GHSERFE#+GPFEHCP#

-3957.199+5.24951*T+4.9251E+30*T**(-9);     6000 N REF0 !

PARAM G(HCP_A3,CR:C;0) 298.15 +GHSERCR#+.5*GHSERCC#

-18504+9.4173*T-2.4997*T*LN(T)+.001386*T**2; 6000 N REF1 !

PARAM G(HCP_A3,FE:C;0) 298.15 +GFEFCC#+.5*GHSERCC#+GPCFCC#

+52905-11.9075*T;         6000 N REF3 !

PARAM L(HCP_A3,CR:C,VA;0) 298.15 +4165; 6000 N REF1 !

PARAM L(HCP_A3,FE:C,VA;0) 298.15 -22126; 6000 N REF3 !

$PARAM L(HCP_A3,FE:C,VA;0) 298.15 -17335; 6000 N TCFE3 !

PARAM L(HCP_A3,CR,FE:VA;0) 298.15 +10833-7.477*T; 6000 N REF4 !

$***** SIGMA (Solution) *************************************************

PHASE SIGMA % 3 8  4  18 !

CONST SIGMA : FE

: CR

: CR,FE : !

PARAM G(SIGMA,FE:CR:CR;0) 298.15 +8*GFEFCC#+22*GHSERCR#

+92300-95.96*T+GPSIG1#;  6000 N REF4 !

PARAM G(SIGMA,FE:CR:FE;0) 298.15 +8*GFEFCC#+4*GHSERCR#+18*GHSERFE#

+117300-95.96*T+GPSIG2#; 6000 N REF4 !

$***** CEMENTITE (Solution) *********************************************

PHASE CEMENTITE % 2 3  1 !

CONST CEMENTITE : CR,FE%

: C : !

PARAM G(CEMENTITE,CR:C;0) 298.15 +3*GHSERCR#+GHSERCC#
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-48000-9.2888*T; 6000 N REF2 !

PARAM G(CEMENTITE,FE:C;0) 298.15 +GFECEM#;         6000 N REF3 !

PARAM L(CEMENTITE,CR,FE:C;0) 298.15 +25278-17.5*T; 6000 N REF2 !

$***** M3C2 (Compound) **************************************************

PHASE M3C2 % 2 3  2 !

CONST M3C2 : CR

: C : !

PARAM G(M3C2,CR:C;0) 298.15 +GCRM3C2#; 6000 N REF2 !

$***** M7C3 (Solution) **************************************************

PHASE M7C3 % 2 7  3 !

CONST M7C3 : CR%,FE

: C : !

PARAM G(M7C3,CR:C;0) 298.15 +GCRM7C3#;         6000 N REF2 !

PARAM G(M7C3,FE:C;0) 298.15 +7*GHSERFE#+3*GHSERCC#

+75000-48.2168*T; 6000 N REF2 !

PARAM L(M7C3,CR,FE:C;0) 298.15 -4520-10*T; 6000 N REF2 !

$***** M23C6 (Solution) *************************************************

PHASE M23C6 % 3 20  3  6 !

CONST M23C6 : CR%,FE%

: CR%,FE%

: C : !

PARAM G(M23C6,CR:CR:C;0) 298.15 +GCRM23C6#;          6000 N REF5 !

PARAM G(M23C6,FE:CR:C;0) 298.15 +.1304348*GCRM23C6#

+.8695652*GFEM23C6#; 6000 N REF5 !

PARAM G(M23C6,CR:FE:C;0) 298.15 +.8695652*GCRM23C6#

+.1304348*GFEM23C6#; 6000 N REF5 !

PARAM G(M23C6,FE:FE:C;0) 298.15 +GFEM23C6#;          6000 N REF5 !

PARAM L(M23C6,CR,FE:CR:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !
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PARAM L(M23C6,CR,FE:FE:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !

$***** GRAPHITE (Compound) **********************************************

PHASE GRAPHITE % 1 1.0 !

CONST GRAPHITE : C : !

PARAM G(GRAPHITE,C;0) 298.15 +GHSERCC#+GPCGRA#; 6000 N REF0 !

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ ASSESSED_SYSTEMS information: 

$   * necessary for the BIN and TERN modules in TCC

$                     the Binary Phase Diagram module in TCW

$                 and the Equilibrium calculation routine in TCW

$------------------------------------------------------------------------

ASSESSED_SYSTEM

$... Binary ...

C-FE(;P3 TMM:300/4000 *)

C-CR(;P3 TMM:300/4000 *)

CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA

;P3 TMM:300/3000 STP:.6/1200/1/-2/2)

$ CR-FE(TDB -HCP ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA

$      ;P3 TMM:300/3000 STP:.6/1200/1/-2/2)

$

$... Ternary ...

C-CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA

;P3 STP:.4/.5/1 STP:0.1/0.5/1)

!

$ 

$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$

$ 

$ LIST OF REFERENCE: 

$

$------------------------------------------------------------------------

LIST_OF_REFERENCES

NUMBER SOURCE
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REF0 'Alan Dinsdale, SGTE Data for Pure Elements, Calphad Vol 15(1991)

p 317-425, also in NPL Report DMA(A)195 Rev. August 1990'

REF1 'J-O Andersson, Calphad Vol 11 (1987) p 271-276, TRITA 0314; C-CR'

REF2 'Byeong-Joo Lee, unpublished revision (1991); C-Cr-Fe-Ni'

REF3 'P. Gustafson, Scan. J. Metall. vol 14, (1985) p 259-267

TRITA 0237 (1984); C-FE'

REF4 'J-O Andersson, B. Sundman, CALPHAD Vol 11, (1987), p 83-92

TRITA 0270 (1986); CR-FE'

REF5 'J-O Andersson, Met. Trans A, Vol 19A, (1988) p 627-636

TRITA 0207 (1986); C-CR-FE'

REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys Database,

v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters

at high temperatures.'

!
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The Database Checker
In this section:

About the Database Checker 70

Database Checker Revision History 70
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About the Database Checker
The Thermo-Calc software package includes a program to check that the syntax of
unencrypted database files is correct. The program applies the syntax rules set out in the
Database Manager User Guide and reports errors and issues warnings. This program is
intended for advanced users who develop and manage databases.

Thermo-Calc accepts deviations from these syntax rules. This means that a
database can work even if the Database Checker reports errors and warnings.
For example, an error is reported if an abbreviated phase name is found, but
phase name abbreviations are accepted by Thermo-Calc and its add-on
modules.

The executable DatabaseChecker file is found in the Thermo-Calc home directory. The
program can also be launched by selecting Tools→ Database Checker from the main menu.

"Database Checker Revision History" below for releases notes that may assist
database developers.

Database Checker Revision History
The DatabaseChecker application is standalone and need not be installed separately, just
download the containing zip file, open it and follow the instructions in the README.TXT file.
The program requires that Java is installed on the target machine. Please note that large
amounts of RAM may be required when checking large databases.
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Release Notes Version 1.4

l The DatabaseChecker user interface has been modified to allow checking of several
database files in one batch. Instead of selecting an individual database file, the user
now selects a directory that contains databases. The application then shows a tree
structure with all database files in the chosen directory and its subdirectories. The
user may then select any number of these files for processing.

l A check of parameters whose interaction order is 3 has been introduced. For such
parameters, there must either exist one parameter with the interaction degree 0 or
three parameters with the interaction degrees 0, 1 and 2.

l To facilitate optimization of databases, the tool now generates information messages
about functions and parameters that will always return 0.

Release Notes, Version 1.3.2

l The tool now detects conflicts between identical parameters even if one of them
have been defined with the G prefix and the other with the L prefix.

Release Notes, Version 1.3

A bug prevented integers bigger than 32 bits from being parsed. This has been corrected.

The tool now checks that the species and number of sublattices used in parameter
definitions match the phase definition and generates an error message for every mismatch.
Ionic liquid parameters are currently exempted from this check as not to break the
widespread use of defining only one constituent for ionic liquid parameters.

Type definitions and case statements are now parsed for errors. However, only a subset of
all possible GES, POLY and TDB commands are accepted and all other commands will result
in an error message. The accepted commands are:

l GES AMEND_PHASE_DESCRIPTION

l COMPOSITION_SETS

l MAJOR_CONSTITUENTS

l DISORDERED_PART

l MAGNETIC_ORDERING

l STATUS_BITS

l DEFAULT_STABLE
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l FRACTION_LIMITS

l EXCESS_MODEL

l REDLICH-KISTER_MUGGIANU

l HKF

l HKF_ELECTROSTATIC

l DEBYE_HUCKEL

l GES CHANGE_STATUS

l TDB DEFINE_SYSTEM_ELEMENTS

l TDB RESTORE_PHASES

l TDB REJECT_PHASES

Some improvements to warning and error messages have been made to facilitate finding
errors.

Release Notes, Version 1.2

l The tool now uses parallel processing of database files on multi-core systems. This
significantly improves performance when large databases are checked.

l It is no longer required that inter-dependent database statements are defined in a
specific order in the database file (e.g., species need not any longer be defined
before the elements on which they depend). However, for the sake of readability, it is
still advised that the database statements occur in a natural order in the file.

l Because of the parallel processing of database statements, multiple definition errors
(cases where one name has been used to define more than one entity in the
database e.g, two identically named species) may now be generated for any of the
violating occurences and not only for the last occurence in the file.

Release Notes, Version 1.1

l Phase names were not properly recognized in parameter definitions if there was one
or more whitespace characters between the opening parenthesis and the phase
name. This has been corrected.

l The error message Could not parse parameter, <species name> has been given
without a sublattice number but is defined in more than one sublattice is now
displayed only for phases where the general diffusion model is used. Note: this
implementation is temporary and may be subject to changes later.
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l The meaning of the information message The phase <phase name> expects the
following parameters: [<parameter names>]  was unclear to users. It is now longer
shown for the parameter names T and P. For all other names, the message is now
displayed as an error message with the following text: The phase <phase name>
contains references to the following undefined functions: [<function names>].

l The tool now looks for function names that are abbreviations of other function names
and warns about this, since abbreviated names may cause problems during the
execution of macro files that have been auto-generated from GES.

l The tools also warns for functions whose names are in the format V<integer>, since
this may cause conflicts with names that are used by PARROT.

l Parameter names are now shown in a format that is less cryptic and more resembles
the format used in the database. However, the format of diffusion parameters may
still differ somewhat from what is used in the database.

Release Notes, Version 1.0

l The tool parses a TDB file and produces a log with error, warning and information
messages about the state of the file

l The message log can be exported and saved as a separate file for later analysis

l The tool is based on the database command definitions given in TC_Database_
ManagersGuide and DICTRA27_UsersGuide. All commands in these documents are
supported. Some undocumented DIFFUSION commands are not supported.

l Databases that span several files are correctly handled, also blocked files

l The tool is in some aspects more strict than required by the guides (see Additional
Information below)

l The tool performs the following checks:

l Syntax control of database statements: ERROR

l Line size: ERROR or WARNING depending on context

l Multiply defined elements, species or phases: ERROR

l Multiply defined functions and parameters: ERROR

l Multiply defined assessed system: ERROR

l Multiply defined references: ERROR

l References entries that are never used: WARNING

l References to non-existent type definitions: ERROR

l Type definitions that are never used: WARNING
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l Unused functions and parameters: WARNING

l Functions and parameters with undefined references: WARNING

l References to undefined elements, species or phases: ERROR

l Dependencies to external names from a phase: INFORMATION. (All parameters of a
phase are evaluated with respect to their dependencies to other parameters and
functions and all unresolved names are listed. Typically, this should only yield
dependencies on T and possibly P)

Additional Information

In addition to the command definitions given in the user guides listed above, the following
rules are also applied:

l Names are case-sensitive, meaning that e.g., the defined element MN cannot be
referred to  under the name Mn;

l Phase names cannot be abbreviated. When referred to in parameter descriptions
their full names must be used.
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